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ELECTRONIC END USER LICENSE AGREEMENT
FOR SELPA MANAGER

NOTICE TO USER

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE 
TERMS AND CONDITIONS OF THIS AGREEMENT.

This SELPA Manager End User License Agreement accompanies the product and related 
explanatory materials (“Software”). The term “Software” also shall include any upgrades, 
modified versions or updates of the Software licensed to you by Fusion Technik. Please read 
this Agreement carefully. At the end, you will be asked to accept this agreement and 
continue to install or, if you do not wish to accept this Agreement, to decline this agreement, 
in which case you will not be able to use the Software. Upon your acceptance of this 
Agreement, Fusion Technik grants to you a non-exclusive license to use the Software, 
provided that you agree to the following: 

1. Use of the Software.

o You may install the Software on a hard disk or other storage device; install and use the 
Software on a file server for use on a network for the purposes of (i) permanent installation 
onto hard disks or other storage devices or (ii) use of the Software over such network; and 
make backup copies of the Software. 

o You may make and distribute unlimited copies of the Software, as long as each copy that 
you make and distribute contains this Agreement and other proprietary notices pertaining 
to this Software that appear in the Software. If you download the Software from the Internet 
or similar on-line source, you must include the copyright notice for the Software with any 
on-line distribution and on any media you distribute that includes the Software. 

o Operation (continued use) of the Software on a computer for a period in excess of 60 days 
will require that you register the Software with Fusion Technik. Fusion Technik will 
provide you with a serial number that will allow the Software to be used without additional 
time limits (see below).

2. Copyright and Trademark Rights. The Software is owned by Fusion Technik and its 
suppliers, and its structure, organization and code are the valuable trade secrets of Fusion 
Technik and its suppliers. The Software also is protected by United States Copyright Law 
and International Treaty provisions. You may use trademarks only insofar as required to 
comply with Section 1 of this Agreement and to identify printed output produced by the 
Software, in accordance with accepted trademark practice, including identification of 
trademark owner’s name. Such use of any trademark does not give you any rights of 
ownership in that trademark. Except as stated above, this Agreement does not grant you any 
intellectual property rights in the Software.

3. Restrictions. You agree not to modify, adapt, translate, reverse engineer, decompile, 
disassemble or otherwise attempt to discover the source code of the Software. You may not 
alter or modify the installer program or create a new installer for the Software. 



      
4. No Warranty. The Software is being delivered to you AS IS and Fusion Technik makes 
no warranty as to its use or performance. FUSION TECHNIK AND ITS SUPPLIERS DO 
NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY 
OBTAIN BY USING THE SOFTWARE OR DOCUMENTATION. FUSION TECHNIK 
AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO 
NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR 
FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL FUSION 
TECHNIK OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR 
LOST SAVINGS, EVEN IF AN FUSION TECHNIK REPRESENTATIVE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY 
ANY THIRD PARTY. Some states or jurisdictions do not allow the exclusion or limitation 
of incidental, consequential or special damages, or the exclusion of implied warranties or 
limitations on how long an implied warranty may last, so the above limitations may not 
apply to you.

5. Governing Law and General Provisions. This Agreement will be governed by the laws of 
the State of California, USA., excluding the application of its conflicts of law rules. This 
Agreement will not be governed by the United Nations Convention on Contracts for the 
International Sale of Goods, the application of which is expressly excluded. If any part of 
this Agreement is found void and unenforceable, it will not affect the validity of the balance 
of the Agreement, which shall remain valid and enforceable according to its terms. You 
agree that the Software will not be shipped, transferred or exported into any country or used 
in any manner prohibited by the United States Export Administration Act or any other 
export laws, restrictions or regulations. This Agreement shall automatically terminate upon 
failure by you to comply with its terms. This Agreement may only be modified in writing 
signed by an authorized officer of Fusion Technik.

Unpublished-rights reserved under the copyright laws of the United States.

Fusion Technik, 5850 Sonoma Mountain Road, Santa Rosa, CA 95404.

On-line documentation distributed under end-use license for pdf documents, from Adobe 
Systems Incorporated. Adobe, Acrobat, and Acrobat Exchange are trademarks of Adobe 
Systems Incorporated.

YOUR ACCEPTANCE OF THE FOREGOING AGREEMENT WAS INDICATED 
DURING INSTALLATION.

Program registration information
From the time that you first open SELPA Manager, you have a trial period 
of up to three months (90 days) to register your purchase. You can register 
at any time during that trial period by selecting Preferences from the File 
menu, and then pressing the SERIAL No. button. 
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After you press the SERIAL No. button, the program will request a response 
code (serial number) while at the same time presenting a challenge code —

PLEASE ENTER SERIAL NUMBER: [challenge code]

Copy down the challenge code exactly on a slip of paper, or prepare a 
printed fax cover, from the serial number request dialog. The challenge code 
is case- and space-sensitive. Send the challenge code to Fusion Technik by 
email, fax, or by telephoning customer support. For email and fax 
correspondence, be sure to include your name, SELPA, district if applicable, 
address, and telephone number.

Fusion Technik will register you as a SELPA Manager user, and provide a 
response code (serial number) to license the program for continued use 
beyond the 90-day trial period.

For now, you may cancel the serial number request dialog. The program will 
inform you of the date by which you must provide the serial number. If you 
do not provide a serial number by that date, the serial number request will 
appear as you try to open the program, and you won’t be able to access the 
program.

Thirty days prior to the expiration of the trial period, the program will 
remind you each time it starts up of the impending registration deadline.

Once you have registered the program, it is not necessary to re-register when 
you receive program upgrades. You won’t have to re-register unless: 

(1) You change the SELPA information as it appears in the Preferences 
dialog; or 

(2) You remove the program’s existing data file (e.g., on a Windows PC, 
“SelpaMgr_v47.4dd” and “SelpaMgr_v47.4DR”) from the directory and/or 
instruct the program to start a new (blank) data file; or 

(3) You are running a multi-user edition of SELPA Manager, and you re-
open the data file in a single-user edition of the program; or

(4) You are running a single-user edition of SELPA Manager, and you re-
open the data file in a multi-user edition of the program.



     
In Cases 1, 3, and 4, the program will ask you for a new serial number the 
next time you attempt to open the program. In the second case (new data 
file), you will have another three months’ trial period in which to register the 
program.

If you anticipate making frequent switches from single-user to multi-user 
editions of SELPA Manager, then you may want to obtain both serial 
numbers from Fusion Technik.

For more detailed information on the registration process, refer to 
“Preferences for administrators” on page 243.
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62

Maximizing throughput for network applications (rather than file sharing) in Windows 
2000 Server. 65
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Welcome dialog for the SELPA Manager installer program (client-server edition, PC), 
showing the blue gradient background. 66

Select Components dialog for the SELPA Manager installer program (client-server edition, 
PC). 67

Welcome dialog for the SELPA Manager update installer program (client-server edition, 
PC). 69

Read Me File dialog, for the SELPA Manager update installer program (client-server edi-
tion, PC). 69

Select Components dialog for the SELPA Manager update installer program (client-server 
edition, PC). 71

Start Installation dialog for the SELPA Manager installer program (client-server update, 
structure only), which is the final step prior to physical installation. 72

Views tab of the Folder Options dialog, Windows XP, with settings that permit file type 
extensions to be displayed. 73

Appearance of the “SELPA_fldr” after pasting in the recovered data file 
(“TUSD_2003.4DD” and “TUSD_2003.4DR”). 74

4D Server 2003 license agreement. 75

4D Server 2003 license number entry dialog. 75

4D Server open/create database dialog, prompting you to specify which database to open. 
76

4D Server, standard open-file dialog for selecting a database (structure file). 77

4D Server, standard open-file dialog for selecting a data file. 78

4D Server in operation, showing the main window (“4D Server”) and the two auxiliary 
windows (“Backup Scheduler” and “Restore Log”). 79

Full Backup dialog, displayed by 4D Server when you select “Full backup...” from the 
Backup menu. 80

“Save as...” dialog, displayed by 4D Server when you press the BACKUP button on the 
Full Backup dialog. 82

Save backup project dialog, displayed by 4D Server after changes are made in a 4D Backup 
configuration. 82

“Scheduling the backup” dialog, which appears while configuring the Backup Scheduler 
window. 84

License number entry dialog, 4D Server 2003. Serial number shown is for illustration pur-
poses only (not a valid number). 85
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Welcome dialog for the SELPA Manager installer program (client-server edition, PC), 
showing the blue gradient background. 87

Select Components dialog for the SELPA Manager installer program (client-server edition, 
PC). 88

Window and virtual disk for the SELPA Manager installer program (single-user edition, 
Macintosh). 91

The SELPA Manager installer program (single-user edition, Macintosh) presents a dialog 
with an INSTALL button. 92

The SELPA Manager installer program (single-user edition, Macintosh), appearance fol-
lowing successful installation. 92

The SELPA Manager program in its installed directory (Macintosh single-user). 93

Top portion of a 4D Server 2003 license card, illustrating a portion of the Product ID num-
ber (valid numbers are longer than the number shown). 96

Web-based form on www.4D.com/register, for registering 4D Product ID numbers. 97

Web-based confirmation form on www.4D.com/register, returning the serial number for a 
4D Server registration (the numbers shown are not valid, for illustration purposes only). 
98

Window for the virtual disk, SELPA Manager installer program (client-server edition, 
Macintosh). 101

The SELPA Manager installer program (client-server edition, Macintosh) presents a dialog 
with an INSTALL button. 102

The SELPA Manager installer program (client-server edition, Macintosh) after installation 
of the server components. 102

The SELPA Manager program in its installed directory (Macintosh client-server). 103

Expanding (unstuffing) the SELPA Manager update file, using the contextual menu plug-
in for Stuffit Deluxe (client-server edition, Macintosh). 104

After Stuffit has expanded the update file, use the contents of the resulting 
“Server_upgrade_fldr” to replace the corresponding items in the “~Applications/Fu-
sion Technik/SELPA _fldr” directory (client-server edition, Macintosh). 105

4D Server 2003 license agreement (Macintosh server). 106

4D Server 2003 license number entry dialog (Macintosh server). 107

4D Server open/create database dialog, prompting you to specify which database to open 
(Macintosh server). 107

4D Server (Macintosh), standard open-file dialog for selecting a database (structure file). 
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108

4D Server (Macintosh), standard open-file dialog for selecting a data file. 109

4D Server (Macintosh), standard dialog for creating a new data file. The default name pre-
fix (“Selpa_Mgr_v475”) can be replaced with your school or district name. 110

4D Server (Macintosh) in operation, showing the main window (“4D Server”) and the two 
auxiliary windows (“Backup Scheduler” and “Restore Log”). 111

Full Backup dialog, displayed by 4D Server (Macintosh) when you select “Full backup...” 
from the Backup menu. 112

“Save as...” dialog, displayed by 4D Server when you press the BACKUP button on the 
Full Backup dialog. In this example, the user should double-click on the “Data back-
ups” folder, to place the backup in that location. 113

Save backup project dialog, displayed by 4D Server (Macintosh) after changes are made in 
a 4D Backup configuration. 114

“Scheduling the backup” dialog, which appears while configuring the Backup Scheduler 
window. 116

License number entry dialog, 4D Server 2003 (Macintosh). Serial number shown is for il-
lustration purposes only (not a valid number). 117

Window for the virtual disk, SELPA Manager installer program (client-server edition, 
Macintosh). 119

The SELPA Manager Macintosh client installer (client-server edition) presents a dialog 
with an INSTALL button. 120

The SELPA Manager Macintosh client installer (client-server edition), following installa-
tion. 120

Converting a data file to work with the 4D 6.7.1 database engine. This dialog appears when 
opening SELPA Manager 4.701 with an existing data file, from a SELPA Manager ver-
sion prior to 4.701. 122

Selecting the SELPA Manager single-user runtime from the Windows Start menu. 135

The SELPA Manager program in its installed directory (Macintosh single-user). 136

The 4D Client application, in the Windows Start menu (Windows client-server). 137

4D Client connection dialog, “TCP/IP” tab, starting 4D Client from a workstation. 137

4D Client connection dialog, “Custom” tab, for manually entering a TCP address and then 
selecting the server (starting 4D Client from a workstation). 138

Login dialog for SELPA Manager. Highlight the desired user login name, then enter the 
corresponding password in the lower box. 142
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Summary of the relationships among user access groups. The “CounselorLtdGrp” is not 
shown to reduce confusion. If it were to be shown, it would most likely overlap the 
“TeacherLtdGrp” and extend into the “ReadWriteGrp”. 155

Browse window displaying user information. 160

Confirmation dialog, which appears after closing the Passwords dialog (File menu -> “Us-
ers and groups...”. 160

Specifying school or district access limits for a user, from the program user data entry form. 
161

“Open file”-type dialog for SELPA Manager. The program presents this dialog for the sin-
gle-user edition, if a data file cannot be located, or if the user holds down the [ALT/OP-
TION] key after the user login dialog. 163

“Save-as”-type dialog, to create a new data file on disk. 164

“Welcome to SELPA Manager” Preferences dialog, when opening a new data file on disk. 
165

About SELPA Manager... dialog.The program presents this dialog when the user first ac-
cesses a data file after a program version update. 166

Dialog offering to import students (displayed when no student records exist yet in the pro-
gram). 167

The SELPA Manager browse window 168

The SELPA Manager browse window, with navigational shortcuts shown. 174

The Order By dialog, accessible from the Data menu. (“Sort”) 178

The Query Editor. 179

Evaluation sequence for user-entered text expressions, Location box. 182

Dialog for adding attendance information directly from the browse window. 184

List displayed when the user clicks on the drop-down arrow for the Location box. The cur-
rent focus of the browse window is on schools, so the field names displayed are in the 
[School] table. 187

Get students with service(s) dialog, for “count student services” function, Location box. 
193

Get students with disciplinary action(s) dialog, for “count disciplinary actions” function, 
Location box. 194

Find students with IEP meetings, evaluations, or compliance dates outside of user-specified 
limits. For the “overdue” function, Location box. The first two or the second two search 
criteria can be used simultaneously (but not all four together). 195
List of Figures 27 

• 
• 
• 
•
•
•



 

28

 

Lis

 

• 
• 
• 
•
•
•

 

Dialog, for placing student-related date information onto the Calendar, for a selection of 
students. Activated by the “place dates on calendar” function, Location box. 196

Direct entry into date fields in the browse window, for a Student list that has the current 
focus. The user can double-click into an enterable cell, or use the associated date drop-
down list in the cell. Activated by the “unlock” function, Location box. 198

Dialog, for updating the Quick Report “clone” fields, for a selection of students. Activated 
by the “update quick report fields” function, Location box. 200

Last found or last saved set dialog. 223

The Calendar display. 227

Sample data entry form. 231

Choice list menu for a combo box. Clicking on the arrow icon for the ethnicity combo box 
displays a menu of choices, for selecting the ethnicity type. Also shown (but not acti-
vated) is a simple drop-down list, just to the right of the “Ethnicity” label. 232

Data entry areas containing coded information 235

Lower-case data entry, before leaving the field. 235

Capitalization upon leaving a field. 236

Blank dates appear in fields as “00/00/00”. However, on entering the field, the program 
switches to “MM/DD/YYYY”. 236

Selecting a date from a drop-down list within a cell, in a list of student service records. 237

Boolean fields. DNR and Mark are check box-style Boolean fields; Translator Required is 
a “radio-button” style, user-defined Boolean field. 237

Data entry into a scrolling text area. 238

The SAVE, CANCEL, record navigation (VCR-style) buttons, and the list of missing/prob-
lem items, data entry form. The SAVE button is dimmed if there are problems listed, 
unless (for a student) the DNR (“do not report”) box is checked. Also shown here are 
the (<-) and (->) buttons, for cycling among the tabs on a tabbed data entry form. 239

Error message resulting from pressing a record navigation button, on a record where the 
save button is dimmed and where the user has made changes to the record. 240

Record update information appears in the lower-left corner of most data entry forms. 240

Summary of browse window contexts where new records may be added. The flow chart il-
lustrates the optional data entry cycle for adding students. This option must be selected 
in Preferences. 242

Preferences dialog (administrators), SELPA information tab. 244

Program registration dialog, for entering the serial number. 248
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Fax cover request form (generated by the program), for obtaining a serial number from 
technical support 249

Alert indicating the number of days until serialization will be mandatory (the expiration 
date of the trial period). 249

“Prepare for SSL...” dialog, to obtain a Secure Sockets Layer certificate for the SELPA 
Manager web server. 252

Sample application for a SSL certificate (from qualityssl.com). The CSR text that has been 
pasted into the box is for illustration only. 254

Preferences dialog (administrators), System 1 tab. 255

Confirmation dialog to recalculate student ages, after changing the “Age calcs. fm.” date. 
257

Confirmation dialog to clear infant/preschool fields on recalculating student ages, after 
changing the Report As Of date. 258

Editing auxiliary service codes and associated parameters. 262

Dialog for adding/editing disabling condition codes. 263

Dialog for adding/editing non-primary drop reasons. 264

Dialog for adding/editing auxiliary checkboxes, to appear on the enhanced transportation-
only form. 265

Appearance of the enhanced transportation-only form. after adding auxiliary checkboxes, 
as in Fig. 4-13. 266

Preparing a Quick Report of user-entered choice list items. 267

Audit trail information for a student record, showing changes to each field since the record 
was created. The audit trail feature must be enabled in Preferences. 271

Preferences dialog (administrators), System 2 tab. 275

Pop-up choice list of dates that appears when the user clicks into a date field, on the assess-
ment (IEP) form, goal/objective tab only. 276

Pop-up choice list of dates that appears when the user clicks into a date field, on the goal 
data entry form. 277

Example of a non-date, pop-up choice list that appears when the user clicks into a progress 
field, on the IEP data entry form, goal/objective tab. Does not apply to all IEP forms. 
278

Appearance of the “IEP form to use:” drop-down list, when a custom IEP template is avail-
able. 280

Dialog for creating or editing a logon notice, which is displayed when each non-web user 
List of Figures 29 

• 
• 
• 
•
•
•



 

30

 

Lis

 

• 
• 
• 
•
•
•

 

connects to the program. 286

District access restrictions, confirmation dialog. 287

Preferences dialog (administrators), IEP notice defaults tab. 288

Copying IEP notice preferences to a particular student (COPY PROGRAM DEFAULTS 
button). 289

Preferences dialog (administrators), Appearance tab. 290

Example of “tool tip” help, which can be turned off. 291

Custom sort order dialog, accessible after pressing the EDIT button next to the “Sort 
browse lists” check box, Preferences. Up to four columns can be sorted, for each data-
base table. 294

Transportation-only data entry form for students (partial, showing upper portion). This 
form scrolls vertically – the SAVE and CANCEL buttons are located at the bottom of 
the form (not shown). 300

First tab, data entry form for a student, displaying the student’s calculated age as of today’s 
date (indicated by the “[T]” suffix. The number in the recessed area, next to the AGE 
button, is the calculated age field (an integer age that is always referenced to the Report 
As Of date). 301

Preferences dialog for user in the “ReadWriteGrp” access group, General tab. 303

Preferences dialog for user in the “ReadWriteGrp” access group, IEP notice defaults tab. 
304

Preferences dialog for user in the “ReadWriteGrp” access group, Appearance tab. 304

Preferences dialog for user in the “TeacherLtdGrp” or “CounselorLtdGrp” access groups, 
General tab. 305

Preferences dialog for user in the “TeacherLtdGrp” or “CounselorLtdGrp” access groups, 
IEP notice defaults tab. Because the “My defaults” box is checked, the various IEP no-
tice items can be edited. 306

Preferences dialog for a read-only user, General tab. 307

Preferences dialog for a read-only user, Appearance tab. 308

Data entry form for adding a new district. 311

District holidays and vacation periods (list), on District data entry form. 314

Typing the sentence “district name is san joaquin” into the Location box, to find a district. 
316

The program locates the appropriate record(s). 317

Browse window displaying the Schools context (schools in upper list, teacher assignments 
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in lower list). 319

Data entry form for adding a new school. 320

Dependencies among the staff-related areas of SELPA Manager, and their relationship to 
student services. 326

Browse window displaying the Staff context (staff members in the upper list, assignments 
in the lower list). 329

Data entry form for a staff member, General (first) tab. 330

Data entry form for a staff member, Demographics (second) tab. 333

Data entry form for a staff member, Teacher services - assignments (third) tab. 336

Finding an existing teacher record from the Location box. 342

Set the current context of the browse window to student services. The focus should be on 
the upper list. 343

Dialog for selecting current student services. 344

Select the name of the staff member that is being replaced. 344

The browse window should now contain only current student services for the staff member 
that is being replaced. 345

The apply teacher dialog. These settings will assign “Tucker, Prudy” to the listed student 
services, creating any needed teacher services and (teacher) assignments for Ms. Tuck-
er in the process. 346

Confirmation dialog after apply teacher action. 346

Appearance of student services list after the Apply teacher action is complete. 347

Adding a new teacher service for a staff member, from the browse window (current focus 
is on teacher services, the lower list). 348

Data entry form for a new teacher service. 349

Data entry form for an assignment. 352

Dialog box for selecting service(s) to be used in creating new attendance record(s). {CN-
TRL/CMD]-Click or [SHIFT]-click to select more than one service. 354

Data entry form for an assignment, after adding attendance records. 355

The record number ([Student]Record_number) appears just to the left of the student’s 
name, in the upper left portion of the data entry form. 360

Logic chart for selecting the district of residence and the district code prefix of the student 
record number ([Student]Record_number). 361

The [Student]Student_ID field appears between brackets (“[5]”), along with record selec-
tion and created/modified information. 362
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The SELPA Manager browse window, showing the Students context. 364

Dialog for selecting the district for the record number prefix, when adding a new student. 
365

Data entry form for a student, first (General) tab. 366

When a student contact is copied into the “QR_” or the “QR2_” fields, the contact infor-
mation then becomes available when generating a student report in the Quick Report 
Editor. 370

The add contact form, which appears after pressing the ADD (+) button on Tab 1 (General) 
of the student data entry form. 372

Data entry form for a student, second (Demographics) tab. 375

Ethnicity pop-up list, data entry form for a student, second (Demographics) tab. The “>” 
character indicates that the particular ethnicity listing is not blank. 376

Data entry form for a student, third (Dates) tab. 381

Data entry form for a student, fourth (Services) tab. 384

The add service form, which appears after pressing the ADD (+) button on Tab 4 (Services) 
of the student data entry form. 385

Control buttons adjacent to the list of services, Tab 4 (Services) of Student data entry form. 
392

Drop service(s) dialog. 393

Editing choice list items for non-primary drop reason. 394

Word processing area on Tab 4 (Services) for the Student record. The word processing ruler 
has been hidden to permit the text to be displayed (View menu > Ruler). 395

Word processing area on Tab 4 (Services), zoomed to become a separate word processing 
window. The ruler and two tool bars are shown; these items can be toggled on and off 
from the View menu. 396

Data entry form for a student, fifth (IEP Notice) tab. 397

Data entry form for a student, sixth (Discipline) tab. 399

Data entry form for a student, seventh (Transportation) tab. 402

Data entry form for a student, eighth (User A1) tab. 406

Data entry form for a student, ninth (User A2) tab. 407

Data entry form for a student, tenth (User nbr/date) tab. 409

Data entry form for a student, eleventh (User Y/N) tab. 410

Data entry form for a student, tenth (Notes / dups) tab. 411
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Top portion of the transportation-only data form., showing display-only components. 414

Bottom portion of the transportation-only data form., showing the data entry areas. 414

Data entry form for adding a new student service. 419

Data entry form for adding a new goal, first tab. 428

Data entry form for adding a new goal, second tab. 431

Data entry form for adding a new goal (SELPA 3702 form), first tab. 432

Data entry form for a goal (SELPA 3702 form), second tab. 433

Data entry form for a goal (SELPA 3702 form), fifth tab. 434

Data entry form for a goal (SELPA 0901 form), second tab. 435

Data entry form for a goal (SELPA 4811 form), third tab. The only difference from the de-
fault form is the absence of a sixth date and progress level. 436

Data entry form for a goal (SELPA 0400/4500/5300 form), first tab. 437

Data entry form for a goal (SELPA 0400/4500/5300 form), second tab. 438

Importing goals and objectives for the palette. 440

Importing goals and objectives for the palette (second dialog). 440

Importing goals and objectives for the palette (file open dialog). 441

Goals/objectives palette (initial appearance). 442

Goals/objectives palette (expanded appearance). 443

Inserting an item from the goals/objectives palette into Benchmark 1 of the goals data entry 
form. 444

Inserting an item from the goals/objectives palette into Benchmark 2 of the goals data entry 
form. 445

Adding a new category (Behavior) to the goals/objectives palette. 446

A new category (Behavior) has been added to the goals/objectives palette. 446

Adding a new sublisting (a grade level) to the goals/objectives palette, by holding down the 
[ALT/OPTION] key and clicking on the (+) button. 447

Appearance of the palette after adding six new sublistings (grade levels) to a new category 
(Behavior), on the goals/objectives palette. 448

Adding a sublisting (measurable objective) for a grade level, on the goals/objectives pal-
ette. 449

Adding a sublisting (goal) for a measurable objective, on the goals/objectives palette. In 
this case, the goal description (title) was longer than 30 characters, and therefore was 
truncated. The long description remains in the lower box, however. 450
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Appearance of the goals/objectives palette after editing a goal title that was truncated. 451

Appearance of the goals/objectives palette after adding and editing a benchmark. Bench-
marks are at the final (fifth) expansion level of the palette, and are preceded by a green 
dot. 451

Confirmation dialog for exporting goals/objectives palette items. 452

Save to disk dialog, for exporting goals/objectives palette items. 453

Confirmation after exporting goals/objectives palette items. 453

SELPA Manager import dialog, showing the SELPA Manager goals/objectives import. 454

Standard open file dialog, showing the SELPA Manager goals/objectives file to be import-
ed. 455

Print districts dialog. 457

District chargeback report dialog, first tab (“By school name”). 458

Chargeback calculation formula, Type 1 chargeback report. 459

Sample print preview, Type 1 chargeback report. 461

District chargeback report dialog, second tab (“By school type”). 462

Sample partial print preview, Type 2 chargeback report. 464

Dialog for editing auxiliary service codes. 466

Browse window displaying the Discipline context (disciplinary actions in upper list, stu-
dents in lower list). 472

Data entry form for a new disciplinary action. 473

Finding an existing discipline record from the Location box. 477

Error message, displayed to “TeacherLtdGrp” access group users when there are no exist-
ing IEP forms available for viewing / editing. 481

To display the Assessment section, the item, “Students / assessments” or “Assessments / 
students”, should be selected on the Appearance tab of Preferences. 482

Students browse window context, showing assessments (rather than contacts) in the lower 
list. 483

Data entry form for a new assessment, first (IEP 1) tab, view of upper area on the form. 
Note the use of both horizontal and vertical scroll bars. 485

Dialog displayed when an assessment is saved, and SELPA Manager detects changes to 
student-level information on the assessment form. Accepting the form (OK button) up-
dates the student record. 487

Request in the Location box for a new assessment (IEP) form. This request can be made 
with any context being displayed. 488
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Request for a new assessment (IEP) form. SELPA Manager could not find the student, so 
it is assuming that a new student is to be added simultaneously. 489

Appearance of a new assessment (IEP) form., where a new student is to be added simulta-
neously with the assessment. 490

Data entry form for a new assessment, first (IEP 1) tab, view of lower area on the form. 493

Data entry form for a new assessment, second (IEP 2) tab, view of upper area on the form. 
494

Data entry form for a new assessment, second (IEP 2) tab, view of lower area on the form. 
497

Data entry form for a new assessment, third (IEP 3) tab, view of upper area on the form. 498

Data entry form for a new assessment, fourth (IEP 4) tab, view of upper area on the form. 
499

Data entry form for a new assessment, fifth (IEP 4.1) tab, view of upper area on the form. 
500

Data entry form for a new assessment, sixth (IEP 5) tab, view of upper area on the form. 
Note the presence of an inner, vertical scroll bar, used to move among the goal/objec-
tives for this assessment. 503

Using the goals/objectives palette to enter benchmarks (and associated goals) to the IEP5 
tab, for an assessment. As many as three benchmarks can be entered for each goal 
record. 505

Data entry form for a new assessment, seventh (Team certification) tab, view of upper area 
on the form. 507

Data entry form for a new assessment, eighth (Assessment results) tab, view of upper area 
on the form. 509

Locked record warning, when attempting to edit a record. This message appears when an-
other window is already displaying a data entry form for the same record. 514

Import dialog (File menu -> Import...). 514

Sample SELPA Central import confirmation dialog. 516

Import dialog (File menu -> Import...), showing the “other import” selections. 523

Confirmation dialog for the Discipline (generic) import. 527

Confirmation dialog for importing a tab-delimited Zip (postal) code file. 537

Transfer dialog for student records (File menu -> Transfer...). 568

Districts to central export dialog (File menu -> Districts to central...). 569

Districts to central, confirmation dialog (File menu -> Districts to central...). 570
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MediCAL export confirmation dialog (File menu -> MediCAL. eligibility...). 571

Users and groups (Passwords) dialog. White icons denote items created by the program de-
signer (cannot be modified). 574

Add/edit user dialog, accessed from Users and groups (Passwords) dialog. 575

Add/edit password dialog, accessed from the add/edit user dialog. 576

Add/edit group dialog, accessed from the users and groups (Passwords) dialog. 579

Save groups and users dialog, accessed from the users and groups (Passwords) dialog. 582

“Who is here...”dialog. 584

Print students dialog. 586

IEP verification, example print, default form (partial view). 587

IEP notice extra items dialog. 588

IEP notice, example print, default form (partial view). 588

Transportation profile, example print, default form (partial view). 589

Transportation summary, example print (partial view). 590

Caution dialog that appears before generating the Enrollment summary by disability report. 
591

Configuration dialog for the Enrollment summary by disability report. 591

Sample print preview for the Enrollment summary by disability report. 592

Print assessments dialog. 592

Print student services dialog. 593

Print goals confirmation dialog. 594

Print goal detail (example, partial print as preview, SELPA 3702). 595

Print teachers dialog. 596

Print student by teachers report dialog. 596

Student by teacher report (sample print preview). 597

Attendance register report (sample print preview). 598

Print Attendance Registers report dialog. 599

Print districts dialog. 600

District total page, personnel report form (print preview, partial). 602

Delete record confirmation dialog. In this example, the user selected the three highlighted 
students for deletion. 612

Search preference dialog, displayed when the user selects “Show current for...” from the 
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Data menu. 618

The Query Editor. 622

Query Editor, selecting a field from a related table 628

Chart Wizard, for preparing charts and graphs from browse window selections. Shown: 
Chart type tab. 632

Chart Wizard, Chart style tab. 632

Chart Wizard, Chart style tab. 633

Sample bar graph of student name vs. calculated age, for a selection of students (prior to 
editing chart settings). 634

Sample bar graph of student name vs. calculated age, for a selection of students (after ed-
iting chart settings). 635

Sample bar graph of student name vs. calculated age, for a selection of students (after ed-
iting chart settings). Students sorted by age prior to graphing. 635

“Order by” dialog, for sorting a selection of records in the browse window. 636

Find transportation dialog, which appears when the user selects “Transportation...” from 
the Data menu. 642

“Get students with disciplinary action(s)...” dialog, which appears when the user selects 
“Discipline...” from the Data menu. 644

“Get students with alternate assessment(s)...” dialog, which appears when the user selects 
“Alternate assessment...” from the Data menu. 645

“Find created or modified records...” dialog, which appears when the user selects “Last 
modified on...” from the Data menu. 646

Dialog for specifying the “other” or “alternate” year to be displayed in the browse window. 
This dialog appears when the user selects “Other year services” from the Data menu, 
when the current year is being shown. 648

Browse window, showing the Services context, after switching to an alternate (“other”) 
year from the Data menu. 649

Print request dialog from the Services context (student services in upper list, which has the 
current focus; teachers in the lower list). To display the Quick Report Editor, select the 
first option and press the OK button. 722

Quick Report Editor, when creating a new report from the Services context. 723

Quick Report Editor, showing the appearance after selecting four fields by dragging them 
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 1 Overview

[rev. 12.2005]

SELPA Manager is a computer program which facilitates the collection and 
maintenance of information about special education students, providers, and 
associated services. It is available in single-user and multiple-user editions, 
and will run under the following computer operating systems: Windows 
98/ME, Windows 2000/XP, and Macintosh Systems 9.2.1 and above. On 
Macintosh OS X, SELPA Manager versions below 4.75 run in Classic 
mode; versions 4.75 and above run in native mode.

One of the program’s key features is the ability to prepare student-level 
(pupil count) information in an electronic (paperless) format that is 
compatible with the California Special Education Management Information 
System (CASEMIS). With this feature, SELPA Manager users are able to 
validate and then submit pupil count information to the California 
Department of Education, Special Education Division, via electronic mail or 
other electronic media. 

The Department of Education requires that Special Education Local Plan 
Areas (SELPAs) submit student-level information electronically, twice per 
year. The data submissions allow the Department to monitor special 
education programs statewide, on a continuous basis, for better planning, 
policy making, and administration.

Another key feature of SELPA Manager is the ability to maintain separate 
data files at the school site or district offices throughout the SELPA. When 
a CASEMIS submission is due, persons using SELPA Manager single-user-
edition may each generate an export file, which can be transferred 
electronically to a central-office user of SELPA Manager, who then submits 
the aggregated student-level data to the Department of Education.
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Alternately, some SELPAs may prefer the client-server (multi-user) edition 
of SELPA Manager, where district-level users can directly update the 
student-level information. The central-office user can then submit the 
aggregate information for CASEMIS, without the need to first perform 
imports from other SELPA Manager users.

A user of SELPA Manager can also generate an export file for another 
SELPA Manager user, when one or more students transfer to another 
district. The program also permits internal district-to-district transfers, 
which may prove convenient for an office of education that manages many 
districts. 

Other transfer options available within the program include one for the 
determination of MediCAL eligibility; the “CSIS LEAL LC” export and 
import pair, to obtain state-assigned SSID numbers for the students; and an 
export file for the Aeries Software special education module.

SELPA Manager can maintain “internal” districts or “sub-districts” and 
their associated schools, for which the program can report student services 
through another, “official” district to CASEMIS. These internal districts 
may be useful for maintaining information on county-served, special 
education programs and other shared academic activities.

SELPA Manager reads a variety of import file formats, for compatibility 
with CASEMIS and for reading student information from other educational 
software programs.

An additional feature of the program is the capability for teachers, 
counselors, therapists, and other student service providers to enter new or 
maintain existing Individual Education Plans (IEPs) for their students. At 
present, SELPA Manager contains custom IEP form sets for roughly twelve 
California SELPAs. In addition, there are three more “default” IEP form sets 
that may be selected for use. Two of the default form sets are the products 
of a state-wide IEP standardization committee.

The administrator can optionally place program users into one of two 
limited-access groups, for teachers or for counselors. Group members are 
restricted to a simpler, browse-list interface for adding and editing IEPs. In 
this case, the non-IEP areas of the program are mostly inaccessible. 



           
By entering a new IEP for a student that is not already listed in the program, 
the user simultaneously creates a new student record, when the IEP forms 
are saved. The program will copy demographic and similar information 
from the IEP forms into the new student record. 

A new or revised IEP for an existing student record can update the existing 
student (e.g., a change to the next IEP date or address information). To 
reduce the potential for data entry and other errors, however, IEP updates 
from limited-access users do not directly change the corresponding fields for 
the student. Instead, a user who is not in a limited-access group must first 
approve the changes.

Program users with any level of read-write access can also enter IEP 
information over the web, using a standard web browser such as Internet 
Explorer, FireFox, or Safari. Most IEP changes performed on the web must 
then be approved by a non-limited-access user, before the program will 
update the corresponding student record. 

SELPA Manager is the product of several years’ worth of practical 
experience among the SELPAs that have participated in its development, 
and who continue to use it for their data-collection activities. The program 
provides forms for collecting the information needed by the California 
Department of Education, as well as additional student information that 
participating SELPAs have found to be useful over the years. 

Organization of this manual
This guide is organized approximately in the order that a school district-
level or a central-office user might begin using a new copy of SELPA 
Manager. 

First there are step-by-step instructions for installing SELPA Manager on 
your computer, and for entering license numbers. Next is a summary of the 
major forms used in the program: the browse window for finding and adding 
records; data entry forms; and dialog boxes. We then present a discussion 
how to configure SELPA Manager for your SELPA, and how to set personal 
preferences.
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The next few chapters discuss data entry into the various sections of the 
program. These chapters are organized approximately into the order in 
which you would add new content: districts, schools, teachers and teacher-
related information, students, student services, goals, disciplinary actions, 
assessments (IEPs), transitions, and other (auxiliary) information.

The chapter dealing with assessments contains a section addressing the 
simpler browse interface that can be made available for teachers, counselors, 
and other service providers.

Following the chapters on data entry, there is a discussion of the items in the 
main program menus. Particular emphasis is placed on the batch operations 
in the Actions menu.

Another chapter presents the web-based IEP interface to SELPA Manager.

Finally, there are appendices illustrating the table and field structure (the 
“data dictionary”); import specifications; and showing the use of certain 
standard program components: the Query Editor, the Quick Report Editor 
(an ad hoc report generator), and 4D Write (for word processing within the 
program, and for mail-merge type operations such as preparing form letters 
to parents).

Student-level information (pupil counts)
Pupil count is more than counting students. It is a means of gathering 
information to monitor performance and development of special education 
students. By observing trends in disabilities, services provided, the number 
of students being served, the age brackets of students, and other parameters, 
a SELPA may tailor its special education program to fit the needs of the 
students in its area.

All special education students in California must have an Individual 
Education Plan (IEP). This plan specifies the program services to be 
provided so that the student will grow emotionally, academically, and 
physically. The preparation of a relevant IEP depends heavily upon having 
accurate information from the pupil count. The more accurate the counting 
is, the more assured we can be that the students are receiving the appropriate 
services they need for a proper education.



                     
Students have varying disabling conditions which make them eligible for 
special education services. All special education students must be 
categorized by age and primary disabling condition.Other important 
classification information includes the student’s ethnicity; whether s/he will 
need special transportation; and whether s/he will need services in addition 
to those necessitated by the primary disabling condition.

The information that the SELPA collects on its special education students is 
compiled and sent to the California Department of Education, which, in 
turn, combines the information with student information from other 
SELPAs in California.

Collecting student-level information: an example
The system in place for the Mendocino County SELPA provides an example 
of how student-level information can be maintained.

A special education student receives annual evaluations, also referred to as 
IEP meetings, and an additional evaluation that takes place every three years 
(three-year evaluation). The IEP for the student identifies the services that 
are to be provided, and the sequence in which they are to occur.

The key individuals responsible for managing student-level information 
include:

• Case Carrier: the individual responsible for monitoring a particular 
student’s progress.

• Pupil Count Operator (the Operator): a professional charged with 
entering a student’s IEP service information into the pupil count system.

• Provider: teachers and other professionals assigned to teach the special 
education student the skills needed to attain the goals specified in the IEP. 
The Operator must ensure that the Case Carrier receives a copy of the 
student’s IEP information in time for the student’s next IEP meeting.

The flow of student-level information at the Mendocino SELPA occurs 
in the following manner:

1 Distribute student-level forms

• To Case Carriers
Input, Update, Drop Forms
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• To Transportation Department, Special Education Director, Business 
Manager
Specific forms as required

Operators are responsible for printing and distributing the student-level 
forms. These forms may include Input, Update, and Drop Forms; Caseload 
Reports; Transportation Reports; and other items as required. The Operators 
distribute the forms to Case Carriers and to certain other persons who 
require information: the District Special Education Director, District 
Business Manager, SELPA Director, SELPA Pupil Count Manager, and the 
SELPA Fiscal Agent from the Mendocino County Superintendent of 
Schools.

2 Update

• Case Carriers verify student information
Return student information to operators with corrections, if any.

3 Input

• Operators update student records on computer
Distribute, Update, and Input steps are repeated as needed.

The Case Carriers must verify the student information and make changes as 
necessary according the student’s Annual or Three Year Review IEP. The 
Case Carriers return these updated forms, or new input forms (for a first-
time student) to the Operators. Operators then update/input the revised/new 
information into the pupil count system.

4 Repeat

• Repeat distribute and update as needed
Beginning of each new year, new student, IEP meeting, Exiting student, 
etc.

Each district/Operator establishes a routine to minimize the amount of 
ongoing work. Most find it easier to make periodic updates, rather than 
waiting until they have a larger backlog of changes. Updating the 
information regularly allows the Operator to catch errors in the data prior to 
the State reporting deadlines.

5 Print

• Monthly Caseload Reports-Last week of the month
Distribute to Case Carriers and Providers



             
Once the information has been updated in the computer, the Operator prints 
the Caseload Reports and distributes them to the providers in November, 
December, March, April, May and June. A Caseload Report lists the 
students that are receiving services from a particular provider.

6 Correct Caseloads

• Update Computer Student Records

The providers verify their caseloads and make changes as necessary. They 
return their Caseload Reports to the Operators. The Operators make changes 
as necessary, keeping in mind that the student information in the computer 
must match that listed on the IEP. Monitoring the accuracy of student 
information is the responsibility of the Case Carrier. If a problem is 
recognized, the Operator should notify the Case Carrier. The Case Carrier 
and Provider work together to ensure that the IEP is being followed.

7 Transfer

• Information via e-mail, regular mail (on disk) or modem
Signed report(s) due to the SELPA office NO LATER than the 5th of 
November, December, March, April, June, and July 

All of the student information is then prepared for transfer either to the 
district office, or to the SELPA office. Our Pupil Count system prepares an 
Export set of files, which are sent via e-mail, regular mail (on disk) or 
modem. All student information must be in the SELPA office by the 5th of 
November, December, March, April, June, and July. The districts are 
responsible to set up their process to be sure that this is done.
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 2 Installing SELPA Manager

[rev. 12.2005]

This chapter covers the installation of SELPA Manager onto your computer. 
Separate sections discuss the installation onto Windows-based PCs and onto 
Macintosh. There are instructions for both single-user and multi-user 
editions.

Program installation instructions
SELPA Manager is available in both single-user (“runtime”) and multi-user 
(“client-server”) editions, for Windows PCs and for Macintosh. The server 
edition, either Windows or Macintosh, can operate in conjunction with both 
types of client workstations (Windows, Macintosh, or both simultaneously).

Be sure that you obtain the correct edition and version of the SELPA 
Manager installation program for your particular computer and deployment 
configuration. 

If you are updating SELPA Manager from an earlier version, then you 
should read the sections, “Major version updates” on page 121, and “Minor 
version updates” on page 123, before installing the updated program. You 
will need to know the location and name of your existing SELPA Manager 
data file. You should save any user/password information that you have 
customized. In some cases, prior to a major version update, data-file 
conditioning steps may be recommended.

In order to reduce the number of steps listed for the multi-user installation, 
this chapter separates the server installation procedure from the client 
installation procedure. You should install the server software before 
installing the client workstation software.
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PC single-user
For the single-user edition of SELPA Manager for Windows, the 
recommended operating system is Windows 2000 or Windows XP. SELPA 
Manager may run on a Windows 98/ME workstation, although the 
configuration is not recommended. However, it will not run under Windows 
3.1. Additionally, the computer should have at least 128 megabytes of 
installed memory. 

SELPA Manager can be installed with the recommended (default) settings 
and location on the “C:” drive, by pressing the NEXT button at each new 
dialog prompt during the installation process, followed by the FINISH 
button.

To install or upgrade the PC single-user edition of SELPA Manager:

1 Launch your web browser program (Internet Explorer, Firefox, etc.) and 
go to the SELPA Manager download page.

At present, the URL is “www.ladue.com/fsnbeta.html”, and the portion after 
the slash is case-sensitive. If you cannot find this link, then it may have 
changed. Contact Fusion Technik for assistance.

2 Scroll down on the web page to the downloads section. Find the 
“Windows single-user” category, and click on the link to the latest 
applicable version of SELPA Manager.

If more than one version appears on the page in this category, then the latest 
version of SELPA Manager should have the highest numerical version 
number. The item description will be similar to “SELPA Manager (Windows 
Single-User Runtime v. 4.75x)”, where “x” represents the specific version 
of SELPA Manager.1

3 The web browser may ask you if you want to run the program whose link 
you clicked on. Select the “SAVE AS FILE” button, to place the SELPA 
Manager installer on your hard disk.

1. For example, v. 4.75x  might be v. 4.75045  here and in the discussion which fol-

lows below.



The installer program will download to your computer’s hard disk. Make 
note of the directory into which you saved the installer, so that you can find 
it later (e.g., “My Documents”).

NOTE: If the download takes more than a few minutes, then there may be a 
problem with your connection to the Internet, or with the web-based 
download server. Try the download again in 30-60 minutes. If problems 
persist, contact Fusion Technik for assistance.

4 Exit from the web browser, and from any other programs that you might 
have open.

If you have a virus protection program running, you may wish to disable it 
temporarily. Usually, you can double-click or right-click on the virus 
program icon in tray of the Windows Taskbar (next to the clock) and select 
“disable” or “close”.

5 Locate the installer program on disk (from Step 3). Double-click on the 
installer file to execute it.

The program will have a name on disk similar to “Slpa475x_RT.EXE”. 

After the installer starts, the screen will turn to a gradient blue design and 
will display a welcome message (Fig. 2-1).

Fig. 2-1. Welcome dialog for the SELPA Manager installer program (single-user 
runtime, PC), showing the blue gradient background.
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6 Press the NEXT button.

The installer will display a Choose Destination Location dialog (Fig. 2-2), 
prompting you to identify the location on disk where SELPA Manager is to 
be installed. The default path is “C:\Program Files\Fusn_Tek”.

NOTE: For ease in upgrading to newer (future) versions of SELPA Manager, 
it is recommended that you use the default path (folder) for installation. If 
you install to another letter drive and/or to another directory (another 
path), then you will need to remember that path the next time that you 
perform an upgrade.

7 Press the NEXT button.

The installer will display a Backup Replaced Files dialog (Fig. 2-3), which 
asks you whether you wish to make a backup of any existing components of 
SELPA Manager that may exist at the selected install location.

Fig. 2-2. Choose Destination Location dialog for the SELPA Manager installer 
program, which prompts the user to identify the default installation directory (folder).



Fig. 2-3. Backup Replaced Files dialog for the SELPA Manager installer program, 
which prompts the user for the backup directory location.

It is recommended that you allow the program to make this backup, as 
specified, so that you can “roll back” to a previous version of SELPA 
Manager if necessary. If you do not wish for an installer backup to be made, 
you can click on the “No” button.

8 Press the NEXT button.

The installer will display a Select Components dialog (Fig. 2-4), asking you 
to select a component to be installed. By default, SELPA Manager will be 
checked. If you have not previously installed 4D Tools (a data maintenance 
and repair utility), then you should also check the 4D Tools box.1

1. If you already have 4D Tools installed and you are upgrading to a SELPA Manager version
which uses the same version of Tools, then you can leave the “4D Tools” box un-checked. For
information on using 4D Tools, refer to the Appendix, “Using 4D Tools” on page 757.
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Fig. 2-4. Select Components dialog for the SELPA Manager installer program, which 
prompts the user to select a component for installation.

9 Press the NEXT button.

The installer will display a Select Program Manager Group dialog (Fig. 2-
5), asking you to select a name for the Program Manager group for SELPA 
Manager. The default name is “Selpa 4.75 Runtime (4D 2003)”. The 
selected group name will appear under Programs in the Windows Start 
menu.



Fig. 2-5. Select Program Manager Group dialog for the SELPA Manager installer 
program, which prompts the user to select a name for the Program Manager group.

10 Press the NEXT button.

SELPA Manager will present a final, Start Installation dialog before the 
physical installation process occurs (Fig. 2-6).

11 Press the NEXT button.

The installation proceeds. Progress bars will appear on the screen (Fig. 2-7), 
followed by a confirmation message (Fig. 2-8).

12 Press the FINISH button.

The installer program will exit at this point. SELPA Manager is now 
installed on your computer, and should be accessible from the Windows 
Start menu. If desired, you can also make a shortcut on the Desktop to 
SELPA Manager, so that you can double-click on the shortcut to start the 
program. With SELPA Manager installed into the default location, the path 
to the executable file is:

C:\Program Files\Fusn_Tek\SELPA_475_fldr\SelpaMgr_v475.EXE
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Fig. 2-6. Start Installation dialog for the SELPA Manager installer program, which is 
the final step prior to physical installation.

Fig. 2-7. SELPA Manager installer program, progress bars that appear during the 
physical installation.



Fig. 2-8. SELPA Manager installer program, confirmation message after installation 
has completed.

PC client-server (server installation)
For the server computer on a Windows-based system, the minimum 
recommended configuration is Windows 2000/2003 or Windows XP. 
Windows 98 and Windows ME do not provide a sufficiently robust 
environment for the server, and responsiveness of the program will be 
unacceptable.1 

TCP/IP networking is required for communication between the server and 
all workstations. SELPA Manager does not use the Microsoft file-sharing 
protocols for client-server communication; nor does it make use of 
workgroup or domain memberships. 

The server should have at least 192 megabytes of installed (physical) RAM. 
For each workstation beyond two simultaneous clients that will be 
connected to the server, the server computer should be increased by 
approximately two megabytes of installed RAM. 

1. Windows 98 or ME may be used as client workstations, however. 128 megabytes of installed
RAM are recommended. TCP/IP networking should be installed. Refer to “PC client-server (cli-
ent installation)” on page 86.
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It is not recommended that you install SELPA Manager on an existing 
Windows server that is running other applications which may require 
significant processing time. Possible examples include a primary domain 
controller, a web server, a mail server, or application servers running other 
database programs. Because the 4D database engine powering SELPA 
Manager uses its own, internal threading mechanism for apportioning 
processor time, SELPA Manager may degrade the performance of other 
applications that are running simultaneously on the same server. If a shared 
installation is required, however, there are some internal parameters that 
may be adjusted to improve processor sharing among applications.1

NOTE: Certain steps listed below are required for new installations only, or 
are required when performing a major version update (refer to “Major 
version updates” on page 121). Major version updates are denoted in the 
steps that follow as “major updates”.

To install or update the PC client-server edition of SELPA Manager:

1 (New and major updates only) Purchase a 4D Server license and 
associated expansion licenses from 4D, Inc.

SELPA Manager presently runs on the 4D Server 2003 application. If you 
do not already have licenses for 4D Server 2003, then you must purchase 
them. Server software should be purchased from 4D, Inc. (408 557-4600 or 
online at www.4d.com), prior to continuing the SELPA Manager 
installation. 

The required item for the installation is:

• 4D Server 2003 Runtime (Windows platform, includes 2 4D Client 
connections)

Optional items include: 

• 4D Client 2003 1 User (for one additional 4D Client connection)

• 4D Client 2003 5 User (for 5 additional 4D Client connections)

• 4D Client 2003 10 User (for 10 additional 4D Client connections)

• 4D Write 2003 1 User

• 4D Write 2003 5 User

• 4D Write 2003 10 User
1. Contact Fusion Technik for assistance.



• 4D Server 2003 Web Extension

At a minimum, you will need the 4D Server 2003 Runtime for Windows. 
The other items are optional. Ensure that you purchase 4D Server 2003 
Runtime and not 4D Server 2004 Runtime, which is a newer release of the 
same product.

Your decision to purchase any of the 4D Client items will depend upon how 
many simultaneous connections to the server you anticipate. The basic 4D 
Server 2003 Runtime has the capability of connecting to two client 
workstations simultaneously. When a third client workstation attempts to 
connect to the server, the server will inform the client that the maximum 
number of connections has been reached, and to try again later. 

If you anticipate simultaneous access by more than two users, then you 
should consider purchasing the 4D Client 2003 1, 5, or 10 User expansion 
product licenses from 4D, Inc. You can also purchase additional licenses at 
a later time, should your connectivity needs grow.

You may also want to purchase expansion product licenses for 4D Write, a 
plug-in which allows connected users to prepare generic word processing 
forms with “mail-merge” capabilities.1 

SELPA Manager has certain, limited web-serving functions. When enabled, 
these functions allow users with a web browser such as Navigator, Internet 
Explorer, Firefox, or Safari to create or edit IEPs for students. They may also 
create a new student record in conjunction with a new IEP; or edit IEP notice 
information. If you desire to make use of these features, then you should 
purchase the 4D Server 2003 Web Extension2). 

If you do not purchase the web license but nonetheless wish to use the web 
capabilities occasionally, then the web functionality can be activated in a 
demonstration mode for up to 60 minutes. After 60 minutes, the server 
software must be restarted before web services can be used again (for 
another 60 minutes).

2 Register your 4D Server software to obtain Serial Numbers.

1. The 4D Write plug-in is a standard component of the v. 4.75xx, single-user runtime of SELPA
Manager. However, it must be purchased separately for the client-server version of the program,.

2. Ensure that you purchase this license for 4D Server, rather than for 4th Dimension or 4D Cli-

ent.
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For purchases made from the 4D, Inc., online store, the company does not 
typically ship the product in boxes. Instead, you will receive Product ID 
number(s) by return email. If you order 4D products by phone or by postal 
mail, then 4D may ship the server components to you as boxed CDs, 
accompanied by product registration cards imprinted with the Product ID 
number(s). An illustration of the top of a 4D Server card is shown in Fig. 2-9.

Fig. 2-9. Top portion of a 4D Server 2003 license card, illustrating a portion of the 
Product ID number (valid numbers are longer than the number shown).

Please do not install any of the software that arrives on CDs from 4D, Inc. 
Fusion Technik includes the appropriate 4D Server software with the 
SELPA Manager installers, as outlined in subsequent steps of these 
instructions.

You must register with 4D, Inc., to obtain Serial Number(s) for the Product 
ID number(s). These serial numbers are needed to un-lock the 4D Server 
software, during installation. You can register online, using a web browser, 
at www.4d.com/register.

Fig. 2-10 is an illustration of the web-based form for entering customer 
information and the Product ID numbers. 



Fig. 2-10. Web-based form on www.4D.com/register, for registering 4D Product ID 
numbers.

Upon submission of this registration form, 4D, Inc. supplies the 
corresponding Serial Number on a web-based form (Fig. 2-11). Print the 
return form for your records. Copy down the serial number in case you lose 
the printed form, and store it in a separate location.

The return form allow also allows you to enter additional Product ID 
numbers. In the event that you purchased any of the optional items in Step 
1, then these items should be entered now, by clicking on the link, “Register 
Expansion Products for a 4D Server...”. 4D, Inc. will return serial numbers 
for each of the optional items. These serial numbers are linked to the base 
Product ID number of the 4D Server itself.
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Fig. 2-11. Web-based confirmation form on www.4D.com/register, returning the serial 
number for a 4D Server registration (the numbers shown are not valid, for illustration 
purposes only).

NOTE: 4D, Inc. may consider the Product ID number(s) associated with a 
4D Server purchase to be your proof of purchase. Keep these numbers in a 
safe place. If you received the 4D software on CD, make copies of the 
registration cards. Record the Product ID numbers for your notes, and place 
these items in a secure (back-up) location. If you lose one or more Product 
ID numbers, and there are no other records of the purchase, then 4D, Inc., 
may require that you purchase your 4D Server licenses again!

3 Go to the SELPA Manager download page, on the Web.

At present, the URL is “www.ladue.com/fsnbeta.html”, and the portion after 
the slash is case-sensitive. If you cannot find this link, then it may have 
changed. Contact Fusion Technik for the location of the download page.



NOTE: If you cannot use the server computer for web access, then you may 
want to download the installer program to another computer, and then 
transfer it to the server via file sharing.

4 Scroll down on the web page to the heading, “Server - PC (4.75 versions 
with 4D 2003”.

5 (New and major updates only) Click on the latest applicable version of 
SELPA Manager that is indicated as a “full installation” and contains the 
version of 4D Server for which you are licensed.

For SELPA Manager 4.75x running with 4D Server 2003, the full installer 
link will appear as “SELPA Manager (Windows Server v. 4.75xx, full 
installation with 4D 2003.x” (or similar), and is approximately 40-45 
megabytes in size.1 

NOTE: A serial number for 4D Server 6.7, 4D Server 6.8, or 4D Server 2004 
does not allow you to run 4D Server 2003, and vise-versa. Be certain that 
you have the correct license number(s).

6 (New and major updates only.) The web browser may ask if you want to 
run the program whose link you clicked. Select the “SAVE AS FILE” 
button, to place the installer on your hard disk.

The installer program will download to your computer’s hard disk. Make 
note of the directory into which you saved the installer, so that you can find 
it later.2 After the download has completed, proceed to Step 7.

NOTE: If the download takes more than several minutes, then there may be 
a problem with your connection to the Internet, or with the remote web 
server. Try the download again in 30-60 minutes. If problems persist, 
contact Fusion Technik for assistance.

7 Under the “Server-PC” heading, click on the latest applicable version of 
SELPA Manager that is indicated as a “structure only” update3 installer.

This item will have a link name similar to “SELPA Manager (Windows v. 
4.75xx, structure only, updates the 4.75xx full installation).” Normally, the 
update installer is in the range of 15-20 megabytes in size. 

1. At this writing, in November, 2004.
2. The name of the full installer on disk should be “SLPAsrv_475039.EXE” or similar.
3. Structure  in this context refers to the compiled SELPA Manager program structure, as dis-

tinguished from the 4D Server / 4D Client software and the data file.
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Ensure that you select a structure-only update installer that is compatible 
with the full installation version that you have previously downloaded (in 
Step 5, above). Any full installation for which the version number is below 
4.75 cannot use a structure-only update that is above 4.75, and vise-versa.

Do not download a “structure only” update installer, if it has the same 
version number, or a lower version number, than the full installation. In this 
case, the full installation may be the latest applicable version.

8 The web browser may ask if you want to run the program whose link you 
clicked on. Instead, select the “SAVE AS FILE” button, to place the 
installer on your hard disk.

The installer program will download to your computer’s hard disk. Make 
note of the directory into which you saved the update installer, so that you 
can find it later.1

9 Exit from the web browser program, and from any other programs that 
you might have running.

10 (New installations only.) If you are running Windows 2000 Server on the 
server computer, ensure that the server is optimized for network 
applications rather than for file sharing.

On Windows 2000 Server, this setting can be found by right-clicking to get 
Properties on the Local Area Connection icon, in the Network and Dial-Up 
Connections Folder, in Control Panels. 

Windows will display the Local Area Connection Properties window. 
Highlight the “File and Printer Sharing for Microsoft Networks” item, and 
press the PROPERTIES button. Windows will display the dialog shown in 
Fig. 2-12.

If it is not already selected, check the box labeled “Maximize throughput for 
network applications.”

NOTE: When you change this setting, Windows may require you to re-start 
the server.

1. The name of the update installer on disk should be “SLPAsr1_475xx.EXE”, where “xx” rep-
resents the specific version of SELPA Manager contained in the update installer.



Fig. 2-12. Maximizing throughput for network applications (rather than file sharing) 
in Windows 2000 Server.

11 (Major updates only1.) Run the version of 4D Tools that matches your 
existing data file, to perform a Recovery (Recover by Tags).

This step is applicable only if you have been using a version SELPA 
Manager prior to 4.701, prior to installing this (the update) version, and will 
be carrying forward with your previous data. 

In this case, you should run 4D Tools 6.0.6 on the previous SELPA Manager 
installation, before using the earlier data file with the current version. 4D 
Tools should have been installed on the server computer with your earlier 
copy of SELPA Manager. 

Additional discussion of this operation appears under “Major version 
updates” on page 121, and in the Appendix , “Using 4D Tools” on page 771. 
Be certain that you are using the correct version of 4D Tools for your data 
file (refer to Fig. E-1 on page 758).

1. If the update is from SELPA Manager v.4.7x to 4.75x, then Step 11 can be skipped (the data
file format is the same among these versions).
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12 (New and major updates only.) Find the SELPA Manager “full installation” 
installer program on disk, that you downloaded in Step 6. Double-click on 
it to run the installer.

The program will have a name on disk similar to “SLPAsrv_475xx.EXE”.

When the installer is running, the screen will turn to a gradient blue design 
and will display a welcome message (Fig. 2-13).

Fig. 2-13. Welcome dialog for the SELPA Manager installer program (client-server 
edition, PC), showing the blue gradient background.

13 (New and major updates only.) Press the NEXT button.

The installer will display a Choose Destination Location dialog (similar to 
Fig. 2-2, in the example for the single-user installer), prompting you to 
identify the location on disk where SELPA Manager is to be installed. The 
default path is “C:\Program Files\Fusn_Tek”.

NOTE: For ease in upgrading to newer (future) versions of SELPA Manager, 
it is recommended that you use the default path (folder) supplied for 
installation. If you install on another drive (to another path), then you will 
need to remember that path the next time that you perform an update.

14 (New and major updates only.) Press the NEXT button.



The installer will display a Backup Replaced Files dialog (similar to Fig. 2-
3, in the example for the single-user installer), which asks you whether you 
wish to make a backup of any existing components of SELPA Manager that 
may exist at the selected install location.

It is recommended that you allow the program to make this backup, as 
specified, so that you can “roll back” to a previous version of SELPA 
Manager if necessary. If you do not wish for a backup to be made, you can 
click on the “No” button.

15 (New and major updates only.) Press the NEXT button. Check the “Selpa 
Manager Server” and “4D Tools” boxes.

The installer will display a Select Components dialog (Fig. 2-14), asking 
you to select a component to be installed. You should check the “Selpa 
Manager Server” box. Also, it is recommended that you install 4D Tools 
(check the “4D Tools” box). The other check boxes represent items that are 
intended for client workstations only.

Fig. 2-14. Select Components dialog for the SELPA Manager installer program (client-
server edition, PC).

16 (New and major updates only.) Press the NEXT button.
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The installer will display a Select Program Manager Group dialog (similar 
to Fig. 2-5, in the example for the single-user installer, except that the 
default group name is different). The dialog prompts you to select a name 
for the Program Manager group for SELPA Manager. This is the name that 
will appear under Programs in the Windows Start menu.

17 (New and major updates only.) Press the NEXT button.

SELPA Manager will present a final confirmation dialog before the physical 
installation process occurs.

18 (New and major updates only.) Press the NEXT button.

The installation proceeds. Progress bars will appear on the screen, followed 
by a confirmation message when the installation is finished.

19 (New and major updates only.) Press the FINISH button.

The full installer program will exit at this point. The server computer will 
now have 4D Server 2003, the SELPA Manager program files, and related 
utilities installed on its hard disk.

20 If applicable, find the SELPA Manager “structure only” installer file on 
disk, that you downloaded in Step 7. Double-click on it to execute the 
installer program.

The program will have a name on disk similar to “SLPAsr1_475xx.EXE”. 

NOTE: If you did not download a “structure only” update, then skip this 
portion of the installation. Proceed to Step 28, below, to make Desktop 
shortcuts.

When the installer program is running, the screen will turn to a gradient blue 
design and will display a welcome message (Fig. 2-15).



Fig. 2-15. Welcome dialog for the SELPA Manager update installer program (client-
server edition, PC).

21 Press the NEXT button.

The installer will display a Read Me File dialog, similar to the one depicted 
in Fig. 2-16. The dialog presents information pertaining to recent updates to 
SELPA Manager.

Fig. 2-16. Read Me File dialog, for the SELPA Manager update installer program 
(client-server edition, PC).
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22 Press the NEXT button.

The installer will display a Choose Destination Location dialog (similar to 
Fig. 2-2, in the example for the single-user installer), prompting you to 
identify the location on disk where SELPA Manager is to be installed. The 
default path is “C:\Program Files\Fusn_Tek”.

NOTE: If you installed the previous version of the server (or performed the 
“full installation,” in previous steps) to a different path, then you will need 
to specify that path now, so that the previous version can be updated.

23 Press the NEXT button.

The installer will display a Backup Replaced Files dialog (similar to Fig. 2-
3, in the example for the single-user installer), which asks you whether you 
wish to make a backup of any existing copy of SELPA Manager that may 
exist at the selected install location.

It is recommended that you allow the program to make this backup, as 
specified, so that you can “roll back” to a previous version of SELPA 
Manager if necessary. If you do not wish for a backup to be made, you can 
click on the “No” button.

24 Press the NEXT button, and check the “Selpa Manager Structure” box.

The installer will display a Select Components dialog (Fig. 2-17), asking 
you to select a component to be installed. By default, “SELPA Manager 
Structure” is the only component, and is already checked for installation.

If you do not check any box on the Select Components dialog, the 
installation will appear to proceed, but no program files will be installed on 
the server.



Fig. 2-17. Select Components dialog for the SELPA Manager update installer program 
(client-server edition, PC).

25 Press the NEXT button.

SELPA Manager will present a final, Start Installation dialog before the 
physical installation process occurs (Fig. 2-18).

26 Press the NEXT button.

The installation proceeds. Progress bars will appear on the screen, followed 
by a confirmation message when the installation is finished.

27 Press the FINISH button.

The installer program will exit at this point. The SELPA Manager program 
files on the server computer are now updated.
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Fig. 2-18. Start Installation dialog for the SELPA Manager installer program (client-
server update, structure only), which is the final step prior to physical installation.

28 (New and major updates only.) If desired, make new or replace existing 
shortcuts on the Desktop to the SELPA Manager program, to 4D Server, 
and to 4D Tools.

The current “full” installers for SELPA Manager should create these 
desktop shortcuts for you automatically. In this case, this step may be 
skipped.

Example paths for which shortcuts should be made are (assuming default 
install directories):

1. SELPA Manager Structure:
C:\Program Files\Fusn_Tek\Selpa_475_fldr\Selpa_Mgr_v475.4DC

2. 4D Server:
C:\Program Files\Fusn_Tek\4D Server 2003\4DServer.exe

3. 4D Tools:
C:\Program Files\Fusn_Tek\4D Tools 2003\4DTools.exe

If you have existing shortcuts on the Desktop to the previous version(s) of 
SELPA Manager, 4D Server, and 4D Tools, then you should delete them at 
this time.



NOTE: If you cannot see the “.4DC” extension at the end of the file name, 
then you may need to enable the display of file type extensions. In Windows 
98, select Views menu -> “Folder Options...” In Windows XP, select Tools 
menu -> “Folder Options...” 

When Windows displays the Folder Options dialog, click on the second tab 
(View, Fig. 2-19). Ensure that the box, “Hide file extensions for known file 
types” is not checked. Also ensure that the radio button, “Show all files” is 
selected.

Fig. 2-19. Views tab of the Folder Options dialog, Windows XP, with settings that 
permit file type extensions to be displayed.

29 (Major updates only.) If necessary, copy or move the previous data file 
into the “SELPA_475_fldr” directory.

Find the previous data file (*.4DD) and its companion, the data resource file 
(*.4DR), which you may have re-created (recovered) in Step 11 using 4D 
Tools. If this pair of files is not already in the SELPA_475_fldr directory, 
then copy or move the two files to the SELPA_475_fldr directory now.
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You can first select and then right-click on the data file and the data resource 
file in their original location. Select “Copy” or “Cut” from the contextual 
menu. Then right-click on top of the “C:\Program Files\Fusn_Tek\ 
SELPA_475_fldr” folder, and select “Paste” from the contextual menu. This 
action will copy or move the recovered data file into the new database folder.

30 (New installation only.) If a SELPA Manager data file has been prepared 
in advance on a separate, single-user installation, then place the data file 
and the data resource file into the following location:

C:\Program Files\Fusn_Tek\SELPA_475_fldr

You should place both files into the “SELPA_475_fldr” path (refer to the 
copy-paste instruction in Step 29, above). Fig. 2-20 illustrates the 
appearance of the “SELPA_475_fldr” directory after pasting in the 
recovered (Step 29) or prepared (Step 30) data file. The directory contains 
three folders (“Mac4DX”, “Html”, and “Win4DX”); the SELPA Manager 
program (“Selpa_Mgr_v475.4DC” and “Selpa_Mgr_v475.RSR”); and the 
two data file components.

Fig. 2-20. Appearance of the “SELPA_fldr” after pasting in the recovered data file 
(“TUSD_2003.4DD” and “TUSD_2003.4DR”).

31 Start the 4D Server application, by double-clicking on the desktop 
shortcut to 4D Server.



New and major updates only: When 4D Server 2003 starts for the first time 
on a “new” hard disk, the program will present a license agreement. To 
proceed, you must click on the “I agree” button and then press the NEXT 
button (Fig. 2-21). 

Fig. 2-21. 4D Server 2003 license agreement.

The program then will present a dialog, prompting you for your name, your 
company name, and the 4D Server serial number (“Serial Number” in Fig. 
2-22). You may use any name and company name that you wish. 

Fig. 2-22. 4D Server 2003 license number entry dialog. 
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For the serial number, use the long alphanumeric code obtained during the 
registration of 4D Server, in Step 2. Do not enter the serial number(s) for any 
of the optional (expansion) products at this time.

The 4D Server serial number is case-sensitive. Characters that resemble the 
lowercase “L” character or a numeric “1” character may actually be a capital 
“i”. If the code is not entered correctly, the program will not allow you to 
proceed. 

You can also press the DEMO button to operate 4D Server temporarily in 
demonstration mode, but in this mode the program restricts the number of 
records that can be entered to 50 in each table.

New and existing installations: At this point, 4D Server will present an 
“open a database/create a database” dialog, prompting you to specify the 
database to be opened (Fig. 2-23).

Fig. 2-23. 4D Server open/create database dialog, prompting you to specify which 
database to open.



32 Select SELPA Manager as the database to be opened.

Press the CHOOSE button next to the “Other database” label. 4D Server will 
present a standard, open file-type dialog (“Open a 4D database,” Fig. 2-24). 
Select the file on disk named “Selpa_Mgr_v475.4DC”. The default path to 
this file, as noted earlier, is:

C:\Program Files\Fusn_Tek\SELPA_475_fldr\Selpa_Mgr_v475.4DC

Fig. 2-24. 4D Server, standard open-file dialog for selecting a database (structure file).

You may find it easiest to navigate in the open file dialog to the Desktop, and 
from there double-click on the shortcut to “Selpa Manager Structure” that 
you created previously.

NOTE: Ensure that the “Files of type:” list has “All files (*.4db, *.4dc) 
shown, or “Compiled database (*.4dc)” shown, rather than “Structure file 
(*.4db)”. If the latter is selected rather than one of the other two, then you 
won’t be able to locate the SELPA Manager program on disk.

33 Select the data file that is to be opened in conjunction with SELPA 
Manager.

4D Server will prompt you with another open file-type dialog (“Open,” Fig. 
2-25), for selecting the data file.
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If you have an existing data file, or if you have prepared one in advance on 
another computer, then you should use the dialog to locate the data file 
component on disk that has the suffix “.4DD”. 

Fig. 2-25. 4D Server, standard open-file dialog for selecting a data file.

NOTE: If your data file was running with a version of SELPA Manager 
earlier than 4.701, then be certain that you followed Step 11 (above), and 
that you read the section, “Major version updates” on page 121, BEFORE 
opening the data file with the current version of SELPA Manager.

If you are starting from scratch, then you may create a new data file by 
pressing the NEW button on the dialog. In this case, 4D Server will prompt 
you to select a data file name. If, for example, you select the name “Central” 
for your data file, then 4D Server will create two files on disk, with the 
names “Central.4DD” and “Central.4DR”.

If you have a data file that has exactly the same prefix as the SELPA 
Manager program (“structure”) file, and is located in the same directory, 
then 4D Server may open that data file automatically, without displaying 
Fig. 2-25. For example, because the SELPA Manager program file is named 
“Selpa_Mgr_v475.4DC”, if you have two files in the same folder on disk 



with the component names “Selpa_Mgr_v475.4DD” and 
“Selpa_Mgr_v475.4DR”, then 4D Server may open the data file 
automatically.

On subsequent re-starts, 4D Server will re-open the same data file that you 
selected in this step — unless the path to the data file changes, or you install 
another update to SELPA Manager. Therefore, it will not display the “Open” 
(data file) dialog of Fig. 2-25 again. However, you can force SELPA 
Manager to present the “Open” dialog on any 4D Server start-up, by holding 
down the [ALT] key after selecting the database in Fig. 2-24.

Once 4D Server is running, you will see one main process window and two 
smaller windows on your monitor (“4D Server”, “Backup Scheduler”, and 
“Restore Log”, refer to (Fig. 2-26). The main (“4D Server”) window 
displays a list of “Users”. The user named “Kernel” includes three rows 
(processes) with the names, “User interface”, “Client Manager”, and “Cache 
Manager”. If you are updating an existing data file from a previous version 
of SELPA Manager, then you may also see a fourth process listed, for 
indexing fields.

Fig. 2-26. 4D Server in operation, showing the main window (“4D Server”) and the 
two auxiliary windows (“Backup Scheduler” and “Restore Log”).

34 (New and major updates only.) From the Backup menu, select “Full 
backup...”
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4D Backup is a component of 4D Server. When configured, it can maintain 
a log of all changes made to the data file, and will make a copy of the data 
to another location on disk at prescribed intervals.

When this menu item is selected, 4D Server will present the Full Backup 
dialog (Fig. 2-27). 

Fig. 2-27. Full Backup dialog, displayed by 4D Server when you select “Full 
backup...” from the Backup menu.

35 (New and major updates only.) Select a destination volume by clicking on 
a hard drive icon.

The destination volume should be a local hard drive or hard drive partition 
with sufficient space on it to accommodate somewhat more than five copies 
of the data file (*.4DD and *.4DR) plus the structure file (*.4DC and 
*.RSR).1 For example, if the size of your data file plus the structure on disk 
is 60 megabytes, then you should have more than 300 megabytes available 
to accommodate five sets of backups.

NOTE: If you select the drive for the backup to be the same drive on which 
the data file is located, then 4D Server will present a warning message. 
Press the OK button to acknowledge the warning.

1. You can specify the number of rotating data file copies that 4D Backup will maintain as the
“number of sets,” in the lower-left portion of the dialog. The default number is five for 4D Server
2003. As an example, suppose that the program makes daily backups at 2:30 am, starting on
Monday morning. On Saturday morning, it will replace the backup made on Monday morning,
so that a total of five “sets” are maintained.



When selecting the destination volume, avoid using a removable media 
(cartridge, CD, or DVD) drive that will spin down after a certain period of 
idle time. If the drive is not spinning at the time that 4D Backup is ready to 
perform the backup operation, then the backup may fail. Once 4D Backup 
has failed, it requires resetting (by performing another manual backup) 
before it can perform additional automatic backups.

Similarly, a non-local (network) drive may not be a desirable destination for 
4D Backup to use, because if the program cannot connect due to network 
traffic or some other network availability issue, then the backup will fail. As 
before, 4D Backup will not attempt any further backups until it is manually 
reset.

The most effective way to use a cartridge or a remote drive in conjunction 
with 4D Backup is to subsequently copy the “sets” (which 4D Backup 
creates) to the drive. You can use a Windows batch file or network backup 
software to automate this process, if desired.

It is not recommended that you copy the active data file (in this example, the 
files “Central.4DD” and “Central.4DR”) while 4D Server is running. 
Although 4D Server will allow you to make this copy, the copy may be 
damaged if the server is writing to the file at the same time that the copy is 
in progress.

36 (New and major updates only.) Press the BACKUP button on the dialog.

4D Server will present a “Save as...” dialog (Fig. 2-28), asking for the 
particular location on disk where the backup files (“sets”) are to be stored. 

To minimize clutter, you should avoid storing the backup files directly in the 
“SELPA_475_fldr” directory, where the program itself resides. Instead, you 
can create a special folder (directory) in which to place the backup sets. This 
folder may be a subdirectory inside the “SELPA_475_fldr”.

The backup sets will each have the same prefix (e.g., “Selpa_Mgr_v475”) 
and the same suffix (“.4BK”). However, 4D Backup will increment the 
number of the set each time a new backup is made (“001”, “002”, etc., for 
“Selpa_Mgr_v475001.4BK”, “Selpa_Mgr_v475002.4BK”, etc.).
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Fig. 2-28. “Save as...” dialog, displayed by 4D Server when you press the BACKUP 
button on the Full Backup dialog.

37 (New and major updates only.) Name the backup file on disk and press 
the SAVE button.

After pressing the SAVE button, you will see a series of progress bars 
moving across the display as 4D Backup prepares the first backup set. As the 
backup finishes, 4D Backup will ask you to save the project settings (“Do 
you wish to save the backup parameters in a project”, Fig. 2-29).

Fig. 2-29. Save backup project dialog, displayed by 4D Server after changes are made 
in a 4D Backup configuration.



38 (New and major updates only.) Press the SAVE button, and place the 
backup project into the same directory as SELPA Manager.

The backup project file contains configuration settings for the backup, but it 
contains no backup data. It should be saved into the same directory as the 
program structure (Selpa_Mgr_v475.4DC). If you installed SELPA 
Manager into the default location, then the backup project should be saved 
into this location as well:

C:\Program Files\Fusn_Tek\Selpa_475_fldr

Allow 4D Backup to save the backup project with the default name, 
“Backup.4BP”. After you have saved the project, 4D Server will return to 
displaying the main window and two auxiliary windows (Fig. 2-26).

39 (New and major updates only.) From the File menu, select the item, 
“Select log file...”.

4D Server will present an open file-type dialog, “Open which log file...”.

40 (New and major updates only.) Press the NEW button to create a new log 
file.

4D Server will present a saves as-type dialog (“Log file name:”). In the 
example, the name chosen will be “Central.4DL”. The log file should be 
placed into the same folder where the backup files reside (refer to Step 36).

41 (New and major updates only.) Press the SAVE button to create the new 
log file.

After you have saved the new log file, 4D Server will return to displaying 
the main window and two auxiliary windows (Fig. 2-26).

42 (New and major updates only.) From the Backup menu, select “Full 
Backup...” again.

4D Server will again display the Full Backup dialog (Fig. 2-27), only this 
time you should see three enabled check marks along the left edge of the 
dialog (rather than two): “Data”, “Structure”, and “Log File”. If “Log File” 
is not already checked, then check this box by clicking on it.

43 (New and major updates only.) Press the BACKUP button to perform 
another full backup.

You will again see progress thermometers moving across the screen as 4D 
Backup prepares the backup set on disk. 

44 (New and major updates only.) Save the changes to the backup project.
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As the backup set completes, the program will alert you that the backup 
parameters have been changed, and it will ask if the project should be saved. 
Press the OK button to revise the backup project parameters.

45 (New and major updates only.) Set the Backup Scheduler window for the 
frequency, date, and time of the next backup.

Click on the check box in front of “Backup every (1) day(s)” so that 4D 
Backup will make a new backup set daily. You may set the scheduler to make 
a backup set on a different frequency, if desired.

You can click on the watch icon below the check box to set the time of day 
and the date for the next backup. 4D Backup will display the “Scheduling 
the backup” dialog (Fig. 2-30). 

Ensure that you specify a backup time when users will not be accessing 
SELPA Manager server. If someone is editing a student, or has gone home 
for the day but has left their connection open, with a record open for editing, 
then the backup may not complete successfully.1

Fig. 2-30. “Scheduling the backup” dialog, which appears while configuring the 
Backup Scheduler window.

If desired, you can click on the appropriate boxes to instruct 4D Backup not 
to make a backup set if there are no changes to the data; and to display an 
alert box on the server, if the backup set has failed.
1. From a workstation, the administrator can set an excluded time  in preferences, where SEL-

PA Manager users cannot remain connected to the server. This feature can close 4D Client on

workstations just before 4D Backup commences. Refer to the Chapter, Configuring SELPA

Manager  on page 243 .



46 (New and major updates only.) If you have purchased 4D expansion 
product licenses (additional licenses beyond the minimum of 2 that come 
with 4D Server), then install them at this time.

From the Help menu in 4D Server 2003, select “Update license...”. 4D 
Server displays the license dialog shown in Fig. 2-31. There should be one 
highlighted row in the entry area, containing the 4D Server serial number 
that you entered in Step 31.

Fig. 2-31. License number entry dialog, 4D Server 2003. Serial number shown is for 
illustration purposes only (not a valid number).

Press the ADD button next to the label, “Expansion Serial Number”, and 
enter each additional serial number that you obtained previously, in Step 2.

47 (New and major updates only.) Place the “full installation” SELPA 
Manager installer in a location where it can be used to configure the 
client workstations.

You have configured the server and are now ready to begin installing 
software on the client workstations.The client software is installed from the 
same (full) installer program that was downloaded to the server in Step 5, 
above. 
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You can place the full installer on a network file server that is accessible for 
execution by each client. Alternately, you can transfer the installer to each 
local client hard drive, using file sharing. Another possibility is to burn a CD 
or place the installer on a Zip disk, and then carry the CD or the Zip disk 
from client to client. 

Once you have run the installer on a workstation, there is no longer a need 
to keep the installer file itself on that workstation.

PC client-server (client installation)
For a Windows-based PC client, the recommended configuration is 
Windows 2000 or Windows XP; TCP/IP networking; and at least 128 
megabytes of installed RAM. Windows 98 should also work with the client 
software. However, no versions of the SELPA Manager program are 
configured to run under Windows 3.1. 

If you have not yet installed the server-side software, then you should 
perform that task first (refer to “PC client-server (server installation)” on 
page 57). After completing those steps, you should have the “full” installer 
program available on the local hard drive of the workstation, on a CD or a 
removable cartridge drive, or accessible from a shared folder over the 
network.

With the exception of major version updates to SELPA Manager, where the 
version of 4D Server and 4D Client changes, the workstation (client) 
software generally does not need to be updated each time that you place a 
new version of SELPA Manager onto the server. When a user starts the client 
software from his/her workstation, the client software will recognize if a 
new version of SELPA Manager is running on the server, and take 
appropriate action.

Generally, the 4D Server software on the server computer and the 4D Client 
software on the client workstation should match each other in both major 
and minor version number. For example, 4D Client 2003.4 is recommended 
for connecting to 4D Server 2003.4. 

However, an earlier version of 4D Client 2003 can often connect to a later 
version of 4D Server 2004. For example, 4D Client 2003.4 should be able to 
connect to 4D Server 2003.7. 



You may install the 4D Client software on as many workstations as you 
wish. The licensing limits are determined by the number of SELPA Manager 
users that are connected to the server simultaneously.

To install or update the PC client software:

1 Find the SELPA Manager “full installation” installer program on disk. 
Double-click on it to run the installer.

The original (full) installer program was downloaded in Step 5 of the server 
installation instructions, above.

When the installer is running, the screen will turn to a gradient blue design 
and will display a welcome message (Fig. 2-32)

Fig. 2-32. Welcome dialog for the SELPA Manager installer program (client-server 
edition, PC), showing the blue gradient background.

2 Press the NEXT button.

The installer will display a Choose Destination Location dialog (similar to 
Fig. 2-2, in the example for the single-user installer), prompting you to 
identify the location on disk where the client software is to be installed. The 
default path is “C:\Program Files\Fusn_Tek”.
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For ease in upgrading to newer (future) versions of the client software, it is 
recommended that you use the default path (folder) supplied for installation. 
If you install on another drive (to another path), then you will need to 
remember that path the next time that you perform an update.

3 Press the NEXT button.

The installer will display a Backup Replaced Files dialog (similar to Fig. 2-
3, in the example for the single-user installer), which asks you whether you 
wish to make a backup of any existing components of the client software 
that may exist at the selected install location.

It is recommended that you allow the program to make this backup, as 
specified, so that you can “roll back” to a previous version of the client 
software if necessary. If you do not wish for a backup to be made, you can 
click on the “No” button.

4 Press the NEXT button, and check the “Selpa Manager Client” box.

The installer will display a Select Components dialog (Fig. 2-33), asking 
you to select a component to be installed. You should check the “Selpa 
Manager Client” box. Do not check the “Selpa Manager Server” box or the 
“4D Tools” box, however (these items are for the server-side installation).

Fig. 2-33. Select Components dialog for the SELPA Manager installer program (client-
server edition, PC).



If you will be using the IEP (assessment1) section of SELPA Manager, then 
you may also want to check the “Goals and objectives...” box. This option 
will place an importable set of student performance goals and objectives, in 
text format, onto your hard disk. These goals and objectives can then be 
imported into SELPA Manager and customized. The content will appear in 
the goals and objectives palette (refer to the Chapter, “Student Services and 
Goals” on page 438).

5 Press the NEXT button.

The installer will display a Select Program Manager Group dialog (similar 
to Fig. 2-5, in the example for the single-user installer). The dialog prompts 
you to select a name for the Program Manager group for SELPA Manager. 
This is the name that will appear under Programs in the Windows Start 
menu.

6 Press the NEXT button.

SELPA Manager will present a final confirmation dialog before the physical 
installation process occurs.

7 Press the NEXT button.

The installation proceeds. Progress bars will appear on the screen, followed 
by a confirmation message when the installation is finished.

8 Press the FINISH button.

The full installer program will exit at this point. 

9 If desired, make a shortcut to the 4D Client program and place it on the 
Desktop.

Placing a shortcut on the Desktop gives the user an easy means to access the 
4D Client program. The other method is through the Windows Start menu. 
The default path to the 4D Client program is:

C:\Program Files\Fusn_Tek\4D_Client_fldr\4D_Client.exe

10 Test the connection to the SELPA Manager server.

Follow the directions for starting the client-server version of SELPA 
Manager (refer to “Client-server (multi-user)” on page 136), to ensure that 
the client workstation is capable of “seeing” the server.

11 Repeat these steps for each client workstation that will need to connect 
to the server.
1. Refer to the Chapter , Entering Assessment Information  on page 479 .
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Macintosh single-user
The current, single-user edition of SELPA Manager requires Mac OS 9.2.1 
or later, with CarbonLib 1.4 or above. If OS X is used, v. 10.2.1 or later is 
recommended. The program will run on a G3 or later PowerPC-based 
Macintosh with at least 24 MB of available RAM (OS 9) or 128 MB of 
installed RAM (OS X). SELPA Manager versions 4.75 and above run as a 
native OS X (Carbon) application.

SELPA Manager is not compatible with some versions of RAM Doubler, a 
Macintosh OS 9 utility. If you are using RAM Doubler, it is recommended 
that you reboot holding down the tilde key (“~”) to disable RAM Doubler.

The installation instructions that follow presume an OS X configuration. If 
you are using OS 9, a different installer will be necessary. As another option, 
you can also move the installed files from an OS X Mac to an OS 9 Mac, by 
file sharing or removable media. Contact Fusion Technik if you require an 
0S 9 installer, and one is not already available on the web site.

To install or update the Macintosh single-user edition of SELPA 
Manager:

1 Launch your web browser and go to the SELPA Manager download page.

At present, the URL is “www.ladue.com/fsnbeta.html”, and the portion after 
the slash is case-sensitive. If you cannot find this link, then it may have 
changed. Contact Fusion Technik for assistance.

2 Scroll down on the web page to “Mac single-user” and click on the latest 
applicable version of SELPA Manager.

If more than one version appears on the page in this category, then the latest 
version of SELPA Manager should have the highest numerical version 
number. The item description will be similar to “SELPA Manager 
(Macintosh Single-User Runtime v. 4.75x)”, where “x” represents the 
specific version of SELPA Manager.

3 Your web browser may immediately download the program to the 
Desktop, or it may ask you where to place the installer file on your hard 
disk (in this case, specify a location).



The installer program will download to your computer’s hard disk. Make 
note of the directory into which you saved the installer, so that you can find 
it later.

NOTE: If the download takes more than a few minutes, then there may be a 
problem with your connection to the Internet, or with the web server. Try the 
download again in 30-60 minutes. If problems persist, contact Fusion 
Technik for assistance.

4 Exit from the web browser program, and from any other programs that 
you might have open.

If you have a virus protection program running, you may wish to disable it 
temporarily. 

5 Locate the installer (.dmg) file on your hard disk, and double-click on it to 
expand the installer program.

The installer file will have a name similar to “Selpa475x_RT.dmg”. 

The installer file will display a progress dialog while verifying and 
expanding. When the file is expanded, a “virtual” disk will mount, and a new 
window will appear in the Finder (Fig. 2-34). 

Fig. 2-34. Window and virtual disk for the SELPA Manager installer program (single-
user edition, Macintosh).

6 Double-click on the SELPA Manager Runtime icon, to launch the installer 
program.
Installing SELPA Manager 91 

• 
• 
• 
•
•
•



92  

• 
• 
• 
•
•
•

The installer program will display a new dialog, containing an INSTALL 
button (Fig. 2-35).

Fig. 2-35. The SELPA Manager installer program (single-user edition, Macintosh) 
presents a dialog with an INSTALL button.

7 Press the INSTALL button.

A set of progress bars will appear temporarily, followed by a confirmation 
message that the installation has completed (Fig. 2-36).

Fig. 2-36. The SELPA Manager installer program (single-user edition, Macintosh), 
appearance following successful installation.



NOTE: The installer places files in the Applications folder on disk. If this 
folder is locked to non-administrative users, then you may need an 
administrator’s password on the Macintosh to successfully run the installer.

After the installer quits, you will have a new “SELPA Mgr Runtime” folder 
on disk, inside the Applications folder, containing the SELPA Manager 
program and associated components (Fig. 2-37). The SELPA Manager 
program has a name similar to “Selpa 4.75x RT”, and has a blue cube icon 
with diagonal stripes.

Fig. 2-37. The SELPA Manager program in its installed directory (Macintosh single-
user).

The installer also places a log file and an uninstaller in the directory, 
~user/library/logs. 

WARNING: The uninstaller will remove the “SELPA Mgr Runtime” 
directory and all of its contents. Therefore, the SELPA Manager data file 
MUST be removed BEFORE using the uninstaller, or it too will be deleted. 
It should not be necessary to use the uninstaller, because the program can 
be removed by dragging the “SELPA Mgr Runtime” folder to the trash. 
Ensure that you keep another copy of your data file in a safe location, 
preferably not on the same hard disk.

8 If desired, make an alias on the Desktop to the program.

Highlight the “Selpa 4.75x RT” program icon and select “Make Alias” from 
the File menu. Drag the alias file onto the Desktop. You can now double-
click on the alias to launch SELPA Manager.

9 (Optional) Move your existing data file, if any, into the new folder.
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If you are updating from a previous version of SELPA Manager, and that 
version was installed in a different directory, then you may wish to move 
your existing data file into the new folder. This step is optional; the program 
will run with the data file in another location. However, over the course of 
multiple updates, it may be easier for you to keep the data file with the 
current version of the program.

Macintosh client-server (server installation)
For the server computer on a Macintosh-based system, the minimum 
configuration is a G3 Macintosh with Mac OS 9.2.1 or later, with CarbonLib 
1.4 or above. For Mac OS 9.2.1, the minimum available memory partition 
for running the 4D Server application is 24 megabytes. For Mac OS X, at 
least 128 megabytes of physical RAM must be installed. 

For each workstation beyond two simultaneous clients that will connect to 
the server, the available memory on the server should be increased by 
approximately 2 megabytes of physical RAM. For servers with many 
clients, it is recommended that you disable file sharing and program linking, 
to boost performance.

SELPA Manager will execute as a Carbon application (SELPA Manager 
v.4.75 and later) under Mac OS X. Mac OS X (10.2.1 or later) is 
recommended over OS 9, due to faster disk access. The instructions which 
follow assume an OS X installation.

NOTE: Certain steps listed below are required for new installations only, or 
are required when performing a major version update (refer to “Major 
version updates” on page 121). Major version updates are denoted in the 
steps that follow as “major updates”.

To install or update the Macintosh client-server edition of SELPA 
Manager:

1 (New and major updates only) Purchase a 4D Server license and 
associated expansion licenses from 4D, Inc.



SELPA Manager presently runs on the 4D Server 2003 application. If you 
do not already have licenses for 4D Server 2003, then you must purchase 
them. Server software should be purchased from 4D, Inc. (408 557-4600 or 
online at www.4d.com), prior to continuing the SELPA Manager 
installation. 

The required item for the installation is:

• 4D Server 2003 Runtime (for Macintosh platform, includes two 4D 
Client connections)

Optional items include: 

• 4D Client 2003 1 User (for one additional 4D Client connection)

• 4D Client 2003 5 User (for 5 additional 4D Client connections)

• 4D Client 2003 10 User (for 10 additional 4D Client connections)

• 4D Write 2003 1 User

• 4D Write 2003 5 User

• 4D Write 2003 10 User

• 4D Server 2003 Web Extension

At a minimum, you will need the 4D Server 2003 Runtime for Macintosh. 
The other items are optional. Ensure that you purchase 4D Server 2003 and 
not 4D Server 2004, which is a newer release of the same product.

Your decision to purchase any of the 4D Client items will depend upon how 
many simultaneous connections to the server you anticipate. The basic 4D 
Server 2003 Runtime has the capability of connecting to two client 
workstations simultaneously. When a third client workstation attempts to 
connect to the server, the server will inform the client that the maximum 
number of connections has been reached, and to try again later. 

If you anticipate simultaneous access by more than two users, then you 
should consider purchasing the 4D Client 2003 1, 5, or 10 User expansion 
product licenses from 4D, Inc. You can also purchase additional licenses at 
a later time, if your connectivity needs grow.

You may also want to purchase expansion product licenses for 4D Write, a 
plug-in which allows connected users to prepare generic word processing 
forms with “mail-merge” capabilities.1 
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SELPA Manager has certain limited web-serving functions. When enabled, 
these functions allow clients with a web browser such as Navigator, Internet 
Explorer, Firefox, or Safari to create or edit IEPs for students. They may also 
create a new student record in conjunction with a new IEP; or edit IEP notice 
information. If you desire to make use of these features, then you should 
purchase the 4D Server 2003 Web Extension1. 

If you do not purchase the web license but nonetheless wish to use the web 
capabilities occasionally, then the web services can be activated in a 
demonstration mode for up to 60 minutes. After 60 minutes, the 4D Server 
2003 software must be restarted before web services can be used again (for 
another 60 minutes).

2 Register your 4D Server software to obtain Serial Numbers.

For purchases made from the 4D, Inc., online store, the company does not 
typically ship the product in boxes. Instead, you will receive Product ID 
number(s) by return email. If you order 4D products by phone or by postal 
mail, then 4D may ship the server components to you as boxed CDs, 
accompanied by product registration cards imprinted with the Product ID 
number(s). An illustration of the top of a 4D Server card is shown in Fig. 2-
38.

Fig. 2-38. Top portion of a 4D Server 2003 license card, illustrating a portion of the 
Product ID number (valid numbers are longer than the number shown).
1. The 4D Write plug-in is a standard component of the v. 4.75xx, single-user runtime of SELPA
Manager. However, it must be purchased separately for the client-server version of the program,.

1. Ensure that you purchase this license for 4D Server, rather than for 4th Dimension or 4D Cli-

ent.



Please do not install any of the software that arrives on CDs from 4D, Inc. 
Fusion Technik includes the appropriate 4D Server software with the 
SELPA Manager installers, as outlined in subsequent steps in these 
instructions.

You must register with 4D, Inc., to obtain Serial Number(s) corresponding 
to the Product ID number(s). These serial numbers are needed to un-lock the 
4D Server software, during installation. You can register online, using a web 
browser, at www.4d.com/register.

Fig. 2-39 is an illustration of the web-based form for entering customer 
information and the Product ID numbers. 

Fig. 2-39. Web-based form on www.4D.com/register, for registering 4D Product ID 
numbers.

Upon submission of this registration form, 4D, Inc. supplies the 
corresponding Serial Number on a web-based form (Fig. 2-40). Print the 
return form for your records. Copy down the serial number in case you lose 
the printed form, and store it in a separate location.
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Fig. 2-40. Web-based confirmation form on www.4D.com/register, returning the serial 
number for a 4D Server registration (the numbers shown are not valid, for illustration 
purposes only).

NOTE: A serial number for 4D Server 6.7, 4D Server 6.8, or 4D Server 2004 
does not allow you to run 4D Server 2003, and vise-versa. Be certain that 
you have the correct license number(s).

The return form allow also allows you to enter additional Product ID 
numbers. In the event that you purchased any of the optional items in Step 
1, then these items should be entered now, by clicking on the link, “Register 
Expansion Products for a 4D Server...”. 4D, Inc. will return serial numbers 
for each of the optional items. These serial numbers are linked to the base 
Product ID number of the 4D Server itself.

NOTE: 4D, Inc. may consider the Product ID number(s) associated with a 
4D Server purchase to be your proof of purchase. Keep these numbers in a 
safe place. If you received the 4D software on CD, make copies of the 
registration cards. Record the Product ID numbers for your notes, and place 



these items in a secure (back-up) location. If you lose one or more Product 
ID numbers, and there are no other records of the purchase, then 4D, Inc., 
may require that you purchase your 4D Server licenses again!

3 Go to the SELPA Manager download page, on the Web.

At present, the URL is “www.ladue.com/fsnbeta.html”, and the portion after 
the slash is case-sensitive. If you cannot find this link, then it may have 
changed. Contact Fusion Technik for the location of the download page.

NOTE: If you cannot use the server computer for web access, then you may 
want to download the installer program to another computer, and then 
transfer it to the server via file sharing.

4 Scroll down on the web page to the heading, “Server - Mac (4.75 versions 
with 4D 2003)”.

5 (New and major updates only) Click on the latest applicable version of 
SELPA Manager that is indicated as a “full installation.”

For SELPA Manager 4.75x running with 4D Server 2003, the full installer 
web-page link will be similar to “SELPA Manager (Macintosh Server v. 
4.75x, full installation with 4D 2003.4”, and the download file is 
approximately 40-45 megabytes in size. 

6 (New and major updates only.) The web browser may immediately 
download the program to the Desktop, or it may ask you where to place 
the installer file on your hard disk (in this case, specify a location).

The installer program file will download to your computer’s hard disk. Make 
note of the directory into which you saved the installer, so that you can find 
it later. The full installer file will have a name on disk that is similar to 
“Selpa475x_svr.dmg”.

NOTE: If the download takes more than several minutes, then there may be 
a problem with your connection to the Internet, or with the web server. Try 
the download again in 30-60 minutes. If problems persist, contact Fusion 
Technik for assistance.

7 Under the “Server - Mac (4.75 versions with 4D 2003)” heading, click on 
the latest applicable version of SELPA Manager that is indicated as a 
“structure only” update1.

1. Structure  in this context refers to the compiled SELPA Manager program structure, as dis-

tinguished from the 4D Server / 4D Client software and the data file.
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This item will have a web page link similar to “SELPA Manager (Macintosh 
Server v. 4.75x, structure only).” 

NOTE: Do not download the “structure only” update if it has the same 
version number as, or if it has a lower version number than the full 
installation. In this case, the full installation is the latest applicable version, 
and you can skip to Step 9, below.

8 The web browser may immediately download the update file to the 
Desktop, or it may prompt you for a location on disk in which it should 
place the update file (in this case, specify a location).

The update file will download to your computer’s hard disk. Make note of 
the directory into which you saved the update file, so that you can find it 
later. The update file is approximately 10-15 megabytes in size, and will 
have a name on disk that is similar to “Selpa475x_svu.sit”, after download 
and prior to expansion.

9 Exit from the web browser program, and from any other programs that 
you might have running on the server.

10 (Major updates, certain cases only1.) Run the version of 4D Tools that 
matches your existing data file, to perform a Recovery (Recover by Tags).

This step is applicable only if you have been using a version of SELPA 
Manager prior to 4.701, before installing this (the current) version, and will 
be carrying forward with your previous data. 

In this case, you should run 4D Tools 6.0.6 on the previous SELPA Manager 
installation, before using the earlier data file with the current version. 4D 
Tools should have been installed on the server computer with your earlier 
copy of SELPA Manager. 

Additional discussion of this operation appears under “Major version 
updates” on page 121, and in the Appendix , “Using 4D Tools” on page 771. 
Be certain that you are using the correct version of 4D Tools for your data 
file (refer to Fig. E-1 on page 758).

11 (New and major updates only.) Find the SELPA Manager “full installation” 
(“.dmg”) file on disk, that you downloaded in Step 6. Double-click on it to 
expand the file.

1. If the update is from SELPA Manager v.4.7x to 4.75x, then Step 10 can be skipped (the data
file format is the same among these versions).



The installer file will display a progress dialog while verifying and 
expanding. When the file is expanded, a “virtual” disk will mount, and a new 
window will appear in the Finder (Fig. 2-41).

Fig. 2-41. Window for the virtual disk, SELPA Manager installer program (client-
server edition, Macintosh). 

12 (New and major updates only.) In the new window, double-click on the 
SELPA Mac Server icon, to launch the installer program.

The installer program will display a dialog, containing an INSTALL button 
(Fig. 2-42).

13 (New and major updates only.) Press the INSTALL button.

A set of progress bars will appear temporarily, followed by a confirmation 
message that the installation has completed (Fig. 2-43).

NOTE: The installer places items into the Applications folder on disk. If this 
folder is locked to non-administrative users, then you may need an 
administrator’s password for the Macintosh, to successfully complete the 
installation.
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Fig. 2-42. The SELPA Manager installer program (client-server edition, Macintosh) 
presents a dialog with an INSTALL button.

Fig. 2-43. The SELPA Manager installer program (client-server edition, Macintosh) 
after installation of the server components.



14 (New and major updates only.) Press the QUIT button to exit the installer 
program.

After the installer quits, you will have a new “Fusion Technik” folder on 
disk, inside the Applications folder, containing 4D Server 2003, the SELPA 
Manager program within a “SELPA_fldr” sub-folder, and associated 
components (Fig. 2-44).

Fig. 2-44. The SELPA Manager program in its installed directory (Macintosh client-
server).

The installer also places a log file and a “SELPA Server uninstall” program 
in the directory, ~user/library/logs. 

WARNING: The uninstaller will remove the “Fusion Technik” directory and 
all of its contents. Therefore, the SELPA Manager data file and any 
associated 4D Backup files MUST be removed BEFORE using the 
uninstaller, or they too will be deleted. It should not be necessary to use the 
uninstaller, because the program can be removed by dragging the “Fusion 
Technik” folder to the trash. Ensure that you keep another copy of your data 
file in a safe location, preferably not on the same hard disk.

15 If you downloaded a SELPA Manager “structure only” update file, then 
find it now on disk. Double-click on it to expand the archived contents 
using Stuffit Expander.

The update file will have a name on disk like “Selpa475x_svu.sit”. 

NOTE: If you did not download a “structure only” update, then skip this 
portion of the installation. Proceed to Step 17, below, to make shortcuts.
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If the update file does not expand when you double-click on it, then you may 
need to drop-launch the update file on top of Stuffit Expander. Alternately, 
if Stuffit Deluxe is installed on your Macintosh, you can right-click (or 
[CNTRL]-click) on the update file and select “UnStuff” from the contextual 
menu (Fig. 2-45). 

Stuffit Expander is included as an OEM application on disk, with new 
Macintosh computers. 

Fig. 2-45. Expanding (unstuffing) the SELPA Manager update file, using the contextual 
menu plug-in for Stuffit Deluxe (client-server edition, Macintosh). 

16 After Stuffit has expanded the update file, there will be a new folder on 
disk named “Server_upgrade_fldr”. Use the contents of this folder to 
replace similar items within “SELPA_fldr”, which were created during the 
last “full” installation (as shown in Fig. 2-46).

The four items that should be replaced include the “HTML” sub-folder, the 
“Mac4DX” sub-folder, the “Win4DX” sub-folder, and the program 
structure (named either “Selpa_Mgr_v475” or “Selpa_Mgr_v475.comp”). 

17 (New and major updates only.) Make aliases (shortcuts) on the Desktop 
to the SELPA Manager program, to the 4D Server program, and (if also 
installed) to the 4D Tools program.

The SELPA Manager program has the name, “Selpa_Mgr_v475” or 
“Selpa_Mgr_v475.comp”. To make a shortcut, highlight the icon of the item 
and select “Make Alias” from the File menu.



Fig. 2-46. After Stuffit has expanded the update file, use the contents of the resulting 
“Server_upgrade_fldr” to replace the corresponding items in the 
“~Applications/Fusion Technik/SELPA _fldr” directory (client-server edition, 
Macintosh). 

18 (Major updates only.) Move the “recovered” data file into the “Selpa_fldr” 
directory.

If you created a recovered data file in Step 10, then move the it if necessary 
into the new database folder. This step applies only if you used an earlier 
version of 4D Tools perform the recovery by tags operation. If you did not 
perform this step, then skip to Step 19.

19 (Existing data files where Step 18 is NOT performed.) If a SELPA Manager 
data file has been prepared in advance on a separate, single-user 
installation, or on a previous version of 4D Server, then place the data file 
into the same folder with the SELPA Manager program (“Selpa_fldr”).

NOTE: This step is intended to promote good housekeeping. You do not 
actually need to have the data file in this location for the program to work; 
the data file can exist in another, accessible folder on disk.

20 Start 4D Server by double-clicking on the desktop shortcut to 4D Server.

New and major updates only: When 4D Server 2003 starts for the first time 
on a new hard disk, the program will present a license agreement. To 
proceed, you must click on the “I agree” button and then press the NEXT 
button (Fig. 2-47). 
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Fig. 2-47. 4D Server 2003 license agreement (Macintosh server).

NOTE: You can also start 4D Server by drag- (drop-) launching the SELPA 
Manager alias on top of the 4D Server alias. In this case, 4D Server will 
NOT prompt for the name of a database to open in Step 22 (see Fig. 2-49, 
below).

The program then will present a dialog, prompting you for your name, your 
company name, and the 4D Server serial number (“Serial Number” in Fig. 
2-48). You may use any name and company (school or district) name that is 
appropriate. 

For the serial number, use the long alphanumeric code obtained during the 
registration of 4D Server, in Step 2. Do not enter the serial number(s) for any 
of the optional (expansion) products at this time.

The 4D Server serial number is case-sensitive. Characters that resemble the 
lowercase “L” character or a numeric “1” character may actually be a capital 
“i”. If the code is not entered correctly, the program will not allow you to 
proceed. 

You can also press the DEMO button to operate 4D Server temporarily in 
demonstration mode, but in this mode the program restricts the number of 
records that can be entered to 50 in each table.



Fig. 2-48. 4D Server 2003 license number entry dialog (Macintosh server).

New and existing installations: At this point, 4D Server will present an 
“open a database/create a database” dialog, prompting you to specify the 
database to be opened (Fig. 2-49).

Fig. 2-49. 4D Server open/create database dialog, prompting you to specify which 
database to open (Macintosh server).
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21 Select SELPA Manager as the database to be opened.

Press the CHOOSE button next to the “Other database” label. 4D Server will 
present a standard, open file-type dialog (“Open a 4D database,” Fig. 2-50). 
Select the file on disk named either “Selpa_Mgr_v475” or 
“Selpa_Mgr_v475.comp”. The default path to this file is:

~Applications/Fusion Technik/SELPA_fldr/Selpa_Mgr_v475

Fig. 2-50. 4D Server (Macintosh), standard open-file dialog for selecting a database 
(structure file).

22 Select the data file that is to be opened in conjunction with SELPA 
Manager.

4D Server will prompt you with another open file-type dialog (“Open,” Fig. 
2-51), for selecting the data file.

If you have an existing data file, or if you have prepared one in advance on 
another computer (Step 18 or Step 19), then you should use the dialog to 
locate the data file on disk. This file generally has the suffix, “.data”.



Fig. 2-51. 4D Server (Macintosh), standard open-file dialog for selecting a data file.

NOTE: If your data file was running with a version of SELPA Manager 
earlier than 4.701, then be certain that you followed Step 10 (above), and 
that you read the section, “Major version updates” on page 121, BEFORE 
opening the data file with the newer (current) version of SELPA Manager.

If you are starting from scratch, then you may create a new data file by 
pressing the NEW... button on the dialog. In this case, 4D Server will prompt 
you to select a data file name (Fig. 2-52). If, for example, you select the 
name “Central” for your data file, then 4D Server will create a 
“Central.data” file on disk.

If you have an existing data file that has exactly the same prefix as the 
SELPA Manager program (“structure”) file, and is located in the same 
directory, then 4D Server may open that data file automatically, without 
prompting you as in Fig. 2-51. For example, because the SELPA Manager 
program file is named “Selpa_Mgr_v475”, if you have a data file in the same 
folder on disk with the name “Selpa_Mgr_v475.data”, then 4D Server may 
attempt to open that data file automatically.
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Fig. 2-52. 4D Server (Macintosh), standard dialog for creating a new data file. The 
default name prefix (“Selpa_Mgr_v475”) can be replaced with your school or district 
name.

On subsequent re-starts, 4D Server will open the same data file that you 
selected in this step — unless the path to the data file changes, or you install 
another update to SELPA Manager. Therefore, it will not display the “Open” 
(data file) dialog of Fig. 2-51 again. However, you can force SELPA 
Manager to present the “Open” dialog on any 4D Server start-up, by holding 
down the [OPTION] key after selecting the database in Fig. 2-50.

Once 4D Server is running, you will see one main process window and two 
smaller windows on your monitor (“4D Server”, “Backup Scheduler”, and 
“Restore Log”, refer to Fig. 2-53). The main (“4D Server”) window displays 
a list of “Users”. The user named “Kernel” includes three rows (processes) 
with the names, “User interface”, “Client Manager”, and “Cache Manager”. 
If you are updating an existing data file from a previous version of SELPA 
Manager, then you may also see a fourth process listed, for indexing fields.



Fig. 2-53. 4D Server (Macintosh) in operation, showing the main window (“4D 
Server”) and the two auxiliary windows (“Backup Scheduler” and “Restore Log”).

23 (New and major updates only.) From the Backup menu, select “Full 
backup...”

4D Backup is a component of 4D Server. When configured, it can maintain 
a log of all changes made to the data file, and will make a copy of the data 
to another location on disk at prescribed intervals.

When this menu item is selected, 4D Server will present the Full Backup 
dialog (Fig. 2-54). 
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Fig. 2-54. Full Backup dialog, displayed by 4D Server (Macintosh) when you select 
“Full backup...” from the Backup menu.

24 (New and major updates only.) Select a destination volume by clicking on 
a hard drive icon.

The destination volume should be a local hard drive or hard drive partition, 
with sufficient space on it to accommodate somewhat more than five copies 
of the data file (*.data) plus the structure file (Selpa_Mgr_v475.comp).1 For 
example, if the combined size of your data file plus the structure on disk is 
60 megabytes, then you should have more than 300 megabytes available to 
accommodate five sets of backups.

If you select a drive for the backup that is the same drive on which the data 
file is located, then 4D Server will present a warning message. Press the OK 
button to acknowledge the warning.

When selecting the destination volume, avoid the use of a removable 
(cartridge, CD, or DVD) drive that will spin down after a certain period of 
idle time. If the cartridge is not spinning at the time that 4D Backup is ready 
to perform the backup operation, then the backup may fail. Once 4D Backup 
has failed, it requires resetting (by performing another manual backup) 
before it can perform additional automatic backups.

1. You can specify the number of rotating data file copies that 4D Backup will maintain as the
“number of sets,” in the lower-left portion of the dialog. The default number is five for 4D Server
2003. As an example, suppose that the program makes daily backups at 2:30 am, starting on
Monday morning. On Saturday morning, it will replace the backup made on Monday morning,
so that a total of five “sets” are maintained.



Similarly, a non-local (network) drive may not be a desirable destination for 
4D Backup to use, because if the program cannot connect due to network 
traffic or some other network availability issue, then the backup will fail. In 
this case, 4D Backup will not attempt any further backups until it is 
manually reset.

The most effective way to use a cartridge or a remote drive in conjunction 
with 4D Backup is to subsequently copy the “sets” (which 4D Backup 
creates) to the drive. If desired, you can use a program such as Dantz’ 
Retrospect to automate this process.

NOTE: It is not recommended that you copy the active data file (e.g., 
“Slpa_Mgr_v475.data” or “Central.data”) while 4D Server is running. 
Although 4D Server will allow you to make this copy, the copy may become 
damaged if the server is writing to the file at the same time that the copy is 
in progress.

25 (New and major updates only.) Press the BACKUP button on the dialog.

4D Server will present a “Save” dialog (Fig. 2-55), asking for the particular 
location on disk where the backup files (“sets”) are to be stored. 

Fig. 2-55. “Save as...” dialog, displayed by 4D Server when you press the BACKUP 
button on the Full Backup dialog. In this example, the user should double-click on the 
“Data backups” folder, to place the backup in that location.
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To minimize clutter, you should avoid storing the backup files directly in the 
“SELPA_fldr” directory, where the program itself resides. Instead, you can 
create a special folder (directory) in which to place the backup sets. This 
folder can be a subdirectory within the “SELPA_fldr”.

The backup sets will each have the same name prefix (e.g., 
“Selpa_Mgr_v475”). However, 4D Backup will increment the number of 
the set each time a new backup is made, appending that number to the 
backup set name (“[1]”, “[2]”, etc., as in “Selpa_Mgr_v475[1]”, 
“Selpa_Mgr_v475[2]”...).

26 (New and major updates only.) Name the backup file on disk and press 
the SAVE button.

After pressing the SAVE button, you will see a series of progress bars 
moving across the display as 4D Backup completes the first backup set. As 
the backup finishes, 4D Backup will ask you to save the project settings 
(“Do you wish to save the backup parameters in a project”, Fig. 2-56).

Fig. 2-56. Save backup project dialog, displayed by 4D Server (Macintosh) after 
changes are made in a 4D Backup configuration.

27 (New and major updates only.) Press the SAVE button, and place the 
backup project into the same folder as SELPA Manager.



The backup project file contains configuration settings for the backup 
operation, but it does not contains any backup data. Then backup project 
should be saved to the same folder as the program (structure file) itself:

~Applications/Fusion Technik/SELPA_fldr

Allow 4D Backup to save the backup project with the default name, 
“Backup Project”. After you have saved the project, 4D Server will return to 
displaying the main window and two auxiliary windows (Fig. 2-53).

28 (New and major updates only.) From the File menu, select the item, 
“Select log file...”.

4D Server will present an open file-type dialog, “Select a log file”.

29 (New and major updates only.) Press the NEW button to create a new log 
file.

4D Server will present a saves as-type dialog (“Log file name:”). In the 
example, the name chosen will be “Selpa_Mgr_v475.data.log”. 

30 (New and major updates only.) Press the SAVE button to create the new 
log file.

After you have saved the new log file, 4D Server will return to displaying 
the main window and two auxiliary windows (Fig. 2-53).

31 (New and major updates only.) From the Backup menu, select “Full 
Backup...” again.

4D Server will again display the Full Backup dialog (Fig. 2-54), only this 
time you should see three enabled check marks along the left edge of the 
dialog (rather than two): “Data”, “Structure”, and “Log File”. If “Log File” 
is not already checked, check this box now by clicking on it.

32 (New and major updates only.) Press the BACKUP button to perform 
another full backup.

You will again see progress thermometers moving across the screen as 4D 
Backup prepares the backup set on disk. 

33 (New and major updates only.) Save the changes to the backup project.

As the backup set completes, the program will alert you that the backup 
parameters have been changed, and it will ask if the project should be saved. 
Press the OK button to revise the backup project parameters.
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34 (New and major updates only.) Set the Backup Scheduler window for the 
frequency, date, and time of the next backup.

Click on the check box in front of “Backup every (1) day(s)” so that 4D 
Backup will make a new backup set daily. You may set the scheduler to make 
a backup set on a different frequency, if desired.

You can click on the watch icon below the check box to set the time of day 
and the date for the next backup. 4D Backup will display the “Scheduling 
the backup” dialog (Fig. 2-57). Specify a backup time when no one is likely 
to be running SELPA Manager. If someone is editing a student, or has gone 
home for the day but has left their connection open, with a record open for 
editing, then the backup may not complete successfully.1

Fig. 2-57. “Scheduling the backup” dialog, which appears while configuring the 
Backup Scheduler window.

If desired, you can click on the appropriate boxes to instruct 4D Backup not 
to make a backup set if there are no changes to the data; and to display an 
alert box on the server, if the backup set has failed.

35 (New and major updates only.) If you have purchased 4D expansion 
product licenses (additional licenses beyond the minimum of 2 that come 
with 4D Server), then install them at this time.

1. From a workstation, the administrator can set an excluded time  in preferences,

where SELPA Manager users cannot remain connected to the server. This feature can

close 4D Client on workstations just before 4D Backup commences. Refer to the Chap-

ter, Configuring SELPA Manager  on page 243.



From the Help menu in 4D Server 2003, select “Update license...”. 4D 
Server displays the license dialog shown in Fig. 2-58. There should be one 
highlighted row in the entry area, containing the 4D Server serial number 
that you entered in Step 20.

Fig. 2-58. License number entry dialog, 4D Server 2003 (Macintosh). Serial number 
shown is for illustration purposes only (not a valid number).

Press the ADD button next to the label, “Expansion Serial Number”, and 
enter the additional serial number that you obtained previously, in Step 2. 
Repeat for each expansion license.

36 (New and major updates only.) Place the “full installation” SELPA 
Manager installer in a location where it can be used to configure the 
client workstations.

You have configured the server and are now ready to begin installing the 
client software on individual workstations.The client software can be 
installed from the same (full) installer program that was downloaded to the 
server in Step 5, above. 

You can place the full installer on a network drive that is accessible for 
execution by each client. Alternately, you can transfer the installer to each 
local client hard drive, using file sharing. Another possibility is to burn a CD 
or place the installer on a Zip disk, and then carry the CD or the Zip disk 
from client to client. 
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Once you have run the installer on a workstation, there is no longer a need 
to keep the installer file itself on that workstation.

Macintosh client-server (client installation)
For a Macintosh-based client, the minimum recommended configuration is 
a G3 Macintosh with Mac OS 9.2.1 or later, with CarbonLib 1.4 or above. 
For Mac OS 9.2.1, at least 16 megabytes of physical RAM should be 
available as a partition in which to run the client software. For Mac OS X 
workstations, at least 128 megabytes of physical RAM must be installed. 
The program is compatible with Mac OS X and will execute as a Carbon 
application (SELPA Manager v.4.75 and later). The instructions which 
follow assume an OS X installation.

If you have not yet installed the server-side software, then you should 
perform that task first (refer to “Macintosh client-server (server 
installation)” on page 94). After completing those steps, you should have the 
“full” installer program available on the local hard drive of the workstation, 
on a removable cartridge drive, or accessible from a shared folder over the 
network.

With the exception of major version updates to SELPA Manager, where the 
version of 4D Server and 4D Client changes, the workstation (client) 
software generally does not need to be updated each time that you place a 
new version of SELPA Manager onto the server. When a user starts the client 
software from his/her workstation, the client software will recognize if a 
new version of SELPA Manager is running on the server, and take 
appropriate action.

Generally, the 4D Server software on the server computer and the 4D Client 
software on the client workstation should match each other in both major 
and minor version number. For example, 4D Client 2003.4 is recommended 
for connecting to 4D Server 2003.4. 

However, an earlier version of 4D Client 2003 can often connect to a later 
version of 4D Server 2004. For example, 4D Client 2003.4 should be able to 
connect to 4D Server 2003.7. 

You may install the 4D Client software on as many workstations as you 
wish. The licensing limits are determined by the number of SELPA Manager 
users that are connected to the server simultaneously.



To install or upgrade the Macintosh client software:

1 Find the SELPA Manager “full installation” installer (“.dmg”) file on disk, 
that you downloaded previously for the server software installation. 
Double-click on it to expand the file.

The installer file will display a progress dialog while verifying and 
expanding. When the file is expanded, a “virtual” disk will mount, and a new 
window will appear in the Finder (Fig. 2-59).

Fig. 2-59. Window for the virtual disk, SELPA Manager installer program (client-
server edition, Macintosh). 

2 Double-click on the “SELPA Mac Client” icon.

The installer program will display a dialog, containing an INSTALL button 
(Fig. 2-60).

3 Press the INSTALL button.

A set of progress bars will appear temporarily, followed by a confirmation 
message that the installation has completed (Fig. 2-61).

NOTE: The installer places 4D Client 2003 into the Applications folder on 
disk. If this folder is locked to non-administrative users, then you may need 
an administrator’s password for the Macintosh, to successfully complete the 
installation.
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Fig. 2-60. The SELPA Manager Macintosh client installer (client-server edition) 
presents a dialog with an INSTALL button.

Fig. 2-61. The SELPA Manager Macintosh client installer (client-server edition), 
following installation.



4 Press the QUIT button to exit the installer.

After the installer quits, you will have a new item, 4D Client 2003, in your 
Applications folder. If desired, you can make an alias (shortcut) to 4D Client 
on your Desktop, or drag the icon to the Dock or the window Toolbar. Also, 
if you prefer, you can move 4D Client to another location on disk.

Major version updates
A major version update to SELPA Manager includes an update to the 4D 
database engine. In this case, in addition to installing the new SELPA 
Manager structure, the 4D Server software must be updated on the server 
computer, and each client must be updated with a new version of 4D Client.1 
SELPA Manager has been through the following major updates in recent 
years:

• Pre-v.4.01 to v.4.01 (starting in 1999) – Update to 4D 6.0. 

• Pre-v.4.701 to 4.701 – Update to 4D 6.7.

• Pre-v.4.75 to 4.75 – Update to 4D 2003.

Because of changes in the 4D database engine, data files from the earlier 
version of SELPA Manager must be converted on start-up to work with the 
newer engine. The conversion process happens when you install a new 
version of SELPA Manager that includes a new version of 4D, and then open 
an existing data file from the previous version.2 In this case, the program 
presents a warning dialog (refer to the example warning in Fig. 2-62). 

Once converted for the new database engine, the data file can no longer be 
re-opened directly with the earlier (previous) version of SELPA Manager.3

1. Some minor updates to SELPA Manager include incremental updates to the 4D database en-

gine. These incremental updates to the database engine are generally for bug fixes; are generally

interoperable with each other; and do not require the purchase of upgrade licensing. For exam-

ple, switching from 4D Database Engine 6.7.1 to 4D 6.7.2, or from 4D 2003.3 to 4D 2003.4,

does not constitute a major version update for SELPA Manager. 

2. Due to the addition of new tables and other structural rearrangements, the pre-v.4.01 to v.4.01

update could not be performed with a simple conversion of the earlier data file. Instead, this up-

date required an export of all data, followed by import into a new (empty) v.4.01 data file.

3. In some cases, you can still transfer data to an earlier version of SELPA Manager by perform-
ing a SELPA Central export from the newer version, followed by a SELPA Central import on
the earlier version. Re-importation will not include data in fields that are absent from the earlier
version.
Installing SELPA Manager 121 

• 
• 
• 
•
•
•



122  

• 
• 
• 
•
•
•

Fig. 2-62. Converting a data file to work with the 4D 6.7.1 database engine. This dialog 
appears when opening SELPA Manager 4.701 with an existing data file, from a SELPA 
Manager version prior to 4.701.

Before performing the conversion process, it may be wise to first make a 
“clean” copy of the data file, one that has been defragmented and rebuilt 
with new indices. Circumstances in which this preparatory step may be 
appropriate include:

1. Conversions from a SELPA Manager version prior to 4.701 to a version 
after 4.701 (i.e., from 4D v6 to 4D v6.7).

2. Hundreds of records have been deleted recently.

3. There is regular deletion of records without the concomitant addition of 
new records, into the same table.

4. SELPA Manager has generated error messages when searching for or 
displaying records.

5. 4D Tools reported data file errors, but you have not performed a recover 
(recover by tags) operation, since the errors were reported.

6. You have moved (or are planning to move, with this conversion) from a 
Macintosh server to a PC (Windows) server, or vise-versa.

If any of these conditions apply, then you should consider making a clean 
copy of the data file. To accomplish this task, use 4D Tools to perform the 
recover operation on the unconverted data file. Use the version of 4D Tools 
that came with the earlier version of SELPA Manager, prior to the major 
version update.



For a detailed description of how to use 4D Tools, refer to the Appendix , 
“Using 4D Tools” on page 760.

The “clean” copy of the data file can then be opened (and converted) with 
the newer version of SELPA Manager.

Minor version updates
Periodically, there are minor or incremental version updates to SELPA 
Manager. These updates are posted to the download pages (“alpha” and 
“beta”) for your use. For multi-user editions of the program, these files are 
referred to as “structure-only” updates, because they include an updated 
version of the SELPA Manager program structure and associated plug-ins; 
however, they do not include new versions of the 4D Server or 4D Client 
applications.

Generally, a minor or incremental version update is one in which the 
numeric change to the version number is smaller than 0.01. For example, 
moving from Version 4.75039 to 4.75045 would be a minor version update, 
whereas moving from Version 4.74045 to 4.75045 would be a major version 
update.

Minor version updates add new features and/or fix problems, but do not 
normally include new releases of the 4D database engine.1 Therefore, the 
client workstation software (for multi-user editions of SELPA Manager) 
generally remains the same, and recovery of the data file with 4D Tools is 
not necessary.2 

Generally, you can skip one minor update and then install the next or the 
following minor update. In other words, you don’t need to install all the 
updates between two minor updates.

To determine whether you should install a minor version update, consult the 
release notes for the update. These release notes usually appear on the 
SELPA Manager HelpServer at the time when the new version is released. 
Do the changes in the new version affect operations which you or your users 
conduct? If so, you may wish to install the update.

1. An exception is SELPA Manager updates that include incremental updates to the 4D database

engine. Refer to the footnote concerning incremental updates, on page 121.

2. The Appendix, “Using 4D Tools” on page 757, covers the use of 4D Tools.
Installing SELPA Manager 123 

• 
• 
• 
•
•
•



124  

• 
• 
• 
•
•
•

To install a minor version update (multi-user editions):

1 If you are using custom login names and/or passwords, then save user 
and group information to disk before quitting from SELPA Manager. 

Log on to SELPA Manager from one of the workstations as the 
Administrator. From the File menu, select “Users and groups...” From the 
Passwords menu, select “Save Groups...” The program will prompt you to 
save the users and groups information to a file on disk.

2 Ensure that all 4D Client workstations have logged off of the server.

Quit from 4D Client on the workstation, after saving the users and groups 
information. Instruct other users to quit (exit) from 4D Client as well.

3 Make note of the full name (including the path) of the data file that you are 
using on 4D Server.

Ensure that you remember the name of the data file (and its location) on the 
server computer, before you quit from the 4D Server application. The name 
of the data file appears in the upper left of the main window of 4D Server 
(after “Data File” label, for example, in Fig. 2-26 on page 79 and in Fig. 2-
53 on page 111).

4 Quit from the 4D Server application.

Select “Quit” from the File menu. 4D Server will present the Server Shut 
Down dialog, prompting you to select a number of minutes to wait 
(“Disconnect from server in: <10> min.”) or to select, “Wait for all users to 
disconnect”. Select zero (“0”) minutes and then press the OK button.

5 Download the desired update from the web

Launch your web browser application and go to the SELPA Manager 
download page. The update will have a name such as “SELPA Manager 
(Windows Server v. 4.75x, structure only, updates the 4.75x full install)”. 

Ensure that the minor update you want to install will work with the last 
major update, or full installation, that is applicable to your server.

Make note of the folder/location into which you have downloaded the 
update file, because you will need to install it in the next step. 

6 Quit from the web browser application.

Ensure that no other programs are running on the server, before installing 
the SELPA Manager update.



7 Install the update on the server computer.

Windows (PC) server: On PC server computers, double-click the 
“SLPAsr1_475x.EXE” installer program that you downloaded in Step 5, 
above. If you are using a different install directory than the default 
(“C:\Program Files\Fusn_Tek”), then you will need to specify that directory 
as the installer proceeds. When the installer has finished, the update will 
have applied over your existing installation of SELPA Manager; your 
Desktop or Start menu short cuts should still be valid.

Macintosh server: On Macintosh servers, if the “Selpa475x_svu.bin” or 
“Selpa475x_svu.sitx” download file has not already expanded into an 
update folder, then expand the “.bin” or “.sitx” file with Stuffit Expander or 
Stuffit Deluxe. 

Once expanded, the Macintosh archive will create a new folder at the root 
level of the hard disk. Use the individual items from this folder to replace 
similar items in the “~Applications/Fusion Technik/Selpa_fldr” destination, 
which contains the previous SELPA Manager program and associated 
components. The four items that should be transferred include the program 
structure (“Selpa_Mgr_v475” or “Selpa_Mgr_v475.comp”1), the 
“Mac4DX” folder, the “Win4DX” folder, and the “HTML” folder. 

8 Re-start 4D Server on the server computer

Use the desktop shortcut, Start menu selection, or other means that you used 
previously to start 4D Server. Identify the structure (“SelpaMgr_v475.4DD” 
or “Selpa_Mgr_v475.comp” if 4D Server prompts you to do so.

9 Locate the data file to be opened, when prompted to do so by 4D Server.

4D Server may ask you to identify the data file to be opened. The data file is 
the file on disk that you identified in Step 3, above.

10 Log onto the server from a client workstation by starting 4D Client.

You should see two small windows appear temporarily at the lower right 
portion of the screen, “Duplicating resources locally...”. 4D Client will then 
present the Password dialog. Connect to the server as the Administrator. 

11 If you are using custom login names and/or passwords, restore them to 
SELPA Manager at this time.
1. Depending on the version of the last full installation and the update, the structure file may

have the suffix .comp  visible in the file name, or it may be hidden. If the update structure is

different in this regard from the previous structure, then you should also make a new desktop

shortcut to the structure file after replacing the structure.
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From the File menu, select “Users and groups...”. The Users and Groups 
dialog will appear on the monitor. 

From the Passwords menu, select “Load groups...”, and then locate the file 
on disk containing the user and password information (saved in Step 1). Your 
custom passwords should now appear in the Users and Groups dialog, and 
the other users should be able to connect to the server.

Updates: other considerations
Another consideration when performing a major update is that the installer 
for the new version might place components into an existing destination 
path, such as the “SELPA_fldr” or “SELPA_475_fldr” directory. If some 
components are not exact replacements (in name) for the existing 
components, then the installation could result in a mixture of old and new 
items. Furthermore, you might want to retain the older directory and all of 
its contents, as an archive for future reference.

For this reason, it is recommended that you read carefully any notes that 
might accompany a particular update, as there may be a manual operation 
that must be performed for the updated program to work properly. For major 
updates, you may want to make a copy of the entire “SELPA_fldr” or 
“SELPA_475_fldr” directory, prior to the update.

Server data backup (4D Backup)
The multi-user editions of SELPA Manager run 4D Server, which includes 
a data backup plug-in and an associated, separate application called 4D 
Backup. You initiate automatic backup by defining the location into which 
the backups are to be placed (“Full backup...”, Step 34 and beyond of the PC 
server installation or Step 23 and beyond of the Macintosh server 
installation).

When properly configured, the 4D Backup plug-in will make a copy of your 
data every day, in a rotating set of backups. 

For example, suppose that 4D Backup is configured to create three backup 
sets. 4D Backup creates the first data backup in the set on Monday morning. 
Then the backup file that 4D Backup creates on Thursday (the fourth day) 
will replace the backup that was prepared on Monday; the backup on Friday 



will replace the backup that was prepared on Tuesday, and so on. Provided 
that there is sufficient space on your hard disk, you can define a larger 
number of backups per set (for example, five instead of three).

The backup files on disk are encoded into a special format, which can be 
restored with the 4D Backup application, for use with 4D Server and SELPA 
Manager. The 4D Backup application is placed on the server computer when 
you perform the full server installation of SELPA Manager (it is named 
“4DBackup.exe” on disk, for a PC server).

4D Server can keep a log file of user activity. The log file keeps track of all 
changes made to individual records in the database since the last full (daily) 
backup. You specify the log file by choosing “Select log file...” from the File 
menu of 4D Server (Step 39 of the PC server installation or Step 28 of the 
Macintosh server installation).

The log file allows 4D Backup to recover information up to the point of a 
server failure, such as a power interruption, a hard disk mechanical failure, 
or some other accident. When you re-start 4D Server after such a failure, the 
program may indicate that “the log file contains more data than what has 
been saved in the database.” This warning is your cue that the log file needs 
to be integrated with the last good copy of your data file, to restore the data 
file to the point prior to the failure. A full integration of this type will bring 
your data up to the point that it was at when the accident occurred. 

You can use the Restore Log window from within 4D Server to perform a 
log file integration (refer to Fig. 2-26 on page 79). You can also use the 4D 
Backup application to perform this task, if 4D Server is not running. 
Detailed instructions on using the Restore Log window and the 4D Backup 
application can be found in the 4D Backup Reference user’s manual.1

Another use of the log file is to undo an error, such as the accidental deletion 
of one or more records. In this case, you can partially integrate the log file 
with the last backup, up until the operation immediately preceding the error 
or series of errors. The Restore Log window contains a detailed listing of 
events (beneath an arrow symbol), which can be used to integrate the log file 
up to a selected point.

1. 4D SA/ 4D Inc., 4D Backup® Reference, Version 6.7 for Windows® and Mac™ OS. Cuper-
tino: 1994–2000, 4D SA/4D, Inc.
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To assure smooth operation of 4D Backup and the maintenance of the 
log file, the following points are important to remember:

1 The log file should be backed up daily, with the data file backup.

This action is accomplished during the server installation by making a 
second full backup following the creation of the log file, and checking the 
“Log file” box in the full backup dialog (Step 42 of the PC server installation 
or Step 31 of the Macintosh server installation).

Under these circumstances, 4D Backup makes an archive copy of the log file 
every day, at the same time as the data backup is made.Then it deletes the 
existing log file and creates a new (blank) one, for the new day. The new log 
file can then be integrated (at a later time, as necessary) with the data 
backup.

For example, suppose that the last daily backup of the data file has the 
following name on disk (assuming two files, for a PC server1);

Oceanside056.4BK
Oceanside056.4BR

The log file backup that is be saved with this data file backup will have the 
name (for a PC server):

Oceanside056.4BL

At the same time, 4D Backup will create a new (empty) log file,

Oceanside.4DL

Suppose that a server crash occurs later in the day, and the active data file 
becomes corrupted. Provided that the current log file (Oceanside.4DL) and 
the last backup (Oceanside056.4BK and Oceanside056.4BR) are still intact, 
then the current log file can be integrated against a de-archived copy of the 
last backup, to bring the previous day’s data file up to the present state of 
modification, just before the crash.

If you do not back up the log file daily with the data file, then the log file will 
continue to grow in size with each user action. This larger log file cannot be 
integrated with the most recent daily backup. Instead, it will need to be 

1. On Macintosh, the data file backup will have a name similar in syntax to, for example,
“Oceanside.data[056]” (there is only one file, not two as on the PC). The backed up log file will
have a name similar to “Oceanside.data.log[055 to 056]”.



applied to the data file backup made just before the log file was first created. 
You may not have that particular data file backup any more; and in any case 
the integration will take a much longer time to complete.

2 The Backup Project (preferences) file should be stored in the same folder 
as the SELPA Manager application itself.

The Backup Project is a file on disk containing the backup parameters, such 
as the location on disk where the backup data archives are saved. The default 
name for this file is “Backup.4BP” for a PC server or “Backup Project” for 
a Macintosh server. 

You create the Backup Project file immediately after you have made the first 
full backup (Step 38 for the PC server installation or Step 27 for the 
Macintosh server installation; at this point, 4D Server asks “Do you wish to 
save the backup parameters in a project?”).

The Backup Project file should be stored in the same folder as the SELPA 
Manager structure (on the PC, the structure files are 
“Selpa_Mgr_v475.4DC” and “Selpa_Mgr_v475.RSR”; the default installed 
path to these files is “C:\Program Files\Fusn_Tek\Selpa_fldr”).

If the Backup Project is not saved to this particular location, then the daily 
backup may not occur.

3 The disk volume onto which 4D Backup places the daily backup files 
should be consistently available.

The directions for installing SELPA Manager onto the server computer 
recommend the specification of an internal hard drive as the target 
(destination) for 4D Backup, rather than a cartridge (removable media) drive 
or a remote (network) drive.

If you were to configure 4D Backup to use a removable media drive, then 
you would need to ensure that the media cartridge is inserted, and that the 
drive is running, or will become available by spinning up to speed in a short 
time. If 4D Backup cannot access the removable media drive quickly, then 
the backup may fail.

If you are using SELPA Manager 4.6x or earlier (with 4D Server 6.0x), then 
an external destination volume must be smaller than 4 GB. FireWire drives 
are not recommended for this version of the program.
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If you were to configure 4D Backup to use a network volume, such as a “P:” 
or “I:” drive, then you would need to ensure that the drive is always available 
at the time that you schedule 4D Backup to perform the data file backup. 

Sometimes 4D Backup will not find the network drive within a specified 
time interval, due to heavy traffic on the network. A failure can also occur if 
the access privileges for the network volume have been changed to “read-
only” rather than “read-write”, or if the available space on the network 
volume is too small.

For these reasons, the installation instructions recommend the local 
(internal) hard drive for 4D Backup (typically “C:” or “D:” on a PC server). 
After the 4D Backup completes, you can then save the contents of the 
backup folder on the local drive to a network volume, using a local or a 
network-based backup program. On Windows NT, you can also use a batch 
file in conjunction with the Scheduler service, to copy the contents of the 
backup folder at a particular time of day.

4 The daily backup should be scheduled for a time when there are no users 
logged on to SELPA Manager.

If 4D Backup begins to make the daily backup when users are connected to 
the server, then these users will be prevented from using the program, for the 
duration of the backup. 

Furthermore, if users are accessing a student record via the data entry form, 
or are accessing certain other types of records from the data entry form, then 
4D Backup may stop part-way through the backup, and wait until the form 
is closed. 

For these reasons, it is recommended that the daily backup take place at an 
odd hour (e.g., early morning such as 2:30 am). There is an administrative 
preference available to disconnect users at a particular time, which could be 
set (for example) to 15 minutes before the backup is scheduled to begin.

5 If 4D Backup fails, you may need to re-create the Backup Project file. 

If possible, determine the cause of the failure. Was the volume onto which 
the backup was scheduled to be sent full or not available? Have the access 
privileges to the volume changed? Is the volume a removable cartridge 
drive, with no cartridge inserted? If a cartridge is present, does the cartridge 
have a different volume name than the name expected by 4D Backup?



To restart 4D Backup, try making a full backup manually, from the Backup 
menu. If the manual backup completes successfully, then reset the time for 
the next automatic backup, in the Backup Scheduler window,. Verify on the 
following day that the automatic backup has resumed, by checking for the 
existence of the next backup file on disk. 

If the automatic backup did not occur as scheduled, then locate the current 
Backup Project file and delete it (“Backup.4BP” for a PC or “Backup 
Project” for Macintosh). 

Then create a new Backup Project file, by performing the steps of the 
SELPA Manager Server installation that deal with creating backup files and 
the log file (“Full backup...”, Step 34 and beyond of the PC server 
installation or Step 23 and beyond of the Macintosh server installation).
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 3 Using SELPA Manager

[rev. 1.2006]

This section covers some of the more fundamental aspects of using SELPA 
Manager, through its standard (non-web) interface.

First, we present some conventions that are used throughout this document, 
and demonstrate how to start the program from your computer.

Next, there is a discussion of the principal types of forms in the program. We 
place particular emphasis on the browse window and how to use it, because 
it is the main access point into the various sections of the program. There are 
some examples of how to change data views (contexts) in the browse 
window, and how to search for records.

Finally, there is a general discussion of how to use data entry forms –
navigating among the fields, entering coded information, choice lists, data 
entry area types, record validation, and accepting records.

If you will be accessing SELPA Manager exclusively using the web 
interface (with a web browser program such as Internet Explorer, Mozilla, 
Firefox, or Safari), then this chapter may not be relevant to your needs. 
Please refer to the later chapter on entering IEP forms through the web 
interface.

If SELPA Manager is not yet installed on your computer, then you should 
complete that task first (refer to the Chapter, “Installing SELPA Manager” 
on page 49), and then return to this chapter.
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Conventions used in this manual

For consistency, certain formatting conventions appear throughout this 
manual to denote particular objects or actions.

1 The names of data tables within the program appear in square brackets. For 
example, [Student] or [Teacher].

2 The name of a field appears immediately after the name of the table that 
contains it. For example: [Student]Last_name, [School]School_code, 
[Student_service]CASEMIS_service_code.

3 The names of keystrokes appear italicized, uppercase, within square 
brackets. For example, [ESC] means the Escape key on the keyboard. 

4 When a keystroke is a modifier to another key or action, it will precede the 
other key or action, with a hyphen. Because some modifiers are different 
between PC and Macintosh platforms, the PC modifier appears first, followed 
by a slash and the Macintosh modifier. For example, the phrase 
[ALT/OPTION]-click means that you would hold down the [ALT] key on a PC or 
the [OPTION] key on a Macintosh, while clicking on an object with the mouse.

5 The name of a button on a form generally appears in all-capital letters. For 
example, press the SAVE button to accept changes to a record.

6 Angle brackets denote that some user input from the keyboard is expected. 
For example, an instruction to type “assignments for” <teacher name> means 
that you would enter a particular teacher’s name: “assignments for King, Julie”.

7 Illustrations of user input from the keyboard appear in a monospaced font. For 
example: 

City is not Benicia

8 Words that appear in boldface indicate emphasis, and may also indicate the 
first use of a new term in the documentation. Italics are also used occasionally 
for emphasis.

Getting started
The means by which you access SELPA Manager will depend upon whether 
you are using a single-user edition (“single-user runtime”) or a multi-user 
(client-server) edition, and whether your workstation is a Windows PC or a 
Macintosh. Furthermore, the login user name which you use to connect to 
SELPA Manager will determine the level of access (permissions) that you 
will have to various sections and features.



Single-user runtime
To begin using the single-user version of SELPA Manager, if you have a 
shortcut or alias on the Desktop to the program, then you can double-click 
on that shortcut. 

On a Windows PC, there should also be a listed item for SELPA Manager in 
the Start menu (the “SELPA Manager 4.75 RT” item, in Fig. 3-1), which you 
can select to run the program.

Fig. 3-1. Selecting the SELPA Manager single-user runtime from the Windows Start 
menu.

For Macintosh OS X users, check for a SELPA Manager alias (shortcut) on 
your desktop, in the Dock, or in the Folder Toolbar. If you do not have one 
in any of these places, then you may want to create one. The normal location 
for the program itself is in the folder:

~Applications/SELPA Mgr Runtime

An example installation is shown in Fig. 3-2. The SELPA Manager program 
has a name similar to “Selpa 4.75x RT”, and has a blue cube icon with 
diagonal stripes.
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Fig. 3-2. The SELPA Manager program in its installed directory (Macintosh single-
user).

Client-server (multi-user)
To begin using the client-server version of SELPA Manager, you must run 
the 4D Client application on your workstation, and then connect to the 
appropriate 4D Server on the network.

To begin using SELPA Manager client-server:

1 Start the 4D Client application on your workstation.

There may be a shortcut or an alias on your Desktop to 4D Client, in which 
case you can double-click on that shortcut. 

On Windows workstations, there should be a 4D Client listing in the Start 
menu, as shown in Fig. 3-3.

For Macintosh OS X users, check for a 4D Client alias (shortcut) on your 
desktop, in the Dock, or in the Folder Toolbar. If you do not have one in any 
of these places, then you may want to create one. The normal, installed 
location for the 4D Client application itself is in the Applications folder.

2 (Local area network connections only) On the “TCP/IP” tab of the 
connection dialog, highlight the SELPA Manager application, then press 
the OK button to connect.

4D Client will present a connection dialog containing three tabs (Fig. 3-4, 
“Connection to 4D Server”). If 4D Client has not connected to the server 
before from this particular workstation, then the dialog will open on the 
middle, “TCP/IP” tab.



Fig. 3-3. The 4D Client application, in the Windows Start menu (Windows client-
server).

Fig. 3-4. 4D Client connection dialog, “TCP/IP” tab, starting 4D Client from a 
workstation.
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The SELPA Manager server should be listed in this tab, with a name similar 
to “Selpa_Mgr_v475.4DC” or “Selpa_Mgr_v475.comp”, followed by the 
host (server) computer name. If this item is not already selected 
(highlighted), then click once on the row to highlight it, and then press the 
OK button to connect to the server.

If your computer has already connected at least once before to the SELPA 
Manager server, then the dialog will initially display on the first (“Recent”) 
tab rather than the middle (“TCP/IP”) tab, and the server name may already 
be highlighted.

3 (Wide area network connections only) Create a “custom” entry in the 
connection dialog, then press OK to connect.

If the server is located in another segment of your network1, then it will not 
be listed on the “TCP/IP” tab of the connection dialog when you run 4D 
Client. Instead, you will need to obtain the IP number or the domain name 
of the server, and enter it manually. 

Click on the “Custom” tab, and a form for manual entry of the server 
information appears, as in Fig. 3-5.

Fig. 3-5. 4D Client connection dialog, “Custom” tab, for manually entering a TCP 
address and then selecting the server (starting 4D Client from a workstation).

1. In other words, your workstation is one or more router “hops” away from the SELPA Manager
server.



In the “Database Name” box on the dialog, enter a name for the server, as 
you would like it to appear subsequently on the “Recent” tab, when you run 
4D Client again. 

In the “Network Address” box, enter the server’s IP address, or a valid 
domain name for the server computer.1 Then press the OK button to connect 
to the server. 

4D Client will add the name of the server to the list in the “Recent” tab, for 
the next time that you connect.

4 Wait for cache files to be created.

On the first time that a workstation connects to 4D Server, the user will see 
a series of two messages at the lower-right corner of your screen 
(“Duplicating resources locally”). These messages indicate that 4D Client is 
downloading information from the server to local cache files, on the 
workstation’s hard disk. 

If network access speed is adequate, then the two messages should appear 
for a few seconds each. If the network connection is slow, then these 
messages will display for a longer time. If you are connecting over the 
Internet with a dial-up or a DSL connection, then the messages may appear 
for a much longer time.

If you do not see the “Duplicating resources locally” messages at all, then 
your 4D Client may have already connected once to the SELPA Manager 
server, and the local cache files are up-to-date with the version of SELPA 
Manager residing on the server. In this case, 4D Client will immediately 
present the Password dialog (refer to “Accessing SELPA Manager (user 
connection)” on page 141).

5 If you encounter problems connecting to 4D Client...

If there are no names listed in the “TCP/IP” selection window (Step 2), then 
you should verify that the 4D Server application is indeed running on a local 
area network (LAN) server computer, and that it has been properly 
configured (refer to “PC client-server (server installation)” on page 57, or to 
“Macintosh client-server (server installation)” on page 94).

1. You can obtain the server TCP/IP address from your network administrator or (if you have
physical access to the server) from the Network control panel.
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If the server is listed in the “TCP/IP” tab of the connection dialog, but 4D 
Client is unable to connect, then it typically displays an error message, and 
then the client application quits.

If you obtain a “-10001” or a “-10002” error on attempting to connect, check 
that your Ethernet cable and that the network connection are in good 
condition. In the case of a “-10002” error, there may be a problem with the 
network, or with the configuration of network control panels on either the 
server or the 4D Client workstation.

If you are in a training class with other program users, ensure that users 
connect sequentially to the server, rather than all at once. The network 
bandwidth from the classroom to the server may not be sufficient to handle 
multiple simultaneous logins. In this circumstance, the workstations may 
“stall” for an extended period of time, without displaying any error 
messages.

Verify that the server and the workstation are using compatible versions of 
4D Server and 4D Client, respectively (e.g., 4D Client 2003.4 connecting to 
4D Server 2003.4). If you happen to be using 4D Client 6.7.2 (from an 
earlier installation of SELPA Manager) rather than 4D Client 2003.4, then 
the 6.7.x client will not successfully connect to 4D Server 2003.x.

If you obtain a “-10001” error when connecting to 4D Server subsequent to 
a first, successful connection, first ensure that 4D Client can still “see” the 
server, by switching from the “Recent” to the “TCP/IP” tab. 

If the name of the SELPA Manager server has changed, or if the computer 
hosting the server has changed, then switching in 4D Client to the “TCP/IP” 
tab may enable you to find the server at a new address. If the server is listed 
on the “TCP/IP” tab, then try clicking on it and pressing the OK button to 
connect.

If the server is not listed on the “TCP/IP” tab, then there may be a problem 
with the server computer, the server may be off-line, or it may have been 
relocated so that it is no longer on your local area network. In the latter case, 
you will need to obtain an IP number for the server, and enter it on the 
“Custom” tab.



If the server is listed on the “TCP/IP” tab, but the connection failure persists, 
then try deleting the cache files in the workstation’s local “4D” folder.1 This 
action will force the client to download the cache files again, on connection 
with the server (you will see the message, “Duplicating resources locally”). 

To delete the cache files within the 4D folder, locate the folder named 
“Selpa_Mgr_v475.4DC” or “Selpa_Mgr_v475.comp”, and move this folder 
to the Trash or Recycle Bin. Then start the 4D Client application again.

You can also remove the items listed in the “Favorites” folder, within the 4D 
folder. If there are no items in this folder, then 4D Client will again display 
the “TCP/IP” tab rather than the “Recent” tab, when starting 4D Client. 

Accessing SELPA Manager (user connection)
Upon starting SELPA Manager single-user runtime, or upon starting 4D 
Client and then selecting the SELPA Manager server, SELPA Manager will 
display a connection, or login dialog (Fig. 3-6). Login names are listed in 
alphabetical order. 

Select the user account that you wish to connect with, by highlighting the 
name in the upper list. Then enter the corresponding password for that user 
name, in the box below the list. You can quickly highlight a user name by 
typing the first character or two of the name, and then use the [TAB] key to 
move the cursor into the Password entry area.

If you don’t enter the correct password for the highlighted user, then the 
login dialog will remain on the screen, and the connection to SELPA 
Manager will not proceed.

1. The Windows path is, for example, “C:\Windows\4D” or “C:\Winnt\4D”. If there is no 4D
folder in this location, then there may be a separate 4D folder for each login user – check
“C:\Documents and Settings\<userName>\4D.”

On Macintosh OS 9, the 4D folder is in Preferences, in the System Folder. On Macintosh OS X,
the path is ~Library/Application Support/4D. Contact technical support for more information.
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Fig. 3-6. Login dialog for SELPA Manager. Highlight the desired user login name, then 
enter the corresponding password in the lower box.

Default (prototype) login names

Initially, there are eight “default” user account names available. If you 
access SELPA Manager with the Administrator login name, you can then 
select the “Users and groups...” item in the File menu to change seven of the 
eight default login names (all except Designer, refer to “Users and groups...” 
on page 573). 

With the multi-user version of SELPA Manager, more than one person may 
connect with the same user name, at the same time. To maximize the benefits 
of the access system, however, you will want to create a unique name for 
each program user.

Six of the eight “default” user login names (all except Designer and 
Administrator) are prototypes, illustrative of a particular level of access to 
SELPA Manager. You may want to try them for a period of time, to 
acclimate yourself with these different levels of access. Then you can re-
name these six prototypes for actual users at your site, and assign access 
levels that are appropriate to these users.

NOTE: Once a user login name is added to the program, it is not possible to 
delete the individual entry. The entry can be changed to another name, or 
disabled by entering a new password that is unknown to the other program 



users. As an alternative, the entire list of users and access groups can be 
replaced by another set, using the “Load groups” command. For additional 
information, refer to “Users and groups...” on page 573.

Each user login name can be associated with one or more user access 
groups. Presently, there are nine user access groups in SELPA Manager. The 
access groups are named “AdminGroup”, “CounselorLtdGrp”, 
“MyCalendarItems”, “MyDistrictRstrs”, “ReadWriteGrp”, 
“TeacherGrp”, “TeacherLtdGrp”, “TransportGrp”, and “4DWriteGrp”. 

The access group(s) to which a user belongs largely determines the user’s 
ability to perform program functions1. These groups are described under 
“Using access groups (custom user names)” on page 146.

The eight default user login names (in alphabetical order) are:

1 Administrator

With exception only to the Designer, the Administrator has the highest level 
of access to the program. The Administrator can add or change program 
users and their access level; change passwords; edit existing records; create 
new records; import records; perform custom-programmed functions using 
the Special Operations dialog; perform changes to selections of listed 
records (batch change operations); activate and then check the audit trail2 
feature for individual records; and access all preference/configuration 
features in SELPA Manager, including those that affect other program users. 
The Administrator is a member of the “AdminGroup” access group.

2 Counselor, Limited

This example user can only create or modify assessment (IEP) forms, and 
does not have access to the standard browse window3 and its associated 
functions. Instead, the program will present a more limited window that lists 
either students or IEPs. This user can double-click on an existing IEP to 
examine or edit the form, or double-click on an existing student to create a 
new IEP for that student. 

1. Users not in the “TeacherGrp” or “TeacherLtdGrp” access groups can further be limited to
accessing records from particular schools or districts, as designated by an administrative user.
Refer to “School or district access restrictions” on page 156.
2. For more information on the audit trail feature, refer to the “Audit trail” on page 270.
3. Refer to “Using the browse window (browser)” on page 168.
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However, the user cannot examine the individual student records or 
associated information, beyond what is visible from the student listings 
themselves.

This user cannot change preference settings that affect other users. S/he 
cannot access audit trail information. S/he is a member of the 
“CounselorLtdGrp” access group.

3 Designer 

This user name is reserved for the program developer. You should not 
attempt to log in to SELPA Manager as the Designer.

4 Martinez, Waldo

Waldo Martinez is a prototypical user that does not belong to any access 
group. He might be a principal or a district administrator that needs to see, 
but not to change, existing information. As a result, if you log in to SELPA 
Manager as Waldo, you will be able to view most records, but will not be 
able to create new or edit existing records. The SAVE button on data entry 
forms will be dimmed. Waldo cannot import records1, perform batch change 
operations, access the audit trail feature or Special Operations, or access 
student disciplinary action information.

5 Read-Write User 

This example user has a level of access that is below the Administrator, but 
higher than Waldo Martinez. As a member of the “ReadWriteGrp”, this user 
has read-write access to most sections of the program, using the standard 
browse window. However, this user cannot change preference settings that 
affect other users. This user cannot access audit trail information.

6 Teacher, Limited

This example user can only create or modify assessment (IEP) forms and 
does not have access to the standard browse window and its associated 
functions. Instead, the program will present a more limited dialog that 
allows this user to access listings of students and of IEPs. 

This user can double-click on an existing IEP to examine or edit the form. 
The user can double-click on a student to create a new IEP for that student. 
However, the user cannot create or edit individual student records, and 
cannot examine them beyond what is viewable from the student listing on 
the limited dialog.
1. Except when first opening a new data file, for the first time.



Unlike the “Counselor, Limited” user, who can generally access IEPs for 
any student in the program1, this user can only create IEP forms for new 
students, or for existing students for whom the teacher provides at least one 
service.2

This user cannot change preference settings that affect other users. S/he 
cannot access audit trail information. This user is a member of the 
“TeacherLtdGrp” access group.

7 Teacher, Standard

Like the “Read-Write User”, this example user has read-write access to 
records using the standard browse window. However, the user is restricted 
to accessing only those students and student-related records for whom the 
user provides at least one student service. Students that do not have at least 
one service provided by this user will not be accessible.3

This user may create new student records. However, if the new student does 
not receive at least one service by the user as a teacher/provider, then the 
user won’t be able to access the student record during subsequent program 
sessions. 

This user cannot change preference settings that affect other users, and 
cannot access audit trail information. This user is a member of the 
“TeacherGrp” and the “MyCalendarItems” access groups. Because of the 
membership in “MyCalendarItems”, s/he can only view his/her own 
Calendar items, and not those of other users.

8 Transport User

This example user is somewhat similar to “Waldo Martinez” in that s/he has 
access to the standard browse window, but cannot create new records. For 
the most part, this user also cannot edit existing records. However, this user 
can modify transportation-related information for an existing student, by 
accessing either limited portions of the standard, student data entry form, or 
by accessing a special, transportation-only data entry form4. 

1. School or district access restrictions, if present, will reduce the user s ability to access partic-

ular IEPs. Refer to “School or district access restrictions” on page 156.
2. If the user did not create a student service in the process of creating an IEP for a new student,
or if the SELPA’s IEP form itself does not permit entry of student services, then SELPA Man-
ager will automatically create a “dummy” service when the new assessment record is saved.
3. That is, the student and student-related records will not appear in the browse window (refer
to “Using the browse window (browser)” on page 168).
Using SELPA Manager 145 

• 
• 
• 
•
•
•



146  

• 
• 
• 
•
•
•

This user can access the audit trail feature to identify changes to individual 
student records, but cannot access the audit trail information in any of the 
other program sections. This user is a member of the “TransportGrp” access 
group.

Using access groups (custom user names)
In addition to or place of the user account names that appear by default in 
the login dialog (Fig. 3-6), the Administrator can create other, custom 
account names in SELPA Manager. Therefore, when you connect to the 
program, you may see a different selection of user names than in Fig. 3-6.

The Passwords dialog, or the Simplified Passwords dialog, permit the 
customizing of user login names and access levels (File menu -> “Users and 
Groups”, refer to “Users and groups...” on page 573). Initially, only the 
Administrator can access the Passwords dialog. However, the Administrator 
may then assign ownership of certain access group(s) to other users.1 Once 
a user is the owner of an access group, then s/he may access the Passwords 
dialog. The Simplified Passwords dialog is available to all administrative 
users.

Custom login names may contain up to approximately 30 characters. Each 
program user can thus access SELPA Manager with his or her own, 
individual name. The Administrator may also replace the default login 
names, such as “Martinez, Waldo” or “Transport User”, with custom names.

The access group or groups into which the Administrator places the login 
users will largely determine their level of access to program features.

There are nine user access groups (listed in their order of appearance 
in the Passwords dialog):

1 AdminGroup 

Membership in the “AdminGroup” access group confers a high level of 
access to SELPA Manager. Members generally have access to the same 
program areas and features as the user named Administrator (the 
4. The “Transport only” box must be checked in Preferences for this user, to enable this form.
Refer to “Transportation only” on page 299. On the standard data entry form for students, entry
into non-transportation fields will be disabled. 
1. However, group owners must themselves be members of the “AdminGroup” access group.
Otherwise, the File menu item will be “Change password...” rather than “Users and groups...”



Administrator is a member of the “AdminGroup”). Members of this group 
are also referred to as “administrative users”; or users with “administrative 
access” or “administrative privileges.” 

Unlike the Administrator, however, the other “AdminGroup” members 
generally cannot use the Passwords dialog to edit, add or delete the login 
names of other program users, or change their passwords or group 
memberships.1 “AdminGroup” members can impose school or district 
access restrictions on themselves and on other users, however.

Members of the “AdminGroup” access group are also automatically 
members of the “ReadWriteGrp” and “TransportGrp” access groups.

2 ReadWriteGrp

Members of this group can edit existing records and create new records in 
most sections of the program. They can import records; perform batch 
change operations; and access the audit trail information for individual 
records. However, they cannot edit, add or delete program users, or change 
their passwords. They cannot access the Special Operations dialog. Nor can 
they change Preferences settings that affect other program users.

3 TransportGrp

Members of this group have the privileges of the user, “Transport user”, as 
described on page 145, above. They have access to the standard browse 
window, but cannot add new records and cannot edit existing records in most 
sections of the program. 

They may use a special, transportation-only data entry form, or use limited 
portions of the standard student data entry form, to edit transportation 
information, for existing students only. They can access audit trail 
information for student records, but not for other types of records. 

4 4DWriteGrp

Membership in this access group is supplemental to membership in one of 
the other groups. Among the sample program users, only the Administrator 
is placed into this group initially. 

1. Exceptions: (1) Administrative users can access the Simplified Passwords dialog to edit ex-
isting user names, passwords, and group associations; (2) The Administrator can designate an
administrative user to be the owner of an access group, thereby allowing the user to gain access
to the Passwords dialog. For further discussion, please refer to “Users and groups...” on
page 573.
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Members of “4DWriteGrp” have access to a special, word processing plug-
in (4D Write) within SELPA Manager, provided that sufficient license 
“seats” for 4D Write are installed on the server. On the single-user editions 
of the program, access to 4D Write is automatic for any user belonging to 
this access group.

4D Write allows users to design custom forms that can be prepared for a 
selection of student records, teacher records, etc., as “mail merge” 
documents. 

4D Write can also be used to prepare fully-formatted, word processing-type 
documents within a particular student or disciplinary action record. SELPA 
Manager automatically saves these documents in the database, when you 
save the student or discipline record. The user can also save these documents 
separately, outside of the database, as a file on disk.

4D Write is further discussed on page 225, and in the appendices.

When a member of the “4DWriteGrp” first connects to a SELPA Manager 
server, the server determines whether an unoccupied license “seat” is 
available for the user. If so, the server enables the user to access 4D Write 
for the duration of his/her connection, and the available number of license 
seats is reduced by one. If all available licenses are taken, then access to 4D 
Write is not enabled. 

Licenses for 4D Write are installed on the server as expansion products 
(refer to the previous instructions for installing SELPA Manager, server 
editions, on page 85 (Step 46) and page 116 (Step 35).

5 TeacherGrp

Members of this group have the privileges of the user, “Teacher, Standard”, 
as described on page 145, above. They may edit existing records and create 
new records in student-related sections of the program. However, only 
existing students for whom the user provides, or is scheduled to provide, at 
least one service will be visible in the browse window. 

If the “TeacherGrp” user does not provide at least one service for a new 
student, prior to saving a new student record, then the student and associated 
items will not be accessible subsequently, in the browse window.

6 MyCalendarItems 



Membership in this access group is intended to supplement membership in 
one of the other access groups. 

Members of “MyCalendarItems” can access only those Calendar items that 
they create themselves. They cannot view or edit Calendar items posted by 
other program users. The default user, “Teacher, Standard” is listed in this 
access group. 

This access group is not applicable to users who are also in the 
“TeacherLtdGrp” or the “CounselorLtdGrp”, because these groups cannot 
access the Calendar itself (they do not use the standard browse window).

7 TeacherLtdGrp

Members of this group have the privileges of the user, “Teacher, Limited”, 
as described on page 144, above. They do not have access to the standard 
browse window. Instead, the program will present a more limited dialog that 
allows them to access listings of students and of IEPs. Group members can 
double-click on an existing IEP to examine or edit the form; however, they 
cannot similarly examine individual student records.

Members of this group can only create IEP forms for new students, or for 
existing students for whom the teacher provides at least one service.1 If they 
attempt to add an IEP for an existing student for whom they provide no 
services, SELPA Manager will create the IEP for a new student, with the 
same name as the existing student.

8 CounselorLtdGrp

Members of this group have the privileges of the user, “Counselor, Limited”, 
as described on page 143, above. They do not have access to the standard 
browse window. Instead, the program will present a more limited dialog that 
allows them to access listings of students and of IEPs. 

Group members can double-click on an existing IEP to examine or edit the 
form. They can also double-click on an existing student, to create a new IEP 
for the student. However, they cannot examine individual student records.

Unlike the members of the “TeacherLtdGrp”, members of this group can 
create an IEP for an existing student or for a new student, regardless of 
whether or not the group member provides a service to the student.

1. If the user did not create a student service in the process of creating an IEP for a new student,
or if the SELPA’s IEP form itself does not permit entry of student services, then SELPA Man-
ager will automatically create a “dummy” service when the new assessment record is saved.
Using SELPA Manager 149 

• 
• 
• 
•
•
•



150  

• 
• 
• 
•
•
•

t in

up

itedj
9 MyDistrictRstrs

Membership in this access group is intended to supplement membership in 
one of the other access groups. Members of this group can edit their own 
school or district access restrictions, but not those of other program users. 
Members of the “AdminGroup” access group normally perform this 
function.

User not a member of any group

When a custom user is not a member of any of these access groups, then s/he 
has read-only access to SELPA Manager, similar to the default user, Waldo 
Martinez. Unlike members of the “TeacherGrp” and “TeacherLtdGrp” 
access groups, however, a user that does not belong to any group can view 
information related to any student.

Function-privilege summary

The table below summarizes group-based access privileges for the user 
access groups (excluding “MyCalendarItems”).

Function / privilege summary by access groupa

Function / privilege Admin
Group

Read
Write
Grp

Teacher
Grp

Teacher
Ltd
Grp

Coun
selor
LtdGrp

Trans
port
Grp

4D
Write
Grp

My
District
Rstrs

No
any
Gro

Create or edit program users; assign 
passwords and privileges 
(Passwords dialog)

Limitedb No No No No No N/Ac N/Ad No

Specify school or district-level 
restrictions for program userse

Yes No No No No No N/A Limitedf No

Receive school or district-level 
restrictions

Yes Yes No No Yes Yes N/A Yes Yes

Access the Special Operations 
dialog

Yes No No No No No N/A N/A No

Set system-wide preferences 
(affecting all users)

Yes No No No No No N/A N/A No

Set non-system-wide preferences 
(affecting login user only)

Yes Yes Yes Limitedg Limitedh Limitedi N/A N/A Lim



 
y

 
y

 
yq

t in

up
Serialize (register) SELPA Manager 
or update license

Yes New 
onlyk

New 
only

New 
only

New 
only

New 
only

N/A N/A New
onl

Set the Report As Of date (for 
CASEMIS)

Yes New 
onlyl

New 
only

New 
only

New 
only

New 
only

N/A N/A New
onl

Set the “Age calcs. fm.” date (base 
date for student age calculations)

Yes No No No No No N/A N/A No

Access audit trail information Yes No No No No Limited
m

N/A N/A No

Import information into SELPA 
Manager

Yes Yes Yes New 
onlyn

New 
onlyo

New 
onlyp

N/A N/A New
onl

Use 4D Write (word processing / 
mail merge, on various forms)

N/A N/A N/A N/A N/A N/A Yesr N/A N/A

Transfer (send) student information 
(SELPA Central, district-to-district, 
MediCal, 3702 student/services 
formats)

Yes Yes Limiteds Limitedt Limitedu No N/A N/A No

Transfer (send) assessment 
information (IEP forms or goals, not 
as SELPA Central)

Yes Yes Limitedv No No No N/A N/A No

Transfer (send) goals/objectives 
palette items to another SELPA 
Manager user

Yes Yes Yes No No No N/A N/A No

Repair/revise date fields from the 
browse window

Yes No No No No No N/A N/A No

Check next student number for each 
district, from the browse window

Yes No No No No No N/A N/A No

Reissue record numbers for selected 
records. 

Yes No No No No No N/A N/A No

Fix zero primary keys in user tables. Yes No No No No No N/A N/A No

Purge audit trail information (record 
change history)

Yes No No No No No N/A N/A No

CASEMIS reports (reporting 
services to the state)

Yes No No No No No N/A N/A No

Function / privilege summary by access groupa

Function / privilege Admin
Group

Read
Write
Grp

Teacher
Grp

Teacher
Ltd
Grp
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LtdGrp

Trans
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Grp
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any
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Edit student, student-related records Yes Yes Limited
w

Limitedx Limitedy Limitedz N/A N/A No

Add new student or student-related 
record

Yes Yes Limited
aa

Limited
ab

Limited
ac

No N/A N/A No

Edit or add teacher, assignment, 
school, or district records

Yes Yes Limitedad No No No N/A N/A No

Delete records from the browse 
window

Yes Limitedae No No No No N/A N/A No

Use “Show current for...” menu item 
(Data menu)

Yes Yes No No No Yes N/A N/A Yes

Perform batch updates (“Update 
user fields...” or “Update other...” 
from the Actions menu)

Yes Yes Limitedaf No No No N/A N/A No

Check for duplicate students, and 
designate a reporting student where 
duplicates exist

Yes Yes Limitedag No No No N/A N/A No

Print district-related reports (district 
chargeback, student service 
summary, personnel data, CBEDS 
county/district info., SNOR, OCR 
District Summary)

Yes Yes Yesah No No Yes N/A N/A Yes

Batch assign a class code to a 
selection of student services; drop or 
continue services; or move one or 
more services to another year

Yes Yes Limitedai No No No N/A N/A No

Batch assign a teacher to a selection 
of student services

Yes Yes No No No No N/A N/A No

Merge two or more teacher records 
together

Yes Yes No No No No N/A N/A No

Batch change grades; recalculate 
ages; assign a case manager; or 
assign a school of attendance to 
selected student records

Yes Yes Limitedaj No No No N/A N/A No

Function / privilege summary by access groupa

Function / privilege Admin
Group

Read
Write
Grp

Teacher
Grp

Teacher
Ltd
Grp

Coun
selor
LtdGrp

Trans
port
Grp

4D
Write
Grp

My
District
Rstrs

No
any
Gro
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Print attendance registers or student 
by teacher reports

Yes Yes Limitedak No No No N/A N/A No

Start or stop web services (web 
server)al

Yes Yes Yes No No No N/A N/A No

Convert service codes for a selection 
of student services

Yes Yes Limited
am

No No No N/A N/A No

Batch calculate percent outside 
regular class; update Quick Report 
address fields; or change certain 
PARTICIP (STAR) codes, for a 
selection of student records.

Yes Yes Limitedan No No No N/A N/A No

a. A program user (login user) can be a member of more than one group.
b. Must be the owner of at least one access group, to use the Passwords dialog. Initially, only the Administrator fall
into this category. However, “AdminGroup” members other than the Administrator can use the Simplified Pass
words dialog to perform more limited tasks: changing names, passwords, and/or group affiliations of existing users
c. Not applicable - membership in this group does not confer or remove this privilege.

d. Not applicable - membership in this group does not confer or remove this privilege.

e. Refer to School or district access restrictions  on page 156.

f. Unless the user is also a member of the AdminGroup  access group, the user can only change his or her own

school or district access restrictions.

g. Cannot change settings that affect the standard browse window (this group does not have access to the standar
browse window).
h. Same as above.
i. Because TransportGrp  members cannot add new records to any section, the Add new record loop  option is

not available.

j. Excluding user preferences that are related to entering new or existing records, since this user cannot add or mod

ify any records.

k. For a newly-created data file only.
l. For a newly-created data file only.
m. “TransportGrp” members can access audit trail information for student records only.
n. For a newly-created (empty) data file only, user can perform a one-time, SELPA Central import.
o. Same as above.
p. Same as above.
q. Same as above.
r. In the multi-user editions of SELPA Manager, subject to the availability of licenses. Licenses are assigned on 
first-come, first-served basis to group members.
s. Transfer is limited to students and student-associated records for whom the user provides at least one service.
t. Transfer is limited to a SELPA Central export of those students for whom the user has created at least one IE
form (no custom options during export).
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Relationships among access groups
Some of the default access groups are themselves members of other access 
groups. For example, the “TeacherGrp” access group is itself a member of 
the “ReadWriteGrp” access group. Members of “TeacherGrp” obtain some 
of the privileges of the “ReadWriteGrp”, but with additional restrictions – 
“TeacherGrp” members are limited to accessing students (and associated 
information) for whom/which they provide student services.

u. Transfer is limited to a SELPA Central export of those students for whom the user has created or modified a
least one IEP form (no custom options during export).
v. Transfer is limited to IEPs and goal records of students for whom the user provides at least one service.
w. Limited to students for whom the user provides at least one service.
x. “TeacherLtdGrp” members can add or edit assessment (IEP) forms only, for either new students or existing stu
dents for whom they provide at least one service. They cannot directly edit students or other student-associated in
formation.
y. “CounselorLtdGrp” members can add or edit assessment (IEP) forms only, for either new students or existin
students. They cannot directly edit students or other student-associated information.
z. “TransportGrp” members can only edit certain, transportation-related fields on student records. The scope o
transportation-related fields that can be edited increases if an administrative user checks the “More transport-onl
fields” box in Preferences (page 272).
aa. Student will not be accessible subsequently, unless user provides at least one service for the student.
ab. User can only add an IEP, either for an existing student or for a new student. For a new student, the studen

record is created at the time that the IEP records is saved. User cannot add student records directly.

ac. User can only add an IEP, either for an existing student or for a new student. For a new student, the studen

record is created at the time that the IEP records is saved. User cannot add student records directly.

ad. TeacherGrp  user can only edit his/her own teacher and assignment records, not those of other teachers or staff

members. On the assignment records of other teachers, the TeacherGrp  user cannot view or edit attendance in-

formation. The user also cannot change his or her own name on the teacher record. The TeacherGrp  user has

view-only access to school and district information.

ae. Deletion of tracking records not permitted (“AdminGroup” access group only).
af. Limited to students and student-related records, for whom the user provides at least one service.
ag. Limited to students for whom the user provides at least one service.
ah. For the district chargeback report, TeacherGrp  users can only select a school at which they provide student

services.

ai. Limited to services of students for whom the user provides at least one service.
aj. Limited to students for whom the user provides at least one service.
ak. For “TeacherGrp” users, attendance registers and student by teacher reports are limited to students for whom
the user is the teacher.
al. Applies to single-user editions of SELPA Manager only. On the multi-user editions, web services are starte
from the server.
am. Limited to student services provided by the user.
an. Limited to students and student-related records, for whom the user provides at least one service.



The “TeacherLtdGrp” access group is itself a member of “TeacherGrp”, but 
is further restricted to editing assessment (IEP) forms only.

Fig. 3-7 is a summary of the relationships among the default access groups 
in SELPA Manager. Groups that are fully-contained (“nested”) within 
another group on the diagram, like “TeacherGrp” and “TeacherLtdGrp”, 
have a subset of the functionality of the containing or parent group. 

An access group which overlaps another group shares some, but not all 
functionality. For example, “AdminGroup” has all of the functionality of the 
“ReadWriteGrp”. However, “AdminGroup” members have other, additional 
privileges beyond those of “ReadWriteGrp” members. 

Groups that do not overlap at all (e.g., 4DWriteGrp and ReadWriteGrp) 
indicate separate functionality or privileges.

Fig. 3-7. Summary of the relationships among user access groups. The 
“CounselorLtdGrp” is not shown to reduce confusion. If it were to be shown, it would 
most likely overlap the “TeacherLtdGrp” and extend into the “ReadWriteGrp”.

The Administrator can also create custom access groups1. By “nesting” 
these custom access groups within one of the default access groups, the 
Administrator can create sub-groups of users that have the same privileges 

1. Creating custom access groups is not necessary for using SELPA Manager. Administrators

who are new to the program may want to skip this discussion for the present.
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as the group into which they are nested, with no additional restrictions 
imposed. A discussion of creating and nesting custom access groups appears 
on page 580.

When deciding how to assign SELPA Manager users to access groups that 
have overlapping or nested functionality, you should place each user into the 
group representing the highest level of access that you would like for the 
user to exercise. 

For example, if a user should have administrative privileges, you should 
place the user into the “AdminGroup”. You should not also place the same 
user into the “ReadWriteGrp”, since “AdminGroup” members already have 
all the privileges of the “ReadWriteGrp”. 

Similarly, if you decide that a user should be limited to entering IEP forms 
only, you can place the user into the “TeacherLtdGrp” or the 
“CounselorLtdGrp”. You should not also place the user into the 
“ReadWriteGrp” or the “TeacherGrp”, which have supersets of 
“TeacherLtdGrp” functionality.

WARNING: Do not remove the Administrator from the “AdminGroup” 
access group. If you remove the Administrator from this group, then you may 
not be able to edit users and groups information any more. Do not change 
the “nested” relationships of the existing access groups, or the program may 
not function as expected.

School or district access restrictions
NOTE: This is an advanced topic. If you are just starting to use SELPA 
Manager, then you may want to skip to “Completing the connection” on 
page 163.

Another technique is available to limit a user’s access to particular records: 
implementing school or district access restrictions on the user’s login 
account. The Administrator or other members of the “AdminGroup” access 
group can apply these restrictions to themselves and to other users. 
Members of the “MyDistrictRstrs” access group can apply these restrictions 
to themselves only.



In the absence of any school or district access restrictions, a user with read-
write access to the program1 may search for, add, or edit records in most 
sections of the program.

However, once an administrator has specified one or more school or district 
access restrictions for the user, then that user is limited to working with 
records that are associated with either the specified schools or the specified 
districts. The school restrictions always take precedence over the district 
access restrictions. If both school and district access restrictions are listed on 
a user account, then the program will use the school restrictions and ignore 
the district restrictions.

School or district access restrictions are applicable to any user, except for 
members of the “TeacherGrp” and “TeacherLtdGrp” access groups. The 
teacher-related groups restrict access based upon providing service to 
particular students, so that additional school or district restrictions would 
conflict. Thus, if you specify school or district restrictions for a user that is 
in one of these two access groups, then the program will ignore them.

If one or more school access restrictions are specified:

1 For [Student], [Student_service], [Student_contact], [Assessment], 
[Assessment_goal], [Transition], and [Disciplinary_action] records, the 
user can access items based upon the student’s school of enrollment.

2 For [Teacher], [Teacher_service], and [Assignment] records, the user can 
access items based upon the school where the teacher assignment takes 
place.

3 For [School] and [District] records, the criterion for access is the school 
name/code in the [School] table itself.

If one or more district access restrictions are specified, and NO school 
access restrictions are specified:

1 For [Student], [Student_service], [Student_contact], [Assessment], 
[Assessment_goal], [Transition], and [Disciplinary_action] records, the 
criterion for access is the first seven digits of the student record number 
([Student]Record_number). 

These seven digits normally represent the student’s district of residence.

1. That is, s/he is directly or indirectly a member of the “AdminGroup” or the “ReadWriteGrp” access
groups (refer to “Using access groups (custom user names)” on page 146).
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2 For [District], [School], [Assignment], [Teacher], and [Teacher_service] 
records, the criterion for access is the district code as listed in the 
[District] table itself.

Two levels of district access restriction are available.

1 In the basic level, the user cannot find or list records from which s/he is 
denied access. 

2 The second (enhanced) level allows the user to find, list, and view these 
records; however, s/he cannot save any edits to these records. 

For example, in the enhanced level, if a user with district access restrictions 
double-clicks in the browse window on a student record which is not in one 
of the specified districts, then the data entry form will display a “District 
access denied” message in the problems/warnings box, and the SAVE button 
will be disabled.

To define school or district access restrictions for an existing program 
user:

1 Ensure that you are connected to SELPA Manager as a member of the 
“AdminGroup” user access group.

If you connect to SELPA Manager as someone who is not in the 
“AdminGroup” access group, then you won’t be able to implement district 
access restrictions for other users. By default, the Administrator is a member 
of the “AdminGroup” user access group. For more information, refer to 
“Using access groups (custom user names)” on page 146.

2 Type “Show user info” into the Location box1 of a browse window, and 
then press [ENTER] or [RETURN].

SELPA Manager should then display program users ([User_info] records) in 
the upper list, and Calendar items in the lower list (Fig. 3-8). If necessary, 
select “Show all” from the Data menu to display all accessible program 
users in the upper list. 

If you are not familiar yet with using the browse window, refer to “Using the 
browse window (browser)” on page 168. 

1. The Location box is discussed in The Location box  on page 180.



If the desired program user name(s) do not appear in the upper list, then 
those user(s) may not have connected to SELPA Manager for the first time. 
In this case you can either: 

(1) Quit and then re-connect to SELPA Manager as each program user for 
whom you will specify school or district access restrictions. Once connected 
as a program user, quit without editing any records. After you have 
connected as each program user, then re-connect as Administrator.

(2) If you are connected as Administrator, then select “Users and groups...” 
from the File menu. The program will then display an “Editing users and 
groups...” dialog. Click on the PASSWORDS DIALOG button at the bottom 
of this form, to open the Passwords dialog. Then, without making any 
changes to users or groups, close the Passwords dialog by clicking on the 
window’s close box. SELPA Manager will ask whether it should create any 
new program users, in the [User_info] table (Fig. 3-9). Confirm the request 
by pressing the OK button, to create the new program user records.

For more information on employing the Passwords dialog for this purpose, 
refer to the instructions for adding a new user, in the Chapter, “File Menu 
Operations” on page 575. 
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Fig. 3-8. Browse window displaying user information.

Fig. 3-9. Confirmation dialog, which appears after closing the Passwords dialog (File 
menu -> “Users and groups...”.

3 Find the program user for whom you wish to apply user access 
restrictions. Double-click on the appropriate row, or highlight the row and 
select “Modify record” from the File menu.

The program user name should be listed in the first (User) column of the 
upper list, in the browse window. After you double-click on the row, SELPA 
Manager will present the data entry form corresponding to the selected user 
record. 



4 Press the RESTRICTIONS BY SCHOOL or the RESTRICTIONS BY 
DISTRICT button.

SELPA Manager will display a dialog (Fig. 3-10) to which you may add 
school or district restrictions for the user, by pressing either the 
RESTRICTIONS BY SCHOOL or the RESTRICTIONS BY DISTRICT 
button.

5 Specify school or district access limits for the user.

If there are neither schools nor districts listed for a particular user, then the 
user will have access to all records. 

If there is/are one or more schools listed, then the user will have access only 
to those records that are related to the specified schools.

If there is/are one or more districts listed, and there are no schools listed, 
then the user will have access only to those records that are related to the 
specified districts.

Fig. 3-10. Specifying school or district access limits for a user, from the program user 
data entry form.

6 For example, to specify a new district access restriction, press the ADD 
(+) button.
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SELPA Manager will add a new row to the listing for district limits. 

If pull-down menus are visible in the row, then you can select the district 
number from the pull-down menu in Column 1 (District Code); or the 
district name from the pull-down menu in Column 2 (District Name).

You can also double-click into either table cell, to directly enter the full 
district code (Column 1), or, at a minimum, the first part of the district name 
(Column 2). In this case, when you finish typing, click away from the cell 
that you just edited, so that the program can validate the entry.

NOTE: The district must already be listed in the Districts section of the 
program. If it is not listed in the Districts section, then you won’t be able to 
specify a corresponding district access restriction here.

7 To remove a district access restriction, highlight the district row that you 
wish to remove as a restriction, and then press the DELETE (-) button.

If the district is the last listed row in the table, then SELPA Manager will 
warn you that the user will now have unrestricted access to all districts.

8 Press the OK button to close the restrictions by district (or the 
restrictions by school) dialog.

9 To provide the enhanced level of district access restriction, check the 
“View all districts” box.

As noted earlier, there are two levels of district access restriction. With the 
basic level, the affected user cannot find or list records that are not consistent 
with the districts specified in Step 6. With the enhanced level, the user can 
find, list, and view these other records; however, s/he won’t be able to make 
any changes to these records on the data entry forms.

10 Press the SAVE button to dismiss the User data entry form.

In order for the school or district access restrictions to be saved, you must 
then save the program user record, by pressing the SAVE button rather than 
the CANCEL button.

SELPA Manager returns to the browse window (Fig. 3-8), from which you 
can either close the window or move to another context.

NOTE: Do not press the CANCEL button to close the data entry form, or the 
changes that you have made to the school or district access restrictions for 
that user will be lost.



Completing the connection
Once you have selected a login user name and entered a valid password, then 
you should see a progress thermometer moving across the monitor screen 
(“Building references...”). 

However, if you are using a single-user edition of SELPA Manager, and the 
program is unable to locate its data file on disk, then it will first prompt you 
to select an appropriate data file on disk (Fig. 3-11). 

SELPA Manager will also prompt you for a data file on disk if you hold 
down the [ALT/OPTION] key as you press the OK button from the login 
dialog. This keystroke sequence allows you to maintain more than one data 
file with a single copy of SELPA Manager.

Fig. 3-11. “Open file”-type dialog for SELPA Manager. The program presents this 
dialog for the single-user edition, if a data file cannot be located, or if the user holds 
down the [ALT/OPTION] key after the user login dialog.
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Fig. 3-12. “Save-as”-type dialog, to create a new data file on disk.

Locate an existing data file on disk, and then press the OPEN button. You 
can also press the NEW button to create an empty data file on disk; SELPA 
Manager displays a “save as”-type dialog for you to specify the new data file 
name and location (Fig. 3-12). You can change the name of the data file to 
something that makes sense for your site, school or district (e.g., 
“Middlebury High.data” for Macintosh, or “Middlebury.4DD” for a PC). 

NOTE: The SPLIT... button should be used only if the data file is anticipated 
to be very large (larger than 2 gigabytes on disk). In this case, the data file 
will need to be partitioned into more than one physical file on disk, each file 
being smaller than 2 gigabytes. You can split a data file at a later time as 
well, for example as it approaches 1.8 gigabytes in size, by using 4D Tools 
to compact the existing data file.

If the data file that you have selected to open is new, then SELPA Manager 
will automatically display a “Welcome to SELPA Manager” new 
preferences dialog (Fig. 3-13). 

The new preferences dialog allows you to make certain, minimal 
configuration settings before using the program. You must complete the 
items that have underlined labels. For example, you must select your SELPA 
code and name from the drop-down list, and specify the school or district 
name at which the program is installed. 



For detailed instructions on configuring SELPA Manager, refer to the 
Chapter , “Configuring SELPA Manager” on page 243.

Fig. 3-13. “Welcome to SELPA Manager” Preferences dialog, when opening a new 
data file on disk.

For an existing (rather than a new) data file, if you have upgraded the SELPA 
Manager program since the last time that the data file was accessed, then the 
program will display the “About SELPA Manager” dialog (Fig. 3-14). This 
dialog displays the latest changes made to the program. You can dismiss this 
dialog by pressing the OK button.
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Fig. 3-14. About SELPA Manager... dialog.The program presents this dialog when the 
user first accesses a data file after a program version update.

SELPA Manager will then display a browse form for locating records. For 
information on using this form and further options, refer to “Using the 
browse window (browser)” on page 168.

If the data file does not as yet contain any student records, SELPA Manager 
will then ask whether it should import student and related information from 
a text file on disk (Fig. 3-15).1

If you press the OK button, then the program will lead you directly into the 
SELPA Central import. Users who are in the “AdminGroup”, 
“ReadWriteGrp”, or “TeacherGrp” access groups can also perform the 
SELPA Central import at a later time, by selecting “Import...” from the File 
menu (refer to the Chapter, “File Menu Operations” on page 514).

1. For users with access to the standard browse window, if there are no student records in the
program, SELPA Manager will ask this question each time a new browse window is displayed.



Fig. 3-15. Dialog offering to import students (displayed when no student records exist 
yet in the program).

Types of forms
There are three basic types of forms in SELPA Manager: browse forms, data 
entry forms, and dialogs:

Browse forms display selections of records (students, teachers, schools, 
services, etc.). 

Data entry forms present information for one particular record, in an 
editable format. For example, a particular student or a teacher record can be 
edited with the appropriate data entry form. Data entry forms may also 
contain lists of other records. As an example, a data entry form for a student 
includes a list of services for that student.

Dialogs are forms that the program displays to issue an alert, set a 
preference, or when you must make a decision before processing can 
continue. Generally, you must close the dialog before moving on to other 
forms and/or tasks.
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Using the browse window (browser)
The browse window, or “standard” browse window (Fig. 3-16) is the 
principal record listing form in SELPA Manager. It is the means for 
accessing the various sections of the program. You can have as many as six 
browse windows open at one time. Having another browse window open 
allows you to work with different views of your data simultaneously.

Fig. 3-16. The SELPA Manager browse window 

Except when the Calendar1 is being displayed, the browse window contains 
two lists of records. The upper (primary) list displays the main set of 
records being browsed, and the lower (secondary) list displays a related set 
of records. 

As you click to highlight one or more records in one list, the selection of 
related records in the other list will change. For example, with the default 
browse window preferences set, highlighting a student name in the upper list 
will cause the program to display IEPs for that student in the lower list.

1. Discussed below, refer to “Calendar view (context)” on page 226.

Push buttons

Location box

Upper list

Lower list

Current focus indicator

Selection desc.

4D Write (WP) button

Slider

Enter



You can highlight more than one student by [SHIFT]-clicking, click-
dragging, or [CONTROL/COMMAND]-clicking on additional rows in the 
upper list. The program will then display the IEPs that are associated with 
these student(s), in the lower list. 

Conversely, if you highlight one or more IEPs in the lower list, then the 
program will display the associated student(s) for these items, in the upper 
list.

To un-highlight one or more highlighted rows, you can 
[CONTROL/COMMAND]-click on the highlighted row(s). To un-highlight 
all rows except one, click once on a single row without using any of the 
modifier keys.

Changing the browse view (context)
There are eight icon-type push buttons across the top that change the current 
view, or browse context, being displayed. (A ninth button, SEARCH, does 
not affect the context.) Depending upon which of the push buttons you 
select, the program will present a different view of the records. 

The principal browse views (contexts) are:

1 Students - Students in the upper list, with student assessments (IEPs), 
student contacts or student transition records listed beneath. The student-
associated tables (IEPs, contacts, or transitions) can also be displayed in the 
upper list, with students listed beneath.

2 Services - Services provided to students (“student services”) in the upper list, 
with either students or teachers listed beneath.

3 Goals - Goals in the upper list, with students listed beneath.

4 Discipline - Disciplinary actions in the upper list, with students listed beneath.

5 Staff - Teachers and other staff members in the upper list, with either teacher 
assignments (services provided to students at a school) or teacher services 
(subjects that the teacher is qualified to provide) listed beneath.

6 Schools - Schools in the upper list, with teacher assignments listed beneath.

7 Districts - Districts in the upper list, with schools listed beneath.

8 Calendar - View tasks, deadlines, and other time-dependant activities on a 
graphical calendar. There are no record lists in this context.
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As you can read from the description, the Students, Services, and Staff 
views each offer alternate display modes, for the secondary list. You can 
select these alternate modes from the Preferences dialog (refer to the 
Chapter , “Configuring SELPA Manager” on page 243).

When student contacts is selected as the secondary list in the Students view, 
you can also add a contact to the program that is not associated with a 
particular student. For example, you could use this section of the program to 
maintain a list of professional contacts. Highlighting an “unassociated” 
contact will not cause a student to be displayed in the other list.

Another way to change the browse context is by typing a phrase 
corresponding to one of these buttons into the Location box, and then 
pressing the [ENTER] key. The Location box is a white, enterable area that 
appears just beneath the buttons, at the top of the browse window (refer to 
“The Location box” on page 180).

There are certain other phrases which, when typed into the Location box, 
will switch browse window context. For example, you can type the words 
“schedule”, “event”, or “date” to switch from the dual-list view to the 
Calendar view. You can type 

assignments for <teacher name>

to switch to the Staff context. The program will then attempt to find the 
teacher and his/her associated assignments (if any). Either the assignments 
or the teacher-provided services will then display in the lower listing.1

Other browse contexts
In addition to the eight primary views, there are three other browse contexts. 
These other contexts are accessible by typing the context name or a related 
expression into the Location box, and then pressing the [ENTER] key.

1. Program users (enter “Show user info” in the Location box) - Displays 
the names of program users and the number of times that each has connected 
to SELPA Manager. The lower list displays associated calendar items.

1. Depending upon whether teacher assignments or services is selected for the lower window, in

Preferences.



2. Postal or Zip - Displays postal codes (Zip Codes). Postal codes can be 
imported into this section of SELPA Manager, to facilitate the entry of 
addresses associated with student contact, teacher, and school records. 
Beneath the postal code listing is a list of the associated student contact 
addresses.

3. Tracking or Events - Displays errors that the program has encountered 
while executing various operations. Also displays the results of import, 
export, certain other batch operations, and CASEMIS report generation 
operations. The lower list displays associated program users (the current 
user at the time of the error message or other tracking operation).

The Program users and the Tracking sections do not permit the manual 
(user-initiated) addition of new records. For a summary of browse window 
contexts and where new record addition is permitted, refer to “The data 
entry cycle” on page 241, below.

The current selection of records
The records that appear listed in the browse window represent the current 
selection of records for that particular table and window. Because there is 
an upper and a lower list displayed for each browse window context1, you 
can view two current selections simultaneously. 

For example, there is a current selection for students and for assessments 
(IEPs), in the students context of the browse window. The current selection 
for students initially may be all student records in the table, while the current 
selection for assessments initially might be no records. 

When you highlight one or more student records in the upper list, SELPA 
Manager will display the corresponding assessments (IEPs) for those 
student(s) in the lower list. At this point, the current selection for 
assessments has changed from zero to however many IEPs are being 
displayed. The current selection of students has not changed, however, even 
though certain rows are now highlighted (selected).

When you switch away from the Student context by pressing the Discipline 
button in the browse window, then the program will switch to displaying 
disciplinary actions in the upper list and students in the lower list. The 

1. Excluding the Calendar.
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current selection in the discipline table may now be all records, while the 
current selection in the student table has changed from all records (in the 
Students context) to no records (in the Discipline context).

If you have more than one browse window open on your screen, then you 
will have current selections for each listed table, for each browse window.

Each time that you open a new browse window, or switch contexts in the 
browse window, the program will display an initial, current selection 
according to your choice in the Preferences dialog: no records, all records, 
or current records can be displayed (refer to the Chapter , “Configuring 
SELPA Manager” on page 296).

You can further revise the current selection of records, for the upper or the 
lower browse list, by using the “Show...”, “Omit subset”, “Find”, “Open a 
set”, “Save a set”, and “Last found set” commands in the Data menu (refer 
to the Chapter , “Data Menu Operations” on page 607).

List navigation
Both the upper and the lower lists can be scrolled, both horizontally and 
vertically. Scrolling horizontally displays additional fields (columns) for the 
listed records. Scrolling vertically brings other records (rows) into view.

The [Up arrow], [Down arrow], [Left arrow], and [Right arrow] keys will 
cause the active list to scroll up, down, left and right, respectively, without 
using the mouse. The [Page up] and [Page down] keys also scroll up and 
down, but by larger increments. The [Home] and [End] keys will scroll the 
list vertically to the start or to the end. The [ALT/OPTION]-[Up arrow] and 
[ALT/OPTION]-[Down arrow] keystroke combinations also scroll the list 
to the start or to the end.

The keystroke pair [CNTRL/CMD]-[Up arrow] or [CNTRL/CMD]-[Down 
arrow] will move the highlighted record in a list up or down one record, 
respectively, without using the mouse. If no record is highlighted when you 
press one of these keystrokes, then the uppermost record visible will receive 
the first highlight.



The vertical scroll position of the list will not change with the highlighted 
record, however, so it is possible to move the highlight beyond the displayed 
area of the list (either above or below). To scroll the entire list, release the 
modifier key and press only the [Up arrow] or [Down arrow] key.

To display more records (rows) at a time in the upper list, and/or to display 
more columns in both lists, drag the lower right-hand corner of the entire 
browse window to make it larger. Ensure that you drag the gray area of the 
window, just beyond where the blue and white, 4D Write word processing 
button is located. You can also use the window’s “zoom” box to maximize 
the window size.

To re-apportion the two lists so that one is larger or smaller relative to the 
other, drag the slider control (located along the extreme right edge of the 
window) up or down.

You can widen a particular column on one of the browse lists as if it is a 
spreadsheet. Position the cursor in the column header, directly over the 
border line between the two columns. The cursor icon appears as two 
vertical lines with arrows. Drag to the right to increase column width, or to 
the left to decrease column width. (When the data being displayed changes, 
however, the column will auto-resize to accommodate the width of the new 
information.)

To “freeze” one or more columns on the left side during horizontal scrolling, 
position the cursor over a thick, black bar on the lower left of the list’s 
horizontal scroll bar. The cursor will change to the vertical lines with arrows. 
Drag to the right to freeze additional columns, or to the left to release 
existing frozen columns.

NOTE: It may not be possible to freeze additional columns, if the width of 
the first column represents most of the available space.

Fig. 3-17 again displays the SELPA Manager browse window, but with 
navigational notations summarizing some of the discussion in this section.
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Fig. 3-17. The SELPA Manager browse window, with navigational shortcuts shown.

Styled browse window text
In certain browse contexts, the listed records may appear in italics or colored 
text. Depending upon the context, the styled text has different meanings, 
explained below. You can disable styled text (so that all listed records appear 

1. Scroll without changing the highlighted row: 
[Up arrow], [Down arrow], [Left arrow], [Right arrow]

2. Scroll by approx. one list height at a time, without changing 
the highlighted row: [Page up], [Page down]

3. Scroll to beginning or end without changing highlighted row:
[ALT/OPT]-[Up arrow], [ALT/OPT]-[Down arrow], [Home], 
[End]

4. Scroll to extreme left or right without changing highlighted 
row: [ALT/OPT]-[Left arrow], [ALT/OPT]-[Right arrow]

Change highlighted row: [CNTRL/CMD]-
[Up arrow] or [CNTRL/CMD]-[Down arrow]

Re-size entire window by dragging this corner

Change height of two lists (relative to each other) with this slider



in plain, black text) by checking the “No styled browse text” option in 
Preferences (refer to the Chapter , “Configuring SELPA Manager” on 
page 293).

• Students

Red-colored student records have the “DNR” (do not report) box checked. 
Records that appear in orange have the “DNQ” (does not qualify) checked. 
Records that appear in fuchsia have both “DNR” and “DNQ” checked. 
Finally, records in italics have the “Mark” box checked. 

If student contacts are displayed in the lower list, then the contact record 
for a student that has the “student resides here” box checked appears in black 
text. The other contacts for the student (which are not marked “resides 
here”) appear in blue text.

If assessments (IEP forms) are displayed in the other list of the students 
context, then assessment records marked with a meeting type of “initial” 
will appear in red text. Assessment records that have a current or future 
meeting date will appear in italics; past assessments will appear in plain text.

If transition forms are displayed in the other list of the students context, 
then transition records that have a current or future meeting date will appear 
in dark violet. Past transitions will appear in black text.

• Services

Student service records that are marked “DNR” (do not report) appear in 
italics. Primary services are in black text; non-primary services appear in 
violet text.

If teachers (staff) appear in the lower browse list, then teachers whose names 
contain the word “open” appear in green text. Teachers whose names 
contain the word “closed” appear in italics. 

• Goals 

Goal records that are associated with an assessment (IEP form) appear in 
orange text. All other (unassociated) goals appear in plain black text.

• Disciplinary action 

Expulsions appear in red text. Actions whose start date is today or in the 
future appear in italics. Past actions appear in black text.

• Staff
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Teachers or other staff members whose names contain the word “open” 
appear in green text. Teachers whose names contain the word “closed” 
appear in italics. 

In the lower list, teacher or other staff assignments that start today or in the 
future appear in blue text; other assignments are in black text. Assignments 
that are not marked “active” appear in italics.

• Schools

No stylized text at the present time. In the lower list, teacher assignments 
that start today or in the future appear in blue text; other assignments are in 
black text. Assignments that are not marked “active” appear in italics.

• Districts

The district record marked as “My District” appears in italics. Others appear 
in plain black text. In the lower list (schools), there is no stylized text at the 
present time. 

• Postal (Zip) Codes

Postal code records with the “Mark” box set appear in red. Postal code 
records that represent out-of-state (non-California) locations appear in 
italics.

• Tracking 

– Error notices appear in red. 
– Batch update events appear in cyan.
– Deletion operations appear in brown.
– Export events appear in magenta.
– Feedback from web users appears in green.
– Import events appear in blue.
– Internal transfer items appear in orange.
– User-login message-read acknowledgements appear in cyan.
– Other items appear in black.



Sorting browse lists
To perform a single-level sort on a displayed column (field), click on the 
colored column header. The cursor may change to an hourglass (Windows) 
or a wrist watch (Macintosh) while the sort is being performed. To reverse-
sort a column, hold down the [ALT/OPTION] key, and click on the column 
header. 

As an example, suppose that you wanted to “browse” the Last IEP dates of 
your current students.

The steps would be:

1 Ensure that the current focus is on a students list.1

2 From the Data menu, select show current.

3 Click on the header of the Last IEP column

SELPA Manager will sort the student records by Last IEP date (field name 
is [Student]Last_IEP_D). You are now viewing the list of current students, 
beginning with the earliest Last IEP date.

To perform a multi-level sort, there are two options: (1) hold down the 
[COMMAND/CONTROL] key, and click on the column header; or (2) select 
Sort from the Data menu. Either approach will cause a multi-level sorting 
dialog to appear on your screen, containing field names. Fig. 3-18 illustrates 
the Order By dialog, which is available from the Data menu. 

NOTE: If you have very many records, and you sort on a column or field that 
is not indexed, then the sorting operation may require an extended amount 
of time to complete. The sorting dialogs display indexed fields in boldface. 
Any multi-level sort, whether performed on indexed or non-indexed fields, 
may take a long time with a very large number of records. 

You can also specify that the listed records in the browse window be sorted 
into a default order, or into a custom sort order, when initially displayed. For 
example, the default sort for Student records is by last name. Having a sort 
preference active requires additional processing time before the records can 
be displayed in the browse window.

1. Refer to Current focus of the browse window  on page 178.
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Fig. 3-18. The Order By dialog, accessible from the Data menu. (“Sort”)

Current focus of the browse window
The current focus of the browse window (either the upper or the lower list) 
is displayed by the pair of radio-style buttons that are just to the left of the 
Location box. These buttons are also repeated at the lower left corner of the 
browse window (“Current focus indicator”, Fig. 3-16 on page 168).

You can change the current focus by clicking into the upper or the lower 
record lists; by clicking on one of the radio-style buttons; or by using one of 
the shortcuts: [CONTROL/COMMAND]-U for upper focus, and 
[CONTROL/COMMAND]-L for lower focus. After clicking on a radio 
button or executing the keystroke shortcut, the cursor will return to the 
Location box, ready for the next set of instructions.

The current focus determines the data table on which you will be performing 
operations. For example, when the context is Students (students in the upper 
list, assessments in the lower list), if the current focus is on the lower list, 
then you will see all assessment (IEP) records, not student records, by 
selecting Show All from the Data menu. 



Similarly, if the context is Staff (staff in the upper list, staff assignments in 
the lower list), but the current focus is on the lower list, selecting “New 
record” from the Data menu will add a new assignment (but not a new staff 
member) to the program.

Searching for records (SEARCH button)
The SEARCH button on the browse window displays the Query Editor 
(Fig. 3-19). This editor allows you to perform multilevel searches to find 
students, student services, teachers, schools, or other records, depending 
upon which list has the current focus, in the browse window. 

Fig. 3-19. The Query Editor.

If the fields that appear in the Query Editor do not seem appropriate for your 
search, ensure that the current focus of the browse window is correct. For 
example, if you are looking for a particular teacher code, but the Query 
Editor displays only assignment information, then perhaps the current focus 
is pointing to the lower list (Assignments) rather than the upper list 
(Teachers). 
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You can also access the Query Editor by selecting “Find...” from the Data 
menu, while working with the browse window (refer to “Find...” on 
page 620, which presents a more detailed discussion of the Query Editor). 

The Location box
The Location box is a white, enterable, horizontal band that lies just 
beneath the buttons, at the top of the browse window (refer to Fig. 3-16 on 
page 168). At the extreme right-hand side of the box is a drop-down arrow, 
for displaying a list of choices1.

Among its other capabilities, the Location box provides an alternate means 
of performing quick, single-level searches (queries) of the information in 
SELPA Manager. (If you need to perform a multiple-level search, involving 
more than one field, then use the Query Editor instead; see “Searching for 
records (SEARCH button)” on page 179.)

You can type a search criterion or some other, recognized phrase into the 
Location box, and then execute the request, either by pressing the ENTER 
button (“->”, immediately to the right of the Location box, refer to Fig. 3-16 
on page 168); or by pressing the [Enter] key, on your keyboard2.

Expressions entered into the Location box are not case-sensitive. However, 
interpretation of the expression can be context-sensitive, dependant upon the 
browse window list that has the current focus. As an example of things that 
might be typed into the Location box, consider the following expressions.

Last name is Colliers
First name is Mark
ssn is 493-22-4389
SELPA From is 2911
Date of birth is after 9.10.85
Teacher code is 0820
Referral D is blank
Evan Tolliver is here
Modified D is yesterday
CASEMIS service code is 410-78
Service name is vision services
Find in selection contact name is “Ellis”

1. The Location box is actually a combo box , refer to Combo boxes  on page 232.

2. On Macintosh, either of the [Enter] keys should work. On some PC keyboards, it may be nec-

essary to press the [Enter] key that is on the numeric keypad, rather than the [RETURN] key

(sometimes labeled [Enter]).



City is not Benicia
Mainstreamed pct is not blank
RIS_B is true
Start_d is before December 1, 1995
Outside reg class pct > 95
outside reg class pct is less than or equal to 75

In general, the Location box evaluates expressions by considering five 
possible categories or types of user entry, in order: attendance 
confirmation expressions, standard search expressions, special 
expressions, context-changing keywords, and in-context search 
expressions. Fig. 3-20 summarizes the evaluation sequence.

If the text entered by the user does not match an attendance confirmation 
expression, then the program determines whether the text matches a 
standard search expression, suitable for the current browse window context. 
If there is no match, then the program attempts to evaluate the text as a 
special expression. If there is no match, the program attempts to evaluate the 
text as a context-changing keyword, and then finally as an in-context search 
expression.

The paragraphs that follow discuss in detail the individual categories for text 
entered in the Location box. If you are new to SELPA Manager, then you 
may want to skip down a few paragraphs for now – you might resume 
reading at “In-context search expressions (Location box)” on page 204, 
below.
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Fig. 3-20. Evaluation sequence for user-entered text expressions, Location box.



Attendance confirmation expressions (Location box)
The Location box can accept an expression of the form,

<student name> <attendance status>

enabling a program user with read-write access1 to directly enter attendance 
information for a student. This technique permits the entry of attendance 
information for only one student per expression, per date.

NOTE: This is an advanced topic. If you are a new user, then you may want 
to skip this section for now. 

You can also enter attendance information for a classroom of students, using 
the teacher assignment data entry form (see the Chapter, “Adding Staff and 
Related Information” on page 350).

• Student name

The student name can be entered as “firstName lastName” or “lastName, 
firstName”. Alternately, if the Social Security Number or the student’s 
record number is known, then one of these numbers can be entered in place 
of the student name. A date of birth can also be entered, although SELPA 
Manager may find more than one student with the same date of birth, 
requiring an additional step to select among the found students.

• Attendance status

The attendance status expression can be one of the following:

is here
is present
is excused
is unexcused
is suspended

• Logging attendance information

If the program user is in the “TeacherGrp” access group2, then the user must 
provide at least one service to the student being requested. If the user does 
not provide any services to the student requested in the Location box 
expression, then the program will present an error message, “Could not find 
a student for the attendance request (no attendance item added).” 
1. The program user must be a member of the ReadWriteGrp  access group, or another group

which itself is a member of the ReadWriteGrp  access group, and which affords access to the

full browse window ( TeacherGrp , AdminGroup ). See the discussion, Using access groups

(custom user names)  on page 146.
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Similarly, if the program user who is not in the “TeacherGrp” has school or 
district access limits1, and enters the name of a student who is not in an 
allowed school or district, then the program will report the same problem.

If SELPA Manager is able to find the student, but the student does not have 
any services, then it will report “Could not find any student services for the 
attendance request (no attendance item added).” If there are no current 
services for the student (as of today’s date), then the program will report, 
“There are no current services available for this student. Please create at 
least one current service (go to the student services section, or add a service 
while editing a student record).”

If the program finds one or more students with the entered name, and 
collectively they have more than one current service, then it will present a 
dialog box listing more than one choice for the attendance item (Fig. 3-21). 
Each row in this dialog corresponds to a current service for the found 
student(s). 

Fig. 3-21. Dialog for adding attendance information directly from the browse window.

2. See the discussion, Using access groups (custom user names)  on page 146 .

1. See the discussion, School or district access restrictions  on page 156.



In this particular example, the user entered “Jesus is here” into the Location 
box. Because there are 57 students with the (first) name “Jesus”, and these 
students have one or more current services, the dialog box offers a selection 
of 74 student services from which to select.

In the lower part of the dialog, it is possible to switch to an attendance date 
other than the default of today, or to an attendance status other than the 
selected status of “here”, which corresponds to the student being present.

After the user has selected a student service from the dialog, SELPA 
Manager will verify that there is a teacher assignment associated with the 
service. If there is more than one assignment, the program will present 
another dialog, asking the user to specify which teacher assignment to use 
for the service. 

If there are no teacher assignments for the student service, the program will 
offer to create one (“A teacher assignment for this student service could not 
be found. Do you wish to create the assignment?”). If the teacher assignment 
does not exist, then the program will not create the attendance item for the 
student.

If the student already has an attendance entry for the selected assignment 
and day, the program will warn, “There is already an attendance item for this 
student service, on the date: <today>. Do you wish to add it anyway? 
(CANCEL=do not add)”. The program will allow the user to enter more than 
one attendance item on the same day, if the user presses the OK button at 
this point.

While creating the attendance item, the program will ask for the number of 
minutes of attendance (the default is that specified for the assignment, if 
greater than zero, and 60 minutes, if not).

The program will then confirm, “The attendance item has been added,” after 
the new attendance record has been created.

The new attendance item can be viewed, edited, or deleted by accessing the 
teacher assignment data entry form for the class (see the Chapter, “Adding 
Staff and Related Information” on page 350).
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Standard search expressions (Location box)
A standard search expression enables the Location box to perform a 
single-level search, in the table displayed in the browse list that has the 
current focus.

NOTE: This is an advanced topic. If you are a new user, then you may want 
to skip this section for now. 

Standard search expressions in the Location box are structured English 
sentences of the form,

<optional prefix> <field name> <comparison operator> <value>

• Optional prefix

When searching on a particular field name, if you precede the field name 
with one of these prefixes:

Find in selection

Query in selection

Search in selection

then the program will perform the search among the displayed records only:

find in selection district name is Whistler

If you wish to perform a search among all records in the table, then you 
should omit the optional prefix.

• Field name

To be recognized, the field name entered must correspond to a field in the 
browse list that has the current focus. The Location box has its own list of 
relevant field names and special keywords. The list contents change with the 
current focus of the browse window. 

To display the list, click on the downward-pointing arrow at the extreme 
right edge of the Location box (Fig. 3-22). The middle part of the list 
contains the alphabetized names of the fields for the database table which 
has the current focus (“List of fields for...”).1 

1. On Macintosh workstations, if the user has specified the Automatic  or Platinum  interface

in Preferences, then longer field lists may be cut off in the Location box choice list. To view the

entire list, switch the interface preference to Mac theme  (refer to the Chapter, Configuring

SELPA Manager  on page 289).



Fig. 3-22. List displayed when the user clicks on the drop-down arrow for the Location 
box. The current focus of the browse window is on schools, so the field names displayed 
are in the [School] table.

As an example, consider the expression,

Last name is Colliers 

This expression is relevant if Students is the current focus, because “Last 
name” is a field in the [Student] table. It would not be a relevant expression 
if Schools is the current focus, however, because there is no “Last name” 
field in the [School] table.

However, under certain circumstances, SELPA Manager will recognize the 
relationship of a field in another table to the current context. For example, if 
the current focus is on a Student Services list, you could compose the same 
request,

Last name is Colliers 

or even,

name is Colliers 

The program will interpret your entry as a request to find student services 
for a student whose last name is “Colliers”.1
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Field names in Location box expressions are not case-sensitive. Field names 
vary somewhat among different SELPAs, for certain tables. For a discussion 
of field name variations, refer to the Appendix, “Principal Data Tables” on 
page 659, and the subsequent appendices which identify the mapping of 
internal field names to external (user) field names, for particular SELPAs.

For date fields that end with a [Space]-D (or [underscore]-D); or Boolean 
fields that end with a [Space]-B (or [underscore]-B) suffix, you can usually 
drop the suffix from the name, as long as the truncated name does not then 
match the name of some other field in the same table. 

For example, you can use a field name of “Gifted program B” or just “Gifted 
program” (dropping the suffix), when the focus is on the Schools list.

As another example, there is a Boolean field in the [Student] table, 
[Student]RIS_B, for “requires intensive services”. The field appears in the 
Sort and Query Editors as “RIS B”. 

The following entries into the Location box should all perform the same 
search, for the current focus on a Students list:

RIS_B is true
RIS B is true
RIS is true

The same logic also applies to date fields. Here the example is for a Student 
Services list:

Start_original_d is before 9.15.82
Start original d is before 9/15/1982
Start original is before September 15, 1982

• Comparison operator

The comparison operator defines the relationship between the field name 
and the value. It can be as simple as the verb “is”, to require the field to be 
equal to the value; or the opposite, “is not”, to require the field to be unequal 
to the value. A listing of available comparison operators appears below:

is greater than or equal to
is less than or equal to
is greater than
is after
after

1. These two expressions are actually in-context search expressions, rather than standard search

expressions. In-context search expressions are covered in detail on page 204, below.



on or before
on or after
on
is before
before
is less than
is equal to
is not equal to
is not
equals
is
for
>= 
<= 
<> (is not equal to)
#  (is not equal to)
=
> 
< 

• Value

The final element in a standard search expression is the value itself – the 
name, type, number or other quantity of the field to be found among the 
records. For example, in the expression, “date of birth is before 6/1/1978”, 
the value would be the date, “6/1/1978”.

For string or text-based fields, you can omit the final portion of a value and 
obtain a “starts with”-type search. For example,

District name is Whistler

would find a school district named “Whistler Amalgamated”, as well as a 
district named “Whistler Unified”.

Except for Boolean fields, you can use the value expression “blank” to 
indicate a null or empty value. For Boolean fields, you can use “true”, “yes”, 
“y”, or “positive” to indicate a checked (true) field value; anything else 
would evaluate to un-checked (false).

You can use the Location box choice list as an aid to constructing simple-
sentence searches. Select the field that you wish to search from the list; then 
add the appropriate comparison operator (is, is not, is after, etc.); and then 
the value.
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• Examples of standard search expressions

Here are some examples of standard search expressions, suitable when the 
focus is on a Students list:

Last name is Wimple
Date of birth is before 8/11/1982
ELL is false
ELL is not true
ELL B is negative
Find in selection extended year B is true
Grade level is 07
Last IEP D is blank

Note that the three expressions involving “ELL” (English language limited, 
the [Student]ELL_B field) all evaluate to the same search.

Here are some additional examples of standard search expressions, when the 
focus is on the Student Services list:

Query in selection teacher name is Hansel
Primary service B is true
Do not report is false
CASEMIS service code is 41
School name is not County Programs
Aux service code is S22

Special expressions (Location box)
Special expressions perform a variety of tasks in SELPA Manager, 
including adding new records; executing functions (both those available as 
menu items and others which are not); generating calculated data or counts; 
converting codes; and switching to a new browse window context. 

Some special expressions appear below the alphabetized field names, in the 
drop-down list of the Location box (Fig. 3-22 on page 187).

NOTE: This is an advanced topic. If you are a new user, then you may want 
to skip this section for now. 

• New record expressions

These Location box expressions will take the user from the browse window 
into a data entry form for a new record, in the appropriate section of SELPA 
Manager:



New transition for <student name>
New ITP for <student name>
New referral for <student name>
New assessment for <student name>
New IEP for <student name>
New goal for <student name>
New discipline for <student name>
New enrollment for <student name>
New service for <student name>

The first three expressions (“new transition”, “new ITP”, and “new 
referral”) will open a [Transition] data entry form, for a new record. The 
next two (“new assessment” and “new IEP”) open a new [Assessment] (IEP) 
form. “New enrollment” and “new service” open a new [Student_service] 
form. In each case, if the browse window is not already in the correct context 
to add the new record, then it will first switch contexts.

When adding a new assessment (IEP) record, the referenced student need 
not correspond to an existing [Student] record in SELPA Manager. For all 
other cases, the [Student] record must exist already. If the special expression 
identifies more than one possible student, then the program will present a list 
of existing [Student] records from which to select.

• Functions

Here is a partial list of Location box phrases that execute functions and other 
tasks in the program. Phrases that appear together but are on separate lines 
are synonyms. Either expression can be used in the Location box, but both 
should not be used together.

Calculate ORC
Calculate %ORC

– Calculates the percentage outside regular classroom as (100 - 
mainstreamed percentage), for a listed selection of student records in the 
browse window, and updates the corresponding field for each listed student. 
Applies only when the current focus is on a [Student] list. Limited to users 
with read-write access. May be further limited by district access restrictions, 
if the user has view-only access to listed students.

Check next student number
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– Checks and, if necessary, updates the next student number for each 
[District] record (the [District]Next_student field), based upon the highest-
numbered [Student] record that exists in the program, for the site number 
that is listed in Preferences. Restricted to “AdminGroup” access group 
members.

Check problem items
Check missing items

– Finds errors (and optionally, warning messages) for each of the listed 
records, when one of the following tables has the current focus in the browse 
window: [Assessment], [Assessment_goal], [Assignment], 
[Disciplinary_action], [District], [Postal_code], [School], [Student], 
[Student_contact], [Student_service], [Teacher], [Teacher_service], or 
[Transition]. 

Changes the selection to display only those records with errors/warning 
messages, or prepares a report listing the individual errors/warning 
messages, for each identified record. Creates a “last found set”1 prior to 
listing the error-containing records, so that the user can restore the original 
selection of records.

Convert disability names

– Fixes mismatches, if any, between disability codes and their current 
(CASEMIS) descriptions, where available, for a selection of [Student] 
records. A students list must have the current focus in the browse window. 
Restricted to program users with read-write access. Does not update 
students displayed with view-only access (district access restrictions).

Convert service codes

– Converts “old-style” student service codes2 into the 2001-2006 two-digit 
codes, for a selection of [Student_service] records. If the “Report As Of” 
date in Preferences3 is set to on or after July 1, 2006, the function will 
instead convert both old-style and 2-digit codes to the “new” 2006-2007, 3-
digit codes.

1. Also refer to the section, Last found set  on page 222, below.

2. Three or six-digit, hyphenated service codes were used prior to the 2001-2002 academic year.

Examples: 430 , 410-50 .

3. Refer to the Chapter, Configuring SELPA Manager  on page 255.



The student services list must have the current focus in the browse window. 
This function is restricted to program users with read-write access. It does 
not update a service displayed with view-only access (district access 
restrictions).

Count student services
Count enrollments
Count services

– Identifies student records that have a specified number of associated 
services. Displays a dialog (Fig. 3-23) allowing the user to specify the 
number of services, and whether or not to count active services only. The 
result is a list of [Student] records meeting the criteria, subject to the user’s 
access limitations (“TeacherGrp” or district access restrictions).

A students list must have the current focus in the browse window to execute 
this function.

Fig. 3-23. Get students with service(s) dialog, for “count student services” function, 
Location box.

Count disciplinary actions
Count discipline
Count suspensions

– Identifies student records in the current selection that have a specified 
number of associated disciplinary actions. Displays a dialog (Fig. 3-24) 
allowing the user to specify the number of actions and type.

An alternative option on the dialog allows the user to find students having a 
specified total (cumulative) days of suspension, within a specific time 
period. The user can omit Saturdays, Sundays, district and/or track holidays.
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The result is a list of [Student] records meeting the criteria, subject to the 
user’s access limitations (“TeacherGrp” or district access restrictions). A 
students list must have the current focus in the browse window to execute 
this function.

Fig. 3-24. Get students with disciplinary action(s) dialog, for “count disciplinary 
actions” function, Location box.

Fix STAR#90 errors

– If a student is in Grades 1, 12, 13, 16, 17, or 18, and does not have a 
participation (“STAR”) code of “90”, then the program will re-assign a 
participation code of 90 to the student.

This function applies only to a selection of students in the browse window, 
when the current focus is on a students list, and the “Report As Of” date in 
Preferences is on or after 7/1/2001. If the “Report As Of” date Preferences 
date is before 7/1/2001, then attempting to use the function will result in an 
error message.

Restricted to program users with read-write access. Does not update a 
student displayed as view-only (due to district access restrictions).

Graph

– Prepare a graph of the listed record data using the Chart Wizard, for the 
browse window that has the current focus. Has the same functionality as the 
Data menu item, “Graph” on page 630. 

Help



– Displays a dialog of general assistance in using the browse window.

Overdue

– Initiates a search for students whose next IEP meeting, last IEP meeting, 
compliance date, or annual review is not within a user-specified time 
interval. The result is a list of [Student] records meeting the “overdue” 
criteria, subject to the user’s access limitations (“TeacherGrp” or district 
access restrictions). A students list must have the current focus in the browse 
window to execute this function.

The program presents a dialog to configure the search for overdue student 
records (Fig. 3-25).

Fig. 3-25. Find students with IEP meetings, evaluations, or compliance dates outside 
of user-specified limits. For the “overdue” function, Location box. The first two or the 
second two search criteria can be used simultaneously (but not all four together).

Place dates on calendar

– This function allows placement of student-related dates onto the Calendar, 
for the current selection of students. The program displays a dialog for 
specifying the dates to use, and how to handle blank dates (Fig. 3-26). This 
function is restricted to users with read-write access to the program.
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Fig. 3-26. Dialog, for placing student-related date information onto the Calendar, for 
a selection of students. Activated by the “place dates on calendar” function, Location 
box.

Purge audit trail
Purge record history

– This function removes [Record_history] items for which the change date 
([Record_history]Change_D) is older than a user-specified date. The 
program will prompt the user to identify the date. Limited to users in the 
“AdminGroup” access group. [Record_history] items are created when the 
Audit trail function is activated by the Administrator, in Preferences (see 
the Chapter, “Configuring SELPA Manager” on page 270).

Reset capitalization

– This function allows the user with read-write access to change the 
capitalization of certain fields in the [Student] and [Student_contact] tables 
to first-letter-only capitalization. For example, if the student’s name is listed 
as all-capital letters, the function will revise it to first-letter-only capital 
letters. The affected fields are [Student]First_name, [Student]Last_name, 
[Student_contact]Contact_name, [Student_contact]Address_Line1, 
[Student_contact]Address_Line2, and [Student_contact]City. The function 
will attempt to revise every contact for each listed student. A students list 
must have the current focus in the browse window, to execute this function.

Restore last found set



– Restores from memory the last “durable” found set of records for both lists 
in the current browse window context. For additional discussion, refer to 
“Last durable (saved) set” on page 224.

Save last found set

– Saves to memory both the last found set and the last “durable” found set 
of records, for both lists in the current browse window context. For 
additional discussion, refer to “Last found set” on page 222 and “Last 
durable (saved) set” on page 224.

Show all
All records

– Displays all records in a table, for the browse window list that has the 
current focus. If the user has limited access due to membership in the 
“TeacherGrp” or district access restrictions, then these phrases will display 
only those records in the table that the user is permitted to access. Has the 
same functionality as the Data menu item, “Show all” on page 613.

Show current

– Displays “current” records in a table (based upon current services, as of 
today’s date), for a browse window list that has the current focus. Applies to 
student-related tables ([Assessment], [Assessment_goal], 
[Disciplinary_action], [Student_service], [School], [Student], 
[Student_contact], and [Transition]). For tables that are not student-related, 
this request generates an error. Found records may be restricted if user is in 
the “TeacherGrp” or has district access restrictions. Has the same 
functionality as the Data menu item, “Show current” on page 615.

Show subset
Omit subset

– Show or omit a subset of highlighted records, for the browse window list 
that has the current focus. Has the same functionality as the Data menu 
items, “Show subset” and “Omit subset” on page 620.

Sort
Order

– Sort the records in the browse window list that has the current focus, using 
the “Order by” dialog. Has the same functionality as the Data menu item, 
“Sort” on page 636.

Special operations dialog
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– Allows users with administrative access (“AdminGroup”) to display the 
Special Operations Dialog. This dialog allows the user to execute written 
scripts in 4th Dimension language, which otherwise would need to be 
compiled into the SELPA Manager application. To display the dialog, the 
list that has the current focus in the browse window must contain at least one 
record.

Unlock

– Allows users with administrative access (“AdminGroup”) to enter selected 
[Student] date fields, directly in the browse window list, thereby reducing 
the need to modify student records in the data entry form. A students list 
must have the current focus in the browse window.

Once the browse window has been “unlocked” in this manner, the user can 
enter dates by double-clicking into the available cells in the table, or by 
using the pull-down date menu in each of the available cells (Fig. 3-27).

Fig. 3-27. Direct entry into date fields in the browse window, for a Student list that has 
the current focus. The user can double-click into an enterable cell, or use the 
associated date drop-down list in the cell. Activated by the “unlock” function, 
Location box.



The enterable date columns in the table include: [Student]Date_of_birth, 
[Student]Original_entry_D, [Student]Last_IEP_D, [Student]Next_IEP_D, 
[Student]Last_evaluation_D, [Student]Next_evaluation_D, and 
[Student]Recall_D.

Care should be exercised in using the “unlock” function, since a lower level 
of error checking applies to direct entry from the browse window, compared 
to using the student data entry form. Furthermore, using this function may 
cause more than one [Student] record to be locked to other users who might 
want to edit them.

After finishing the edits to the date fields in the browse window, the user can 
re-lock the display by typing “lock” into the Location box.

un-transfer students
untransfer students
restore previous record number

– Allows users with administrative access (“AdminGroup”) to return a 
previously-assigned student record number ([Student]Record_number) to 
currency, for a list of students in the browse window. A students list must 
have the current focus in the browse window.

To be affected, a listed student must have a non-blank, previous record 
number in the [Student]Record_number_prev field, and this previous record 
number must not be in current use for another student in the data file. The 
program does not recycle or re-use the student’s current or “new” record 
number, which the previous record number will displace.

This function may be useful if one or more students were internally 
transferred to another district by mistake. However, it does not make any 
changes to the student’s school of residence or school of attendance. Nor 
does it revise the drop status of either the student or his/her services. 
Therefore, these items may also need to be changed, to fully undo an 
internal transfer.

For additional information on the [Student]Record_number field, refer to 
the Chapter, “Entering Students” on page 360.

update quick report fields

– Allows users with read-write access (“ReadWriteGrp”) to place 
designated contact information into the “Quick Report” clone fields. A 
students list must have the current focus in the browse window
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Located in the [Student] table rather than in the [Student_contact] table, the 
Quick Report clone fields are more readily accessible when generating a 
student-level report using the Quick Report Editor. There are two sets of 
Quick Report clone fields in the [Student] table; one set carries the “QR_” 
prefix in the field names, while the other set carries the “QR2_” prefix. 

The program will present a dialog box (Fig. 3-28), requesting that the user 
select the type of contact record for each student, which is to be used to copy 
information into the “QR_” and/or the “QR2_” fields.

Fig. 3-28. Dialog, for updating the Quick Report “clone” fields, for a selection of 
students. Activated by the “update quick report fields” function, Location box.

For additional information on the “QR_” and “QR2_” fields, refer to the 
Chapter, “Entering Students” on page 369. This function is also accessible 
from the Actions menu (“Update other...”, see the Chapter, “Actions Menu 
Operations” on page 652). Detailed information on the use of the Quick 
Report Editor appears in the Chapter, “Quick Report Editor” on page 719.

Context-changing keywords (Location box)
Certain keywords or phrases will cause the browse window to change 
contexts, or temporarily revise the existing context, when entered into the 
Location box.

In some cases, if the browse window is already in the context associated 
with a keyword, then entering the keyword into the Location box will 
produce an in-context search of the fields in the table, for that word (see “In-
context search expressions (Location box)” on page 204). 



For additional discussion of the available browse window contexts, refer to 
“Changing the browse view (context)” on page 169, and “Other browse 
contexts” on page 170.

A selection of keywords appears below

assessment
iep

– Displays the student context, with assessments (IEPs) as the “other” list. 
If the user has selected a student display in Preferences1 that specifies 
student contacts or transitions as the “other” list, then the program will also 
temporarily switch to display assessments in the upper list, and students in 
the lower list.

If the user then switches to another context (e.g., pressing the STAFF 
button), and back again (by pressing the STUDENTS button), then the 
browse window will revert to the original, user-preferred configuration for 
students.

If the user is already in the students context when s/he enters this keyword, 
but the “other” list is not assessments, then the browse window will switch 
temporarily to displaying assessments in the upper list, and students in the 
lower list.

discipline
disciplinary

– Displays the discipline context, with disciplinary actions in the upper list 
and associated students in the lower list.

district

– Displays the districts context, with districts in the upper list and schools in 
the lower list.

goal

– Displays the goals context, with assessment goals in the upper list, and 
students in the lower list.

itp
referral
transition

1. Refer to the Chapter, Configuring SELPA Manager  on page 295 .
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– Displays the student context, with transitions (ITPs) as the “other” list. If 
the user has selected a student display in Preferences that specifies student 
contacts or assessments (IEPs) as the “other” list, then the program will also 
temporarily switch to display transitions in the upper list, and students in the 
lower list.

If the user then switches to another context (e.g., pressing the STAFF 
button), and back again (by pressing the STUDENTS button), then the 
browse window will revert to the original, user-preferred configuration for 
students.

If the user is already in the students context when s/he enters this keyword, 
but the “other” list is not transitions, then the browse window will switch 
temporarily to displaying transitions in the upper list, and students in the 
lower list.

postal
zip

– Displays the postal code context, with postal (Zip) codes in the upper list, 
and student contacts containing those postal codes in the lower list.

schedule
calendar
date

– Displays the graphical Calendar. No lists are displayed in this mode. 

school

– Displays the schools context, with schools in the upper list and teacher 
assignments in the lower list.

service
enrollment

– Displays the student services context, with student services in the upper 
list, and either students or teachers in the lower list (depending upon the 
user’s setting in Preferences). 

show user info

– Displays the user information context, with [User_info] records (program 
users) in the upper list, and Calendar items posted by the users, in the lower 
list.

student



– Displays the students context, with students in the upper list. If the user 
has selected a student display in Preferences that places students in the lower 
list, then this keyword will also temporarily switch the browse window to 
display students in the upper list, and student contacts in the lower list. 

If the user then switches to another context (e.g., pressing the STAFF or 
SCHOOLS button), and back again (by pressing the STUDENTS button), 
then the browse window will revert to the original, user-preferred 
configuration for students.

teacher
staff

– Displays the staff context, with teachers/staff members in the upper list, 
and either teacher assignments or teacher services in the lower list 
(depending upon the user-specified setting in Preferences).

tracking
event

– Displays the tracking information context, with [Tracking] records in the 
upper list, and associated [User_info] records in the lower list.

Searching for records on a change of context

When you enter a keyword into the Location box to switch to a new context 
(“student”, “service”, “calendar”, etc.), you can also append a comparison 
operator and a value, to compose a simple sentence or phrase. The additional 
elements in the phrase will cause SELPA Manager to search for a particular 
selection of records, after the change of context. For example,

Student is Collyer, Robyn
Calendar for June 5, 1999
Schedule for 7.19.2002
Teacher is “Salter, Stephanie”
District is not Whistler Amalgamated

Not all search types are supported, and the results of certain unusual types 
of searches may not be what you expect. For example, “Service is not 
Collyer, Robin” will switch to the student services context, but is not likely 
to display anything of value as the found selection of records.
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In-context search expressions (Location box)
When a user-entered phrase in the Location box won’t evaluate as an 
attendance confirmation expression, a standard search expression, a special 
expression, or a context-changing keyword, then SELPA Manager may 
attempt to evaluate the phrase in the current context of the browse window.

An in-context search expression takes the form,

<search object> <comparison operator> <value>

...where “<search object>” is a specific, short-hand representation for a field 
or some other searchable entity relevant to the current context. It is not the 
name of the field itself, which if entered could have been recognized as a 
standard search expression1. 

For example, if a students list has the current focus, then you might enter one 
of the following items as an in-context search expression, to locate a 
particular student record:

First is Mindy
Last is Jacobs
Name is Jacobs
Contact is Melvin Jacobs

...where “First” and “Last” are shorthand expressions for the fields, 
[Student]First_name and [Student]Last_name, respectively. “Name” is 
another shorthand for the [Student]Last_name field. “Contact” refers to the 
[Student_contact]Contact_name field; in this case, the program first looks 
for a contact with a particular name in the [Student_contact] table. It then 
finds the associated student record(s) for these contact(s).

Note that if you had entered,

First name is Mindy
Record number is 3066429-00236-0009

...then SELPA Manager would have recognized the field (“first name” or 
“record number”) for the [Student] table, and thus would evaluate the item 
as a standard search expression, prior to arriving at this point of evaluation.

1. A discussion of standard search expressions appears on page 186.



In-context search expression, evaluation table

In the table below, selected “<search object>” phrases for in-context search 
expressions appear in the second column. The database table name appears 
in the first column. For the “<search object>” phrases to be effective, the 
database table should be displayed in the browse list that has the current 
focus. Not all database tables have these expressions.

For the [Calendar_item] table, the search phrases listed below apply to 

Location box text only when the graphical Calendar is being displayed. 

The Calendar will display a maximum of 30 days  span after a search, 

beginning with the earliest item found in the search.

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken

[Assessment] “last” last is Miller [Assessment]Last_name, field search

[Assessment] “first” first is 
ferdinand

[Assessment]First_name, field search

[Assessment] “contact” or “parent” or 
“guardian”

Contact is Eileen 
Nussbaum

[Assessment]Parent_guardian_name, field 
search

[Assessment] “type” type is initial [Assessment]IEP_meeting_type, field search

[Assessment] “address” address is 275 
Robards Lane

[Assessment]Address_Line1 or 
[Assessment]Address_Line2 (search both 
fields)

[Assessment] “home phone” home phone is 212 
761-1561

[Assessment]Telephone_home, field search

[Assessment] “work phone” work phone is 
(209) 337-4428

[Assessment]Telephone_work, field search

[Assessment] “phone” phone is 716 248-
4769

[Assessment]Telephone_home or 
[Assessment]Telephone_work (search both 
fields)

[Assessment_goal] “last” last is Jones [Assessment_goal]Last_name

[Assessment_goal] “first” first is Natalie [Assessment_goal]First_name
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[Assessment_goal] “record number” record number is 
3027438-00927-
0026

[Assessment_goal]Record_number

[Assessment_goal] “contact” contact is Maybel 
Harrison

[Student_contact]Contact_name field search 
to get [Student] record(s), then join to get all 
goals for these student(s)

[Assessment_goal] “stdnt number”, “id 
number”, or “id#”

stdnt number is 
300960

[Student]Student_number, field search to get 
[Student] record(s), then join to get all goals 
for these student(s)

[Assessment_goal] “dob” or “date of birth” dob is 8.12.92 [Student]Date_of_birth, field search to get 
[Student] record(s), then join to get all goals 
for these student(s)

[Assessment_goal] “ssn” ssn is 955-83-
2046

[Student]SSN, field search to get [Student] 
record(s), then join to get all goals for these 
student(s). Text must parse to a 9-digit 
numeric code. 

[Calendar_item]a “last” Last is 
Scotchworthy

[Student]Last_name, field search, then find 
any Calendar items associated with each 
found student.

[Calendar_item] “first” First is Darryl [Student]First_name, field search, then find 
any Calendar items associated with each 
found student.

[Calendar_item] “record number” Record number is 
3074238-00425-
0003

[Student]Record_number, field search, then 
find any Calendar items associated with each 
found student.

[Calendar_item] “contact” Contact is Mavis 
Kamminger

[Student_contact]Contact_name, field 
search, then join from [Student_contact] to 
[Student]. Find any Calendar items 
associated with each found student.

[Calendar_item] “stdnt number”, “id 
number”, or “id#”

id# is 393542 [Student]Student_number, field search, then 
find any Calendar items associated with each 
found student

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken



[Calendar_item] “dob” or “birth” dob is 10.15.1992 [Student]Date_of_birth, field search, then 
find any Calendar items associated with each 
found student

[Calendar_item] “ssn” ssn is 204-4438-
7699

[Student]SSN, field search, then find any 
Calendar items associated with each found 
student

[Calendar_item] “teach name” or “teach. 
name”

teach name is 
Waldbaum, Ivan

[Teacher]Teacher_name, field search, then 
find any Calendar items associated with each 
found teacher

[Calendar_item] “teach code” or 
“teach.code”

teach code is 007 [Teacher]Teacher_code, field search, then 
find any Calendar items associated with each 
found teacher

[Calendar_item] “starts on” starts on 
6/15/2003

[Calendar_item]Start_date, field search 
(value must be a non-blank date)

[Calendar_item] “ends on” ends on 9.18.2001 [Calendar_item]End_date, field search

[Calendar_item] “banner” banner for 
Bostick 
Conference

[Calendar_item]Item_type field search for 
“Banner”, AND [Calendar_item]Description 
field search on value

[Calendar_item] “event” event is speech 
exercise

[Calendar_item]Item_type field search for 
“Event”, AND [Calendar_item]Description 
field search on value

[Calendar_item] “item” item is speech 
class

[Calendar_item]Description, field search

[Disciplinary_action] “report date” report date is 
after 6.21.1999

[Disciplinary_action]Incident_D, field 
search

[Disciplinary_action] “action begins”, “start 
date”, or “action starts”

action begins on 
5/20/04

[Disciplinary_action]Action_start_D, field 
search

[Disciplinary_action] “duration” duration is 
greater than 5

[Disciplinary_action]Number_of_days, field 
search

[Disciplinary_action] “reason”, with 2-digit 
<value>

Reason is 20 [Disciplinary_action]Reason_code_1, 
[Disciplinary_action]Reason_code_2, or 
[Disciplinary_action]Reason_code_3

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken
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[Disciplinary_action] “reason”, <value> is 
NOT 2 digits

Reason is serious 
physical injury

[Disciplinary_action]Reason_1, 
[Disciplinary_action]Reason_2, or 
[Disciplinary_action]Reason_3

[Disciplinary_action] “status”, with 2-digit 
<value>

status is 32 [Disciplinary_action]Student_status_code

[Disciplinary_action] “status”, <value> is NOT 
2 digits

status is 
community

[Disciplinary_action]Student_status_name

[Disciplinary_action] “last” last is briggins [Student]Last_name, field search to get 
[Student] record(s), then join to get all 
disciplinary actions for these student(s)

[Disciplinary_action] “first” first is melvin [Student]First_name, field search to get 
[Student] record(s), then join to get all 
disciplinary actions for these student(s)

[Disciplinary_action] “ssn” ssn is 247-33-
2488

[Student]SSN, field search to get [Student] 
record(s), then join to get all disciplinary 
actions for these student(s)

[Disciplinary_action] “stdnt” stdnt is melvin 
briggins

Finds [Student] record(s) using “<firstName 
LastName>”, “<LastName, FirstName>”, 
[Student]Last_name, 
[Student]Student_number”, or 
[Student]First_name. If student(s) are found, 
joins to obtain disciplinary actions for 
this/these student(s)

[Disciplinary_action] “ID#” or “ID nbr” ID nbr is 39448 [Student]Student_number, field search to get 
[Student] record(s), then join to get all 
disciplinary actions for these student(s)

[District] “name” name is Ludlow 
Unified

[District]District_name

[District] “code” Code is 0461537 [District]District_code

[Postal_code] “zip” or “code” code is 95423 [Postal_code]Postal_code

[Postal_code] “ac” ac is 917 [Postal_code]Area_code

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken



[Postal_code] “st” or “prov” st is MA [Postal_code]State_prov

[Postal_code] “lat” lat is 34.04 [Postal_code]Latitude

[Postal_code] “long” long is 118.13 [Postal_code]Longitude

[School] “name” name is Betty 
Middle

[School]School_name

[School] “code” code is 6061438 [School]School_code

[School] “address” address is 179 
Commercial St.

[School]Address_1 or [School]Address_2 
(search both fields)

[School] “phone” phone is 409 878-
2234

[School]Telephone

[School] “principal” principal is 
Milton Dugger

[School]Principal_name

[School] “type” type is 10 [School]Type_school_code (if <value> can 
be parsed to 2 numeric digits); otherwise 
[School]Type_school_name

[Student] “last” last is Boudreaux [Student]Last_name

[Student] “first” first is Marcy [Student]First_name

[Student] “contact” contact is Larry 
Boudreaux

[Student_contact]Contact_name search, then 
join to get student(s) for this/these contact(s)

[Student] “name” name is Boudreaux [Student]Last_name

[Student] “id number” or “id#” id# is 308427 [Student]Student_number

[Student] “dob”, “birthday”, or 
“birth date”

dob on 7.21.93 [Student]Date_of_birth

[Student] “ssn” ssn is 181-44-
2934

[Student]SSN (value must parse to a 9-digit 
numeric code). 

[Student] “dnr” dnr is true [Student]Do_not_report_B

[Student] “dnq” dnq is yes [Student]Does_not_qualify_B

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken
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[Student_contact] “name” or “contact” name is Greta 
Marks

[Student_contact]Contact_name

[Student_contact] “type” type is emergency [Student_contact]Address_type

[Student_contact] “relation” relation is 
father

[Student_contact]Contact_relation

[Student_contact] “address” address is 233 
Hathaway Place

[Student_contact]Address_Line1 or 
[Student_contact]Address_Line2 (search 
both fields)

[Student_contact] “home phone” home phone is 212 
443-8378

[Student_contact]Telephone_home

[Student_contact] “work phone” work phone is 917 
246-8776

[Student_contact]Telephone_work

[Student_contact] “other phone” other phone is 
617 267-0189

[Student_contact]Telephone_3

[Student_contact] “phone” phone is 818 923-
6927

[Student_contact]Telephone_home, 
[Student_contact]Telephone_work, or 
[Student_contact]Telephone_3 (search 3 
fields)

[Student_contact] “email”, “e-mail”, or “e 
mail”

email is 
knute@wallow.com

[Student_contact]e_mail_1 or 
[Student_contact]e_mail_2 (search both 
fields)

[Student_service] “start” start is 
3/15/2001

[Student_service]Start_D

[Student_service] “original start” original start is 
before 9/12/99

[Student_service]Start_original_D

[Student_service] “drop” drop is after 
7/21/2001

[Student_service]Drop_D

[Student_service] “loc” or “place” place is Whidbey 
West

[School]School_code (if <value> can be 
parsed to a numeric code) or 
[School]School_name, then join to get all 
student services at this/these school(s).

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken



[Student_service] “service” or “svc” service is 26 [Student_service]CASEMIS_service_code 
(if <value> can be parsed to a number); or 
[Student_service]CASEMIS_service_name. 
For a code-type search, program looks for 
“old-style” as well as current (2-digit) codes.

[Student_service] “provider”, “pvdr”, or 
“teach”

provider is 
Hathaway, 
Marylou

[Student_service]Teacher_name

[Student_service] “primary drop reason” or 
“prmy drop rsn”

prmy drop rsn is 
76

[Student_service]Drop_rsnCode_primary (if 
<value> can be parsed to a 2-digit numeric 
code), or 
[Student_service]Drop_reason_primary.

[Student_service] “non-primary drop 
reason” or “np drop rsn”

np drop rsn is 80 [Student_service]Drop_rsnCode_nonPrmy 
(if <value> can be parsed to a numeric code), 
or [Student_service]Drop_reason_nonPrmy.

[Student_service] “drop reason” or “drop 
rsn”

drop rsn is 80 [Student_service]Drop_rsnCode_primary or 
[Student_service]Drop_rsnCode_nonPrmy 
(if <value> can be parsed to a numeric code); 
If not, then search 
Student_service]Drop_reason_primary or 
[Student_service]Drop_reason_nonPrmy.

[Student_service] “last” last is Gomez [Student]Last_name, field search to get 
[Student] record(s), then join to get all 
service(s) for these student(s)

[Student_service] “first” first is Joaquin [Student]First_name, field search to get 
[Student] record(s), then join to get all 
service(s) for these student(s)

[Student_service] “ssn” ssn is 181-44-
2934

[Student]SSN, field search (value must parse 
to a 9-digit numeric code). Obtain [Student] 
record(s), then join to get all service(s) for 
these student(s). 

[Student_service] “stdnt” stdnt is Joaquin 
Sanchez

Finds [Student] record(s) using “<firstName 
LastName>”, “<LastName, FirstName>”, 
[Student]Last_name, 
[Student]Student_number”, or 
[Student]First_name. If student(s) are found, 
joins to obtain services for this/these 
student(s).

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken
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[Student_service] “ID#” or “ID nbr” ID nbr is 39448 [Student]Student_number, field search to get 
[Student] record(s), then join to get all 
service(s) for these student(s)

[Teacher] “name” name is 
Fitzsimmons, 
Larry

[Teacher]Teacher_name

[Teacher] “code” code is 20348 [Teacher]Teacher_code

[Teacher] “address” address is 1980 
Congdon Pl.

[Teacher]Address_Line1 or 
[Teacher]Address_Line2 (search both fields)

[Teacher] “home phone” home phone is 409 
277-3162

[Teacher]Telephone_home

[Teacher] “work phone” work phone is 713 
322-8489

[Teacher]Telephone_work

[Teacher] “other phone” other phone is 
877 602-3948

[Teacher]Telephone_other

[Teacher] “phone” phone is 817 346-
4438

[Teacher]Telephone_home, 
[Teacher]Telephone_work, or 
[Teacher]Telephone_other (search 3 fields)

[Teacher] “email”, “e-mail”, or “e 
mail”

email is 
rosa@tepas.com

[Teacher]e_mail_1 or [Teacher]e_mail_2 
(search both fields)

[Teacher_service] “name” name is Waltham, 
Noah

[Teacher]Teacher_name search, then join to 
get service(s) for this/these teacher(s)

[Teacher_service] “code” code is 410-50 [Teacher_service]CASEMIS_service_code 
(NOTE: does NOT search for both “old-
style” and current equivalents of the entered 
value)

[Teacher_service] “service” or “svc” svc is 26 [Teacher_service]CASEMIS_service_code 
(if <value> can be parsed to a number); or 
[Teacher_service]Service_name. For a code-
type search, program looks for “old-style” as 
well as current (2-digit) codes.

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken



[Teacher_service] “status” status is 
certified

[Teacher_service]Certified_status

[Teacher_service] “address” address is 77 
Massachusetts 
Avenue

[Teacher]Address_Line1 or 
[Teacher]Address_Line1 (search both fields) 
for teacher(s) at this address, then join to 
obtain service(s) for this/these teacher(s)

[Teacher_service] “home phone” home phone is 414 
773 2648

[Teacher]Telephone_home, field search for 
teacher(s), then join to obtain service(s) for 
this/these teacher(s)

[Teacher_service] “work phone” work phone is 
(213) 855-7628

[Teacher]Telephone_work, field search for 
teacher(s), then join to obtain service(s) for 
this/these teacher(s)

[Teacher_service] “other phone” other phone is 
409.635.2293

[Teacher]Telephone_other, field search for 
teacher(s), then join to obtain service(s) for 
this/these teacher(s)

[Teacher_service] “phone” phone is 206-455-
7389

[Teacher]Telephone_home, 
[Teacher]Telephone_work, or 
[Teacher]Telephone_other (search 3 fields) 
for teacher(s), then join to obtain service(s) 
for this/these teacher(s)

[Teacher_service] “email”, “e-mail”, or “e 
mail”

email is 
rodney@mulch.com

[Teacher]e_mail_1 or [Teacher]e_mail_2 
(search both fields), then join to obtain 
service(s) for this/these teacher(s)

[Transition] “meeting” meeting on 
8/17/2003

[Transition]Meeting_date

[Transition] “last” last is hedwig [Student]Last_name field search, then join to 
obtain transition(s) for this/these student(s)

[Transition] “first” first is morton [Student]First_name field search, then join to 
obtain transition(s) for this/these student(s)

[Transition] “ssn” ssn is 334-72-
4088

[Student]SSN field search, then join to obtain 
transition(s) for this/these student(s)

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken
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In-context, “free-form” searches

In some cases, you can enter a word or phrase into the Location box for 
which you want to search, without using the full “<search object> 
<comparison operator> <value>” structure needed for a complete, in-
context search expression. 

In some cases, SELPA Manager will attempt to apply the word or phrase to 
what it considers the most likely field or fields, based upon the current 
browse window context. Again using the case where a student list has the 
current focus,

[Transition] “stdnt” stdnt is Bouey, 
Lester

Finds [Student] record(s) using “<firstName 
LastName>”, “<LastName, FirstName>”, 
[Student]Last_name, 
[Student]Student_number”, or 
[Student]First_name. If student(s) are found, 
joins to obtain transitions for this/these 
student(s).

[Transition] “ID#” or “ID nbr” ID nbr is 60244 [Student]Student_number, field search to get 
[Student] record(s), then join to get all 
transition(s) for these student(s)

[Transition] “record number” or “rec 
nbr”

rec nbr is 
4177345-00185-
0009

[Student]Record_number, field search to get 
[Student] record(s), then join to get all 
transition(s) for these student(s)

[User_info] “name” name is Badger, 
Myron

[User_info]User_name

[User_info] “ID” ID is 5 [User_info]User_ID

a. The Calendar will display a maximum range of 30 days, as the result of a search. If the found items

span greater than a 30-day period, then the Calendar will begin on the day of the earliest item. The pro-

gram will present a warning that some items are not displayed. If desired, the user can display a larger

range than 30 days on the Calendar, by selecting a different end date.

Table: Search objects and their meaning (Location box)

Table (list) with the 
current focus

Search object in 
text

Example Field to be searched, or other 
action to be taken



Mindy
Jacobs
Mindy Jacobs
Jacobs, Mindy
3066429-00236-0009

...are examples of free-form searches for a student record. 

The results of a free-form search may be less-than-satisfactory, however, 
due to a lower level of specificity. For example, there may be students who 
have a last name of “Mindy”, as well as students with a first name of 
“Mindy”. In this case, SELPA Manager will only find the students whose 
last name is “Mindy”, because it stops evaluating a free-form search when 
it finds a positive number of records. 

Where you are least certain of what the results should be from a search, you 
should use as much specificity as you can – a standard search expression, or 
an in-context search expression that uses the full syntax.

In-context, “free-form” searches, evaluation table

The table below identifies the evaluation sequence for entered Location box 
text, when the user has not specified the full, in-context search syntax, and 
a “free-form” search is to be conducted. These searches are available only 
when the focus is on the specified list (database table). Some database tables 
do not have “free-form” searches.

For the [Calendar_item] table, the action to be taken applies to Location 

box text only when the graphical Calendar is being displayed. The 

Calendar will display a maximum of 30 days  span after a search, 

beginning with the earliest found item.

.

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken

[Assessment] 1 [Assessment]Meeting_date (if text can be parsed to a 
date)

[Assessment] 2 [Assessment]SSN (if text can be parsed to a 9-digit 
number)
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[Assessment] 3 [Assessment]Telephone_home o r 
[Assessment]Telephone_work (if text can be parsed to 
a 10-digit number)

[Assessment] 4 [Student]Record_number search (if text can be parsed 
to 16 numerals, but has 18 total characters, including 
at least one hyphen). Join from [Student] to 
[Assessment].

[Assessment] 5 BOTH [Assessment]Last_name AND 
[Assessment]First_name, if the text parses to either 
“lastName, firstName” or “firstName lastName”.

[Assessment] 6 [Assessment]Last_name

[Assessment] 7 [Assessment]Parent_guardian_name

[Assessment] 8 [Assessment]IEP_meeting_type

[Assessment] 9 [Student]Student_number, Join from [Student] to 
[Assessment].

[Assessment_goal] 1 [Assessment_goal]Goal_priority_nbr (if text can be 
parsed to a non-zero numeric value)

[Assessment_goal] 2 BOTH [Assessment_goal]Last_name AND 
[Assessment_goal]First_name, if the text parses to 
either “lastName, firstName” or “firstName 
lastName”.

[Assessment_goal] 3 [Assessment_goal]Last_name

[Assessment_goal] 4 [Assessment_goal]First_name

[Assessment_goal] 5 [Assessment_goal]Goal_text

[Calendar_item]a 1 If user has entered a date that is the first of any month, 
then the Calendar re-sizes to display the month 
starting on that date.

[Calendar_item] 2 If user has entered a date that is not on the first of any 
month, then the Calendar refreshes to display a 5-day 
period including that date.

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken



[Calendar_item] 3 If user enters text containing “today” or “now”, then 
the Calendar re-sizes to display a 5-day period 
including today’s date, where the date is either 
[Calendar_item]Start_date or 
[Calendar_item]End_date.

[Calendar_item] 4 If user enters text containing “this month”, then the 
Calendar refreshes to display the current month.

[Calendar_item] 5 If user enters text containing “last month”, then the 
Calendar refreshes to display the previous month.

[Calendar_item] 6 If user enters text containing “next month”, then the 
Calendar refreshes to display the next month.

[Calendar_item] 7 If user enters text that can be parsed as a student’s 
name (“<lastName, firstName>” or “<firstName 
lastName>”), then the program will search the 
[Student] table for any students with this name. The 
Calendar refreshes to display any associated items for 
this/these student(s).

[Calendar_item] 8 [Calendar_item]Description

[Disciplinary_action] 1 [Disciplinary_action]Action_start_D or 
[Disciplinary_action]Incident_D search (if text can be 
parsed to a date)

[Disciplinary_action] 2 [Student]SSN search (if text can be parsed to a 9-digit 
numeric code). Join from [Student] to 
[Disciplinary_action].

[Disciplinary_action] 3 [Student]Record_number search (if text can be parsed 
to 16 numerals, but has 18 total characters, including 
at least one hyphen). Join from [Student] to 
[Disciplinary_action]

[Disciplinary_action] 4 [Disciplinary_action]Reason_code_1, or 
[Disciplinary_action]Reason_code_2, or 
[Disciplinary_action]Reason_code_3, or 
[Disciplinary_action]Student_status_code search (if 
text can be parsed to a 2-numeral code)

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken
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[Disciplinary_action] 5 BOTH [Student]Last_name AND 
[Student]First_name, if the text parses to either 
“<lastName, firstName>” or “<firstName 
lastName>”. Join from [Student] to 
[Disciplinary_action]

[Disciplinary_action] 6 [Student]Last_name, [Student]Student_number, or 
[Student]First_name search, then join from [Student] 
to [Disciplinary_action].

[Disciplinary_action] 7 [Disciplinary_action]Reason_1

[Disciplinary_action] 8 [Disciplinary_action]Reason_2

[Disciplinary_action] 9 [Disciplinary_action]Reason_3

[Disciplinary_action] 10 [Disciplinary_action]Student_status_name

[District] 1 [District]District_code

[District] 2 [District]District_name

[Postal_code] 1 [Postal_code]Postal_code

[Postal_code] 2 [Postal_code]City

[Postal_code] 3 [Postal_code]State_prov

[Postal_code] 4 [Postal_code]County

[Postal_code] 5 [Postal_code]FIPS

[School] 1 [School]School_code

[School] 2 [School]School_name

[School] 3 [School]Principal_name

[School] 4 [School]City

[School] 5 [School]Postal_code

[School] 6 [School]Address_1 or [School]Address_2

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken



[Student] 1 [Student]Date_of_birth (if text can be parsed to a date)

[Student] 2 BOTH [Student]Last_name AND 
[Student]First_name, if the text parses to either 
“<lastName, firstName>” or “<firstName lastName>”

[Student] 3 [Student]Last_name 

[Student] 4 [Student]Record_number

[Student] 5 [Student]Student_number 

[Student] 6 [Student]First_name 

[Student_contact] 1 [Student_contact]Telephone_home, 
[Student_contact]Telephone_work, or 
[Student_contact]Telephone_3, search of 3 fields, 
only if text can be parsed to a 10-digit numeric code

[Student_contact] 2 [Student_contact]Postal_code, only if text can be 
parsed to either a 5- or a 9-digit postal (Zip) code

[Student_contact] 3 [Student_contact]Contact_name

[Student_contact] 4 [Student_contact]Contact_relation

[Student_contact] 5 [Student_contact]Address_type

[Student_contact] 6 [Student_contact]e_mail_1

[Student_contact] 7 [Student_contact]e_mail_2

[Student_contact] 8 [Student_contact]Address_Line1

[Student_contact] 9 [Student_contact]Address_Line2

[Student_contact] 10 [Student_contact]City

[Student_contact] 11 [Student_contact]Telephone_home, 
[Student_contact]Telephone_work, or 
[Student_contact]Telephone_3

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken
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[Student_service] 1 [Student_service]Start_original_D, 
[Student_service]Start_D, or 
[Student_service]Drop_D search (only if text can be 
parsed to a non-blank date)

[Student_service] 2 [Student]SSN search (if text can be parsed to a 9-digit 
numeric code). Join from [Student] to 
[Student_service].

[Student_service] 3 [Student]Record_number search (if text can be parsed 
to 16 numerals, but has 18 total characters, including 
at least one hyphen). Join from [Student] to 
[Student_service]

[Student_service] 4 [School]School_code search (if text can be parsed to a 
7-digit numeric code). Join from [School] to 
[Student_service].

[Student_service] 5 [Student_service]CASEMIS_service_code (if text can 
be parsed to a 2, 3, or 5-digit numeric code)

[Student_service] 6 BOTH [Student]Last_name AND 
[Student]First_name, if the text parses to either 
“<lastName, firstName>” or “<firstName 
lastName>”. Join from [Student] to [Student_service]

[Student_service] 7 [Student]Last_name search. Join from [Student] to 
[Student_service]

[Student_service] 8 [Student]Student_number search. Join from [Student] 
to [Student_service]

[Student_service] 9 [Student]First_name search. Join from [Student] to 
[Student_service]

[Student_service] 10 [Student_service]School_name

[Student_service] 11 [Student_service]Teacher_name

[Student_service] 12 [Student_service]CASEMIS_service_code

[Student_service] 13 [Student_service]Service_name

[Teacher] 1 [Teacher]Teacher_name

[Teacher] 2 [Teacher]Teacher_code

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken



[Teacher] 3 [Teacher]e_mail_1

[Teacher] 4 [Teacher]e_mail_2

[Teacher_service] 1 [Teacher_service]Service_name

[Teacher_service] 2 [Teacher_service]CASEMIS_service_code

[Teacher_service] 3 [Teacher_service]Certified_status

[Teacher_service] 4 [Teacher_service]Service_note

[Teacher_service] 5 [Teacher]Teacher_name search, then join to get 
service(s) for this/these teacher(s)

[Teacher_service] 6 [Teacher]Teacher_code search, then join to get 
service(s) for this/these teacher(s)

[Teacher_service] 7 [Teacher]Teacher_email_1 search, then join to get 
service(s) for this/these teacher(s)

[Teacher_service] 8 [Teacher]Teacher_email_2 search, then join to get 
service(s) for this/these teacher(s)

[Transition] 1 [Transition]Meeting_date or 
[Transition]Projected_transition_D, if text can be 
parsed to a date

[Transition] 2 [Student]SSN search (if text can be parsed to a 9-digit 
numeric code). Join from [Student] to [Transition].

[Transition] 3 [Student]Record_number search (if text can be parsed 
to 16 numerals, but has 18 total characters, including 
at least one hyphen). Join from [Student] to 
[Transition]

[Transition] 4 BOTH [Student]Last_name AND 
[Student]First_name, if the text parses to either 
“<lastName, firstName>” or “<firstName 
lastName>”. Join from [Student] to [Transition]

[Transition] 5 [Student]Last_name search. Join from [Student] to 
[Transition]

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken
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Last found set
Each time that you perform a search by using the Query Editor, by entering 
a request into the Location box), or indirectly by other means, SELPA 
Manager remembers the newly-displayed records in both browse lists. It 
remembers these records in the form of two “sets”. A set is a compact 
representation of a selection of records. A set does not contain any field data 
for the records that it represents.

After completing a search, you might make other manipulations that change 
the selection of records in each browse list. For example, you could 
highlight a few student records and then select “Show subset” or “Omit 
subset” from the Data menu. You might then highlight an assessment record 
in the lower list, so that only one student name remains in the upper list.

You can restore the selection of records from the last search operation by 
selecting “Last found set” from the Data menu. SELPA Manager will 
display a dialog (Fig. 3-29) that offers the option to “remember (save)” or to 
“restore (recall)” selections of records for the browse window.

Press the OK button to accept the dialog with the default option selected 
(“Recall (restore) results from last search activity”). The program will then 
display the records that were listed from the last search operation in the 

[Transition] 6 [Student]Student_number search. Join from [Student] 
to [Transition]

[Transition] 7 [Student]First_name search. Join from [Student] to 
[Transition]

[User_info] 1 [User_info]User_name

[User_info] 2 [User_info]User_ID

a. The Calendar will display a maximum range of 30 days, as the result of a search.

If the found items span greater than a 30-day period, then the Calendar will begin on

the day of the earliest item. The program will present a warning that some items are

not displayed. If desired, the user can display a larger range than 30 days on the Cal-

endar, by selecting a different end date.

Table: Evaluation of “free-form,” in-context searches (Location box)

Table (list) with the current 
focus

Field 
order

Field(s) to be searched, or other action to 
be taken



current context. If you have not performed any searches since opening the 
browse window, or since changing to the current context, then the program 
will restore the selection of records initially displayed when the browse 
window first opened, or when you last switched browse window contexts.

Fig. 3-29. Last found or last saved set dialog.

The program remembers (can recall) the displayed records only until you 
perform the next search, or change to a new browse window context.

For example, suppose that you have a current selection of six students listed 
in the upper browse list. You obtained these particular students by searching 
for students with the last name of “Sanchez”. 

You then highlight the name of one of the “Sanchez” students, click into the 
lower browse list (assessments), and then select “New record” from the Data 
menu. SELPA Manager creates a new [Assessment] record and displays the 
IEP data entry form.

After saving the new assessment record, only the “Sanchez” student that you 
highlighted to add the IEP will remain in the upper (students) list. To restore 
the original set of six “Sanchez” students, select “Last found set” from the 
Data menu. Leave the default option selected in the dialog (“Recall (restore) 
results from last search activity”) and press OK. The program will display 
the six original students again.

Suppose that you now perform another search, for students named “Smith”, 
from the data menu, and then make other manipulations (highlighting 
records, omitting or showing subsets, etc.). If you again select “Last found 
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set” from the data menu, then the program will no longer remember the 6 
“Sanchez” student records. Instead, it will remember the results of the 
“Smith” search.1

Last durable (saved) set
SELPA Manager can remember browse window record selections for a 
longer period of time than the last found set mechanism (“Last found set” 
on page 222). After you pick “Last found set” from the Data menu, and the 
program displays the dialog (Fig. 3-29, above), pick the first option, 
“Remember (save) current selections for this window”, and press the OK 
button.

The program will then maintain sets in memory until the browse window is 
closed, until the program itself is closed, or until you perform this keystroke 
action again for the same browse window. Each browse window that is open 
can maintain its own sets in memory, in this manner.

To restore the record selections from the sets in memory, pick “Last found 
set” from the Data menu again, and select the middle option, “Recall 
(restore) last saved selections for this window”. 

To restore both the upper and lower record selections, you must be in the 
same browse window and the same context from which you originally 
“saved” the sets to memory. 

If the browse window is in a different context, then SELPA Manager will 
attempt to restore one or the other record selections, if possible. For 
example, suppose that you were displaying students and assessments when 
the sets were “saved,” but are now displaying student services and students 
in the same browse window. In this case, SELPA Manager will restore the 
student selection of records, but not the assessments.

Saving a set to disk
You can also save browse window record selections for a longer period of 
time, by creating a set reference file on disk. This information will be 
preserved between SELPA Manager sessions; that is, you can quit SELPA 
Manager, re-start the program, and then restore the set(s) from disk.

1. For additional discussion, refer to “Last found set” on page 639.



To save a record selection as a set on disk, use the “Save a set” command 
from the Data menu. The set to be saved will represent the record selection 
for the browse window list that has the current focus (the upper or the lower 
list, refer to “Current focus of the browse window” on page 178). 

To restore the record selection, use the “Open a set” command from the Data 
menu. The current focus of the browse window must be on the same list as 
when the set was saved. Otherwise, the restore operation will not be 
successful.

The “Save a set” action does not save the contents of the records themselves, 
but instead saves a reference to each of the records that is listed. Old sets can 
be misleading, because they may contain references to records that may 
have been deleted from the program since the set was saved. A Frenchman 
once said, “sets are like fish – they are best used when fresh.”1

Word processing (4D Write)
The browse window supports the creation of word processing documents, 
which can be printed in association with a selection of listed records, for 
mail-merge and similar purposes. 

To open a new or an existing word processing document, click on the “open 
book”, icon-type button at the lower right corner of the browse window (Fig. 
3-16, visible except when the Calendar is being displayed). SELPA 
Manager will open a new window for the document. The window will 
contain a second (smaller-text) set of menus that are specific to word 
processing.

If the word processing button is dimmed, you may not have the 4D Write 
plug-in module installed with SELPA Manager. 

NOTE: If you are using the multi-user (client-server) version of SELPA 
Manager, you must have licenses for 4D Write installed on the server. The 
single-user runtime version of SELPA Manager includes a built-in license 
for 4D Write. 

1. Attributed to Jean-Pierre Ribreau.
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From the word processing menus, you can insert fields from the various 
tables in SELPA Manager. This insertion process allows you to create “mail 
merge”-type, template documents. You can then select Print Merge from the 
word processing File menu to generate the letter for a selection of records. 
For example, you might create a custom notification letter in this manner.

Before printing a print merge-type letter, ensure that you have an 
appropriate selection of records in the browse window. For example, if you 
wanted to generate a letter for 20 students, then these 20 students should be 
listed in the browse window (as opposed to, for example, all students in the 
program). You might also sort the students alphabetically, prior to opening 
the 4D Write window, by clicking on the “Last name” column header of the 
list, or by selecting “Sort” from the Data menu.

Upon closing the word processing window, the program may ask if the 
template document should be saved. If you do not save the document to a 
location on disk, then you will have to re-create it the next time you want to 
use it. 

NOTE: In other sections of the program, where 4D Write is installed directly 
onto data entry forms, you will not receive this warning message. In these 
cases, the document will be saved automatically when you save the record. 

If you have upgraded from a SELPA Manager 4.6x to SELPA Manager 4.701 
or later, and open a data entry form that contains an existing 4D Write 
document, then the program will ask whether the document should be 
converted to the new 4D Write format. You can specify on this dialog that the 
conversion happen automatically, without displaying the dialog again.

Calendar view (context)
When the browse window is displaying the Calendar view (rather than 
displaying the dual record lists of the other contexts), there are additional 
navigational controls in the window (Fig. 3-30). Depending upon the 
operation being performed and the item(s) selected on the Calendar, some 
of the Calendar controls may be disabled.

A bar along the bottom of the window contains an information box 
surrounded by four arrow keys. The information box indicates the current 
range of the calendar.



The two downward-pointing, white arrows are date range menus. They 
allow you to select a particular range start date (left) and range end date 
(right) for the calendar. The two adjacent left and right arrow buttons will 
move back or advance the entire calendar display by the same interval as is 
currently being displayed.

Fig. 3-30. The Calendar display.

Clicking directly over the information box will move the Calendar to a 
default display of the current month, for all calendar item categories. A 
shortcut for this action is [CONTROL/COMMAND]-J.

To show calendar items in a particular category, select the desired category 
from the pull-down / drop down menu that is just to the right of arrow 
buttons.

banner

events

icon

selected day

range start date

range end date
add event

remove event
add icon

remove icon
refresh display

back one frame

forward one frame
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To add an event or a banner (calendar items spanning more than one day) to 
the Calendar, double-click on the day to which you want to add the item. Be 
sure that you double-click on the day itself, rather than any other items that 
may be listed for that day. If you double-click on an existing event or banner, 
then the program will allow you to edit the existing item.

An alternate method for adding an event or a banner is to single-click on the 
day, and then press the (+) button at the bottom of the browse window.

When you are editing records in certain other sections of SELPA Manager, 
you can still add events to the Calendar. For example, to add an IEP date 
while editing a student (from the IEP notice tab), click on the small, oblong 
button that is just to the right of the IEP date field.

To delete an event or banner from the Calendar itself, click once on the item 
to highlight it, and then press the [BACKSPACE] key. You can also press the 
(-) button at the bottom of the browse window.

If you wish, you can move an event or banner to another day by dragging it. 
You can also enlarge or reduce the size of banners by dragging the edges.

It is possible to add selected icons to the Calendar, by single-clicking on a 
particular day, and then selecting the appropriate icon from the pull-down 
icon menu (along the bottom of the browse window). To remove an icon, 
single-click on the day, and then press the (|-) button.

If you are using SELPA Manager in a multi-user (client-server) installation, 
then you may see the events, banners, and icons that are entered by other 
users. The default refresh interval is every 60 seconds. You may change this 
refresh interval in the Preferences dialog. Also, you refresh the display any 
time that you change from some other context to the Calendar context, or 
when you press the (><) button (along the bottom row of the browse 
window, when the Calendar is displayed).



Searching for calendar items (examples)

The previous discussion pertaining to standard search expressions 
(page 186) and in-context search expressions (page 204) for the Location 
box, also pertains to the Calendar. 

Here are some examples of search expressions that can be entered into 
the Location box, which will affect the Calendar:

1 Searches that will find calendar items for one or more students:

Last name is Smith
First name is Jill
Morgan, Justin 
Record number is 470581-00000020-17
Contact is “Ruby Ferguson”
ID number is TFD3109 
dob is September 9, 1952 
ssn is 327-331-2348

2 Searches that will find calendar items associated with one or more 
teachers/staff members:

teach name is Molly Iverson
teach code is 98398

3 Searches that look for items on a particular date or in a date range:

starts on 9.23.1992
ends on 12.15.2004
today
now
this month
last month
next month

NOTE: If the program does not find any items in the specified range, it will 
still display a target date (with a buffer range), or range corresponding to 
the request.

4 Other types of searches:
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banner is “teachers convention”
event equals IEP for Daniel Smith
item is next 3-year for Katie Wilson

NOTE: If the program finds results from a particular search that are spread 
over more than 60 days’ range, it will warn you and then display the first 60 
days of the range. The calendar may not display properly if you select a very 
large range, or if you select start and/or end dates that are before or after 
the range of your computer’s clock.

Using data entry forms
Data entry forms are the means for viewing or editing records in SELPA 
Manager. A data entry form appears when you double-click in the browse 
window on a listed record (row); and when you add a new record. 

Fig. 3-31 is an example of a data entry form with multiple tabs or “pages” 
to the form.

Information storage on data entry forms

Information storage areas on the data entry form include fields or data 
entry areas, display-only areas, drop-down lists, and combo boxes. 

1 Fields or data entry areas

Fields or data entry areas normally have a white background and recessed 
edges. Some have a scroll bar along the right-hand side, which generally 
indicates that paragraph-style text with carriage returns is allowed (a 
scrolling field).

2 Display-only areas

Display-only areas cannot be entered directly by the user. They resemble 
fields, but may have a gray background and/or a less “chiseled” (recessed) 
appearance1. Some of these areas contain record data created by SELPA 
Manager (the student record number at upper left, in Fig. 3-31), while others 
contain diagnostic information (“missing/problem items list” in Fig. 3-31).

1. The appearance will depend on the user s interface preference, refer to Interface (drop-down

list)  on page 290



Fig. 3-31. Sample data entry form.

3 Drop-down lists

Drop-down lists are raised, rectangular objects (similar to buttons but 
usually thinner), with an arrow icon at the right-hand side. Clicking on a 
drop-down list causes it to display a list of choices from which to select a 
value or other item. 

An example of a drop-down list object appears immediately to the right of 
the “Ethnicity” label in Fig. 3-32, below. This drop-down list selects which 
of up to 6 ethnicities will be entered. In this case, the user has not pressed on 
the arrow icon for this item, so the drop-down list is not displayed.

tabs (navigation among pages) data entry areas

enterable list object

record identity/update information
record navigation (accept changes)

tab/page navigation

display only area

accept/cancel & return to browse

missing/problem items list

combo box
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Fig. 3-32. Choice list menu for a combo box. Clicking on the arrow icon for the 
ethnicity combo box displays a menu of choices, for selecting the ethnicity type. Also 
shown (but not activated) is a simple drop-down list, just to the right of the “Ethnicity” 
label.

4 Combo boxes

Combo boxes are similar to drop-down lists, in that they display a list of 
choices when the user presses on an arrow icon. However, they also permit 
direct user entry, into a recessed, white area adjacent to the drop-down 
arrow. Fig. 3-32 illustrates the drop-down list that displays when the user 
clicks on the drop-down arrow of a combo box, for grade level.

5 List objects

List objects, with gray backgrounds and colored headers, display 
information that is related to the record displayed by the data entry form. 
They function somewhat like a spreadsheet table, with rows and columns. In 
Fig. 3-31, the list object displays contacts for this student. List objects on 
data entry forms typically are enterable by double-clicking into the cell that 
you wish to edit. In some cases, there may also be a drop-down list for an 
individual cell, to select a listed item for the cell.

combo box

drop-down list



Adding or editing records

To add a new record to the program, or to edit an existing record in the 
program:

1 From the browse window, ensure that the list (database table) to which 
you want to add/edit a record has the current focus.

For example, to add/edit a student record, click once on the student list in 
the browse window, to give the student list the current focus.

2 To add a new record, select “New record” from the Data menu.

SELPA Manager will display a blank data entry form, for completing the 
new record.

Certain browse window lists (sections of the program) do not allow record 
addition. In this case, the “New record” item will be dimmed in the Data 
menu. Refer to “The data entry cycle” on page 241.

3 To edit an existing record, double-click on the record’s listing in the 
browse window.

You can also highlight the row corresponding to the existing record, and 
select “Modify record” from the Data menu.

SELPA Manager will display a data entry form for the new or the existing 
record.

Navigation within a record
Once a data entry form is being displayed, you can use certain keystrokes to 
move the cursor through the data entry areas on the form.

• Move forward from one area to the next on the form by pressing the 
[TAB] key. Cursor movement will generally go from left to right and top 
to bottom.

• To move the cursor in reverse order through the form areas, use the 
[SHIFT]-[TAB] keystroke.

• Move the cursor into a particular data entry area by clicking on or into the 
area.
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• Beware of using the [ENTER] key or [ESC] key while still entering 
information on the form. These keys may dismiss (close) the data entry 
form. The [ENTER] key is usually a shortcut for pressing the SAVE 
button, which saves any changes to the record before dismissing the form. 
The [ESC] key is a shortcut for pressing the CANCEL button.

• Use the [RETURN] key only when you are in a text (scrolling) field, to 
create a new paragraph. Using the [RETURN] key in some other area of 
the form may save the record, dismissing the data entry form.

• Some data entry forms are organized into tabs of similar information (a 
“tabbed” form). The tabs will appear at the top of the form. Click on the 
name of the tab to which you want to move. 

• You can also “cycle” among the tabs from left to right, or from right to 
left, by pressing one of two buttons, (<-) and (->), that appear near the 
bottom of a tabbed form, above the record navigation buttons (refer to 
Fig. 3-40, below). The shortcuts for these two buttons are 
[CNTRL/CMD]-[left arrow] and [CNTRL/CMD]-[right arrow], 
respectively.

• For assessment data entry forms, you can use the [CNTRL/CMD]-1, 2, 3, 
etc. keystrokes to go immediately to tab 1, 2, 3 (etc.).

NOTE: Moving from one tab to another on a non-Web-based, tabbed data 
entry form does not save the changes made on the previous tab. All edits (on 
all tabs) for the current record are saved when you press the SAVE button at 
the bottom of the form. Conversely, pressing the CANCEL button results in 
all edits (since the last SAVE) to be undone.

Data entry areas for coded information
Some of the information required by the Department of Education is in the 
form of codes. For example, the state code for a grade level of “Preschool” 
is “17”. The code for a foster family home residence is “30”.

To improve the utility of the information that is stored, SELPA Manager 
maintains both the code and a corresponding code description as separate 
fields within the program. To simplify data entry, however, there may be 
only one area on the form to enter either the code or the description, or both 
(Fig. 3-33). 



For example, to place a student in the tenth grade, you could enter the 
numerals “10”, the words “tenth grade”, or even just “tenth” into the Grade 
level combo box. The entry is not case-sensitive, and the program will 
complete the rest of the information when you move the cursor out of the 
combo box.

Fig. 3-33. Data entry areas containing coded information

Capitalization and filtering
The program automatically capitalizes words in some cases (but not in 
scrolling text fields). This feature allows you to enter text in lower case, if 
desired, and the program will capitalize the first letters of words for you. 
Capitalization occurs as you leave a field, after changing the value Fig. 3-34 
and Fig. 3-35).

The program also filters keyboard-entered text for unusual characters 
(“gremlins”) and, except in scrolling text fields, for extra spaces. If left in 
place, gremlins can create indexing problems.

Fig. 3-34. Lower-case data entry, before leaving the field.
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Fig. 3-35. Capitalization upon leaving a field.

Entry into date fields
To place a date directly into a date field in SELPA Manager, enter the 
numerals without the slashes (as “MMDDYYYY”, see Fig. 3-36). You must 
enter the full, four-digit year. When you have completed the last digit, the 
program moves the cursor into the next data entry area. If the day or month 
is a single digit number, enter the numeral “0” before it.

Fig. 3-36. Blank dates appear in fields as “00/00/00”. However, on entering the field, 
the program switches to “MM/DD/YYYY”.

If the date as entered is more than 30 years away from today’s date, then the 
program will present a warning, asking you to confirm that the date is 
correct. You can limit the range of dates that can be entered into SELPA 
Manager by defining the earliest and latest allowed dates in the Preferences 
dialog (refer to the Chapter, “Configuring SELPA Manager” on page 260).

Dates can also be entered into some list objects on data entry forms. Under 
this circumstance, if you double-click into the cell, then you must enter the 
slashes or other delimiter characters between the numerals. You can also 
select the date from a drop-down list within the cell. The drop-down list 
displays a calendar (Fig. 3-37).



Fig. 3-37. Selecting a date from a drop-down list within a cell, in a list of student 
service records.

Entry into Boolean fields
A Boolean field holds a True/False or Yes/No value. (Boole was a 
mathematician who developed a system of true/false logic and set theory). 
A Boolean field appears in SELPA Manager either as a check box or as a 
pair of radio buttons (Fig. 3-38). A check in the box or a darkened “Yes” 
radio button (first of the button pair) means that the field value is True.

Fig. 3-38. Boolean fields. DNR and Mark are check box-style Boolean fields; 
Translator Required is a “radio-button” style, user-defined Boolean field. 

You can change the “Yes/No” value of a Boolean field by performing one of 
the following actions:

• Click in the field with the mouse.
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• When the field has the current focus (indicated in some cases by the 
dotted surround), press the space bar to alternately check or uncheck the 
field.

• When the field has the current focus, type “Y” or “N” to check or un-
check the field, respectively.

Entry into scrolling text areas
Text input areas permit the entry of paragraph-style information, such as 
notes or an analysis (Fig. 3-39). Each text area can hold up to 32,000 
characters. Text areas behave somewhat like a document in a word 
processing program. Unlike the word processor, however, you cannot 
change font types or styles; you cannot use rulers; and the [TAB] key moves 
the cursor out of the text area (to the next data entry area). 

Unlike other data entry fields, a text area permits the use of the [RETURN] 
key to create a new line or paragraph. In this case, the [RETURN] key does 
not close the data entry form for the record.

Fig. 3-39. Data entry into a scrolling text area.

Saving records
After adding a new record or making changes to an existing one, you will 
need to save these edits into the program. To accomplish this task, press the 
SAVE button on the data entry form. A shortcut for pressing the SAVE 
button is pressing the [ENTER] key on your keyboard.



Another method of saving a modified record is to click on the record 
navigation buttons, to move to another record in the selection. The 
navigation buttons have icons which resemble those on a VCR deck (Fig. 3-
40). If the contents of the current record have not changed, then clicking on 
a navigation button will move to another record without saving any changes 
to the current record.

The shortcut keys for moving to the next record and to the previous record 
with the navigation buttons are [CNTRL/CMD]-[SHIFT]-[right arrow] and 
[CNTRL/CMD]-[SHIFT]-[left arrow], respectively.

When adding a new record, the navigation buttons will be dimmed, because 
at that point there are no other records in the current selection.

If the SAVE button is dimmed (disabled), then the program may have 
determined that there are mandatory fields which you may not have entered 
yet, or entered improperly. In this case, the missing/problem items list at 
the lower right corner of the data entry form will contain at least one 
problem item (Fig. 3-40). The missing/problem items list may also contain 
warnings, but warning items will not prevent you from saving the record.

Fig. 3-40. The SAVE, CANCEL, record navigation (VCR-style) buttons, and the list of 
missing/problem items, data entry form. The SAVE button is dimmed if there are 
problems listed, unless (for a student) the DNR (“do not report”) box is checked. Also 
shown here are the (<-) and (->) buttons, for cycling among the tabs on a tabbed data 
entry form.
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Another possibility is that you may not be in the “ReadWriteGrp” or the 
“TeacherGrp” access group, or that there are district access restrictions in 
effect which prevent you from saving changes to the record. For additional 
information, refer to “Using access groups (custom user names)” on 
page 146.

Under these circumstances, the record navigation keys are still accessible, 
but any edits that you have made won’t be saved when moving to another 
record (the program displays an alert, Fig. 3-41).

When SELPA Manager saves a record, it stamps the date and time of the 
update, as well as the user name, on the record. This information appears in 
the lower left corner of most data entry forms (Fig. 3-42).

Fig. 3-41. Error message resulting from pressing a record navigation button, on a 
record where the save button is dimmed and where the user has made changes to the 
record.

Fig. 3-42. Record update information appears in the lower-left corner of most data 
entry forms.



The CANCEL button
When adding a new record or making changes to an existing one, should you 
decide not to save your edits, you may press the CANCEL button (keyboard 
shortcut: [ESC] key). Following the cancellation, the program discards a 
new record; an existing record will revert to its values prior to the edits.You 
may want to use the CANCEL button when you have retrieved an existing 
record for viewing purposes only. The CANCEL button ensures that you 
don’t save any inadvertent changes.

The data entry cycle
Normally, after you have added a new record to SELPA Manager, the 
program will return to the browse window. 

An option in the Preferences dialog (“add new record loop”, see the Chapter, 
“Configuring SELPA Manager” on page 293) instructs the program to add 
new records in a repeating cycle (loop), as long as you continue to press the 
SAVE rather than the CANCEL button after completing each data entry 
form. To stop an add record loop, press CANCEL rather than SAVE when 
the program displays the next empty data entry form.

In browse window contexts where program users, tracking records, or 
calendar items are displayed as lists, you cannot add new records. Fig. 3-43 
summarizes the contexts and associated lists where you may and may not 
add new records. It also contains a sample flow chart for adding new 
students, when the repeating cycle is turned on in Preferences.
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Fig. 3-43. Summary of browse window contexts where new records may be added. The 
flow chart illustrates the optional data entry cycle for adding students. This option 
must be selected in Preferences.



• • • • • •
 4 Configuring SELPA Manager

[rev. 1.2006]

This section presents the Preferences dialog, to customize SELPA Manager 
for your particular SELPA, and for your personal viewing/appearance 
settings. Some of the configuration information displays initially as a 
“Welcome to SELPA Manager” dialog, when the program first opens with a 
new, unregistered data file (refer to Fig. 3-13 on page 165). Certain items 
must be completed on this dialog before the program will continue.

You may also update configuration information at a later time, by selecting 
“Preferences...” from the File menu.

Preferences for administrators
The Preferences dialog enables you to configure SELPA Manager for your 
particular SELPA; to set certain program functions and behaviors; to 
configure default field information for the IEP notification form; and to 
modify the appearance of the program. Most of these parameters affect all 
program users. Some items, including the appearance settings, apply to each 
program user individually. 

Certain preference settings can only be changed when you have connected 
to SELPA Manager as the Administrator or as another user with 
administrative access (“AdminGroup” access group member; refer to the 
“Using access groups (custom user names)” on page 146). 

If you do not connect as an administrative user, then you will have access to 
a more limited Preferences dialog. Some of the settings in the discussion 
that follows will not be available, while other items may be arranged 
differently on the form. A discussion of the more limited preference dialogs 
starts on page 302. 
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SELPA Information (Tab 1)
This tab (Fig. 4-1) contains the basic site name, address and number settings 
needed to differentiate this copy of SELPA Manager from other copies. It 
also provides a mechanism to register the program by obtaining a serial 
number from technical support, and to expand the number of simultaneous 
users (for multi-user editions of SELPA Manager). 

Fig. 4-1. Preferences dialog (administrators), SELPA information tab.

• SELPA (drop-down list)

The four-digit code and name corresponding to the SELPA/region in which 
this copy of SELPA Manager is to be located.

When the SELPA is selected, the program will place a county code (the first 
2 digits of the 4 digit SELPA code) into the County code field (page 246), 
provided that this area is still empty. For example, in Fig. 4-1, the county 
code should be “41” for SELPA 4100. However, if the digits “27” were 
already in the County code field, the program would not overwrite them.



If your SELPA code does not appear in the pull-down list, then this version 
of SELPA Manager cannot be used with your SELPA. Contact technical 
support for information about adding your SELPA to the program.

• Site number

The site number ranges between 1 and 9999, and should be unique to each 
installation of SELPA Manager within a particular SELPA region. The site 
number becomes a suffix for the record number, when you add a new student 
to the program (refer to “Student identification numbers” on page 359).

When only one workstation (or one server, for the multi-user edition) is 
running SELPA Manager within a SELPA region, then the site number for 
that installation may be left at the default value of 1. However, when more 
than one installation of SELPA Manager exists within a SELPA region, then 
each installation must have a different site number to ensure data integrity. 
The SELPA region office or a similar authority should be responsible for 
issuing site numbers. Call the office to verify your site number before adding 
any student records to the program.

If you change the site number after you have entered students into the 
program, then (upon closing/saving the Preferences dialog) the program will 
offer to update all student record numbers that have the old site suffix. You 
should make this change unless the region office instructs otherwise.

NOTE: If you are using SELPA Manager as a SELPA Central, then in most 
cases you will not want to update student record numbers after a site number 
change. Each district should update its own site number prior to sending the 
district-to-central export file to you. 

EXCEPTION: If you are both a region office and a unique district (with 
students not included in other installations of SELPA Manager), then you 
should allow the update to student record numbers, after changing the site 
number.

• School / district name

This item is the SELPA region name, a district name, a school/site name, or 
other identifying information about the installation. Initially, if this field is 
blank, the program inserts the SELPA region name as you select it from the 
drop-down list.However, you can instead substitute a more appropriate 
name for your site (e.g., “Pennyhill School”, “Amber Unified School 
District”, “Maxwell County Office of Education”, etc.).
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• Your name

The name of the person who will serve as the principal administrator of this 
copy of SELPA Manager. The named individual will appear as the 
registrant/licensee for this copy of SELPA Manager.

• County code

The two-digit numeric code corresponding to the county in which this copy 
of SELPA Manager is installed. The program will insert this code 
automatically as the SELPA is selected (page 244). If you remove the 
county code, then the Preferences dialog cannot be saved (the OK button 
will be dimmed).

• Address

Two data entry areas, up to 80 characters each, representing the street and/or 
mailing address for the site.

• City, State, Postal code (3 areas)

Additional address information about the site.

• Phone / Fax (2 areas, each with a button)

Telephone and fax numbers for the site, including the area code (10 digits). 
Do not use punctuation or telephone extension numbers in these entry areas. 
Press the button to clear the telephone number and associated formatting 
from the entry area.

• Alt. district of service, CASEMIS Table A (check box) 

Checking this box will cause SELPA Manager to use the first seven digits of 
each student’s record number as the district of service in the CASEMIS 
exports/reports. These digits generally represent the student’s district of 
residence, not the district of service, in SELPA Manager (refer to “Student 
identification numbers” on page 359).

The default behavior, when this preference box is not checked, is for the 
program to determine the student’s CASEMIS district of service from the 
school associated with the student’s current primary service.

You might want to check this box if your SELPA maintains a separate, 
special education district that provides special education services for the 
other districts in the SELPA.



• SERIAL NO. (button) 

Press this button when you are ready to license (serialize) the program. 
SELPA Manager is copy-protected through the use of a serial number. You 
may use the program on a trial basis with no restrictions, for up to 90 days. 
At the end of the trial period, SELPA Manager will require you to enter a 
serial number at program start-up.

However, you may enter the serial number at any time prior to the expiration 
of the trial period, by pressing the SERIAL NO. button. Once you have 
entered the serial number, you will not need to re-enter a serial number 
unless: (1) the SELPA code or site code is changed; (2) the school/district 
name is changed; (3) you wish to add more simultaneous users to a multi-
user installation. 

SELPA Manager will display an alert message if you are about to make a 
change that will require re-serialization. Additionally, when you are within 
30 days of the expiration of the trial period, the program will provide a 
warning indicating the number of days left, at each start-up.

NOTE: If your copy of SELPA Manager is already serialized, then the 
SERIAL NO. button will be dimmed.

To serialize your copy of SELPA Manager:

1 Press the SERIAL NO. button

SELPA Manager will prompt you, “Set for how many users:”

2 Enter the number of users who will be accessing SELPA Manager 
simultaneously, then press OK.

For a single-user edition of the program, this number should be one (1).For 
a multi-user edition, you would generally specify the number of client 
licenses or “seats” that you have purchased.

A program registration dialog will appear, containing a challenge code and 
a blank area for entering the serial number (Fig. 4-2).
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Fig. 4-2. Program registration dialog, for entering the serial number.

3 Write down the challenge code on a piece of paper, take a snapshot of 
the screen, or press the [P]REPARE FAX COVER button to generate a fax 
request form containing the challenge code.

The challenge code is case- and space-sensitive. You should ensure that you 
copy all of the challenge code characters accurately.

As a convenience in preparing a written serial number request, you can press 
the [P]REPARE FAX COVER button to produce a fax cover containing the 
challenge code and other necessary information for licensing SELPA 
Manager (Fig. 4-3).

4 Close the serial number dialog by pressing CANCEL. 

Because you have not yet entered the serial number, the program will 
display an alert indicating how many days are left until the program must be 
serialized (Fig. 4-4). 

5 Press the OK button.

This action will close the alert dialog (returning you to the Preferences 
dialog). Close the Preferences dialog by clicking on the OK button, unless 
you intend to make additional preference selections.

6 Send the challenge code to technical support.

For email or fax correspondence, be sure to include your name, SELPA 
code, site name, address, and telephone number. Based upon your supplied 
information, we will be able to provide you with the corresponding serial 
number.



Fig. 4-3. Fax cover request form (generated by the program), for obtaining a serial 
number from technical support

Fig. 4-4. Alert indicating the number of days until serialization will be mandatory (the 
expiration date of the trial period).

7 When you have obtained a serial number from technical support, re-open 
Preferences. Press the SERIAL No. button from the dialog, and again 
specify the same number of users as in Step 2, to re-open the program 
registration dialog. 

8 Type the serial number into the entry area below the challenge code. 

At that time, you will press the OK button instead of the CANCEL button. 
The program is now serialized for the specified number of users, and the 
SERIAL NO. button on the Preferences dialog will be dimmed.

9 Press the OK button to close the Preferences dialog.
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If you press the CANCEL button rather than the OK button, the serial 
number that you entered will not be saved and SELPA Manager will not be 
registered.

• UPDATE LICENSE (button)

Press this button when you have a licensed copy of the program, but need to 
add more simultaneous users. You might need to perform this task after 
purchasing an expansion pack of 4D Client licenses.

To add new users to a multi-user (client-server) installation of SELPA 
Manager:

1 Press the UPDATE LICENSE button. 

SELPA Manager will prompt you, “Set for how many users:”

2 Enter the number of users who will be accessing SELPA Manager 
simultaneously, then press OK.

For a multi-user edition, you would generally specify the number of 
additional client licenses or “seats” that you have purchased.

A program registration dialog will then appear, containing a challenge code 
and a blank area for entering the serial number.

3 Follow Step 3 through Step 6 under (“To serialize your copy of SELPA 
Manager”), to send the challenge code to technical support. 

We will supply a new serial number that can be entered into the program 
registration dialog, when you receive it.

• SSL (button)

The SSL button provides a means for preparing the items needed to request 
a Secure Sockets Layer (SSL) certificate from a certification authority. 
SSL is the standard security technology for creating an encrypted link 
between a web server and a web browser. 

The certificate (and associated items) enables SELPA Manager’s web server 
to run under SSL encryption. A web user connecting to your SELPA 
Manager server will then see the “lock” icon on their web browser, 
indicating that the web site is protected by encryption.



To obtain an SSL certificate from a certification authority, you must be the 
registered owner of the IP address1, domain name, or subdomain name at 
which the SELPA Manager web server is or will be located. The certification 
authority may charge an annual fee for issuing the certificate.

You do not need to have an SSL certificate in order to use the SELPA 
Manager web server. However, the certificate provides an additional layer of 
protection against unauthorized “listening” by intruders.

To generate a certificate signing request (CSR):

1 Press the SSL button on the Preferences dialog.

SELPA Manager displays the “Prepare for SSL...” dialog (Fig. 4-5).

2 Complete each requested item on the dialog.

You must specify the web server IP address, domain, or subdomain; the 
country, city, state, company name, and company division or unit. The IP 
address, domain name, or subdomain name must be registered to the 
company; otherwise the certification authority won’t be able to issue the 
certificate.

3 Press the GENERATE CERTIFICATE REQUEST button.

In the folder where the database resides, SELPA Manager will generate the 
following three files:

a. “key.pem” – The private encryption key.

b. “public.pem” – The public encryption key.

c. “request.txt” – The certificate signing request (CSR).

You should make a copy of all three of these items, and place them onto a 
backup disk for safekeeping. In particular, the “key.pem” private key should 
not be given to any other persons or organizations. If you lose your 
“key.pem” file, then the certification authority will need to issue a new SSL 
certificate.

4 Press the DONE button to close the “Prepare for SSL...” dialog.

1. Also referred to as the TCP, or TCP/IP address.
Configuring SELPA Manager 251 

• 
• 
• 
•
•
•



252  

• 
• 
• 
•
•
•

Fig. 4-5. “Prepare for SSL...” dialog, to obtain a Secure Sockets Layer certificate for 
the SELPA Manager web server.

5 Press the OK button to save changes and close the Preferences dialog.

Ensure that you press OK rather than CANCEL. If you press the CANCEL 
button, then the information that you entered for the SSL certificate will not 
be saved. 

6 Locate the “request.txt” document on disk and open it with a text 
processor

The “request.txt” document will be in the same folder as the SELPA 
Manager program. For example, on a Windows single-user edition, the 
default path would be,

“C:\Program Files\Fusn_Tek\Selpa_475_fldr\request.txt”

For a Windows workstation connecting with 4D Client to SELPA Manager 
server, the “request.txt” file will be stored in the same folder as the 4D Client 
application (“4DClient.exe”).

You can open the “request.txt” file with WordPad, TextEdit, or a word 
processing program such as Microsoft Word.

7 In the text processor, copy the text between the “begin” header and the 
“end” footer.



For example, suppose that the file had the following appearance in the text 
editor,

-----BEGIN CERTIFICATE REQUEST-----

MIIByjCCATMCAQAMTFnbHBhbWFuYWdlciWR1ZS5jb20x

CzAJBgNVBAYTAlVTMRYEw1TYW4gRnJhbwEQDVQQIEwpD

YWxpZm9ybmlhMKEw1MYWR1ZSBTeXN0ZWVQQLEwtEZXZl

MKAwqI4vZS0PH/LN1S1G0ybYR+FhicqRgevVDwuXMNVZ

KGGZYgDbbhN0LGNWCjdFSxfKN4NVaLfdPO5pB3PS7Q2d

-----END CERTIFICATE REQUEST-----

In this case, you would copy from the first “M” to the last “d”, and place it 
onto the clipboard.

8 Submit the contents of the “request.txt” file to a certification authority

Paste the text into the application form for the certification authority. Fig. 4-
6 is an example of an application form for an SSL certificate, from a 
certification authority (QualitySSL.com).

9 Complete the remainder of the application for the SSL certificate, provide 
payment as required, and submit the application.

The certification authority will need to verify the information that you have 
supplied in the application. You must await notice of approval from the 
certification authority.

10 Obtain the SSL certificate (“cert.pem” file) from the certification 
authority.

If the certification authority approves your application, then they will send 
notice that your SSL certificate is ready. You may then be able to download 
the SSL certificate file (“cert.pem”) from the authority’s web site.

You should place a copy of the “cert.pem” file onto a backup disk for 
safekeeping, as you did for the other files in Step 3, above.
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Fig. 4-6. Sample application for a SSL certificate (from qualityssl.com). The CSR text 
that has been pasted into the box is for illustration only.

11 On the web server computer, place the “cert.pem”, “key.pem” and 
“public.pem” files into the folder with the SELPA Manager structure.

Note that the application process prior to this point (Step 1 through Step 10) 
may have taken place on a different computer than the one that will be 
running the SELPA Manager web server. 

The computer that runs the web server will be configured as a SELPA 
Manager server, whether you plan to use it in single-user mode (with 4th 
Dimension) or as a server (with 4D Server). For more details, refer to the 
chapter on configuring SELPA Manager for web serving.



System 1 Tab, overview
This tab configures system-wide, date-related preferences; general 
parameters; and choice lists (Fig. 4-7). 

Except as noted, changing the parameters on this tab will affect all program 
users on multi-user installations. However, other users who are presently 
connected to the server may not notice any change until the next time that 
they connect to SELPA Manager.

Fig. 4-7. Preferences dialog (administrators), System 1 tab.

System 1 Tab, Dates subsection
• Report as of date (combo box) 

The next scheduled reporting date for the CASEMIS-format, student-level 
information reports to the California Department of Education. A 
comparison between the Report As Of date and student service start/stop 
dates partly determines whether or not a student record will appear in a 
CASEMIS report. 
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CASEMIS reporting dates are December 1 and June 30 for the current 
academic year. However, SELPA Manager allows other dates to be 
specified. Even if the date that you wish to enter does not appear in the drop-
down list, you may still type it in manually.

The Report As Of date also is used as a evaluation criterion for transfers and 
for other types of reports, such as the SSID Enrollment Update for CSIS.

Because CASEMIS substantially revised its data codes for the 2006-2007 
academic year, the selection of a Report As Of date after 6/30/2006 causes 
different codes to become available for certain CASEMIS data fields. 
Examples are the disabilit(ies) and the services.

CASEMIS also made changes to the STAR (testing participation) codes 
twice in the past, so Report As Of dates set prior to 6/30/2003 or prior to 
12/1/2002 place different codes into the STAR choice list, when compared 
to codes after 6/30/2003 or to codes after 6/30/2006.

If a student record contains an older or a newer CASEMIS code for a field, 
then the displayed value will appear in italics on the data entry form, to 
indicate that it is not part of the current set of code choices.

The Report As Of date also factors into data validation, because of structural 
changes over time to the CASEMIS data specification (“data dictionary”).

For example, the field [Student]Plan_type_code was required for the fall 
2001 submission, but not prior to that point. Therefore, SELPA Manager 
identifies an error if the plan type is missing for a student record, and the 
Report As Of date is after 6/30/2001.

Similarly, for the 2006-07 academic year, CASEMIS requires a referral 
date, a referred by person/entity, and an initial evaluation date for most 
students (ages 0-22 yrs.). Previously the referral date was needed only for 
infants. Therefore, SELPA Manager sets error messages if these items are 
missing, and the Report As Of date is after 6/30/2006.

To assist you in determining which fields are required on a data entry form, 
the program underlines the labels of most fields that are required. As the 
Report As Of date changes, however, the label underlining may also change, 
to reflect different requirements over time.



• Age calcs. fm. (date)

The date from which the student’s age is calculated, for student records. If 
this item is empty (“00/00/0000”), then SELPA Manager will use the Report 
As Of date for this purpose.1

The student’s age, in turn, is used to verify that services are appropriate 
during data entry validation. It is important to set this date correctly, to 
obtain accurate reports and search results.

If you change an existing Report As Of (reporting) date, then SELPA 
Manager will also change the “Age calcs. fm.” date to correspond with the 
Report As Of date. You can then reset the “Age calcs. fm.” date to some other 
date, if desired. 

If the “Age calcs. fm.” date has changed, then when you save changes and 
close the Preferences dialog, SELPA Manager will ask whether it should 
recalculate student ages for the new date (Fig. 4-8).

Fig. 4-8. Confirmation dialog to recalculate student ages, after changing the “Age 
calcs. fm.” date.

1. Historical note: For versions prior to 4.696 of SELPA Manager, the Report As Of date was used
to calculate the student’s age. Versions 4.696 through 4.698 used the December 1 that preceded the
Report As Of date, based upon a 4/6/2001 CA Department of Education directive. (The Department
subsequently rescinded this directive.) Versions after 4.698 use the “Age calcs. fm.” date (when avail-
able) to calculate the student’s age.

In the Assessments (IEP) section of SELPA Manager, calculated age derives from the IEP meet-
ing date, rather than the Report As Of or the “Age calcs. fm.” date.
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Additionally, as a result of the change in “Age calcs. fm.” date, there may be 
students who consequently change in age from infant to preschool level, or 
beyond preschool level. SELPA Manager will also offer to remove 
information from certain infant-only or preschool-only fields (referral date, 
transition meeting date, solely low incidence check box, infant setting, and 
preschool setting), Fig. 4-9. 

Fig. 4-9. Confirmation dialog to clear infant/preschool fields on recalculating student 
ages, after changing the Report As Of date.

Alternately, you could allow the changes to take place for all students, but 
then check the “no infant/preschool error checking” box in Preferences 
(page 261). Then re-enter the infant/preschool setting information for the 
particular student(s) who exited as infants/preschoolers. 

If a particular student exits special education while still an infant or a 
preschooler, then you may wish to leave the infant setting or preschool 
setting codes in place. In this case, you might reply negatively to the offer in 
Fig. 4-9 to remove infant/preschool information.1 

If there are several students who should have the same infant or preschool 
setting, you can also apply a batch update for infant or preschool setting, 
when the students to be modified are listed in the browse window (Actions 
menu -> Update other... -> Batch update student fields, refer to “Update 
other...” on page 652).



In each case where the student information has been changed as a result of 
a change in the “Age calcs. fm.” date, the program will make a note of the 
change to the notes field on the Student data entry form (refer to “Notes / 
dups (Student Tab 12)” on page 410).

NOTE: You do not have to change either the calculated age or the 
infant/preschool service information when you revise the Report As Of date. 
To prevent both of the updates from taking place, press the CANCEL button 
when the program presents the dialog in Fig. 4-8, above.

• No As Of warnings

When checked, this box prevents certain warning messages from appearing 
in the missing/problem items list1, on the student and assessment data entry 
forms.

NOTE: This setting applies to, and can be set by, individual program users.

The warnings for student records include:

– Date of birth is later than As Of date
– Original entry date is later than As Of date
– Referral date is later than As Of date
– Last evaluation date is later than As Of date
– Last evaluation date is 3 or more years from As Of date

The warnings for assessment (IEP) records include:

– Last evaluation date is later than As Of date
– Last evaluation date is 3 or more years from As Of date

1. Having an infant setting, a transition meeting date, or (with an As Of date set prior to
7/1/2006) a referral date for a student who is older than 2 years, will generate warning messages
in the missing/problem items list for the student record (refer to Fig. 3-40 on page 239). 

However, the warning messages will not prevent the record from being saved. Similarly, having
a preschool setting for a student that is older than 5 years will generate a warning, but will not
prevent the record from being saved. 

However, having the “Solely low” incidence box checked for a student that is older than 2 years
of age will generate an error message in the missing/problem items list, and will prevent the stu-
dent record from being saved unless Do Not Report is checked (refer to the “DNR (Do Not Re-
port, check box)” on page 367).

1. At the lower-right corner of the data entry form. For an example, refer to Fig. 3-40 on
page 239. The missing/problem items list is just above the SAVE and CANCEL buttons.
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Whether this option is checked or not, neither the student nor the assessment 
“As Of” warnings appear for users who are members of the “TeacherGrp” 
or “TeacherLtdGrp” access groups.

• Earliest allowed date / Latest allowed date (2 areas)

These items assist in preventing typographical errors while entering dates, 
by establishing program-wide lower and upper limits. For example, if you 
mistakenly entered a student’s birth date as 6/18/1889 instead of 6/18/1989, 
and you had an earliest allowed date of 1/1/1972, then the program would 
not allow you to move to the next student field until you corrected the date.

Even if you elect to leave these date limits blank, however, the program will 
still provide a warning if an entered date is more than 30 years greater (or 
less) than the current date. In this case, however, the program does not 
prevent you from making the date entry.

• No start date match on stdnt services

Normally, when performing a SELPA Central import, SELPA Manager uses 
the following field criteria to identify a student service record that already 
exists in the target data file:

[Student]Record_number
[Student_service]Start_D
[Student_service]CASEMIS_service_code
[Student_service]Created_D
[Student_service]Created_T

If the sender of the student / service information subsequently changes the 
start date of the service record, and then re-exports the information, then the 
SELPA Central copy of the program will contain two service records for the 
same service. 

To prevent this problem from occurring, check this option, and the SELPA 
Central import routine will omit [Student_service]Start_D from the 
matching criteria. In this case, the program will then update the existing 
copy of the service with the revised start date.



• No age-related error checking when editing an existing student 

Certain selections on the student data entry form and the student service data 
entry form are appropriate for infants or for preschool students only. 
Selecting one of these items for a non-infant or non-preschooler may 
generate a warning or an error message in SELPA Manager. 

For example, if you check the “Solely low” box for a 9-year-old student, 
then the program will generate an error message, “Solely low incid > 2 yrs.” 
in the missing/problem items list. That error message, in turn, prevents the 
student record from being saved unless the Do Not Report (DNR) box is 
checked (refer to “DNR (Do Not Report, check box)” on page 367).

Checking this preference will cause SELPA Manager to ignore date-related 
warning and error messages for existing students. In the example provided, 
you would be able to check the “Solely low” box for an existing student that 
is not an infant. This preference does not affect data entry for a new student 
record, however — a new student still must have an appropriate age for 
infant or preschool item selections, or SELPA Manager will present 
warnings and/or error messages in the missing/problem items list.

When the no infant/preschool error checking option is selected, the record 
update information box for students and for services (at the lower left corner 
of the data entry form, refer to Fig. 3-42 on page 240) will contain the suffix, 
“no age checks.”

System 1 Tab, Lists subsection
• EDIT (button and drop-down list)

Clicking on this button allows you to customize one or more lists of items 
in SELPA Manager. These lists appear as choices for data entry, in various 
places in the program. Select the name of the list that you wish to edit from 
the drop-down list, and then press the EDIT button. 

If you perform an [ALT/OPTION]-click on the EDIT button, then SELPA 
Manager will offer to export the items in the selected list to a file on disk. 
This file can then be imported by another SELPA Manager user (refer to the 
Choice list items import, in the Chapter, “File Menu Operations” on 
page 524).
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Examples of choice lists that can be edited are:

1 Aux service code 

A list of “auxiliary” student service codes and/or descriptions. These codes 
and associated parameters can be used in conjunction with a selection of 
districts to print the district chargeback report (refer to “District chargeback 
report” on page 456). District chargeback calculations may be useful if your 
SELPA provides special education services at a central location, for more 
than one district.

Fig. 4-10 illustrates the Edit auxiliary service codes dialog. When the edit 
dialog appears, press the (+) button to add a new row to the list. Double-click 
into the row to edit each cell (column) for the new entry. 

Fig. 4-10. Editing auxiliary service codes and associated parameters.

Each auxiliary service code/description can be up to 80 characters in length 
(first column). Aside from the code/name itself, each row can have a state 
level (days), 4 actual levels (days) by student age tiers, and an annual service 
cost. Chargeback costs are figured as follows, 

daily cost = (annual service cost/180) x (state level/actual level)

The total cost in chargebacks, per student and per district, can be determined 
by printing the chargeback report, from the Districts section of the program.



2 Gen ed academic areas

A list of academic areas for Tab 2 (IEP 2) of the “4100 San Mateo (original)” 
IEP data entry form (“Participation in General Education Program, If Yes, 
Academic Areas”). If you are not using this IEP form, then this list may not 
be relevant.

3 Gen ed non-academic areas

A list of non-academic areas for Tab 2 (IEP 2) of the “4100 San Mateo 
(original)” IEP data entry form (“Participation in General Education 
Program, Non-Academic Areas”). If you are not using the this IEP form, 
then this list may not be relevant.

4 Handicapping condition

A list of disabling (handicapping) condition codes for the student’s primary 
service.1 The dialog allows you to edit a list of disabling condition codes 
(Fig. 4-11). On the Services tab of the Student data entry form, the codes 
appear as a pull-down menu in the “Disab. Cond.” column (refer to 
“Services (Student Tab 4)” on page 383). 

Fig. 4-11. Dialog for adding/editing disabling condition codes.

For a new data file, this list will be empty. However, SELPA Manager 
maintains its own, internal list of disabling condition codes. These default 
codes will appear in the pull-down menu in the absence of any user-defined 
1. The disabling (handicapping) condition codes should not be confused with the primary dis-
ability for CASEMIS reporting purposes, which applies to the student record rather than to the
service record. For further discussion of the primary disability, refer to the Chapter, “Entering
Students” on page 377.
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codes. As soon as you add one or more codes to make your own list, 
however, the default list will no longer be displayed with the student / 
service record.

5 ITP activities 3013

Items that are to appear in the activity pull-down menus, on the Individual 
Transition Plan data entry form for SELPA 3013 (Anaheim).The first 
column (“ITP Area”) represents a particular activity menu on the form 
(Community experiences, Daily living skills, etc.). The second column 
represents the activity item that is to be included in the menu.

6 Non-primary drop

Non-primary drop reasons for student services. If you have a new data file, 
this list will be empty. When the edit dialog appears (Fig. 4-12), press the 
(+) button to add a new row to the list. Double-click into the row to edit each 
cell (column) for the new entry. The first column represents the drop code, 
and the second column is for the drop reason (description).

NOTE: You do not need to add the primary drop reason codes to the non-
primary list; they are available there (even though not listed) by typing the 
primary code directly into the non-primary code field.

Fig. 4-12. Dialog for adding/editing non-primary drop reasons.



7 Transport aux boxes

Allows you to specify which of the ten user-specified / auxiliary student 
checkboxes, [Student]User_YesNo_1 through [Student]User_YesNo_10, 
should appear on the enhanced transportation-only data entry form, for 
editing student records. 

For example, the selection of items listed in Fig. 4-13 would result in the 
addition three checkboxes to the bottom of the enhanced transportation-only 
data entry form (Fig. 4-14). If each check box has a custom (user-assigned) 
label on the standard student data entry form1, then the label will appear on 
the enhanced transportation-only form. Otherwise, the check box will not 
have a label.

Fig. 4-13. Dialog for adding/editing auxiliary checkboxes, to appear on the enhanced 
transportation-only form.

These checkboxes will not appear on the transportation-only data entry form 
unless “Enhanced transpt-only access (more fields)” is selected in 
Preferences (page 272).The contents of the data entry form itself is 
discussed in the Chapter, “Entering Students” on page 412.

1. For more information on adding custom labels, refer to “User Y/N (Student Tab 11)” on
page 409.
Configuring SELPA Manager 265 

• 
• 
• 
•
•
•



266  

• 
• 
• 
•
•
•

Fig. 4-14. Appearance of the enhanced transportation-only form. after adding 
auxiliary checkboxes, as in Fig. 4-13.

System 1 Tab, Lists subsection (buttons)
• [P]RINT USER LISTS (button)

Clicking on this button enables you to design or load a report that will print 
all user-generated choice list items.The [Choice_list] table contains both 
custom user lists and the goals/objectives palette contents. Initially, the 
information is sorted by list name.

This feature makes use of 4D’s ad-hoc reporting tool, the Quick Report 
Editor (Fig. 4-15). Drag the fields from the Master Table list at the lower left 
side of the dialog onto the gray report area above, to create the appropriate 
columns. To sort the report, highlight a field in the Master Table list and click 
the green arrow, to place the field name into the Sort Order list. Select “Print 
preview...” or “Generate...” from the report editor’s File menu when you are 
ready to preview, or to place the report on paper. 

For more information on using the Quick Report Editor, refer to the Chapter, 
“Quick Report Editor” on page 720



Fig. 4-15. Preparing a Quick Report of user-entered choice list items.

• WRITE CASEMIS CODES (button)

Clicking on this button causes SELPA Manager to generate a delimited text 
file on disk that contains codes for various CASEMIS fields: (infant) agency, 
discipline reason, discipline status, drop reason, ethnicity, frequency, grade 
level, disability, infant setting, language, (infant) location, preschool setting, 
residence, school type, student service, and STAR participation.

You may then open this file with a spreadsheet or word processing program 
for printing or review.

• GOALS/OBJECTIVES PALETTE (button)

Display a palette of assessment goals and objectives for editing and review. 
This goals/objectives palette is employed when pasting objectives, goals, 
and benchmarks onto an IEP form or a student goal form. 

For information on adding IEPs to SELPA Manager, refer to the Chapter, 
“Entering Assessment Information” on page 479. For information on using 
the goals/objectives palette, refer to “Using the goals/objectives palette” on 
Configuring SELPA Manager 267 

• 
• 
• 
•
•
•



268  

• 
• 
• 
•
•
•

page 441. You can import standard or custom goals and objectives for the 
goals/objectives palette; refer to “Importing generic goals/objectives for the 
palette” on page 439, and to “Importing goals/objectives palette contents 
from another user” on page 454.

NOTE: SELPA Manager will display the palette from Preferences, but you 
will not be able to manipulate the palette until you have closed the 
Preferences dialog, by pressing either the OK or the CANCEL button. 
Otherwise, the palette will remain layered behind the Preferences dialog.

• OTHER IEP FORMS (button)

Displays a dialog for adding and removing blank IEP templates (in pdf, or 
Portable Document Format) to/from SELPA Manager. 

This feature allows you to maintain blank IEP forms, in a graphical-only 
format, in addition to those incorporated into the assessment data entry form 
itself. If you have a scanner, you can also save the completed forms for a 
particular student, with the student’s assessment record.

Access to these blank IEP templates applies only to those SELPAs that have 
an OTHER FORMS button located on their assessment data entry form.

For example, suppose that your SELPA has selected the State of California 
(“DFL2”) data entry form for use in the assessment section. However, your 
SELPA has developed a separate form for IEP team follow-up activity.

If the follow-up activity form is in pdf format on disk, then you can use the 
OTHER IEP FORMS button to incorporate the blank form into SELPA 
Manager. Later, when the case manager is preparing an IEP form for a 
particular student, s/he can press the OTHER FORMS button to create a 
copy of the blank form on disk, for printing.

Once the IEP team has completed the follow-up form (in ink), the case 
manager can scan the completed form. Then, the OTHER FORMS button 
can be used to save the scan file back into SELPA Manager, for later 
reference or printing.

Detailed information on using the assessment section of SELPA Manager 
can be found in the Chapter, “Entering Assessment Information” on 
page 479.



System 1 Tab, General subsection
• MediCal provider no.

In this area, you can specify the MediCAL provider identification number 
for your SELPA. This program uses this number when exporting a selection 
of students to the State of California, to determine MediCAL eligibility.

• Default dist. of res. code 

The 7-digit code for the default district of residence, to be incorporated 
automatically into the student fields, [Student]District_residence_code and 
[Student]District_residence_name, when adding a new student record to the 
program.

If a default district of residence code is not specified in Preferences, then 
SELPA Manager attempts to obtain a new student’s district of residence 
from the program user’s “My District” designation, if available1. 

If “My District” is not specified, then the program assumes that the district 
of residence will be the same as the district that the user selected in the 
dialog that appears initially, when adding a new student record (refer to Fig. 
7-5 on page 365).

When a default district of residence is specified in Preferences, it will always 
be used initially for a new student’s district of residence. Thus, it is possible 
for the student’s district of residence and record number prefix to be 
different.

A flow chart illustrating the logic for assignment of the district of residence 
and the student record number’s district prefix appears in the chapter on 
student data entry, as Fig. 7-2 on page 361.

• Student ID for CASEMIS

When generating student-level information for transfer to the CASEMIS 
program, SELPA Manager normally uses the field [Student]Record_number 
as a reference to the student. The program creates the student record number 
automatically when you add a new student to the program. You cannot make 
revisions to the record number on the student data entry form.

1. Each program user with read-write access can designate one district as My District , while

editing district records. Refer to the Chapter, “Entering Districts and Schools” on page 309.
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When the “Student ID for CASEMIS” preference box is checked, the 
program will use another field, [Student]Student_number, as a reference to 
the student in the export/report for CASEMIS, instead of 
[Student]Record_number. Unlike the record number, the student number is 
not assigned by SELPA Manager, and is user-editable from the data entry 
form.

Care should be exercised in checking this option, since 
[Student]Student_number is not a required field in the [Student] table. 
Therefore, some of the student records that the program assembles for a 
CASEMIS export might not have a student number (the field is empty). This 
situation will create CASEMIS errors.

A discussion of the various student identification numbers appears in 
“Student identification numbers” on page 359.

• Shared school codes

Checking this box allows more than one school to have the same school 
code. Thus, you could add more than one record into the Schools section of 
SELPA Manager, which would have the same code. This feature may be 
useful if you have multiple “sub-sites” where services are provided, but 
which report to CASEMIS through a common school site number (school 
code). If this box is not checked, then SELPA Manager will require each 
record in the Schools section to have a unique code.

If the “Shared school codes” box is checked on a copy of SELPA Manager 
that is performing a SELPA Central-type import, then the program will 
attempt match the school records being imported with existing schools on 
both school name and school code. If the box is not checked, then the match 
will consider school code, but not school name. 

For more information on SELPA Central imports, refer to the Chapter, “File 
Menu Operations” on page 515. For information on entering new school 
records, refer to the Chapter, “Entering Districts and Schools” on page 317.

• Audit trail

Checking this box will enable field-level auditing of all changes to existing 
records. The audit information is stored in a separate, [Record_history] 
table.



This feature may be useful for multi-user deployments of SELPA Manager, 
where each user logs into the program with their own user name. If all users 
log into SELPA Manager with the same user name (“Administrator”, for 
example), then you will not be able to identify which user made a particular 
change. 

To determine what changes have taken place to a particular record, highlight 
the record in the browse window and select “Audit trail...” from the Actions 
menu. If there were changes to specific fields while audit trail was active, 
then the program will present a dialog listing the changes. Each changed 
field represents a row in the list, with the date, time, field name, old value, 
new value, and the name of the user making the change (Fig. 4-16).

Record deletions, text field values, and audit trail

Audit trail detects changes to alpha, Boolean, date, time, and number fields. 
At this time, audit trail does not track changes to text (scrolling) fields, 
unless a record is completely deleted. 

Fig. 4-16. Audit trail information for a student record, showing changes to each field 
since the record was created. The audit trail feature must be enabled in Preferences.
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In the case of a record deletion, the text field values as they existed 
immediately prior to deletion are saved into the [Record_history] table. 
Because the deleted record(s) no longer appear in the browse window, 
however, you must find instances of deletion by displaying all 
[Record_history] records, and examining rows where the new field value is 
indicated as “(deleted)”. 

To find deletions, hold down the [ALT/OPTION] key while selecting “Audit 
trail...” from the Actions menu. SELPA Manager will ask whether you want 
to view all audit trail items for a particular table, or for the entire program. 
To reduce the number of records that you will need to examine, you should 
choose to examine [Record_history] for one table only.

NOTE: You may wish to turn Audit trail off while conducting batch update 
operations, such as recalculating student age or assigning a teacher to a 
large number of students. Leaving Audit trail on may slow the progress of 
batch operations; however, leaving Audit trail on does allow you to recover 
from mistaken batch change operations, because the old value for each 
(non-text-type) field changed will be saved.

• More transport-only fields 

Checking this box allows users to access additional information on a special, 
transportation-only data entry form, which can be displayed in place of the 
standard data entry form for students. Furthermore, if the standard student 
data entry form is being displayed, then this setting allows users who are 
members of the “TransportGrp” access group to edit additional 
transportation fields, which otherwise would be read-only for them.

The transportation-only data entry form may be set to display by the 
individual user1 from the Appearance tab of Preferences (refer to 
“Appearance Tab, overview” on page 289). The contents of the form itself is 
discussed in the Chapter, “Entering Students” on page 412.

The additional information that the transportation-only form will display 
with this option includes the Do Not Report check box; an indication of the 
student’s current service status (“Drop on:”, display only); the bussing 
agency name; the transportation required check box; and up to ten of the 
user-defined, student yes/no fields (refer to “User Y/N (Student Tab 11)” on 

1. Except for users that are members of the “TeacherLtdGrp” access group, who do not have ac-
cess to this data entry form.



page 409). To have the yes/no fields appear on the form, the administrator 
must also select which of the ten will appear with the EDIT button 
(page 261).

With this option checked, some areas of the transportation-only form that 
are normally read-only are now editable, such as the reason for the 
transportation request; transportation notes; IEP instruction boxes and POP 
type; and the pick-up and drop-off day columns in the list. The user can also 
add and delete pick-up and drop-off items from the list (the “+” and “-” 
buttons are enabled next to the list).

If the standard data entry form for students is being displayed instead of the 
transportation-only data entry form, then users in the “TransportGrp” access 
group normally have very limited access to items on the Transportation tab 
(“Transportation (Student Tab 7)” on page 402). With this option checked, 
“TransportGrp” members have access to most data entry areas on this tab.1

• RIS default 

If this box is checked, then new students (as they are added) are assumed to 
require intensive services (RIS).

• “Other” district required

“Other district” is a pair of fields on the Schools tab of the student data entry 
form, Checking this preference item makes entry of an “other” district 
mandatory, before the student record can be saved.

• No %ORC warnings/errors

Checking this box will suppress warning messages2 that are related to the 
percent of time that a student is Outside of a Regular Classroom (%ORC). 

These warning messages would otherwise appear in the missing/problem 
items list, for student and assessment records, if the percent ORC is zero for 
a student in grades K-13 or of ages 6-22. A warning message also appears if 
a student outside of these grades or ages has a positive ORC value.

1. Members of the “TransportGrp” access group do not have read-write access to the information
on other tabs of the standard, student data entry form (whether or not this option is selected).
2. For SELPA 3013 (Anaheim), the absence of %ORC for students in the grades K-13 or ages

6-22 yrs. results in an error message, rather than a warning.
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• Disc. action requires school/district

If this box is checked, then disciplinary actions are required to have both a 
school of attendance and a district of attendance listed, before the record can 
be saved. Normally, these items are optional entries on the data entry form. 
For information on entering disciplinary actions, refer to the Chapter, 
“Entering Disciplinary Actions” on page 471.

• Contact default address type (combo box)

This item establishes a default address type, when adding a new contact for 
a student. When the new contact record opens in its own data entry form, the 
selected address type should be listed. For information on entering contact 
information, refer to the Chapter, “Entering Students” on page 371.

NOTE: This setting applies to, and can be set by, individual program users.

• Contact default relationship type (combo box)

This item establishes a default relationship type between the student and an 
associated, new contact. When a new contact record opens in its own data 
entry form, the selected relationship type should be listed. 

NOTE: This setting applies to, and can be set by, individual program users.

System 2 Tab, overview
This tab configures system-wide preferences for student services, goals / 
objectives / benchmarks, IEP forms, and certain multi-user (client-server) 
parameters (Fig. 4-17). Additionally, administrators may post logon notices 
for both regular clients and for web-based access to the program. 

This tab also includes some per-user settings to configure some items on the 
IEP data entry form, and to set dialing parameters for an internal modem. 
Users can also verify their school or district access restrictions.



Fig. 4-17. Preferences dialog (administrators), System 2 tab.

System 2 Tab, student services subsection
• Limit student services to active teacher assignments

If this box is checked, then a teacher must have an active (current) 
assignment in a particular service, at a particular school, before the teacher 
can be selected to provide the service to the student. Thus, you must create 
the appropriate teacher assignments before defining a student’s services. We 
recommend that you check this box. For additional information, refer to 
“Services, assignments, and attendance” on page 327.

• When checking the PRIMARY box for a student service, should the 
student’s case manager be updated (pull-down menu)

This item instructs the program as to whether the teacher providing the 
primary service for a student should also be entered as the student’s case 
manager. This action would occur at the point that the user checks a box on 
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the service data entry form, to indicate that the service is the student’s 
primary service. For detailed information on adding student services, refer 
to the Chapter, “Student Services and Goals” on page 418.

The options in the menu are “Always”, “Ask first”, “Never”, and “Only if 
unassigned”.

System 2 Tab, goal/objective/benchmark subsection
• Bench dates fm Calendar (desc. “IEP5...”) 

This option changes the pop-up choice list of dates that appears while 
editing certain date fields on the assessment (IEP) form. The pop-up choice 
list appears when you click with the cursor into a date field, on the 
goals/objectives tab only (Fig. 4-18).

Fig. 4-18. Pop-up choice list of dates that appears when the user clicks into a date field, 
on the assessment (IEP) form, goal/objective tab only.

The pop-up choice list also appears when you click into a date field on the 
goal data entry form that is not associated with the IEP form (Fig. 4-19).

If this preference box is not checked, then the dates which appear in the 
choice list represent a year’s worth of dates into the future, beyond the 
current date. If this option is checked, then the program obtains at each client 



start-up the dates to be included in the choice list from specially-marked 
items on the Calendar — the program finds each Calendar item entry that 
begins with the words, “IEP5”.

To disable the date pop-up entirely, see “No date pop-ups” on page 277.

NOTE: This setting applies to, and can be set by, individual program users.

Fig. 4-19. Pop-up choice list of dates that appears when the user clicks into a date field, 
on the goal data entry form.

• No date pop-ups

Checking this box will prevent pop-up choice lists from appearing when you 
edit date fields on the goals/objectives tab of the assessment (IEP) form; and 
on the goal data entry form. For a description of the pop-up, see page 276.

NOTE: This setting applies to, and can be set by, individual program users.
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• No non-date pop-ups 

Checking this box will prevent pop-up choice lists from appearing when you 
edit other, non-date types of fields on the goals/objectives tab of the 
assessment (IEP) form. This setting applies only to certain IEP forms, as not 
all forms make use of the non-date pop-up choice lists. An example of a non-
date pop-up appears in Fig. 4-20.

NOTE: This setting applies to, and can be set by, individual program users.

Fig. 4-20. Example of a non-date, pop-up choice list that appears when the user clicks 
into a progress field, on the IEP data entry form, goal/objective tab. Does not apply to 
all IEP forms.

• No prefix or suffix on goals/benchmarks

This item affects the way that the program pastes goals and benchmarks 
from the goals/objectives palette into specific student goal records, either 
while completing an assessment (IEP) form for the student, or while adding 
“loose” goals for the student (not associated with a particular IEP form).1

Normally, SELPA Manager will replace “[date]” with the IEP meeting date 
plus one year; and replace “[name]” with the student’s name. 

1. For information on using the goals/objectives palette, refer to “Using the goals/objectives palette”
on page 441



If the “[date]” and “[name]” meta-characters are not present in the palette 
text, then the program will prefix the benchmark with the phrase “Will 
improve ability to”; and add a suffix to the benchmark of “, by ” <meeting 
date plus 1 year>. 

For example, if a benchmark were listed as, 

Read at 30 words per minute for 10 minutes.

then the benchmark as pasted into the student goal record would be 

Will improve ability to read at 30 words per minute for 10 
minutes, by 12.18.2006.

When the “No prefix or suffix on goals/benchmarks” preference box is 
checked, then SELPA Manager will not perform the substitutions to the goal 
or benchmark text. Instead, it will paste the text as it appears in the palette.

You may want to enable this option if you have prepared a custom list of 
goals/objectives that you do not wish for the program to alter in any way.

For detailed information on using the goals/objectives palette in conjunction 
with goal entry, refer to “Goals/objectives palette” on page 438.

• Omit goal/benchmark numbering

Like the “No prefix or suffix on goals/benchmarks” preference (above), this 
item also affects the manner in which the program pastes items from the 
goals/objectives palette into an IEP (or into a goal data entry form).

If this preference box is checked, then SELPA Manager will remove any 
leading numeric characters from the objective, goal, and benchmark text, 
before pasting the text into the IEP or goal data entry form. For example, 
suppose that a benchmark item in the goals/objectives palette starts with the 
text, 

4.1.2.1 By [date], when given a list of...

Then if this preference box is checked, the text would be changed to,

By [date], when given a list of...

If the “No prefix or suffix on goals/benchmarks” box (above) is also 
checked, then the text would be further changed by a date substitution, e.g., 

By 12.15.2006, when given a list of...
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The date substitution used is the IEP meeting date plus one year, or the 
current date plus one year (for a free-standing goal entry).

System 2 Tab, IEP subsection
• IEP form to use (drop-down list)

SELPA Manager supports multiple IEP templates (blank form sets), 
including custom templates for specific SELPAs and three “common” or 
“default” IEP templates. This preference item allows the administrator to 
select the IEP template that should be used when a user creates a new IEP 
for a student.

The IEP templates that are available in the drop-down list will depend upon 
which SELPA is selected on the SELPA information tab (“SELPA (drop-
down list)” on page 244). If the SELPA has a custom template, then this item 
will appear in the drop-down list, in addition to the three common templates. 
Otherwise, only the three common templates will be available in the drop-
down list.

For example, Fig. 4-21 illustrates the template choices for SELPA 3911. The 
first item (“3911 - Custom this SELPA”) is the custom template set, while 
the remaining three templates are the common ones.

Fig. 4-21. Appearance of the “IEP form to use:” drop-down list, when a custom IEP 
template is available.

SELPA Manager maintains a record of the template that was used to create 
an existing IEP1. Therefore, regardless of the drop-down list setting for 
creating a new IEP, when a user opens an existing IEP, the program will 
attempt to display the appropriate form.

1. Since SELPA Manager v. 4.75068. Does not apply if the IEP was created prior to that version.



• Requires student-required fields

Checking this box imposes additional requirements for completion of an 
assessment record (IEP) before it can be saved.You will see the additional 
requirements displayed in the lower right corner of the assessment data entry 
form, in the missing/problem items list. The additional requirements 
generally correspond to the requirements for saving a student record, except 
where the particular IEP form does not contain a field that is required on the 
student form. 

The additional requirements notwithstanding, if the user checks the 
INCOMPLETE button on an assessment record, then it can be saved by 
specifying only the meeting type, meeting date, and student.

• Allow drops on IEP

Checking this box will permit dropped student services to appear on the 
printed IEP verification form (cover sheet) for student records. This setting 
may also apply to the full IEP (assessment) record for both data entry and 
for printing, if the assessment form contains student service listings. 

If this box is not checked, then dropped services are excluded from the 
form(s). For some IEP verification forms, space limitations dictate that only 
four service rows will print. The program selects the four by sorting all 
services for the student so that the primary appears first, followed in sort 
order by drop date and start date. 

NOTE: Not all IEP student verification forms or assessment forms contain 
a list of services. In the case of SELPA 2400 (Merced), this preference is a 
per-user setting, available to program users in the “ReadWriteGrp” access 
group. For all other SELPAs, the administrator sets this preference for all 
users.

• First page items from last IEP

This preference item determines whether certain “first page” information 
from a previous IEP is copied onto a new IEP, for a particular student. 

Normally, SELPA Manager copies only demographic information from an 
existing [Student] record, when available, onto the new [Assessment] 
record. 
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When this box is checked, however, SELPA Manager will look for the most 
recent existing IEP for the same student, and copy selected items from the 
existing IEP to the new IEP. The items copied depend upon the specific IEP 
template in use.

The copying works only if the existing IEP used the same template as the 
new form, and only for selected IEP templates. At this writing, the templates 
that can make use of this feature include “DFLT”, “0400”, “0901”, “2300”, 
“2400”, “3013”, “3200”, “3702”, “4100” (San Mateo original), “4500”, 
“4900”, and “5300”.

NOTE: This setting applies to, and can be set by, individual program users.

• No names on signature lines

The printed signature page of some IEP forms display the name of each 
person, beneath or adjacent to the signature line. If you do not want these 
names to appear on the printed form, then check this box.

• Contacts to copy: Main / Second (2 combo boxes)

When creating a new IEP for an existing student, the program copies certain 
parental contact information, such as the name and address. Some IEP forms 
contain both a primary and a secondary parental contact. 

Because the student record can have multiple contacts associated with it, the 
program needs criteria to determine which contact(s) to select, to copy onto 
the new IEP form.

These two items allow you to specify the type/nature of the principal contact 
and the secondary contact (where applicable), to be copied to a new IEP 
form. The items in the list are address types from the contact section of the 
program ([Student_contact]Address_type), except when preceded with the 
phrase “RLN:” — in this case, the program looks for a match in the contact 
relationship ([Student_contact]Contact_relation) field.

NOTE: This setting applies to, and can be set by, individual program users.

System 2 Tab, modem dialing subsection
• Modem dialing parameters (dialing port, dialing prefix, long 

distance prefix, local area code)



These four parameters can be configured so that your modem-equipped 
computer will be able to speed dial telephone numbers from within SELPA 
Manager. To the left of most telephone and fax fields on data entry forms is 
a button; clicking on the button will dial the telephone or fax number, if 
these parameters are properly configured.

This option affects only the particular logged-in user, and any other users 
that may subsequently connect to the server using the same login name.

NOTE: When the dialing port is set to “None”, the other three parameter 
fields are not available for data entry. This setting applies to, and can be set 
by, individual program users.

System 2 Tab, multi-user subsection
• Browse refresh (secs) 

This parameter specifies how often the browse window will update (refresh) 
with new information when there is no local user activity. This setting 
applies to multi-user installations only.

The browse window refreshes when the user performs searches, sorts, 
change browse window context, or edit records.

In multi-user installations, however, the browse window does not refresh 
automatically if the local user has made no changes to the listed items. At 
the same time, other program users connected to the server might update 
records that the local user is viewing in the upper or lower lists, or on the 
Calendar. Therefore, the local user’s display could become out of date.

The browse refresh setting allows the local user to specify a periodic 
window refresh rate, to account for the possible actions of other users. 

The default (recommended) value for this parameter is 60 seconds. 
However, if you experience problems with the cursor moving unpredictably 
when you are editing data entry lists, you might try disabling this feature (by 
setting it to zero seconds). 

NOTE: This setting applies to, and can be set by, individual program users.
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• Excluded time / duration (mins) (2 items)

These parameters allow the administrator to define a time of day (start time) 
and a duration, during which users cannot connect to the server. If a 
workstation is connected and the excluded time begins, then the program 
will disconnect the workstation after a 5-minute warning. This feature is 
useful to prevent user activity while the backup is in progress. 

Suppose that a user leaves his/her workstation connected to the server and 
goes home for the day. The user forgets that s/he also was editing a particular 
student’s record. Later, when 4D Server is performing a backup (say, at 2:00 
am), as it reaches the open record, the backup stops and waits for the record 
to be released by the user. When other users return the next morning, they 
will be unable to connect to the server, because the backup is still in 
progress.

If the duration is set to a non-zero value in minutes, then the exclusion will 
be in effect starting at the specified time of day. If the duration is set to zero, 
then there will not be an excluded time.

There are exceptions to the server excluded time:

In the following cases, the server will not force the client workstation to 
disconnect.

1 A workstation is registered to perform print-to-pdf services for the 
SELPA Manager web server.

2 An administrative user (in the “AdminGroup” access group) holds down 
the [SHIFT] key, following password entry, while connecting to the server 
during the excluded time period.

Note that if the administrative user connected to the server outside of the 
excluded time period, then that user remains subject to the 5-minute auto-
logoff, if s/he is still connected when the excluded time period occurs.

3 A web user who is already connected to SELPA Manager multi-user.

If a new, web-based user attempts to connect, then the SELPA Manager web 
server will refuse the connection. For a user that is already connected, 
however, the program will not disconnect the user1. 

1. Web-based access does not create the same problem with the server backup as client-based access.



• Web: print-to-pdf timeout (secs) / pdf995 (secs) (2 items)

The multi-user editions of SELPA Manager makes use of “registered” 4D 
Client workstations to generate pdf documents, when web clients request 
printed reports. 

There are a number of steps involved in the pdf generation process, from the 
transfer of the request to an available client workstation, to the receipt of the 
completed pdf report from the workstation. Some of these steps require that 
either the server or the client workstation wait for a response from each 
other. 

These two items allow an administrator to specify a maximum number of 
seconds to allow at each one of the waiting steps, during pdf generation. If 
the maximum is exceeded, then the pdf generation fails, and the web server 
will report an error back to the client.

The “print-to-pdf timeout” is the principal value that needs to be specified 
for web printing. It must be at least 60 seconds. 

The “pdf995” value is a supplemental timeout for tasks that are specific to 
the pdf995 print driver, a Windows print driver that generates pdf 
documents. If the pdf995 print driver is not the default print driver, or the 
workstation performing the printing is a Macintosh, then this setting has no 
effect.

It is recommended that you leave these two settings at their default values, 
unless you experience frequent timeout problems. Consult technical support 
for additional guidance in adjusting these values.

System 2 Tab, multi-user subsection (buttons)
• Logon message (button)

This button enables an administrative user to post a message for all non-web 
based users to view when they connect to SELPA Manager. The user must 
acknowledge that s/he has read the message before SELPA Manager will let 
him/her complete the connection process. 

When you click on the button, the program displays a dialog for entering a 
logon message (Fig. 4-22).
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Fig. 4-22. Dialog for creating or editing a logon notice, which is displayed when each 
non-web user connects to the program.

When you have entered the message and press the OK button, the program 
will ask “Set flags for users to see this notice?” If you press the OK button 
to confirm, then SELPA Manager will set a “flag” for each user account.

When each user next connects to SELPA Manager, the program will display 
the logon message. If the user then presses the “I have read this message” 
button, then the program will dismiss the flag for that user account.

Once a user has read the message, s/he will not see it again, unless an 
administrative user creates a new or revised logon message.

• Web login notice (button)

This button enables an administrative user to post an optional message, 
which will appear at the top of the “home” or main list page, after a web-
based user has connected to SELPA Manager. The message will appear each 
time the user returns to the home page.

• Access restr(ictions) (button)

Displays a confirmation dialog (Fig. 4-23), indicating the school(s) or 
district(s), if any, to which the current user is restricted for entering records. 

Administrative users can apply school or district access restrictions for any 
user that is not in one of the teacher access groups (“TeacherGrp” or 
“TeacherLtdGrp”). 



Fig. 4-23. District access restrictions, confirmation dialog.

For more information on applying school or district access restrictions, refer 
to “School or district access restrictions” on page 156. For more information 
on the use of access groups with user login names, refer to the “Using access 
groups (custom user names)” on page 146.

NOTE: This button applies to, and can be accessed by, any program user, at 
the time s/he is connected to SELPA Manager.

• Web cache info. (button)

Displays a dialog containing web server statistics: the number of “hits” on 
particular pages, and the percentage of hits that could be served from the 
cache. 

NOTE: At the present time, the statistics request may not be returning any 
information (stay tuned).

• Clear html folder (button)

This button causes the html folder on the server to be cleared of any files 
with the prefix “WX_”, the suffix “.pdf”, and/or the suffix “.txt”.

These files may be generated in the course of user activities such as printing 
reports over the web. Normally, the program deletes these files after the user 
downloads them, and then clicks on a return link, to resume work where s/he 
was prior to the print job taking place. If the user does not click on the return 
link, however, then the download file remains in a folder on the server. 
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IEP Notice Defaults Tab
This tab (Fig. 4-24) allows users to identify default IEP participant names 
and location/address information, for student IEP notification forms. 

Fig. 4-24. Preferences dialog (administrators), IEP notice defaults tab.

If you are connected as an administrative user, then you may edit the global 
contact and address information that would apply to all program users. You 
can also edit another, personal set of contact and address items by checking 
the “My defaults” check box. 

Users without administrative privileges may view, but cannot change, the 
global IEP defaults. However, checking the “My defaults” check box 
enables them to edit their personal set of defaults.

Later, when you are editing a particular student, you can press the button, 
COPY PROGRAM DEFAULTS, on the IEP Notice tab, to incorporate IEP 
default items into the student record (Fig. 4-25).



Fig. 4-25. Copying IEP notice preferences to a particular student (COPY PROGRAM 
DEFAULTS button).

If the “My defaults” box is checked under Preferences for your login 
account, then SELPA Manager will copy the personal set of IEP defaults to 
the student record. Otherwise, it will copy the global set of defaults.

However, you can force it to copy the global set (when “My defaults” is 
checked), by holding down the [ALT/OPTION] key as you press the button. 
If there is existing information in the student’s IEP verification fields, then 
the program will warn you (prior to pasting in the default field contents) that 
the student information will be overwritten.

Appearance Tab, overview
The settings on this tab (Fig. 4-26) determine the appearance and behavior 
of SELPA Manager on individual user workstations. They affect only a 
particular user account, rather than affecting all program users.

The settings are organized into five different areas on the page: General, 
Students, Student services, Teachers - staff, and Logo.
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Fig. 4-26. Preferences dialog (administrators), Appearance tab.

Appearance Tab, general subsection
• Interface (drop-down list)

The interface affects how buttons, fields, check boxes, and other form 
elements appear on the user’s workstation while running SELPA Manager. 
If set to “Automatic”, then the program appearance will vary according to 
the operating system that is running on the workstation. 

For Windows, the “Windows 95/98/2000” interface is the default when 
“Automatic” is selected. For Macintosh, the “Platinum” interface is the 
default when “Automatic” is selected. 

“Platinum” resembles the Mac OS9 interface. The “Mac Theme” setting 
provides an interface that is more like OS X.



The results of changing the interface setting are immediately visible, and do 
not affect any program data. However, if the user clicks on the CANCEL 
button instead of SAVE, to close the Preferences dialog, then the interface 
will revert to its previous setting.

• No tool tips

When this box is checked, SELPA Manager will not display the “tool tip” 
contextual help at the end of the cursor, when the cursor lingers over a 
particular object that has associated help information (Fig. 4-27). 

When this box is not checked, each tool tip appears for a few seconds and 
then disappears. The tool tip can be made to reappear if the user moves the 
mouse away and then back over the same object again.

Tool tips are useful for new users of SELPA Manager as they become 
familiar with the program, but may be annoying to more experienced users. 

Fig. 4-27. Example of “tool tip” help, which can be turned off.

• No browse window

Checking this box causes the new windows (File menu -> “New window”) 
to be of the “limited”-type for selecting IEPs, rather than the full browse 
window. This option may be useful for administrative users that wish to 
preview, demonstrate, or test the limited interface, without a need to re-
connect to SELPA Manager under a different user account.
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Users in the “TeacherLtdGrp” or “CounselorLtdGrp” access groups are not 
able to toggle this item on and off, as they can only use the limited interface.

• No spelling

SELPA Manager includes a spelling verification feature that activates when 
the user moves the cursor out of a text1 field, where the user has changed the 
field contents. The detection of one or more potential errors causes a dialog 
to appear that identifies the word(s) that may be misspelled, along with 
correction suggestions.

The spelling feature can be disabled by checking the “no spelling” 
preference item. When the auto-spelling feature disabled, however, you can 
still check spelling manually, from the Actions menu.

• Scale forms (0-100%) 

This setting allows a user to specify a form size that is larger than standard, 
for resizeable forms. When this setting is a positive percent value, the 
program will scale the browse window and standard data entry forms by that 
amount. 

Certain elements such as fields on the form may “grow” or “move” to take 
advantage of the larger size. However, the text on the forms will remain the 
same size.Minimum data entry form size, except for the IEP forms, is 780 
by 526 pixels (width by height). Therefore, a setting of “10” in this box 
would result in forms that are 10 percent larger when initially opened, 858 
by 579 pixels.

Unlike the other data entry forms, IEP (assessment) data entry forms are a 
fixed width (approx. 780 pixels) and height. The user can enlarge or reduce 
the window by dragging the corner, but the objects such a fields on the form 
will now grow or reposition themselves. 

The height of the IEP data entry form varies for specific forms, but is usually 
longer than the available height on the monitor. Therefore, the program 
displays a vertical scroll bar during data entry, so that the user can move up 
or down on the form.

1. Spell checking also occurs in some of the longer alphanumeric fields, as well.



• Max recent items (0-50) 

Sets the maximum number of recent search items that can appear in the 
Location box drop-down list, on the browse window (refer to “The Location 
box” on page 180). 

The user types search requests (such as a student’s name or a date of birth) 
into the Location box, and then presses the [ENTER] key. 

SELPA Manager remembers recent search items, placing them into the 
drop-down list for easy recall. The list of recent items will change as the user 
changes the current focus in the browse window. To turn this feature off, 
select a value of zero (0) items.

• Add new record loop

When this box is checked, the program will add new records repeatedly, 
without the user having to select New Record from the Data menu each time. 
After the user accepts a new record by pressing the SAVE button, SELPA 
Manager will display another new, blank record for data entry. When 
finished adding records, the user presses CANCEL when a new (blank) 
record is being displayed, and the program will return to the browse window. 

If you prefer to add records one at a time, you should leave this option turned 
off.

• No styled browse text 

When the browse window displays records in its two lists, the program by 
default displays stylized text to indicate certain conditions that apply to 
particular records. For example, a student record that has the “DNR” (Do 
Not Report) box checked is listed in the browse window in italic text. A 
student record that has the “Mark” box checked is listed in red text. For a 
tabulation of stylized text meanings, refer to “Styled browse window text” 
on page 174.

If you do not wish to see the stylized text in the browse window, check this 
box, and all listed records will appear in plain, black text.

• Don’t guess AC prefix 

When this box is checked, SELPA Manager does not insert an area code 
prefix for the work, fax or “other” telephone number, based upon the area 
code prefix of a previously-entered telephone number (e.g., the home or 
Configuring SELPA Manager 293 

• 
• 
• 
•
•
•



294  

• 
• 
• 
•
•
•

main number). This option affects only certain areas of the program where 
telephone numbers can be entered: student contact, teacher, and school 
records.

• Sort browse lists (check box and associated EDIT button)

Checking this preference item causes the program to sort browse list items 
upon initial display, and when the user changes the browse window from 
one context to another. The browse list will not re-sort after editing one or 
more records, however.

The field on which a list is sorted by default will vary with the tables being 
displayed. 

The user can customize the sort for any browse list by pressing the EDIT 
button. A dialog will appear (Fig. 4-28) that allows one sort specification 
row per database table. The user can sort on up to four columns (Sort 1, Sort 
2, Sort 3, and Sort 4, in each table. The number entered in each Sort column 
should correspond to the appearance order of the column in the browse list.

Fig. 4-28. Custom sort order dialog, accessible after pressing the EDIT button next to 
the “Sort browse lists” check box, Preferences. Up to four columns can be sorted, for 
each database table. 

If no custom sort definition is available for a particular table, but the “sort 
browse lists” item is checked in Preferences, then the program will return to 
the default sort field for the table(s) being displayed.



Sorting requires more processing time before the records are initially 
displayed, particularly if the sort field(s) are not indexed and there are many 
thousands of records to display.

• Browse window initially displays (drop-down list)

Changing this option will affect the selection of records that appear initially 
in the upper list, when opening a new browse window, or when changing the 
browse window context. 

The records displayed may be further limited by the access group to which 
the user belongs, and/or by school or district access restrictions that may 
apply. For additional information on these restrictions, refer to “Using 
access groups (custom user names)” on page 146, and to “School or district 
access restrictions” on page 156.

The options available in the drop-down list are limited to only three, if the 
user is a member of the “TeacherGrp” access group: 

– Current (as of, for me)
– Current (today, for me)
– No records

For users who are not members of the “TeacherGrp” access group, the 
options in the drop-down list include:

– All records
– Current (as of date)
– Current (as of, for me)
– Current (as of, no DNR)
– Current (today)
– Current (today, for me)
– Current (today, no DNR)
– No records

The lower list of the browse window will be empty when the window first 
appears or on changing contexts, with one exception: the user performs a 
search on a context change, and the search results in the display of one 
(found) record in the upper list. In this case, the lower list will display 
associated records for the record in the upper list.
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Examples:

School is Plaza Robles
Assignments for Douglass, Denise

Browse window initial display options:

1 All records 

Displays all records in the table. This option is the program default.

2 Current (as of date)

Displays current records, based on the Report As Of date (page 255).

The term “current” for the initial display of browse window records refers 
to primary student services where (1) the drop date is greater than a specified 
date (in this case, the Report As Of date), or the drop date is empty; and (2) 
the start date is less than or equal to the specified date. 

SELPA Manager will restrict the search to student service records that have 
been placed into either the current year or a specified “alternate” year, 
depending upon whether the “Other year services” item is checked in the 
Data menu (refer to “Other year services” on page 647).

The “Current (as of date)” option and other “current” display options affect 
the selection of student services, and of tables related to services by 
association: schools, students, student contacts, disciplinary actions, 
transitions, assessments, and assessment goals. Unrelated or more distantly-
related tables, such as districts and teachers, are not affected; they will 
simply display all records under the “current” options. 

For example, to obtain current schools, the program finds the schools at 
which the current services take place. 

To obtain current students, the SELPA Manager finds the students 
corresponding to the current services, for primary services only. From these 
students, the program can then obtain current student contacts, disciplinary 
actions, assessment (IEP) forms, and goals.

In addition to setting this initial display preference, the user can also display 
current services (and items related to current services) at any time from a 
browse window by selecting Show Current from the Data menu (refer to the 
Chapter, “Data Menu Operations” on page 607.)



NOTE: Because the “current” display options require that SELPA Manager 
perform a search based upon current services, the browse window may 
require a much longer time interval to display than in the “all records” and 
“no records” cases. 

3 Current (as of, for me)

Displays current records, based on the Report As Of date, where the student 
services found are for the current user name as the provider.

4 Current (as of, no DNR)

Displays current records, based on the Report As Of date, excluding students 
flagged as Do Not Report (DNR).

5 Current (today)

Displays current records based on today’s date, rather than using the Report 
As Of date. 

This option uses the date set on the workstation’s computer clock or, for the 
multi-user editions of SELPA Manager, the server’s computer clock. For the 
“today” options like this one, it is important that the computer clock or 
server computer clock is correctly set.

6 Current (today, for me)

Displays current records, based on today’s date (computer clock or server 
computer clock), where the services found are for the current user name as 
provider.

7 Current (today, no DNR)

Displays current records based on today’s date (computer clock or server 
computer clock), excluding students flagged as Do Not Report (DNR).

8 No Records

Displays no records at all initially, so that both the upper and the lower list 
will be blank. 

This option minimizes both memory usage and time required to display the 
browse window, and is the preferred one for multi-user installations.
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• Optional browse fields (students/assessments) (2 drop-down lists)

To insert another field of your choosing as the fourth column of the student 
listing, or as the eighth column of the assessment listing, select one of the 
fields listed in these two drop-down lists.If you do not wish to insert another 
field, select “None” for both lists. You may select a field that is already being 
displayed at another column location, for either list.

Any change that you make with this option will not take effect until you 
switch browse contexts, or open a new browse window.

Appearance Tab, students subsection
• In the browse window, show: (drop-down list) 

When you start SELPA Manager or open a new browse window, the 
program will display the Students context initially. You can change the 
associated table that is displayed with students from this drop-down list. The 
options are “Students / Contacts”, “Students / Assessments”, “Students / 
Transitions”, “Assessments / Students”, and “Transitions / Students” (upper 
list / lower list).

Any change that you make with this option will not take effect until you 
switch browse contexts, or open a new browse window. 

If your current preference does not include assessments (IEPs), then you can 
temporarily change the browse view to include assessments, while 
maintaining your standard preference, by typing the word “assessment” or 
“IEP” into the Location box. 

Similarly, if your current preference does not include transitions (ITPs), then 
you can temporarily change to a browse view that includes them, by typing 
the word “transition” or “ITP” into the Location box.

When you switch away from and then return to the student context, it will 
revert to your default choice (e.g., “Students / Contacts”).

In a similar vein, by typing an appropriate request into the Location box, you 
can create a new assessment form or a new transition form for a student, 
even if you are not currently displaying assessments or transitions. For 



example, the following requests will cause SELPA Manager to temporarily 
change the context (if necessary) and open a new IEP or transition form for 
the student:

New assessment for Cathy Smith
New IEP for Wendell Kay
New transition for Clay Williams
New ITP for Powell Magnusson

After you save or cancel the new record, switch to some other context, and 
then return to the students context, the program will revert to the original 
students context display preference.

For more detailed guidance on using the Location box, refer to “The 
Location box” on page 180.

• Transportation only

Checking this box causes SELPA Manager to display a limited, 
transportation-related data entry form instead of the standard student data 
entry form (Fig. 4-29).

While this option is active, you cannot add new student records. Instead, you 
can only modify existing students’ transportation information by double-
clicking on the student name in the browse window. For additional 
discussion of this form, refer to “Transportation-only data form” on 
page 412.

Program users who are not members of the group, “ReadWriteGrp” cannot 
normally save changes to a student record. However if the program user is a 
member of another (separate) group, “TransportGrp”, then s/he will be able 
to save transportation-related modifications. These modifications can be 
performed on the transportation-only data form, or on the Transportation tab 
of the standard student data entry form. 

When using SELPA Manager’s default set of users and groups, the user 
called “Transport Only” has this type of access privileges.

An additional system setting on Tab 2 allows more fields to be enterable on 
the transportation-only form; refer to the checkbox, “More transport-only 
fields” on page 272.
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Fig. 4-29. Transportation-only data entry form for students (partial, showing upper 
portion). This form scrolls vertically – the SAVE and CANCEL buttons are located at 
the bottom of the form (not shown).

• Student’s age today 

When checked, this option causes SELPA Manager to display the student’s 
age as of today’s date, in years and months, on the first tab of the student data 
entry form. The age will include the suffix, “[T]” as a reminder that it is 
referenced to today’s date (Fig. 4-30).

When this preference is not checked, SELPA Manager will display the 
student’s age in years and months, referenced to the “Age calcs. fm.” date, 
or (if blank), the Report As Of date. The “Age calcs. fm.” date is discussed 
on page 257 in this chapter.



Fig. 4-30. First tab, data entry form for a student, displaying the student’s calculated 
age as of today’s date (indicated by the “[T]” suffix. The number in the recessed area, 
next to the AGE button, is the calculated age field (an integer age that is always 
referenced to the Report As Of date).

Appearance Tab, student services subsection
• Student services: browse list above__ Teachers-Staff; __Students (2 

radio buttons)

When you switch to the services context in a browse window, by default the 
program displays student service records in the upper list and associated 
students in the lower list. 

Clicking on the “Teachers-staff” option will change the lower list to display 
associated teachers, rather than associated students. You will need to click 
on another browse context (e.g., teachers, districts, etc.) and then back again 
to services, before you will see the display change

• Alternate data entry form

Checking this box causes the program to display a data entry form for 
student services that has a slightly different arrangement of items. The 
alternate form does not differ in the number or type of fields displayed, 
however.

Appearance Tab, teachers-staff subsection
• Browse list above __ Services; __ Assignments (radio buttons) 
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When you switch to the Staff context in a browse window, by default the 
program displays teacher-staff records in the upper list and associated 
assignments in the lower list. 

Clicking on the “Services” option will change the lower list to display 
associated teacher services, rather than associated assignments. You will 
need to click on another browse context (e.g., services, districts, etc.) and 
then back again to Staff, before you will see the display change

Appearance Tab, logo subsection
• SELPA logo (LOAD button and field)

If you have a picture, design logo, or other graphic that you would like to 
appear on some printed assessment forms, then you can paste it from the 
Clipboard into this field. You may also press the button to paste in a logo or 
picture from a file on disk.

Preferences for non-administrative users
Users who do not have administrative access to SELPA Manager will have 
more limited choices when they select “Preferences...” from the File menu. 
The three other Preference dialogs are for users with read-write access 
(“ReadWriteGrp” access group); limited access (“TeacherLtdGrp” and 
“CounselorLtdGrp” access groups); and read-only access (program user 
does not belong to any access group).

Preferences dialog (read-write users)
Fig. 4-31 illustrates the General tab of the Preferences dialog, for read-write 
users. 

Unlike the administrative Preferences dialog, this dialog does not allow the 
user to change SELPA, site number, or school/district name. While these 
items appear on the form, they are disabled for data entry. Nor can the user 
change the Report As Of, earliest allowed, or latest allowed dates. Multi-
user parameters are also excluded.



However, the read-write user can specify defaults when adding new contact 
or IEP records; prevent “As Of” warnings from appearing on records during 
data entry; allow pop-up choice lists for goals/objectives/benchmarks; and 
configure dialing parameters for a modem. An ACCESS RESTRICTIONS 
button apprises the user of whether any school or district access restrictions 
apply to his/her user account.

Fig. 4-31. Preferences dialog for user in the “ReadWriteGrp” access group, General 
tab.

Fig. 4-32 illustrates the “IEP notice defaults” tab of the read-write 
Preferences dialog. Unlike the administrative user, a read-write user cannot 
edit IEP notice defaults that will affect all users. However, by clicking the 
“My defaults” box, the read-write user is able to edit his/her own set of IEP 
notice information — the all-user defaults disappear, replaced by white, 
field-entry boxes for the read-write user’s own selections.

Fig. 4-33 illustrates the “Appearance” tab of the read-write Preferences 
dialog. It is very similar to the administrative Preferences dialog for 
appearance items, but does not allow the read-write user to add a logo.
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Fig. 4-32. Preferences dialog for user in the “ReadWriteGrp” access group, IEP 
notice defaults tab.

Fig. 4-33. Preferences dialog for user in the “ReadWriteGrp” access group, 
Appearance tab.



Preferences dialog (limited users)
The Preferences dialog for “limited” users is accessible to program users 
that are in the “TeacherLtdGrp” or “CounselorLtdGrp” access groups. 
These groups do not have access to the full browse window. Therefore, the 
range of items that they may configure in Preferences is more limited than 
either the administrative or the read-write user.

Fig. 4-34 illustrates the General tab for the limited-access user Preferences 
dialog. As with the read-write user Preferences, the limited-access user 
cannot change the SELPA, the date configuration items, or the multi-user 
parameters. 

The limited-access user can specify defaults when adding new IEP records; 
prevent “As Of” warnings from appearing on IEP records during data entry; 
allow pop-up choice lists for goals/objectives/benchmarks; and configure 
dialing parameters for a modem. An ACCESS RESTRICTIONS button 
apprises the user of whether any school or district access restrictions apply 
to his/her user account1.

Fig. 4-34. Preferences dialog for user in the “TeacherLtdGrp” or “CounselorLtdGrp” 
access groups, General tab.

1. School or district access restrictions can apply to members of the CounselorLtdGrp, but not

to members of the TeacherLtdGrp, see School or district access restrictions  on page 156.
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Certain appearance items (interface, no tool tips, and no spelling) also 
appear at the bottom of the General tab, because there is not a separate 
appearance tab for limited-access users.

Fig. 4-35 illustrates the “IEP notice defaults” tab of the limited-access user 
Preferences dialog. Like the read-write user, a limited-access user cannot 
edit IEP notice defaults that will affect all users. Instead, s/he can click on 
the “My defaults” box to edit notice items for his/her own use only.

Fig. 4-35. Preferences dialog for user in the “TeacherLtdGrp” or “CounselorLtdGrp” 
access groups, IEP notice defaults tab. Because the “My defaults” box is checked, the 
various IEP notice items can be edited.

Preferences dialog (read-only users)
The Preferences dialog for read-only users has a General tab and an 
Appearance tab. It does not have IEP notice defaults, because a read-only 
user cannot save a record, with or without pasted IEP defaults.

Fig. 4-36 illustrates the General tab for the read-only user Preferences 
dialog. The read-only user cannot change the SELPA, the date configuration 
items, or the multi-user parameters. However, the user can prevent “As Of” 
warnings from appearing on IEP records during data entry; and configure 



dialing parameters for a modem. An ACCESS RESTRICTIONS button 
informs the user of whether any school or district access restrictions apply 
to his/her account.

Fig. 4-36. Preferences dialog for a read-only user, General tab.

Fig. 4-37 illustrates the Appearance tab for the read-only user. It is similar 
to the Appearance tab for administrative users, because the read-only user 
has access to the full browse window. However, there are no provisions to 
disable the browse window; to disable spelling; to have an add new record 
loop; or to save a logo.
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Fig. 4-37. Preferences dialog for a read-only user, Appearance tab.

Saving changes to Preferences information
Press the OK button to save all changes that you have made to the 
Preferences dialog. If you press CANCEL instead of OK, then the changes 
will not be saved.

EXCEPTION: Changes to the choice lists (page 261) are saved regardless 
of whether you press OK or CANCEL.



• • • • • •
 5 Entering Districts and Schools

[rev. 1.2006]

When entering information into a new copy of SELPA Manager, you will 
want to add district records first, followed by school records. There must be 
at least one district record before any school records can be entered. 

If you already have listed districts and/or schools in a spreadsheet-style file 
on disk, then you can bypass manual entry and import the spreadsheet 
information into the program (“Import...” from the File menu). Prior to 
import, ensure that the columns are in the correct order and that the file on 
disk is in the correct format.1 

Codes for districts and schools can be obtained from the California Public 
School Directory2 or the California directory of private schools3.

If you transfer information from a local copy of SELPA Manager to another 
district or county office using the SELPA Central export, you should work 
with the SELPA office to ensure that your district and school codes and 
names agree with those of other program users. 

As an example, suppose that you have a district with the code, 3467348, 
named “Galt Elementary”, and another user calls this same district “Galt 
Joint Union”. Then the name of this district in the SELPA Central data file 
may change each time that the import source changes between you and the 
other program user.4

1. Instructions can be found under Import...  on page 514.

2. California Public School Directory. Sacramento: CDE Press, California Dept. of Education,
(annual).
3. Directory of Private Elementary Schools and High Schools in California. Sacramento: Cali-
fornia State Dept. of Education, (annual).
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District entry
As a first step in starting a new data file, you will need to have at least one 
district record entered.

Adding a new district

To add a new district to the program (from the browse window):

1 Click on the DISTRICTS button.

The browse window will change contexts, if necessary, so that districts 
appear in the upper list and schools appear in the lower list. 

After switching to the new context, the focus will be on the upper list. If you 
have not yet entered any districts, or if you have specified in Preferences that 
the browse window should initially display no records, then the upper list 
will be empty (refer to “Browse window initial display options:” on 
page 296).

If you did not switch contexts (you were already browsing districts), then 
ensure that the focus is on the upper list.

2 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for districts (Fig. 5-1). 

3 Enter information for the new district record.

Data entry areas that must be completed to save the record have labels that 
are underlined on the form. For a district, the district code and the district 
name are required.

At lower right on the form is a list of missing/problem items that have yet to 
be completed or that must be corrected to save the record. When there are 
no “problem” items listed, the SAVE button at the bottom of the form will 
changed from disabled to enabled

4. Unless the SELPA Central user un-checks the “allow updates to existing records” check box
for the Districts table, refer to Fig. 11-3 on page 516. If this box is not checked, then the import
will create new districts, but will not revise existing districts in the SELPA Central data file.



Fig. 5-1. Data entry form for adding a new district.

4 After completing the form, press the SAVE button. 

The program will save the new district. If the Add new record loop option is 
turned on in Preferences, then the program will display a new, blank form 
for the next district to be entered (refer to the Chapter, “Configuring SELPA 
Manager” on page 293).

District entry form

The following items appear on the district data entry form (Fig. 5-1):

1 Code

Enter the district code, as listed in the California Public/Private Schools 
Directory.
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If the program detects another district with the same code, it will not allow 
you to enter this code again. Make sure that you are using the correct code 
for the district.

2 Name

Enter the name of the district. SELPA Manager will issue a warning if you 
have entered a name that is the same as another (existing) district record. 
The duplication will not prevent you from using the name, however.

3 Address / City / State / Zip / County

Enter the district office address and the associated county name, if desired. 

4 Report to CASEMIS as

If the district is to be reported to CASEMIS through another district, enter 
the other (main) district code.

This provision allows you to maintain “sub-districts” for special education 
services within a main district. Having one or more sub-districts may be 
useful for internal accounting purposes, if only the main district has an 
associated state district code.

If a program user has district access restrictions in place that limit the user 
to the sub-district, then that user will also have access to the main (reported-
through) district. For more information on district access restrictions, refer 
to “School or district access restrictions” on page 156.

5 My District

If you are the SELPA administrator for a school district, then you may want 
to check the My District box for that district. Except where an administrative 
user has already specified a default district of residence in Preferences1, 
SELPA Manager will then use the My District selection as the student’s 
district of residence, when you add a new student record to the program2. 

SELPA Manager also will incorporate the district code for My District into 
the first seven digits of the new student’s record number 
([Student]Record_number field).

1. Refer to “Default dist. of res. code” on page 269.
2. A flow chart illustrating the logic used to assign the district of residence and the district code
prefix for a new student appears as Fig. 7-2 on page 361.



If you do not wish to have the program assume a district of residence when 
creating new students, then leave the My District check box empty. Then, 
assuming that a default district is not specified in the administrator 
Preferences, the program will prompt you for the student’s district of 
residence each time that you create a new student record.

NOTE: SELPA Manager will permit only one district designated as My 
District, for each user account.

6 Next student number

The next student number value is incorporated, indirectly, into the student 
record number ([Student]Record_number) field. Each time that a user adds 
a new student record to the program, the program places the next student 
number from the associated district into the new student’s record number. It 
then increments the next student number in the district record by one.

Normally, SELPA Manager automatically maintains the value in the next 
student number field. If you manually change the next student number for a 
district, then the program checks that there are no existing student records 
that incorporate a higher “next student” number in the 
[Student]Record_number field.

Leave the next student number set at 1 for a new district record, unless you 
would like for new student record numbers to start with a higher number.

7 County office

If the district operates as the county office of education, check the county 
office button (for one district only).

For the District Summary (ED-101) report, U.S. Department of Education, 
SELPA Manager counts student populations in county office districts 
differently from non-county office districts. Therefore, checking this box 
will affect the ED-101 report results. Only one district (per copy of SELPA 
Manager) can be designated as the county office district.

8 Promotion test / Graduation test (combo boxes)

If desired, enter promotion test and graduation test information.

Item 8 in the 2003 District Summary (ED-101) report for the Office of Civil 
Rights (OCR) requests information about whether an entity required 
students to pass a test, either to be promoted to the next grade or to graduate. 
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These two entry areas allow you to specify for each district the entity, if any, 
that requires examination for promotion or graduation.

9 District holidays and vacation periods (list)

SELPA Manager takes district holidays and vacations into consideration 
when calculating compliance dates for student evaluations; when preparing 
attendance; when counting student suspensions; and when preparing a 
district chargeback report1. A holiday is a single-day event, whereas a 
vacation takes place over multiple (contiguous) days.

You may add as many holidays and vacations as you wish. Each will appear 
as a row in the list (Fig. 5-2). After you have saved the district record, the 
holidays and vacations also should appear as items in the Calendar2 section 
of the browse window.

Fig. 5-2. District holidays and vacation periods (list), on District data entry form.

To add a new holiday or vacation for the district, press the (+) button to the 
left of the list. The program will add a new, highlighted row to the list 
displaying today as the start date. You can then double-click into each 
editable column to enter appropriate information. Click once away from an 
edited cell, or use the [TAB] key, for the changes to register.

1. Refer to “District chargeback report” on page 456.
2. Refer to Calendar view (context)  on page 226. Vacations appear as banners on the Calendar.

A vacation may not appear on the Calendar if it spans a period larger than the range of days

which the Calendar covers.



If you add a new row when an existing row is already highlighted, the 
program will ask whether it should make a copy of the highlighted row 
(“Duplicate highlighted row?”); press CANCEL if you want the program to 
create a new row that is not a duplicate of the highlighted one.

To delete a listed holiday or vacation, highlight the row by clicking once on 
it, and then press the (-) button.

• Start date – Date on which the holiday occurs or the vacation starts.

• Event time – Time at which a holiday occurs (for reference only, not used 
for calculations).

• End date – Date on which a vacation ends (does not apply to holidays).

• Type (display only) – The Calendar item entry type. For multi-day items 
(vacations), the program will display “Banner” in this location. For 
single-day items (holidays), it will display “Event”.

• Class – The Calendar item classification. When viewing events and 
banners on the Calendar, you can examine all items, or look only at items 
within a specific classification. The drop-down list in this column offers 
both “Holiday” and “Vacation” classifications. 

You can also enter some other classification by double-clicking into the 
column. However, you may also wish to add the new classification to the 
“Calendar item class” list in Preferences (see “System 1 Tab, Lists 
subsection” on page 261), so that the new classification appears in the 
drop-down list on the Calendar.

• Description – Title or other description for the vacation or holiday. By 
default, the program will enter “Vac/hol, District: xxxxxxx[yy]”, where 
“xxxxxxx” is the 7-digit district code, and “[yy]” represents the 
internally-assigned record number, in the [Calendar_item] table. You 
may edit this description as you wish.

• Created by, Modified on, Modif. by (display only) – These fields 
indicate the name of the original creator of the Calendar item; the date 
and time of last modification; and the person who last modified the item.

Editing an existing district
Once a district is entered into the program, it will appear as a row in the 
Districts list of the browse window. You may need to access it again later, to 
view the data entry form or make changes.
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To edit an existing district (from the browse window):

1 Find the district record in the upper browse list.

If there are a large number of districts listed, you may not be able to locate 
it immediately. There are several approaches to locating the district record, 
some of which are listed here:

• Sort the list, either by district code or by district name, by clicking in the 
first or second column headers of the upper list. Scroll through the list 
until you find the district record.

• Type the district name or the district code in the Location box, then press 
the [ENTER] key.

• Select the field, “district name” from the Location box pop-up menu, 
complete the sentence with the district name (or beginning portion 
thereof), and then press the [ENTER] key (Fig. 5-3 and Fig. 5-4). For 
example,
district name is amador

Fig. 5-3. Typing the sentence “district name is san joaquin” into the Location box, to 
find a district.



Fig. 5-4. The program locates the appropriate record(s).

2 Double-click on the row corresponding to the district record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the district.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes and returns you to the browse window. 
The row corresponding to the edited record should still be highlighted.

School entry
You should create a record for each of the schools at which staff members 
provide special education services. Schools have an indirect link to student 
services, by association with an active teacher assignment (a provided 
service at a particular school).

Unless you have un-checked the Preference, “Limit student services to 
active teacher assignments”1, then records representing the school, teacher, 
and teacher assignment must be present to save a service record for a 
student.

If you add a new school at a later time, make sure that the SELPA office is 
aware of the addition.

1. Refer to the Chapter, “Configuring SELPA Manager” on page 273.
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Schools may be added from two different browse window contexts (refer to 
Fig. 3-43): They appear in the upper list for the Schools context, and in the 
lower list for the Districts context. In the latter case, when one district name 
is highlighted in the upper list, and a school is added to the lower list, the 
program will place the new school into the highlighted district.

For simplicity, the instructions which follow will assume that you are adding 
the new school in the Schools context.

Adding a new school

To add a new school to the program (from the browse window):

1 Ensure that you have at least one district entered into the program.

You cannot add a new school, if there is no district with which to associated 
the school. Refer to “Adding a new district” on page 310.

2 Press the SCHOOLS button.

The browse window will change contexts, if necessary, so that schools 
appear in the upper list and teacher assignments appear in the lower list (Fig. 
5-5). After switching to the new context, the focus will be on the upper list. 

If you did not switch contexts (you were already browsing schools), then 
ensure that the focus is on the upper list.

If you have not yet entered any schools, or if you have specified in 
Preferences that the browse window should initially display no records, then 
the upper list will be empty (refer to “Browse window initial display 
options:” on page 296). Otherwise, you should see existing schools listed.

3 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for schools (Fig. 5-6). 



Fig. 5-5. Browse window displaying the Schools context (schools in upper list, teacher 
assignments in lower list).

4 Enter information for the new school record.

Data entry areas that must be completed to save the record have labels that 
are underlined on the form. For each new school, you must enter at least the 
school name and code, and select the associated district.

At lower right on the form is a list of missing/problem items that have yet to 
be completed or that must be corrected to save the record. When there are 
no “problem” items listed, the SAVE button at the bottom of the form will 
changed from disabled to enabled

5 After completing the form, press the SAVE button. 

The program will save the new school. If the Add new record loop option 
is selected in Preferences, then the program will display a new, blank form 
for the next school to be entered (refer to “Add new record loop” on 
page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another school, the repeat the instructions from Step 3 onward.
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Fig. 5-6. Data entry form for adding a new school.

School entry form

The following items appear on the school data entry form (Fig. 5-6):

Among the items listed below, only the school code, school name, and 
district are required.

1 School code

The code representing the school. The entry must be 7 digits long; 
otherwise, the school record cannot be saved. It is recommended that you 
use the state-assigned code (listed in the public or private school directory, 
refer to the citations in the footnote on page 309). 

Unless you have selected the “Shared school codes” option in Preferences1, 
the school code that you enter should be a unique identifier for each school 
within the SELPA. 

1. Refer to “Shared school codes” on page 270.



If you have selected the “Shared school codes” option, and you enter the 
same code as one or more other schools that are already listed in SELPA 
Manager, then the program will alert you to this fact and ask you to confirm 
that the code should be used again.

If both the code and the name of the current school match another school, 
then the program will disallow the entry.

If the “Shared school codes” option is not selected, then attempting to enter 
the same code for more than one school will result in an error message.

Occasionally a school or site of service does not have a state-assigned code. 
Some preschools and independent study programs may fall into this 
category. When this circumstance occurs, the SELPA office should assign a 
special, 7-digit school code to that site. This code can contain alpha 
characters as well as numeric digits. 

2 Name

The name of the school.

Generally, if the name as entered exactly matches the name of another 
school in SELPA Manager, then the program will warn you of this fact, as 
you move the cursor out of the field. If you have selected the “Shared school 
codes” option in Preferences, and both the name and school code match 
another record, then SELPA Manager will not allow the name to be entered. 
Otherwise, the program will allow you to have more than one school with 
the same name. 

If you have a situation where multiple schools share the same name, or if a 
particular school provides services in more than one district, then you might 
create school records with slightly different school names. For example, 

Adams elementary (Galt)
Adams elementary (Nevada Middle)

3 District (drop-down list)

The code and name for the district to which the school belongs. 

4 Type (combo box, coded1, restricted2)

1. For more information on coded data entry, refer to “Data entry areas for coded information”
on page 234.
2. The user is restricted to selecting among the choices on the list.
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The type of school (public day school, charter school, continuation school, 
etc.).

You may select an item from the choice list, or enter either the type code or 
a portion of the description. If the partial entry is recognized, the program 
will complete the entry for you.

5 Level (combo box, restricted)

The educational level for the school (e.g., elementary, middle/junior high, 
etc.). This item appears on the Individual School Report (ED102), for the 
Department of Education’s Civil Rights Report.

6 Principal

The name of the principal of the school.

7 Grades offered (15 check boxes)

Check boxes for the specific grade level(s) offered at the school. If the 
school has no grade levels, then check the “Ungraded” box. This action will 
un-check any other grade-level boxes that might be selected.

These selections appear on the Individual School Report (ED102).

8 Address / City / St. / Zip / County / Phone / Ext. / Fax

Use these data entry areas to specify the street address, telephone number, 
and fax number for the school. 

The telephone and fax numbers should be entered without prefixes or other 
punctuation. To clear a telephone or a fax number, hold down the 
[ALT/OPTION] key while clicking on the PHONE or FAX button.

9 Starts at / Ends at; Starts at (2) / Ends at (2); Starts at (3) / Ends at (3) (6 
time of day fields)

These six entry areas allow you to specify up to three separate sets of default 
daily start and end times for the school. 

When adding a pick-up or a drop-off transportation item for a student, 
SELPA Manager will insert the default start time or the default end time for 
the school of attendance, for the student’s primary service. The time inserted 
will depend upon whether the transportation item is a “Pick up”, “Pick up 
2”, “Pick up 3”, “Drop off”, “Drop off 2”, or “Drop off 3”. For additional 
information, refer to “Transportation (Student Tab 7)” on page 402.



10 Special ed only / ability grouping / gifted programs / magnet school / 
magnet only / acad. difficulties / discipline probs / pregnant students (8 
check boxes)

If the school has any of these attributes, then you can check them. These 
items appear on the Individual School Report (ED102).

Editing an existing school

To edit an existing school (from the browse window):

1 Find the school record in the appropriate browse list.

If there are a large number of schools listed, you may not be able to locate 
it immediately. There are several approaches to locating the record, some of 
which are listed here:

• Sort the list, either by school code or by name, by clicking in the first or 
second column headers of the school list. Scroll through the list until you 
find the school record.

• Type the school name or the school code in the Location box, then press 
the [ENTER] key.

• Select the field, “school name” from the Location box pop-up menu, 
complete the sentence with the school name (or portion thereof), and then 
press the [ENTER] key. For example,
school name is galt

2 Double-click on the row corresponding to the school record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the school.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes and returns you to the browse window. 
The row corresponding to the edited record should still be highlighted.
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 6 Adding Staff and Related Information

[rev. 2.2006]

If you have already entered districts and schools into SELPA Manager, then 
you are ready to add information concerning the special education personnel 
in your SELPA. Staff members and related information should be entered 
into SELPA Manager prior to adding students and services.

There are three sections of SELPA Manager which contain staff-related 
information:

• Staff – Names, addresses, contact information, etc. for instructors, 
teachers, other special education service providers, and classified (non-
teacher) staff members.

• Teacher services – Special education services that staff members are 
qualified to deliver to students (e.g., language and speech, occupational 
therapy, etc.). Includes the provider’s certification status and state 
classification when providing the service.

• Assignments – A special education service that is delivered by a staff 
member at a service location (school). Includes the portion of the staff 
member’s available time that is allocated to the assignment.

The Staff section can be accessed from the upper list of the browse window, 
after you press the STAFF button (refer to “Staff entry” on page 328). 

Depending upon your Preferences settings, you can also access either 
teacher services or assignments from the lower list of the same browse 
window context, below the staff list1. When you double-click to display a 
row in the lower list, the program will open either the teacher service data 
entry form or the assignment data entry form.

1. Refer to the individual user preference item, “Browse list above __ Services; __ Assignments
(radio buttons)” on page 301.
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In addition, both teacher services and assignments are also accessible from 
Tab 3 of the staff data entry form. Initially, you will probably find it easier 
to enter both teacher services and assignments in this manner, from within 
the staff data entry form itself.

Fig. 6-1 illustrates the dependency relationships among staff members, 
teacher services, and assignments in SELPA Manager. You cannot add a 
teacher service if you haven’t yet entered any staff members into the 
program. Similarly, you cannot add an assignment without first entering an 
associated teacher service. You must also have at least one school listed in 
the program to add an assignment.

Fig. 6-1. Dependencies among the staff-related areas of SELPA Manager, and their 
relationship to student services.

Importing staff and naming consistency
If you already have staff members listed in a spreadsheet-type file on disk, 
then you can bypass manual entry of staff, and import the spreadsheet 
information into the program (“Import...” from the File menu, refer to the 
Chapter, “File Menu Operations” on page 514). Prior to import, ensure that 
the columns are in the correct order (refer to the import type, “Teachers 
(generic)” on page 565), and that the file on disk is in the correct format. 

If you transfer staff records from one copy of SELPA Manager to another1, 
then you should coordinate with the destination user, to ensure that your 
staff codes and names are consistent with those of other program users.

Staff member

Teacher service

Assignment

Student School

Student service 
(enrollment)



As an example, suppose that among your listed staff members, you have a 
teacher with the code, RCP238, named “Richards, Pat”. Further suppose 
that another SELPA Manager user (using a separate copy of the program, in 
another district) has a staff member named “Pat Richards” with the same 
code, RCP238. If both of you transfer information to a third copy of SELPA 
Manager, perhaps maintained in the county office of education, then the 
name of this teacher in the county office data file will change each time that 
the import source changes between you and the other district user.

As a corollary, suppose that your code for Pat Richards is “RCP238” and the 
other user’s code for her is “RIPP”. In this case, the program manager in the 
central office will have two separate listings for the same service provider. 
This situation may be desirable if, for example, the same person provides 
special education services in different school districts. Usually, however, 
you will want to have only one record in the staff section for a service 
provider, and instead enter the various sites where the staff member provides 
special education services as assignment records.

SELPA Manager supplies a tool in the Actions menu (“Merge...”), for 
combining two or more duplicate staff member records into one record1. 
The highlighted records become one single record, and in the process the 
program also consolidates the associated services and assignments.

Services, assignments, and attendance
As noted in the introduction to this chapter, SELPA Manager maintains a list 
of teacher services that a staff member is capable of providing to students. 
Each teacher service record represents a state-specified special education 
service. The service record can be stamped with a personnel classification 
or job description (e.g., audiologist, counselor, interpreter, etc.); a current 
status (certified, preliminary credential, no state requirements, etc.); and, if 
relevant, the date on which a certificate of competency expires. One service 
can also be designated as the “default” teacher service, for each staff 
member.

A staff member can offer special education services at more than one 
location (school or other facility). The combination of a service at a 
particular school is an assignment. Assignments can be marked as active or 
1. Refer to the topics, “Transfer...” on page 567; and “Districts to central...” on page 569, for
more information on district-to-central export options.
1. Refer to the Actions menu operation, “Merge...” on page 654.
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inactive. You can specify a starting date for the assignment, and the number 
of Full Time Equivalents (FTEs) that are applicable. A provider can have up 
to 1.2 FTEs among all of his/her active assignments.

SELPA Manager allows each staff record to have multiple services and 
assignments. Each service entry for a provider must be for a different, 
CASEMIS-defined special education service, however, thereby limiting the 
maximum number of services that any staff record can have. 

The program will allow you to enter more than one assignment for a 
particular teacher service at the same school; however, it will present a 
warning each time that you add more than one assignment for the same 
service.

Another feature of assignments is the capability of logging daily student 
attendance. This feature is available from the assignments data entry form, 
or by typing specific phrases into the Location box, on the browse window 
(e.g., “Samuel Taylor is present”, “Gloria Campanella is excused”). You 
cannot access attendance information directly from the staff data entry form. 

As a print-time option, actual attendance information can be printed onto 
attendance register forms (refer to the “Attendance registers report” on 
page 598).

In any case, you will need to add student and student service data to SELPA 
Manager before collecting any attendance information. Therefore, you may 
want to skip over the discussion of attendance in this chapter initially. After 
you have added student and student service information, you can then access 
the assignment records for one or more particular staff members, to add 
student attendance.

Staff entry

To add a new staff member to the program (from the browse window):

1 Press the STAFF button.

The browse window will change contexts, if necessary, so that staff records 
appear in the upper list and assignments appear in the lower list (Fig. 6-2).1 
After switching to the new context, the focus will be on the upper list. 
1. Unless you have selected to have services appear in the lower list, rather than assignments.
Refer to the Chapter, “Configuring SELPA Manager” on page 301.



Fig. 6-2. Browse window displaying the Staff context (staff members in the upper list, 
assignments in the lower list).

If you did not switch contexts (you were already browsing staff members), 
then ensure that the focus is on the upper list.

If you have not yet entered any staff, or if you have specified in Preferences 
that the browse window should initially display no records, then the upper 
list will be empty (refer to “Browse window initial display options:” on 
page 296). Otherwise, you should see existing staff listed.

2 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for staff. This form has 
three tabbed displays, General, Demographics, and Teacher services - 
assignments. (Fig. 6-3). Initially, the program displays the General tab.

3 Enter information for the new staff record.

For each new record, you must enter, at a minimum, the code and the name 
of the staff member. The other fields are optional.
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Fig. 6-3. Data entry form for a staff member, General (first) tab.

At lower right on the form (first two tabs only) is a list of missing/problem 
items that have yet to be completed or that must be corrected to save the 
record. When there are no “problem” items listed, the SAVE button at the 
bottom of the form will changed from disabled to enabled

4 After completing the form, press the SAVE button. 

The program will save the new staff record. If the Add new record loop 
option is selected in Preferences, then the program will display a new, blank 
form for the next staff record to be entered (refer to “Add new record loop” 
on page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another staff member, the repeat the instructions from Step 3 
onward.



Staff entry form: General tab

The following items appear on the staff data entry form, General tab 
(Fig. 6-3):

1 Code

An identifying code for the staff member. Can be up to 20 alpha or numeric 
characters. Must be unique within the SELPA; contact the SELPA office 
before changing or adding a teacher code.

2 Name

Name of the staff member. For convenience in searching and sorting listings 
in the browse window, you may want to enter the name as <last name>, 
<first name>.

Staff names are unique in SELPA Manager. If you enter a name for a new 
staff member that exactly matches an existing record in the program, then 
the program will disallow the entry.

If you change the name of an existing staff member that provides student 
services, then the program will attempt to change the associated name in 
each student service record, as well. If the student services update was not 
fully successful, due to the presence of locked records, then the program will 
suggest that you cancel the staff data entry form, so that none of the changes 
that you have made will be saved.

3 Title (combo box, restricted1)

The principal or default job classification for this staff member. You must 
select one of the state-defined, special education classifications, or leave this 
item blank. 

Later, when you are adding services (Teacher services - assignments tab, 
“Pvdr type (with drop-down list, restricted)” on page 339, below), SELPA 
Manager initially assumes that this default title applies to the new service.

4 Address, City, State, Zip

Entry areas for the contact address of the teacher. If you have records in the 
Postal Codes section of the program, then the program will attempt to 
supply the city and state after you enter the Zip code and then exit the field.

1. The user is restricted to selecting among the choices on the list.
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Therefore, if you know the staff member’s Zip code, and the Postal Codes 
section already contains state Zip codes, then you may want to tab into the 
Zip field, before entering the city and state.

5 Note (scrolling text field)

For miscellaneous notes concerning this staff member. The program also 
uses this field to record import information.

6 email (1) / email (2) 

Electronic mail and alternate electronic mail address for the staff member.

7 Tel h, Tel W, Ext., Tel oth, Type

Home and work telephone numbers for the staff member, extension number, 
other telephone number, and type of “other” phone number (e.g., pager, 
cellular, etc.).

8 Picture

You can add a picture or graphic representation of the staff member, by 
copying the image from another application, and then pasting it into this 
rectangle.

NOTE: At the present time, you cannot transfer the picture to another copy 
of SELPA Manager, using the SELPA Central export.

Staff entry form: Demographics tab

In addition to the staff member code and name, the following items 
appear on the Demographics tab (Fig. 6-4):

1 Inactive (check box)

Indicates whether or not the staff member is retired or otherwise inactive. 
Checking this box will prevent the staff member’s name from appearing in 
the drop-down list of providers, on enterable student service lists. Enterable 
student service lists appear on the Services tab of the student data entry 
form; and when adding student services to some IEP forms.



Fig. 6-4. Data entry form for a staff member, Demographics (second) tab.

If you mark a staff member as inactive, but s/he currently has active 
assignments, then SELPA Manager will offer to change these assignments 
to inactive status.

Inactive status also comes into play when printing the California Basic 
Educational Data System (CBEDS) forms. Inactive staff members will not 
count toward the totals in Section A (Number of Classified Staff) of the 
School and the County/District Information Forms. Also, teachers having 
inactive status will not appear on the printed Professional Assignment 
Information Form (PAIF)1.

2 Gender (“M” or “F” only)

The gender (female or male) of the staff member. 

1. For the PAIF, SELPA Manager prints a table of values, from which the user can transfer the

information to the Genesis Data (Scantron-type, machine-readable) form. The program does not

print the Genesis Data form directly.
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This information appears on the printed CBEDS Professional Assignment 
Information Form (PAIF), for each eligible teacher. Additionally, the 
program uses gender to separate the calculated totals for non-teacher staff 
categories, on the CBEDS School and County/District Information Forms.

3 DOB (date entry)

The staff member’s date of birth. 

This information appears on the printed CBEDS Professional Assignment 
Information Form (PAIF) for each eligible teacher. 

4 Credentials (scrolling text field, with drop-down list)

This area allows you to identify the authorized teaching areas for a provider, 
in paragraph-style or list-style format. The contents of this area will appear 
on the printed CBEDS Professional Assignment Information Form (PAIF), 
for each eligible teacher.

5 Years of educational service

The total years of professional educational service for a teacher, regardless 
of district, including the present year. Excludes substitute teaching. This 
number must be an integer value.

The contents of this area will appear on the printed CBEDS Professional 
Assignment Information Form (PAIF), for each eligible teacher.

6 Years in this district

Total years of service for a teacher as a contracted professional, in the 
current district. This number must be an integer value.

The contents of this area will appear on the printed CBEDS Professional 
Assignment Information Form (PAIF), for each eligible teacher.

7 Percent (%) full time

Percent of a full-time position that a teacher or other staff member holds. 
This number can be greater than 100, but must be an integer value.

The contents of this area will appear on the printed CBEDS Professional 
Assignment Information Form (PAIF), for each eligible teacher. 

Additionally, the program separates the calculated totals for non-teacher 
staff categories into full-time positions (100 percent or greater) and part time 
positions (less than 100 percent), on the CBEDS School and County/District 
Information Forms.



8 Classification (combo box, restricted)

The classification for staff member’s position – office-clerical, other 
classified, paraprofessional, or Teacher (non-classified).

These classifications appear in the Section A (Number of Classified Staff) 
counts, on the CBEDS School and the County/District Information Forms.

9 Status (combo box, restricted)

Teacher or other staff member's status (tenured, probationary, long-term 
substitute, etc.). This information appears on the printed CBEDS 
Professional Assignment Information Form (PAIF), for each eligible 
teacher.

10 Highest edu. level (combo box, restricted)

The highest educational level attained by a teacher or other staff member. 
This information appears on the printed CBEDS Professional Assignment 
Information Form (PAIF), for each eligible teacher.

11 Ethnicity (1 drop-down list and 1 combo box; coded, restricted)

Staff member’s ethnic background, up to 6 allowed. Enter the 3-digit code, 
the description, or select from the combo box choices, for one or more 
ethnicities. If the staff member has more than one ethnicity, then the primary 
ethnicity should be entered into the first (“1”) area. For each non-blank 
ethnicity specification, SELPA Manager will place a “>” sign following the 
ethnicity number in the drop-down list

This information appears on the printed CBEDS Professional Assignment 
Information Form (PAIF), for each eligible teacher. The ethnicities also 
count toward the subtotals on the CBEDS School and County/District 
Information Forms.

12 For a staff member who does not teach, specify EITHER the affiliated 
school, OR, for staff at the district office ONLY, specify the affiliated 
district (4 data entry areas, school/district code/name)

The school and/or district affiliations/locations for non-teacher staff 
members. The school and district affiliations determine which staff get 
counted for the Section A (Number of Classified Staff) tabulations, on the 
CBEDS School and the County/District Information Forms.
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Staff entry form: Teacher services - assignments tab
The Teacher services - assignments tab (Fig. 6-5) contains two lists. The 
upper list includes the special education service areas that a teacher is 
qualified or provisionally qualified to provide (teacher services). The lower 
list indicates the specific locations at which the teacher provides the services 
(assignments). 

Fig. 6-5. Data entry form for a staff member, Teacher services - assignments (third) tab.

To add an assignment in the lower list for a teacher at a particular school, 
you must first enter the teacher service in the upper list. 

NOTE: In order to conserve space for the two lists, the missing/problem 
items list does not appear in the lower-right corner, on this particular tab 
only.



Services (upper list)

To create a teacher service listing, press the ADD (+) button adjacent to the 
upper list. The program will add a new service record and highlight the row. 

You will see arrow buttons, each representing a drop-down list, in the Code, 
Service, Status, Ends On, and Pvdr Type columns. For each new service row, 
you must enter, at a minimum, the code or name of the service.

The columns where information can be edited are accessible by double-
clicking into the appropriate cell and typing, or by selecting an item from a 
drop-down choice list (where available). Once you have edited a particular 
cell, you can use the [TAB] key to move to the next editable cell to the right.

You can add multiple services for a staff member, but each service must have 
a unique CASEMIS code.

1 Dflt (check box)

Indicates a default service for this staff member. Double-click into the first 
column, and check the box that appears. When the cursor exits the cell, the 
cell will then display “Yes”.

A staff member can have a maximum of one service designated as the 
default service. 

Later, when you are adding a service for a student, if you select this staff 
member to provide the student’s service, then the program will also enter the 
provider’s default service code and description.1

2 Code (with drop-down menu, restricted)

CASEMIS code representing the special education service. Double-click 
into the second column and type the service code, or select it from the drop-
down list. The program will then enter the corresponding name of the 
service in the third column (Service), as you exit from the code column.

The service codes that will be available for selection in the drop-down list 
will depend upon the Report As Of date that is selected in Preferences.2 If 
the Report As Of date is before 7/1/2006, then the drop-down list will 
display the 2-digit CASEMIS service codes that have been in use since the 
2001-2002 academic year.

1. Refer to the Chapter, “Entering Students” on page 386.
2. Refer to Report as of date (combo box)  on page 255 .
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If the Report As Of date is on or after 7/1/2006, then the drop-down list will 
display the 3-digit service codes for the 2006-2007 academic year.

You can also type in an “old-style”, 3- or 5-digit CASEMIS service code. In 
this case, SELPA Manager will attempt to substitute a current equivalent for 
the old code – either the 2-digit, 2001-2002 code or the 3-digit, 2006-2007 
code, depending upon the Report As Of date setting in Preferences.1 When 
the 3-digit, 2006-2007 codes are being displayed, you can also enter the 
two-digit service codes manually, and SELPA Manager will attempt a 
conversion to the newer codes.

If you do not want code substitution to take place, so that the “old” code is 
retained, then hold down the [ALT/OPTION] key as you move out of 
Column 2, after data entry.

3 Service 

Name corresponding to the CASEMIS code for the service. Rather than 
entering the service code, you can select the service by name in this column, 
and the program will enter the corresponding service code in Column 2. 

When entering a service from the keyboard, you can type the first few letters 
of the description, [TAB] to exit the cell, and the program will attempt to 
finish the description (as well as placing the service code). For example, 
“Ori” becomes “Orient. & Mobility” (59); or “res” becomes “Resource 
services, school based” (25).

As with the service codes, the service names that will be available for 
selection in the drop-down list will depend upon the Report As Of date that 
is selected in Preferences.

4 Status (with drop-down list) 

This column can be used to track the staff member’s credential status. Select 
an item from the drop-down list, or enter any text up to 30 characters.

5 Ends on (date, with drop-down calendar/list) 

The date on which a teacher credential or certification to provide this service 
is due for renewal. 

1. The Department of Education introduced the 2-digit CASEMIS service codes for the 2001-
2002 academic year; and introduced the 3-digit codes for the 2006-2007 academic year. There
is not a one-to-one correspondence among the three sets of service codes, so the program’s code
substitutions are inexact.



6 Pvdr type (with drop-down list, restricted)

Provider type, personnel classification, or job title/description for the staff 
member while providing this service. You must select one of the state-
defined, special education classifications, or leave this item blank. 

The classification descriptions appear on the Special Education Personnel 
Data Report1. SELPA Manager uses the provider type designation, along 
with the credential status (Item 4, above), to tabulate the number of 
personnel for this report.

If you previously entered a title for the staff member, then SELPA Manager 
will have already entered that title here, on adding the new service (refer to 
“Title (combo box, restricted)” on page 331, above).

7 Comments

Miscellaneous information concerning this teacher-provided service (up to 
80 characters).

NOTE: The Comments column is the last user-editable column in the 
services list.

Assignments (lower list)

To create an assignment in the lower list, the staff member first must have a 
corresponding teacher service entry in the upper list. To add a new 
assignment, highlight the teacher service to be provided in the upper list, 
and then press the ADD (+) button adjacent to the lower (assignments) list.

The program will add a new, related assignment record to the lower list and 
then highlight the new row. The new row will be listed as Active (Column 
1), and will have the same service code and description as the highlighted 
service in the upper list (“Code” and “Assigned service”, Columns 2 and 3). 

If you need to change the service being provided by the assignment, you can 
select another service in Columns 2 or 3. The service must be present in the 
upper list, however, or the program will not allow you to select it for the 
lower list.

At a minimum, each assignment listed in the table must include both a 
service and a location (school).

1. California Department of Education, Form R-30 SE. This form can be printed for selected dis-

tricts, when the current focus of the browse window is on districts.
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1 Active (check box)

Indicates that the assignment is active. Double-click into the first column, 
and check or un-check the box that appears. When the cursor exits the cell, 
the cell will then display “Yes” if the box is checked.

Generally, an assignment that is not active cannot be specified for a student 
service.1 

2 Code (with drop-down list, restricted)

CASEMIS code representing the special education service provided by the 
assignment. Double-click into the cell to type in the code, or select it from 
the drop-down list. The program will automatically enter the corresponding 
name of the service in the next column (Assigned service).

3 Assigned service (with drop-down list, restricted)

Name of the service, corresponding to the CASEMIS code. 

4 Code (with drop-down list, restricted)

Code corresponding to the school where the staff member will be providing 
the service. You may enter either the code (this column) or the school name 
(next column, Item 5), and the program will complete the other item for you, 
as you exit the edited cell. Double-click to enter a cell, or select the school 
code from the drop-down list2.

5 School (with drop-down list, restricted)

Name of the school where the staff member will be providing the service. 
You may enter either the code (previous column, Item 4) or the school name 
(this column), and the program will complete the other item for you, as you 
exit the edited cell. When entering the school name, you can enter the first 
few letters, and the program will attempt to complete the name for you, as 
you exit the cell.

NOTE: The program will present a warning if you add more than one 
instance of a particular service, at a particular school, to the assignments 
list.

6 Starts on (date, with drop-down calendar/list)

1. Unless “Limit enrlmts to active teacher assignments” is un-checked in Preferences (refer to
the Chapter, “Configuring SELPA Manager” on page 273).
2. The drop-down lists of school codes and of schools are not available on Windows, if the lists

would contain more than 200 schools.



The date on which the assignment commences. Select a date from the drop-
down list, or double-click to type into the cell.

7 FTEs (Full-time equivalents, number)

The Full Time Equivalent (FTE) represents the fraction of the staff 
member’s available time that is consumed in providing this assignment. The 
sum of all active assignments for a staff member should total in the range of 
1.0 to 1.2; inactive assignments do not count toward the total. SELPA 
Manager will not allow the staff member to have more than 1.2 FTEs.

8 CBEDS assign

Four-digit code for the assignment. This information appears on the printed 
CBEDS Professional Assignment Information Form (PAIF) for each of the 
eligible teacher’s assignments.

9 CBEDS grade (with drop-down list, restricted)

The grade level of the majority of students in the class, for a 
departmentalized class. This information appears on the printed CBEDS 
Professional Assignment Information Form (PAIF) for each of the eligible 
teacher’s assignments.

10 UC/CSU req (check box)

Checking this box indicates that the course is designated as meeting the 
UC/CSU requirements for admission.

NOTE: UC/CSU Req. is the last user-editable column in the assignments 
list.

Modifying an existing staff member
As noted earlier, making changes to the records of existing staff members 
can create inconsistencies when you transfer the information to another 
program user. You should make it your policy to inform the SELPA office 
whenever you are planning to edit existing staff member information. The 
SELPA office can then advise other program users of the changes.

To modify a existing staff member in the program (from the browse 
window):

1 Find the staff record in the appropriate browse list.
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If there are a large number of staff members listed, you may not be able to 
locate it immediately. There are several approaches to locating the record, 
some of which are listed here:

• Sort the list, either by code or by name, by clicking in the first or second 
column headers of the list. Scroll through the list until you find the 
teacher record.

• Type the staff member’s name or code in the Location box, then press the 
[ENTER] key.

• Select the field, “teacher name” from the Location box pop-up menu, 
complete the sentence with the staff member’s name (or portion thereof), 
and then press the [ENTER] key. For example (also shown in Fig. 6-6),
teacher name is tuck

Fig. 6-6. Finding an existing teacher record from the Location box.

2 Double-click on the row corresponding to the staff member record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the staff member.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse window. 
The row corresponding to the edited record should still be highlighted.



Replacing a staff member
Replacing a staff member may be necessary when s/he leaves the school 
district, and another person will be assuming their case load. The 
replacement operation in SELPA Manager should affect the services for all 
students who presently receive services from the person who is departing.

A special function, “Assign teacher...” in the Actions menu1, allows you to 
replace one or more teachers/providers with another staff member, for a 
selection of student service records. The services to be changed should be 
listed in the browse window prior to selecting the menu item.

To replace a staff member for a selection of student services (in the 
browse window), you must first list the services:

1 Press the SERVICES button on the browse window.

If you are not already displaying services in the browse window, you will 
need to change contexts so that services are displayed. Make sure that the 
focus is on the services list Fig. 6-7).

Fig. 6-7. Set the current context of the browse window to student services. The focus 
should be on the upper list.

2 From the Data menu, select “Show current for...”

The program will display the following dialog (Fig. 6-8).

1. For additional information on the Actions menu functions, refer to the Chapter, “Actions
Menu Operations” on page 651.
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Fig. 6-8. Dialog for selecting current student services.

3 From the dialog, select FOR ONE TEACHER. Make sure that the item, 
INCLUDE ONLY PRIMARY SERVICES, is unchecked.

These settings instruct SELPA Manager to find any current student services, 
for a particular staff member.

4 Press the OK button to close the dialog.

The program will now display a second dialog, containing a list of staff from 
which to select the person being replaced (Fig. 6-9).

Fig. 6-9. Select the name of the staff member that is being replaced.



5 Select the staff member who is being replaced, and press the OK button.

The program should now be displaying a selection of current services for the 
staff member that is being replaced (Fig. 6-10).

Fig. 6-10. The browse window should now contain only current student services for the 
staff member that is being replaced.

To perform a staff member replacement for the current selection of 
student services:

1 Select “Assign teacher...” from the Actions menu.

The program will display the “Apply teacher...” dialog (Fig. 6-11).

2 Enter the replacement staff member name or code in the TEACHER box. 

To select from a list of staff members, enter the wildcard character (“@”)1 
and press the [TAB] key. The teacher that you select should be the one that 
will be replacing the current staff member, for the student service.

3 Check the boxes for CREATE TEACHER SERVICE... and CREATE NEW 
TEACHER ASSIGNMENT.

These dialog box choices will build a selection of services and assignments 
for the replacement staff member, which mirror the requirements of the 
existing services.
1. For additional information on the use of the wildcard character, refer to “The wild-
card character (“@”)” on page 625.
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Fig. 6-11. The apply teacher dialog. These settings will assign “Tucker, Prudy” to the 
listed student services, creating any needed teacher services and (teacher) 
assignments for Ms. Tucker in the process.

4 Press the OK button to execute the apply teacher action.

When the action is complete, the program will present a confirmation dialog 
(Fig. 6-12).

Fig. 6-12. Confirmation dialog after apply teacher action.

The list of student services should now reflect the new teacher assignment 
(Fig. 6-13). Additionally, if you now examine the data entry form for the 
replacement teacher, you may see new services and assignments (Services 
tab).



Fig. 6-13. Appearance of student services list after the Apply teacher action is 
complete.

Adding services from the browse window
As noted earlier, you can add a teacher service in the upper portion of the 
Teacher services - assignments tab, from the staff member data entry form 
(Fig. 6-5). 

You can also add a new service record directly from the browse window, 
provided that the default selection, “Above services”, is chosen in 
Preferences as the display option for the teachers-staff context. 

To add a teacher service to the program (from the browse window):

1 Ensure that “Teachers - staff / Browse list above / Services” is selected 
in Preferences (Appearance tab).

2 Press the STAFF button.

The browse window will change contexts, if necessary, so that staff 
members appear in the upper list and teacher services appear in the lower list 
(refer to Fig. 6-14). After switching to the new context, the focus will be on 
the upper list. 
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Fig. 6-14. Adding a new teacher service for a staff member, from the browse window 
(current focus is on teacher services, the lower list).

3 Set the focus to the LOWER list (teacher services).

4 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for teacher services (Fig. 
6-15). 

NOTE: Before you select “New record” from the Data menu, if you have 
highlighted a row in the upper list of the browse window (a staff member 
record), then the new teacher service form will already be linked to that staff 
member. Similarly, if there is only one staff member record listed in the 
upper list, then the new service will be linked to that staff member. You can 
re-link to a different staff member before saving the teacher service record.



Fig. 6-15. Data entry form for a new teacher service.

5 Enter teacher service information onto the data entry form.

For each new service, you must enter, at a minimum, the teacher and the 
special education service. The other fields are optional.

• Teacher (1 data entry area and one display-only area) – Name of the 
teacher (staff member) that is/will be providing a special education 
service.You may enter the beginning of the name or enter the code, and 
the program will attempt to complete the entry when you [TAB] out of 
the data entry area. 

Enter just the Wildcard character (“@”) and then [TAB], to obtain a 
complete list of staff members. You can also enter a telephone number or 
a Zip code for the staff member, and the program will either find a match 
or present a list of potential matches. To be entered here, the person must 
be listed first in the Staff section of the program (refer to the “Staff entry” 
on page 328).

• Service (2 data entry areas, each with pop-up lists, restricted) – The code 
and the name for the special education service. You can enter either the 
code or the beginning of the service name into either field, and the 
program will attempt to complete both data entry areas. 
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• Default service for this teacher (check box) – A staff member can have 
only one service designated as his/her default at one time. Later, when 
you are adding a service for a student, if you select this staff member to 
provide the student’s service, then the program will also enter the 
provider’s default service code and description

• Status (with drop-down list) – The staff member’s credential status. 
Select an item from the pop-up menu or enter any text (up to 30 
characters).

• Classification/title (with drop-down, restricted) – Provider type, 
personnel classification, or job title/description for the staff member 
while providing this service. You must select one of the state-defined, 
special education classifications, or leave this item blank. If there is a 
linked staff member, then SELPA Manager will copy the default title 
from the staff member record (refer to “Title” on page 331).

• Ends on (date) – The date on which a teacher credential or certification 
in this service is due for renewal. 

• Note – Miscellaneous information concerning this teacher-provided 
service (up to 80 characters).

6 After completing the teacher service data entry form, press the SAVE 
button. 

The program will save the new teacher service record. If the “Add new 
record loop” option is turned on in Preferences, then the program will 
display a new, blank form for the next service to be entered (refer to the 
Chapter, “Configuring SELPA Manager” on page 293). 

If you do not have the add new record loop preference activated, but you 
wish to add another service, then repeat the instructions from Step 4 onward.

7 Repeat from Step 4 for each teacher service that you wish to add. 

Once you have completed service entry, you may wish to browse the records 
and review/print the list of entries to verify proper entry.

Adding assignments and attendance information
As noted earlier, you can add an assignment to the lower list, on the Teacher 
services - assignments tab of the staff data entry form (Fig. 6-5). 



You can also add an assignment record directly from the browse window, 
provided that the default selection, “Above assignments”, is chosen in 
Preferences as the display option for the teachers - staff context.1 Unlike the 
staff member data entry form, the assignments data entry form allows you 
to enter student attendance information.

To add a new assignment to the program (from the browse window):

1 Press the STAFF button.

The browse window will change contexts, if necessary, so that teachers 
appear in the upper list and teacher assignments appear in the lower list (Fig. 
6-2). After switching to the new context, the focus will be on the upper list. 

2 Set the focus to the LOWER list (assignments).

3 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for assignments (Fig. 6-
16). The top portion of the form has data entry areas for specifying the 
teacher (staff member), school, and service information, as well as the 
starting date for the assignment. 

NOTE: Before you select “New record” from the Data menu, if you have 
highlighted a row in the upper list of the browse window (a staff member 
record), then the new assignment form will already be linked to that staff 
member. Similarly, if there is only one staff member record listed in the 
upper list, then the new assignment will be linked to that staff member. You 
can re-link to a different staff member before saving the assignment record.

The bottom portion of the form contains a list for attendance information, 
pertaining to the individuals who attend the class. There are two tools for 
specifying the attendance date: a drop-down calendar/date selector and a 
“date type” drop-down list. 

For a new assignment record, the attendance date initially is set to today’s 
date, and the attendance list will be empty. To display all attendance records 
for the displayed assignment, regardless of the date, select “Any date” from 
the date type drop-down list (shortcut: [CNTRL/CMD]-J). 

To view attendance information on a specific date, select “Specify date...” 
from the drop-down list, or pick the date from the calendar/date selector. You 
can also select “Yesterday” (shortcut: [CNTRL/CMD]-Y), “Today” 
1. Refer to the Chapter, “Configuring SELPA Manager” on page 301.
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(shortcut: [CNTRL/CMD]-T), “1 week ago”, “1 month ago”, or “1 year ago” 
as the date type. You can perform a search for attendance records meeting 
specific criteria (“Custom search...”), using the Query Editor.

Fig. 6-16. Data entry form for an assignment.

4 Enter assignment information onto the data entry form.

For each new assignment, you must enter, at a minimum, the teacher, the 
school, and the service that is being provided. The other fields are optional.

• Teacher (1 data entry area and one display-only area) – Name of the staff 
member that is/will be providing a special education service.You may 
enter the beginning of the staff member’s name or enter a code, and the 
program will attempt to complete the entry when you [TAB] out of the 
data entry area. 

Enter just the Wildcard character (“@”) and then [TAB], to obtain a 
complete list of staff members. You can also enter a telephone number or 
a Zip code for the staff member, and the program will either find a match 

Calendar/date selector

Date type drop-down list



or present a list of potential matches. To be entered here, the staff member 
must be listed first in the Staff section of the program (refer to the “Staff 
entry” on page 328).

• School (2 data entry areas) – The name and code for the school where the 
staff member is providing the service. To be selected here, the school 
must first be listed in the Schools section of the program (refer to “School 
entry” on page 317). 

• Service (2 data entry areas, each with pop-up lists, restricted) – The code 
and the name for the service to be provided. You can enter either the code 
or the beginning of the service name into either field, and the program 
will attempt to complete both data entry areas. 

• Full-time equivalents (1 data entry area, numeric) – The fraction of the 
staff member’s available time that is consumed in providing this 
assignment. The sum of all active assignments for a staff member should 
total in the range of 1.0 to 1.2. Inactive assignments do not count toward 
the total.

• Min of class (numeric) – The number of minutes generally spent in the 
class or provided to the students. Used as a default value when creating 
attendance records. The program copies this minutes value into new 
attendance items, as it creates them (refer to the “Mins” item on 
page 356).

• Assignment is active (checkbox) – An assignment that is not active 
cannot be used for a student service.

• Starts on (date) – The date on which the staff member begins to provide 
the service at the site.

• CBEDS: Assignment code – A four-digit assignment code, which will 
appear on the printed CBEDS Professional Assignment Information 
Form (PAIF), for an eligible teacher.

• Grade level (combo box, restricted) – The grade level of the majority of 
students in the class, for a departmentalized class. This information 
appears on the printed CBEDS Professional Assignment Information 
Form (PAIF), for each of an eligible teacher’s assignments.

• UC/CSU course (check box) – Indicates that the course is designated as 
meeting the UC/CSU requirements for admission.

5 If desired, enter attendance information for the students who are taking 
the class.
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The list on the data entry form is for attendance items (records) for particular 
students taking the class. If you do not enter attendance information now, 
you can always return to the assignment record at a later time, to add or edit 
attendance information. 

Once you have added one or more attendance items, you can no longer 
change the staff member, school, or service associated with the assignment 
— all of the associated attendance items must be deleted first.

Press the ADD (+) button adjacent to the list. SELPA Manager will search 
for student services with the staff member, service, and school 
corresponding to this particular assignment record. If you wish to use 
another date as the current date, then choose another date from the calendar 
selector; or choose “Specify date...” from the date type drop-down list.

Normally, to add an attendance item for a student service, the student service 
must be current (not dropped) as of the attendance target date. Additionally, 
an attendance item for the same student service should not already be listed 
on the same attendance date. However, if you hold down the [SHIFT] key 
while pressing the ADD (+) button, then the program will allow dropped 
services and/or duplicated attendance items to be used.

Holding down the [ALT/OPTION] key while pressing the ADD (+) button 
on the assignment form will direct SELPA Manager to display a dialog 
containing the eligible student services for the attendance target date. (Fig. 
6-17). 

Fig. 6-17. Dialog box for selecting service(s) to be used in creating new attendance 
record(s). {CNTRL/CMD]-Click or [SHIFT]-click to select more than one service.



On this dialog, use the [SHIFT]-click and/or [CNTRL/COMMAND]-click 
keystrokes to create contiguous or non-contiguous highlights, thereby 
selecting more than one student service with which to create attendance 
items. Press the OK button to create the attendance items, or press CANCEL 
to stop without creating any attendance items. 

If the [ALT/OPTION] button is not held down while pressing the ADD (+) 
button, then the program will not display Fig. 6-17. Instead, it will create 
attendance items automatically, on the target date and for all eligible student 
services, and place them onto the assignment data entry form (Fig. 6-16).

Once the program has created the attendance items, they will appear in the 
attendance list on the assignment data entry form, (Fig. 6-18), ready for 
editing. Initially the new attendance items will have the date shown in the 
date type drop-down list.1 

Fig. 6-18. Data entry form for an assignment, after adding attendance records.

1. If the date type drop-down list is not displaying a date, then the new attendance items will be
assigned today’s date. 
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If SELPA Manager cannot find any suitable services from which to create 
the attendance items, then the program will present a warning message, 
“There are no services associated with this assignment. Please create at least 
one service for this assignment (go to the services section, or add a service 
while editing a student record).”

If one or more of the attendance record(s) to be created already is on display 
in the attendance listing (i.e., the same service on the same day), then 
SELPA Manager will ask you to confirm that you wish to duplicate the 
attendance items anyway.

Each attendance item that was successfully created will appear as a new row. 
Each row should contain, at a minimum, the date and the attendance status.

NOTE: SELPA Manager only checks attendance records that are presently 
being displayed for completeness. To show all attendance records, select 
“Any date” from the “Date to display:” pull-down menu.

The columns where information can be edited are accessible by double-
clicking into the appropriate cell, or by selecting an item from a drop-down 
choice list. Once you have edited a particular cell, you can use the [TAB] key 
to move to the next editable cell.

• Date (date, with drop-down calendar/list) – Date of attendance. 

• Status (with drop-down list) – Student’s attendance status, on the date of 
attendance. 

• Mins (numeric) – Minutes of service provided. As an initial value, the 
program copies the value for the [Assignment]Classroom_mins_default 
field (“min of class”, refer to page 353).

• Grp (with drop-down list, restricted) – Student’s age group, as specified 
by the Americans with Disabilities Act (ADA). The choices are: PS - 
preschool; Elem - elementary (K-8); and HS - high school (9-13). Any 
child with a fifth birthday falling in the range of July 1-December 1 is 
designated as elementary. For birthdays between December 2 and June 
30, the child becomes elementary on the day that s/he turns 5.

• Last name (display only) – Student’s last name.

• First name (display only) – Student’s first name.

• Student ID (display only) – Student identification number 
([Student]Student_number).



• Svc (display only) – CASEMIS service code, for the service provided to 
the student.

• Service (display only) – name for the service provided to the student. 

• Note – Notes pertaining to the attendance record (up to 80 characters). 
This column is the last in the table permitting user entry.

6 After completing the assignment data entry form, press the SAVE button. 

The program will save the new assignment record. If the “Add new record 
loop” option is turned on in Preferences, then the program will display a 
new, blank form for the next assignment to be entered (refer to the Chapter, 
“Configuring SELPA Manager” on page 293). 

If you do not have the add new record loop preference activated, but you 
wish to add another assignment, then repeat the instructions from Step 3 
onward.

7 Repeat from Step 3 for each assignment that you wish to add. 

Once you have completed assignment entry, you may wish to browse the 
assignments and review/print the list of entries to verify proper entry.

Adding attendance information from the browse window
You can also add attendance items directly from the browse window, from 
any browse context, by entering a phrase into the Location box that is 
structured as follows:

<studentName> is here
<studentName> is present
<studentName> is excused
<studentName> is unexcused
<studentName> is suspended

...where “<studentName>” can be student’s name, record number, student 
number, date or birth, or Social Security Number. 

For more information on this mode of entry for attendance information, 
refer to the Chapter, “Using SELPA Manager” on page 183.
Adding Staff and Related Information 357 

• 
• 
• 
•
•
•



358  

• 
• 
• 
•
•
•



• • • • • •
 7 Entering Students

If you have entered districts, schools, and teachers (and their associated 
services and assignments) into SELPA Manager, then you are ready to add 
student information.

[rev. 2.26.2003]

The data entry form for students is one of the most detailed data entry forms 
in this program, spread over thirteen tabs that are organized by topic. You 
can add an unlimited number of contacts (parents, guardians, etc.); student 
services; disciplinary actions; and pick-up and drop-off events for the 
student, while editing this form. There is also a series of “user” fields of 
various types that can be designated for purposes unique to your SELPA.

If you already have or can generate student information as a file on disk, then 
you may be able to import student data (Import from the File menu) and 
thus save yourself some time. There are a few student import formats from 
which to choose; please refer to the appendices for detailed information.

Student identification numbers
SELPA Manager maintains two independent “key” or identification 
numbers for each student, the Student Record Number and the Student ID 
Number. The program assigns these numbers automatically when you create 
a new student record. Each key is unique; there should be no other student 
that will have exactly the same number. 

Neither of the two key fields can be edited. However, there is an optional 
third number or code, the Student Number, which the you may enter / edit, 
or leave empty.
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[Student]Record_number
This key is an 18-digit code, in 7-5-4 digit format (with two hyphens):

district code prefix - sequence number - site number

For example, the 176th student added to District 3968585, into the SELPA 
Manager program set as Site No. 1 in Preferences1, would have the 
following student record number: 

3968585-00176-0001

The student record number appears in the upper left of the student data entry 
form, just to the left of the student’s name (Fig. 7-1). 

Fig. 7-1. The record number ([Student]Record_number) appears just to the left of the 
student’s name, in the upper left portion of the data entry form.

Generally speaking, when adding a new student to the program, SELPA 
Manager will present a list of districts. You should select the district into 
which the student should be placed. The code for the selected district will 
then become the first seven digits of the student’s record number. The 
selected district also becomes the student’s district of residence (although 
you may change to another district of residence).

However, if you have identified a particular district as My District in the 
Districts section2, then the program will not present the list of districts when 
adding a new student. Instead, the code for My District will be used for the 
1. The site number is set in Preferences. Refer to the Chapter, “Configuring SELPA
Manager” on page 245.
2. Refer to the Chapter, “Entering Districts and Schools” on page 312.



first seven digits of the student’s record number. For the district of residence, 
the program initially assumes My District, unless there is a default district 
of residence entered in Preferences.1 Fig. 7-2 displays the program logic for 
selecting the district code prefix and the district of residence, when adding 
a new student.

Fig. 7-2. Logic chart for selecting the district of residence and the district code prefix 
of the student record number ([Student]Record_number).

1. Refer to the Chapter, “Configuring SELPA Manager” on page 269.

Has My District 
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Add a new student

Is there a default 
district code in 
Preferences?

Yes

District of residence = 
default district code from 

Preferences
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No

Prompt user to select a 
district from a list

No

Student record prefix 
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Allow user to edit 
new student record

User selected a 
district from the 

list?

Is there a default 
district code in 
Preferences?

Yes

District of residence = 
default district code from 

Preferences

Yes

District of residence = 
user-selected district 

(from list)

No

Student record prefix 
based on user-selected 

district (from list)

Allow user to edit 
new student record

Cancel new student 
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Except when the box, USE STUDENT ID FOR CASEMIS is checked in 
Preferences, the SELPA Manager uses the student record number for 
reporting purposes, when exporting students to the State Department of 
Education.

In the current version of SELPA Manager, the record number uses 7 digits 
for the district number, 5 digits for the sequence number, and four digits for 
the site number (“7-5-4”). Versions of SELPA Manager prior to v.4.60 used 
a record number of the format, “7-7-2”. If you are a SELPA Central user, 
you may still have some students with this record number format, which 
may have been imported from other program users.

[Student]Student_ID 
This number is a long integer, which increases monotonically for each new 
student added to the program (regardless of district, etc.). The Student_ID 
number appears between square brackets (e.g., “[5]”), in the lower left 
corner of the data entry form, along with the created/modified information. 
Fig. 7-3 displays the information at the lower-left corner.

Fig. 7-3. The [Student]Student_ID field appears between brackets (“[5]”), along with 
record selection and created/modified information.

[Student]Student_number 
In addition to the two identification numbers that the program assigns 
automatically, there is a third identification number that is user-assigned.



This third, optional identification field for students is labeled as the “ID” on 
the data entry form (Fig. 7-1, just below the record number). This field is 
editable by the user. If the box, USE STUDENT ID FOR CASEMIS, is 
checked in Preferences, then the program uses this field instead of the record 
number when exporting students to the State Department of Education

Adding a new student

To add a new student to the program (from the browse window):

1 Display the list of students in the browse window.

If the browse window is not already displaying students in either the upper 
or the lower list, then press the STUDENTS button.The browse window will 
switch to the Students context, where students appear in the upper list.1 

If the browse window is already displaying students and you did not change 
to another context, ensure that the focus is on the list containing student 
record information before continuing.

If you have not yet entered any students, or if you have specified in 
Preferences that the browse window should initially display no records, then 
the student list will be empty (refer to “Browse window initial display 
options:” on page 296).

Otherwise, you will see student record information (Fig. 7-4). You can also 
use the horizontal scroll bar to view additional columns of student 
information.

1. Fig. 3-43 summarizes the browse window display modes (contexts), showing which
records appear in each context. Refer to “The data entry cycle” on page 241.
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Fig. 7-4. The SELPA Manager browse window, showing the Students context.

2 From the Data menu, select New record.

SELPA Manager will display a dialog, asking you to select a district for 
incorporation into the new student’s record number (“Select district for 
record number prefix...”, Fig. 7-5). 

NOTE: If you have designated one district as My District (refer to the 
Chapter, “Entering Districts and Schools” on page 312), then the program 
will not display the district selection dialog. In this case, skip Step 3 (the next 
step).

If you have checked the “Transportation only” box in Preferences (refer to 
the Chapter, “Configuring SELPA Manager” on page 299), then the New 
record item in the Data menu will be dimmed. You must un-check 
“Transportation only” before you can add new student records. Refer to 
“Transportation-only data form” on page 412.



Fig. 7-5. Dialog for selecting the district for the record number prefix, when adding a 
new student.

3 Select a district for the new student’s record number, then press OK.

The selected district will be the new student’s district of residence.

The program will now open a blank data entry form, for a new student. This 
form has thirteen individual tabs or pages (Fig. 7-6). Initially, the program 
displays the General tab.

4 Enter information for the new student.

Data entry areas that must be completed to save the record have labels that 
are underlined on the form. At lower right on the form is a list of 
missing/problem items that have yet to be completed or that must be 
corrected to save the record. As you enter information into the fields, this list 
should diminish in length. When there are no “problem” items listed, the 
SAVE button at the bottom of the form will changed from disabled to 
enabled.1

1. The SAVE button will always be enabled if the DNR box is checked on the form.
The DNR box is discussed in the next section. Items in the “missing/problem item(s)”
list that start with “WNG:” are warning messages only, and do not prevent the record
from being saved. Also refer to “Saving records” on page 238.
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Fig. 7-6. Data entry form for a student, first (General) tab.

5 After completing the student data entry form, press the SAVE button. 

The program will save the new student record. If the “Add new record loop” 
option is turned on in Preferences, then the program will display a new, 
blank form for the next student to be entered (refer to the Chapter, 
“Configuring SELPA Manager” on page 293).

If you do not have the “Add new record loop” preference activated, but you 
wish to add another student, then repeat the instructions from Step 2 onward.

General (Student Tab 1)
Here are the data entry areas for Tab 1 (General) of the student data entry 
form, as they appear from left to right and top to bottom. The student record 
number (display only, assigned by the program) appears just to the left of the 
first enterable area.

[rev. 1.14.2003]

• Last – Student’s last (family) name.

• First – Student’s first name.



• DNR (Do Not Report, check box)

When this box is checked, the program excludes the student from student-
level data exports to the Department of Education (CASEMIS exports). 
Checking this box will also allow a student record to be saved, regardless of 
whether or not some required fields are incomplete.

• Mark (check box)

A check box (Boolean) field provided for your convenience (to find marked 
students). The program does not use this field for any other purposes.

• ID

Student’s identification number. A locally-used identification number or 
code for the student, up to 20 characters in length. This field is optional; the 
program maintains its own key fields to identify each student (refer to the 
discussion of “Student identification numbers” on page 359). If you have 
checked the “Use Student ID for CASEMIS” option in Preferences 
(page 269), however, SELPA Manager will use the ID number rather than 
the student’s record number as the keying field for the CASEMIS export.

If you enter something into the student ID field, it must be unique; the 
program will not allow you to enter a number/code used for another student 
record.

• SSN – Student’s Social Security Number (digits only). 

This number must be either unique for the student or left blank; the program 
will not allow you to enter a number that is assigned to another student.

• CSIS

The California School Information Services (CSIS) 10-digit identification 
number for the student (digits only). This number must be either unique for 
the student or left blank; the program will not allow you to enter a number 
that is assigned to another student.

• Name type (with pop-up list)

The type of name that is entered for the student (alias or legal name).

• DOB (date of birth, date field) – Student’s date of birth. 

Enter digits only, including all 4 year digits.
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• Vfy (coded1, with drop-down list, restricted2; plus a conditional, 80-
character “other”-type field)

The means used to verify the student’s date of birth. Enter the 1-digit code 
or the description. If “Other” is selected as the verification method, then the 
field to the right of the pop-up is unlocked for entry of further explanation.

• Age (button; display-only field; and display-only information)

The AGE button calculates the student’s age from the date of birth to the 
“Age calcs. fm.” reference date (or, if the latter is empty, to the Report As Of 
date) that is set in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 257). The result is displayed immediately to the right of 
the button as a whole number, in the calculated age field.

SELPA Manager also displays the student’s age in months and years, just to 
the right of the calculated age field. This information is not stored with the 
student record; instead, it is refreshed whenever you first display the student, 
or press the AGE button. If “Student’s age today” is checked in Preferences 
(refer to the Chapter, “Configuring SELPA Manager” on page 300), then the 
age in months and years will be based upon the current date, rather than the 
“Age calcs. fm.” reference date.

• M/F – Gender of the student (male “M” or female “F”).

NOTE: At the point that you have entered last name, date of birth, and 
gender for the student, the program performs a background search to find 
any other students with the same last name, date of birth, and gender. If the 
program finds any other students, it will alert you to this fact to reduce the 
likelihood of duplicate entries for the same student.

• Lives with (with pop-up list)

The person with whom the student lives (parent, guardian, etc.). This 
optional field is not the same as the required “residence” entry area of the 
Demographics tab (refer to page 377). If desired, you can use the “Lives 
with” field to provide additional specificity, beyond the CASEMIS 
residence codes used for the “residence” entry area.

• Recall (recall date, date field)

1. For more information on coded data entry, refer to “Data entry areas for coded information”
on page 234.
2. In other words, you are restricted to selecting among the choices on the drop-down list.



A reminder date, for your convenience. Clicking the small button to the right 
of the field will place the date on the Calendar.

• MediCAL __Eligible __Sent 

Two Boolean fields for indicating the student’s status with respect to the 
state MediCAL program. SELPA Manager can generate an export of student 
records, which can be sent to the state to evaluate the students’ eligibility for 
MediCAL. After the export is finished, SELPA Manager will automatically 
stamp the export records so that the __Sent box is checked.

• Student contacts (list, with ADD and DELETE buttons)

A list of contact information for the student (home address, mailing address, 
work contact, emergency contact, etc.). Each student contact is a record in 
the [Student Contact] table. For instructions on adding and editing contacts, 
and a description of the contact fields, refer to “Student contacts (list).” on 
page 371.

• QR (button) 

Allows you to clone (copy) information from one or two listed student 
contacts, for use with the Quick Report Editor when printing a [Student] 
report. Highlight the contact in the student contacts list, then press the QR 
button. SELPA Manager will copy the selected name and address 
information into a special set of “QR_” fields in the student record. 

The copied contact information will also appear to the right of the button, 
for display only. When printing a selection of student records in the Quick 
Report Editor, you will be able to select the contact information from the 
fields that are prefixed with the phrase “QR_” (Fig. 7-7). 

If you [SHIFT]-click on the QR button, then SELPA Manager will copy the 
selected contact information into a second set of fields (“QR2_”) in the 
student record.

To remove the contact from the “QR_” and “QR2_” fields, [ALT/OPTION]-
click on the QR button.
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NOTE: Copying contact information into the Quick Report fields does not 
save or delete the contact record itself. Updating the student contact 
record(s) does not automatically update the “QR_” and “QR2_” field 
contents for the student.

• Plan status (with pop-up list, restricted)

The student’s SELPA plan status (initial, interim, or none). If the 
compliance date field is blank or the student record is new (as yet unsaved), 
then changing the contents of this area will cause the date to recalculate. 

Selecting a status of initial will set the compliance date to today’s date plus 
50 days. Selecting a status of interim will set the compliance date to today’s 
date plus 30 days. Selecting a status of none or leaving the status blank will 
set the compliance date to a blank date (00/00/00).

Remember, the SELPA plan status only affects the compliance date when 
the date is blank, or when the student record is new.

• Comply by (button); Compliance date (display-only field)

The COMPLY BY button calculates the compliance date, based on today’s 
date and the student’s SELPA plan status. 

Fig. 7-7. When a student contact is copied 
into the “QR_” or the “QR2_” fields, the 
contact information then becomes 
available when generating a student report 
in the Quick Report Editor.



Holding down the [ALT/OPTION] key and clicking on this button will clear 
the compliance date. [SHIFT]-clicking on the button allows you to enter a 
specific date manually, without performing the 30-plus or 50-plus days 
calculation. A small, rectangular button to the right of the compliance date 
allows you to add the compliance date to the Calendar.

• Plan type (with pop-up list, restricted)

Type of special education plan to be designed for this student (IEP, IFSP, 
etc.).

• Case mgr.

A person who is responsible for managing the student’s special education 
program. This person must be listed in the Teachers section of SELPA 
Manager. If you enter a name that is not listed, then the program will offer 
to create the listing.1

Student contacts (list). 

This list allows you to add as many contacts (names and addresses) for a 
student as you would like. For example, you might have separate home and 
mailing addresses, work and emergency contacts, etc. 

To add a new contact, press the ADD (+) button to the left of the contact 
list. The program will display an add contact form(Fig. 7-8). 

At a minimum, you must enter some information into the contact name and 
the address type fields (otherwise, the SAVE button will be dimmed). When 
you save the contact, the add contact form will close and the new contact 
will be added to the contact list.

1. This feature appeared in v.4.62 and later of SELPA Manager
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Fig. 7-8. The add contact form, which appears after pressing the ADD (+) button on 
Tab 1 (General) of the student data entry form.

NOTE: The add contact form is a modal dialog. You must either press SAVE 
or CANCEL to close this form, before you can return to the student data 
entry form.

To edit a contact from the listing on Student Tab 1, double-click into the cell 
on the list that you wish to edit. To add a new contact in place (directly into 
the table, without opening the add contact form), [ALT/OPTION]-click on 
the ADD (+) button. The new contact will appear listed in the table, ready 
for editing.

NOTE: If another listed contact is highlighted when you add a contact in 
place, then the new contact will be a clone (copy) of the highlighted contact.

To delete a listed contact, highlight the contact that is to be deleted, and 
press the DELETE (-) button.

To obtain field-level audit information on a contact, highlight that contact 
row and press the Audit (Au) button. 

NOTE: To access audit information using this button, you must be a member 
of the “AdminGroup” access group. For the audit information itself to be 
collected and thus available to program users, the Audit trail option must be 
checked in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 270).



List of student contact data entry areas:

• Contact name – Name of the contact person.

• Student resides here (check box) – Indicates that the contact record 
represents the student’s home address.This address is used for certain 
printed forms; for example, the default IEP verification sheet uses this 
address (if available) for the parent/guardian name and address. A student 
record can have only one address with this box checked.

• Address type (with pop-up list) – Nature of this contact (work, home, 
emergency, etc.). If there is more than one emergency contact, the default 
IEP verification sheet sorts them by address type and selects the first one 
to print onto the form, under “Emer. name” and “Emer. phone.”

• Relationship (with pop-up list) – The nature of the relationship of the 
contact to the student (parent, guardian, aunt, etc.). If a student has no 
contact with the Student resides here box checked, then the default IEP 
verification sheet uses the contact with a relationship of “Guardian” as 
the parent/guardian name and address. The IEP form also looks for a 
“Guardian 2” relationship for the second printed address (“2nd 
Parent/Guard”).

• Address / City / State / Postal Code (5 entry areas) – Address 
information for the contact. The keystroke [CTNRL/CMD]-L will move 
the cursor directly into the postal code area. If you have imported Zip 
codes into SELPA Manager, and you enter a Zip code that it recognizes, 
then the program will enter the corresponding city and state, provided 
that these target areas are empty. Also, if the telephone fields are empty, 
and the program finds an Area Code corresponding to the Zip code, it will 
enter the Area Code into the home and work telephone numbers.

• Tel (h) / Tel (w) / Ext. / Tel 3 / Type / Tel 4 / Type / Tel 5 / Type (9 entry 
areas; Type has a choice list) – These entry areas hold home, work, and 
other telephone numbers for the contact. The telephone number entry 
areas are set to display the standard, 10-digit, area code plus phone 
number format. Therefore, you need enter only the digits. After the last 
digit is entered, the cursor automatically moves to the next field (without 
using the [TAB] key).

The buttons to the left of the telephone numbers will dial the number, 
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provided that you have configured modem dialing in the Preferences 
dialog. If you [ALT/OPTION]-click on the button, you can clear the 
contents of the telephone entry area.

NOTE: When editing the telephone numbers of existing contact(s) (in place, 
on the list), phone number formatting will not display until you exit the 
modified telephone number cell, and the program is able to save the 
changes.

• email 1, email 2 – Electronic mail addresses for the contact (up to 80 
characters each).

• Note – Miscellaneous information concerning the contact (up to 80 
characters).

Demographics (Student Tab 2)
Fig. 7-9 illustrates Tab 2 (Demographics) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. Descriptions of the data 
entry areas, as they appear from left to right and top to bottom, follows 
immediately.

[rev. 1.14.2003]

• Grade level (coded1, with pop-up list, restricted) – The current scholastic 
grade level of the student. Enter the 2-digit grade code, the grade 
description, or select from the pop-up list.

• WorkAbility pgm. (checkbox) – Indicates that the student is 
participating or has participated in the WorkAbility program during the 
school year. 

• CAC mailing (check box) – The parent/guardian has requested 
information on the Community Advisory Committee, a group that 
consists (in part) of the parents of special education students.

• Chapter 1 (check box) – A determination has been made that the 
student’s family qualifies for Chapter 1 funding, due to the family’s 
income level.

1. For more information on coded data entry, refer to “Data entry areas for coded in-
formation” on page 234.



Fig. 7-9. Data entry form for a student, second (Demographics) tab.

• Ethn (Ethnicity, coded, with 2 pop-up lists, restricted) – Student’s ethnic 
background, up to 6 allowed. Enter the 3-digit code, the description, or 
select from the pop-up menu, for one or more ethnicities. If there is more 
than one ethnicity, then the student’s primary ethnicity should be entered 
into the first (“1”) area. For each non-blank ethnicity specification, 
SELPA Manager will place a “>” sign following the ethnicity number in 
the first pop-up list (Fig. 7-10).

• Migrant ed. (checkbox) – Indicates that the student is eligible for 
participation or is participating in the migrant education program. A 
student attains this eligibility because the parents move across school 
district or state lines, in pursuit of their occupation(s).

• Transp. req’d. (check box) – Student requires transportation. This check 
box also appears on Tab 7 (Transportation). 

• Chapter 26.5 (checkbox, previously “AB 2726 (3632)”) – Indicates that 
a mental health agency has referred the student for special education 
services.
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Fig. 7-10. Ethnicity pop-up list, data entry form for a student, second (Demographics) 
tab. The “>” character indicates that the particular ethnicity listing is not blank.

• Home lang. (coded, with pop-up list, restricted) – Primary language 
spoken at the student’s home (home language). Enter the 2-digit code, the 
description, or select from the pop-up menu. If the “Student lang.” entry 
area is empty when the home language is selected, then SELPA Manager 
enters the home language into the student language area as well.

• ELL (checkbox) – Limited English proficiency (English Language 
Learner). Student’s home language is not English, and the student does 
not have the English-language skills necessary to succeed in the school’s 
regular education program. This box cannot be checked if the student’s 
(home) language is indicated as being English.

• FEP (checkbox) – Fluent English proficiency. Student is fluent in the 
English language. Checking this box will un-check the LEP box, and 
vise-versa.

• RIS (checkbox) – Requires intensive services.

• Interpreter (checkbox) – An interpreter is required for the student to 
participate in his/her assessment/evaluation meeting.

• Student lang. (coded, with pop-up list, restricted) – Student’s primary 
spoken language. Enter the 2-digit code, the description, or select from 
the pop-up menu. The student language can be different from the home 
language; however, if the student language is empty when the home 
language is selected, then SELPA Manager enters the home language into 
the student language area as well.



• Solely low (checkbox) – For infants only, indicates that the student has a 
solely low incidence disability. The program will object to this item being 
checked if the student is more than 2 years old (based on the “Age calcs. 
fm.” date).This box is disabled if the primary disability is not a low 
incidence disability (020-Hard of hearing, 030-Deaf, 050-Visual 
impairment, 070-Orthopedic impairment, or 100-Deaf-blindness).

• Low incidence (checkbox, display only) – When checked, indicates that 
the primary disability is a low-incidence one. SELPA Manager checks or 
clears this box, depending upon the selected disability. The following are 
low incidence disabilities: 020-Hard of hearing, 030-Deafness, 050-
Visual impairment, 070-Orthopedic impairment, 100-Deaf-blindness.

• IEP translation (checkbox) – Indicates that IEP forms need to be 
translated into another language for the student or the student’s 
parent/guardian.

• Transition lang. (checkbox) – Indicates that a transition service 
language has been included in the IEP for this student (the 
“TRAN_LANG” field in CASEMIS).

• Disability (coded, with pop-up list, restricted) – Student’s primary 
disability or handicap. Enter the 3-digit disability code, the description, 
or select from the pop-up menu.

• Residence (coded, with pop-up list, restricted) – Student’s CASEMIS 
residential status. Enter the 2-digit code, the description, or select from 
the pop-up menu. This field is not linked in any way with the “Lives with” 
field on the General tab (page 368).

• STAR (coded, with 2 pop-up lists, restricted) – Participation of the 
student in the last Statewide Testing and Reporting (STAR) program, for 
the current year (“This”) and, optionally, an alternate year (“Next”). 
Enter the 2-digit code, the description, or select from the pop-up menu. 
The alternate year STAR code can be transferred, to replace the current 
year code, when you select Actions menu -> “Change grade...” for the 
listed students in the browse window (refer to “Change grade...” on 
page 653).

• Alternate assessment (checkbox) – Indicates that the student 
participated in the statewide alternate assessment (for students with 
severe disabilities who did not participate in the STAR program). For this 
box to be checked, the STAR program status code must be either 30 (“NO 
- alternate assessment”) for Report As Of dates after June 30, 2001; or 90 
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(“NO - IEP exemption(s)”) for Report As Of dates on or prior to June 
30,2001. Any other STAR status will cause the program to add it to the 
list of missing/problem items.

• Foster/LCI # – The foster home or licensed care institution number, for 
the residence at which the student lives (if applicable).

Educational settings

• Infant (coded, with pop-up list, restricted) – Student’s infant setting 
(early intervention class, family child care, etc.). Enter the 2-digit code, 
the description, or select from the pop-up menu. The program will add a 
warning to the missing/problem items list1 if you specify an infant setting 
for a student that is more than 2 years old (based on the “Age calcs. fm.” 
date in Preferences), unless “No infant/preschool error checking when 
editing an existing student” is checked in Preferences. For additional 
information, refer to the Chapter, “Configuring SELPA Manager” on 
page 261.

• Preschool setting (coded, with pop-up list, restricted) – The program 
setting for preschool services. Enter the 2-digit code, the description, or 
select from the pop-up menu. Unless “No infant/preschool error 
checking...” is checked in Preferences, the program will add a warning to 
the missing/problem items list when you to select a preschool setting for 
a student that is not between 3 and 5 years of age (based on the “Age 
calcs. fm.” date in Preferences, refer to the Chapter, “Configuring SELPA 
Manager” on page 257).

• Phys. ed.(with pop-up list) – The type of physical education setting that 
is appropriate for the student.

Schools/districts

• Schl Attend (2 data entry areas, restricted2) – Student’s school of 
attendance. The first area is for the school code, and the second area holds 
the school name. However, you may enter either the code or the 
beginning of the school name into either area, and the program will 
attempt to complete both areas. 

To select from a list of all schools, type the wildcard character (“@”) into 
either data entry area, and then press the [TAB] key. To select from a list 
of all schools beginning with the letter “T” (as another example), type the 

1. Refer to “Saving records” on page 238.
2. Restricted to schools already in the schools section of SELPA Manager.



letter “T” and then press the [TAB] key.

After you have selected a school, SELPA Manager checks to see whether 
there is a designated default school type for the selected school (in the 
Schools section). If so, then the program automatically inserts the school 
type into the next data entry area (Type, see below).

If the school name or code that you specify is not listed in the Schools 
section, then SELPA Manager will disallow the entry.

• Type (coded, with pop-up list, restricted) – The type of school in which 
the student is enrolled or receives general education. Enter the 2-digit 
code, the description, or select from the pop-up menu. 

• Track – The student’s academic track, up to 2 alpha or numeric 
characters. This item prints on the default IEP verification sheet. There is 
an option, when printing teacher attendance registers, to separate the 
student services by school name and student track, rather than by class 
code and service code.

• Ext. yr: __d __min (Extended year, 1 checkbox and 2 fields) – When 
checked, the box indicates that the school of attendance for this student 
features an extended academic year. The two fields allow you to specify 
the number of days and the number of minutes in the extended academic 
year. Specifying either days or minutes automatically checks the box.

• % Mainstr. (Percent mainstreamed, numeric, range 0-100) – The 
percentage of instructional time that the student spends in regular 
educational programs, as opposed to special education programs.

NOTE: The program will allow you to specify a value of 100 to indicate full 
participation in regular education. The allowed range for export in the 
CASEMIS format is 0 to 99, however. Therefore, when exporting percent 
mainstreamed in the CASEMIS format, SELPA Manager converts entered 
values of 100 to an exported value of 99.

• % ORC (Percent outside regular class, numeric, range 0-100) – The 
percentage of instructional time that the student spends outside regular 
classes for special education.This setting applies to students age 6-22, or 
who are in kindergarten or a higher grade. If the student’s grade is infant 
or preschooler, or if the student’s calculated age (based on the “Age calcs. 
fm” date in Preferences) is not in the 6-22 range, then SELPA Manager 
will create an error in the missing/problem items area.
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• Schl Resid (2 data entry areas, restricted) – Student’s school of residence. 
The first area is for the school code, and the second area holds the school 
name. However, you may enter either the code or the beginning of the 
school name into either area, and the program will attempt to complete 
both areas. 

If the school name or code that you specify is not listed in the Schools 
section, then SELPA Manager will disallow the entry.

• Dist Resid (2 data entry areas, for district code and name) – The student’s 
district of residence. The program accepts either the code, which must be 
seven numeric digits, or the district name. If your entry is not found in the 
Districts section of SELPA Manager, then the program will offer to add 
the district as a new record.

When you add a student to the program by selecting New record from the 
Data menu, SELPA Manager prompts you to select the district of 
residence. When the new student data entry form opens, these areas 
should already contain the district of residence code and name.

NOTE: (1)Changing the district of residence will not change the student 
record number, the prefix of which is based upon the district of residence 
code. Users with “ReadWriteGrp” access group privileges can change the 
record number prefix for a student by performing an internal transfer (refer 
to “Transfer...” on page 567). (2) There is not a separate district of service 
field in SELPA Manager; the district of service for CASEMIS reporting 
purposes is obtained from the school of attendance for the primary student 
service.

• Schl Prev (previous school) – The name of the school that the student 
previously attended. You may enter any text, up to 30 characters. This 
data entry area does not perform searches for school codes or names, and 
the entry does not have to exist already in the Schools section.

• Fm. (From SELPA) – The 4-digit code for the SELPA from whence this 
student came. From the browse window, when you select New record 
(Data menu) to add a new student, SELPA Manager inserts your SELPA 
code, as specified in Preferences, into this area. This area does not 
perform searches for SELPA codes or names. 

• Previous record number (display only, no title shown) – The student’s 
previous identification number, for CASEMIS reporting purposes. This 
area will be empty, unless the student has been imported into SELPA 



Manager using one of the following two methods: (1) a district-to-district 
transfer, where the previous district exported the student using SELPA 
Manager; or (2) a CASEMIS-format import, where the previous district 
exported the student in a CASEMIS format that SELPA Manager was 
able to import.

This field also appears on Tab 12 (Notes / dups) of the student data entry 
form, refer to page 412.

Dates (Student Tab 3)
Fig. 7-11 illustrates Tab 3 (Dates) of the student data entry form. Certain 
items, such as the student record number and name, and the DNR and Mark 
check boxes, are carried over from Tab 1. Descriptions of the data entry 
areas, as they appear from left to right and top to bottom, follows 
immediately.

Fig. 7-11. Data entry form for a student, third (Dates) tab.

• Dates (button) – Resets all date entry areas on Tab 3 to a null value 
(“00/00/0000”). You can also reset date areas individually by clicking 
into them and pressing the [BACKSPACE] key, until all digits are zero.
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• Infant referral (date) – The date of referral to assess the student’s 
eligibility for special education services. Applies to infants only (ages 0-
2). Entering a date here for a non-infant will cause the program to add a 
warning to the list of missing/problem items, unless “No infant/preschool 
error checking when editing an existing student” is checked in 
Preferences (refer to the Chapter, “Configuring SELPA Manager” on 
page 261).

• Original entry (date) – Date that the student originally entered special 
education. The program will warn you if the date you select does not 
appear to be in the past, based on today’s date on the computer clock. If 
original entry date is still null (“00/00/0000”) when you enter the Last 
IEP date (see below), then the program will assign the Original entry date 
to be the Last IEP date.

• Evaluation: Plan (date) – The date on which the student’s special 
education entry evaluation is scheduled to be performed. Clicking the 
small button to the right of the field will place the date on the Calendar.

• Evaluation: Waiver (date) – The date on which the student’s parent 
gives permission to reschedule the entry evaluation.

• Evaluation: Actual (date) – The date on which the student’s special 
education entry evaluation is actually performed.

• Evaluation: Term (date) – The date on which the student’s special 
education entry evaluation is considered to be complete.

• Infant transition mtg. (date) – The date of the transition planning 
meeting for an infant (ages 0-2 years). Entering a date here for a non-
infant will cause the program to add a warning to the list of 
missing/problem items, unless “No infant/preschool error checking when 
editing an existing student” is checked in Preferences (refer to the 
Chapter, “Configuring SELPA Manager” on page 261).

• Last IEP (date) – The date of the student’s last IEP (annual) meeting. The 
program will warn you if the date you select does not appear to be in the 
past, based on today’s date on the computer clock. 

If the Original entry date is blank(“00/00/0000”) when you enter the Last 
IEP date (see below), then the program will assign the Original entry date 
to be the Last IEP date. 

If the Next IEP date is blank, then the program will assign it to be the Last 
IEP date, plus one year. If the Next evaluation date is blank, then the 



program will assign it to be the IEP date, plus three years.

If the Last IEP date is more than one year before the Report As Of date, 
then a warning will appear in the list of missing/problem items at lower 
right (“WNG: Last IEP not within 1 yr”). If the Last IEP date is after the 
Report As Of date, then the box will contain the message (“WNG: Last 
IEP after As Of”). The presence of these warning messages does not 
prevent the student record from being saved, however.

• Other (date) – The date of another type of assessment meeting (not the 
IEP meeting or evaluation meeting).

• Next IEP (date) – The date of the student’s next scheduled IEP (annual) 
meeting. The program will warn you if the date you select does not 
appear to be in the future, based on today’s date on the computer clock. 
Clicking the small button to the right of the field will place the date on the 
Calendar.

• Last evaluation (date) – The date of the student’s last (triennial) 
evaluation (also known as the last assessment, or last 3-year evaluation). 
The program will warn you if the date you select does not appear to be in 
the past, based on today’s date on the computer clock. 

• Next evaluation (date) – The date of the student’s next scheduled 
(triennial) evaluation (also known as the next assessment, or next 3-year 
evaluation). The program will warn you if the date you select does not 
appear to be in the future, based on today’s date on the computer clock. 
Clicking the small button to the right of the field will place the date on the 
Calendar.

• Transferred (date) – The date on which the student transferred to another 
school district. SELPA Manager can automatically enter a date into this 
field when a batch of students is transferred (exported) to another district 
(File menu -> “Transfer...”, refer to page 567). The transfer date can be 
used to exclude students from district-to-central exports, and from 
CASEMIS reports.

Services (Student Tab 4)
Fig. 7-12 illustrates Tab 4 (Services) of the student data entry form. Certain 
items, such as the student record number and name, and the DNR and Mark 
check boxes, are carried over from Tab 1. 
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There are only two other data entry areas on the Services tab – a list of 
student services with associated control buttons, and a word processing area 
in the lower-left corner of the form.1

Fig. 7-12. Data entry form for a student, fourth (Services) tab.

Student services (list)

This list allows you to add services (special education services provided at 
a particular location) for a student.

To add a new student service, press the ADD (+) button to the left of the 
services list. The program will display an add service form(Fig. 7-13). 

1. The word processing area will not appear if you are on a multi-user version of SELPA Man-

ager that does not have a sufficient number of 4D Write licenses available.



At a minimum, you must complete the data entry areas that are underlined 
(teacher, school, service, and start date). Otherwise, the SAVE button will be 
dimmed. When you save the service, the add service form will close and the 
new service will be added to the list.

NOTE: The add service form is a modal dialog. You must either press SAVE 
or CANCEL to close this form, before you can return to the student data 
entry form.

To edit a listed service, double-click into the cell on the list that you wish 
to edit.

Fig. 7-13. The add service form, which appears after pressing the ADD (+) button on 
Tab 4 (Services) of the student data entry form.

To add a new student service in place (directly into the table, without 
opening the add service form), [ALT/OPTION]-click on the ADD (+) 
button. The new service will appear listed in the table, ready for editing. As 
a default, SELPA Manager assumes that the start date for a service added in 
place is today.

NOTE: When adding a service in place, or when editing an existing service, 
the pop-up choice list for the teacher or the school column may be empty if 
there are more than 200 possible selections of teachers or schools, 
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respectively (Windows versions only). The selection of available schools and 
services in the pop-up choice lists does not change to conform with the 
available assignments for a selected teacher.

Add service form, data entry areas:

• Teacher – Name of the teacher that is/will be providing the special 
education service to the student.You may enter the beginning of the 
teacher’s name or a teacher code, and the program will attempt to 
complete the entry when you [TAB] out of the data entry area. Enter just 
the wildcard character (“@”) and then [TAB], to obtain a complete list of 
teachers. You can also enter a telephone number or a postal code for the 
teacher, and the program will either find a teacher or present a list of 
potential matches. To be entered here, the teacher must be listed first in 
the Teachers section of the program (refer to the Chapter, “Adding Staff 
and Related Information” on page 328).

If the check box, “Limit student services to active teacher assignments” 
is checked in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 273), then SELPA Manager will first verify that the 
selected teacher has active assignments (in any subject, at any school). If 
not, then the program will display an error message, indicating that the 
teacher cannot be selected.

Suppose that you have already selected a teacher, a school, and a service 
for the student, and then decide to change to a different teacher.1 If “Limit 
student services...” is checked in Preferences, then SELPA Manager will 
verify that the teacher has an active assignment in the selected topic, at 
the selected school. If not, then the program will display an error 
message, indicating what active assignments are available for the new 
teacher at the selected location.

If “Limit student services...” is checked in Preferences, then SELPA 
Manager will also populate the choice lists for services with the names 
and codes of services for which the teacher has active assignments. 
Similarly, the program will populate the schools choice list with only 
those schools at which the teacher has active assignments.

1. This circumstance could also occur when changing the teacher for an existing ser-
vice, although it would not occur on this particular form (which is for new services
only). The data entry form in the Services section has an appearance and behaviors
similar to the add service form.



If “Limit student services...” is not checked in Preferences, then the 
services choice lists will contain all services, and the schools choice list 
will be empty (to conserve memory).

If the selected teacher has a default service designated in the Teachers 
section of the program, then SELPA Manager will enter that service code 
and name (below). For more on default services, refer to the Chapter, 
“Adding Staff and Related Information” on page 337.

• Primary service (check box) – Indicates that the service is the student’s 
primary service. Each student record should have exactly one active (not 
dropped) primary service, generally the main service being provided as a 
result of the student’s disability. Usually, the primary service is also the 
service that is provided for the longest amount of time.

If you check a service as being the primary, SELPA Manager will search 
for other active primary services1 for this student. If one is found, then 
the program will present an error message, and uncheck the box.

• School (with pop-up list, restricted; and display-only school code) – The 
name of the school where the teacher is providing the service. To be 
selected here, the school must first be listed in the Schools section of the 
program (refer to “School entry” on page 317). After selecting the school, 
the school code will appear in a display-only box, immediately to the 
right.

You must first select a teacher for the service, before the program will 
allow you to select the school. After selecting the teacher, if “Limit 
student services...” is checked in Preferences, then the pop-up list for 
School will contain just those schools at which the teacher has active 
assignments.

Suppose that you have already entered a teacher, a school, and a service, 
and then change to a different school. If “Limit student services...” is 
checked in Preferences, then the program will verify that the teacher has 
an active assignment for the service at the new school. If not, SELPA 
Manager will display an error message and revert to the previous school 
name.

1. SELPA Manager searches for another primary service for the student, that has no
drop date. A more comprehensive set of criteria for an “active primary” service applies
in other circumstances, such as the transportation summary report (refer to the Chapter,
“File Menu Operations” on page 589).
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• Service (2 data entry areas, each with pop-up lists, restricted) – The 
CASEMIS service code and the name for the service to be provided for 
the student. You can enter either the code or a portion of the service name 
into either field, and the program will attempt to complete both data entry 
areas. 

If you choose to enter the CASEMIS service code, you may use either the 
“old” 3- or 6- digit code used prior to the 2001-2002 academic year, or 
the “new” 2-digit code. If you enter the service name (or a portion 
thereof), be sure that you use the “new” name — even if the teacher 
assignment is listed with the “old” service description in the Assignments 
section. Otherwise, SELPA Manager won’t find the service.

You must first select a teacher for the service, before the program will 
allow you to select the service. After selecting the teacher, if “Limit 
student services...” is checked in Preferences, then the two pop-up lists 
for services (service name and service code) will contain just those 
services for which the teacher has active assignments.

If you select some other, valid service, then the program will display an 
error message, indicating that the teacher has no active assignments for 
that service. The message may display other services (and locations, if 
the school has not been specified) for which the teacher has active 
assignments.

To select some other service, either turn off the “Limit student services...” 
setting in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 273) or create an appropriate assignment for the 
teacher, at the school (refer to the Chapter, “Adding Staff and Related 
Information” on page 327).

• Start (date) – The date on which the student service begins. The start date 
cannot be prior to the original start date, or after the drop date. Clicking 
the small button to the right of the field will place the date on the 
Calendar.

• Minutes/session (number) – The duration of a session of the student 
service, in minutes. When writing infant services in the CASEMIS 
reporting format, the program uses this number for the state’s 
“DURATION” field.

• Sessions/week (number) – The total number of sessions provided each 
week, for the student service. 



• Class – A code (up to 5 characters) for the class in which the service is 
provided. When printing attendance registers for the teacher’s provided 
services, under the default option, the forms can be separated by class 
code and service code.1

• Disab. cond.(with pop-up list, restricted) – The disabling condition 
(handicapping condition) for a primary service. Cannot be selected for a 
non-primary service.

For SELPA 3702 (North Coastal), if the value of “MR-MILD”, “MR-
MODERATE”, “MR-SEVERE” or “SH” is entered for the disabling 
condition on the active primary service, then the assessment (IEP) form 
for the student will have “Mild”, “Moderate”, “Severe”, or “Severe” 
checked (respectively).

• Isolated site (check box) – Indicates that the site where the service is 
being provided is geographically remote.

• Do not report (check box) – Indicates that the service should not be sent 
to the state Department of Education, as part of the CASEMIS export. 
Likewise, the program skips over student services that are marked “Do 
not report” when determining which student records are eligible for the 
export.

When you continue a student service, the program will stamp the old 
(discontinued) service as “Do not report” (refer to “Student service list 
controls” on page 391).

NOTE: Both student and service records have a check box for “Do not 
report” (DNR). The student DNR box allows the Student record to be saved 
without completing all required data entry; however, the service DNR box 
does not have the same save-enabling effect.

• Regional SDC (check box) – Indicates that the student is receiving the 
Special Day Class service2 at a regional center rather than at a local 
center. This box can be checked for a primary service of CASEMIS Code 
430 or 41 only.

• Aux. code (auxiliary code, with pop-up list) – An alternate description for 
the special education service being provided, up to 80 characters. You can 
change the choice list items for this entry area by editing the “Aux service 
code” list on the System 1 tab of the Preferences dialog (refer to the 
Chapter, “Configuring SELPA Manager” on page 243).

1. The other option is to separate by school name and student track, refer to page 599.
2. CASEMIS Code 430 in the “old” codes or Code 41 in the “new” codes.
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Each auxiliary code can have associated cost parameters. These 
parameters can be used to generate chargeback reports (Actions menu > 
District chargeback..., when Districts have the current focus in the 
browse window). Chargeback reports may be useful when the location 
for the special education service is not within the student’s normal district 
of service. For example, services that a student receives at a central, 
special education facility can be charged back to the district.

• Aux. svc. loc. (auxiliary service location) – An alternate description for 
the location where the service is being provided. This field may be useful 
to SELPAs that operate “county-served” programs. The contents of this 
field are not part of the CASEMIS reported information.

• Sess. note (session note) – Note pertaining to the service or session(s), 
max. 80 characters.

For SELPA 3702 (North Coastal) only, the information in this field is 
used to complete the “Location” column on the first page of the IEP form. 
Additionally, if the field contents begin with text enclosed by square 
brackets (e.g., “[text]...”), then SELPA Manager will print the bracketed 
text as the frequency of service, rather than using the default value of “per 
wk”.

• Original start (date) – The date on which the service originally started. 
The original start date cannot be after the service start date, or after the 
drop date.

When you continue a service, the program will insert the start date of the 
original service into the original start date field of the newly-created 
service (refer to “Student service list controls” on page 391).

When selecting students eligible for the CASEMIS report, the program 
considers active (not dropped) primary services that start before the 
Report As Of date, or that have an original start date that is before the 
Report As Of date.

• Drop (date) – The date on which the service ends. This area should be 
null (“00/00/0000”) for an active (current) service. The drop date cannot 
occur before the original start or the start date.



• Evaluation (date) – A date on which the service is evaluated in regard to 
the student’s needs and progress. May not precede the original start or the 
start dates. On some of the assessment/IEP forms, the evaluation date 
appears as the “end” date column in an instructional settings/services 
table.

• Infants only: Agency (coded entry, with pop-up list, restricted) – The 
name and code for the agency that provides a Designated Instruction 
Service (DIS) or related service to an infant. Example agencies include 
the Department of Rehabilitation, the Department of Social Services, etc. 
Enter the 2-digit code, the agency description, or select from the pop-up 
menu. 

• Infants only: Location (coded entry, with pop-up list, restricted) – The 
location where an infant-related service is provided. Examples include 
Home, Hospital, Residential Facility, etc. Enter the 3-digit code, the 
location description, or select from the pop-up menu. 

• Infants only: Frequency (coded entry, with pop-up list, restricted) – The 
frequency with which an infant-related service is provided. Examples 
include Daily (2x per day), Weekly (2x per week), etc. Enter the 2-digit 
code, the frequency description, or select from the pop-up menu. 

• Drop reason (primary) (2 data entry areas, each with pop-up lists, 
restricted) – The reason code and the reason that the service was 
discontinued. Enter the two-digit code, the drop reason, or select from the 
pop-up menu. The program will complete the other area. For primary 
services only.

• Drop reason (non-primary) (2 data entry areas, each with pop-up lists) 
– The reason code and the reason that the service was discontinued, for 
non-primary services only. Enter the two-digit code, the drop reason, or 
select from either pop-up menu. The program will attempt to complete 
the other area. You may use primary drop codes and reasons in these 
fields, if desired.

Because this set of entry areas does not limit you to using items on the 
pop-up lists, the program may not find the analogous description for the 
code that you enter, or vise-versa. In this case, the program will present 
an alert that the other entry area has not been changed.

Student service list controls
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There are 6 buttons adjacent to the list of student services on Tab 4 (Fig. 7-
14). These buttons allow you to add, remove, and change services on the list; 
and to check changes made to a highlighted service.

• Add (+) button – Press the Add button to add a new service record to the 
list. If the [ALT/OPTION] key is held down, the program adds the record 
directly in the list (double-click into cells to edit). Without the modifier 
key, the program displays the new service record using a modal add 
service form (Fig. 7-13, above).

• Delete (-) button – Remove one or more services.The services must be 
highlighted in the list before this button will function.

• Continue (Ct) button – Continues a service, by dropping the highlighted 
(“source”) service record and creating a duplicate (“continued”) service 
of the same type, with a different start date and no drop information. If 
the original start date of the continued (duplicate) service record is null 
(“00/00/0000”), then the start date from the source service becomes the 
original start date for the continued service.

The Continue button functions when exactly one service record is 
highlighted in the list (the service to be dropped). The button will work 
with source services that are already dropped; however, to avoid more 
than one primary service, the button will not continue a dropped primary 
service if the student already has another active primary service.

Fig. 7-14. Control 
buttons adjacent to the 
list of services, Tab 4 
(Services) of Student 
data entry form.



During the continuation process, the program will ask for a start date for 
the continued service. If the source service is not already dropped, the 
program will also ask for a drop date. If there is not a drop reason yet for 
the source service, then the program will use 76 (“Moved, known 
continuing”), for either primary or non-primary services. The program 
will also stamp the dropped service as “Do not report”. 

• Drop (Dr) button – This button drops one or more highlighted services. 
There must be at least one listed service highlighted for this button to 
function. The program will present a dialog (Fig. 7-15) asking you to set 
the drop date, to set the drop reasons for both primary and non-primary 
services, and to indicate whether services that are already dropped should 
be updated. 

Fig. 7-15. Drop service(s) dialog.

• Audit trail (Au) button – Enables you to check field-by-field changes 
that have been made to the service record. One service record must be 
highlighted before pressing the Audit trail button. You must be a member 
of the administrative users group (“AdminGroup”). Finally, for the audit 
information itself to be available, the Audit trail option must be checked 
in Preferences (refer to the Chapter, “Configuring SELPA Manager” on 
page 270).
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• Edit lists button – Allows you to create and edit non-primary drop 
reasons and disabling conditions, which appear in separate pop-up choice 
lists. A sample edit window appears in Fig. 7-16. If there are no user-
entered disabling conditions, then the program will display a default list 
of choices in the pop-up menu.

NOTE: Be sure that you save the Student record after editing the choice lists. 
Otherwise, the changes that you make to the lists will not be saved.

Fig. 7-16. Editing choice list items for non-primary drop reason.

Word processing area (4D Write)
A small word processing area is located at the lower-left corner of the 
Services tab (Fig. 7-17). The area allows you to create your own forms and 
other types of documents that make use of fields in the [Student] table. When 
you save the student record, the formatted text in the window is 
automatically saved to a field within the record. You can also save the 
document as a file on disk, using the miniature word processing menus (File 
> Save As...).



Fig. 7-17. Word processing area on Tab 4 (Services) for the Student record. The word 
processing ruler has been hidden to permit the text to be displayed (View menu > 
Ruler).

To enlarge the word processing area, click on the zoom box in the upper-
right corner. Fig. 7-18 shows the word processing area as a separate window, 
after clicking on the zoom box.

NOTE: If you have the multi-user version of SELPA Manager, you must have 
available 4D Write licenses installed on the server. The word processing 
area will not be available if there are more users connected to the program 
than there are 4D Write licenses. For more information, refer to the 
Chapter , “Configuring SELPA Manager” on page 243.

If you saved 4D Write documents with student records in previous versions 
of SELPA Manager (Version 4.6982 and earlier), and you then open these 
student records in Version 4.701 or later, then you may see an alert message 
asking whether the 4D Write document should be converted to a new format. 
The newer versions of SELPA Manager include a later version of 4D Write, 
which stores documents in the revised format. You can choose to either 
perform the conversion or leave the document in the earlier format; your 
selection will not impact the way that SELPA Manager works.
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Fig. 7-18. Word processing area on Tab 4 (Services), zoomed to become a separate 
word processing window. The ruler and two tool bars are shown; these items can be 
toggled on and off from the View menu.

IEP Notice (Student Tab 5)
Fig. 7-19 illustrates Tab 5 (IEP Notice) of the student data entry form. Tab 5 
contains entry areas that will appear on the printed IEP Notice form for the 
student.

Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The IEP Notice form provides notification of upcoming IEP meetings (and 
attendees). It can be printed and sent to the parents and/or guardians of the 
students.



Fig. 7-19. Data entry form for a student, fifth (IEP Notice) tab.

Descriptions of the data entry areas, as they appear from left to right and top 
to bottom, follows immediately.

• IEP date (date) – Date for the next scheduled IEP meeting. This date also 
appears on Tab 3 (Dates), as “Next IEP”. Clicking the small button to the 
right of the field will place the date on the Calendar.

• IEP time – Scheduled time for the IEP meeting. Rather than being in a 
numeric time format, this “time” is stored as plain text (up to 10 
characters).

• Purpose (1 entry area with pop-up) – Reason or purpose for the IEP 
meeting. When generating the default IEP notice or the SELPA 2700 
(Lake County) IEP notice form, the purpose may cause certain boxes to 
be checked on the printed form. 

For example, on the default form, the presence of the word “annual” in 
the IEP purpose field (when “triennial” is not present), or the presence of 
the words “existing eligibility”, will cause the second box to be checked 
(“review of existing eligibility, services, and/or placement”). 
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• Location – Location of the IEP meeting (building name, etc.)

• Copy program defaults (button) – Allows you to quickly paste the 
default IEP notification information from Tab 3 of the Preferences dialog, 
into the current student record (refer to the Chapter , “Configuring 
SELPA Manager” on page 243). If you have checked the “My Defaults” 
box in Preferences, then SELPA Manager will paste the defaults that you 
have entered as an individual, unless you hold down the [ALT/OPTION] 
key when clicking on this button. If you have not checked “My Defaults”, 
then SELPA Manager will paste the default IEP notice information 
established by the Administrator, which is common to all program users.

• Street – Street address for the IEP meeting.

• Regular teacher – Name of the student’s regular teacher.

• Sp. ed. teacher – Name of one of the student’s special education 
teachers.

• Psychologist – Name of the student’s psychologist (if relevant).

• Translator – Name of the student’s translator (if relevant).

• Nurse – Name of a nurse who has responsibility for the student (if 
relevant).

• Other 1 – Name of an interested party, who may attend the IEP meeting.

• Principal – Name of the school principal.

• Other 2 – Name of another interested party, who may attend the IEP 
meeting.

• Speech/language – Name of the student’s speech or language instructor 
(if relevant).

• Contact/title– Name and title of the person who is coordinating the IEP 
meeting arrangements.

• Address 1, Address 2, City, St., Zip, Phone – Information for 
contacting the person who is coordinating the IEP meeting arrangements.



Discipline (Student Tab 6)
Sometimes a special education student receives disciplinary actions that 
result in suspension or expulsion. Suspension or expulsion of a special 
education student be submitted to the state as part of the CASEMIS data. 
SELPA Manager provides a tab in the Student section of the program 
specifically for this purpose.

Fig. 7-20 illustrates Tab 6 (Discipline) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The Discipline tab consists of a list of disciplinary actions for the student, 
with associated control buttons for adding and deleting actions.

NOTE: You can also add disciplinary actions directly from the browse 
window, when the current browse context is “Discipline”, and the 
disciplinary action list has the current focus, by selecting New record from 
the Data menu. Refer to the Chapter, “Entering Disciplinary Actions” on 
page 471

Fig. 7-20. Data entry form for a student, sixth (Discipline) tab.
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To add a new disciplinary action, press the ADD (+) button to the left of 
the list. The program will create a new action (row) in the list, defaulting to 
a suspension. The cursor will be entered into the “Start on” date (second) 
column. Enter a date (as appropriate) and then use the [TAB] key to move 
among the other data entry columns.

Each disciplinary action row that you add must contain an action type 
(suspension or expulsion); a starting date; at least one (primary) reason for 
the action; the student’s status, and (for actions starting on or after 7/1/2001) 
a disciplinary authority.

To edit a listed disciplinary action, double-click into the cell on the list that 
you wish to edit.

To obtain field-level audit information on a disciplinary action, highlight 
that contact row and press the Audit (Au) button. 

NOTE: To access audit information using this button, you must be a member 
of the “AdminGroup” access group. For the audit information itself to be 
collected and thus available to program users, the Audit trail option must be 
checked in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 270).

Disciplinary actions, column list:

• Type (with pop-up list, restricted) – Type of disciplinary action 
(suspension or expulsion).

• Start on (date, with pop-up list) – Date on which the action is scheduled 
to begin.

• Days (number) – The duration in days of the disciplinary action.

• Incident date (date, with pop-up list) – The date on which the incident 
occurred or was reported.

• Code 1 (coded data, with pop-up list, restricted) – A code representing 
the primary student behavior or action leading to the disciplinary action.

• Reason 1 (coded data, with pop-up list, restricted) – The reason 
corresponding to the first code.

• Code 2 (coded data, with pop-up list, restricted) – A second (optional) 
code, representing the student behavior or action leading to the 
disciplinary action.



• Reason 2 (coded data, with pop-up list, restricted) – The reason 
corresponding to the second code.

• Code 3 (coded data, with pop-up list, restricted) – A third (optional) code, 
representing the student behavior or action leading to the disciplinary 
action.

• Reason 3 (coded data, with pop-up list, restricted) – The reason 
corresponding to the third code.

• ST code (coded data, with pop-up list, restricted) – A code representing 
the student’s current status.

• Student status (coded data, with pop-up list, restricted) – The student’s 
current status (corresponds to the ST code).

• Ath code (coded data, with pop-up list, restricted) – A code representing 
the authority responsible for handling the disciplinary action.

• Authority (coded data, with pop-up list, restricted) – The name of the 
authority responsible for handling the disciplinary action (corresponds to 
the Ath code).

• User 1 – A custom field that you can allocate for your own use (up to 80 
characters). You can change the name of this field from the disciplinary 
action data entry form, by clicking on the label box associated with the 
field (refer to the Chapter, “Entering Disciplinary Actions” on page 475). 
Once you have re-named the field, the column title will be the selected 
name, rather than “User 1”.

• User 2 – A custom field for your use (up to 80 characters). You can 
change the name of this field from the disciplinary action data entry form, 
by clicking on the label box associated with the field (refer to the Chapter, 
“Entering Disciplinary Actions” on page 475). Once you have re-named 
the field, the column title will be the selected name, rather than “User 2”.

• Comment (scrolling text area) – Other information concerning the 
disciplinary action (up to 32,000 characters).

• Modified on (2 columns, display only) – Date and time at which the 
disciplinary information was last modified.

• Modif. by (display only) – Log-on name of the last user that modified the 
disciplinary information.
Entering Students 401 

• 
• 
• 
•
•
•



402  

• 
• 
• 
•
•
•

Transportation (Student Tab 7)
Fig. 7-21 illustrates Tab 7 (Transportation) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The data entry areas on this tab concern the pick-up and drop-off 
requirements to move the student to and from special education classes. This 
information can be printed onto a Transportation Profile form for each 
student, by selecting Print from the File menu. Some SELPAs may have a 
custom, printed Transportation Profile form. However, the default form 
should still be available by checking the “Default form only” box, at the time 
that you print.1

Fig. 7-21. Data entry form for a student, seventh (Transportation) tab.

Descriptions of the data entry areas for transportation, as they appear from 
left to right and top to bottom, follows below. 

1. Contact Fusion Technik to develop custom print forms. If “Transportation only” is
checked in Preferences, then SELPA Manager uses the SELPA 3911 (Lodi) form, un-
less you override by checking the “Default form only” box at print time.



In addition to their presence here, certain data entry areas for student 
transportation are editable from a special, transportation-only data entry 
form (see “Transportation-only data form” on page 412). Only those fields 
below that are marked with an asterisk (*) are editable on the special form.1

• Req’d. (check box) – Indicates that transportation services are required 
for this student. This check box also appears on Tab 2 of the Student data 
entry form (page 375).

• Req. (with pop-up list) – Person or entity requesting the transportation 
services.

• Reason (with pop-up list) – Reason that transportation services are being 
requested for the student.

• Agency – The bus service (or other transit agency) which is responsible 
for providing the student transportation.

• Req. (date) – The date on which the transportation services were/are 
being requested.

• Start* (date) – The date on which the transportation services are to 
begin.Clicking the small button to the right of the field will place the date 
on the Calendar.

• Nfy P:* (date and character field) – The date on which the parent was 
notified of the transportation arrangements, and the name of the person 
(representing the parents) with whom contact was made. (Enlarging the 
window horizontally will cause the parent name field to enlarge for better 
visibility.)

• Sch:* (date and character field) – The date on which the student’s school 
was notified of the transportation arrangements, and the name of the 
person contacted at the school.

Special requirements (next 10 items):

• Lift (checkbox) – The student requires a lift-equipped bus to facilitate 
transport.

• Seat belt (checkbox) – The student must be seat-belted during transport.

• Harness (checkbox) – The student requires a harness during transport.

• Ticket (checkbox) – The student requires a ticket for transport.

1. If “Enhanced transportation-only form (more enterable fields)” is checked in Pref-
erences, then additional fields will be enterable on the transportation-only form. Refer
to the Chapter, “Configuring SELPA Manager” on page 272.
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• Wheelchair (checkbox) – The student requires a wheelchair during 
transport.

• CS (checkbox) – The student requires a car seat during transport.

• Vest (checkbox) – The student requires a supportive/restraining vest 
during transport.

• Aide (checkbox) – The student requires an instructional aide during 
transport.

• PT (checkbox) – The student physical therapy during transport.

• POP (checkbox plus data entry area with pop-up list) – Requirements, if 
any, specified for the student’s points of pick-up. “Hand to hand” means 
that a parent or teacher must physically assist the student in getting on 
and off the bus. “Supervised” means that the parent or teacher must be 
present, but that physical assistance is not required.

NOTE: Typing information into the data entry area will cause the box to 
become checked.

• Pick up at (time*, plus 5 check boxes M-F and an ALL button) – The 
time and specific days of the week at which and on which the student is 
to be picked up. Pressing the ALL button will cause all five days to be 
checked. 

NOTE: SELPA Manager stores the days checkbox information in a single, 
matrixed field called [Student]TR_pickup_days. For example, a student 
whose transportation information indicated pick-up days of Monday, 
Tuesday, Thursday, and Friday would appear in this field as “MTRF”.

• School starts (time) – Time of day at which school commences.

• Address* (button and field) – The street address (up to 80 characters) at 
which the student is to be picked up. If you have specified a “Student 
resides here” address among the contacts on Tab 1, then pressing the 
ADDRESS button will insert that address information for both the pick-
up and drop-off address fields (refer to page 373).

• City* – The city from which the student is to be picked up.

• Bus* – Number or code for the bus that is picking up the student.

• Xfer* – Number or code for a transfer bus (if any), for the pick up.



• Drop off at (time*, plus 5 check boxes M-F and an ALL button) – The 
time and specific days of the week at which and on which the student is 
to be dropped off after school. Pressing the ALL button will cause all five 
days to be checked. 

NOTE: SELPA Manager stores the days checkbox information in a single, 
matrixed field called [Student]TR_dropoff_days. For example, a student 
whose transportation information indicated drop-off days of Monday, 
Tuesday, Thursday, and Friday would appear in this field as “MTRF”.

• School ends (time) – Time of day at which school finishes.

• Address* (button and field) – The street address (up to 80 characters) at 
which the student is to be dropped off. If you have specified a “Student 
resides here” address among the contacts on Tab 1, then pressing the 
ADDRESS button will insert that address information for both the pick-
up and drop-off address fields (refer to page 373).

• City* – The city from which the student is to be dropped off.

• Bus* – Number or code for the bus that is dropping off the student.

• Xfer* – Number or code for a transfer bus (if any), for the drop-off.

• Sitter – Name of the student’s baby-sitter (if applicable).

• Phone (button and field) – Telephone number of the baby-sitter. Pressing 
the PHONE button will dial the number, provided that you have 
configured modem dialing in the Preferences dialog. If you 
[ALT/OPTION]-click on the button, you can clear the contents of the 
telephone entry area.

• Address – Street address of the baby-sitter (up to 80 characters).

• Note – Miscellaneous notes related to the student’s transportation 
arrangements (up to 32,000 characters).

• Spec instr* (special instructions, text entry area with zoom box) – 
Special instructions related to transportation of the student. Use the zoom 
box to display more of the field for editing.

• Emrg nbrs* (emergency numbers, text entry area with zoom box) – 
Emergency telephone names/numbers, for transportation issues. The 
contents of this area are not linked in any way to the student contacts on 
the first tab, refer to “General (Student Tab 1)” on page 366.

• Emrg drop* (emergency drop-off, text entry area with zoom box) – 
Emergency drop off instructions for the student.
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User A1 (Student Tab 8)
Fig. 7-22 illustrates Tab 8 (User A1) of the student data entry form. Certain 
items, such as the student record number and name, and the DNR and Mark 
check boxes, are carried over from Tab 1. 

Fig. 7-22. Data entry form for a student, eighth (User A1) tab.

The data entry areas on this tab allow you to customize SELPA Manager to 
hold alphanumeric information that is specific to your SELPA and/or 
districts. 

• User alpha fields (10 data entry areas and associated labels, numbered 1-
10) – These ten data entry areas each hold up to 80 characters. You can 
name each one by clicking on the blank label to the left of the field. The 
first alpha field is indexed, for faster searching.



NOTE: When you supply a custom name to a user field, the name applies 
only to your copy of SELPA Manager. If you will be exporting student-level 
information to another copy of SELPA Manager (to the SELPA central 
office, for example), then all users in your SELPA should be storing the same 
type of information in each user field.

User A2 (Student Tab 9)
Fig. 7-23 illustrates Tab 9 (User A2) of the student data entry form. Certain 
items, such as the student record number and name, and the DNR and Mark 
check boxes, are carried over from Tab 1.

Fig. 7-23. Data entry form for a student, ninth (User A2) tab.

The data entry areas on this tab allow you to customize SELPA Manager to 
hold alphanumeric information that is specific to your SELPA and/or 
districts. 
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• User alpha fields (10 data entry areas and associated labels, numbered 
11-20) – These ten data entry areas each hold up to 80 characters. You can 
name each one by clicking on the blank label to the left of the field. 

NOTE: When you supply a custom name to a user field, the name applies 
only to your copy of SELPA Manager. If you will be exporting student-level 
information to another copy of SELPA Manager (to the SELPA central 
office, for example), then all users in your SELPA should be storing the same 
type of information in each user field.

User nbr/date (Student Tab 10)
Fig. 7-24 illustrates Tab 10 (User nbr/date) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The data entry areas on this tab allow you to customize SELPA Manager to 
hold numeric and date information that is specific to your SELPA and/or 
districts. Descriptions of the data entry areas follows immediately.

• User number fields (10 fields and associated labels) – These ten data 
entry areas each hold a long integer number. You can name each one by 
clicking on the blank label to the left of the field. The first field is indexed, 
for faster searching.

• User date fields (10 data entry areas and associated labels) – These ten 
data entry areas each hold one date, which you can name by clicking on 
the blank label to the left of the field. The first date field is indexed, for 
faster searching

NOTE: When you supply a custom name to a user field, the name applies 
only to your copy of SELPA Manager. If you will be exporting student-level 
information to another copy of SELPA Manager (to the SELPA central 
office, for example), then all users in your SELPA should be storing the same 
type of information in each user field.



Fig. 7-24. Data entry form for a student, tenth (User nbr/date) tab.

User Y/N (Student Tab 11)
Fig. 7-25 illustrates Tab 11 (User Y/N) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The data entry areas on this tab allow you to customize SELPA Manager to 
hold Boolean (yes/no) information that is specific to your SELPA and/or 
districts. Descriptions of the data entry areas follows immediately.

• User yes/no fields (15 fields and associated labels) – These fifteen data 
entry areas each hold a Boolean (yes/no) value. You can name each one 
by clicking on the blank label to the left of the field. The first field is 
indexed, for faster searching.
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Fig. 7-25. Data entry form for a student, eleventh (User Y/N) tab.

NOTE: When you supply a custom name to a user field, the name applies 
only to your copy of SELPA Manager. If you will be exporting student-level 
information to another copy of SELPA Manager (to the SELPA central 
office, for example), then all users in your SELPA should be storing the same 
type of information in each user field.

Notes / dups (Student Tab 12)
Fig. 7-26 illustrates Tab 12 (Notes / dups) of the student data entry form. 
Certain items, such as the student record number and name, and the DNR 
and Mark check boxes, are carried over from Tab 1. 

The data entry area on this tab (a scrolling text field) is available for entry of 
miscellaneous student notes.

In addition, there is a mechanism for associating the displayed student 
record with some other student record, for CASEMIS reporting purposes.



Fig. 7-26. Data entry form for a student, tenth (Notes / dups) tab.

• Notes (scrolling text field, with zoom box) – This data entry area can be 
used for miscellaneous notes and other information concerning the 
student (up to 32,000 characters). SELPA Manager will also use this area 
to record programmatic updates to the record. The zoom box can be used 
to display or edit the field contents in a larger dialog.

• Duplicate of (button, duplicate student handling) – Clicking on this 
button allows you to associate the current student record with another 
student record, for CASEMIS reporting purposes. After making the 
association, services for any of the linked student records will be reported 
through the record that is designated as the “reporting” or “master” 
student record.

You may want to make this association if a student receives services in 
more than one district, and each of these districts records the services 
using SELPA Manager. In this case, after importing student-level 
information from the various districts, the SELPA Central version of the 
program may have more than one student record for the same individual.
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To associate the student record with another record, for CASEMIS 
reporting purposes, determine the 18-digit record number of the student 
that is to be the reporting (master) record. Press the DUPLICATE OF 
button, and then enter the record number (including the dashes between 
numbers).

NOTE: The record number that you enter should be the number of the 
reporting (master) student. The current record will become a dependant 
record of the master record. You cannot designate a student record to be a 
master, if that record is itself a dependant of another student record. Once 
the association is made, the name, record number, and the 
[Student]Student_ID for the master student will appear adjacent to the 
button.

To remove an existing association, the name and record number of the 
reporting (master) student must appear adjacent to the button (or, if the 
student being viewed is itself the reporting/master student, then the 
expression “master student” will appear adjacent to the button). In this case, 
press the DUPLICATE OF button to remove the association.

A somewhat easier method of associating or dissociating students for 
reporting purposes is to highlight two or more student records in the browse 
window, and then select Duplicates from the Actions menu (refer to the 
discussion of the Actions menu).

• SELPA 3.x-4.5 record number (display only) – The previous record 
number for this student, in the format used in earlier versions of SELPA 
Manager (“District - next student - site”, as 7 digits - 7 digits - 2 digits). 
The student will have something listed here only if s/he existed in the data 
file prior to conversion to v.4.60 and higher of SELPA Manager.

• Previous record number (display only) - The student’s previous 
identification number. This field is repeated from the Demographics tab, 
refer to page 380.

Transportation-only data form
A single-page (non-tabbed) data entry form can be displayed on the screen 
instead of the standard, multiple-tabbed student data entry form that is 
described earlier in this chapter. This single-page form contains fields 
related to transportation activity for the student (Fig. 7-27 and Fig. 7-28 are 
upper and lower views, respectively). You might find the transportation-only 



data form useful if you work with a separate transportation department that 
requires limited, read-write access to SELPA Manager from their 
computers.

The transportation-only data form scrolls vertically. It can be activated by 
checking the “Transportation only” box in Preferences (refer to the Chapter, 
“Configuring SELPA Manager” on page 299). 

While this option is activated for a particular user, that user cannot create 
new student records. The “New” item will be dimmed in the Data menu until 
the user un-checks the “Transportation only” box in Preferences.

Only certain fields are enterable on the transportation-only data form; these 
fields were identified earlier with asterisk notations (see page 402).

SELPA Manager users who are members of the “AdminGroup”, 
“ReadWriteGrp”, or “TransportGrp” can save changes made on this form. 
However, users who are members of the “TransportGrp”, but who are not 
also in the “ReadWriteGrp” or the “AdminGrp”, cannot save changes to any 
other data entry forms in SELPA Manager, including the standard, multi-
tabbed student data entry form. For these “TransportGrp” users, the SAVE 
button on all other data entry forms will be dimmed.

The “TransportGrp” members can check audit trail (field-level change) 
information, for student records only. Other users do not have access to audit 
trail information, unless they are in the administrative group 
(“AdminGroup”).

In the default set of users when a fresh copy of SELPA Manager is installed, 
there is a user named “Transport User”. This user has membership privileges 
set to the “TransportGrp” only, and therefore is set for the limited 
transportation access. If you log into SELPA Manager as this user, you must 
still check the “Transportation only” box in Preferences to see the 
transportation-only data form.
Entering Students 413 

• 
• 
• 
•
•
•



414  

• 
• 
• 
•
•
•

Fig. 7-27. Top portion of the transportation-only data form., showing display-only 
components.

Fig. 7-28. Bottom portion of the transportation-only data form., showing the data entry 
areas.

Editing an existing student

To edit an existing student (from the browse window):

1 Find the student record in the appropriate browse list.



SELPA Manager initially opens each new browse window in the student 
view / context. If there are a large number of students listed, you may not be 
able to locate it immediately. There are several approaches to locating the 
record, some of which are listed here:

• Sort the list by student last name, by clicking in the first column header 
of the student list. Scroll through the list until you find the student record.

• Type the student’s name (or the beginning portion of the name), record 
number, student number, Social Security Number, or date of birth in the 
Location box, then press the [ENTER] key.

• Select the field, “last name” from the Location box pop-up menu, 
complete the sentence with the student’s family name (or portion 
thereof), and then press the [ENTER] key. For example,
last name is smathers

• If you only type in the first one or two letters of the student’s name, then 
all students whose last name begins with those two letters will appear in 
the browse list. This feature is useful if you are not sure about the specific 
spelling of a student’s name.
ab
last name is ab

• Use any of the following words in a simple sentence, with an appropriate 
search criterion: name, contact, record number, student number, id 
number, dob, birthday, birth date, ssn. These phrases are not case-
sensitive. For example,
ssn is 423-338-4489
name is Mitchell, Tyler
ID Number is 43879
contact is Reginald Smith
DOB is 7/19/1952

2 Double-click on the row corresponding to the student record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the student.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse window. 
Unless you have Auto re-sort lists turned on in Preferences, the row 
corresponding to the edited record should still be highlighted.
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 8 Student Services and Goals

In SELPA Manager, a student can have multiple special education services. 
At any time, however, there can be only one active primary service. An 
active service is one that has not been dropped, or that is scheduled to be 
dropped some time in the future, but is currently valid. A primary service is 
the student’s principal special education service, based upon the student’s 
primary disability.

There are three principal methods to add services to SELPA Manager. The 
first is to use the Services tab of the Student data entry form (refer to 
“Services (Student Tab 4)” on page 383). A second method is to add services 
directly from the browse window, when a services list is active (has the 
current focus). Using this method, you select “New record” from the Data 
menu, and the program will display a blank student service data entry form 
(refer to “Student service entry” on page 418).

A third method of adding services is from the assessment (IEP) form. Some, 
but not all, assessment forms have this capability. For additional details, 
refer to the Chapter, “Entering Assessment Information” on page 479.

Services that have associated auxiliary service codes can be used to generate 
a district chargeback report, which is discussed in “District chargeback 
report” on page 456.

Student achievement goals in SELPA Manager can be added directly from 
the browse window, when the Goals list is active. Goals can also be added 
from a student’s assessment (IEP) form, in which case each goal is linked to 
that particular assessment. Each goal may contain alternative assessment 
codes for content, mastery, and reason for failure, if an alternate assessment 
is appropriate for the student. 
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For convenience, there is a goals/objectives palette from which you can 
copy standardized goals for a particular student (refer to “Goals/objectives 
palette” on page 438).

Prior to Version 4.60 of SELPA Manager, there were two types of goals: 
those that were associated with services, and (in Version 4.5x only) those 
that were associated with assessments. With Version 4.60 and beyond, only 
the assessment goals remain. If you have goals that were associated with 
services in v.4.5x of SELPA Manager, then the program will convert them 
to assessment goals the first time that your data file is opened with v.4.60 or 
higher of the program.

Student service entry

To add a new student service to the program (from the browse window):

1 Click on the SERVICES button.

The browse window will change contexts, if necessary, so that services 
appear in the upper list and either students or teachers appear in the lower 
list.1 

After switching to the new context, the focus will be on the upper list. If you 
have not yet entered any services, or if you have specified in Preferences that 
the browse window should initially display no records, then the upper list 
will be empty (refer to “Browse window initial display options:” on 
page 296).

If you did not switch contexts (you were already browsing services), then 
ensure that the focus is on the upper list.

2 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for student services (Fig. 
8-1). 

3 Enter information onto the student service data entry form.

1. You can configure SELPA Manager to display either students or teachers in the low-
er list, for the Services context. Refer to the Chapter, “Configuring SELPA Manager”
on page 301.



For each new service you must enter, at a minimum, the student name/code, 
the start date, the school name/code, and the service name/code. The other 
fields are optional.

NOTE: Before you select “New record” from the Data menu, if you have 
highlighted a row in the lower list of the browse window (a student or a 
teacher record), then the new service form will already be linked to that 
student or that teacher, respectively. Similarly, if there is only one student or 
one teacher record listed in the lower list, then the new service will be linked 
to that student or teacher. You can re-link to another student or another 
teacher before saving the new record.

Fig. 8-1. Data entry form for adding a new student service.

• Student (1 entry area, plus three display-only fields for last name, first 
name, and student number) – The student for whom you are creating the 
service record. In the data entry area, you can type any of the following: 
the student’s last name, record number, student number, date of birth, 
Social Security Number, or first name. If the program finds more than one 
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student that meet the criterion, it will display a scrollable list from which 
you can select one student. 

Once a student is selected, the entry area will display the student record 
number.

NOTE: If you remove an existing record number from the entry area, the 
program will offer to delete the link to the existing student.

• Teacher – Name of the teacher that is/will be providing a special 
education service to the student.You may enter the beginning of the 
teacher’s name or a teacher code, and the program will attempt to 
complete the entry when you [TAB] out of the data entry area. 

Enter just the wildcard character (“@”) and then [TAB], to obtain a 
complete list of teachers. You can also enter a telephone number or a Zip 
code for the teacher, and the program will either find a teacher or present 
a list of potential matches. To be entered here, the teacher must be listed 
first in the Teachers section of the program (refer to the Chapter, “Adding 
Staff and Related Information” on page 328).

If the check box, “Limit student services to active teacher assignments” 
is checked in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 273), then SELPA Manager will first verify that the 
selected teacher has active assignments (in any subject, at any school). If 
not, then the program will display an error message, indicating that the 
teacher cannot be selected.

Suppose that you have already selected a teacher, a school, and a service 
for the service, and then decide to change to a different teacher.1 If “Limit 
student services...” is checked in Preferences, then SELPA Manager will 
verify that the teacher has an active assignment in the selected topic, at 
the selected school. If not, then the program will display an error 
message, indicating what active assignments are available for the new 
teacher at the selected location.

If “Limit student services...” is checked in Preferences, then SELPA 
Manager will also populate the choice lists for services with the names 
and codes of services for which the teacher has active assignments. 
Similarly, the program will populate the schools choice list with only 

1. This circumstance could also occur when changing the teacher for an existing stu-
dent service.



those schools at which the teacher has active assignments.

If “Limit student services...” is not checked in Preferences, then the 
services choice lists will contain all services, and the schools choice list 
will be empty (to conserve memory).

If the selected teacher has a default service designated in the Teachers 
section of the program, then SELPA Manager will enter that service code 
and service name below, in the Service areas. For more information on 
default services, refer to Chapter, “Adding Staff and Related 
Information” on page 337.

• Primary service (check box) – Indicates that the service is the student’s 
primary service. Each student record should have exactly one active (not 
dropped) primary service, generally the main service being provided as a 
result of the student’s disability. Usually, the primary service is also the 
service that is provided for the longest amount of time. 

If you check a service as being the primary, and it is not dropped on or 
before today’s date, then SELPA Manager will search for other active 
primary services for this student. If one is found, then the program will 
present an error message, and uncheck the box.

NOTE: You should not create more than one active primary service for a 
student.

• School (with pop-up list, restricted; and display-only 7-digit school code) 
– The name of the school where the teacher is providing the service. To 
be selected here, the school must first be listed in the Schools section of 
the program (refer to “School entry” on page 317). After selecting the 
school, the school code will appear in a display-only box, immediately to 
the right.

Before you can select a school, you must first select a teacher for the 
service. After selecting the teacher, if “Limit student services...” is 
checked in Preferences, then the pop-up list for School will contain just 
those schools at which the teacher has active assignments.

Suppose that you have already entered a teacher, a school, and a service, 
and then change to a different school. If “Limit student services...” is 
checked in Preferences, then the program will verify that the teacher has 
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an active assignment for the service at the new school. If not, SELPA 
Manager will display an error message and revert to the previous school 
name.

• Disab. cond.(with pop-up list, restricted) – The disabling condition 
(handicapping condition) for a primary service. Cannot be selected for a 
non-primary service.

• Isolated site (checkbox) – Indicates that the site where the service is 
being provided is geographically remote.

• Do not report (check box) – Indicates that the service should not be sent 
to the state Department of Education, as part of the CASEMIS export. 
Likewise, the program skips over services that are marked “Do not 
report” when determining which student records are eligible for the 
export.

When you continue an service, the program will stamp the old 
(discontinued) service as “Do not report” (refer to “Student service list 
controls” on page 391).

NOTE: Both student and service records have a check box for “Do not 
report”. The student DNR box allows the Student record to be saved without 
completing all required data entry; however, the service Do not report check 
box does not have the same save-enabling effect.

• Service (2 data entry areas, each with pop-up lists, restricted) – The code 
and the name for the service to be provided for the service. You can enter 
either the code or the beginning of the service name into either field, and 
the program will attempt to complete both data entry areas. 

You must first select a teacher for the service, before the program will 
allow you to select the service. After selecting the teacher, if “Limit 
student services...” is checked in Preferences, then the two pop-up lists 
for services (service name and service code) will contain just those 
services for which the teacher has active assignments.

If you select some other, valid service, then the program will display an 
error message, indicating that the teacher has no active assignments for 
that service. The message may display other services (and locations, if 
the school has not been specified) for which the teacher has active 
assignments.



• Regional SDC (check box) – Indicates that the student is receiving the 
Special Day Class service (SDC, CASEMIS code 430) at a regional 
center rather than at a local site. This box can be checked only for a 
primary service of type 430 (Special Day Class).

• Class – A code (up to 5 characters) for the class in which the service is 
provided. When printing attendance registers for the teacher’s provided 
student services, under the default option, the forms can be separated by 
class code and service code.1

• Auxiliary code (with pop-up list) – An alternate description for the 
special education service being provided, up to 80 characters. You can 
revise the choice list for this entry area by editing the “Aux service code” 
list on the System 1 tab of the Preferences dialog (refer to the Chapter, 
“Configuring SELPA Manager” on page 262).

Each auxiliary code can have associated cost parameters. These 
parameters can be used to generate district chargeback reports, so that 
fees for special education services that a student receives at county / 
SELPA offices can be charged back to the individual district where the 
student resides (refer to “District chargeback report” on page 456). 

• Original start (date) – The date on which the service originally started. 
The original start date cannot be after the service start date, or after the 
drop date, discussed below.

When you continue an service, the program will insert the start date of 
the original service into the original start date field of the newly-created 
service (refer to “Student service list controls” on page 391).

When selecting students eligible for the CASEMIS export, the program 
considers active (not dropped) primary services that start before the 
Report As Of date, or that have an original start date that is before the 
Report As Of date.

• Start (date) – The date on which the service begins. The start date cannot 
be prior to the original start date, or after the drop date. Clicking the small 
button to the right of the field will place the date on the Calendar.

• Drop (date) – The date on which the service ends. This area should be 
null (“00/00/0000”) for an active (current) service. The drop date cannot 
occur before the start date, or before the original start date.

1. The other option is to separate by school name and student track.
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• Evaluation (date) – A date on which the service is evaluated in regard to 
the student’s needs and progress. May not precede the original start or the 
start dates. On some of the assessment/IEP forms, the evaluation date 
appears as the “end” date column in an instructional settings/services 
table.

• Minutes/session (number) – The duration of a session of the service, in 
minutes. When exporting infant services in CASEMIS format, the 
program uses this number for the state’s “DURATION” field.

• Sessions/week (number) – The total number of sessions provided each 
week, for the service. 

• Session note – Note pertaining to the service or session(s), up to 80 
characters.

• Infants only: Agency (coded entry, with pop-up list, restricted) – The 
name and code for the agency that provides a Designated Instruction 
Service (DIS) or related service to an infant. Example agencies include 
the Department of Rehabilitation, the Department of Social Services, etc. 
Enter the 2-digit code, the agency description, or select from the pop-up 
menu. 

• Infants only: Location (coded entry, with pop-up list, restricted) – The 
location where an infant-related service is provided. Examples include 
Home, Hospital, Residential Facility, etc. Enter the 3-digit code, the 
location description, or select from the pop-up menu. 

• Infants only: Frequency (coded entry, with pop-up list, restricted) – The 
frequency with which an infant-related service is provided. Examples 
include Daily (2x per day), Weekly (2x per week), etc. Enter the 2-digit 
code, the frequency description, or select from the pop-up menu. 

• Drop reason (primary) (2 data entry areas, each with pop-up lists, 
restricted) – The reason code and the reason that the service was 
discontinued. Enter the two-digit code, the drop reason, or select from the 
pop-up menu. The program will complete the other area. For primary 
services only.

• Drop reason (non-primary) (2 data entry areas, each with pop-up lists) 
– The reason code and the reason that the service was discontinued, for 
non-primary services only. Enter the two-digit code, the drop reason, or 
select from either pop-up menu. The program will attempt to complete 
the other area. You may use primary drop codes and reasons in these 
fields, if desired.



Because this set of entry areas does not limit you to using items on the 
pop-up lists, the program may not find the analogous description for the 
code that you enter, or vise-versa. In this case, the program will present 
an alert that the other entry area has not been changed.

4 After completing the student service data entry form, press the SAVE 
button. 

The program will save the new service record. If the Add new record loop 
option is turned on in Preferences, then the program will display a new, 
blank form for the next service to be entered (refer to the Chapter, 
“Configuring SELPA Manager” on page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another service, then repeat the instructions from Step 2 onward.

5 Repeat Step 2 through Step 4 for each student service that you wish to 
add. 

Once you have completed service entry, you may wish to browse the 
services and review/print the list of entries to verify proper entry.

Editing an existing student service
Generally, you will want to edit an existing service by editing the student 
who has the service. In the student browse list, find the student’s name, 
double-click on it, and then go to the fourth tab (Services) on the Student 
data entry form. Refer to “Services (Student Tab 4)” on page 383.

You can also edit a student service directly, from the services browse list. 

To edit an existing student service (from the browse window):

1 Find the record in the student services browse list.

If there are a large number of services listed, you may not be able to locate 
it immediately. There are several approaches to locating the record, some of 
which are listed here:

• Type the student’s name, or the beginning portion of the name, as <first 
name last name> or as <last name, first name> in the Location box, 
then press the [ENTER] key.
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• Type the student’s record number, student number, or Social Security 
Number in the Location box, then press the [ENTER] key.

• Type the school code, CASEMIS service code, service name, or teacher 
name in the Location box, then press the [ENTER] key.

• Type the original start date, the start date, or the drop date in the Location 
box, then press the [ENTER] key.

• Use a keyword sentence that does not change the browse window context, 
as in the following examples:
start date is august 9
original start is 6.21.1998
drop date is after 10/15/1999
location is 6042147
place is lawrence
service is RSP
service is 410-50
provider is Nancy Fields
primary drop reason is 76
non-primary drop reason is 18
drop reason is return to regular ed

NOTE: If you are in another browse window context, you can also access 
services for a student by using a variant of the expression,

services for Trout, Natasha

In this case, the browse window will switch to the Services context, and then 
find the appropriate service records.

2 Double-click on the row corresponding to the service record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the service.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse window. 
Unless you have Auto re-sort lists turned on in Preferences, the row 
corresponding to the edited record should still be highlighted.



Goal entry
You can add goals for a student directly from the browse window, or in the 
process of entering an assessment (IEP form) for a student. Goal entry using 
the assessment form is discussed in the Chapter, “Entering Assessment 
Information” on page 502. In that case, each goal is linked both to the 
student and to the assessment form. In contrast, goals that are entered 
directly from the browse window are not associated with any IEP form. 
When creating a goal from the browse window, you must link the goal to the 
student record.

To add a new goal/objective to the program (from the browse window):

1 Click on the GOALS button.

The browse window will change contexts, if necessary, so that goals appear 
in the upper list and services appear in the lower list.

After switching to the new context, the focus will be on the upper list. If you 
have not yet entered any goals, or if you have specified in Preferences that 
the browse window should initially display no records, then the upper list 
will be empty (refer to “Browse window initial display options:” on 
page 296).

If you did not switch contexts (you were already browsing goals), then 
ensure that the focus is on the upper list.

2 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for goals/objectives (Fig. 
8-2), set to the first data entry tab. Depending upon which SELPA you are 
registered as in Preferences, however, you may see a slightly different form. 
For example, SELPA 3702 (North Coastal) users will see the blank data 
form shown in Fig. 8-4.

To reduce confusion, the paragraphs that follow immediately below will 
discuss data entry into the default (SELPA 4100) goals/objectives form. 
Differences in the other forms will appear subsequently; for example, refer 
to “Objective/Goal (Tab 1, SELPA 3702 form)” on page 432.

3 Enter information onto the goal/objective data entry form.

For each new goal you must enter, at a minimum, the associated (linking) 
student and the goal text. The other fields are optional.
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Fig. 8-2. Data entry form for adding a new goal, first tab.

4 After completing the goal data entry form, press the SAVE button. 

The program will save the new goal/objective record. If the Add new record 
loop option is turned on in Preferences, then the program will display a new, 
blank form for the next goal/objective to be entered (refer to the Chapter, 
“Configuring SELPA Manager” on page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another goal, then repeat the instructions from Step 2 onward.

5 Repeat Step 2 through Step 4 for each goal that you wish to add. 

Once you have completed goal entry, you may wish to browse the goals and 
review/print the list of entries to verify proper entry.

Objective/Goal (Goal Tab 1, default form)
The first tab of the goal data entry form (Fig. 8-2) identifies the goal itself, 
and associated categories/characterizations for the goal.



• Student (1 data entry area, with two additional, display-only areas for: 
last name and first name) – When completed, the data entry box displays 
the record number of the student for whom you are creating the 
goal/objective record. You may enter the student’s last name (or portion 
thereof), first name, record number, Social Security Number, or date of 
birth. The program will attempt to complete the link to a Student record, 
when you [TAB] out of the data entry area.

If the student is not found, SELPA Manager will display an error 
message. If more than one student is found, the program will display the 
list of found students, so that you may select one.

• IEP (display only) – Number for the assessment (IEP) record, to which 
the goal is linked. For a new record, this box will be blank.

• Goal/priority no. (numeric entry only) – Number / priority number of 
the goal for this student, or for this student’s IEP form.

• Area of need – Field of endeavor in which the goal is to be defined, 
related to the student’s assessment and present level of performance. 
Examples: mathematics, behavior, language arts, etc.

• Measurable objective (text entry area) – A sub-topic within the area of 
need, for which the goal is to be defined. Examples: speaking 
applications; listening and speaking strategies; mathematical reasoning; 
number sense; etc.

• Enables student to be involved with general education (checkbox) – 
Indicates that achievement of the goal would enable the student to be 
involved in a general education curriculum.

• Addresses other educational needs due to the disability (checkbox) –
Indicates that achievement of the goal helps the student accomplish 
educational needs beyond the general education curriculum, that result 
from the student’s disability.

• Goal (text entry area) – The goal to be accomplished.Examples: 
“Students use strategies, skills, and concepts in finding solutions”; 
“Narrative analysis of grade-level-appropriate text”; etc.

• L+ (button) – Clicking on this button causes SELPA Manager to display 
a small palette of goals and objectives.The palette can be used to add 
standardized benchmarks and companion goals for the student. For more 
information on configuring and using the palette, refer to 
“Goals/objectives palette” on page 438.
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• Present level & performance to be reviewed by (text entry area) – 
Name of a person or persons who will monitor and review the student’s 
progress toward achieving the goal and its individual benchmarks.

• Alternate assessment: (coded data entry, with pop-up list, restricted) – 
The pop-up list contains a selection of content areas for the alternate 
assessment. The item to be selected should be the one that best describes 
the instructional goal for the student. 

Provided that the student is otherwise eligible for the 2000-2001 
CASEMIS Table A export, the presence of this code determines whether 
the student will also be reported in the alternate assessment table 
(following the generation of Table C, in the 2000-2001 CASEMIS 
report). 

If you select an alternate assessment content code for a goal, and the 
associated student record is not marked for STAR Code 90 (no STAR 
program participation due to IEP exemptions), then SELPA Manager will 
identify an error condition, and offer to change the student’s STAR 
participation to Code 90. 

• Mastery (coded, with pop-up list, restricted) – The degree of mastery 
exhibited by the student towards the instructional goal. This item is 
related to the alternate assessment.

• Not met because (coded, with pop-up list, restricted) – The reason, if 
any, that the student has not met the goal of the alternate assessment.

Benchmark 1-2-3 (Goal Tabs 2 through 4, default form)
Each of these data entry form tabs allows you to enter a benchmark 
associated with the goal, for a total of up to three per goal. Each benchmark 
can have up to six progress dates and progress levels. Carried forward from 
the first tab are the student name, IEP form linking number (if any), and the 
L+ button for displaying the goals/objectives palette (Fig. 8-3).



Fig. 8-3. Data entry form for adding a new goal, second tab.

• Short Term Objective / Benchmark 1-2-3 (text entry area) – A discrete, 
measurable criterion with which the student’s progress toward achieving 
the goal can be measured, on a regular basis. Example: “Will improve 
ability to identify and correctly use clauses, phrases, and mechanics of 
punctuation, by 4/29/2002.”

• Baseline data and methods used to measure progress (with pop-up 
list) – The means by which progress toward meeting the benchmark is to 
be measured (e.g., work samples, testing, teacher records).

• Progress review (date/level) (six date and progress level entry areas, 
each progress level area with pop-up list) – The date and the level of 
progress that the student has made in achieving the benchmark. Example: 
“No progress”; “Partial progress (1-40%)”; etc. The first date (D1) and 
progress level (L1) can be used as the baseline performance/progress 
level toward achieving the benchmark.

There is a pop-up list of dates that appears when you press the (v) button, 
immediately to the right of the label. The program will insert a selected 
date into one of the date fields (D1-D6), either the first one (D1) or 
whichever other one (D2-D6) currently contains the blinking cursor.
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Objective/Goal (Tab 1, SELPA 3702 form)
The first tab of the goals/objectives data entry form for SELPA 3702 is 
similar to the default form (Fig. 8-2), but has a few different fields (Fig. 8-
4). The alternate assessment information is not displayed on the first tab; 
instead, there is an additional (fifth) tab, “Progress reports” where this 
information is located. The fields that have been added to the first tab are 
discussed below.

• IEP meeting date (date) – The date on which an IEP meeting is 
scheduled to occur, during which this goal will be discussed.

• Goal baseline (text entry area) – Student’s baseline performance in 
achieving the goal.

Fig. 8-4. Data entry form for adding a new goal (SELPA 3702 form), first tab.

Benchmark 1-2-3 (Goal Tabs 2 through 4, SELPA 3702 
form)
The second, third, and fourth tabs of the goal data entry form for SELPA 
3702 differ from the default form in the sense that there are no dates; instead, 
there is a text field for describing baseline performance, and one code field 
(Fig. 8-5).



Fig. 8-5. Data entry form for a goal (SELPA 3702 form), second tab.

• Baseline evaluation (text entry area) – Instructor’s evaluation of the 
student’s baseline (starting) performance in meeting the particular short-
term objective/benchmark (Benchmark 1, 2, or 3).

• Annual review progress code (Codes 1, 2, 3, or 4 only) – The student’s 
progress in meeting the benchmark, as of the annual meeting date. A code 
of “1” indicates no progress; “2” indicates partial progress (1-49%); “3” 
indicates substantial progress (50-99%); and “4” indicates that the goal 
was met or exceeded.

Progress reports (Goal Tab 5, SELPA 3702 form)
The form for SELPA 3702 has an extra tab when compared to the default 
goal data entry form. The fifth tab is shown in Fig. 8-6. In addition to 
containing the alternate assessment fields, there are data entry areas for up 
to three interim progress reports and for one annual review.

• Date (date, total of 4 fields, one for each progress report and one for the 
annual review) – Date of the progress report / annual review.
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• Progress code (Codes 1, 2, 3, or 4 only; total of 4 fields) – The student’s 
progress in meeting the goal, as of the interim progress report date or the 
annual review date. A code of “1” indicates no progress; “2” indicates 
partial progress (1-49%); “3” indicates substantial progress (50-99%); 
and “4” indicates that the goal was met or exceeded.

• Progress sufficient to meet annual goal? (“Y” or “N” only, up to 3 
fields) – An indication of whether the progress during the reporting 
period is sufficient to meet the annual goal.

• If not sufficient / goal not met, enter reason code (Codes A, B, C, D, or 
E only; up to 4 fields) – Reason (code) explaining why the student’s 
progress is not sufficient to meet the annual goal during the reporting 
period or annual review: A-more time needed (continuing goal); B-
excessive absences or tardies; C-assignments not completed; D-need to 
review or revise goal; E-other. 

• Comment (Up to 4 fields, up to 80 characters each) – Miscellaneous 
comments for each progress report or for the annual review.

Fig. 8-6. Data entry form for a goal (SELPA 3702 form), fifth tab.



Default form adaptations (SELPAs 0901, 4811)
When displaying a goal data entry form for SELPA 0901 (El Dorado) or for 
SELPA 4811 (Vallejo), SELPA Manager uses the default form (Fig. 8-2) 
with certain adjustments.

For SELPA 0901, two additional fields appear on Tab 2 (Benchmark 1) and 
Tab 3 (Benchmark 2). These fields are shown in Fig. 8-7. Furthermore, Tab 
4 (Benchmark 3) is not accessible; clicking on this tab will generate an error 
message.

• Goal met (checkbox) – Indicates that the short-term objective / 
benchmark was achieved.

• / Plan: (with pop-up choice list) – Subsequent activity, if any, on this 
short-term objective / benchmark. Typically “Continue”, “Discontinue”, 
or “Revise”.

Fig. 8-7. Data entry form for a goal (SELPA 0901 form), second tab.

For SELPA 4811, the program displays five progress review dates and 
levels, rather than the standard six, for each benchmark (Fig. 8-8).
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Fig. 8-8. Data entry form for a goal (SELPA 4811 form), third tab. The only difference 
from the default form is the absence of a sixth date and progress level.

Objective/Goal (Tab 1, SELPA 0400/4500/5300 form)
The first tab of the goals/objectives data entry form for SELPAs 0400, 4500, 
and 5300 is similar to the default form, with minor changes (Fig. 8-9). 

• Baseline (text entry area) – Student’s baseline performance in achieving 
the goal. 

• Person(s) responsible (text entry area) – Name of a person or persons 
who will monitor and review the student’s progress toward achieving the 
goal and its individual benchmarks.

• Reviewed (date) – The date on which the student’s progress toward 
achieving this goal was first reviewed.

• Met / Not Met (radio buttons) – Indicates whether the student 
successfully met the goal.

• Comment (text entry area) – Miscellaneous comments regarding the 
student’s performance and progress in meeting the goal.



Fig. 8-9. Data entry form for a goal (SELPA 0400/4500/5300 form), first tab. 

Benchmark 1-2-3 (Tabs 2 through 4, SELPA 
0400/4500/5300 form)
The other tabs of the goals/objectives data entry form for SELPAs 0400, 
4500, and 5300 is similar to the default form. However, there is only one 
progress report date (rather than six). Additionally, instead of the six 
progress level entry areas of the default form, there is a single check box to 
indicate whether the short-term objective / benchmark has been met (Fig. 8-
10). 

• Reviewed (date) – Date on which the student’s performance in achieving 
the short-term objective / benchmark is being evaluated.

• Met / Not Met (radio buttons) – Indicates whether the student 
successfully met the criteria of the short-term objective / benchmark.
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Fig. 8-10. Data entry form for a goal (SELPA 0400/4500/5300 form), second tab. 

Goals/objectives palette
The goals/objectives palette provides a means for selecting goals and 
specific benchmarks (for attaining the goal) from a list, while entering goal 
information for a student. The palette can be used when adding goal 
information to an assessment (IEP) form, or when adding goals for a student 
directly from the browse window.

To display the goals/objectives palette, press the (L+) button on the goal data 
entry form (refer to Fig. 8-2, Fig. 8-3, or Fig. 8-4), or on the assessment data 
entry form (refer to the Chapter, “Entering Assessment Information” on 
page 505). If you have not yet created or imported any standardized 
goals/objectives for inclusion on the palette, then the palette will be empty 
when you first display it. In this case, dismiss the palette by clicking on the 
close box in the upper left-hand corner of the window.

The SELPA Manager installation program includes two sets of goals and 
objectives that can be imported into the palette, one for Mathematics and 
one for Language Arts. These two import files are based upon goals and 
objectives published in Portable Document Format (pdf) by the State of 
California.1 2



You can customize the state goals and objectives by editing them and/or by 
supplementing them with other goals and objectives. You can also create 
your own, complete set of goals and objectives for the palette. 

Once you have customized the state goals and objectives to your liking, or 
when you have created your own goals and objectives for the palette, you 
can then distribute them to other users within your district or region, as a 
custom export file on disk. For details on exporting goals/objectives to 
another SELPA Manager user, refer to the Chapter, “File Menu Operations” 
on page 572. For importing goals/objectives, refer to the description for 
“Goals/objectives (SELPA Mgr)” on page 534, of the same chapter.

It is important to remember that goals, objectives, benchmarks, and other 
items on the goals/objectives palette are not linked to any particular student. 
Rather, they represent a “menu” of possible goals and benchmarks that can 
be assigned to a particular student. When you select an item from the palette 
for use with a student, SELPA Manager copies the benchmark, the goal, the 
objective, and the area of need (category) from the palette onto the particular 
student’s goal record. Subsequent changes to the items on the palette will 
have no effect on the student goal records that you have already created.

Importing generic goals/objectives for the palette

To import State of California goals/objectives for use with the palette:

1 Select “Import...” from the File menu.

SELPA Manager will display a dialog containing import file types.

2 From the “Other import:” pop-up list, select “Goals/objectives (Generic)” 
and then press the OK button.

Fig. 8-11 shows the dialog box with this item selected. 

1. Edward O’Malley (ed.), Reading/Language Arts Framework for California Public
Schools, Kindergarten Through Grade Twelve. Curriculum Development and Supple-
mental Materials Commission. (Sacramento: California Department of Education,
1999).
2. Janet Lundin and Shiela Bruton (eds.), Mathematics Framework for California Pub-
lic Schools, Kindergarten Through Grade Twelve. Curriculum Development and Sup-
plemental Materials Commission. (Sacramento: California Department of Education,
1999).
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Fig. 8-11. Importing goals and objectives for the palette.

SELPA Manager will then present a second dialog (Fig. 8-12) that displays 
the format of the goals and objectives import (5-column delimited). 

Fig. 8-12. Importing goals and objectives for the palette (second dialog).

3 Without changing the delimiter settings in the second dialog, press the 
OK button.

SELPA Manager will display a standard open file dialog (Fig. 8-13), asking 
you to identify the file on disk to be imported.



Fig. 8-13. Importing goals and objectives for the palette (file open dialog).

4 Select the file on disk corresponding to the goals/objectives to be 
imported. Press the OPEN button to start the import.

The import files on disk have the names “LangArts_G1.txt” and 
“Mathematics_G1.txt”. You can find them in a “Goals and objectives” 
folder, within the SELPA Manager program folder. For example, in a default 
Windows installation, the path to these files would be:

C:\Program Files\Fusn_Tek\Slpa_46_fldr\Goals_and_objectives

SELPA Manager will import the goals/objectives file and display a dialog 
confirming what was imported.

5 Repeat Steps 1 through 4 to import another goals/objectives file. 

Only one generic goals/objectives file can be imported at a time. For 
example, if you first imported the “LangArts__G1.txt”, then repeat the 
import steps for “Mathematics_G1.txt”. 

Using the goals/objectives palette

To use the palette in conjunction with the data entry form for goals:

1 Press the (L+) button to display the goals/objectives palette.

SELPA Manager will display the palette, showing the area(s) of need in an 
upper, scrolling box. If you have imported the Mathematics and Language 
Arts goal/objectives supplied with the program, then you will see these two 
categories as the areas of need (Fig. 8-14). 
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Fig. 8-14. Goals/objectives palette (initial appearance).

2 Click on the arrows (+ buttons for the PC) to the left of the text, to expand 
the area of need. Continue expanding the palette until the desired 
benchmark title is displayed.

SELPA Manager will expand the displayed items in the following order: (1) 
area of need; (2) grade level; (3) measurable objective; (4) goal; and (5) 
benchmark. The fifth (benchmark) level is the maximum expansion of the 
palette. Benchmark items can be distinguished by the small green dot to the 
left of each item.

NOTE: You can enlarge the display area of the palette by dragging the lower 
right corner of the palette window. 



3 Highlight the benchmark title to be selected, in the palette.

The palette should now be similar to the illustration in Fig. 8-15. Note that 
the highlighted item has both a short title and a longer description, which 
appear in data entry areas below the highlighted item in the list.

Fig. 8-15. Goals/objectives palette (expanded appearance).

4 Press the USE button to transfer the benchmark to the goal data entry 
form.

If Benchmark 1, Benchmark 2, or Benchmark 3 is empty, then SELPA 
Manager will insert the highlighted item into the first available benchmark 
field. The program will also insert the area of need, measurable objective, 
and goal onto the first tab of the data entry form. Depending upon which 
benchmark slot is filled, the program will then switch to displaying the 
corresponding benchmark tab of the data entry form.

For example, if Benchmark 1 is the first available benchmark “slot”, and the 
data entry form is currently displaying Tab 1 (Objective/Goal), then the 
entry form will switch to displaying Tab 2 (Benchmark 1), into which 
SELPA Manager will place the highlighted palette item (Fig. 8-16).
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Fig. 8-16. Inserting an item from the goals/objectives palette into Benchmark 1 of the 
goals data entry form.

If the benchmark to be copied has a long description (in the lower scrolling 
box on the palette) that is different from the benchmark title, then SELPA 
Manager will copy the long description rather than the title (the title has a 
maximum of 30 characters).

If the benchmark to be copied has a numeric prefix, such as “1.1”, “2.2”, 
etc., then SELPA Manager will remove it before placing the text into the 
benchmark field. Additionally, SELPA Manager will precede the copied text 
with the words “Will improve ability to...”, and will append a suffix of 
“...by...” plus a date equal to the current date plus one year.

NOTE: If you are adding a goal from the assessment (IEP) form rather than 
from the browse window, then the future date in the benchmark suffix will be 
based upon the date of the IEP Meeting (rather than the current date).

5 To add another benchmark for the same goal, highlight another green, 
bulleted item on the palette and press the USE button again.

SELPA Manager will switch tabs to the next available benchmark area and 
insert the adjusted benchmark text (Fig. 8-17).



NOTE: If the goal data entry form already has one or more benchmarks, and 
you select a benchmark from a different goal, measurable objective, or area 
of need, then SELPA Manager will warn you that you are inserting a 
benchmark from a different goal, objective, etc. If all three benchmarks 
already contain text, the program will warn you that it cannot insert the 
selected item until one of the existing benchmarks is cleared.

Fig. 8-17. Inserting an item from the goals/objectives palette into Benchmark 2 of the 
goals data entry form.

Customizing the goals/objectives palette
Suppose that you have now imported the Language Arts and the 
Mathematics goals and objectives. Now, you wish to create a third category 
of goals and objectives, Behavior.

To create a new category (and associated items) in the palette:

1 Highlight one of the category names (Mathematics or Language Arts) 
and press the (+) button at the bottom left side of the palette. 

SELPA Manager will present a dialog box, asking for the name (title) of the 
new item (Fig. 8-18). The category title is limited to 30 characters.
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Fig. 8-18. Adding a new category (Behavior) to the goals/objectives palette.

2 Type the name of the new category, then press the OK button.

The new category (“Behavior”) will be inserted above the previously- 
highlighted category (“Mathematics”, Fig. 8-19). The highlight has now 
switched to the new “Behavior” category.

Fig. 8-19. A new category (Behavior) has been added to the goals/objectives palette.

3 Holding down the [ALT/SHIFT] key while the new category is highlighted, 
press the (+) button again to add grade levels for the category.



SELPA Manager will prompt you to name (title) the new item to be added 
beneath the Behavior category (Fig. 8-20). You may add any text that you 
wish, up to 30 characters; however, the title should represent a grade level.

Fig. 8-20. Adding a new sublisting (a grade level) to the goals/objectives palette, by 
holding down the [ALT/OPTION] key and clicking on the (+) button.

4 Repeat Step 3 to add other grade levels, as subitems for the new 
category.

After adding the grade levels for “Behavior”, the palette should look similar 
to Fig. 8-21. 

NOTE: If the palette fails to display the sublistings after you have added 
them, you may need to force it to redraw. Close the palette and then re-open 
it again. 

If you make an error during grade entry and need to correct the grade level, 
highlight the grade level and correct its text by placing the blinking cursor 
into the Title box. Then [TAB] out of the Title box and press the UPDATE 
button.

If you need to change the order of a grade level, highlight it and use either 
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the up (^) or the down (v) buttons to move it above or below the next grade 
level entry. Remember to click again on “Behavior” to highlight it after the 
edits, before adding any more new grade level(s).

Fig. 8-21. Appearance of the palette after adding six new sublistings (grade levels) to 
a new category (Behavior), on the goals/objectives palette.

5 Add a measurable objective for a particular grade level, by highlighting 
the grade level and then [ALT/OPTION]-clicking on the (+) button. Repeat 
as needed to define additional measurable objectives for this grade level 
and/or for other grade levels.

SELPA Manager will prompt you for the name (title) of the new item to be 
added beneath the grade level that is highlighted (Fig. 8-22). The 
measurable objective title is limited to 30 characters.



Fig. 8-22. Adding a sublisting (measurable objective) for a grade level, on the 
goals/objectives palette.

6 Add a goal beneath one of the measurable objectives. Highlight the 
measurable objective and [ALT/OPTION]-click on the (+) button. Repeat 
as necessary to add additional goals beneath this or other measurable 
objectives.

SELPA Manager will prompt you for the name (title) of the new item to be 
added beneath the measurable objective that is highlighted. Enter the goal 
title, up to 30 characters. 

Note that if you enter more than 30 characters, the goal title will be 
truncated. You can have a goal than is longer than 30 characters, but in this 
case the full text of the goal will need to be listed separately. In the example 
in Fig. 8-23, the user entered “Follows instructions from an authority”, 
which is longer than 30 characters. SELPA Manager truncated the title to 
“Follows instructions from an a”, but kept the full goal text listed below, in 
the larger, scrolling box at the bottom of the palette.
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Fig. 8-23. Adding a sublisting (goal) for a measurable objective, on the 
goals/objectives palette. In this case, the goal description (title) was longer than 30 
characters, and therefore was truncated. The long description remains in the lower 
box, however.

At this point, you might wish to edit the truncated title into something more 
coherent. You can also edit the full text, if desired. When you have finished 
editing the title and/or the full text, press the UPDATE button to save the 
changes (Fig. 8-24).

7 Add a benchmark beneath one of the goals. Highlight the goal and 
[ALT/OPTION]-click on the (+) button. Repeat as necessary to add 
additional benchmarks beneath this or other goals.

The benchmark title is limited to 30 characters. As before, however, you can 
have the full benchmark text listed below the title, in the lower box. The 
palette will place a green dot in front of each benchmark, to remind you that 
the benchmark level is the fifth (maximum) level of expansion in the palette 
(Fig. 8-25). It is also the level at which items can be copied from the palette 
to the student goal form or the assessment (IEP) form.



Fig. 8-24. Appearance of the goals/objectives palette after editing a goal title that was 
truncated.

Fig. 8-25. Appearance of the goals/objectives palette after adding and editing a 
benchmark. Benchmarks are at the final (fifth) expansion level of the palette, and are 
preceded by a green dot.
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NOTE: When SELPA Manager copies a benchmark from the palette to a 
particular student goal or IEP form, it will remove any leading numeric 
values (e.g., 1.0, 1.1, etc.), and attach the prefix, “Will improve ability to...” 
and the suffix, “...by...”, plus a future date (refer to “Using the 
goals/objectives palette” on page 441). Therefore, you should structure 
your benchmark sentences to work with these conventions.

You can add new goals or benchmarks to existing palette categories, grade 
levels, etc. For example, after importing the state goals/objectives for 
mathematics, you can then customize the grade levels, objectives, goals, 
and/or benchmarks for mathematics.

Exporting goals/objectives palette contents to 
another user
When you have customized the goals/objectives palette for use in your 
SELPA or district, you can then export the palette items to other SELPA 
Manager users. In this manner, each program user can have access to the 
same objectives, goals, and benchmarks.

To export the goals/objectives palette contents:

1 From the File menu, select “Export Goals and Objectives....”

The program will ask for confirmation that it should export the goals and 
objectives (Fig. 8-26).

Fig. 8-26. Confirmation dialog for exporting goals/objectives palette items.



2 Press the OK button on the confirmation dialog.

SELPA Manager will present a standard “save as”-type dialog for placing a 
new file on disk (Fig. 8-27).

Fig. 8-27. Save to disk dialog, for exporting goals/objectives palette items.

3 Name the export file and press the SAVE button.

Give the file a meaningful name (e.g., “MyGoalsObj_050201.txt”) and 
remember its location on disk. The file will be a delimited text file, with 
special delimiter characters. SELPA Manager will perform the export (you 
will see a progress thermometer), and then present a confirmation dialog 
when the export is complete (Fig. 8-28).

Fig. 8-28. Confirmation after exporting goals/objectives palette items.

4 Place the export file on a shared hard drive where other SELPA Manager 
users can access it, or attach it to an email message and send it to other 
program users.
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If you send the export file as an email attachment, ensure that your email 
program does not insert extra characters into text attachments; these extra 
characters will prevent the recipients from importing the file into their 
copies of SELPA Manager.

Importing goals/objectives palette contents from 
another user

To import the goals/objectives palette contents that was created by 
another user (using the steps outlined in the previous section):

1 From the File menu, select “Import....” and select “Goals and objectives 
(SELPA Mgr)” from the pop up list. Press the OK button.

SELPA Manager will present the import dialog (Fig. 8-29).

Fig. 8-29. SELPA Manager import dialog, showing the SELPA Manager 
goals/objectives import.

2 SELPA Manager will present a standard open file-type dialog. Select the 
export file on disk, and press the OPEN button.

Fig. 8-30 illustrates the open file dialog, with the name of the palette 
goals/objectives export file highlighted. SELPA Manager will attempt to 
import the contents of the file. If the file is in the correct format, then you 
will see progress thermometers on the screen, followed by a confirmation 
message when the import is complete.



Fig. 8-30. Standard open file dialog, showing the SELPA Manager goals/objectives file 
to be imported.

NOTE: If you already have some items in your goals/objectives palette, but 
wish to delete them prior to importing the file from disk, hold down the 
[ALT/OPTION] key while opening the palette. This operation works only if 
you are a member of the administration group (“AdminGroup”), in Users 
and Groups. 

To display the goals/objectives palette without opening a student goal or 
assessment form, you can press the GOALS/OBJECTIVES PALETTE button 
in Preferences (refer to the Chapter, “Configuring SELPA Manager” on 
page 267).

Editing an existing goal

To edit an existing student achievement goal (from the browse window):

1 Find the goal record in the goals browse list.

If there are a large number of goals listed, you may not be able to locate it 
immediately. There are several approaches to locating the record, some of 
which are listed here:

• Type the student’s name, or the beginning portion of the name, as <first 
name last name> or as <last name, first name> in the Location box, 
then press the [ENTER] key. SELPA Manager will find any goals 
associated with the student.
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• Type a portion of the goal text into the Location box, then press the 
[ENTER] key.

• Use a keyword sentence that does not change the browse window context, 
as in the following examples:
Last name is Battaglia
First is Sondra
Record number is 3968727-0000219-07
Contact is Joe Gruber
Stdnt number is 3378945
ID number is 3378945
id# is 3378945
dob is 7.21.64
SSN is 448-32-2199

NOTE: Some goals may be associated with assessment (IEP) forms. These 
goals will appear in orange text (unless “no styled browse text” has been 
selected in Preferences, refer to the Chapter, “Configuring SELPA 
Manager” on page 293). These goals can be edited, but not deleted, from the 
browse window.

2 Double-click on the row corresponding to the goal record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the goal/objective.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse window. 
Unless you have Auto re-sort lists turned on in Preferences, the row 
corresponding to the edited record should still be highlighted.

District chargeback report
[revised 9.17.2002]

The district chargeback report is a mechanism for a SELPA, county office, 
or other central facility to generate a statement of charges for services that 
the central facility provides to students from selected districts of residence.



You generate a district chargeback report when one or more districts (of 
residence) are listed in the browse window, by selecting “Print” from the 
File menu. SELPA Manager will then display the dialog shown in Fig. 8-31, 
from which you select the second (“2. District chargeback”) option.

Fig. 8-31. Print districts dialog.

The chargeback report in SELPA Manager can be produced using one of two 
methods:

(1) School name – by selecting a particular school of attendance where the 
services are provided, and by defining auxiliary service codes and charge 
rate information for the services that are provided; or

(2) School type – by specifying up to four types of school of attendance and 
associated per diem service fees.

The paragraphs that follow refer to these options as the Type 1 (“by school 
name”) and the Type 2 (“by school type”) chargeback reports. You select 
one of these two options just prior to printing, by configuring the report 
parameters under either the first tab (“By school name”) or under the second 
tab (“By school type”) of the chargeback print dialog, shown in Fig. 8-32. 

For a summary of the minimum information required to complete a printed 
chargeback report in Type 1 or Type 2 format, refer to “Chargeback report 
information requirements” on page 464. A more detailed discussion of both 
options follows immediately below (“Chargeback calculations” on 
page 458).

For instructions on generating a chargeback report, refer to “Generating the 
chargeback report” on page 467.
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Fig. 8-32. District chargeback report dialog, first tab (“By school name”).

Chargeback calculations
The chargeback calculations for Type 1 and Type 2 reports are substantially 
different.

Type 1 (by school name) calculations, general

For the Type 1 chargeback report, you will need to define the auxiliary 
service codes and associated fiscal information in Preferences (refer to the 
Chapter, “Configuring SELPA Manager” on page 262, and to “Defining 
auxiliary service codes (Type 1 report)” on page 465, below). 

Once the auxiliary codes are defined, they can be associated with specific 
student services. Services that do not have an associated auxiliary service 
code are not included in the total chargeback amount.



For a specified starting and ending date, SELPA Manager can tally the total 
days of each service, per pupil, for all special education students from a 
district of residence to a particular school of attendance/service location. 
Using the auxiliary code charge rates, it can also calculate the total cost that 
should be charged back to the district of residence.

SELPA Manager calculates the chargeback amount (dollars) for a child 
receiving a special education service over a period of time as follows (Fig. 
8-33),

Fig. 8-33. Chargeback calculation formula, Type 1 chargeback report.

where Daysservice represents the number of days that the student attends 
special education classes; Daysacademic yr. is the number of days in the 
school year, assumed to be 180; and Costannual is the cost per academic year, 
per pupil, of providing the service.

The ratio, [Levelstate / Levelactual] is sometimes called the service modifier. 
It varies with the particular special education service being provided, and 
with the age of the child. 

For example, suppose that the type of service is a special day class for a 
student that is hard of hearing. This service might have a state level 
(Levelstate) of 10. The actual level (Levelactual) is determined by where the 
child fits into a series of four age brackets. If the child is between the ages 
of 4 yrs 9 months and 8 yrs 9 months, for instance, then the actual level 
might be 8. Therefore, the service modifier would be (10/8), or 1.250. 

Suppose Johnny Smith, age 6, spent 50 days of the academic year in a 
county-sponsored special day class for hard-of-hearing students. Further 
suppose that the annual cost of providing this service is $6,800.00. Then the 
chargeback calculation would be,

Chargeback = (50/180) x (10/8) x (6,800) = $2,361.11

Ch ebackarg
Days

service

Days
academicyr

---------------------------------------
Level

state

Level
actual

---------------------------- Cost
annual

[ ]××=
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Of course, Johnny might have been provided with other, county-sponsored 
special education services over the course of the academic year, each of 
which might have had different service modifiers and annual per-pupil costs. 
Therefore, the total chargeback for Johnny would have to take into account 
all services provided, and the number of days that Johnny attended each 
service. Johnny also could have had a birthday during the chargeback 
period, and because of the age change he might have switched from one 
Levelactual tier to another -- affecting the service modifier calculation. 

As an additional wrinkle, the county / SELPA office might want to charge 
the districts on a monthly or quarterly basis, rather than at the end of the 
year. When figuring the cumulative days of Johnny's attendance over a given 
calendar span between two arbitrary dates, the county office might have to 
exclude Saturdays, Sundays, school district holidays, any days before 
Johnny's first service day, and any days after Johnny's drop (last) day.

Type 1 (by school name) calculations, program algorithm

The algorithm that SELPA Manager uses to arrive at the total for Type 1 
chargeback calculations is as follows:

1 Find the students whose districts of residence are the district(s) listed in 
the browse window.

2 Find any services for these students at the school of attendance 
specified on Tab 1 of the print chargeback dialog (Fig. 8-32).

3 Prepare a list of valid school days, from the start to the end of the 
chargeback time period, excluding weekends and district holidays1 as 
appropriate.

4 For each listed date, generate a set of “active” services, where the drop 
date is either blank or is after the listed date; where the start date for the 
service is on or before the listed date; and for the presently-displayed 
current or alternate year only.

5 For each listed date, intersect the selection of services from Step 4 with 
the selection of services from Step 2. The resulting selection represents 
the active services over each school day in the chargeback period, at the 
school of attendance, for students whose districts of residence are the 
district(s) listed in the browse window.

1. District holidays are specified on the District data entry form, refer to the Chapter,
“Entering Districts and Schools” on page 314.



6 For each service from Step 5 that has an auxiliary code with associated, 
age-based service rates (in Preferences), calculate the student’s age on 
the particular school day.

7 For each service from Step 6, using the formula in Fig. 8-33 with a 180-
day academic year, calculate the chargeback cost for that particular 
district-student-service-auxiliary code combination, on the particular 
day.

8 Add the daily chargeback cost from Step 7 to the cumulative subtotal for 
each district-student-service-auxiliary code combination.

9 Print the report, displaying subtotals for each district of residence and 
each student.

Fig. 8-34 is an example of a printed page from a Type 1 chargeback report. 
Note that each line represents the chargeback subtotal for a particular 
service which a student receives, over the period of time that the report 
covers.

Fig. 8-34. Sample print preview, Type 1 chargeback report.

Type 2 (by school type) calculations

The Type 2 chargeback calculations do not require the use of auxiliary 
service codes. Instead, SELPA Manager uses a flat, user-assigned per diem 
rate for each type of school. The student will incur a per-diem charge for 
each day within a specified time interval that s/he attends the school.1
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For example, suppose that you specify a Type 2 chargeback report for the 
month of September, for three types of schools: juvenile court schools, 
community schools, and parochial schools. Fig. 8-35, the second tab of the 
chargeback print dialog, illustrates the report options that might be selected 
for this example.

Fig. 8-35. District chargeback report dialog, second tab (“By school type”).

The steps that SELPA Manager will take to produce the report include the 
following items:

1 Find all schools of the type(s) requested (in Fig. 8-35).

In the example, SELPA Manager searches the [School] table for any 
juvenile court schools, community schools, or parochial schools.

2 Find all student services at the schools identified in Step 1.

3 For each district that is listed in the browse window, repeat the next 
sequence, from Step 4 – Step 10:

1. If the “Bill once per student/school type/day” box is checked in Fig. 8-35, then the
student will accumulate only one charge per school type per day, even if s/he has more
than one service at the school, on that date.



4 Find all students whose district of residence is the “current” district (the 
district being evaluated, from Step 3).

5 Find all services for the students in Step 4.

6 Intersect the services from Step 2 with the services from Step 5, to obtain 
the services for the current district, for the school type(s) requested.

7 Build a list of valid school days for the current district, for the chargeback 
period, excluding weekends and district holidays1 as appropriate.

8 For each listed school day, generate a set of “active” services, where the 
drop date for the service is either blank or is after the listed date; where 
the start date for the service is on or before the listed date; and where the 
service is for the presently-displayed current / alternate year only. 

9 For each active service, determine what per-diem charge should be 
applied.

If the service is at a school type corresponding to one of the requested types 
in district chargeback report dialog (Fig. 8-35), and the listed date is not a 
holiday for the school type on the calendar,2 then SELPA Manager will 
evaluate the per-diem charge as follows – 

If the box, “Bill once per student/school type/day” is checked (Fig. 8-35), 
and there is already another service that has accrued a charge for the student, 
on the listed school day, then the per-diem charge is zero. 

If the box is not checked, or there is not another per-diem charge that has 
accrued for the student on the listed school day, for the school type, then 
SELPA Manager will add one per-diem charge for the school type, as 
specified in Fig. 8-35.

10 Add the daily chargeback cost from Step 9 to the cumulative subtotal for 
each district-school type-student-service combination.

For example, suppose that May 2 is a school day at Forester Middle School, 
a public day school that Johnny Smith attends for his language and speech 
class. Further, suppose that the per-diem is $24 for public day schools. 

In this case, SELPA Manager would add $24 to the cumulative chargeback 
subtotal for Johnny Smith receiving language and speech services at public 
day schools.
1. District holidays are specified on the District data entry form.
2. The box, “Skip clndr holidays for type” must be checked in Fig. 8-35. To be consid-
ered as a holiday for a particular type of school, the calendar listing must be an event
of type “holiday”, with the school type listed in the description of the event. For exam-
ple, the description could be “Juvenile court school holiday”.
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11 Print the report, including subtotals for each district of residence and 
school type.

Fig. 8-36 is a sample print preview of a portion of a printed page, for the 
Type 2 chargeback report. School types (for the school of attendance) appear 
separately within each district of residence. 

The individual line items represent a student receiving a particular service 
for a cumulative number of days (the chargeback time period). Line items 
that have a zero cumulative total indicate that either (1) the per-diem charge 
is zero for the school type; or (2) that the student has more than one service 
at the same school on the same day, and the “Bill once per student/school 
type/day” box is checked in Fig. 8-35.

Fig. 8-36. Sample partial print preview, Type 2 chargeback report.

Chargeback report information requirements
In order to perform calculations for the Type 1 chargeback report, SELPA 
Manager needs to have the following information:

• The district(s) of residence (listed in the browse window).

• The annual cost of providing each county-provided special education 
service, per pupil (Costannual).



• The state service level (Levelstate) for each county-provided special 
education service.

• The actual service level (Levelactual) for each county-provided special 
education service, at four different age tiers: 
a) 3 yrs. 0 mos. to 4 yrs. 9 mos
b) 4 yrs. 9 mos. to 8 yrs. 9 mos.
c) 8 yrs. 9 mos. to 11 yrs. 9 mos.
d) 11 yrs. 9 mos. and older

• The association of auxiliary service codes with each student service, for 
county-provided special education services.

• The starting and ending dates for the billing period.

• The dates of any district holidays that should be excluded from the 
chargeback calculations (entered for the students’ districts of residence, 
refer to the Chapter, “Entering Districts and Schools” on page 314).

The first three items are entered in the process of defining auxiliary service 
codes (refer to “Defining auxiliary service codes (Type 1 report)” on 
page 465, below).

In order to perform calculations for the Type 2 chargeback report, SELPA 
Manager needs to have the following information:

• The district(s) of residence (listed in the browse window).

• The school types of one to four schools (for the schools of attendance).

• The per-diem chargeback rates for each type of school of attendance.

• The starting and ending dates for the billing period, and any excluded 
dates (weekends, district holidays, or school type holidays).

Defining auxiliary service codes (Type 1 report)

To define auxiliary service codes for the Type 1 chargeback report, and 
associated fiscal parameters:

1 From the File menu, select “Preferences...” 

SELPA Manager will display the Preferences dialog.

2 Go to the System 1 tab, and select the “Aux service code” list, and press 
EDIT.
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SELPA Manager will display a dialog for editing auxiliary service codes 
(Fig. 8-37).

3 To add a row to the list, press the (+) button on the dialog. 

SELPA Manager will add a new row for the auxiliary code, and the service 
title in the first column will appear as “Service [xxxx] - Name”. 

4 Double-click into the first column cell, and change the contents to an 
auxiliary code and/or name representing the special education service.

The code and/or name that you select here need not be the same as the 
CASEMIS code for the service (e.g., “410-50”, “420”, “52”, “66”, etc.). For 
example, you might have “SDC- hard of hearing”, “DIS-adaptive physical 
education”, etc.).

Fig. 8-37. Dialog for editing auxiliary service codes.

When figuring the charge-back fees, SELPA Manager uses the auxiliary 
code field to find cost information, and not the CASEMIS service 
code/name fields.1

1. However, when tallying chargeback costs for students, SELPA Manager does use a
combination of the student’s name, the CASEMIS service code, and the auxiliary ser-
vice code to define an array element, which is then used to accumulate total charges
for that particular service.



5 [Tab] or double-click with the cursor, to move into the second column (in 
the same row). Enter the state service level (Levelstate).

You will notice that SELPA Manager has already placed the number “24” 
into this cell. DIS services generally have a state level of 24, while SDC 
services usually have a state level of 10. If you are entering an SDC service, 
you may need to replace the 24 with a 10 in this cell. 

6 [Tab] or double-click with the cursor into each of the next four columns 
(in the same row). These columns represent four age tiers for the actual 
service level (Levelactual).

For each applicable age tier (“3->4.75 yr”; “4.75->8.75 yr”; “8.75->11.75 
yr”; and “11.75->yr”), enter the appropriate number. In the hard-of-hearing 
example for Johnny Smith (“Chargeback calculations” on page 458), the 
levels for the four age tiers are 6, 8, 8, and 8, respectively. If you don’t have 
an actual level for a particular age tier, then leave it as zero.

7 [Tab] or double-click with the cursor into the last column, to enter the 
annual cost of providing the service.

8 To add additional auxiliary service codes, repeat Steps 3 through 7, 
above.

9 Press the OK button to close the auxiliary service codes dialog.

10 Press the OK button on the “Set System Preferences...” dialog, to close 
Preferences.

Generating the chargeback report

To generate a chargeback report for one or more districts:

1 Ensure that all relevant information has been entered

Verify that you have entered all the bulleted items presented in “Chargeback 
report information requirements” on page 464. In particular, for the Type 1 
report, ensure that you have associated auxiliary service codes with each 
student service.

2 From the browse window, click on the Districts icon.

The browse window will change contexts, if necessary, so that districts 
appear in the upper list and schools appear in the lower list. 

After switching to the new context, the focus will be on the upper list. 
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3 Select the district(s) for which you want to run the chargeback report.

Use “Show subset” from the Data menu, or perform a search (query), to 
narrow the listed district(s) to only those districts of residence for which you 
want to run the chargeback report.

4 From the File menu, select Print...

SELPA Manager will present a dialog for printing districts (Fig. 8-31, 
shown previously).

5 Select the “2. District chargeback” option on the dialog, and press the OK 
button.

SELPA Manager will then present another dialog specifically for printing 
the district chargeback report (refer to Fig. 8-32, the first tab, for Type 1 
reports; or to Fig. 8-35, the second tab, for Type 2 reports). 

6 Select the appropriate tab depending upon the type of report to be 
created, “By school name” for the Type 1 chargeback or “By school type” 
for the Type 2 chargeback).

7 For Type 1 reports, select the school of attendance. For Type 2 reports, 
select up to 4 school types and the associated per-diem rates, for the 
schools of service.

For the Type 1 chargeback report, you cannot generate the report for more 
than one school of attendance at a time.

8 Select the starting and ending dates for the chargeback billing period.

During this time period, there must be active services for student(s) at the 
selected district(s) of residence, at the school(s) of attendance. For the Type 
1 report, these services must have associated auxiliary service codes with 
cost information. If there are no suitable services, then SELPA Manager will 
present an error message rather than printing a report.

9 Indicate whether the calculation should exclude Saturdays, Sundays, 
and/or holidays, by checking the appropriate boxes.

If you want to exclude district holidays, ensure that you have entered them 
already for each district, on the district data entry form (refer to the Chapter, 
“Entering Districts and Schools” on page 314). 

If you want to exclude holidays for particular school types, ensure that you 
have entered them on the Calendar for the appropriate date(s).1 

10 Select a name for the report



This name will appear in the header, for each page of the chargeback report.

11 Press the PRINT button. 

SELPA Manager will make a series of searches to get the appropriate 
services (refer to “Chargeback calculations” on page 458).

12 Once services have been tallied over the range of dates, SELPA Manager 
will present the Page Setup dialog for printing. Press the PRINT button.

The cumulative chargeback amounts are generated for the print only - 
SELPA Manager does not store them internally. Sample pages for a 
fictitious chargeback report appeared previously as Fig. 8-34 (Type 1 report) 
and Fig. 8-36 (Type 2 report).

1. The box, “Skip clndr holidays for type” must be checked in Fig. 8-35. To be consid-
ered as a holiday for a particular type of school, the calendar listing must be an event
of type “holiday”, with the school type listed in the description of the event. For exam-
ple, the description could be “Juvenile court school holiday”.
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 9 Entering Disciplinary Actions

Disciplinary actions are suspensions or expulsions that are associated with 
a particular student. You may add a disciplinary action for a particular 
student by going to Tab 6 (Discipline) of the Student data entry form, and 
then adding a new row to the disciplinary actions list (refer to “Discipline 
(Student Tab 6)” on page 399).

There are times, however, when you may wish to access the discipline 
record directly in its own data entry form, rather than in list view. The data 
entry form allows you to add paragraph-type notes more easily, and to 
compose a letter concerning the student, using the 4D Write (word 
processing) plug-in.

This chapter briefly covers use of the Disciplinary action data entry form, 
for entering the discipline record directly.

Adding a new disciplinary action

To add a new disciplinary action to the program (from the browse 
window):

1 Press the DISCIPLINE button.

The browse window will change contexts, if necessary, so that disciplinary 
actions appear in the upper list and students appear in the lower list (Fig. 9-
1). After switching to the new context, the focus will be on the upper list. 

If you did not switch contexts (you were already browsing disciplinary 
actions), then ensure that the focus is on the upper list.
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Fig. 9-1. Browse window displaying the Discipline context (disciplinary actions in 
upper list, students in lower list).

If you have not yet entered any disciplinary actions, or if you have specified 
in Preferences that the browse window should initially display no records, 
then the upper list will be empty (refer to “Browse window initial display 
options:” on page 296).

If there are existing records, then you will see the action type, start date, 
duration, report date, and code/reason information for each listed action. 
You can also use the horizontal scroll bar to view additional disciplinary 
information.

2 From the Data menu, select New record.

SELPA Manager will open a blank data entry form for disciplinary actions. 
(Fig. 9-2).



Fig. 9-2. Data entry form for a new disciplinary action.

3 Enter disciplinary action information onto the data entry form.

For each new disciplinary action, you must enter, at a minimum, the 
associated student, the action type (suspension or expulsion), the start date 
for the action, the primary (first) reason for the action, and the student status. 
The other fields are optional.

NOTE: Before you select “New record” from the Data menu, if you have 
highlighted a row in the lower list of the browse window (a student record), 
then the new disciplinary action form will already be linked to that student.

The data entry areas for the disciplinary action data entry form are:

• Student (1 entry area for record number, plus three display-only areas for 
last name, first name, and student number) – The student on whose behalf 
the disciplinary action is being taken. In the data entry area, you can type 
any of the following: the student’s last name, record number, student 
number, date of birth, Social Security Number, or first name. If the 
program finds more than one student that meet the criterion, it will 
display a scrollable list from which you can select one student. 
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Once a student is selected, the entry area will display the student record 
number.

NOTE: If you remove an existing record number from the entry area, the 
program will offer to delete the link to the existing student.

• Type (with pop-up list, restricted) – Type of disciplinary action, 
suspension or expulsion.

• Start on (date) – Date on which the action is scheduled to begin. Clicking 
the small button to the right of the field will place the date on the 
Calendar.

• Days (number) – The duration in days of the disciplinary action.

• Reasons (coded data, 3 pairs of two data entry areas, each with pop-up 
list, restricted) – A code and the corresponding reason representing the 
student behavior or action, which resulted in the disciplinary action. 
Enter up to three codes/reasons for each disciplinary action record. There 
must be a reason in the first pair of fields to save the record.

The Department of Education determines the codes and reasons in the 
pop-up lists. Consequently, they are not user-modifiable.

• Student status (coded data, 2 entry areas, each with pop-up list, 
restricted) – The student’s current status code and status description.

• Report date (date) – The date on which the disciplinary action was/is 
being reported. Clicking the small button to the right of the field will 
place the date on the Calendar.

• Notes (scrolling text area) – Other, textual information concerning the 
disciplinary action (up to 32,000 characters).

• Word processing (4D Write) – A small word processing window is 
located at the middle of the right-hand side of the discipline data entry 
form. The window allows you to create your own forms and other types 
of documents that make use of fields in the [Disciplinary_Action] table. 
When you save the record, the formatted text in the window is 
automatically saved to a field within the record. You can also save the 
document as a file on disk, using the word processing menus (File > Save 
As...).



To enlarge the word processing window, click on the zoom box in the 
upper-right corner. 

NOTE: If you have the multi-user version of SELPA Manager, you must 
specify the number of 4D Write licenses that you have installed on the server. 
The word processing area will not be available if there are more users 
connected to the program than there are 4D Write licenses. For more 
information, refer to the Chapter , “Configuring SELPA Manager” on 
page 243.

• User 1, User 2 (2 data entry areas and associated labels)– These custom 
fields are for your own use (up to 80 characters each). Name each field by 
clicking on the blank label to the left of the field.

NOTE: When you supply a custom name to a user field, the name applies 
only to your copy of SELPA Manager. If you will be exporting disciplinary 
action information to another copy of SELPA Manager (to the SELPA 
central office, for example), then all users in your SELPA should be storing 
the same type of information in each user field.

4 After completing the disciplinary action data entry form, press the SAVE 
button. 

The program will save the new disciplinary action record. If the Add new 
record loop option is turned on in Preferences, then the program will 
display a new, blank form for the next disciplinary action to be entered (refer 
to the Chapter, “Configuring SELPA Manager” on page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another disciplinary action, then repeat the instructions from 
Step 2 onward.

5 Repeat Step 2 through Step 4 for each disciplinary action that you wish 
to add. 

Once you have completed data entry, you may wish to browse the list of new 
disciplinary actions and review/print to verify proper entry.
Entering Disciplinary Actions 475 

• 
• 
• 
•
•
•



476  

• 
• 
• 
•
•
•

Modifying an existing disciplinary action

To modify a existing disciplinary action in the program (from the 
browse window):

1 Find the disciplinary action record in the appropriate browse list.

If there are a large number of actions listed, you may not be able to locate it 
immediately. There are several approaches to locating the record, some of 
which are listed here:

• Sort the list, by start date, report date, or other appropriate field, by 
clicking on the corresponding column header of the list. Scroll through 
the list until you find the record.

• Type the student’s last name, first name, combined (last, first) name, 
record number, student number, or Social Security Number in the 
Location box, then press the [ENTER] key.

• Type the action date, report date, reason, reason code, or student status 
code in the Location box, then press the [ENTER] key.

• Select the field, “Action start D” (disciplinary action start date) from the 
Location box pop-up menu, complete the sentence with the starting date 
of the action, and then press the [ENTER] key. For example (also shown 
in Fig. 9-3),
action start d is june 10

• Use a keyword sentence that does not change the browse window context, 
as in the following examples:
report date is august 9
action starts on 5.12.88
duration is greater than 20 (days)

2 Double-click on the row corresponding to the disciplinary action record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the disciplinary action.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse 
window. Unless you have Auto re-sort lists turned on in Preferences, 
the row corresponding to the edited record should still be highlighted.



Fig. 9-3. Finding an existing discipline record from the Location box.
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 10 Entering Assessment Information

Versions 4.50 and later of SELPA Manager contain an Assessment (IEP) 
section, which can be used to enter the results of the annual and 3-year 
student performance reviews. An assessment report (IEP form) can then be 
printed from the program in a standard format. 

To maximize the benefit of using the Assessment section, you should first 
enter basic information about the student(s) to be assessed in the Student 
section (for example, parent/guardian name, address, Social Security 
Number, residence code, etc. – refer to the Chapter, “Entering Students” on 
page 359). When this information is available in the Student section, the 
program copies it onto a new assessment form, thereby saving you the effort 
of re-entering it.

However, should you prefer, or if you do not have access to the student data 
entry form1, then you may add an assessment record for a student that hasn’t 
been entered into the program yet. 

If you have access to the browse window, type “New IEP for <student 
name>” into the Location box. If the student does not yet exist, SELPA 
Manager will prompt to select the district of residence for a new student.

If you have upgraded from a previous version of the program, then SELPA 
Manager may be displaying students above contacts, in the Student context 
of the browse window. To access the Assessments section, however, you will 
want to specify “Students / assessments” or “Assessments / students” for the 
first browse window context, from the Preferences control panel, 
Appearances tab (refer to the Chapter, “Configuring SELPA Manager” on 
page 298). 

1. Program users who log into SELPA Manager using the “TeacherLtdGrp” access
group do not have access to student data entry forms or to the browse window. Please
refer to the discussion in the next section.
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As a shortcut to temporarily display assessment information, you can type 
the word “assessment” into the Location box. In this case, SELPA Manager 
will display assessment information until you next switch the browse 
window to a new context.

This chapter covers use of the Assessment data entry form, for entering or 
editing student assessment information. If your SELPA has a customized 
assessment form that has been added to SELPA Manager, then the data entry 
form in your copy of SELPA Manager may differ from the default form 
discussed here.1 Similarly, you may see assessment fields in the Query 
Editor, Sort Editor, and Quick Report Editor that are not available if you 
select another SELPA in Preferences.Some field names are specific to a 
particular SELPA, and thus are not displayed for users in other SELPAs.

Restricted-access users (“TeacherLtdGrp”)
If you use SELPA Manager as a member of the “TeacherLtdGrp” access 
group, then you will not see the browse window interface that other users 
see when they first connect to the program.Instead, SELPA Manager 
initially presents a blank assessment (IEP) form for data entry. 

If you would like to enter a new IEP, then you can use the blank form that 
SELPA Manager presents, following the instructions in the next section, 
starting at Step 7 on page 485. 

If SELPA Manager does not recognize student name that you enter onto the 
blank IEP form, then it will create a new student record corresponding to the 
information you enter onto the IEP form (at the time that you save the IEP 
form). The program will also create a new student if you enter the name of 
an existing student, but for whom you are not listed as the provider for at 
least one service. 

Instead of adding an IEP, if you wish to review or modify an existing IEP 
form, then hold down the [ALT/OPTION] key while selecting “New 
window” from the File menu. This action will cause the program to present 
a list of any available, existing IEPs, for students with whom you have at 
least one service. If there are not any existing IEPs that meet these criteria, 
then the program will display an error message (Fig. 10-1).

1. The default assessment form is modeled from the SELPA 4100 (San Mateo) forms.



Fig. 10-1. Error message, displayed to “TeacherLtdGrp” access group users when 
there are no existing IEP forms available for viewing / editing.

Another technique for finding existing IEP forms involves the use of a pop-
up menu that appears on the IEP form itself. 

Adding a new assessment
Assessment (IEP) forms can be added to SELPA Manager for existing 
students, or for students that have not yet been entered into the program. For 
a new student, the program will ask you to specify the district of residence, 
and it will create the student record when you save the assessment form.

Adding an assessment for an existing student

To add a new assessment (IEP) record to the program for an existing 
student (from the browse window):

1 Ensure that access to the Assessment section is enabled in Preferences.

From the File menu, select “Preferences” and go to the Appearance tab. The 
first browse window context should either be “Students / assessments” or 
“Assessments / students”, as shown in Fig. 10-2. For more information on 
configuring SELPA Manager refer to the Chapter, “Configuring SELPA 
Manager” on page 243.
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Fig. 10-2. To display the Assessment section, the item, “Students / assessments” or 
“Assessments / students”, should be selected on the Appearance tab of Preferences.

2 Press the STUDENTS button.

The browse window will change contexts, if necessary, to the first (students) 
context. If you have selected “Students / assessments” as your preference, 
then students appear in the upper list and assessments appear in the lower 
list (Fig. 10-3). The lower list should have an orange title bar (if it does not, 
refer to the previous step). After switching to the new context, the focus will 
be on the upper (students) list. 

If you have specified in Preferences that the browse window should initially 
display no records, then the upper list will be empty (refer to “Browse 
window initial display options:” on page 296).

Otherwise, if there are existing student records, then you will see the student 
names and associated information in the upper list. Clicking on a student 
that has assessments in the program will cause SELPA Manager to display 
the corresponding assessment record(s) in the lower list.



Fig. 10-3. Students browse window context, showing assessments (rather than 
contacts) in the lower list.

3 In the upper list, find the name of the student for whom you are adding 
an assessment.

There are several approaches to locating the student record, some of which 
are listed here:

• Sort the list by student last name, by clicking in the first column header 
of the student list. Scroll through the list until you find the student record.

• Type the student’s name (or the beginning portion of the name), record 
number, student number, Social Security Number, or date of birth in the 
Location box, then press the [ENTER] key.

• Select the field, “last name” from the Location box pop-up menu, 
complete the sentence with the student’s family name (or portion 
thereof), and then press the [ENTER] key. For example,
last name is smathers

• If you only type in the first one or two letters of the student’s name, then 
all students whose last name begins with those two letters will appear in 
the browse list. This feature is useful if you are not sure about the specific 
spelling of a student’s name.
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ab
last name is ab

• Use any of the following words in a simple sentence, with an appropriate 
search criterion: name, contact, record number, student number, id 
number, dob, birthday, birth date, ssn. These phrases are not case-
sensitive. For example,
ssn is 423-338-4489
name is Mitchell, Tyler
ID Number is 43879
contact is Reginald Smith
DOB is 7/19/1952

4 Highlight the name of the student by clicking on it, in the students list.

5 Change the focus to the lower list, either by clicking once in the lower list 
or by pressing the LOWER radio button.

For more information on changing the current focus, refer to “Changing the 
browse view (context)” on page 169).

NOTE: Do NOT click on an existing assessment in the lower list, as this 
action will remove the highlight from the upper list. Instead, click on the 
empty, gray area of the lower list. 

6 From the Data menu, select New record.

SELPA Manager will open a new data entry form for entering an 
assessment. Fig. 10-4 illustrates the default (SELPA 4100) form. Initially, 
the form will open to the first of eight tabs, “IEP 1”.

Depending upon the size of the browse window before opening the 
assessment data entry form, you may see the window re-size itself to 
accommodate the larger width of the assessment form.

A significant difference between the assessment form and other data entry 
forms in SELPA Manager is the use of scroll bars. Most other data entry 
forms do not use horizontal or vertical scroll bars. With the assessment form, 
however, they are used to enable you to move around in sections on a 
“virtual” page. 



Fig. 10-4. Data entry form for a new assessment, first (IEP 1) tab, view of upper area 
on the form. Note the use of both horizontal and vertical scroll bars.

In order to access the record navigation buttons (to save or cancel the new 
record), you must either scroll to the bottom of the form, or use one of the 
keystroke shortcuts: [ENTER] for saving the record or [ESC] for canceling 
the record.

NOTE: Version of SELPA Manager prior to v.4.701 have a redraw problem 
that, after scrolling the assessment form, appears to prevent you from 
entering information into fields that have associated pop-up choice lists. 
Because of this problem, you should try to enter information into data entry 
areas with choice lists BEFORE you scroll the form. Data entry areas with 
choice lists generally appear on the upper part of the form.

If a data entry area exhibits the problematic behavior, you can force the form 
to refresh by moving to another tab on the form, and then moving back. For 
example, click on the IEP 2 tab, then back on the IEP 1 tab; or, use the 
shortcuts, [CNTRL/CMD]-[Right arrow] followed by [CNTRL/CMD]-[Left 
arrow]. You may also want to re-size the window to a larger (vertical) size.

7 Enter assessment information onto the data entry form.
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For each new assessment, you must enter, at a minimum, the associated 
student, the assessment meeting type, and the meeting date. The other fields 
are optional. At lower right, on the bottom of the form, is a list of items that 
have yet to be completed or that must be corrected to save the record 
(“missing/problem item(s)”). As you enter information into the fields, this 
list should diminish in length. When there are no items listed, the SAVE 
button at the bottom of the form will changed from disabled to enabled.

If the associated student record for a new assessment has certain information 
available, then SELPA Manager will “clone” that information into the new 
assessment record. Accordingly, the following fields may be completed for 
you when the form is first opened:

• Student name (first name plus last name), ethnicity, gender, date of birth, 
and grade level.

• Calculated age (based upon date of birth and the meeting date, which 
initially is the current date).

• Date started special education (original entry date); annual review date 
(next IEP date); triennial review date (next evaluation date); and other 
review date.

• School of attendance, school of residence, residence code, home 
language, LEP, and primary disability.

• Parent name, address, and telephone (from the contact record that has the 
“ST Res”, student resides here, box checked).

NOTE: Because these fields are copies of information that exists in the 
[Student] table, you can change their contents without affecting the original 
information. When you save the assessment form, if you have made changes 
to some of the student information, SELPA Manager will offer to update the 
associated student record.

For SELPA 0901 (El Dorado), the program will copy portions of the current 
services for the student into an [Assessment_Disposition] table, which 
appears as a list at the top of the “Form 4” tab (not shown). Changes to 
these records do not have any effect upon the original [Student_service] 
records for the student.

8 After completing the assessment data entry form, press the SAVE button. 



The program will save the new assessment record. If you have made changes 
to student-related information for an existing student, then SELPA Manager 
will ask you whether you want to update this information on the student 
record as well (Fig. 10-5).

Fig. 10-5. Dialog displayed when an assessment is saved, and SELPA Manager detects 
changes to student-level information on the assessment form. Accepting the form (OK 
button) updates the student record.

If the Add new record loop option is turned on in Preferences, then the 
program will display a new, blank form for the next assessment to be entered 
(refer to the Chapter, “Configuring SELPA Manager” on page 293).

If you do not have the add new record loop preference activated, but you 
wish to add another assessment, then repeat the instructions from Step 3 
onward.

9 Repeat Step 3 through Step 8 for each assessment that you wish to add. 

Once you have completed data entry, you may wish to browse the list of new 
assessments and review/print to verify proper entry.

Adding an assessment for a new or an existing 
student (alternate method)
A shortcut to adding a new assessment in the browse window is to type a 
request into the Location box of the following form: 

new assessment for <student name>
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For example:

new assessment for Joan Waltham

new IEP for Adolphus O’Malley

This request can be typed into the Location box regardless of the current 
context (Students, Teachers, Districts, etc., refer to the example in Fig. 10-
6), and irrespective of the setting in Preferences for the first context display 
(refer to “Adding an assessment for an existing student” on page 481). 

The browse window will switch to the Students context and (if necessary) 
temporarily display Assessments as the upper list. 

If the student name is not found among existing students in the program, 
SELPA Manager assumes that a new student record is to be added 
simultaneously with the assessment form. In this case, the program displays 
an add student dialog, asking you to confirm the new student’s name and to 
select the new student’s district of residence (Fig. 10-7).

Fig. 10-6. Request in the Location box for a new assessment (IEP) form. This request 
can be made with any context being displayed.



Fig. 10-7. Request for a new assessment (IEP) form. SELPA Manager could not find 
the student, so it is assuming that a new student is to be added simultaneously.

Once the name of the new student is confirmed and the district is selected, 
SELPA Manager displays the first tab of a new assessment form (Fig. 10-8).

After you have completed the assessment form, when you press the SAVE 
button on the form, SELPA Manager will sequentially create the new 
student record and the assessment record. Because some of the information 
necessary for a complete student record is not present on the assessment 
form, SELPA Manager stamps the student record as Do Not Report (DNR, 
refer to the Chapter, “Entering Students” on page 367).
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Fig. 10-8. Appearance of a new assessment (IEP) form., where a new student is to be 
added simultaneously with the assessment.

IEP 1 (Assessment Tab 1, default form)
Here are the display and data entry areas for Tab 1 (IEP 1) of the assessment 
data entry form.

• Review date (Annual) (date) – The date for the next IEP meeting.

• Review date (Triennial) (date) – The date for the next triennial 
evaluation.

• Student name (display only, upper right corner) – The student’s name, 
as <first name last name>. If the student is new (to be created 
simultaneously with the assessment record), then no name will appear 
here.

• IEP Meeting (with pop-up list, restricted) – The type or nature of the IEP 
meeting: initial, annual, exit, expulsion, etc.

• Date student entered special ed. (date) – The date on which the student 
first entered the special education program.

• Meeting date (date) – The scheduled date for the assessment meeting, for 
which the assessment form is being prepared.If this date and the date of 
birth are available, then SELPA Manager will calculate the student’s age 
between these two dates.



• Student – Name of the student, as <last name, first name>. If the 
student is new (to be added simultaneously with the assessment form), 
then the suffix “(add new)” will appear after the name.

NOTE: If you change to another student name, and SELPA Manager 
recognizes the new name as belonging to an existing student in the program, 
then, as you [TAB] out of this area, it will copy the student-related fields for 
that student onto the assessment form. If the previous student name also 
existed in SELPA Manager, it will first ask you to confirm that the previous 
student link should be deleted.

• SS# - Social Security Number for the student.

• Birth date (date entry area) – Student’s date of birth.

• CA (display only) – Student’s calculated age, from date of birth to the 
scheduled meeting date. If the meeting date is blank, then SELPA 
Manager will calculate the age based upon today’s date.

• Parent/guardian –Name of the parent or guardian for the student. 

• School of attend. (2 data entry areas) – Student’s school of attendance. 
The first area is for the 7-digit school code, and the second area holds the 
school name. You may enter either the school code or the school name 
into either area, and the program will attempt to complete both areas.

• Grade – The current scholastic grade level of the student. Enter the 2-
digit grade code.

• Address (2 lines for street address; plus city, state, and postal code) – The 
parent or guardian’s residence address. If you enter a Zip code into the 
postal code area, the program will attempt to complete the city and state 
from its Postal Code section listings. Similarly, if the phone numbers are 
blank and the area code is available from the Postal Code listings, the 
program will insert the area code for the home and work telephone 
numbers.

• Dist/Sch of Residence (2 data entry areas) – Student’s school of 
residence. The first area is for the 7-digit school code, and the second area 
holds the school name. You may enter either the school code or the school 
name into either area, and the program will attempt to complete both 
areas.

• Tel h; Tel w (2 data entry areas, each with a button) – The home and work 
telephone numbers for the parent or guardian. The areas are pre-
formatted in the standard, 10-digit area code plus phone number format. 
You need enter only the digits. After the last digit is entered, the cursor 
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automatically moves to the next field (without using the [TAB] key).

The buttons to the left of the telephone numbers will dial the number, 
provided that you have configured modem dialing in the Preferences 
dialog. If you [ALT/OPTION]-click on the button, you can clear the 
contents of the telephone entry area.

• Residence (coded, with pop-up list, restricted) – Student’s residential 
status. Enter the 2-digit code, the description, or select from the pop-up 
menu.

• Gender – Gender of the student (“M” or “F”).

• Primary lang. (coded, with pop-up list, restricted) – Student’s primary 
language spoken at home. Enter the 2-digit code, the description, or 
select from the pop-up menu.

• LEP (checkbox)– Limited English Proficiency. Student’s home language 
is not English, and the student does not have the English-language skills 
necessary to succeed in the school’s regular education program. LEP 
cannot be selected if the primary language is English.

• FEP (checkbox)– Fluent English Proficiency (the student speaks English 
fluently).

• English only (checkbox) – The student speaks only the English 
language.

• Ethnicity (coded, with pop-up list, restricted) – Student’s ethnic 
background. Enter the 3-digit code, the description, or select from the 
pop-up menu. 

• Certification of eligibility / Not eligible for special education 
(checkbox) – Indicates that the student is deemed to be ineligible for 
special education services. Checking this box will cause the “certified 
eligible for special education as” box to be un-checked.

• Certification of eligibility /Certified eligible for special education as: 
(checkbox) – Indicates that the student is deemed to be eligible for 
special education services, with the primary disability indicated in the 
next data entry area (below). Checking this box will cause the “not 
eligible for special education” box to be un-checked.

• Primary (coded, with pop-up list, restricted) – Student’s primary 
disability or handicap. Enter the 3-digit disability code, the description, 
or select from the pop-up menu.



• Other disabilities... (list, with pull-down menu and delete button) – If 
the student has other (non-primary) disabilities, you may select the 
additional disabilities from the pull-down menu. SELPA Manager will 
not allow you to enter the same disability more than once, whether 
primary or not.

To remove a listed, non-primary disability, highlight it and press the 
DELETE (-) button.

NOTE: You may find it necessary to scroll the window downward, to view the 
next group of data entry areas on the form (Fig. 10-9).

Fig. 10-9. Data entry form for a new assessment, first (IEP 1) tab, view of lower area 
on the form.

• List areas of strength – The student’s areas of strength. You may enter 
up to 32,000 characters, but the printed form will not display text that 
exceeds the available space on the form.

• List areas of need – The student’s areas of need. You may enter up to 
32,000 characters, but the printed form will not display text that exceeds 
the available space on the form.
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• Service delivery options considered – Options considered to provide 
educational services to the student. You may enter up to 32,000 
characters, but the printed form will not display text that exceeds the 
available space on the form.

• Rationale for decision – Reason(s) for the selected option(s) for 
providing academic services to the student. You may enter up to 32,000 
characters, but the printed form will not display text that exceeds the 
available space on the form.

IEP 2 (Assessment Tab 2, default form)
Here are the display and data entry areas for Tab 2 (IEP 2) of the default 
assessment data entry form (Fig. 10-10 and Fig. 10-11).

Fig. 10-10. Data entry form for a new assessment, second (IEP 2) tab, view of upper 
area on the form.



• Participation in General Education Program (yes/no radio buttons) – 
A “yes” selection indicates that the student participates to some degree in 
regular academic and/or regular non-academic school programs. A “no” 
selection indicates no participation (at any level) in regular (general) 
education.

• Percent of time in General Education (number) – The portion of time, 
expressed as a percentage, that the student spends in regular (general) 
education programs. If a number greater than zero is entered here, then 
the Participation in General Education Program should be marked 
“yes”.

• If Yes, Academic Areas (text entry area with pop-up) – The academic 
areas of general education in which the student participates. If 
information is entered here, then the Participation in General 
Education Program should be marked “yes”.

Select item(s) from the pop-up list or type the description directly into the 
field. The pop-up places each selected item on a new line, and will not 
allow you to enter the same item more than once. When entering 
information directly into the field (without using the pop-up), you can 
add items in any format that you wish.

To edit the choice list of academic areas for the pop-up, press the small 
rectangular button beneath the pop-up.

NOTE: If you press CANCEL, to close the Assessments data entry form 
without saving changes, then any modifications that you may have made to 
the pop-up lists (using the rectangular button) will not be saved.

• Non-Academic Areas (text entry area with pop-up) – The non-academic 
areas of general education in which the student participates. If 
information is entered here, then the Participation in General 
Education Program should be marked “yes”. 

Select item(s) from the pop-up list or type the description directly into the 
field. The pop-up places each selected item on a new line, and will not 
allow you to enter the same item more than once. When entering 
information directly into the field (without using the pop-up), you can 
add items in any format that you wish.

To edit the choice list of non-academic areas for the pop-up, press the 
small rectangular button beneath the pop-up.
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• If No, Provide Rationale – Reason(s) why the student does not 
participate to any degree in general (regular) education.If information is 
entered here, then the Participation in General Education Program 
should be marked “no” and the Percent of time in General Education 
number should be zero.

Recommendations for Special Education and Related Services Based on IEP 
Team Findings. This table contains a eight-by-six matrix of instructional 
settings and services for the student, as determined during the IEP meeting. 
The next six bulleted items describe the columns in the table.

NOTE: The Subject Areas Non Intensive row/service does not have an entry 
area for each column. Instead, there is one entry area for the entire row. The 
The sixth and seventh rows of the table have entry areas in the border 
(Service) column, allowing you to identify unlisted services.

• Personnel Responsible (first column) – The name of the special 
education teacher or other personnel who will provide services to the 
student, in each specific area. 

• Initiation date (second column, date entry) – The date on which the 
service is scheduled to begin for the student. 

• Duration (third column, number) – The number of days over which the 
service is to be provided. This number should not exceed one year (365 
days).

• Frequency (Min. per wk) (fourth column, number) – The total number 
of minutes per week for the service.

• Location Code (fifth column, coded, with pop-up list) – The two-digit 
code for the location where the service is to be provided.

• Service Code (sixth column, coded, with pop-up list) – The service 
delivery code for the service (e.g., “CC” – collaboration consultation; 
“DS” – direct service).

Other fields (below the services matrix):

• Does student need ESY to receive FAPE (Yes/No buttons) – Student 
requires an extended service year to receive Free Appropriate Public 
Education (FAPE).



• DIS/Transportation (with pop-up list containing teacher names) – The 
personnel providing and/or the type of transportation services to be 
provided to the student.

Fig. 10-11. Data entry form for a new assessment, second (IEP 2) tab, view of lower 
area on the form.

• Physical Education (with pop-up list) – The type of physical education 
program that the student requires.

• Pre-Vocational/Vocational Goal Included (Yes/No buttons) – A “yes” 
selection indicates that a pre-vocational or vocational goal is included in 
the IEP.

• General Education Accommodations are needed (2 fields; one yes/no 
and one descriptive text) – If the “yes” button is pressed, use the text entry 
area to describe the type of general education accommodations that are 
necessary for the student.

• Additional information (text entry area) – Additional information 
pertinent to the student’s ability to achieve the goals of the IEP.
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IEP 3 (Assessment Tab 3, default form)
The display and data entry areas for the upper portion of Tab 3 (IEP 3) of the 
assessment data entry form appear in Fig. 10-12, below.

Fig. 10-12. Data entry form for a new assessment, third (IEP 3) tab, view of upper area 
on the form.

• Primary language (please specify) (coded, with pop-up list, restricted) 
– Student’s primary language spoken at home. Enter the 2-digit code, the 
description, or select from the pop-up menu.

• Accommodations...if yes, explain (text entry area) – Description of 
accommodations made in the special education program for the student’s 
language proficiency.

• Is this student visually impaired / address possible Braille instruction 
needs (Yes/No buttons and text entry area) – Indicate that a student is 
visually impaired by pressing the “Yes” button, and then discuss needs 
for instruction in Braille, if any.

• Is this student deaf or hard of hearing/ consider the child’s language 
and communication needs (Yes/No buttons and text entry area) – 
Indicate that a student is hearing impaired by pressing the “Yes” button, 
and then discuss the child’s language and communication needs.



• Assistive technology: does the student require assistive devices... 
(Yes/No buttons and data entry area) – If assistive devices, equipment, 
services, or assessment is/are required to meet goals and objectives and 
access to the core curriculum, press the “Yes” button and use the data 
entry area to specify the types of devices, etc.

• Student behavior (four Yes/No buttons) – Use these buttons to indicate 
whether the student is able to follow school rules or (if not) whether some 
behavioral adaptations are necessary to deal with behavioral issues.

IEP 4 (Assessment Tab 4, default form)
Tab 4 contains an area for the free-form entry of supplemental information 
on the IEP, plus an area at the bottom for signatures. The display and data 
entry areas for the upper portion of the form appear in Fig. 10-13, below.

Fig. 10-13. Data entry form for a new assessment, fourth (IEP 4) tab, view of upper 
area on the form.

• Additional information (text entry area) – Other information related to 
the student’s educational program.
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• Prior contacts made (2 date entry areas) – Identify the date of any prior 
contact(s) with the parent, either by mail or by telephone. 

• Parent/guardian attended meeting (Yes/No buttons) – Indicate 
whether the parent or guardian attended the assessment meeting.

• Parent’s Comments (text entry area) – Parent’s observations and 
remarks concerning the student’s educational program.

• Student enrolled in private school by parents refer... (check box) – 
Indicates that the parents of students enrolled in a private school should 
refer to the Service Plan for the student.

IEP 4.1 (Assessment Tab 5, default form)
Tab 5 contains parameters related to state or district-wide standardized 
testing, and the high school exit examination (where applicable). The upper 
portion of the form appears in Fig. 10-14.

Fig. 10-14. Data entry form for a new assessment, fifth (IEP 4.1) tab, view of upper 
area on the form.



• The student is to be tested with general education standards 
(standardized testing, checkbox) – Indicate whether the student is to be 
tested with general education standards.

• Standard accommodations (standardized testing, 4 check boxes and 3 
data entry areas) – Indicate the standard modifications, if any, that may 
be necessary to evaluate the student’s performance. For flexible setting or 
revised test format, specify the rationale in the corresponding data entry 
area. For the revised test directions option, specify any portions of the text 
that are to be read to the student.

• Non-standard accommodations (standardized testing, 4 check boxes 
and 2 data entry areas) – Indicate the non-standard modifications, if any, 
that may be necessary to evaluate the student’s performance. For the use 
of aide or instructional assistants, identify the specific type of aid or 
instructional assistant in the data entry area. For exempting specific 
portions of the test, indicate the rationale for the exemption(s).

• Student is to be exempted from state/district-wide standardized 
testing...the reason for exemption is – If the student is to be exempted 
from standardized testing, specify the reason for exemption. 

• Alternative assessment will be done (checkbox) – Check the box if 
performing an alternative assessment.

High school exit examination parameters

• Type of participation (with pop-up list, restricted) – Use this area to 
indicate whether the student will participate in the high school exit 
examination and, if so, whether accommodations are required.

• Presentation accommodations (4 check boxes) – Check the appropriate 
box to indicate whether large print, Braille transcriptions, markers, 
masks, reduced numbers of items per page, and/or signed or oral 
directions are needed for the testing to take place.

• Response accommodations (2 check boxes) – Check the appropriate 
box if any special accommodations must be made for the student to 
register his/her responses to the test questions.

• Timing/scheduling accommodations (3 check boxes) – Check the 
appropriate box to indicate whether additional time, more frequent 
breaks, or multiple sessions are required.

• Setting accommodations (4 check boxes) – Check the appropriate box 
to indicate whether special furniture, lighting or acoustics, individual 
area, or a separate room are required.
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• English language learners may utilize the following additional 
accommodations (2 check boxes) – Check the appropriate box to 
indicate whether a primary-language-to-English glossary or testing in a 
small group is appropriate.

IEP 5 (Assessment Tab 6, default form)
The display and data entry areas for the upper portion of Tab 6 (IEP 5) of the 
assessment data entry form appear in Fig. 10-15, below. Tab 6 is used to add 
specific goals and objectives for the student’s assessment. The goals may be 
entered by manually typing into the various fields, or by selecting from 
listed items in the goals/objectives palette, discussed below.

To enter goal information on this tab, you must first create one or more new 
goal records for the assessment, by pressing the ADD (+) button. Each time 
you press the (+) button, SELPA Manager creates (and then displays) one 
new goal record for the particular assessment form. Each goal record in the 
assessment becomes a separate “IEP 5-1” page when printed.

If multiple goals are entered for a particular assessment, then you can 
navigate among these goals, one at a time, by clicking on the up or down 
arrow buttons along the left edge (Fig. 10-15). The goal number being 
displayed is listed between the two arrow buttons. You can also enter a 
specific goal number that you wish to view, and then press the [TAB] key.

Alternatively, you can also press the ALL button to display all goals for the 
assessment simultaneously, then moving among them by manipulating the 
inner, vertical scroll bar on the right-hand side. When all goals for an 
assessment are displayed, the goal number indicator between the arrows will 
be empty.

The inner, vertical scroll bar is also active when you initially open an 
existing assessment record that contains multiple goals.

To remove a goal record from the list, click into one of the data entry areas 
for the displayed goal and then press the DELETE (-) button.

• Area of need (2 data entry areas) – The first data entry area is for an 
optional number, to indicate the goal/objective number. The second data 
entry area indicates the name of the area of need (e.g., mathematics, 
language arts, etc.)



• Measurable annual goal (text entry area and two check boxes: “enables 
student to be involved with general education”; and “addresses other 
educational needs due to the disability”) – Specify the name of the 
measurable annual goal (measurable objective) to be achieved by the next 
annual review (e.g., “Listening and speaking strategies,” “Literary 
response and analysis,” “writing strategies,” etc.). If either of the two 
check boxes is relevant to the measurable annual goal, then the 
appropriate box(es) should be checked.

• Goal (text entry) – Specify the goal to be achieved (e.g., “research and 
technology,” “organization and focus,” “comprehension and analysis of 
grade-level-appropriate text,” etc.).

Fig. 10-15. Data entry form for a new assessment, sixth (IEP 5) tab, view of upper area 
on the form. Note the presence of an inner, vertical scroll bar, used to move among the 
goal/objectives for this assessment.

• Present level and performance to be reviewed by (text entry) – The 
name and/or description of the personnel who will monitor / review 
progress toward the goal.

• Alt. assessment: Content: (2 entry areas, coded data entry, restricted) – 
The content areas for the alternate assessment, if an alternate assessment 
is to be conducted for the student.1 The item to be selected should be the 
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one that best describes the instructional goal for the student. 

Provided that the student is otherwise eligible for the 2000-2001 
CASEMIS Table A export, the presence of this code determines whether 
the student will also be reported in the alternate assessment table 
(following the generation of Table C, in the 2000-2001 CASEMIS 
report). 

• Mastery (2 entry areas, coded, restricted) – The degree of mastery 
exhibited by the student towards the instructional goal. This item is 
related to the alternate assessment.

• Not met because (2 entry areas, coded, restricted) – The reason, if any, 
that the student has not met the goal of the alternate assessment.

• Baseline data and methods used to measure progress (3 entry areas, 
with pop-up choice list) – The means by which progress is to be measured 
(e.g., testing, work sample, etc.). The pop-up choice lists can be turned 
off by disabling goal/objective pop-ups in Preferences (refer to the 
Chapter, “Configuring SELPA Manager” on page 277).

• Short Term Objective/Benchmark (3 text entry areas) – The specific 
benchmark(s) to be used in measuring whether the student achieves the 
goal. Each of the three benchmarks is associated with six date and 
progress level fields, described next.

• Progress review (Date/Level) (six date areas and six progress level areas 
for each benchmark; with pop-up choice lists) – The date and level of 
progress made (e.g., no progress, partial progress, etc., by the specified 
date). The date entry areas display a pop-up choice list of dates, either one 
year’s worth of days into the future, or selected dates from the Calendar 
section (refer to the discussion of benchmark dates in the Chapter, 
“Configuring SELPA Manager” on page 276). 

The date/level choice lists can be turned off by disabling goal/objective 
pop-ups in Preferences (refer to the Chapter, “Configuring SELPA 
Manager” on page 277).

• Display goals/objectives palette (L+, button) – Press this button to 
display the goals/objectives palette. The palette can be used to add 
standardized benchmarks and companion goals for the student. For more 
details on using and customizing the goals/objectives palette, refer to 

1. The student record should be marked with a STAR Code of 90. Refer to the Chapter,
“Entering Students” on page 377.



“Goals/objectives palette” on page 438. 

The items listed in the palette represent a “menu” of possible goals and 
benchmarks that can be assigned to a particular student. When you select 
an item from the palette for use with a student, SELPA Manager copies 
the benchmark, the goal, the objective, and the area of need (category) 
from the palette onto a particular goal record. You can copy up to three 
benchmarks from the palette onto a goal record (Fig. 10-16).

Before using the palette, make sure that you have at least one goal record 
that is currently selected (the cursor is placed into a data entry area on the 
goal). Each benchmark that you add to a single record should be from the 
same goal in the palette, rather than from different goals.

Fig. 10-16. Using the goals/objectives palette to enter benchmarks (and associated 
goals) to the IEP5 tab, for an assessment. As many as three benchmarks can be entered 
for each goal record.

• Link unattached goal (A+, button) – Pressing this button allows you to 
associate pre-existing, “unattached” goals with this assessment form. 
Unattached goals are created in the Goals context of the browse window, 
by selecting “New record” from the Data menu (refer to “Goal entry” on 
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page 427). They are associated with a student, but not with an assessment 
record.

If there are unattached goals for the student, then SELPA Manager will 
present a dialog allowing you to select among them for the one to 
associate with the assessment. If there are no unattached goals available 
for the student, SELPA Manager will present an alert message instead.

• Previous goal (up arrow, button) – Pressing this button will cause SELPA 
Manager to display the previous goal, when multiple goal records exist 
for an assessment.

• Goal number (entry/display area, numeric) – Shows the number of the 
goal currently being displayed, based upon its order/placement in the 
current selection of goals. If more than one goal is currently being 
displayed, then this area will be empty. 

If you enter a number and [TAB] out of the area, then SELPA Manager 
will search for the goal(s) having the goal/objective number as entered 
(refer to the two “area of need” fields, page 502), for the current 
assessment record. If more than one goal is found with the same number, 
SELPA Manager will display an alert. If no goal is found with that 
number, but there are multiple goals for the assessment, then SELPA 
Manager will sort the goals by goal/objective number, and then select the 
“nth” goal in the sort order to display (where “n” is the number entered 
into the display).

Entering the number zero (“0”) or removing an existing, non-zero entry 
will display all goals for the current assessment.

• Next goal (down arrow, button) – Pressing this button will cause SELPA 
Manager to display the next goal, when multiple goal records exist for an 
assessment.

• All (button) – Pressing this button will find all goals for the current 
assessment. The goal number display will be empty. The inner, vertical 
scroll bar at right can now be used to move among the goal records.

Team certification (Assessment Tab 7, default form)
Tab 7 contains information confirming the eligibility of the student for 
special education services. The display and data entry areas for the upper 
portion of the form appear in Fig. 10-17, below.



Fig. 10-17. Data entry form for a new assessment, seventh (Team certification) tab, 
view of upper area on the form.

• I. The student demonstrates a severe discrepancy...measured by 
standardized achievement tests (Yes/No radio buttons) – Check “Yes” 
to indicate that the student demonstrates a severe discrepancy between 
intellectual ability and achievement, based upon standardized 
evaluations. In this case, the “alternative measures” radio buttons, 
discussed below, should be set to “No”; the program will make this 
change as necessary.

• Ability Test(s) (Specify): (text entry area) – Use this area to describe 
specific ability test scores used to identify an ability-achievement 
discrepancy.

• Achievement Test(s) (Specify): (text entry area) – Use this area to 
describe specific achievement test scores used to identify an ability-
achievement discrepancy.

• The IEP Team finds that a discrepancy exists based upon alternative 
measures... (Yes/No radio buttons) – Check “Yes” if the IEP Team used 
alternative measures to determine that an ability-achievement 
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discrepancy exists for the student. In this case, the previous “Yes/No” 
radio buttons for a discrepancy on standardized tests should be set to 
“No”; the program will make this change as necessary.

• II. The discrepancy exists in one or more of the academic areas 
checked below: (Yes/No radio buttons and seven check boxes) – Identify 
the academic area in which the discrepancy exists, if any: oral expression, 
listening comprehension, written expression, basic reading skills, reading 
comprehension, mathematics calculation, and/or mathematics reasoning. 
Checking any of the boxes will set the “Yes/No” buttons to “Yes”.

• III. The discrepancy is due to a disorder in one or more of the basic 
psychological processes checked below: (Yes/No radio buttons and 
seven check boxes) – Identify the psychological processes in which the 
disorder exists, if any: attention, visual processing, auditory processing, 
sensory-motor skills, cognitive association, cognitive conceptualization, 
and/or cognitive expression. Checking any of the boxes will set the 
“Yes/No” buttons to “Yes”.

• IV. The discrepancy is primarily the result of the following: (7 Yes/No 
radio buttons) – Check item(s) as appropriate. The presence of any of 
these items disqualifies the student under severe learning disability 
(SLD) for special education.

• V. The discrepancy is corroborated by other assessment data... 
(Yes/No radio button) – Check “Yes” if appropriate.

• VI. These deficits adversely affect the student’s educational 
performance... (Yes/No radio button) – Check “Yes” if appropriate.

• VII. The student’s needs cannot be met solely within the general 
education classroom setting... (Yes/No radio button) – Check “Yes” if 
appropriate. This item is the final certification that the student requires 
special education services. It also appears on the IEP1 tab as the check 
box, “certified eligible for special education as:”, discussed on page 492.

Assessment results (Assessment Tab 8, default form)
Tab 8 contains detailed assessments of the student’s present level of 
performance. The display and data entry areas for the upper portion of the 
form appear in Fig. 10-18, below.



Fig. 10-18. Data entry form for a new assessment, eighth (Assessment results) tab, view 
of upper area on the form.

• Person(s) completing assessment(s)/present level of performance – 
Indicate the name of the person completing the assessment record 
information.

• Assessment information / present level of performance (9 check boxes 
and a text entry area) – Check any of the boxes representing area(s) that 
are discussed in the text entry area (pre-academic/academic, 
communication, social adaptation, vocational, psychomotor, self-help 
skills, psychological, leisure skills, and/or other). 

The text entry area is intended to be a description of each evaluation 
procedure, test, record, report, or observation used as a basis for 
proposing or refusing service. Comments may also be included 
concerning the student’s progress in the general curriculum.

Modifying an existing assessment

To modify a existing assessment in the program (from the browse 
window):

1 Find the assessment record in the appropriate browse list.
Entering Assessment Information 509 

• 
• 
• 
•
•
•



510  

• 
• 
• 
•
•
•

If there are a large number of assessments listed, you may not be able to 
locate it immediately. There are several approaches to locating the record, 
some of which are listed here:

• Sort the list by meeting date, student name, or other appropriate field, by 
clicking on the corresponding column header of the list. Scroll through 
the list until you find the record.

• Type the student’s last name, first name, combined (last, first) name, 
record number, student number, or Social Security Number in the 
Location box, then press the [ENTER] key.

• Type the parent/guardian’s name, the home phone number, the IEP 
meeting type, or the meeting date in the Location box, then press the 
[ENTER] key.

• Use a keyword sentence that does not change the browse window context, 
as in the following examples:
Last is O’Malley
First is Quentin
Contact is Maureen Gibcier
Guardian is Harold Van Deventer
Type is initial
Work phone is (209) 538-3389

2 Double-click on the row corresponding to the assessment record.

Alternatively, you can single-click on the row to highlight it, and then select 
Modify record from the Data menu. 

SELPA Manager will open the data entry form for the assessment.

3 Make changes to the form as appropriate, then press the SAVE button.

SELPA Manager saves the changes, and returns you to the browse window. 
Unless you have Auto re-sort lists turned on in Preferences, the row 
corresponding to the edited record should still be highlighted.



• • • • • •
 11 File Menu Operations

Many of the tasks in SELPA Manager can be performed by making use of 
menu items. The purpose of this chapter is to summarize the operations that 
are available in the File menu 

[rev. 9.23.2002]

The five principal menus of a workstation running SELPA Manager are File, 
Edit, Window, Data, and Actions. These menu items appear in both the 
single-user runtime version and the client-server version of the program.

The File, Edit, and Window menus are always visible, although the items in 
each menu that are enabled will depend upon the context in which you 
access the menus. 

The Data and Actions menus are visible when SELPA Manager is displaying 
a browse window as the active (front-most) window. The Chapter, “Data 
Menu Operations” on page 607, describes the items in the Data menu, while 
the Chapter, “Actions Menu Operations” on page 651, describes the items in 
the Actions menu.

When no windows are displayed other than the status bar (a narrow sliver 
of a window at the lower right corner of your screen), then the Data and 
Actions menus will not be visible. Similarly, when you click on the status 
bar to make it the active window, then the Data and Actions menus will 
disappear.

This chapter does not discuss the items that appear on the menus on the 
server computer. To install the server computer software on a multi-user 
installation of SELPA Manager, refer to “PC client-server (server 
installation)” on page 57 or to “Macintosh client-server (client installation)” 
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on page 118. For a more detailed look at the various menu items that are 
available in the 4D Server application, please refer to the documentation for 
4D Server.1 2

If SELPA Manager is not yet installed on your computer, please refer to 
“Getting started” on page 134. If SELPA Manager is installed on your 
computer, but you have not yet started using the program, then we 
recommend that you refer to “Getting started” on page 134.

File menu overview
The File menu items include displaying the 
basic SELPA Manager program window (the 
browse window); setting system-wide 
parameters; selecting display and usage 
preferences for each program user; creating 
program users and associated passwords; 
administering user access privileges3; importing 
and exporting students and associated 
information; printing reports; making 
information available on the World Wide Web; 
and quitting (exiting) the program. 

Not all items will be available at all times. For 
example, the “Transfer...” item is available only 

when students, assessments, or goals has the current focus in the browse 
window. Several items in the File menu are disabled when you are editing a 
student or other record.

New window
• Function: Displays a new browse window, initially in the Students 

context, with the default display configurations as set in Preferences 
(refer to the Chapter , “Configuring SELPA Manager” on page 295).

1. 4D SA/ 4D Inc., 4D Server Reference, Version 6.0 for Windows ® and Mac™ OS.
Cupertino: 1985-1997, 4D SA/4D Inc.
2. 4D SA/ 4D Inc., 4D Server Reference, Version 6.7 for Windows ® and Mac™ OS.
Cupertino: 2001, 4D SA/4D Inc.
3. Users without administrative privileges do not see the “Users and groups...” item;
instead, they have access to a “Change password...” item.



• Shortcut key: [CNTRL/CMD]-1

• Modifier key: If the [SHIFT] key is held down while selecting this menu 
item, SELPA Manager will create a new browse window with double the 
normal “procedure stack” memory allocation, 256 KB instead of 128 KB. 
Use this feature if you receive “stack is full” error messages, or if 
instructed to do so by Fusion Technik. Having additional procedure stack 
memory available does not affect the memory allocation for storing or 
displaying the record information itself.

• Accessible from: Other browse windows; data entry forms; the status 
bar.

• Accessible to: All users.

• Notes/limitations: 

To conserve memory, the program will display a maximum of 6 browse 
windows simultaneously. Because data entry forms are accessed from 
within browse windows, this restriction means that the program will display 
a maximum of 6 browse and/or data entry forms at the same time.1

Selecting this menu item repeatedly will cause the new windows to “tile” 
from upper left to lower right, subject to the available space on the screen. 
If the lower right corner is reached, then the next window will begin at the 
upper left again.

SELPA Manager is based upon the 4th Dimension database engine, which 
is a multi-threaded application. Each open browse window has its own 
memory and variable allocations. 

As an example, you can have two student lists open simultaneously, each 
containing the same or a different selection of students. However, if you 
attempt to display two data entry forms in the two windows, for the same 
student, then the program will present an error message as you double-click 
on the second listed instance of the same student record (Fig. 11-1). 

1. Some SELPA Manager users have reported occasional problems opening multiple
browse windows, when using the Windows 95 operating system. Additionally, open-
ing, closing, and re-opening many browse windows in rapid succession may cause
SELPA Manager to quit unexpectedly.
File Menu Operations 513 

• 
• 
• 
•
•
•



514  

• 
• 
• 
•
•
•

Two or more different windows can list the same record(s) at the same time, 
but only one can edit the record at one time, because the first window has 
“locked” the record to other windows and other program users.1

Fig. 11-1. Locked record warning, when attempting to edit a record. This message 
appears when another window is already displaying a data entry form for the same 
record.

Import...
• Function: Selecting “Import...” from the File menu causes SELPA 

Manager to display a dialog box of import types (Fig. 11-2). From this 
dialog, administrative-level users can import information from other 
programs, or from other copies of SELPA Manager.

• Shortcut key: None.

Fig. 11-2. Import dialog (File menu -> Import...).

1. It is possible to display a second data entry form for the same record, if more than
one record is listed in the browse window. Double-click on another, adjacent record
and then use the arrow keys to move backward or forward. In this case, SELPA Man-
ager will present another warning message when it arrives at the locked record. It will
then display the data entry form for the locked record, with the SAVE button disabled.



• Modifier key: For members of the “AdminGroup” access group, holding 
down the [ALT/OPTION] key while selecting this item will cause the 
program to offer to close an import file that was left in an open state, on 
disk. This operation should not be necessary under ordinary 
circumstances. 

• Accessible from: Browse windows, the status bar.

• Accessible to: Users that have read-write access to SELPA Manager 
(“ReadWriteGrp”).

• Notes/limitations: 

The import dialog box offers access to many different data-reading and 
parsing routines. 

The import routines that are available on the import dialog include the 
following items:

SELPA Central Import
[rev. 12/6/2002]

Reads a special-format, delimited text file on disk that is generated by 
another SELPA Manager user. The other SELPA Manager user generated 
this file using the “Districts to central...” export (page 569). The text file can 
contain one or more selected districts, or a particular group of students (and 
associated districts, schools, teachers, etc.) selected by the sender.

When you select the SELPA Central import option and press the OK button, 
SELPA Manager will prompt you to select a SELPA Central import file that 
is on your hard disk. If you select a file that is not in the correct format, then 
SELPA Manager will display an error message and the import will not 
proceed. If the file is in the correct format, then SELPA Manager will 
display a confirmation dialog prior to continuing (Fig. 11-3).

SELPA Central import files can contain records from the following tables: 
districts, schools, teachers, teacher services, teacher assignments, students, 
contacts, disciplinary actions, student services, assessments, assessment 
dispositions, other disabilities (for assessments), goals, transitions, test 
scores, and attendance items.
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In addition to creating new records, the SELPA Central import has the 
capability of updating existing records, when it is able to detect them. The 
confirmation dialog includes a series of check boxes that enable you to 
specify in which tables the import should be allowed to update existing 
records. 

The default option is for records in all import tables to be updated. To 
prevent existing record updates for a particular table, un-check the box 
corresponding to the table name. To prevent existing record updates in any 
tables, press the [U]NCHECK ALL button. Even if the box for a particular 
table is not checked, the import will still create new records (if it finds no 
match for the import data among the existing records).

Fig. 11-3. Sample SELPA Central import confirmation dialog.

Existing students are located on the basis of their record numbers.1 
However, when the INTERACTIVE box is checked on the confirmation 
dialog (Fig. 11-3), if SELPA Manager cannot find a matching student record 
on the basis of the record number, then it will also search for student records 
with the same last name, gender, and date of birth. If any matches are found 
from this search, then the program will present a dialog prompting the user 
to select one of the records (“Associate <student name> to an existing 



student”). If the user cancels the dialog, the program will offer to create a 
new student record; declining this offer will cause the program to skip the 
student being imported.

Matches for existing records in tables other than students are based upon a 
variety of search criteria. For example, student service matches are based 
upon the student, CASEMIS service code, service starting date1, and the 
time and date of original record creation. School matches are based upon the 
school code and, if the “shared school codes” box is checked in 
Preferences2, also on the school name.

The SELPA Central import procedure reads the incoming data using the 
table and field definitions of the receiving (“target”) copy of SELPA 
Manager. Therefore, it is advisable to use the same version of SELPA 
Manager for importation as the sender used originally to generate the import 
file. SELPA Manager will display a warning in the confirmation dialog, if 
the sending and receiving versions of the program do not match. In some 
cases, if the source and target versions of the program are too far apart, the 
program will not allow the import to proceed.

Be sure that you read the full contents of the confirmation dialog before 
proceeding with the SELPA Central import.

1. SELPA Manager checks the incoming student record number for matches with the
[Student]Record_number field. If the student is not found, and there is a non-blank
SELPA 3.5-4.5 record number in the incoming data, then the program also checks the
[Student]Record_number_400 field for matches. 

Record numbers in SELPA Manager prior to v.4.6 had an “old” format of 7-7-2 digits
(“xxxxxxx-xxxxxxx-xx”) rather than 7-5-4 digits (“xxxxxxx-xxxxx-xxxx”). When a
copy of SELPA Manager v. 4.5x and earlier is opened in Version 4.6 or later, the pro-
gram issues new record numbers in the 7-5-4 digit format to all student records with
the same site number suffix. It places the previous 7-7-2 format record number into the
[Student]Record_number_400 field.
1. Student service starting date is not used as a matching criterion when the “no start
date match on stdnt services” box is checked in Preferences (refer to the Chapter,
“Configuring SELPA Manager” on page 260).
2. Refer to the Chapter, “Configuring SELPA Manager” on page 270.
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District-to-district import
Reads a special-format, delimited text file on disk. This file is generated by 
another SELPA Manager user, using the “Transfer...” (export to disk) option 
for a selected group of students. 

When you select the district-to-district import option and press the OK 
button, SELPA Manager will prompt you to select an import file that is 
located on your hard disk. If you select a file that is not in the correct format, 
then SELPA Manager will display an error message (the import will not 
proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

After pressing the OK button on the confirmation dialog, you will next see 
a dialog that lists existing districts. Select the district into which the transfer 
students should be placed by highlighting the corresponding row in the 
table, and then press the OK button.

District-to -district import files can contain records from the following 
tables: students, contacts, disciplinary actions, student services, 
assessments, assessment dispositions, other disabilities (for assessments), 
goals, transitions, and test scores. 

The district-to-district import will not update existing records; however, it 
will attach new, student-related records (disciplinary actions, student 
services, goals, etc.) to an existing student. The import searches for an 
existing student by record number or by previous record number.1

The district-to-district import reads the incoming data using the table and 
field definitions of the receiving (“target”) copy of SELPA Manager. 
Therefore, it is advisable to use the same version of SELPA Manager for 

1. The district-to-district import checks the incoming student record number for match-
es with the [Student]Record_number field, the [Student]Record_number_prev field, or
the [Student]Record_number_400 field. 

If a matching student record is found and the record is not locked, the import writes a
long integer key to the student record for linking related services, disciplinary actions,
etc. If the student is not found, then the import creates a new student, places the incom-
ing record number into the [Student]Record_number_prev field, and issues a new
record number in the new district.



importation as the sender used originally to generate the import file. SELPA 
Manager will display a warning in the confirmation dialog, if the sending 
and receiving versions of the program do not match.

SELPA Manager 3.5x
Reads a special-format, delimited text file that is generated from a pre-1999 
version of SELPA Manager, either v. 3.57 or 3.58. These older versions used 
a much different table structure than the current version of SELPA Manager. 

When you select the SELPA Manager 3.5x import option and press the OK 
button, SELPA Manager will prompt you to select an import file that is on 
your hard disk. If you select a file that is not in the correct format, then 
SELPA Manager will display an error message (the import will not 
proceed). If the file is in the correct format, then SELPA Manager will 
display a confirmation dialog prior to continuing.

SELPA Manager 3.5x import files can contain information from the 
following tables (in the earlier version): districts, schools, teachers, students, 
student services, and transportation.

This import will only create new records; it cannot update existing records 
in any table. The criterion for finding an existing student is based upon 
searching the [Student]Record_number_400 field.1

170-column CASEMIS (1998-99)
Reads a 170-column (169 columns plus return character, fixed), 34-field, 
student and services file that is in the format used for state reporting in the 
1998-1999 calendar year. The field and column specification appears in the 
table below.

1. Record numbers in SELPA Manager v.3.5x had the “old” format of 7-7-2 digits
(“xxxxxxx-xxxxxxx-xx”) rather than 7-5-4 digits (“xxxxxxx-xxxxx-xxxx”).

Field listing for 170-columna CASEMIS (1998-99) import.

Field Start Length CASEMIS name, description

1 1 8 REPT_DATE, report as of date

2 9 4 SELPA_CODE, code for current SELPA
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3 13 4 SELPA_FROM, code for “from” SELPA

4 17 7 DIST_SERV, district of service

5 24 7 DIST_RESI, district of residence

6 31 7 SCH_CODE, school of attendance

7 38 2 SCH_TYPE, type code for school of attendance

8 40 15 LAST_NAME 

9 55 15 FIRST_NAME

10 70 16 STUDENT_ID

11 86 9 SSN

12 95 8 BIRTHDATE, date

13 103 1 SEX, M or F

14 104 3 ETHNICITY, code

15 107 1 LEP, Limited English Proficiency (Y/T or N/F)

16 108 2 HOME_LANG, home language code

17 110 1 MIGRANT, migrant education (Y/T or N/F)

18 111 2 RESID_STAT, residential status

19 113 8 ENTRY_DATE, date

20 121 8 LAST_IEP, date

21 129 8 LAST_3_YR, date

22 137 3 HANDICAP, primary disability code

23 140 3 PLACEMENT, primary placement

24 143 2 INFANT_SET, infant setting code

25 145 2 MAINSTREAM, percent in general educ.

26 147 2 GRADE, codes 01 through 18

27 149 1 RIS, requires intensive services (Y/T or N/F)

Field listing for 170-columna CASEMIS (1998-99) import.

Field Start Length CASEMIS name, description



If the file to be imported does not contain exactly 170 columns, then SELPA 
Manager will check for two possible variants:

1. If the file contains 160 columns (including the return delimiter), then the 
program will offer to run the import assuming that the exit date and exit 
reason are not included.

2. If the file contains 173 columns (including the return delimiter), then the 
program will offer to place the contents of the 3 extra columns into the field, 
[Student]User_alpha_1, for each imported student.

If the file to be imported does not contain either 160, 170, or 173 columns 
(with delimiter), then SELPA Manager will present an error message, and 
the import will not proceed.

The import creates new student and associated service, school, and district 
records. It will not update existing records. The criteria for finding existing 
students (and therefore excluding import lines) are as follows:

1. If the length of the record number in the import file (with leading zeroes 
removed) is 16 characters, then SELPA Manager inserts hyphens to create 
the 7-5-4 digit format, and searches for an existing record with the same 7-
5-4 number ([Student]Record_number field). If no student is found, then the 
program also searches the [Student]Record_number_prev field.

28 150 2 TOTAL_DIS, number of provided services

29 152 2 DIS1, first service code

30 154 2 DIS2, second service code

31 156 2 DIS3, third service code

32 158 2 DIS4, fourth service code

33 160 8 EXIT_DATE, date exited special ed

34 168 2 EXIT_RESON, reason code for exiting special ed

a. 169 data columns plus a return character as the delimiter.

Field listing for 170-columna CASEMIS (1998-99) import.

Field Start Length CASEMIS name, description
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2. If the length of the record number with leading zeroes removed is not 16 
characters, or if the search in Item 1 did not find an existing student, then 
SELPA Manager queries for an existing student record that has the same 
student number, without the hyphens inserted, using the 
[Student]Student_number field.

3. If the searches in Items 1 and 2 do not find an existing student in SELPA 
Manager, then the program performs a final search on last name, date of 
birth, gender, and (if available) the Social Security Number of the student 
from the import file.1 If no existing student is found, then SELPA Manager 
creates a new student record.

Other import (pull-down menu)
Provides several other import types, which are listed in a pull-down menu 
(Fig. 11-4). Select the import type from the pull-down menu, then press the 
OK button to proceed. The remaining portion of the “Import...” section 
discusses the import types that are included in the “Other import” pull down 
menu, individually.

Assessment (full IEP form)
Reads a special-format, delimited text file on disk, containing student IEP 
information. This file is generated by another SELPA Manager user, using 
the “Transfer...” option for a selected group of assessment (IEP) records. 

When you select this option and press the OK button, SELPA Manager will 
prompt you to select an import file that is on your hard disk. If you select a 
file that is not in the correct format, then SELPA Manager will display an 
error message (the import will not proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

1. Note that this final search could prevent the second of two twins from being import-
ed, if neither of the twins have Social Security Numbers.



Fig. 11-4. Import dialog (File menu -> Import...), showing the “other import” 
selections.

The import has the capability of creating records in the following tables: 
[Student], [Assessment], [Assessment_disposition], 
[Assessmt_other_disability] (secondary disabilities), [Assessment_goal] 
(student goals), and [Test_score]. Only certain IEP forms (for particular 
SELPAs) will create records in the auxiliary tables (other than [Student] and 
[Assessment]).

This import does not modify existing records, except to write keys for 
linking with records in the auxiliary tables.

Some of the IEP forms in SELPA Manager have the capability of creating 
associated [Student_service] records for the student. However, this import 
does not make any changes to the [Student_service] table. Therefore, if the 
student(s) being imported already exist in your copy of the program, 
importing the IEP information will not affect the existing students’ services. 

A corollary to this point is that if the student(s) do not already exist in your 
copy of SELPA Manager, then this import routine will create new student 
records that lack associated services.
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The criteria for finding an existing student record during the import are as 
follows: 

1. SELPA Manager searches for an existing student by querying for the field, 
[Student]Record_number. If the student record is found, the program 
associates the IEP information to be imported with that existing student 
record.

2. If no student record is found, SELPA Manager queries again for a student 
having the same last name, gender, and date of birth as the student whose 
IEP information is being imported. If one or more student records is found, 
the program prompts the user to select the correct student with whom to 
associate the IEP information.

3. If the user cancels the association request, the program offers to create a 
new student record for the IEP information (OK button) or to skip to the next 
student and associated IEP information.

Choice list items
Reads a special-format, delimited text file on disk, containing a custom list 
of items for a choice list, that was created on the System settings tab of 
Preferences (refer to “System 1 Tab, overview” on page 255). This file is 
generated by another SELPA Manager user who has administrative access 
(“AdminGroup”) to the program.

When you select this import option and press the OK button, SELPA 
Manager will prompt you to select an import file that is on your hard disk. 
If you select a file that is not in the correct format, then SELPA Manager will 
display an error message (the import will not proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

This import will not modify items that you may already have in the choice 
list, for your SELPA Manager data file. 

If there are existing items in the program for this choice list, prior to running 
the import, then SELPA Manager will warn you that they exist. The program 
will offer to delete the existing items prior to importing the new items. If you 



do not delete the existing items, then you should examine the choice list 
carefully after the import process has completed, to remove any 
redundancies manually.

Discipline (CASEMIS Tbl C)
Reads a 48-column (fixed width), 10-field, disciplinary action file that is in 
the format used for state reporting in the 2000-2001 calendar year. The field 
and column specification appears in the table below. 

Field listing for 48-columna CASEMIS Table C (2000-2001) import.

a. 48 data columns plus a return character as the delimiter.

Field Start Length CASEMIS name, description

1 1 8 REPT_DATE, date of report (MM/DD/CCYY)

2 9 4 SELPA_CODE, SELPA or state-operated program 
reporting data (CCCC)

3 13 16 STUDENT_ID, student identification code 
(CCCCCCCCCCCCCCCC) 

4 29 8 DSPL_DATE, date of the disciplinary action 
(MM/DD/CCYY)

5 37 1 DSPL_TYPE, type of the disciplinary action (S or E)

6 38 3 DSPL_DAYS, number of days the disciplinary action 
is effective (DDD)

7 41 2 REASON1, primary reason (code) for the disciplinary 
action (DD)

8 43 2 REASON2, a second reason (code) for the 
disciplinary action (if any) (DD)

9 45 2 REASON3, a third reason (code) for the disciplinary 
action (if any) (DD)

10 47 2 DSPL_STAT, Status of the student as a result of the 
disciplinary action
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SELPA Manager attempts to associate the disciplinary action information 
being imported with an existing student, by searching for a record number 
([Student]Record_number) that matches the STUDENT_ID data (with 
hyphens inserted to make SELPA Manager’s “7-5-4” -digit format). 

If the student cannot be located, or if the STUDENT_ID cannot be placed in 
7-5-4 digit format, then the program performs an alternate search for 
STUDENT_ID in the [Student]Student_number field, without adding 
hyphens and after stripping off any leading zeroes from the STUDENT_ID.

If the program cannot find an existing student record corresponding to the 
STUDENT_ID, then it skips to the next disciplinary action to be read, 
without importing the previous disciplinary information. This import 
routine will not create new student records.

SELPA Manager does not check for the existence of a similar disciplinary 
action in the program prior to importation. Therefore, repeated imports of he 
same disciplinary action file on disk can create multiple records for the same 
disciplinary action(s).

NOTE: The 2001-2002 CASEMIS Table C has a different format from the 
2000-2001 table, and contains additional fields. This import does not yet 
read the 2001-2002 format. 

Discipline (generic)
Reads a 12-field, delimited text file on disk containing information related 
to disciplinary actions for one or more students. The default delimiters are 
[Tab] (ASCII 9) and [Return] (ASCII 13), although the user can specify 
custom delimiters in the confirmation dialog for the import (Fig. 11-5).

The fields to be read and their order of appearance are listed in the table 
below. SELPA Manager attempts to associate the discipline information 
with an existing [Student] by searching the [Student]Student_number. If no 
student is found, it then searches the [Student]Record_number field and 
(finally) the Social Security number field.If no corresponding student record 
is found, the program does not import the disciplinary data, instead skipping 
to the next line of the import file.



Fig. 11-5. Confirmation dialog for the Discipline (generic) import.

Field listing for Discipline (generic) import

Field Length Name, description

1 18 STUDENT_ID, the [Student]Student_number, 
[Student]Record_number, or [Student]SSN (Social 
Security number).

2 30 Action type (suspension or expulsion)

3 (date) Action start date

4 (nbr) Action duration (days)

5 (date) Report date (Report As Of date)

6 2 Reason code, representing the primary reason for the 
action

7 2 Reason code, representing another reason for the 
action (if any)

8 2 Reason code, representing a third reason for the 
action (if any)

9 2 Student status code
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SELPA Manager does not check for the existence of a similar disciplinary 
action in the program prior to importation. Therefore, repeated imports of he 
same disciplinary action file on disk can create multiple records for the same 
disciplinary action(s).

Districts (generic)
Reads a 2-field or 3-field, delimited text file on disk containing district 
listings. The default delimiters are [Tab] (ASCII 9) and [Return] (ASCII 
13), although the user can specify custom delimiters in the confirmation 
dialog for the import. If the optional, third field occurs in the first line of the 
import, then SELPA Manager will prepend the contents of the third field to 
the district name (second field imported).

This import will add a new district record, provided that the district code 
being imported does not already exist in the program. It will not update 
existing district records.

10 80 User Field 1

11 80 User Field 2

12 (text) Discipline comment / note

Field listing for District (generic) import

Field Length Name, description

1 7 District code (all numeric digits)

2 40 District name

3 40 
(Items 
2+3)

District name modifier (optional), prepended to 
district name field (Item 2).

Field listing for Discipline (generic) import

Field Length Name, description



Districts (San Mateo)
Reads a 3-field, delimited text file on disk containing district information for 
San Mateo SELPA. 

The default delimiters are [Tab] (ASCII 9) and [Return] (ASCII 13), 
although the user can specify custom delimiters in the confirmation dialog 
for the import. 

The program will not import any line item that does not have a 7-digit 
district code (Item 3 in the table). The San Mateo district code in Field 1 will 
be prepended on the district name, as “[x]-DistrictName”.

This import will add a new district record, provided that the district code 
being imported does not already exist in the program. It will not update 
existing district records.

Enrollments (aux., San Mateo) 
Reads a 110-column, fixed-column file on disk, of auxiliary student service 
information, specifically for San Mateo SELPA. The field definitions appear 
in the following table.

Field listing for District (San Mateo) import

Field Length Name, description

1 1 San Mateo district code (alpha)

2 40 District name

3 7 CDS (district) code 

Field listing for Enrollment (aux. San Mateo) import

Field Start Length Name, description

1 1 6 Student number

- 7 1 ! delimiter (not a data field)

2 8 3 San Mateo service code (placed into 
[Student_service]Session_note field; converted to 
the corresponding CASEMIS service code when 
adding a new record).
File Menu Operations 529 

• 
• 
• 
•
•
•



530  

• 
• 
• 
•
•
•

This import routine is intended to update existing student service records in 
SELPA Manager with certain information (school, teacher, service code, 
start date, San Mateo “change” date, exit date and reason, SUB, LOC, LEV, 
and remarks). 

The program finds an existing student service record (if possible) by 
matching against the student number, the service start date, and the 
primary/non-primary status of the service. 

If no existing student service records are found, then the import can create a 
new service record for an existing student. However, you must specify 
(when prompted by the program) whether to allow the program to create 
new services or not. 

3 13 1 “P” or “S” (primary or non-primary service)

4 17 3 San Mateo school code (location of service, matched 
against [School]Address_2 field)

5 21 4 Teacher/provider code (matched against 
[Teacher]Teacher_code field)

6 26 8 Start date, MM-DD-YY format

7 35 8 “Changed” date (placed into 
[Student_service]Session_note field)

8 44 40 Remarks (placed into 
[Student_service]Session_note field)

9 85 8 Exit date, MM-DD-YY format

10 94 2 San Mateo exit code (placed into 
[Student_service]Session_note field)

11 100 3 SUB (placed into [Student_service]Session_note 
field)

12 104 3 LOC (placed into [Student_service]Session_note 
field)

13 108 3 LEV (placed into [Student_service]Session_note 
field)

Field listing for Enrollment (aux. San Mateo) import

Field Start Length Name, description



NOTES:

1. Not every column from the import file on disk is read into SELPA 
Manager.

2. The import discards the first three (header) rows, and tests the fourth row 
for a length of 110 columns (excluding line feed and return). If the fourth 
row does not contain 110 columns, then the import will not proceed.

3. If a row in the import has a blank student number (Cols. 1-6 are empty), 
then it will be skipped. If the student number is not blank, but does not 
correspond to exactly one record in the [Student] table, then the row will be 
skipped.

4. The import file is read for a 3-digit, alphanumeric San Mateo service code 
(Cols. 8 through 10), but not for the CASEMIS service codes. The import 
routine attempts to convert the San Mateo code into a 2-digit, CASEMIS 
service code if a new student service record needs to be created. However, 
this conversion only works with certain San Mateo “D”, “N”, and “R” 
codes. Therefore, the service code for a newly-created [Student_service] 
record may be empty.

5. When the import creates a new [Student_service] record, the new record 
is marked as Do Not Report ([Student_service]Do_not_report_B is true).

6. If the teacher code cannot be found in the [Teacher] table, then the import 
routine will create a new teacher record

7. The [School] record is matched to the [Student_service] record based 
upon the presence of a 3-digit school code in the [School]Address_2 field. If 
this code cannot be found, then the [School] record cannot be linked to the 
[Student_service] record. The import will not add a new record to the 
[School] table.

8. The [Student_service]Session_note field is limited to 80 characters. The 
import places a combination of the 3-digit service code, the change date, the 
3-digit exit code, SUB, LOC, LEV, and the remarks into this field (if each are 
not blank). If this concatenation exceeds 80 characters, then it will be 
truncated.
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Enrollments (generic)
(This import type is not yet in service.)

Goals (student)
Reads a special-format, delimited text file on disk, containing student and 
goal information. This file is generated by another SELPA Manager user, 
using the “Transfer...” option for a selected group of (assessment) goal 
records. 

When you select this option and press the OK button, SELPA Manager will 
prompt you to select an import file that is on your hard disk. If you select a 
file that is not in the correct format, then SELPA Manager will display an 
error message (the import will not proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

The import has the capability of creating records in the [Student] and the 
[Assessment_goal] tables only.

This import does not modify existing student or goal records, except 
temporarily, to write keys for linking between existing student and imported 
goal records.

If the student(s) for whom goals are being imported do not already exist in 
your copy of SELPA Manager, then this import routine will offer to create 
new student records. These new student records will lack associated 
services.

The criteria for finding an existing student record during the import are as 
follows: 

1. SELPA Manager searches for an existing student by querying for the field, 
[Student]Record_number. If the student record is found, the program 
associates the goal(s) to be imported with that existing student record.



2. If no student record is found, SELPA Manager queries again for a student 
having the same last name, gender, and date of birth as the student whose 
goal information is being imported. If one or more student records is found, 
the program prompts the user to select the correct student with whom to 
associate the goal(s).

3. If the user cancels the association request, the program offers to create a 
new student record for the goal(s) (with the OK button) or to skip to the next 
student and associated goal(s).

Goals/objectives (generic)
Reads a 5-field, delimited text file on disk containing goals, objectives, and 
benchmark information, to be placed into the goals/objectives palette (refer 
to the Chapter, “Student Services and Goals” on page 438). This import will 
create new goals/objectives records for the palette, but it will not modify any 
existing items in the palette.

Two example import files of this type are provided with the installers for 
SELPA Manager, “LangArts_G1.txt” and “Mathematics_G1.txt”. These 
import files are adapted from State of California goals and objectives for 
Mathematics and English.1 2 Once you have imported these two files into 
SELPA Manager, the goals/objectives palette will display State-provided 
standards for these two subject areas. For further import instructions, also 
refer to the Chapter, “Student Services and Goals” on page 439.

The default delimiters for the import file are [Tab] (ASCII 9) and [Return] 
(ASCII 13), although the user can specify custom delimiters in the 
confirmation dialog for the import.

1. Edward O’Malley (ed.), Reading/Language Arts Framework for California Public
Schools, Kindergarten Through Grade Twelve. Curriculum Development and Supple-
mental Materials Commission. (Sacramento: California Department of Education,
1999).
2. Janet Lundin and Shiela Bruton (eds.), Mathematics Framework for California Pub-
lic Schools, Kindergarten Through Grade Twelve. Curriculum Development and Sup-
plemental Materials Commission. (Sacramento: California Department of Education,
1999).
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Each row in the import file represents an hierarchical list item of the form, 
topic area -> grade level -> objective -> goal -> benchmark. Each row of the 
import text should be complete down to the benchmark. Otherwise, the other 
item(s) represented in a row may not be added to the palette.

After the import is complete, the SELPA Manager will display a 
confirmation message, indicating how many lines of the import it read and 
the number of new records added. You can expect that the message will 
indicate, “<xx> record(s) not added (already in pgm)”. The hierarchical 
nature of the import rows means that the topic, grade level, objective, and 
goal may already exist when the program reads a new benchmark.

Goals/objectives (SELPA Mgr)
Reads a special-format, delimited text file on disk, containing goals, 
objectives, and benchmark information for the goals/objectives palette 
(refer to “Goals/objectives palette” on page 438). This file is generated by 
another SELPA Manager user, using the “Export: Goals and objectives...” 
item in the File menu. 

Field listing for Goals/objectives (generic) import

Field Length Name, description

1 30a b

a. Items that are longer that 30 characters are truncated during
the import. However, the full description (without truncation) is
placed into a text field that is visible at the bottom of the
goals/objectives palette.
b. If the first row of the import file starts with the word, “Topic”,
then it will be discarded as an informational header; SELPA
Manager will begin reading information on the next row down.

Topic area (area of need)

2 30a Grade level

3 30a Objective

4 30a Goal

5 30a Benchmark (short-term objective)



When you select this import option and press the OK button, SELPA 
Manager will prompt you to select an import file that is on your hard disk. 
If you select a file that is not in the correct format, then SELPA Manager will 
display an error message (the import will not proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

The import has the capability of creating goal/objective/benchmark records 
for the goals/objectives palette only. It does not create goals and objectives 
for particular students; nor does it create records in the [Student] table, or in 
student-related tables.

This import does not modify or in any way make use of existing goals, 
objectives, or benchmarks that you may already have in the goals/objectives 
palette. For example, if you have existing palette items under the topic area, 
“Mathematics”, and the import file also contains “Mathematics” items, then 
you will have two “Mathematics” topics listed in the palette after the import 
is completed.

For this reason, this import option is best used when the goals/objectives 
palette is still empty. For example, a district-level administrator might want 
to distribute a standard palette of goals/objectives to all SELPA Manager 
users, throughout a district or SELPA.

If you wish to augment your existing goals/objectives palette items with 
items from another SELPA Manager user’s palette, then you can add them 
manually, directly from the palette (refer to “Customizing the 
goals/objectives palette” on page 445). Another option is to prepare a 5-
column table of these extra items in your favorite spreadsheet, save them as 
tab-delimited text, and use the “Goals/objectives (generic)” import, instead 
of this import (refer to “Goals/objectives (generic)” on page 533). The 
“Goals/objectives (generic)” import can place new goals, benchmarks, etc. 
under existing palette items.

If there are existing palette items in the program prior to running the 
“Goals/objectives (SELPA Mgr)” import, then SELPA Manager will warn 
you that they exist. The program will offer to delete the existing palette items 
File Menu Operations 535 

• 
• 
• 
•
•
•



536  

• 
• 
• 
•
•
•

prior to importing the new items. If you do not delete the existing items, then 
you should examine the palette carefully after the import process has 
completed, to remove any redundancies manually.

Postal codes
Reads an 11-field, delimited text file on disk containing US postal code 
listings and associated information. The required delimiters are [Tab] 
(ASCII 9) between fields and [Return] (ASCII 13) between records.

Even if the import file contains only the postal code, city name, and state, it 
must have tab delimiters in place for all the fields listed in the table. 

When you select this import option, SELPA Manager asks, “Read Alto-
Stratus 11-field, tab-delimited US Zip Code file?” (Fig. 11-6). Press the OK 
button to proceed with the import, and SELPA Manager will then display an 
Open File dialog, prompting you to identify the file on disk that is to be 
imported.

Field listing for Postal codes import

Field Length Name, description

1 10a

a. Maximum length - postal codes may be shorter (e.g., 5 char-
acters).

Zip or postal code

2 80 City name

3 30 State name

4 80 County name

5 20 FIPS (US only)

6 nbr Area code

7 nbr Latitude, degrees

8 nbr Longitude, degrees

9 30 Time zone description

10 date Modified date

11 40 Comments



If the file is not in the correct format, SELPA Manager will display an error 
message, and the import will not proceed. If the import file appears to be in 
the correct format, then SELPA Manager will then ask whether you wish to 
update existing records with matching postal codes. 

If you allow updates to existing records, and the program finds one unlocked 
record with the same US postal code as the import row, then the import will 
revise the following fields (when they differ from the imported values, and 
the imported values are not blank): state, city, county, FIPS, area code, 
latitude, longitude, time zone, and comments.

Fig. 11-6. Confirmation dialog for importing a tab-delimited Zip (postal) code file.

Schools (generic)
Reads a 13-field, delimited text file on disk containing school information. 
The default delimiters are [Tab] (ASCII 9) and [Return] (ASCII 13), 
although the user can specify custom delimiters in the confirmation dialog 
for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 13 fields in the 
specification, plus an end-of-record delimiter. If the first row begins with the 
word “Code”, then SELPA Manager will discard the first row as a header, 
and begin on the second row instead.

This import procedure will only create new school records. It will not 
modify existing school records in SELPA Manager (as determined by 
school code). If the district code in the import file does not correspond to an 
existing record in the [District] table in SELPA Manager, then the import 
will create a new district with the name, e.g., “New District [xx]”.
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Schools (San Mateo)
Reads a 6-field1, delimited text file on disk containing school information 
that is specific to the San Mateo SELPA. The default delimiters are [Tab] 
(ASCII 9) and [Return] (ASCII 13), although the user can specify custom 
delimiters in the confirmation dialog for the import. 

The fields to be read and their order of their appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 6 fields in the 
specification, plus an end-of-record delimiter.

Field listing for Schools (generic) import

Field Length Name, description

1 7 School code

2 40 School name

3 7 District code

4 2 Type of school (2-digit, numeric code)

5 80 Address line 1

6 80 Address line 2

7 40 City

8 20 State

9 20 Postal code

10 40 Principal’s name

11 10 Telephone number of school

12 10 Fax number of school

13 10 Telephone extension (if applicable)

1. The second field is present for compatibility reasons, but is not used.



The program stores the 3-digit school code (Field 1 in the import) into the 
SELPA Manager field, [School]Address_2. If the 7-digit state (CASEMIS) 
code is available for the school being imported, then the program will 
attempt to locate an existing school in SELPA Manager using the same code. 
If the 7-digit code is not available for a particular row in the import, then 
SELPA Manager searches for the existing school based on the contents of 
the [School]Address_2 field (the 3-digit school code information). If one or 
more existing schools corresponding to the import are found, then the 
import row is ignored. There are no updates to existing school records.

Field listing for Schools (San Mateo) import

Field Length Name, description

1 3 San Mateo 3-digit school code, where the first digit is 
an alpha character corresponding to the “lead” 
character in the district name (e.g., “[A]-Smith Unified 
SD”). 

The program associates the school being imported 
with an existing district based on this first alpha 
character. The alpha character for the district may 
have been imported as a special, third column in the 
generic district import (“Districts (generic)” on 
page 528).

If the first column contains exactly one character 
(rather than 3 characters), then the program assumes 
that the row being imported is special. It contains only 
the alpha character (Field 1) and the associated 
district name in (Field 3).

2 3 Duplicate of Field #1 (not used).

3 40 School name

4 80 Street address

5 N/A City, state, and postal code

6 7 7-digit state (CASEMIS) code, if available
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If the district associated with a school being imported does not exist already 
in SELPA Manager, then the program will create a district record as well. As 
a temporary measure, SELPA Manager assigns the 7-digit district code as 
the characters “99” plus the assigned [District] ID number. For example, if 
the ID number for the new district were “243”, then the temporary district 
code would be “9900243”. You should reassign the district its correct, 7-
digit CASEMIS code when the schools import is complete.

If the characters, [comma]-[space] exist in the fifth import field, then the 
program attempts to parse city, state, and postal code based upon the 
location of the comma and space (after city name), and a two-character state 
name. Otherwise, the program assumes that the entire line is the city name 
(limited to 40 characters in SELPA Manager).

SELPA 0600 (Colusa County)
Reads a 61-field, delimited text file on disk containing students, services, 
and associated information. The default delimiters are [Tab] (ASCII 9) and 
[Return] (ASCII 13), although the user can specify custom delimiters in the 
confirmation dialog for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 61 fields in the 
specification, plus an end-of-record delimiter. 

Before importing the student, SELPA Manager checks for the existence of 
a student record with the same student number (Field 1 in the import, 
compared with [Student]Student_number in SELPA Manager). The import 
will not create a new student record if one or more students with the same 
student number already exist. It will, however, create new contacts 
(addresses), districts, schools, and services as necessary in conjunction with 
a new student record. The services that are created make use of the “old”-
style, 3- or 5-digit service codes.

The import does not make updates to existing student records.



.

Field listing for SELPA 0600 (Colusa) import

Field Length Name, description

1 20 Student number

2 15 Last name

3 15 First name

4 date Date of birth

5 1 Gender (M/F)

6 2 Grade (CASEMIS code, numeric digits only)

7 9 Social Security Number (SSN)

8 3 Ethnicity code (CASEMIS code)

9 2 Home language code

10 1 Limited English Proficiency (LEP), “Y” or “N”

11 3 Disability (CASEMIS code)

12 1 Migrant education, “Y” or “N”

13 2 Residence status (CASEMIS code)

14 1 PL89-313 designation, “Y” or “N”

15 1 Requires Intensive Services (RIS), “Y” or “N”

16 3 Mainstreamed, percent expressed as a whole 
number

17 date Date first entered into Special Education (original 
entry date)

18 date Last IEP date

19 date Last assessment date

20 date Exit date (on which the student exited Special 
Education)

21 2 Exit reason (CASEMIS code)

22 7 SELPA from code
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23 7 District of residence code

24 40 District of residence name

25 7 District of service/attendance code

26 7 School of attendance code

27 40 School of attendance name

28 2 School of attendance type (CASEMIS code)

29 1 Extended year, “Y” or “N”

30 2 Infant setting (CASEMIS code)

31 1 Transportation required, “Y” or “N”

32 50 Parent or guardian name

33 30 Relationship to student

34 80 Street address

35 80 Mailing address

If both street and mailing address are available (not 
blank), then SELPA Manager will create one 
[Student_Contact] record for each, where the former 
is the “resides here” address, and the address type is 
“Home”. 

If only the street or the mailing address is available, 
then SELPA Manager will create only one 
[Student_Contact] record as the “resides here” 
address (whether street or mailing address).

36 40 City

37 20 State

38 80 County of residence. If present, SELPA Manager 
places the information into the 
[Student]User_alpha_4 field.

39 10 Postal code

Field listing for SELPA 0600 (Colusa) import

Field Length Name, description



40 20 Home telephone number. If 7 digits long rather than 
10 digits, SELPA Manager prepends the default area 
code (the program asks for the default area code as 
the import begins).

41 date Report date #1 (“REPT_DATE”), placed into the 
SELPA Manager field, [Student]User_date_1.

42 date Report date #2 (“REPT.DATE”), placed into the 
SELPA Manager field, [Student]User_date_2.

43 1 Active service (student is actively enrolled in Special 
Education), “Y” or “N”, placed into the SELPA 
Manager field, [Student]User_YesNo_1.

44 text Student note/comment, placed into the SELPA 
Manager field, [Student]Student_note.

45 80 Psychologist name, placed into the SELPA Manager 
field, [Student]User_alpha_3.

46 3 Placement code (pre-2001 CASEMIS placement 
code, such as “410”, “420”, “430”, etc.

47 2 Designated Instruction Service (DIS) No. 1 (pre-2001 
CASEMIS DIS Code 1).

If the placement code (Field 46, above) is “410”, then 
this DIS will be checked in SELPA Manager as the 
primary service. If the placement code is not “410”, 
then SELPA Manager will create a primary service 
corresponding to the service in Field 46 only, and this 
DIS will not be the primary service. Refer to the 
comments below Field 50.

48 2 Designated Instruction Service (DIS) No. 2 (pre-2001 
CASEMIS DIS Code 2).

49 2 Designated Instruction Service (DIS) No. 3 (pre-2001 
CASEMIS DIS Code 3).

Field listing for SELPA 0600 (Colusa) import

Field Length Name, description
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50 2 Designated Instruction Service (DIS) No. 4(pre-2001 
CASEMIS DIS Code 4).

The DIS 1-4 codes, if present, are each entered as a 
separate service in SELPA Manager, in the earlier 
format (e.g., “410-50”, “410-52”, “410-54”, etc.). If the 
placement code is NOT “410”, then the placement 
becomes another, separate service record.

Once the import has completed, you can convert “old-
style” service codes into the “new,” 2-digit codes from 
the Actions menu in the SELPA Manager browse 
window. From the Services context, find the services 
with “old”-style codes to be converted; then select 
Actions menu -> Update other... -> Convert “old”-style 
service codes.

51 40 Teacher name. Used in SELPA Manager with the 
primary service, if the placement code (Field 46) is 
not “410”.

52 40 Teacher 1 name (for DIS No. 1, if present).

53 40 Teacher 2 name (for DIS No. 2, if present).

54 40 Teacher 3 name (for DIS No. 3, if present).

55 40 Teacher 4 name (for DIS No. 4, if present).

56 1 Goals and objectives set for this student, “Y” or “N”. 
Placed into the SELPA Manager field, 
[Student]User_YesNo_2.

57 80 “ENTD”, if present, placed into the SELPA Manager 
field, [Student]User_alpha_1.

58 nbr. Calculated age

59 date Next assessment date

60 80 “BD.CON”, if present, placed into the SELPA Manager 
field, [Student]User_alpha_2.

Field listing for SELPA 0600 (Colusa) import

Field Length Name, description



SELPA 1600 (King’s County)
Reads a 66-field, delimited text file on disk containing students, services, 
and associated information. The delimiters are [Tab] (ASCII 9) and 
[Return] (ASCII 13). 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 66 fields in the 
specification, plus an end-of-record delimiter. 

Before importing the student, SELPA Manager checks for the existence of 
a student record with the same student number (Field 10 in the import, 
compared with [Student]Student_number in SELPA Manager). 

The import will not create a new student record if one or more students with 
the same student number already exist. It will, however, create new contacts 
(addresses), districts, schools, and services as necessary in conjunction with 
a new student record. The services that are created make use of the “old”-
style, 3- or 5-digit service codes.

The import does not make updates to existing student records. Not all field 
positions in the file are imported into SELPA Manager.

61 nbr. Hours of Special Education (“MAINSTR.HRS”); if 
present, placed into the SELPA Manager field, 
[Student]User_number_1.

Field listing for SELPA 1600 (King’s County) import

Field Length Name, description

1 N/A Not used

2 N/A Not used

3 N/A Not used

Field listing for SELPA 0600 (Colusa) import

Field Length Name, description
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4 7 District of service (7-digit code)

5 7 District of residence (7-digit code)

6 7 School of attendance (7-digit code)

7 2 School type (school of attendance, 2-digit CASEMIS 
code)

8 15 Last name

9 15 First name

10 20 Student identification number 
([Student]Student_number), used to determine 
whether the student exists already in SELPA 
Manager.

11 9 Social Security Number

12 date Date of birth

13 2 Gender (M or F)

14 3 Ethnicity (3-digit CASEMIS code)

15 1 English Language Learner (ELL), “Y” or “N”

16 2 Home language (2-digit CASEMIS code)

17 1 Migrant education, “Y” or “N”

18 2 Residence (2-digit CASEMIS code)

19 date Original entry date

20 date Last IEP date

21 date Last evaluation date

22 3 Primary disability (3-digit CASEMIS code)

23 3 Primary placement (3-digit, “old” CASEMIS code)

24 2 Infant setting (2-digit CASEMIS code)

25 nbr Percent mainstreamed

Field listing for SELPA 1600 (King’s County) import

Field Length Name, description



26 2 Grade level (2-digit CASEMIS code)

27 1 Requires intensive services (RIS), “Y” or “N”

28 N/A Not used

29 2 DIS1 (Designated instruction service, CASEMIS 
“old”-style code)

30 2 DIS2 (Designated instruction service, CASEMIS 
“old”-style code)

31 2 DIS3 (Designated instruction service, CASEMIS 
“old”-style code)

32 2 DIS4 (Designated instruction service, CASEMIS 
“old”-style code)

33 date Drop date for primary service

34 2 Exit reason (2-digit CASEMIS code)

35 N/A Not used

36 N/A Not used

37 N/A Not used

38 N/A Not used

39 N/A Not used

40 N/A Not used

41 15* Middle initial (total of 15 characters with first name).

42 text “AKA” name for student (placed into 
[Student]Student_note field)

43 80 Address Line 1

44 40 City

45 N/A Not used

46 50a Parent/guardian first name

47 50 Parent/guardian last name

Field listing for SELPA 1600 (King’s County) import

Field Length Name, description
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48 date Optional date 1, entered as [Student]User_date_1

49 date Optional date 2, entered as [Student]User_date_2

50 80 Optional alpha item 1, entered as 
[Student]User_alpha_1

51 N/A Not used

52 date Start date for DIS2 service

53 date Start date for DIS3 service

54 date Start date for DIS4 service

55 N/A Not used

56 date Drop date for DIS2 service

57 date Drop date for DIS3 service

58 date Drop date for DIS4 service

59 N/A Not used

60 80 Optional alpha item 2, entered as 
[Student]User_alpha_2

61 80 Optional alpha item 3, entered as 
[Student]User_alpha_3

62 80 Optional alpha item 4, entered as 
[Student]User_alpha_4

63 N/A Not used

64 text “New_locate” information (placed into 
[Student]Student_note field)

65 80 Optional alpha item 5, entered as 
[Student]User_alpha_5

66 text “Active: ” information (placed into 
[Student]Student_note field)

a. Total of 50 characters for first and last name, parent/guardian.

Field listing for SELPA 1600 (King’s County) import

Field Length Name, description



SELPA 3013 / Nightly (Anaheim Union)
Reads a 19-field, delimited text file on disk containing student, address, and 
associated information, from the Anaheim Union School District mainframe 
computer. This import provides a means to update existing student 
information SELPA Manager, which may have changed on the mainframe 
computer during the day.

The default delimiters are [Tab] (ASCII 9) and [Return] (ASCII 13), 
although the user can specify custom delimiters in the confirmation dialog 
for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 19 fields in the 
specification, plus an end-of-record delimiter. 

SELPA Manager checks for the existence of a student record with the same 
student number (Field 4 in the import, compared with 
[Student]Student_number in SELPA Manager). The program then compares 
the contents of each field against the corresponding data in the import file, 
and updates the field as necessary.

If the student record (corresponding to a row in the import file) does not exist 
in SELPA Manager, then the program creates a new student record. It may 
also create a new [Student_contact] record for the address information.

If SELPA Manager finds more than one existing student record with the 
student number specified in the import file row, then it writes an error 
message to the Tracking section. In this case, the program does not update 
the existing records.

Field listing for SELPA 3013 / nightly update import

Field Length Name, description

1 15 Last name

2 15 First name

3 15a Middle initial
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4 20 Student identification number 
([Student]Student_number in SELPA Manager)

5 50 Parent/guardian name

6 1 Student resides here, “Y” or “N”

7 80 Address Line 1

8 40 City

9 20 State

10 10 Postal code

11 20 Home telephone (prepends a default area code if the 
length is 7 characters)

12 20 Work telephone (prepends a default area code if the 
length is 7 characters)

13 date Date of birth

14 1 Gender, “M” or “F”

15 2 Grade level (CASEMIS 2-digit code)

16 80 School of attendance. If the item being read is a 7-
digit CASEMIS code, then the program places it in the 
[Student]Sch_attend_code field, and when available 
finds the corresponding school name and school 
type, from the Schools section of SELPA Manager. If 
the item being read is longer than 7 digits, then the 
program places it in the [Student]USER_alpha_2 
field.

17 2 Home language (2-digit CASEMIS code)

18 3 Ethnicity 1 (2-digit CASEMIS code)

19 3 Ethnicity 2 (2-digit CASEMIS code)

a. Maximum length when combined with first name field

Field listing for SELPA 3013 / nightly update import

Field Length Name, description



SELPA 3702 / Basic View (North Coastal SELPA)
Reads a 112-field1, delimited text file on disk containing students, services, 
and associated information. The default delimiters are [Tab] (ASCII 9) and 
[Return] (ASCII 13), although the user can specify custom delimiters in the 
confirmation dialog for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 110 fields in the 
specification, plus an end-of-record delimiter. 

Some of the information in the import file is placed into custom user fields 
in SELPA Manager, or into fields having a different name than on the import 
source (e.g., “-> User Alpha Field 1").

If there is no teacher for a student service, then the program will use the case 
manager name or, if blank, will use “Teacher, Unknown”. The import will 
generate teacher services and assignments as needed. 

If there is an overall program exit date without an exit reason, then the 
program will use Code 80 (“Unknown if continuing”) as the drop reason. 
The so-called “end” dates imported with each service are placed into the 
field, [Student_service]Evaluation_D (evaluation date) for each service 
record that the import creates. The end date is not assumed to be individual 
service drop date; instead, the overall program exit date is used for this 
purpose.

Before importing the student, SELPA Manager checks for the existence of 
a student record with the same student number (Field 19 in the import, 
compared with [Student]Student_number in SELPA Manager). 

The import will not create a new student record if one or more students with 
the same student number already exist. However, the import will create new 
contacts (addresses), districts, schools, and services as necessary in 
conjunction with a new student record. The services that are created make 
use of the current, 2-digit CASEMIS codes; however, the import will accept 
the “old”-style, 3- or 5-digit service codes.

1. Formerly was a 110-field import (revised 4.9.2002)
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This import does not make updates to existing student records in SELPA 
Manager.

Field listing for SELPA 3702 (North Coastal) import

Field Length Name, description

1 15 Last name

2 15 First name

3 15a Middle name

4 1 Gender, “M” or “F”

5 date Date of birth

6 9 SSN

7 1 Interpreter needed, “Y” or “N”

8 30 FC/LCI number (if applicable -> 
[Student]Foster_LCI_number)

9 50 Address (parent) name

10 2 Home language (CASEMIS 2-digit code)

11 80 Address line 1

12 70* Address as “city, state   zip code” (*the program will 
parse the items into separate fields of 40, 20, and 10 
characters, respectively).

13 20 Telephone home

14 20 Telephone work

15 20 Telephone other (->[Student_Contact]Telephone_3)

16 4 SELPA from code

17 7 District of service code

18 7 District of residence code

19 20 Student number

20 3 Ethnicity 1 (CASEMIS 3-digit code)

21 1 LEP (Limited English Proficiency, or English 
Language Learner), “Y” or “N”



22 2 Student language (CASEMIS 2-digit code)

23 1 “SH” condition. If this item is read as “Y” or “T”, then 
SELPA Manager assigns “SH” to the field, 
[Student_service]Disabling_condition, for the 
student’s primary service.

24 1 Migrant education, “Y” or “N”

25 2 Residence (CASEMIS 2-digit code)

26 date Original entry date

27 Primary disability code

28 Plan type (1 or 2)

29 SDC Type (->User Alpha 2 Field. NOTE: Also checks 
Regional SDC for a type 430 primary service)

30 % Outside regular class

31 service 1 code (primary service, required)

32 service 1 start date

33 service 1 end date (-> 
[Student_service]Evaluation_D)

34 service 1 sess/week

35 service 1 min/session

36 service 1 teacher

37 service 1 class

38 service 2 code

39 service 2 start date

40 service 2 end date (-> 
[Student_service]Evaluation_D)

41 service 2 sess/week

42 service 2 min/session

Field listing for SELPA 3702 (North Coastal) import

Field Length Name, description
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43 service 2 teacher

44 service 2 class

45 service 3 code

46 service 3 start date

47 service 3 end date (-> 
[Student_service]Evaluation_D)

48 service 3 sess/week

49 service 3 min/session

50 service 3 teacher

51 service 3 class

52 service 4 code

53 service 4 start date

54 service 4 end date (-> 
[Student_service]Evaluation_D)

55 service 4 sess/week

56 service 4 min/session

57 service 4 teacher

58 service 4 class

59 service 5 code

60 service 5 start date

61 service 5 end date (-> 
[Student_service]Evaluation_D)

62 service 5 sess/week

63 service 5 min/session

64 service 5 teacher

65 service 5 class

Field listing for SELPA 3702 (North Coastal) import

Field Length Name, description



66 service 6 code

67 service 6 start date

68 service 6 end date (-> 
[Student_service]Evaluation_D)

69 service 6 sess/week

70 service 6 min/session

71 service 6 teacher

72 service 6 class

73 service 7 code

74 service 7 start date

75 service 7 end date (-> 
[Student_service]Evaluation_D)

76 service 7 sess/week

77 service 7 min/sessions

78 service 7 teacher

79 service 7 class

80 service 8 code

81 service 8 start date

82 service 8 end date (-> 
[Student_service]Evaluation_D)

83 service 8 sess/week

84 service 8 en min/sessions

85 service 8 teacher

86 service 8 class

87 Exit date

88 Exit reason

Field listing for SELPA 3702 (North Coastal) import

Field Length Name, description
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89 School of attendance code

90 School type code

91 Grade

92 Case manager

93 Extended school year (-> ext. year checkbox and nbr. 
of days)

94 Residence school

95 Transportation required

96 Physical ed type

97 Type of evaluation (->User Alpha 1 field)

98 Other review date

99 Next IEP date

100 Last IEP date

101 Next evaluation date

102 Last evaluation date

103 Differential standards (->User YesNo 1 field)

104 Workability program

105 Preschool setting code

106 STAR code

107 Alternate assessment req'd.

108 Track (max. 2 digits)

109 Infant setting code

110 Agency service(s) (-> Student note field)

111 Relationship (contact to student)

112 Alternate student ID (-> User Alpha 3 field)

Field listing for SELPA 3702 (North Coastal) import

Field Length Name, description



Students (aux., San Mateo)
Reads a 13-field, 184-fixed column text file on disk, containing auxiliary 
student information.

The fields to be read and their order of appearance are listed in the table 
below. The import ignores the first three (header) rows in the text file. 
SELPA Manager will add the import information only if the student record 
already exists in the program. If the provider code in the import is not listed 
in the [Teacher] table, then the program will create a new teacher with a 
name in the form, “NewTeach [Teacher_code]”.

The import data (if not blank) will always overwrite the existing contents of 
the Social Security Number (SSN) and Case Manager fields. Address 
information does not get overwritten; instead, the program will always 
create a new, linked address record for the student (address and telephone 
information is assumed to be for the home).  

a. First name and middle initial together must be 15 characters
or less.

Field listing for Students (aux., San Mateo) import

Field Start Length Name, description

1 1 6 Student ID (->[Student]Student_number)

2 12 3 “PRI” (SELPA 4100 primary service code -> 
[Student]Student_note)

3 16 4 “PROV” (SELPA 4100 provider code -> 
[Student]Case_manager_name)

4 21 65 Comment (-> [Student]Student_note)

5 87 30 Street name in address

6 118 20 City name in address

7 139 2 State abbrev. in address

8 142 5 Zip code in address

9 148 10 Telephone number

10 161 3 SEC field (-> [Student]Student_note)
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Students (CASEMIS Table A)
Reads a 42-field, 196-fixed column text file on disk, containing student and 
associated information in the Department of Education’s CASEMIS Table 
A (text) format. There are two additional, mutually exclusive options, with 
either 43 fields (199 columns) or 47 fields (219 columns). These options 
appear at the end of the table, below.

The program will add the student(s) and associated services only if the 
student does not already exist in this copy of SELPA Manager. 

If the program finds either the student's record number or a combination of 
last name, date of birth, gender, and Social Security Number (if not blank), 
then the student and associated service(s) will not be imported. Therefore, 
the second individual of a pair of twins, who does not have a Social Security 
Number, could be excluded from this import.

“Old-style”, 3- or 5-digit service codes are converted into the CASEMIS, 2-
digit format and associated descriptions.

NOTE: This import uses the Table A format of the 2000-2001 academic year.  

11 165 1 CO field (-> [Student]Student_note)

12 168 3 ECE field (-> [Student]Student_note and 
[Student]User_alpha_1)

13 172 9 SSN field

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description

1 1 8 REPT_DATE, report as of date

2 9 4 SELPA_CODE

3 13 4 SELPA_FROM

4 17 7 DIST_SERV, district of service

Field listing for Students (aux., San Mateo) import

Field Start Length Name, description



5 24 7 DIST_RESI, district of residence

6 31 7 SCH_CODE, school of attendance

7 38 2 SCH_TYPE, type of school of attendance 

8 40 15 LAST_NAME 

9 55 15 FIRST_NAME

10 70 16 STUDENT_ID, student record number 
([Student]Record_number), with hyphens removed

11 86 9 SSN (Social Security Number)

12 95 8 BIRTHDATE

13 103 1 GENDER (M or F)

14 104 3 ETHNICITY (CASEMIS code for primary ethnicity, 
[Student]Ethnicity_code_1)

15 107 1 LEP (T or Y / F or N)

16 108 2 HOME_LANG

17 110 8 REFR_DATE

18 118 1 MIGRANT, Migrant Education (T or Y / F or N) 

19 119 2 RESID_STAT, residential status (CASEMIS code)

20 121 8 ENTRY_DATE

21 129 8 LAST_IEP (date)

22 137 8 LAST_EVAL (date)

23 145 3 DISABILITY (CASEMIS code)

24 148 1 SOLE_LOW (solely low incidence, T or Y / F or N)

25 149 3 PLACEMENT, primary placement

26 152 2  PRESCH_SET (preschool setting, CASEMIS code)

27 154 3 OUT_REGCLS (outside regular class, percent)

28 157 2 GRADE, 01-18

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description
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29 159 8 TRAN_DATE (transition date)

30 167 1 WORKAB (workability, T or Y / F or N)

31 168 2 DIS1, first service (CASEMIS code)

32 170 2 DIS2, second service

33 172 2 DIS3, third service

34 174 2 DIS4, fourth service

35 176 2 DIS5, fifth service

36 178 2 DIS6, sixth service

37 180 2 DIS7, seventh service

38 182 2 DIS8, eighth service

39 184 2 PARTICIP (STAR participation code)

40 186 1 ALTERNATE (alternate assessment, T or Y / F or N)

41 187 8 EXIT_DATE, leave blank if current

42 195 2 EXIT_RESON, CASEMIS reason code for exiting 
program, leave blank if current

43 197 3 (Option 1 only: Optional 3-digit field, placed into 
[Student]USER_alpha_1)

43 192 1 (Option 2 only: Transportation required, Y/N)

44 198 3 (Option 2 only: Teacher code, placed into 
[Student]USER_alpha_1)

45 201 8 (Option 2 only: Next IEP date)

46 209 8 (Option 2 only: Next evaluation date)

47 217 3 (Option 2 only: School code, placed into 
[Student]USER_alpha_2)

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description



Students (CMS Tbl A 01-02)
Reads a 47-field, 211-fixed column text file on disk, containing student and 
associated information in the Department of Education’s CASEMIS Table 
A (text) format, academic year 2001-2002. There are two additional, 
mutually exclusive options, with either 48 fields (214 columns) or 52 fields 
(234 columns). These options appear at the end of the table, below.

The program will add the student(s) and associated services only if the 
student does not already exist in this copy of SELPA Manager. 

If the program finds either the student's record number or a combination of 
last name, date of birth, gender, and Social Security Number (if not blank), 
then the student and associated service(s) will not be imported. Therefore, 
the second individual of a pair of twins, who does not have a Social Security 
Number, could be excluded from this import.

“Old-style”, 3- or 5-digit service codes are not supported in this routine.

NOTE: This import uses the Table A format of the 2001-2002 academic year.  

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description

1 1 8 REPT_DATE, report as of date

2 9 4 SELPA_CODE

3 13 4 SELPA_FROM

4 17 7 DIST_SERV, district of service

5 24 7 DIST_RESI, district of residence

6 31 7 SCH_CODE, school of attendance

7 38 2 SCH_TYPE, type of school of attendance 

8 40 15 LAST_NAME 

9 55 15 FIRST_NAME

10 70 16 STUDENT_ID, student record number 
([Student]Record_number), with hyphens removed

11 86 10 CSIS_ID, provided by the state

12 96 9 SSN (Social Security Number)
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13 105 8 BIRTHDATE

14 113 1 GENDER (M or F)

15 114 3 ETHNICITY 1 (CASEMIS code for primary ethnicity, 
[Student]Ethnicity_code_1)

16 117 3 ETHNICITY 2

17 120 3 ETHNICITY 3

18 123 3 ETHNICITY 4

19 126 3 ETHNICITY 5

20 129 3 ETHNICITY 6

21 132 1 ELL (English Language Learner, T or Y / F or N)

22 133 2 HOME_LANG

23 135 1 PLAN TYPE

24 136 8 REFR_DATE

25 144 1 MIGRANT, Migrant Education (T or Y / F or N) 

26 145 2 RESID_STAT, residential status (CASEMIS code)

27 147 8 ENTRY_DATE

28 155 8 LAST_IEP (date)

29 163 8 LAST_EVAL (date)

30 171 3 DISABILITY (CASEMIS code)

31 174 1 SOLE_LOW (solely low incidence, T or Y / F or N)

32 175 2  PRESCH_SET (preschool setting, CASEMIS code)

33 177 3 OUT_REGCLS (outside regular class, percent)

34 180 2 GRADE, 01-18

35 182 1 WORKAB (workability, T or Y / F or N)

36 183 1 TRAN LANG (transition language, T or Y / F or N)

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description



Students from web
Reads a special-format, delimited text file on disk. This file is generated by 
the web server on another installation of SELPA Manager, when a 
connected web client presses the EXPORT button, when displaying a 

37 184 2 First service (CASEMIS code)

38 186 2 Second service

39 188 2 Third service

40 190 2 Fourth service

41 192 2 Fifth service

42 194 2 Sixth service

43 196 2 Seventh service

44 198 2 Eighth service

45 200 2 PARTICIP (STAR participation code)

46 202 8 EXIT_DATE, leave blank if current

47 210 2 EXIT_RESON, CASEMIS reason code for exiting 
program, leave blank if current

48 212 3 (Option 1 only: Optional 3-digit field, placed into 
[Student]USER_alpha_1)

48 212 1 (Option 2 only: Transportation required, Y/N)

49 213 3 (Option 2 only: Teacher code, placed into 
[Student]USER_alpha_1)

50 216 8 (Option 2 only: Next IEP date)

51 224 8 (Option 2 only: Next evaluation date)

52 232 3 (Option 2 only: School code, placed into 
[Student]USER_alpha_2)

Field listing for Students (CASEMIS Table A) import

Field Start Length Name, description
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selected group of students. For more information on the web serving 
functions of SELPA Manager, refer to the menu item, “Start web services” 
on page 604.

When you select the students from web import option and press the OK 
button, SELPA Manager will prompt you to select an import file that is on 
your hard disk. If you select a file that is not in the correct format, then 
SELPA Manager will display an error message (the import will not 
proceed). 

If the file is in the correct format, then SELPA Manager will display a 
confirmation dialog prior to continuing. Make sure that you read the entire 
contents of this confirmation dialog before you press the OK button. 

The import files can contain records from the following tables: students, 
contacts, disciplinary actions, student services, assessments, assessment 
dispositions, other disabilities (for assessments), goals, transitions, and test 
scores. 

The import will not update existing records; however, it will attach new, 
student-related records (disciplinary actions, student services, goals, etc.) to 
an existing student. The import searches for an existing student by record 
number.1

The students from web import reads the incoming data using the table and 
field definitions of the receiving (“target”) copy of SELPA Manager. 
Therefore, it is advisable to use the same version of SELPA Manager for 
importation as the sender used originally to generate the import file. SELPA 
Manager will display a warning in the confirmation dialog, if the sending 
and receiving versions of the program do not match.

1. The students from web import checks the incoming student record number for
matches with the [Student]Record_number field only. If a matching student record is
found and the record is not locked, the import writes a long integer key to the student
record for linking related student services, disciplinary actions, etc. If the student is not
found, then the import creates a new student, places the incoming record number into
the [Student]Record_number_prev field, and issues a new record number in the new
district.



Student-associated schools
Reads a 2-field, 13-fixed column text file on disk. Each line contains a 
student number and an associated school code for the student’s school of 
residence or school of attendance, as specified at the time of importation. 
Where possible, the update uses the school name from a matching record in 
the [School] table. 

This import will not create new student records. It only revises existing 
students, if the associated school is different from the school code in the 
update file.

 

Teachers (generic)
Reads a 9-field, delimited text file on disk containing teacher information. 
The default delimiters are [Tab] (ASCII 9) and [Return] (ASCII 13), 
although the user can specify custom delimiters in the confirmation dialog 
for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 9 fields in the 
specification, plus an end-of-record delimiter. If the first row begins with the 
word “Code”, then SELPA Manager will discard the first row as a header, 
and begin on the second row instead.

Field listing for student-associated schools import

Field Start Length Name, description

1 1 6 Student ID (->[Student]Student_number)

2 7 6 School code (for either the school of attendance or 
school of residence, as specified by the user at the 
start of the import).
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This import procedure will only create new teacher records. It will not 
modify existing teacher records in SELPA Manager (as determined by the 
teacher code).  

Teachers (San Mateo)
Reads a 4-field, delimited text file on disk containing teacher information, 
for the San Mateo SELPA. The default delimiters are [Tab] (ASCII 9) and 
[Return] (ASCII 13), although the user can specify custom delimiters in the 
confirmation dialog for the import. 

The fields to be read and their order of appearance are listed in the table 
below. Even if the import file contains only some of the field information 
from the table, it must have a delimiter for each of the 4 fields in the 
specification, plus an end-of-record delimiter. If the first row begins with the 
word “Code”, then SELPA Manager will discard the first row as a header, 
and begin on the second row instead.

Field listing for Teachers (generic) import

Field Length Name, description

1 20 Teacher code

2 40 Teacher name

3 80 Address line 1

4 80 Address line 2

5 40 City

6 20 State

7 20 Postal code

8 10 Home telephone number (digits only)

9 10 Work telephone number (digits only)



This import procedure will only create new teacher records. It will not 
modify existing teacher records in SELPA Manager (as determined by a 
match on the teacher code).  

Transfer...
• Function: The “Transfer...” item in the File menu enables you to send 

student, assessment, or goal information to another SELPA Manager 
user. In the case of student records, it also provides a mechanism to move 
students into another district, either by export or by internal transfer.

• Shortcut key: None. 

• Modifier key: Selecting “Transfer...” while holding down the 
[ALT/OPTION] key with a selection of student records as the current 
focus, performs a SELPA Central export without transfer, for only the 
listed students. For information on the SELPA Central export, refer to 
“Districts to central...” on page 569.

• Accessible from: Browse windows, when students, assessments (IEP 
forms), or goals have the focus.

• Accessible to: Users that are members of the “ReadWriteGrp” access 
group (users with read-write access to the program).

• Notes/limitations: 

The “Transfer...” item is available when a list of students, assessments (IEP 
forms), or goals is displayed in the browse window. In other contexts, this 
menu item will be disabled.

Field listing for Teachers (San Mateo) import

Field Length Name, description

1 4 Teacher code, 4-digit, where first digit is alpha district

2 4 Teacher code (duplicate of Field #1, not used but 
required for formatting)

3 40 Teacher name

4 text “MGR” (-> [Teacher]Teacher_note field). Note: If Field 
#3 is empty, then the contents of this field go into the 
[Teacher]Teacher_name field.
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SELPA Manager offers to transfer the listed students, assessments, or goals. 
In the latter two cases (assessments and goals), the transfer is in the form of 
a custom-format, delimited text export file that can be imported by another 
SELPA Manager user.

For student records, the program can either generate an export file, or 
perform an internal transfer of the student(s) to another district. SELPA 
Manager displays a dialog box of student transfer operations (Fig. 11-7). 
From this dialog, users can select an appropriate option for the listed 
students.

The export file option requires a drop date and a drop reason, as the 
student(s) will be dropped from their services as they are exported. For the 
internal transfer, the drop date and reasons are optional; you may select 
“Internal xfer” rather than “Internal xfer w/drop”. 

The internal transfer options require you to select a new district for the 
student(s). After you press the OK button to accept the transfer dialog, 
SELPA Manager will display a scrolling list of districts from which to select 
the new district. Each student to be transferred will receive a new student 
record number which contains the code for the new district of residence (as 
the first seven digits)

Fig. 11-7. Transfer dialog for student records (File menu -> Transfer...).

Checking the “New dist. of res.” box (internal transfers only) will reset the 
student’s district of residence field to match the new record number prefix. 
If you do not check this box, then the student’s record number may not 
match the district of residence.



Districts to central...
• Function: Performs a SELPA Central export – sends all relevant 

information about selected district(s) to another copy of SELPA 
Manager, as a custom-format, delimited text file on disk. 

• Shortcut key: None. 

• Modifier key: None. However, the SELPA Central export also can be 
initiated when a selection of students is in the current focus, by holding 
down the [ALT/OPTION] key while selecting “Transfer...” from the File 
menu (refer to “Transfer...” on page 567).

• Accessible from: Browse windows, when a districts listing has the focus.

• Accessible to: Users that are members of the “ReadWriteGrp” access 
group (users with read-write access to the program).

• Notes/limitations: 

The information in the generated text file can include districts, schools, 
teachers, teacher services, assignments, students, student contacts, 
disciplinary actions, student services, assessments, assessment dispositions, 
other disabilities (assessment-related), goals, transitions, and test scores.

When the user selects this item, SELPA Manager displays a “Send” dialog 
(Fig. 11-8) that allows the user to specify whether Do Not Report students 
and services should be excluded from the export; and whether students that 
transferred on or before a specified date should also be excluded.1

Fig. 11-8. Districts to central export dialog (File menu -> Districts to central...).

1. The corresponding fields for these criteria are [Student]Do_not_report_B,
[Student_service]Do_not_report_B, and [Student]Transfer_D.
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After the user presses the OK button, SELPA Manager performs the 
searches to generate the necessary record(s) for export. The program then 
presents a confirmation dialog (Fig. 11-9), containing detailed information 
about the export.

Acceptance of the confirmation dialog then permits the user to create an 
export file on disk.

The recipient of the export file can perform a SELPA Central import 
(page 515) on it, to bring the information into the other copy of SELPA 
Manager. The recipient of the file has the option of importing only new 
records or importing new and updating existing records (that are already in 
his/her copy of SELPA Manager, refer to Fig. 11-3 on page 516).

Fig. 11-9. Districts to central, confirmation dialog (File menu -> Districts to 
central...).

The SELPA Central import procedure reads the incoming file using the table 
and field definitions of the receiving (“target”) copy of SELPA Manager. 
Therefore, it is advisable to use the same version of SELPA Manager for 
importation as the sender used originally to generate the import file.

MediCal eligibility...
• Function: Generates an export file on disk, for sending selected student 

information to the State of California, to determine whether the student(s) 
are eligible to receive MediCAL benefits. 



• Shortcut key: None. 

• Accessible from: Browse window, when students have the focus and one 
or more students is listed.

• Accessible to: Users that are members of the “ReadWriteGrp” access 
group (users with read-write access to the program).

• Notes/limitations: 

Prepares a 105-column fixed, text export file on disk, in the format of the 
table below. SELPA Manager presents a confirmation dialog (Fig. 11-10), 
and then writes one line for each student record in the current selection. The 
program marks each student in the export file by checking the field, 
[Student]MediCAL_exported_B, for the corresponding record.

Fig. 11-10. MediCAL export confirmation dialog (File menu -> MediCAL. 
eligibility...).

 

Field listing for the MediCAL eligibility export

Field Start Length Name, description

1 1 9 Social Security Number (SSN)

2 10 20 Last name

3 30 15 First name

4 45 1 Middle initial (if present, from [Student]First_name)

5 46 8 DOB as “YYYYMMDD”

6 54 1 Gender (M/F)
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Goals and objectives...
• Function: Generates an export file on disk, for sending goals and 

objectives information to another SELPA Manager user. 

• Shortcut key: None. 

• Accessible from: Browse window or no user windows displayed.

• Accessible to: Users that are members of the “ReadWriteGrp” access 
group (users with read-write access to the program).

• Notes/limitations: 

Prepares a custom-format, delimited export file on disk containing all goals 
and objectives listed in the goals/objectives palette (refer to the Chapter, 
“Student Services and Goals” on page 438). This file can then be imported 
by another SELPA Manager user (refer to the import type, “Goals/objectives 
(SELPA Mgr)” on page 534).

This combination of export and import capability for the palette enables a 
SELPA Manager user to develop a tailored set of goals and objectives that 
can then be distributed, thereby creating a standard palette for all SELPA 
Manager users within a region or district.

Preferences...
• Function: Displays the Preferences dialog, for editing user and system-

wide default settings.

• Shortcut key: None. 

• Modifier key: For users with administrative access, when a browse 
window list has the current focus, holding down the [ALT/OPTION] key 
while selecting “Preferences...” from the File menu will cause the 
prompt, “Show special operations dialog?” to appear. 

7 55 9 MediCAL Provider ID, from Preferences

8 64 20 School of attendance (name)

9 84 22 (unused)

Field listing for the MediCAL eligibility export

Field Start Length Name, description



The Special Operations Dialog enables users with administrative access 
to perform direct programming tasks in interpretive mode, using the 4th 
Dimension language. You should not access this dialog without first 
consulting with Fusion Technik.

If the user cancels the “show special operations dialog” prompt, SELPA 
Manager will then offer to execute a specific method by name (“name of 
a procedure to execute:”). You should not access this feature without first 
consulting with Fusion Technik.

• Accessible from: Browse windows and when no user windows are 
present.

• Accessible to: All users. However, system-wide settings are enabled only 
for users with administrative privileges.

• Notes/limitations: 

For details on how to make selections in the Preferences dialog, please refer 
to the Chapter, “Configuring SELPA Manager” on page 243.

Users and groups...
• Function: Displays a dialog (and related items) that enables group 

administrator(s) to add new users; to edit passwords; and to add or 
remove users from access groups.

• Shortcut key: None. 

• Modifier key: For users with administrative access, holding down the 
[ALT/OPTION] key while selecting “Users and groups...” will allow the 
user to change his/her own current password, without displaying the 
users and groups dialog. For all other users, this menu item is listed as 
“Change password”, and does not display the users and groups dialog.

• Accessible from: Browse windows, data entry forms, and when no user 
windows are present.

• Accessible to: A user that is the administrator of at least one access 
group. In the default configuration for SELPA Manager, only the user 
called “Administrator” can access this menu item.

• Notes/limitations: 

SELPA Manager’s access system is based on users and groups.1 The 
administrator can create users and assign passwords, and place users into 
particular access groups. Each access group has specific rights to view 
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and/or edit appropriate parts of the database. The default, login user names 
are discussed in the Chapter, “Using SELPA Manager” on page 143. The 
default access groups are discussed on page 146.

For program users that do not have administrative access, this item is 
replaced by “Change password...”, which allows the user to edit his or her 
login password. Non-administrative users do not have access to the names 
and passwords of other program users.

To open SELPA Manager, a user either selects or types his or her user name 
and then types his or her password (refer to Fig. 3-6 on page 142). Then, 
depending on which groups the user belongs to and to which parts of the 
database the groups have been assigned, the user can operate the parts of the 
database that were specified by the access system.

The users and groups (Passwords) dialog appears with the default selection 
of users and groups in Fig. 11-11. The dialog contains four scrollable areas.

The upper-left (“Users”) list displays login user names. The users named 
“Designer” and “Administrator” appear at the top of the list, followed by the 
others. The lower-left list displays the names of any groups to which a 
selected (highlighted) user belongs. 

Fig. 11-11. Users and groups (Passwords) dialog. White icons denote items created by 
the program designer (cannot be modified).

1. Portions of this discussion are taken from 4th Dimension Design Reference, Version
6.5 for Mac™ OS and Windows ®, 1985–1999 ACI SA/ACI US, Inc.

List of groupsList of users

List of List of users 
for highlighted 
group

groups for 
highlighted 
user



The upper-right, “Groups” list displays the names of access groups. The 
lower-left list displays the names of users who belong to a selected 
(highlighted) group. The owner of a particular group (highlighted in the 
upper-right listing) will appear first in the lower-left listing.

When the Password dialog is active, a corresponding Passwords menu is 
available. You use the menu commands on this menu to add users and 
groups.

Adding a new user

To add a user and assign user information:

1 Select “New user” from the Passwords menu

SELPA Manager will display an add/edit user dialog, shown in Fig. 11-12. 
Note that the default name is prefixed with a triangle character, which 
indicates that the Administrator (rather than the Designer) has created this 
particular user.

Fig. 11-12. Add/edit user dialog, accessed from Users and groups (Passwords) dialog.

2 Type a new user name.

You can omit the triangle character from the login name. So that the list of 
login names sorts well alphabetically, you may want to enter the new user’s 
name in the format, “Last name, First name”.
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3 Press the EDIT button to specify a password for the new user.

SELPA Manager will display another dialog for password entry (Fig. 11-
13).

Fig. 11-13. Add/edit password dialog, accessed from the add/edit user dialog.

You can use up to 15 alphanumeric characters for a password. Passwords are 
case sensitive — the user must enter the password exactly as it is entered in 
Fig. 11-13. For example, if you define a user’s password as “HolyCow”, the 
user must enter it with a capital H and capital C, or the program will not 
accept the password.

After you specify a user password, that password is not available for viewing 
the next time you open the add/edit user dialog (Fig. 11-12). Asterisks 
display in place of the password characters.

To ensure correct password entry, you must enter the same password twice, 
then press the OK button. 

If you are creating passwords for several users, you may wish to use a 
common password (e.g., “test”) or a common password scheme (e.g., user’s 
first name plus last initial, such as “RobertC”, “TammyK”). Each new user 
can then subsequently log into SELPA Manager and use the “Change 
password...” menu item to customize their password.

4 Click OK to validate the password.



If the two password entries do not match, the program plays a beep, and the 
add/edit password dialog will not close.

5 Press the OK button to close the add/edit user dialog.

NOTE: Do not modify any of the other items on the add/edit user dialog 
(Startup Method, Last Use, Number of Uses, Default Owner of Objects 
created by this User).

The users and groups dialog will now display the name of the new user, in 
the upper-left list.

If you hold down the [ALT/OPTION] key as you close the users and groups 
dialog, SELPA Manager will offer to create [User_info] records for any 
users that are not yet listed in the [User_info] table (“Create any new users 
in the [User_info] table?”). You may find this feature useful if you plan on 
restricting users’ access to the program by district.

If you do not create the [User_info] records in this manner, then SELPA 
Manager will create them one at a time, as program users connect with the 
new login names. 

If you have changed an existing user name, then the program will create a 
new listing in [User_info] for the revised name, without deleting the listing 
under the previous login name.

Changing user information

To change user names and/or passwords:

1 From the users and groups dialog, select the user name in the list of 
users, and double-click the user name.

As an alternative, you can also highlight the user name by clicking on it 
(once), and then selecting “Edit User” from the Passwords menu. 

The program will then display the add/edit user dialog (Fig. 11-12).

2 Make the desired modifications in the add/edit user dialog.

As noted above for adding users, you can change the user name and/or the 
password. You should not change any of the other items.
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3 Press the OK button to save the changes to the user profile.

NOTE: You can create up to 16,000 login user names. However, once you 
have created a new name, you cannot directly delete that name from the list. 
It is possible to replace an entire list of administratively-created users with 
another list, using the “Save groups” and “Load groups” items in the 
Passwords menu (refer to “Saving and loading access information” on 
page 581).

Because users can’t be deleted directly, you should create new users only 
when you are certain that you require them. You can modify the names and 
passwords of “old” login names that are no longer in use, to recycle them 
to new program users.

Creating/editing access groups
SELPA Manager has several default access groups (“AdminGroup”, 
“ReadWriteGrp”, “TeacherGrp”, “TeacherLtdGrp”, “TransportGrp”, 
“MyCalendarItems”, and “4DWriteGrp”; refer to the Chapter, “Using 
SELPA Manager” on page 147). The AdminGroup is owned by the Designer 
and cannot be renamed or deleted. The other access groups can be re-named, 
but then they would lose their relevance to access privileges within SELPA 
Manager. 

You may create as many other (custom) access groups as you wish for 
management purposes, but unless the new groups are themselves members 
of one of the default access groups (“nested1”), then they will have no 
bearing on a user’s access privileges to features within SELPA Manager.

To add a new access group

1 Choose New Group from the Passwords menu.

The program displays the add/edit group dialog (Fig. 11-14).

2 Enter a group name in the Group Name box.

The group name can be up to 15 characters in length. You can remove the 
triangle prefix character, which indicates that the group was created by the 
Administrator rather than the Designer.

1. Refer to the discussion of “Nesting access groups” on page 580.



3 Click on the Group Owner box and select a user from the drop-down list 
of users.

The group owner can add users to and remove users from the access group. 
The group owner can be a program user other than the Administrator, but 
s/he must be a member of the “AdminGroup” in order to access the users 
and groups dialog. A group owner that is not the Administrator cannot create 
or change login user names or passwords.

Fig. 11-14. Add/edit group dialog, accessed from the users and groups (Passwords) 
dialog.

4 Click the OK button to add the group to the access system.

The name of the new group appears in the group list, in the upper-right 
corner of the users and groups dialog.

To change access groups:

1 From the users and groups dialog, double-click the group name in the list 
of groups.

You can also click on the group name and choose Edit Group from the 
Passwords menu. The program then displays the add/edit group dialog (Fig. 
11-14).

2 Enter a new group name or specify a new group owner in the dialog box.

3 Click the OK button to save the changes you made to the group.
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Assigning users to access groups
You can assign users to any access group, and you can assign a user to more 
than one access group. If you do not assign a user to any group, then that 
user will not have read-write privileges within SELPA Manager (refer to the 
discussion of default groups in the Chapter, “Using SELPA Manager” on 
page 146).

To assign a user to an access group, drag the user name from the (upper-left) 
Users list over the name of the desired group in the (upper-right) Groups list, 
and then release the mouse button.

The user name then appears in the lower-right list of users assigned to the 
selected (highlighted) access group. The group name also appears in the 
lower-left Users list of groups assigned to the selected (highlighted) user. 
The assigned user now has all the privileges that accompany membership in 
the selected access group.

Click once on any group name to see a list of users who belong to that group.

To remove a user from an access group:

1 Click on the access group name in the upper-right Groups list, to view (at 
lower-right) the names of users assigned to the access group.

2 Drag the user name from the lower-right Groups list to the upper-left 
Users list, and release the mouse button.

The user no longer has the privileges that are provided to that access group.

Nesting access groups
You can “nest” access groups, placing one group within another, to create a 
group hierarchy. Having nested access groups may facilitate the 
management of a large number of program users.

Some of the default access groups in SELPA Manager are already nested. 
For example, the “TeacherLtdGrp” is nested within the “TeacherGrp”, 
which itself is nested within the “ReadWriteGrp”. (For additional 
information on the nesting relationships among the default access groups, 
refer to Fig. 3-7 on page 155.)



The users belonging to a new, nested access group that you would create 
would obtain the privileges of the next higher (parent) access group in the 
hierarchy. For example, suppose that you created a “SouthernGrp” access 
group that is nested inside the ReadWriteGrp. Users assigned to the new 
SouthernGrp automatically obtain the privileges of ReadWriteGrp. 

To remove a group from another group:

1 Click on the access group name in the upper-right Groups list, to display 
the names of users and groups assigned to the group.

The names of users and nested access groups that are assigned to the 
highlighted access group will appear in the lower-right list.

2 Select the group name in the lower-right list, drag the name to the upper-
left Users list, and then release the mouse button.

The formerly-nested, access group name disappears from the list of users for 
the selected group.

Saving and loading access information
The password system allows the Administrator to save to a disk file and load 
from a disk file any users and groups that s/he has created or modified. When 
users and groups are saved, everything about the current users and access 
groups are saved. Later, when loaded again, the original users and groups are 
restored. 

The saving and loading capability allows the Administrator to save the 
access system information to disk, and then to transfer it to a different 
version of SELPA Manager. This feature is useful for restoring the access 
system information after installing a newer version of SELPA Manager. 
Each time you install a fresh copy of SELPA Manager, it will contain the 
original (default) users and groups.

A good practice for the Administrator is to save groups to disk immediately 
after making any changes to the users or access groups. For example, the 
Administrator might have a folder on his or her hard drive named “Users and 
groups” which contained several date-labeled users and groups files (e.g., 
“Solano_High_050302.4ug”, “Solano_High_041802.4ug”, etc.). 
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If the Administrator always has the latest version of the users and groups 
information on disk, then s/he will not accidentally lose the latest users and 
groups information when performing an update to SELPA Manager. 
Further, if the Administrator adds users or groups that s/he then regrets 
adding, then the groups file on disk can be used to restore the users and 
groups configuration to a point before the new users or groups were added.

To save access groups to disk:

1 Enter the database as the Administrator, and select “Users and groups...” 
from the File menu

2 Select “Save Groups” from the Passwords menu.

SELPA Manager displays a standard, “save-as”-type dialog (Fig. 11-15).

Fig. 11-15. Save groups and users dialog, accessed from the users and groups 
(Passwords) dialog.

3 Name the groups file on disk and press the SAVE button.

To load (restore) access groups from disk, into SELPA Manager:

1 Enter the database as the Administrator, and select “Users and groups...” 
from the File menu.

2 Select “Load Groups” from the Passwords menu.



The program displays an open-file dialog, for locating the Groups file on 
disk.

3 Select the groups file on disk, and press the OPEN button.

The program replaces the existing users and groups information with the 
revised users and groups on the disk file. 

Assigning access to the 4D Write plug-in
SELPA Manager uses the 4th Dimension “plug-in” architecture to provide 
certain ancillary features, such as word processing, calendar display, and 
progress thermometer bars. These plug-ins are included the single-user 
editions of the program. 

For the multi-user editions of SELPA Manager, however, the 4D Write 
(word processing) plug-in is not included; if you wish to use it, you must 
purchase one or more expansion pack licenses for it from 4D, Inc. For 
information on installing SELPA Manager multi-user on a PC server, refer 
to the “PC client-server (server installation)” on page 57. For Macintosh 
multi-user installations, refer to page 94.

If you purchase fewer 4D Write licenses than the number of server “seats”, 
then some users may not be able to access 4D Write when they are 
connected to the server. You can prioritize access to the 4D Write plug-in by 
assigning users that require 4D Write access to the group, “4DWriteGrp”. 
Program users that are not members of this access group will not occupy one 
of the total number of 4D Write licenses as they log in to the program.

From the Passwords menu, it is possible to reassign 4D Write group access 
to another group (other than “4DWriteGrp”). It is strongly recommended 
that you do not make this change, since SELPA Manager counts available 
licenses numbers based upon the number of logged-in users from the 
“4DWriteGrp”. SELPA Manager would not know if you reassigned group 
access of the 4D Write plug-in to another group.
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Who’s here...
• Function: Displays a dialog (Fig. 11-16) listing the login names under 

which users are presently connected to SELPA Manager; the number of 
users connected with each login name; and, for each login name, the date 
and time at which the user last connected.

• Shortcut key: None. 

• Accessible from: Browse windows, data entry forms, and when no user 
windows are present.

• Accessible to: All users.

• Notes/limitations: 

If a user has exited from a multi-user edition of SELPA Manager 
abnormally, by crashing, shutting off the computer, or logging off of the 
computer without first quitting SELPA Manager, then the login may still be 
listed in the “Who is here...” dialog.

With the single-user editions of SELPA Manager, only one user should be 
listed.

Fig. 11-16. “Who is here...”dialog.

Print
• Function: From the browse window, prints the selection of records in the 

list that has the current focus. If there are no records in that list, SELPA 
Manager displays an error message, “There are no records in the 
selection to print.” 



From a data entry form, the Print menu item will print a single record (the 
one currently displayed), rather than a selection of records. Not all data 
entry forms have corresponding print forms available yet.

• Shortcut key: [CNTRL/CMD]-P. 

• Accessible from: Browse windows and some data entry forms.

• Accessible to: All users.

• Notes/limitations: 

In general, the printed forms in SELPA Manager have been developed and 
tested for compatibility with Hewlett-Packard LaserJet™ 4P-Series printers 
(using the HP-GL language) for Windows computers, and with Hewlett-
Packard 5P/5MP-Series printers (using the PostScript™ language) for 
Macintosh. For both platforms, we make use of the print drivers included 
with the operating system, rather than with the drivers that HP furnished 
with the printer.

Certain forms may require a specific setting; for example, wider margins on 
Macintosh, or legal-sized paper for attendance registers. In most cases, 
however, SELPA Manager attempts to adjust the printer settings accordingly 
for you. 

If you are using a PostScript printer driver on a Windows computer, you may 
find that the printed pages are slightly small and can be enlarged slightly 
(PROPERTIES button for the printer, when Windows displays the first, 
standard print confirmation dialog). If you are using a non-PostScript 
(QuickDraw™-based) printer on a Macintosh, you may find it necessary to 
specify wider margins, or a 95-percent print size (5 percent reduction). 

If you have requested that Fusion-Technik develop custom forms for your 
SELPA, and you use a specific printer that is not fully compatible with the 
HP drivers, be sure that you request development and testing for that specific 
printer.

Printing students
Fig. 11-17 is a dialog that SELPA Manager displays when you choose Print 
for a selection of (for example) 3634 students in the browse window.
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A similar dialog will appear when you choose Print from the student data 
entry form, except that Options 6, 8, and 9 on the dialog would be disabled; 
these items apply only to a selection of student records, not to an individual 
student. At this writing, Option 7 is always disabled, as there is not yet a 
student profile form.

IEP data verification forms (Options 1–4)

Options 1 through 4 can be associated with IEP data verification and 
notification forms that are customized for your SELPA. Option 5 can be 
associated with a customized transportation profile. When these custom 
forms are available, they will appear in the list on the right (“Forms 
available”). If there are no custom forms available for a particular print 
option, the list will display the name of the default form (e.g., “Default IEP 
all”).

Fig. 11-17. Print students dialog.

You can always override the use of the custom forms by checking the 
DEFAULT FORM box — when this box is checked, SELPA Manager will 
use only the default forms for Options 1 through 5.

Options 1 through 3 represent different printing options for the same form, 
the IEP data verification: template and data (the full printed form); data only 
(for preprinted forms); and template only (to print blank forms). If you use 
Option 2, ensure that you place the preprinted forms into the printer tray 
with the correct orientation for the printing mechanism. 



Fig. 11-18 is a sample print preview of the default verification form. To 
obtain a second listed parent (“2nd Parent/Guard”) printed onto the form, 
the student must have an associated contact record in SELPA Manager with 
the Relationship column entry (the [Student_Contact]Contact_relation 
field) designated as “Parent 2”. If there is more than one contact for the 
student with this relationship, then SELPA Manager sorts these contacts by 
address type and contact name, and then takes the first listed contact.

To obtain an emergency listing (“Emer. name”) on the printed form, the 
student must have an associated contact record of address type 
“Emergency”, “Emergency 2”, or “Emergency 3”, etc. If there is more than 
one contact of the “Emergency...” address type, then SELPA Manager sorts 
these contacts by address type and contact name, and then takes the first 
listed contact

Fig. 11-18. IEP verification, example print, default form (partial view).

When you select Option 4 (IEP notice) for the default notification form, 
SELPA Manager displays another dialog (Fig. 11-19). Here you may enter 
supplemental information that should be placed onto the IEP notification 
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forms that are printed. This supplemental information is not stored with the 
student record. A sample print preview of an IEP notice form appears in Fig. 
11-20.

Fig. 11-19. IEP notice extra items dialog.

Fig. 11-20. IEP notice, example print, default form (partial view).



Transportation profile (Option 5)

The transportation profile (Option 5 in the print students dialog) is a 
relatively simple printed form, displaying the students’ transportation 
requirements and drop-off / pick-up information (Fig. 11-21).

Fig. 11-21. Transportation profile, example print, default form (partial view).

Transportation summary report (Option 6)

The transportation summary report (Option 6, Fig. 11-22) is a printed listing 
for the current selection of students who have “active primary” services; that 
is, those services designated as primary, which begin on or before a date 
specified in Fig. 11-17, and that are either dropped after the same specified 
date, or that have no drop date1. 

If no students in the current selection meet the service criteria, then SELPA 
Manager displays an error message (“There are no students that have 
eligible services (cannot print).”). 

1. As with all service-based searches, SELPA Manager also looks either within the
current or the selected alternate year, depending upon whether “Other year services”
is checked in the Data menu, for that browse window. Refer to “Other year services”
on page 647
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The transportation summary report is printed in alpha order by student 
name. If you check the box, BY TEACHER that accompanies Option 6 (Fig. 
11-17), then SELPA Manager will first sort all student records by the name 
of the teacher providing the primary service, and insert a page break 
between teachers. 

Fig. 11-22. Transportation summary, example print (partial view).

Quick Report Editor (Option 8)

The eighth listed choice for printing students (Option 8 in Fig. 11-17) is an 
ad hoc report, using the Quick Report Editor. The Quick Report Editor 
allows you to make your own, custom-format, columnar report with student-
level information. For additional details on using the Quick Report Editor, 
please refer to the Chapter, “Quick Report Editor” on page 720.

Other (Option 9)

The final selection in the print students dialog (Option 9 in Fig. 11-17) is 
“Other”, which includes a pull-down menu of other reports that can be 
selected. 

1 Enrollment summary by disability

The “Other” menu contains an “Enrollments by disability” report. This 
report is similar to the CASEMIS software “Enrollment Summary by 
Disability” report. However, the numeric totals from the SELPA Manager 



report do not exactly match those of the CASEMIS report. Accordingly, 
SELPA Manager presents a warning dialog (Fig. 11-23) when you request 
this report.

Following the caution, SELPA Manager presents a report configuration 
dialog (Fig. 11-24), prompting you to specify how records for the report are 
to be selected and collated. Fig. 11-25 is a sample, print preview of a report. 

Fig. 11-23. Caution dialog that appears before generating the Enrollment summary by 
disability report.

Fig. 11-24. Configuration dialog for the Enrollment summary by disability report.
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Fig. 11-25. Sample print preview for the Enrollment summary by disability report.

Printing assessments (IEP forms)
When you choose “Print...” from the File menu, and a selection of 
assessment records has the current focus in the browse window, then SELPA 
Manager displays the dialog shown in Fig. 11-26.

Fig. 11-26. Print assessments dialog.

Generally, each checkbox on this dialog (except “Quick Report”) represents 
a separate page of the IEP form. Checking the box means that you want that 
page to be printed. Depending upon the particular configuration of your IEP 
form, you may see a different number of check boxes, and the descriptions 



may be different. Some SELPAs also have a checkbox for “Spanish forms” 
and/or “Working copy” (in which portions of the first page are printed as 
incomplete, without the data from the record).

If you select “Print...” while you are editing a particular assessment data 
entry form, then the same dialog (Fig. 11-26) will appear, but the Quick 
Report check box will be disabled. In this case, SELPA Manager will offer 
to print only the assessment form that is being edited.

Printing student services
When you choose “Print...” from the File menu, and a list of student service 
records has the current focus, then SELPA Manager displays the dialog 
shown in Fig. 11-27.1

Fig. 11-27. Print student services dialog.

There are two options available for printing a selection of services, an ad hoc 
report generated with the Quick Report Editor, and a transportation 
summary report. For details on using the Quick Report Editor, please refer 
to the Chapter, “Quick Report Editor” on page 720

The transportation summary report is the same one that is illustrated in Fig. 
11-22 on page 590, above, except that the starting point here is a selection 
of services rather than a selection of students. If you check the box, “Active 
primary services only, as of:” then SELPA Manager will further narrow the 

1. At this time, there is no print option when editing an individual student service
record (SELPA Manager will display an alert, “No printable form exists yet in this ar-
ea”.)
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selection of services to include only primary services that start on or before 
the specified date, and that are either dropped after the specified date, or that 
are as yet not dropped.

If you leave the “Active primary services only, as of:” box unchecked, then 
SELPA Manager will include all listed services in the transportation 
summary report, sorted by student name. If the “Collate by teacher” box is 
checked, then SELPA Manager will first sort all printed rows by the name 
of the teacher providing the service, and insert a page break between 
teachers. 

Printing goals
When you choose “Print...” from the File menu, and a list of assessment goal 
records has the current focus, then SELPA Manager displays a dialog (Fig. 
11-28), asking whether a detailed goal form should be printed. If you press 
CANCEL, then the program displays the Quick Report Editor, for ad hoc 
reporting. 

Fig. 11-28. Print goals confirmation dialog.

Fig. 11-29 is a print preview of a sample “print detail” goal for a particular 
SELPA (3702). This form includes two goals per page, so the number of 
printed pages will be half the number of goals in the current selection.



Fig. 11-29. Print goal detail (example, partial print as preview, SELPA 3702).

Printing disciplinary actions
There are no custom printed forms for disciplinary actions. Consequently, 
selecting “Print…” when a list of disciplinary action goals has the current 
focus, will cause SELPA Manager to display the Quick Report Editor.

Printing teachers
When you choose “Print...” from the File menu, and a list of teacher records 
has the current focus, then SELPA Manager displays the dialog shown in 
Fig. 11-30. There are three options available for printing a selection of 
teachers, the Student by Teacher report, Attendance Registers, and an ad hoc 
report generated with the Quick Report Editor.

NOTE: For the Student by Teacher and the Attendance Registers report 
options, users who are in the “TeacherGrp” access group (only) are limited 
to printing these reports for the teacher corresponding to their current login 
name. If the printed results are not as expected, then you should ensure that 
you have selected the correct current or alternate year for student services.
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Student by teacher report

The Student by Teacher report is a listing of students that have services 
provided by the teacher or teachers listed in the browse window. 

Fig. 11-30. Print teachers dialog.

The dialog for this report (Fig. 11-31) allows you to find students that have 
primary services only; that have non-primary services only; or that have 
either primary or non-primary services with the listed teacher(s).

[rev. 1.16.2003]

Fig. 11-31. Print student by teachers report dialog.

You can also select the type of contact address that is to be included for each 
student/service row printed in the report (“Type of student contact to 
include:”). The default selection is “Resides here checkbox”, which will find 
the contact record that has the “resides here” box checked for the student.1 
Another option, “Any parent”, will find the contacts for each student for 
1. Only one “resides here” address is permitted for each student, refer to the Chapter,
“Entering Students” on page 373)



whom the [Student_Contact]Contact_relation field starts with either 
“parent”, “mother”, or “father”. If more than one contact is found, then the 
program sorts the records by contact name, and prints the first one listed. 
Another contact option is “First alpha sort”, which directs the program to 
find all contacts for a particular student, sort them by contact name, and then 
print the first one. Any other contact specification in Fig. 11-31 will match 
the phrase entered to the contents of the [Student_Contact]Address_type 
field.

For each teacher that is to be printed, SELPA Manager locates associated 
student services with a start date on or before a user-specified date (Fig. 11-
31), for which the drop date is either blank or after the user-specified date.

The student(s) represented by these services are sorted alphabetically or, if 
“Separate by school and track” is checked in Fig. 11-31, sorted by school of 
attendance and track. Because this report is essentially a list of students for 
one or more teachers, the student will only appear once per teacher, even if 
the student has more than service with that teacher. Fig. 11-32 is an example 
(as a print preview) of a portion of the Student by Teacher report.

Fig. 11-32. Student by teacher report (sample print preview).

The Student by Teacher report dialog (Fig. 11-31) also has an option to 
generate the information as a delimited text file on disk (“Export to disk 
file”), instead of printing the report on paper.
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Attendance registers report

In contrast to the Student by Teacher report, the Attendance Registers report 
(Fig. 11-33) prints one row per student service, with a selected teacher. 
Thus, if a student has more than one service with the teacher within the 
specified time period, then the student will appear in more than one row of 
the report.

The Attendance Registers report is a legal-sized, landscape-format 
document representing a four week (Monday–Friday) period as 20 columns. 
For each teacher to be printed, SELPA Manager finds services that start on 
or before the last day (the fourth Friday) of the time period, and that either 
are not dropped or that drop after the first Monday of the time period. Up to 
25 services can be printed as rows per page.

A dialog (Fig. 11-34) allows you to specify the start date for the four-week 
time period. If you select a date that is not a Monday, then SELPA Manager 
will block out the days from the preceding Monday to the specified start 
date. You can also specify other dates or date ranges that should be blocked 
out, such as vacations or holidays. A “skip blanks” check box allows you to 
omit teachers that are in the current selection, but who do not have any active 
student services within the specified, 4-week time period.

Fig. 11-33. Attendance register report (sample print preview).



Fig. 11-34. Print Attendance Registers report dialog.

The student services for each teacher are sorted by class code and 
CASEMIS service code, unless you have marked the “Separate by 
school/track” check box in Fig. 11-34, in which case SELPA Manager will 
instead sort by school name (for the particular student service) and student 
track.

If you have entered actual attendance records into SELPA Manager for the 
students, then the program can print attendance marks onto the attendance 
register. You must check the “Show actual attendance marks” box in Fig. 11-
34. Actual attendance information may be entered into the browse window 
Location box, or while accessing the teacher assignment data entry form. 
For instructions, refer to the Chapter, “Adding Staff and Related 
Information” on page 353.

Printing schools or assignments
There are no custom printed forms for schools or for teacher assignments. 
Consequently, selecting “Print…” when a list of schools or teacher 
assignments has the current focus, will cause SELPA Manager to display the 
Quick Report Editor.
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Printing districts
When you choose “Print...” from the File menu, and a list of district records 
has the current focus, then SELPA Manager displays the dialog shown in 
Fig. 11-35. 

Fig. 11-35. Print districts dialog.

There are seven reports available for printing a selection of districts: the 
district chargeback report, the student service summary by disability report, 
the personnel data report, the CBEDS county/district information report, the 
Student National Origin Report (SNOR), the Office of Civil Rights (OCR) 
District Summary (ED101), and an ad hoc report generated with the Quick 
Report Editor.

District chargeback report

The District chargeback report provides a mechanism for a SELPA or other 
central facility to generate a statement of charges, for services that the 
central facility provides to students whose district of residence is listed in 
the browse window. The chargeback report can be specified by selecting a 



school of attendance, or by specifying from one to four types of school of 
attendance. A detailed discussion of the chargeback report appears in the 
Chapter, “Student Services and Goals” on page 456.

Student service summary by disability report

The student service summary by disability report is the same report that is 
available when printing a selection of students (refer to “Printing students” 
on page 585 and Fig. 11-25 on page 592). 

If you have elected to collate by district of residence in the report 
configuration dialog (Fig. 11-24), then SELPA Manager generates the report 
for all students whose district of residence corresponds to one of the districts 
listed in the browse window. If, instead, you have chosen to collate the report 
by district of service, then SELPA Manager first finds all schools in the 
listed districts; then finds student services at those schools; and then the 
students corresponding to those services.

Personnel data report

The Personnel data report accounts for special education services that 
teachers and other providers are supplying on a specific date, in specified 
service categories, and within the districts that are listed in the browse 
window. 

The report includes three CASEMIS-specified forms: the district total (one 
page per district), the SELPA summary (one page summarizing totals for all 
districts), and the certification form. An example of a district total form 
appears in Fig. 11-36.

To print the SELPA summary form, all districts must first be listed in the 
browse window, at the time that you select Print from the File menu. If all 
districts are not listed, then the “SELPA” check box is disabled in Fig. 11-
35. 

The district and SELPA summary forms account for providers in 23 
different categories (e.g., Resource Specialist, Vocational Education 
Specialist, Audiologist, School Social Worker, etc.). 
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Fig. 11-36. District total page, personnel report form (print preview, partial).

For a personnel count to be included in the report, the following conditions 
must be met:

• The teacher/provider has assignment(s) at schools located in the listed 
districts. For information on creating assignments, refer to the discussion 
on page 339 (adding assignments, lower list) or on page 350 (entering 
assignments directly from the browse window).

• The assignment is marked as active.

• The starting date for the assignment is on or before the report date (“on 
date:” in Fig. 11-35).

• The Full Time Equivalent (FTE) for the assignment is not blank.1

• The expiration date for the teacher service associated with the assignment 
is either blank, or is after the report date. The expiration date is the “Ends 
on” (fifth) column in the teacher services list, Tab 2 of the teacher data 
entry form (page 338).

1. Unless the box, “Count blank FTEs as 1” is checked in Fig. 11-35. With this option,
blank FTEs for otherwise valid assignments are counted as one. A teacher can have a max-
imum of 1.2 FTEs among all his/her active assignments.



• The provider type for the teacher service associated with the assignment 
falls into one of the 23 state-defined personnel categories accounted for 
in the report (“Pvdr type” the sixth column in the teacher services list, Tab 
2 of the teacher data entry form, page 339).

The column in the personnel report to which the assignment is added will 
depend upon the status of the associated teacher service. “Status” is the 
fourth column in the teacher services list, Tab 2 of the teacher data entry 
form (page 338).

• If the service is “current”, “certified”, “preliminary credential”, 
“certificate not required”, or “no state requirements”, then the count 
applies to the first column (“Fully certified”). 

• If the status of the teacher service is “vacant”, then the count applies to 
the third column (“Vacant”). 

• All other status descriptions, including an empty status, apply to the 
second column (“Not fully certified”).

For the purpose of identifying vacant positions, you might want to create 
one or more new teachers with fictitious names (e.g., “Open Position 1”, 
“Open Position 2”, etc.). 

On Tab 2 of each of these new teacher data entry forms, add one or more 
teacher services to the upper list, with the status of “vacant” (Column 4). 
Add one or more active teacher assignments to the lower list on Tab 2, one 
for each vacancy that you wish to be listed. Ensure that you specify 
assignment starting dates and FTE values that are consistent with the 
settings for the personnel data report which you will be generating.

Print label
• Function: From the browse window, prints fields, in label format, from 

the selection of records in the list that has the current focus. The Print 
label menu item is not available when editing an individual record, on a 
data entry form. 

• Shortcut key: None

• Accessible from: Browse windows.

• Accessible to: All users.

• Notes/limitations: 
File Menu Operations 603 

• 
• 
• 
•
•
•



604  

• 
• 
• 
•
•
•

Print label makes use of the 4th Dimension Label Editor, which is described 
in the Appendix, “Using the 4D Label Editor” on page 775. 

If you wish to print mailing labels for a selection of students, then you 
should ensure that the Quick Report replicate/clone fields (“QR_...” or 
“QR2_...” fields in Fig. 7-7 on page 370) are populated with the appropriate 
address information from the contacts for the students; refer to the QR 
button in the Chapter, “Entering Students” on page 369. You can also update 
the Quick Report replicate fields for a selection of students, using the 
“Update other...” command in the Actions menu.

Start web services
• Function: Starts web services from the single-user editions of SELPA 

Manager. For multi-user versions of the program, where the web server 
is operational and the client has print-to-pdf capability, this menu item 
can establish a print-to-pdf service for web-based program users.

• Shortcut key: None.

• Accessible from: Browse windows; also when no windows are open. 
Disabled if the function is already running.

• Accessible to: Members of the “ReadWriteGrp” access group.

• Notes/limitations: 

SELPA Manager provides limited access to web-based clients, through the 
mechanism of an internal web server. The web server permits SELPA 
Manager users with read-write type access to add new or edit existing IEP 
forms. New IEPs can be created for students that already exist in the 
program, or for new students.

There is also a provision in the web server that permits a teacher to 
download his/her students over the web, in a format that can subsequently 
be imported into another copy of SELPA Manager (refer to the import 
description for “Students from web” on page 563).

To start the web serer, the “Default CA IEP form” box must be checked, in 
the System 2 tab of the Preferences dialog.

This web serving capability can be activated on the single-user editions of 
the program by selecting “Start web services” from the File menu. On the 
multi-user editions of the program, the web services must be started from 



the 4D Server application itself, on the SELPA Manager server computer. In 
this case, the “Start web services” menu item on the workstations of 
connected users can be used to start print-to-pdf services for web-based IEP 
printing.

Web services can remain active for up to one hour, at which point the 
temporary web license expires and the program (either SELPA Manager for 
single-user editions or 4D Server for multi-user editions) must be re-started 
to obtain an additional hour of use. For unrestricted use of the web server 
function, a 4D Web Extension License can be purchased from 4D, Inc.

Stop web services
• Function: Stops web services from the single-user editions of SELPA 

Manager. On multi-user editions, stops the print-to-pdf service for web-
based clients.

• Shortcut key: None.

• Accessible from: Browse windows; also when no windows are open. 
Disabled if web services are not running.

• Accessible to: Members of the “ReadWriteGrp” access group.

• Notes/limitations: 

Selecting this item will cause SELPA Manager to refuse any new requests 
to connect to the program via the web. On single-user editions, the item will 
stop a print-to-pdf service that is currently operating on that client 
workstation.

“Stop web services” will be enabled on single-user editions of SELPA 
Manager, if web services are currently active. It is disabled when web 
services are not currently active. 

The item is enabled on workstations of a multi-user edition of SELPA 
Manager, when a print-to-pdf service is running on that client computer.

On the multi-user editions of the program, the web services must be stopped 
from the 4D Server application itself, on the SELPA Manager server 
computer.
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Exit
• Function: Used as a means to exit (quit) from SELPA Manager.

• Shortcut key: [CNTRL/CMD]-Q. When no browse windows or data 
entry forms are open, pressing [ESC] has the same effect (SELPA 
Manager presents a confirmation dialog in this case).

• Accessible from: Browse windows; also when no windows are open.

• Accessible to: All users.

• Notes/limitations: 

Use this menu selection to exit from SELPA Manager. If one or more browse 
windows / data entry forms are open, then the program will ask for 
confirmation that you want to quit, warning you that some windows are still 
open. If there is any unsaved data on any open data entry forms, then that 
information will be lost on quitting the program.



• • • • • •
 12 Data Menu Operations

Many of the tasks in SELPA Manager can be performed by making use of 
menu items. The purpose of this chapter is to summarize the operations that 
are available in the Data menu 

[rev. 1.13.2003]

The five principal menus of a workstation running SELPA Manager are File, 
Edit, Window, Data, and Actions. These menu items appear in both the 
single-user runtime version and the client-server version of the program.A 
description of the items in the File menu appears in the Chapter, “File Menu 
Operations” on page 511. The Chapter, “Actions Menu Operations” on 
page 651, describes the functions in the Actions menu.

The File, Edit and Window menus are always visible, although the items in 
each menu that are enabled will depend upon the context in which you 
access the menus. 

The Data and Actions menus are visible when SELPA Manager is displaying 
a browse window or a data entry form as the active (front-most) window. 
When no windows are displayed other than the status bar (a narrow sliver 
of a window at the lower right corner of your screen), then the Data and 
Actions menus will not be visible. Similarly, when you click on the status 
bar to make it the active window, then the Data and Actions menus will 
disappear.

This chapter does not discuss the items that appear on the menus on the 
server computer. To install the server computer software on a multi-user 
installation of SELPA Manager, refer to “PC client-server (server 
installation)” on page 57 or to “Macintosh client-server (server 
installation)” on page 94. For a more detailed look at the various menu items 
that are available in the 4D Server application, please refer to the 
documentation for 4D Server.1 2
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If SELPA Manager is not yet installed on your computer, please refer to 
“Getting started” on page 134. If SELPA Manager is installed on your 
computer, but you have not yet started using the program, then we 
recommend that you refer to “Getting started” on page 134.

Data menu overview
The Data menu items include record selection 
and editing commands; searching, graphing and 
sorting functions; and record set manipulation. 
There is also a provision to access services in an 
alternate year (“other year services”), which 
allows you to plan class rosters for one or more 
future academic terms.

Not all items will be available at all times. Most 
items in the Data menu are disabled when you 
are editing information in a data entry form. The 
item, “Find again” is only active during data 
entry operations, and the “Find” item works 
differently when used in browse windows from 

its function during data entry.

New record
• Function: Adds a new record to the table that has the current focus, in the 

active browse window. Changes the browse window to a data entry form, 
for the new record.

• Shortcut key: [CNTRL/CMD]-N.

• Modifier key: (none)

• Accessible from: Browse windows, where the current focus is on a table 
that permits the addition of records through user data entry.

1. 4D SA/ 4D Inc., 4D Server Reference, Version 6.0 for Windows ® and Mac™ OS.
Cupertino: 1985-1997, 4D SA/4D Inc.
2. 4D SA/ 4D Inc., 4D Server Reference, Version 6.7 for Windows ® and Mac™ OS.
Cupertino: 2001, 4D SA/4D Inc.



• Accessible to: Users that are members of the “ReadWriteGrp” access 
group. However, if the TRANSPORTATION ONLY box is checked in 
Preferences (page 299), then “New record” will be disabled when the 
current focus is on a students list.

Members of the “TeacherGrp” access group can also access “New 
record”. However, they cannot add records when the current focus is on 
a teacher, teacher service, assignment, school, or district list in the browse 
window. 

This command is not available to members of the “TeacherLtdGrp” 
access group.

Notes/limitations: 

Certain tables do not permit the addition of new records from a browse 
window list, using this menu item. These tables include [User_info], 
[Tracking], and [Calendar_item]. To add an item to the [Calendar_item] 
table, you can double-click on a particular date on the Calendar itself (refer 
to the Chapter, “Using SELPA Manager” on page 226).

If you have checked the TRANSPORTATION ONLY box on the 
Appearance tab of Preferences, then the “New record” item will be disabled 
when the current focus in on a students listing (refer to the Chapter, 
“Configuring SELPA Manager” on page 299).

When a member of the “TeacherGrp” access group adds a new student 
record, the record should always be saved with at least one service that is 
provided by the user. Otherwise, the user will not have access to the student 
record after it is saved.

If you have highlighted one record in the list that does not have the current 
focus in the browse window, and then select “New record”, then SELPA 
Manager will attempt to associate the new record with the highlighted 
record. This result will also occur if only one record is listed, in the table 
listing that does not have the current focus.

For example, suppose that you are in the Discipline context, and that you 
highlight the name, “Jason Smith” in the lower (student) listing. If you then 
make the upper (discipline) list active and select “New record”, then SELPA 
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Manager will create a new disciplinary action record for the student, Jason 
Smith. If more than one record in the alternate table is highlighted, then the 
program will not link any of the highlighted records with the new record.

“New record” alters the current selection of records in the browse window, 
so that it contains only the record(s) being added. For example, if you select 
“New record” while the current focus is on students; enter student 
information into the data entry form; and then press the SAVE button, then 
the students list will display only the new student record.1 In a similar vein, 
when editing the new record, the record navigation buttons on the data entry 
form (page 239) will be disabled, because there are no other records 
available to access.

If the ADD NEW RECORD LOOP box is checked in Preferences 
(page 293), and, after the last new record is added, the user presses the 
CANCEL button, then the browse list will contain only the record(s) that the 
user added.

Modify record
• Function: Allows you to view or edit an existing (highlighted) record, in 

the table that has the current focus, in the active browse window. Changes 
the browse window to a data entry form, displaying the record.

• Shortcut key: [CNTRL/CMD]-M. As an alternative to using the menu 
item, you may also double-click on a listed record.

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: All users except “TeacherLtdGrp” access group.

Notes/limitations: 

To successfully make changes to (to edit) an existing record using the 
standard data entry forms, the user must be a member of the 
“ReadWriteGrp” access group, and must not be subject to a district access 
restriction for that particular record.2 Otherwise, the SAVE button on the 
form will be disabled. 

1. However, if the user presses the CANCEL button while in the process of adding a
single new record, then the browse window will display the previous selection of
records.



To edit student information on the transportation-only data entry form, the 
user must be in the “ReadWriteGrp” access group or in the “TransportGrp” 
access group. Further, the user must not be subject to a district access 
restriction for that particular record (refer to the Chapter, “Using SELPA 
Manager” on page 156). Otherwise, the SAVE button on the form will be 
disabled.

While the user is viewing the data entry form for a particular record, the 
navigation buttons at the bottom of the form (page 239) will be available for 
moving among records, if there is more than one record in the current 
selection.

Delete selected
• Function: Allows you to permanently delete one or more existing 

(highlighted) records, in the table that has the current focus, in the active 
browse window. May also delete related records, depending upon the 
context.

• Shortcut key: [CNTRL/CMD]-E. 

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Users that are members of the “ReadWriteGrp” access 
group, including “AdminGroup” members (refer to Fig. 3-7 on 
page 155). Not available to members of the “TeacherGrp” or 
“TeacherLtdGrp” access groups.

Notes/limitations: 

“Delete selected” will function only if one or more records are highlighted 
in the table that has the current focus. Prior to deleting the record(s), SELPA 
Manager will present a dialog, asking you to confirm that you wish to delete 
the highlighted records. If related records are involved, then the dialog will 
present additional information concerning the related records (see, for 
example, Fig. 12-1, below, for a deletion of 3 student records).

2. Members of the “TeacherGrp” access group also have this capability, by virtue of
the fact that the “TeacherGrp” itself is a member of the “ReadWriteGrp” access group.
For more information, refer to the discussion of relationships among access groups, in
the Chapter, “Using SELPA Manager” on page 154.
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In some cases, deletion may not be successful. Examples include the 
following:

• One or more of the records to be deleted is being edited by another 
program user, on the client-server version of the program.

• One or more of the records related to the records to be deleted, is being 
edited by another program user, on the client-server version of the 
program.

• One or more of the records to be deleted is being edited in another 
window, on the same copy of SELPA Manager.

• One or more of the records related to the records to be deleted, is being 
edited in another window, on the same copy of SELPA Manager.

Fig. 12-1. Delete record confirmation dialog. In this example, the user selected the 
three highlighted students for deletion.

• An [Assessment] record (IEP form) to be deleted has been marked as 
locked (SELPA 3702 only).



In these instances, the affected records will be locked, and cannot be deleted. 
SELPA Manager will present a dialog indicating that the deletion failed, and 
that none of the selected records or related records were deleted. You may 
wish to narrow the selection of records to be deleted, or wait to delete the 
records at a later time.

If you have a hundreds of records to be deleted, it is best not to delete them 
all at once. For example, if you wish to delete 900 records, then you might 
highlight the first 150 to 200 records, delete them, and repeat with the next 
150-200 records, until all records are deleted.

Show all
• Function: Displays all records for the list that has the current focus, on a 

browse window.

• Shortcut key: [CNTRL/CMD]-J. 

• Modifier key: [ALT/OPTION] to show all records, when the menu item 
is “Show all for me” (see Item 2, below). [ALT/OPTION] to show records 
in the user’s districts only, when district access restrictions are in effect 
but the user has not selected “My Districts” as the initial browse display 
in Preferences (see Item 3, below). Also add [SHIFT] in the latter case, 
to avoid the confirmation dialog, “Restrict to your districts? ...”

• Accessible from: Browse windows.

• Accessible to: All users (results subject to access restrictions), 
except/excluding members of the “TeacherLtdGrp” access group.

Notes/limitations: 

1 Student services

In the list of services, a “Show all” request will cause SELPA Manager to 
display all services for the “alternate” or “other” year that is currently being 
displayed, for the particular browse window (refer to “Other year services” 
on page 647).

2 “Show all for me” (student-related tables)

If the user is a member of the “TeacherGrp” access group and is not also a 
member of the “AdminGroup” access group; or if the user has selected one 
of the “for me” options in Preferences for the browse window initial display 
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setting1, then the “Show all” item in the Data menu will become “Show all 
for me,” when the current focus is a student-related list (students, 
assessments, goals, disciplinary actions, student services, contacts, and 
transitions).

“Show all for me” causes SELPA Manager to find all student service records 
for which the current login user is the teacher, in the “alternate” or “other” 
year that is currently being displayed. 

From this set of services, the program can then obtain the corresponding 
students and, depending upon the list that has the current focus, the 
associated assessments, goals, disciplinary actions, contacts, or transitions.

Users that are not members of the “TeacherGrp” access group2 can hold 
down the [ALT/OPTION] key while selecting this menu item, to obtain all 
records instead of “all for me.”

3 District access restrictions in effect

If (1) the login user has one or more district access restrictions; (2) the user 
has selected “My districts” option in Preferences for the browse window 
initial display setting; and (3) the current focus is on a list of schools, 
districts, students, assessments, goals, disciplinary actions, student services, 
contacts, or transitions; then SELPA Manager will offer to restrict the “show 
all” display to records associated with the districts to which the user is 
restricted. 

For example, suppose that an administrator has restricted the login user to 
the districts “Seymour High” and “Carlsbad Middle”, and that the user has 
selected “My districts” as the browse window initial display preference. 
Further suppose that the current focus is on schools when the user selects 
“Show all” from the Data menu. Then SELPA Manager will present a 
confirmation dialog, “Restrict to your districts? (CANCEL=all districts)”. If 
the user presses the OK button, then the program will display only those 
schools that are in one of these two districts. 

1. For more information on the browse window initial display option setting in Prefer-
ences, refer to the Chapter, “Configuring SELPA Manager” on page 296.
2. This restriction does not apply to a user that is also a member of the “AdminGroup”
access group.



If the current focus is on students or a student-related table, then SELPA 
Manager will find students whose record number begins with the district 
number corresponding to one of the specified districts (Seymour High or 
Carlsbad Middle). For student services, assessments, etc., the program then 
obtains the associated records for the found students.

If the user has one or more district access restrictions in effect, but has not 
selected “My districts” as the initial browse preference, s/he can still obtain 
the offer of restricting the displayed records to the user’s districts, provided 
that s/he holds down the [ALT/OPTION] key while selecting “Show all” 
from the Data menu. 

NOTE: To skip displaying the “Restrict to your districts...” confirmation 
dialog, hold down the [SHIFT] key when selecting the “Show all” item.

Show current
• Function: Displays records that are associated with current student 

services, for the list that has the current focus, on a browse window.

• Shortcut key: (none)

• Modifier key: [SHIFT] key down, from a students list only — finds 
students having no current services (no associated services for the 
student, or all associated services have been dropped on or before a user-
specified date). [ALT/OPTION] key down — finds current records where 
a specified teacher is the provider for the associated student services 
(refer to Item 2, below).

• Accessible from: Browse windows where the current focus is on a 
student or student-related list.

• Accessible to: All users (results subject to access restrictions), 
except/excluding members of the “TeacherLtdGrp” access group.

Notes/limitations: 

1 Search criteria

This item obtains current records in the table from which it was called (the 
“target” table), by first searching the student service table for current 
services, and then relating the found selection of services to a corresponding 
selection in the target table. 
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The basis for obtaining current student services includes the following 
criteria:

• The service drop date is empty (00/00/00) or is after today’s date (based 
upon the computer’s clock or, for client-server editions, on the server’s 
computer clock).

• The starting date for the service is on or before today’s date.

• The “alternate” or “other” year for the service corresponds to the year 
being displayed in the browse window (refer to “Other year services” on 
page 647)

• If the target table for the search is the [Student_service] table itself, or if 
it is the [School] table, then the search includes primary and non-primary 
services. For all other target tables where “Show current” is selectable 
(assessments, goals, discipline, students, student contacts, transitions), 
the search includes only primary services.

2 “Show current for me” (student-related tables)

If the user is a member of the “TeacherGrp” access group and is not also a 
member of the “AdminGroup” access group; or if the user has selected one 
of the “for me” options in Preferences for the browse window initial display 
setting1, then the “Show current” item in the Data menu will become “Show 
current for me,” when the current focus is a student-related list (students, 
assessments, goals, disciplinary actions, student services, contacts, and 
transitions).

“Show current for me” causes SELPA Manager to further restrict the search 
of the student service records to services for which the current login user is 
the teacher. 

Users that are not members of the “TeacherGrp” access group2 can hold 
down the [ALT/OPTION] key while selecting this menu item, to restrict the 
search to student services provided by a particular teacher (SELPA Manager 
will prompt the user, “Select a teacher/provider (CANCEL=all):”).

3 District access restrictions in effect

1. For more information on the browse window initial display option setting in Prefer-
ences, refer to the Chapter, “Configuring SELPA Manager” on page 296.
2. This restriction does not apply to a user that is also a member of the “AdminGroup”
access group.



If (1) the login user has one or more district access restrictions; and (2) the 
user has selected “My districts” option in Preferences for the browse 
window initial display setting, then SELPA Manager will offer to restrict the 
“show current” display to records associated with the districts to which the 
user is restricted. The program will present a confirmation dialog, “Restrict 
get current to your districts? (CANCEL=all districts).”

The district access restriction is based upon finding one of the user’s district 
codes in the first seven digits of the student record number. 

Show current for...
• Function: Displays records that are associated with current student 

services for a particular teacher, school, or district, for the list that has the 
current focus, on a browse window. Can also find students and associated 
items for which there are no current services.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows where the current focus is on 
assessments, disciplinary actions, student services, goals, students, 
student contacts, or transitions.

• Accessible to: Users who are not members of the “TeacherGrp” access 
group1. Also excludes members of the “TeacherLtdGrp” access group.

Notes/limitations: 

This item obtains current records in the table from which it was called (the 
“target” table), by first searching the student service table for current 
services, and then relating the found selection of services to a corresponding 
selection in the target table. 

The search criteria are similar to the “Show current” item in the data menu 
(page 615), except that SELPA Manager displays a search preference dialog 
that affords a greater degree of control over the search process (Fig. 12-2). 

1. Users in the “TeacherGrp” access group, who are also members of the “Admin-
Group” access group, are able to use this function.
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The user may search for services that occur in a particular district or at a 
particular school, or that are provided by a selected teacher. For each of 
these options, after the user has closed the search preference dialog, the 
program will display another dialog from which the user can select the 
particular district, school, or teacher of interest.

The search preference dialog also allows the user to specify whether the 
search should be limited to primary services or not; to exclude “do not 
report” (DNR) students and student services; and whether to search for a 
particular evaluation date. If the evaluation date is a non-blank value (not 
00/00/00), then the services must start on or before this date, and drop after 
this date (or have a blank drop date).

Fig. 12-2. Search preference dialog, displayed when the user selects “Show current 
for...” from the Data menu.

Checking the box, “With all services dropped on/before eval. date” will 
cause the search to be for “non-current” student services. 

For example, suppose that you wish to identify students that have only non-
current services from a school named “Blaney School”. On the search 
preference dialog, check the “For one school” box; specify the “evaluation 
date for services” (defines what is considered to be a current student 
service); and check the “With all services dropped on/before eval. date” box. 
Press the OK button and specify “Blaney School” as the selected school, in 
the next dialog that appears.



Show subset
• Function: In the browse window, displays the highlighted records (only) 

in the list that has the current focus.

• Shortcut key: [CNTRL/CMD]-R

• Modifier key: Prior to selecting this menu item, if you hold down the 
[ALT/OPTION] key while highlighting the records that will comprise the 
subset to be displayed, then SELPA Manager will not search for related 
records, for the other list in the browse window.

• Accessible from: Browse windows.

• Accessible to: All users except members of the “TeacherLtdGrp” access 
group.

Notes/limitations: 

This command displays a subset of the records that are currently listed in the 
browse window, in the list that has the current focus. For example, to display 
a particular student, click (once) on the student’s name in the list, and then 
select “Show subset”. 

To highlight more than one contiguous records from a list, click (once) on 
the starting record, then scroll the list down and [SHIFT]-click on the ending 
record. If you select a very large number of items, then SELPA Manager will 
display a progress dialog (“Getting related records...”), which can be 
cancelled since you will be executing the “Show subset” command next.

To highlight one or more non-contiguous records, click (once) on the 
starting record, then [CNTRL/CMD]-click on each additional record that 
should be included in the subset. You can also start a contiguous section of 
highlights at a different location in the list by a [CNTRL/CMD]-“click-and-
drag-downward” action. When large numbers of records are highlighted, the 
program will display a progress bar while it obtains related items for the 
lower list.1

After “Show subset” has finished executing, you should see only the 
previously-highlighted records in the list. The records will no longer be 
highlighted.

1. To prevent the display of related records, hold down the [ALT/OPT] key while se-
lecting records (refer to the modifier key discussion on page 619).
Data Menu Operations 619 

• 
• 
• 
•
•
•



620  

• 
• 
• 
•
•
•

Omit subset
• Function: In the browse window, omits/hides the highlighted records 

(only) in the list that has the current focus.

• Shortcut key: (none)

• Modifier key: Prior to selecting this menu item, if you hold down the 
[ALT/OPTION] key while highlighting the records that will comprise the 
subset to be omitted, then SELPA Manager will not search for related 
records, for the other list in the browse window.

• Accessible from: Browse windows.

• Accessible to: All users except members of the “TeacherLtdGrp” access 
group.

Notes/limitations: 

This command omits (hides) a subset of the records that are currently listed 
in the browse window, in the list that has the current focus. For example, to 
omit a particular student from the current listing, click (once) on the 
student’s name in the list, and then select “Omit subset” from the Data 
menu.

You can “un-hide” record(s) by selecting “Show all”; by performing a 
search for the record(s) in the Query Editor (refer to “Searching for records 
(SEARCH button)” on page 179); or by typing the name(s) in the Location 
box. 

The record(s) to be omitted must be highlighted in the list, before selecting 
“Omit subset” from the menu. The highlighting process is the same as for 
“Show subset” on page 619.

Find...
• Function: From the browse window – displays the Query Editor, to 

construct and then execute a multi-level search (query) for items in the 
list that has the current focus.

From data entry forms – when the cursor is inside an alphanumeric or text 
field, searches for instances of a specified word. (However, this command 
does not work if the cursor is located inside the goals/objectives tab, 
assessment form.)



• Shortcut key: [CNTRL/CMD]-F

• Modifier key: (none)

• Accessible from: Browse windows, data entry forms.

• Accessible to: From the browse window – available to all users, except 
members of the “TeacherLtdGrp” access group. Results of browse 
window searches may be dependent upon the user’s level of access. 

From data entry forms – Available to all users.

Notes/limitations: 

When executed from the browse window, the “Find...” command causes 
SELPA Manager to display the Query Editor, enabling the user to construct 
multi-level searches for records in the browse list that has the current focus. 
Selecting “Find...” is equivalent to pressing the SEARCH button in the 
browse window (refer to “Searching for records (SEARCH button)” on 
page 179). Fig. 12-3 is a graphical representation of the Query Editor. 

For searches of the [Student_service] table, SELPA Manager will further 
restrict the results of a Query Editor search to the current or “alternate” year 
that is being displayed in the browse window (refer to “Other year services” 
on page 647). If the user is in the “TeacherGrp” access group, then the 
program will further restrict the results of any search to those students or 
student-associated records for whom the user has access privileges.

The sections that follow immediately below present a general discussion of 
searching for records in SELPA Manager, and the use of the Query Editor.
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Fig. 12-3. The Query Editor.

Searching concepts and features1

“Searching” or “finding” with the Query Editor refers to finding a group of 
records in the database, based on the contents of one or more fields. You 
perform a search by specifying a query. A query is the set of instructions 
that tells the program which records to include in the new current selection, 
such as “Last name is equal to Dortmunder”.

A query always has three elements: field name, comparison operator, and 
value. The field name is from the table that has the current focus in the 
browse window, or from a related table. The comparison operator tells 
SELPA Manager how to compare the contents of the field to the value you 
specify (equal to, greater than, less than, and so forth). The value specifies 
the number, string, or other value to which each record is compared.

1. Discussion in this and subsequent sections is adapted from 4D SA/ 4D Inc., 4th Di-
mension User Reference, Version 6.7 for Mac ™ OS and Windows. Cupertino: 1985-
1990, 4D SA/4D Inc.

Criteria area

Available fields menu

Fields list

Value area

Conjunction buttons

Comparison operator area



Suppose that you want to view all the students who have dates of birth more 
recent than 8/16/1992. The query you would use is “Date of birth is greater 
than 8/16/1992.” In this example, “Date of birth” is the field; “is greater 
than” is the comparison operator; and “8/16/1992” is the value.

When you search a database, SELPA Manager compares the contents of the 
field in the query to the value you specify. The new current selection in the 
browse window is made up of records that satisfy the rules stated in the 
query.

The new current selection can be no records, one record, a group of records, 
or all the records in the table.

Sequential and indexed queries

SELPA Manager can carry out queries very quickly if it has an ordered list 
of records to work from. An ordered list is called an index. An index is 
associated with a particular field and is stored on disk as part of the data file.

A query that is performed without an indexed field is slower than a query 
performed with an indexed field, because the program must start at the 
beginning of the table and examine each record until it finds the records that 
meet the criteria you have set. To be sure that it has found all the records you 
are looking for, it must examine every record in the table sequentially. This 
process is called a sequential search.

If an index is available, the program “knows” where the target records are 
located. If you are searching for all students whose last name is Smith, the 
program will know where in the [Student] table the Smiths are located. 
Thus, it doesn’t need to examine every record in the table.

A good analogy for an index is a card catalog in a library. The card catalog 
is an alphabetized list of all the books in the library. Each record in the 
catalog contains information about the book’s location. If you are looking 
for a particular book, it would be inefficient to conduct a sequential search 
of the library’s entire holdings. It is much faster to consult the card catalog, 
obtain the location of the book, and then search the particular shelf on which 
the book is stored.
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In the Query Editor, fields that appear in boldface type are indexed fields. As 
you enter or import new records, SELPA Manager automatically updates all 
indexes. When you perform a query, the program automatically uses an 
index if it is available for the specified field name.

Comparisons and comparison operators

When you write a query, you tell the program how to compare the value you 
specify to the contents of the database. For example, the query, “Last name 
equals Pescadore” uses the “is equal to” comparison operator. It tells the 
program to compare the values in the Last name field to the string 
“Pescadore.”

Comparisons involving alphanumeric values are not case-sensitive. A search 
on the last name “Pescadore” will find records containing “pescadore”, 
“PESCADORE”, “pESCADore” and so on.

The following comparison operators are available for the Query Editor: This 
set of operators is somewhat smaller than the set that is available for a search 
using the Location box (refer to the Chapter, “Using SELPA Manager” on 
page 188).

• Is equal to

• Is not equal to

• Is greater than

• Is greater than or equal to

• Is less than

• Is less than or equal to

• Contains

• Does not contain

NOTE: Queries using the Contains and Does Not Contain operators are 
always sequential queries.



The wildcard character (“@”)

To make queries easier to specify, SELPA Manager has a wildcard character 
(“@”) that can replace one or more characters in a search involving an 
alphanumeric or text field. For example, if you are looking for all 
occurrences of the name “Pescadore” in a field, you may specify the search 
value in several ways:

• “Pes@” – all values beginning with “Pes”

• “@ore” – all values ending with “ore”

• “Pes@ore” – all values starting with “Pes” and ending with “ore”

• “@cad@” – all values containing “cad”

Wildcard queries are not case-sensitive. A search for “@P” is the same as a 
search for “@p”.

Simple and compound queries

You can use the Query Editor to search on one or more fields. A query on 
one field is called a simple query. For example, the search “Last name 
equals Pescadore” is a simple query. When you do a simple query, SELPA 
Manager examines the contents of only one field when searching the 
database.

A query on two or more fields is called a compound query. When you 
perform a compound query using the Query Editor, you combine separate 
queries using a conjunction operator. The conjunction operator tells the 
program how to combine the results of the individual queries. There are 
three conjunction operators that can be used with the Query Editor:

• And – This operator finds all the records that meet two conditions 
simultaneously. For example, the query “Find all the students whose last 
name starts with Bialy and whose last IEP is later than 9/15/2001” will 
find the records of only those students that meet both criteria.

• Or – This operator finds all the records that meet either of two simple 
queries. For example, the query “Find all the students whose last name 
starts with Bialy or whose last IEP is later than 9/15/2001” will find all 
students whose last name starts with “Bialy”; as well as all students with 
last IEP dates later than 9/15/2001, regardless of their last names.
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• Except – This operator is the equivalent of “not.” For example, the query 
“Find all the students whose last name starts with Bialy except those 
whose last IEP is later than 9/15/2001” will find all students whose last 
name starts with “Bialy”, but then will exclude any students with last IEP 
dates more recent than 9/15/2001.

NOTE: To perform a compound search containing both the “And” and the 
“Or” conjunction operators, you must place all individual query statements 
linked with “Or” operators first, before any query statements linked with 
“And” operators.

Query Editor, general features

The Query Editor is a general-purpose editor that can be used to create 
simple or compound queries:

• You can create compound searches linked with the And, Or, or Except 
conjunctions. 

• You have the choice of searching through the current selection of records 
or all the records in the table. 

• You can save queries to disk, and open them when you want to repeat the 
query.

• The Query Editor remembers your last query. You can edit the query or 
clear it and enter a new query.

• You can search on fields in the table in the browse window that has the 
current focus, and on fields in related tables. For example, if the current 
focus is on students, you could search for students whose services start 
on or after 7/16/1995. The new current selection of students consists of 
all records that are related to at least one record in the student service 
table that starts on or after 7/16/1995. Queries on related tables are 
always sequential, even if the field being searched on is indexed.

Query Editor, dialog components

The Query Editor dialog contains the following items (refer to Fig. 12-3 on 
page 622):

• Criteria area – This area displays the query as you create it or after you 
load it from a disk file.



• Available fields menu – This menu allows you to select the table or 
tables from which you want to display fields in the Fields list. You can 
display fields from the Master table, the Related tables, or All tables.

• Fields list – This area displays a hierarchical list of the fields in the 
selected table or tables. Indexed fields are shown in boldface.

• Comparison operator area – This area displays a list of comparison 
operators.

• Conjunction buttons – This area contains three buttons that correspond 
to conjunction operators you can use to join the current simple query to 
the previous simple query.

• Value area – You enter the value for which you want to search in this 
area.

• Query in selection button – This button performs the query only on the 
records in the current selection.

• Query Editor buttons – You use this area to save your queries, load other 
queries from disk, cancel the query, or execute the query.

Query Editor, use to create a query

1 Choose “Find...” from the Data menu or press the SEARCH button in the 
browse window.

SELPA Manager displays the Query Editor, highlighting the first row of the 
Criteria area.

2 Click a field name in the Fields list.

If the desired field is in a related table, then you will need to adjust the Fields 
list display. While the Available fields menu is displaying “Related tables”, 
find the “linking field” to the related table in the Fields list (arrow for 
Macintosh or plus sign for Windows, adjacent to the field name), and click 
on the symbol. Fields are listed alphabetically. 

For example, Fig. 12-4 shows the user opening the “Student ID” linking 
field connecting student service to student records, in order to search for a 
student field during a student service record query.
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Fig. 12-4. Query Editor, selecting a field from a related table

The Query Editor displays the selected field name in the Criteria area, and 
adds the “is equal to” comparison operator.

3 If you don’t want to use the “is equal to” operator, click the desired 
comparison operator.

Your choices are:

• Is equal to

• Is not equal to

• Is greater than

• Is greater than or equal to

• Is less than

• Is less than or equal to

• Contains (Alpha and Text fields only)

• Does not contain (Alpha and Text fields only)
4 Type the value for which you want to search in the Value area.



In a text or alphanumeric field, you can use the wildcard character (“@”) at 
the end of the value to request a “Begins with”-type search. If the field you 
selected is associated with a choice list, then SELPA Manager displays the 
list and prompts you to select a value. If the field you selected is a Boolean 
field, then the program displays a pair of radio buttons. 

5 If you want to add another simple query, click ADD LINE.

The program adds a new line using the “AND” conjunction operator.

6 If you want to use the “OR” or “EXCEPT” operator, click the desired 
conjunction operator button.

7 Repeat Step 2 through Step 4 to build the second simple query.

When you build a compound query, SELPA Manager evaluates the simple 
queries in the order in which they appear in the Query Editor (i.e., from top 
to bottom). There is no precedence among the conjunctions. That is, AND 
doesn’t have priority over OR. Thus, if you use more than two simple 
queries in building the compound query, the order in which you enter the 
simple queries can affect the results of the query.

If you need to add a third simple query, you can choose to either add the 
condition to the existing compound query or insert the new simple query 
between the first two simple queries. To add the new query to the end of the 
existing queries, click ADD LINE. To insert the new query, highlight the last 
query and click INSERT LINE. The new query is inserted above the line you 
highlighted.

As you build the compound query, you can modify existing parts of the 
query by clicking the line you want to change and clicking on a new field or 
operator or by typing a new value. You can also remove a query by selecting 
the line and then clicking DEL LINE.

8 To save the query to disk, click the SAVE button and enter a filename in 
the create-file dialog box.

You do not need to save your query to perform the search. However, if your 
query is a complex, multi-line one, then you may wish to save a backup copy 
of the search to disk. Later, you can retrieve the search without re-typing, by 
pressing the LOAD button, and opening the saved file on disk.

9 Click QUERY to search the entire table.

OR:
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• QUERY IN SELECTION to restrict the query to the current selection.

• Click the CANCEL button to put away the Query Editor without doing a

query.

Find again
• Function: In data entry forms, when the cursor is inside an alphanumeric 

or text field, this command searches for the next instance of a specified 
word or phrase. The word or phrase must have been requested previously 
inside this or another alpha or text field with the “Find...” command.

• Shortcut key: [CNTRL/CMD]-G

• Modifier key: (none)

• Accessible from: Data entry forms.

• Accessible to: All users.

Notes/limitations: 

This command can be selected when the user is editing a data entry form, 
while the cursor is in either an alphanumeric field or a text field. It attempts 
to locate the next instance of the word or phrase previously selected with the 
“Find...” menu item (page 620). This command does not work if the cursor 
is located inside alphanumeric field or text field of the goals/objectives tab, 
in the assessment form.

Graph
• Function: Allows the user to create graphs from field data, for the 

selection of records that has the current focus in the browse window.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.



Notes/limitations: 

This command makes use of the included, 4D Chart plug-in to produce 
custom charts and graphs. It enables you to portray data graphically from a 
selection of records in the browse window. If the selection for the table that 
has the current focus of the browse window contains more than 100 records, 
then SELPA Manager will present a warning that the results of plotting so 
many points may be unsatisfactory (although you may still proceed with the 
graph construction).

Graphing dialog (4D Chart)

When you select Graph from the Data menu, SELPA Manager displays two 
new windows above the browse window (Fig. 12-5): 

• The chart area, a blank window where the chart will be placed. This area 
includes a special chart menu bar as well as a button bar.

• The Chart Wizard dialog.

The Chart Wizard enables you to define the chart/graph type and the data 
source (fields) to be used. On the first, “Chart type” tab of the Chart Wizard, 
you select the general type of chart or graph that you wish to prepare. 

Make sure that the data fields available match the type of chart that you want 
to create. At least one of the data fields to be plotted should be either numeric 
or a date field, for the plot “ordinate”. The other data field to be plotted 
generally can be non-numeric, for example, a student’s last name, a school 
name, etc. In the case of an XY-type plot (“2D XY” on the “Chart type” tab 
of the Chart Wizard), both fields should be numeric, or one date-type and 
one numeric field.

Depending upon the chart type selected, the style options of the second, 
“Chart style” tab will change. For example Fig. 12-6 displays the chart 
styles available when the “2D Column” graph is selected as the chart type, 
from the “Chart type” tab.
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Fig. 12-5. Chart Wizard, for preparing charts and graphs from browse window 
selections. Shown: Chart type tab.

Fig. 12-6. Chart Wizard, Chart style tab.



The third tab of the Chart Wizard allows you to select the fields to be plotted 
(Fig. 12-7). Suppose that you want a bar graph which depicts a selection of 
students and their calculated ages. The field selection would be similar to 
that shown in Fig. 12-7. 

Fig. 12-7. Chart Wizard, Chart style tab.

To specify the fields as illustrated, first ensure that the Source Table pull-
down menu is on “Students”. Then drag the “[Student]Last name” field from 
the scrolling list at lower left (“Select Fields from the Table:”) to the 
“Category (X Axis):” box, on the right. Drag the “[Student]Age calculated” 
field from the scrolling list to the “Values (Z Axis):” box. Then press the OK 
button to view and/or edit the graph. The Chart Wizard dialog will disappear 
and the graph will appear on the (formerly) blank window, Fig. 12-8.

At this point, you might want to clean up the graph so that it is more 
presentable. For example, to eliminate the errant legend from the upper-right 
corner, on the chart menu bar go to the “Chart” menu, and select “Legend...” 
Un-check the “Display legend” box and the press the OK button. 

Again from the chart menu bar, select “Chart -> Axes -> Values (Z)...”, and 
change the minimum value for Scale to zero. Next, go to “Chart -> Titles -> 
Values (Z)” and add a values label. Select a position (e.g., “Left”) and an 
orientation (e.g., “Rotated left”) from the Titles dialog that appears, and 
enter the ordinate label (“Calculated age”). 
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You can re-size the graph using the edge, or move it around on the graph area 
window. To change the bar color, [CNTRL/CMD]-click twice, in sequence, 
on one of the bars (on the second click all bars should be selected); choose 
“Object -> Fill color” and select another color from the palette.

Fig. 12-8. Sample bar graph of student name vs. calculated age, for a selection of 
students (prior to editing chart settings).

Fig. 12-9 illustrates the resulting graph after editing. Fig. 12-10 is a similar 
graph to Fig. 12-9, except that the students are reverse-sorted for the field 
“[Student]Age calculated”, prior to plotting1. If you want the items being 
charted to appear in a certain order on the chart, then you should sort the 
records in that order prior to selecting “Graph” from the Data menu.

You can save your work by selecting “File -> Save” or “File -> Save as...” 
from the chart menu bar. 

NOTE: SELPA Manager does not save graphs into the data file. To save a 
graph, you must save your work as a file on disk (“File -> Save” from the 
chart menu bar).

1. To sort the records prior to plotting, refer to instructions for the command, “Sort” on
page 636, below.



Fig. 12-9. Sample bar graph of student name vs. calculated age, for a selection of 
students (after editing chart settings).

Fig. 12-10. Sample bar graph of student name vs. calculated age, for a selection of 
students (after editing chart settings). Students sorted by age prior to graphing.
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Sort
• Function: Arranges (orders) records into a user-specified order, for the 

selection of records that has the current focus in the browse window.

• Shortcut key: [CNTRL/CMD]-T

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

Notes/limitations: 

Selecting Sort from a browse window causes SELPA Manager to display the 
standard “Order By” dialog (Fig. 12-11). 

Fig. 12-11. “Order by” dialog, for sorting a selection of records in the browse window.

You can select the field(s) on which you want to sort from the scrolling list 
(“Available Fields”) on the left. You can either double-click on the field 
name, or drag the name from the list at left to the list on the right (“Ordered 
by Fields/Formulas”). Fields in boldface are indexed, and may execute 
faster for single-level sort operations.



It is also possible to construct a sort based upon one or more calculated 
values, by pressing the ADD FORMULA... button. The button causes 
SELPA Manager to display the Formula Editor, for specifying a calculation 
involving fields, 4th Dimension commands, and/or SELPA Manager 
methods. You should exercise caution when using the Formula Editor, since 
you might accidentally change your data by selecting the wrong command 
or method.

Fields that you have placed in the list on the right determine the sort order. 
You can rearrange the fields in the right list by dragging them up or down. 
You can change the sort direction of an individual field by clicking once on 
the arrow, adjacent to each sort field in the right-hand list.

When you are finished, press the ORDER BY button, to execute the sort and 
then display the result in the browse window.1

Open a set
• Function: Using a “set” of references from a file on disk, restores a 

selection of records to the list that has the current focus in the browse 
window. 

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

Notes/limitations: 

A set is a compact representation of a selection of records, accurate at the 
time that the set is created. Sets can be stored on disk for later reference or 
use. Selecting “Open a set” causes SELPA Manager to display a standard, 
file-open type dialog, for opening a file on disk containing a set. Once the 
program has opened a file containing the set, it can then display the 
corresponding records in the browse window.

1. Versions of SELPA Manager prior to 4.7393 did not properly display the result of “Order 
by” dialog sorts, if the list was previously sorted by clicking on a column header in the list, 
or if “Sort browse lists” was checked in Preferences.
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Sets are saved to disk with the “Save a set” command in the Data menu (refer 
to “Save a set” on page 638). If the set as originally saved refers to a table 
other than the one that has the current focus in the browse window, then 
restoring the set will not display the correct selection of records. Sets do not 
contain any field data from the records that they represent.

If the user who retrieves the set is in the “TeacherGrp” access group, but the 
user who originally saved the set had a higher level of access, such as the 
“ReadWriteGrp” or the “AdminGroup”, then the selection that is restored 
with the “Open a set” command may be smaller than the original set (by the 
records to which the “TeacherGrp” user does not have access).

Sets stored on disk are most useful for records that do not change, or when 
the period of use for the set is very short. If the selection of records 
represented by the set change, then the set as restored from the disk file may 
no longer be accurate. For example, the user might have changed a field 
value in a record, in a manner that the record no longer qualifies to be in the 
selection. The user may have even deleted the record, or added new records 
that properly belong in the selection. 

Save a set
• Function: Saves “set” of record references to a file on disk. The contents 

of the set is based upon the selection of records in the list that has the 
current focus, in the browse window. 

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

Notes/limitations: 

A set is a compact representation of a selection of records. A set does not 
contain any field data for the records that it represents. The selection of 
records can be retrieved at a later time by opening the corresponding set, as 
a file on disk. A set is accurate at the time that it is created; subsequent 



changes, additions, and deletions to the records may affect set accuracy, 
however. For additional information on set retrieval and limitations, refer 
to“Open a set” on page 637. 

Last found set
• Function: Restores the selection of records in the browse window to 

those that were present immediately after the most recent search (query) 
operation or change of browse window context.

• Shortcut key: [CNTRL/CMD]-2

• Modifier key: Holding down the [ALT/OPTION] key while selecting 
this menu item will cause SELPA Manager to save (into computer 
memory) the “last durable” sets, representing the current selection of 
records in each of the browse window lists. These sets will remain in 
memory until you quit SELPA Manager; until the browse window is 
closed; or until the you execute this keystroke combination again, to 
create new sets in memory.

Holding down the [ALT/OPTION]-[SHIFT] keystroke combination 
while selecting this menu item will cause the program to read the sets 
from computer memory, and therefore to restore the selections of records 
that were last saved with the [ALT/OPTION] keystroke and this 
command. If the user has switched to a different browse window context, 
then one or both list selections can no longer be restored.

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

Notes/limitations: 

A set is a compact representation of a selection of records. A set does not 
contain any field data for the records that it represents. For additional 
discussion on the limitations of sets, refer to “Open a set” on page 637. 

Each time that the user switches to a different browse window context; 
performs a search (query); or selects a menu item such as “Show current” 
that changes the selection of records being displayed, SELPA Manager 
automatically creates in computer memory two sets representing the records 
displayed in the upper and lower browse window lists. 
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Executing “Last found set” will cause SELPA Manager to “read” these two 
sets, and thus restore the record selections that they represent to the browse 
window. This action may be helpful if you have clicked on one or more 
records in the two lists, to display related records in the other list.

For example, suppose that the browse window is in the Students context, 
displaying the student list above the contacts list. If you type “Dan” into the 
Location box and press the [ENTER] key when the current focus is on 
Students, SELPA Manager then might return a selection of students with the 
names “Dan”, “Daniel”, “Danielle”, and maybe even “Dano”. 

If you then click (once) on one of the “Dan” entries, a corresponding list of 
contacts for that student appears in the other (lower) list. If you now move 
your mouse to the lower list, and click on one of the contacts, then the upper 
(students) list will only contain one “Dan” name – the others are no longer 
there. 

To restore all the “Dan” entries that were in the students list prior to the 
clicking actions, you can select “Last found set” from the Data menu. 

For another example of the last found set, refer to the discussion of browse 
window features and operations (“Last found set” on page 222).

“Last durable” sets

SELPA Manager will also remember another pair of sets, the “last durable” 
sets for the two lists, if you hold down the [ALT/OPTION] key while 
selecting this menu item. The program will display a confirmation message 
(“Save current displayed as last found set?), prior to creating these two sets.

Unlike the last found sets, the last durable sets remain in computer memory 
until you close the browse window, quit SELPA Manager, or redefine the 
sets by selecting [ALT/OPTION] - “Last found set” from the Data menu 
again.

Subsequently, you can display the records represented by the last durable 
sets by holding down the [SHIFT]-[ALT/OPTION] keystroke combination, 
while selecting “Last found set” from the Data menu. 

If you have switched to a new browse window context, then SELPA 
Manager will still attempt to restore at least one of the list contents, provided 
that it is the same. 



For example, if the new context is Services with students displayed below, 
then SELPA Manager will restore the students list (services will be empty). 
However, if the new context is Services with teachers displayed below, then 
SELPA Manager will display an error, since neither of the lists are 
displaying the same records as they were when the last durable sets were 
saved (“Unable to restore last durable set (context has changed.”)

Dist res # dist service
• Function: Finds students in the current selection of records whose 

district of residence does not match the district of service for the active 
primary service.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows, when a list of students has the 
current focus.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

Notes/limitations: 

This command works with a current selection of students in the list that has 
the current focus. If there are no students in the current selection, then 
selecting this item generates an error message. If the current focus is not on 
a students list, then the menu item is disabled. 

For each student in the list, the program searches for current primary 
services (the drop date is blank or is greater than today’s date), in the 
“current” or “other” year that is being displayed in the browse window1. If 
more than one service meets these criteria, then it takes the first current 
primary and obtains the district from the associated school2. If this district 
does not match the student’s district of residence, then the student meets the 
search criterion.

1. Refer to “Other year services” on page 647.
2. Normally, there should be only one active primary student service. In display years
other than the current year, however, SELPA Manager does not enforce this require-
ment.
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After evaluating all students in the current selection, SELPA Manager then 
displays only those students whose district of residence did not match the 
district of service.

Transportation...
• Function: Finds students who have transportation requirements, or for 

whom transportation fields have changed since a specified date. Searches 
either all student records or only students that are in the current selection.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows, when a list of students has the 
current focus.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group. Results returned from the search may be 
dependent upon the user’s level of access.

Notes/limitations: 

When you select this menu command, SELPA Manager displays a dialog 
box requesting additional details (Fig. 12-12).

Fig. 12-12. Find transportation dialog, which appears when the user selects 
“Transportation...” from the Data menu.



If you select the first (default) button, “Find students requiring 
transportation”, then SELPA Manager identifies students that have the 
transportation required box checked on the student data entry form 
(“Transp. req’d” on the Demographics tab, or “Req’d” on the Transportation 
tab, refer to the Chapter, “Entering Students” on page 375).

If you select the second button, “Find transportation changes since:”, and 
specify a date, then SELPA Manager will identify student records on which 
any of the transportation fields have changed since the specified date. For 
this search to be effective, a user in the “AdminGroup” access group must 
have activated the Audit trail feature in Preferences (refer to the Chapter , 
“Configuring SELPA Manager” on page 270). If Audit trail is not 
activated, then the search will not identify any records.

If you are in the “TeacherGrp” access group, then the program will further 
restrict the results of the search to those students for whom the you have 
access privileges.

Discipline...
• Function: Finds students who have more than a specified number and 

type of associated disciplinary actions. Searches either all student records 
or only students that are in the current selection.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows, when a list of students has the 
current focus.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group. Results returned from the search may be 
dependent upon the user’s level of access.

Notes/limitations: 

When you select this menu command, SELPA Manager displays a dialog 
requesting additional details to perform the search (Fig. 12-13).
Data Menu Operations 643 

• 
• 
• 
•
•
•



644  

• 
• 
• 
•
•
•

Fig. 12-13. “Get students with disciplinary action(s)...” dialog, which appears when 
the user selects “Discipline...” from the Data menu.

The program will find students that have more than a specific number of 
disciplinary actions that begin on or after a specified action start date (the 
“Start on” date, refer to the Chapter, “Entering Disciplinary Actions” on 
page 474). You can also specify suspensions only, expulsions only, or both 
types of actions. 

If you are in the “TeacherGrp” access group, then the program will further 
restrict the results of the search to those students for whom the you have 
access privileges.

Alternate assessment...
• Function: Finds students who have a current-year STAR participation 

code of 30 (“No - alternate assessment 30”) and/or a current-year STAR 
code of 90 (presently listed as “No - outside testing range 90”). Searches 
either all student records or only students that are in the current selection.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows, when a list of students has the 
current focus.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group. Results returned from the search may be 
dependent upon the user’s level of access.



Notes/limitations: 

When you select this menu command, SELPA Manager displays a dialog 
requesting additional details to perform the search (Fig. 12-14).

Fig. 12-14. “Get students with alternate assessment(s)...” dialog, which appears when 
the user selects “Alternate assessment...” from the Data menu.

The program can search for students with a current-year STAR participation 
code of “30”, “90”, or both (the “STAR” field, refer to the Chapter, 
“Entering Students” on page 377). A STAR code of “90” was used in 
previous years to indicate alternate assessment, but a STAR code of “30” is 
now used for this purpose.

If you also check the box “WITH current alternate assessment goals (not 
marked DNR”, then SELPA Manager will verify that each student with a 
STAR code of “30” and/or “90” (from the previous step) has at least one 
associated goal with an alternate assessment Functional code of “10” or 
higher, and which is not marked as “DNR” (Do not report). Any students 
that do not have at least one associated goal meeting these criteria is 
excluded from the found students.

If you check the box “WITHOUT current alternate assessment goals”, then 
the program will check each student with a STAR code of “30” and/or “90” 
(from the first step) for the presence of any associated goals that have a non-
blank, alternate assessment Functional code, and that are not marked as 
“DNR”. If any goals of this type are associated with the student, then the 
student is excluded from the found students. Thus, in this case only students 
with no reportable alternate assessment goals will be found.
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If you are in the “TeacherGrp” access group, then the program will further 
restrict the results of the search to those students for whom the you have 
access privileges.

Last modified on...
• Function: Finds records in the browse window, for the list that has the 

current focus, for which the created date or modified date is before, on, 
or after a user-specified date. Searches among all records in the table.

• Shortcut key: (none)

• Modifier key: (none)

• Accessible from: Browse windows.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group. Results returned from the search may be 
dependent upon the user’s level of access.

Notes/limitations: 

When you select this menu command, SELPA Manager displays a dialog 
requesting additional details to perform the search (Fig. 12-15).

Fig. 12-15. “Find created or modified records...” dialog, which appears when the user 
selects “Last modified on...” from the Data menu.

You can search either for the date on which the record was created, or for the 
date on which the record was last modified by any user. The range of choices 
for the search includes “is after”; “is before”; “is on”; “is on or after”; and 
“is on or before” the specified date. The scope of the search is all records in 
the table; the search is not limited to records in the current selection.



If you are in the “TeacherGrp” access group, then the program will further 
restrict the results of the search to those students for whom the you have 
access privileges.

Modification date handling

When searching for modified records, it is important to understand some of 
the details of when the modified date field gets revised.

The modification date for a record will update automatically to the current 
date1 when you press the SAVE button2 on a data entry form, whether or not 
you have actually made any changes to fields on the form. 

The modification date will also update if you make a change to one or more 
fields on the data entry form, and then press one of the record navigation 
buttons to move to another record (refer to page 239). 

The modification date will not update if you make a change to a related 
record on the same form, but do not make changes to any of the fields on the 
master (“parent”) record itself, and then press a record navigation button. In 
this case, the modification date of the related record is updated, but not the 
modification date of the parent record. 

Other year services
• Function: Displays student service records that are associated with the 

“current” year or with a specified “alternate” year.

• Shortcut key: [CNTRL/CMD]-Y

• Modifier key: (none)

• Accessible from: Browse windows; the Student data entry form; and 
Assessment (IEP) data entry forms which display a student services list.

• Accessible to: Available to all users, except members of the 
“TeacherLtdGrp” access group.

1. For multi-user systems, the time and date which SELPA Manager uses is based upon
the server computer’s clock.
2. Also applies to using the [Enter] key shortcut for the SAVE button.
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Notes/limitations: 

SELPA Manager allows you to create and edit student services that are not 
part of the current academic year. Services that are not listed for the current 
academic year are considered to have been placed into an “alternate” or 
“other” year. You can place services into as many alternate years as you wish 
(up to approximately 32,000).

Placing services into an alternate year allows you to plan future academic 
calendars and teacher assignments, and to analyze transportation 
requirements, without affecting services and teacher assignments for the 
current year. For example, you can prepare the student by teacher report 
(page 596) or attendance registers (page 598) on each teacher’s planned 
schedule for next fall, without changing the teacher assignments or drop 
status for students’ services in the current academic year.

By default, when SELPA Manager first opens a new browse window, the 
window will display services that are in the current year. To change the 
browse window to an “other” or “alternate” year, select “Other year 
services” from the Data menu. SELPA Manager then prompts you to select 
a particular alternate year (Fig. 12-16).

Fig. 12-16. Dialog for specifying the “other” or “alternate” year to be displayed in 
the browse window. This dialog appears when the user selects “Other year services” 
from the Data menu, when the current year is being shown.

The current year is number zero (0); alternate year numbers range from 1 to 
approximately 32,000. 

After you enter a non-zero number for the alternate year, SELPA Manager 
displays that year (only) for the student services list. If you have not yet 
entered any services into the specified alternate year, then the services list 



will be empty (Fig. 12-17). The list header for services list will turn a dark 
shade of pink (rather than the default, lighter shade), and only services for 
the specified alternate year will be shown. 

Fig. 12-17. Browse window, showing the Services context, after switching to an 
alternate (“other”) year from the Data menu.

For added emphasis, the browse window title will indicate the alternate year 
that is being displayed (e.g., “W1: Student services [Alternate year 1]” in 
Fig. 12-17). The “[Alternate year 1]” label will remain on the title, even 
when the student services list is not being displayed.

If you again select “Other year services” from the Data menu, while you are 
viewing one of the alternate years, then SELPA Manager will switch back 
to displaying the current year. The student services list will again have a 
light pink header, and the “[Alternate year 1]” label will disappear from the 
browse window title.

During the time that the program is displaying an alternate year in a 
particular browse window, all additions, deletions, and modifications to 
student service records will affect services only for the specified alternate 
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year. Similarly, searches and printed reports that make use of student service 
records will reflect only those services which are available in the alternate 
year. 

For example, if you type a student’s name into the Location box to find 
services for a particular student, then SELPA Manager will search only in 
the currently-specified alternate year for suitable services. Therefore, it may 
not find any services, even though the student has services in the current 
year.

NOTE: Any records that you add, edit, or delete from other tables will be 
valid for all current or alternate year settings.

Because SELPA Manager permits you to have as many as six browse 
windows open at the same time, you can display student services for the 
current year and for one or more alternate years simultaneously. To move or 
to copy services from the current year to an alternate year (and vise-versa) 
refer to the command, “Move to other year...” on page 654.
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 13 Actions Menu Operations

Many of the tasks in SELPA Manager can be performed by making use of 
menu items. The purpose of this chapter is to summarize the operations that 
are available in the Actions menu 

[rev. 9.30.2002]

The five principal menus of a workstation running SELPA Manager are File, 
Edit, Window, Data, and Actions. These menu items appear in both the 
single-user runtime version and the client-server version of the program. A 
description of the items in the File menu appears in the Chapter, “File Menu 
Operations” on page 511. The Chapter, “Data Menu Operations” on 
page 607, describes the items in the Data menu.

The File, Edit and Window menus are always visible, although the items in 
each menu that are enabled will depend upon the context in which you 
access the menus. 

The Data and Actions menus are visible when SELPA Manager is displaying 
a browse window as the active (front-most) window. When no windows are 
displayed other than the status bar (a narrow sliver of a window at the lower 
right corner of your screen), then the Data and Actions menus will not be 
visible. Similarly, when you click on the status bar to make it the active 
window, then the Data and Actions menus will disappear.

This chapter does not discuss the items that appear on the menus on the 
server computer. To install the server computer software on a multi-user 
installation of SELPA Manager, refer to “PC client-server (server 
installation)” on page 57 or to “Macintosh client-server (server 
installation)” on page 94. For a more detailed look at the various menu items 
that are available in the 4D Server application, please refer to the 
documentation for 4D Server.1 2
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If SELPA Manager is not yet installed on your computer, please refer to 
“Getting started” on page 134. If SELPA Manager is installed on your 
computer, but you have not yet started using the program, then we 
recommend that you refer to “Getting started” on page 134.

Actions menu overview
The Actions menu items include batch 
operations that can be applied to a selection of 
records in the browse window. The items in the 
menu that are enabled will depend upon the 
current context and focus of the browse window. 
For example, student service-related batch 
changes will be enabled when the current focus 
of the browse window is on a student services 
list.

Other functions available in the Actions menu 
include printing special reports, generating 
CASEMIS export files on disk, and monitoring 
changes that have been made to a particular 

record (“Audit trail...”, page 655).

Not all items will be available at all times. For example, most items in the 
Actions menu are disabled when you are editing a data entry form, for a 
student or other record.

Update user fields...

Update other...

1. 4D SA/ 4D Inc., 4D Server Reference, Version 6.0 for Windows ® and Mac™ OS.
Cupertino: 1985-1997, 4D SA/4D Inc.
2. 4D SA/ 4D Inc., 4D Server Reference, Version 6.7 for Windows ® and Mac™ OS.
Cupertino: 2001, 4D SA/4D Inc.



Duplicates...

Change grade...

Recalculate ages

Assign case manager...

Assign school...

Assign class...

Assign teacher...

Drop...

Continue service...
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Move to other year...

Merge...

All schools...

Selected districts...

Selected schools...

Attendance registers...

IEPs...

Student by teacher...

District chargeback...



Audit trail...

This is the end of the documentation so far...
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 14 Web-Based IEP

Many of the tasks in SELPA Manager can be performed by making use of 
menu items. The purpose of this chapter is to summarize the operations that 
are available in the Actions menu 

[rev. 11.29.2004].

The File, Edit and Window menus are always visible, although the items in 
each menu that are enabled will depend upon the context in which you 
access the menus. 

The Data and Actions menus are visible when SELPA Manager is displaying 
a browse window as the active (front-most) window. When no windows are 
displayed other than the status bar (a narrow sliver of a window at the lower 
right corner of your screen), then the Data and Actions menus will not be 
visible. Similarly, when you click on the status bar to make it the active 
window, then the Data and Actions menus will disappear.

This chapter does not discuss the items that appear on the menus on the 
server computer. To install the server computer software on a multi-user 
installation of SELPA Manager, refer to “PC client-server (server 
installation)” on page 57 or to “Macintosh client-server (server 
installation)” on page 94. For a more detailed look at the various menu items 
that are available in the 4D Server application, please refer to the 
documentation for 4D Server.1 2

1. 4D SA/ 4D Inc., 4D Server Reference, Version 6.0 for Windows ® and Mac™ OS.
Cupertino: 1985-1997, 4D SA/4D Inc.
2. 4D SA/ 4D Inc., 4D Server Reference, Version 6.7 for Windows ® and Mac™ OS.
Cupertino: 2001, 4D SA/4D Inc.
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If SELPA Manager is not yet installed on your computer, please refer to 
“Getting started” on page 134. If SELPA Manager is installed on your 
computer, but you have not yet started using the program, then we 
recommend that you refer to “Getting started” on page 134.

Actions menu overview
The Actions menu items include batch 
operations that can be applied to a selection of 
records in the browse window. The items in the 
menu that are enabled will depend upon the 
current context and focus of the browse window. 
For example, student service-related batch 
changes will be enabled when the current focus 
of the browse window is on a student services 
list.

Other functions available in the Actions menu 
include printing special reports, generating 
CASEMIS export files on disk, and monitoring 
changes that have been made to a particular 

record.

Not all items will be available at all times. For example, most items in the 
Actions menu are disabled when you are editing a data entry form, for a 
student or other record.

Update user fields...

This is the end of the documentation so far...
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 Appendix A: Principal Data Tables

This appendix contains information on the principal user tables and fields in 
SELPA Manager. Each table that appears below represents one user table in 
the SELPA Manager database. 

The first column (Order) is the internal order of occurrence for the field (the 
structural field sequence). 

The second column (Field name) identifies the internal or structural name 
of the field. Depending upon which SELPA code is set in Preferences, the 
field names that appear in the program environment (Quick Report Editor, 
Query Editor, Sort Editor; and the Location box choice list) may be different 
from those listed here. Refer to subsequent appendices for the mapping of 
internal names to the usable field names for each SELPA.

Underscore characters (“_”) that are within a field name are replaced by 
spaces when they appear in the program environment. However, field names 
that begin with an underscore character do not appear at all in the program 
environment; they generally represent fields that have been temporarily 
retired from use.

Field names that begin with four numeric digits are visible only to the 
SELPA represented by those digits. When these fields appear in the program 
environment, they will not display the numeric digit prefix.

The fourth column (Attributes) provides information on certain field 
characteristics. Fields that have the “invisible” attribute set do not appear at 
all in the program environment. Fields that are “indexed” will search (query) 
and sort faster than those that are not. Indexed fields also appear in boldface 
in the Query and Sort Editors. 
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Fields marked “unique” have structural enforcement of uniqueness; that is, 
no two records can have an identical entry in this field, including a zero or a 
blank entry.

District table field listing

School table field listing

[District] table field listing

Order Field name Type Attributes

1 District_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Created_D Date Invisible; Enterable; Modifiable

3 Created_T Time Invisible; Enterable; Modifiable

4 Created_by Alpha_33 Invisible; Enterable; Modifiable

5 Modified_D Date Invisible; Enterable; Modifiable

6 Modified_T Time Invisible; Enterable; Modifiable

7 Modified_by Alpha_33 Invisible; Enterable; Modifiable

8 District_code Alpha_7 Indexed; Enterable; Modifiable

9 District_name Alpha_40 Indexed; Enterable; Modifiable

10 My_district_B Boolean Enterable; Modifiable

11 Next_student Long_Integer Enterable; Modifiable

12 Prev_District_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

13 Holidays_txt Text Enterable; Modifiable

[School] table field listing

Order Field name Type Attributes

1 School_ID Long_integer Invisible; Indexed; Unique; Enterable; 
Modifiable



2 District_ID Long_integer Indexed; Enterable; Modifiable

3 GenSpare_1 BLOB Invisible; Enterable; Modifiable

4 Created_D Date Invisible; Enterable; Modifiable

5 Created_T Time Invisible; Enterable; Modifiable

6 Created_by Alpha_33 Invisible; Enterable; Modifiable

7 Modified_D Date Invisible; Enterable; Modifiable

8 Modified_T Time Invisible; Enterable; Modifiable

9 Modified_by Alpha_33 Invisible; Enterable; Modifiable

10 School_code Alpha_7 Indexed; Enterable; Modifiable

11 School_name Alpha_40 Indexed; Enterable; Modifiable

12 Type_school_code Alpha_2 Enterable; Modifiable

13 Type_school_name Alpha_30 Enterable; Modifiable

14 Address_1 Alpha_80 Enterable; Modifiable

15 Address_2 Alpha_80 Enterable; Modifiable

16 City Alpha_40 Enterable; Modifiable

17 State_prov Alpha_20 Enterable; Modifiable

18 Postal_code Alpha_20 Enterable; Modifiable

19 Principal_name Alpha_40 Enterable; Modifiable

20 Telephone Alpha_20 Enterable; Modifiable

21 Fax Alpha_20 Enterable; Modifiable

22 Telephone_ext Alpha_10 Enterable; Modifiable

23 Prev_School_ID Long_integer Invisible; Indexed; Enterable; Modifiable

[School] table field listing

Order Field name Type Attributes
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Teacher table field listing

Order Field name Type Attributes

1 Teacher_ID Long_Integer Invisible; Indexed; Unique; Enterable

2 Created_D Date Invisible; Enterable; Modifiable

3 Created_T Time Invisible; Indexed; Enterable; Modifiable

4 Created_by Alpha_33 Invisible; Enterable; Modifiable

5 Modified_D Date Invisible; Enterable; Modifiable

6 Modified_T Time Invisible; Enterable; Modifiable

7 Modified_by Alpha_33 Invisible; Enterable; Modifiable

8 Teacher_code Alpha_20 Indexed; Enterable; Modifiable

9 Teacher_name Alpha_40 Indexed; Enterable; Modifiable

10 Address_Line1 Alpha_80 Enterable; Modifiable

11 Address_Line2 Alpha_80 Enterable; Modifiable

12 City Alpha_40 Enterable; Modifiable

13 State Alpha_20 Enterable; Modifiable

14 Postal_code Alpha_20 Enterable; Modifiable

15 Telephone_home Alpha_20 Enterable; Modifiable

16 Telephone_work Alpha_20 Enterable; Modifiable

17 Telephone_ext_wor
k

Alpha_10 Enterable; Modifiable

18 Telephone_other Alpha_20 Enterable; Modifiable

19 e_mail_1 Alpha_80 Enterable; Modifiable

20 e_mail_2 Alpha_80 Enterable; Modifiable

21 Teacher_note Text Enterable; Modifiable

22 Telephone_other_ty
pe

Alpha_30 Enterable; Modifiable

23 Prev_Teacher_ID Long_Integer Invisible; Indexed; Enterable; Modifiable



Teacher service table listing

Assignment table field listing

[Teacher_service] table field listing

Order Field name Type Attributes

1 TeacherService_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Teacher_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 CASEMIS_service
_code

Alpha_6 Indexed; Enterable; Modifiable

10 Service_name Alpha_30 Enterable; Modifiable

11 Service_note Alpha_80 Enterable; Modifiable

12 Certified_status Alpha_30 Enterable; Modifiable

13 CertifyEnds_D Date Enterable; Modifiable

14 Default_service_B Boolean Enterable; Modifiable

[Assignment] table field listing

Order Field name Type Attributes

1 Assignments Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Teacher_ID Long_Integer Indexed; Enterable; Modifiable

3 School_ID Long_Integer Indexed; Enterable; Modifiable
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Student table field listing

4 Created_D Date Invisible; Enterable; Modifiable

5 Created_T Time Invisible; Enterable; Modifiable

6 Created_by Alpha_33 Invisible; Enterable; Modifiable

7 Modified_D Date Invisible; Enterable; Modifiable

8 Modified_T Time Invisible; Enterable; Modifiable

9 Modified_by Alpha_33 Invisible; Enterable; Modifiable

10 FullTime_equivalen
ts

Real Enterable; Modifiable

11 School_code Alpha_7 Enterable; Modifiable

12 School_name Alpha_40 Enterable; Modifiable

13 Assignment_Start_
D

Date Enterable; Modifiable

14 Assignment_Active
_B

Boolean Enterable; Modifiable

15 CASEMIS_service
_code

Alpha_6 Choices; Enterable; Modifiable

16 Service_name Alpha_30 Choices; Enterable; Modifiable

[Assignment] table field listing

Order Field name Type Attributes

[Student] table field listing

Order Field name Type Attributes

1 Student_ID Long Integer Invisible; Indexed; Unique; Enterable

2 Created_D Date Invisible; Enterable; Modifiable

3 Created_T Time Invisible; Enterable; Modifiable

4 Created_by Alpha_33 Invisible; Enterable; Modifiable

5 Modified_D Date Invisible; Enterable; Modifiable

6 Modified_T Time Invisible; Enterable; Modifiable



7 Modified_by Alpha_33 Invisible; Enterable; Modifiable

8 First_name Alpha_15 Indexed; Enterable; Modifiable

9 Last_name Alpha_15 Indexed; Enterable; Modifiable

10 SSN Alpha_9 Indexed; Enterable; Modifiable

11 Record_number Alpha_18 Indexed; Unique; Modifiable

12 Student_number Alpha_20 Indexed; Enterable; Modifiable

13 Home_language_code Alpha_2 Enterable; Modifiable

14 Home_language_name Alpha_30 Enterable; Modifiable

15 Gender Alpha_2 Enterable; Modifiable

16 Infant_setting_code Alpha_2 Enterable; Modifiable

17 Infant_setting_name Alpha_30 Enterable; Modifiable

18 SELPA_from Alpha_4 Enterable; Modifiable

19 Sch_attend_code Alpha_7 Indexed; Enterable; Modifiable

20 Sch_attend_name Alpha_40 Enterable; Modifiable

21 Sch_attend_type_code Alpha_2 Enterable; Modifiable

22 Sch_attend_type_name Alpha_30 Enterable; Modifiable

23 Sch_reside_code Alpha_7 Indexed; Enterable; Modifiable

24 Sch_reside_name Alpha_40 Enterable; Modifiable

25 Residence_code Alpha_2 Enterable; Modifiable

26 Residence_name Alpha_30 Enterable; Modifiable

27 Grade_level Alpha_2 Enterable; Modifiable

28 Original_entry_D Date Enterable; Modifiable

29 Recall_D Date Enterable; Modifiable

30 Last_IEP_D Date Enterable; Modifiable

31 Next_IEP_D Date Indexed; Enterable; Modifiable

32 Last_evaluation_D Date Indexed; Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes
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33 Next_evaluation_D Date Enterable; Modifiable

34 Date_of_birth Date Indexed; Enterable; Modifiable

35 Migrant_ed_B Boolean Enterable; Modifiable

36 PL89_313_B Boolean Enterable; Modifiable

37 Low_incidence_B Boolean Modifiable

38 CAC_mailing_B Boolean Enterable; Modifiable

39 Extended_year_B Boolean Enterable; Modifiable

40 Marked_B Boolean Indexed; Enterable; Modifiable

41 Do_not_report_B Boolean Indexed; Enterable; Modifiable

42 MediCAL_eligible_B Boolean Enterable; Modifiable

43 MediCAL_exported_B Boolean Enterable; Modifiable

44 LEP_B Boolean Enterable; Modifiable

45 RIS_B Boolean Enterable; Modifiable

46 TR_transport_required_B Boolean Indexed; Enterable; Modifiable

47 TR_requested_D Date Enterable; Modifiable

48 TR_start_D Date Enterable; Modifiable

49 TR_parent_notified_D Date Enterable; Modifiable

50 TR_pickup_T Time Enterable; Modifiable

51 TR_dropoff_T Time Enterable; Modifiable

52 TR_schoolStart_T Time Enterable; Modifiable

53 TR_schoolEnd_T Time Enterable; Modifiable

54 TR_pickup_days Alpha_20 Enterable; Modifiable

55 TR_dropoff_days Alpha_20 Enterable; Modifiable

56 TR_pickup_address Alpha_80 Enterable; Modifiable

57 TR_pickup_city Alpha_40 Enterable; Modifiable

58 TR_dropoff_address Alpha_80 Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes



59 TR_dropoff_city Alpha_40 Enterable; Modifiable

60 TR_requested_by Alpha_30 Enterable; Modifiable

61 TR_bussing_agency Alpha_30 Enterable; Modifiable

62 TR_request_reason Alpha_30 Enterable; Modifiable

63 TR_bus_nbr_pickup Alpha_9 Enterable; Modifiable

64 TR_bus_nbr_dropoff Alpha_9 Enterable; Modifiable

65 TR_sitter_name Alpha_40 Enterable; Modifiable

66 TR_sitter_address Alpha_80 Enterable; Modifiable

67 TR_sitter_phone Alpha_10 Enterable; Modifiable

68 TR_req_Harness_B Boolean Enterable; Modifiable

69 TR_req_Lift_B Boolean Enterable; Modifiable

70 TR_req_Seatbelt_B Boolean Enterable; Modifiable

71 TR_req_Wheelchair_B Boolean Enterable; Modifiable

72 TR_req_Ticket_B Boolean Enterable; Modifiable

73 TR_req_POP_B Boolean Enterable; Modifiable

74 TR_req_CS_B Boolean Enterable; Modifiable

75 TR_req_Vest_B Boolean Enterable; Modifiable

76 TR_req_Aide_B Boolean Enterable; Modifiable

77 TR_req_PT_B Boolean Enterable; Modifiable

78 TR_POP_category Alpha_30 Enterable; Modifiable

79 TR_notes Text Enterable; Modifiable

80 Outside_reg_class_pct Integer Enterable; Modifiable

81 Referral_D Date Enterable; Modifiable

82 Solely_low_incidence_B Boolean Enterable; Modifiable

83 Resides_with Alpha_30 Enterable; Modifiable

84 Age_calculated Integer Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes
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85 Mainstreamed_pct Integer Enterable; Modifiable

86 Case_manager_name Alpha_40 Indexed; Enterable; Modifiable

87 Track Alpha_2 Enterable; Modifiable

88 Disability_prime_code Alpha_3 Indexed; Enterable; Modifiable

89 Disability_prime_name Alpha_30 Enterable; Modifiable

90 Ethnicity_code Alpha_3 Indexed; Enterable; Modifiable

91 Ethnicity_name Alpha_30 Enterable; Modifiable

92 Record_nbr_last Alpha_18 Enterable; Modifiable

93 District_residence_code Alpha_7 Indexed; Enterable; Modifiable

94 WR_StudentLetter_ BLOB Enterable; Modifiable

95 USER_YesNo_1 Boolean Indexed; Enterable; Modifiable

96 USER_YesNo_2 Boolean Enterable; Modifiable

97 USER_YesNo_3 Boolean Enterable; Modifiable

98 USER_YesNo_4 Boolean Enterable; Modifiable

99 USER_YesNo_5 Boolean Enterable; Modifiable

100 USER_number_1 Real Indexed; Enterable; Modifiable

101 USER_number_2 Real Enterable; Modifiable

102 USER_number_3 Real Enterable; Modifiable

103 USER_number_4 Real Enterable; Modifiable

104 USER_number_5 Real Enterable; Modifiable

105 USER_alpha_1 Alpha_80 Indexed; Enterable; Modifiable

106 USER_alpha_2 Alpha_80 Enterable; Modifiable

107 USER_alpha_3 Alpha_80 Enterable; Modifiable

108 USER_alpha_4 Alpha_80 Enterable; Modifiable

109 USER_alpha_5 Alpha_80 Enterable; Modifiable

110 USER_date_1 Date Indexed; Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes



111 USER_date_2 Date Enterable; Modifiable

112 USER_date_3 Date Enterable; Modifiable

113 USER_date_4 Date Enterable; Modifiable

114 USER_date_5 Date Enterable; Modifiable

115 IEP_time Alpha_10 Enterable; Modifiable

116 IEP_location Alpha_50 Enterable; Modifiable

117 IEP_street Alpha_80 Enterable; Modifiable

118 IEP_teacher Alpha_40 Enterable; Modifiable

119 IEP_psychologist Alpha_40 Enterable; Modifiable

120 IEP_nurse Alpha_40 Enterable; Modifiable

121 IEP_principal Alpha_40 Enterable; Modifiable

122 IEP_speech_lang_teacher Alpha_40 Enterable; Modifiable

123 IEP_special_ed_teacher Alpha_40 Enterable; Modifiable

124 IEP_translator Alpha_40 Enterable; Modifiable

125 IEP_other_1 Alpha_40 Enterable; Modifiable

126 IEP_other_2 Alpha_40 Enterable; Modifiable

127 IEP_contact Alpha_40 Enterable; Modifiable

128 IEP_address_1 Alpha_80 Enterable; Modifiable

129 IEP_address_2 Alpha_80 Enterable; Modifiable

130 IEP_cityStateZip Alpha_80 Enterable; Modifiable

131 IEP_telephone Alpha_20 Enterable; Modifiable

132 Student_note Text Enterable; Modifiable

133 Sch_previous Alpha_30 Enterable; Modifiable

134 Plan_status Alpha_30 Enterable; Modifiable

135 Plan_D Date Enterable; Modifiable

136 Waiver_D Date Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes
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137 Actual_D Date Enterable; Modifiable

138 Term_D Date Enterable; Modifiable

139 Compliance_D Date Indexed; Modifiable

140 Prev_Student_ID Long Integer Invisible; Indexed; Enterable; Modifiable

141 Record_number_prev Alpha_18 Indexed; Enterable; Modifiable

142 QR_print_name Alpha_50 Enterable; Modifiable

143 QR_print_address_L1 Alpha_80 Enterable; Modifiable

144 QR_print_address_L2 Alpha_80 Enterable; Modifiable

145 QR_print_city Alpha_40 Enterable; Modifiable

146 QR_print_state Alpha_20 Enterable; Modifiable

147 QR_print_postalCode Alpha_10 Enterable; Modifiable

148 QR_print_tel_h Alpha_20 Enterable; Modifiable

149 QR_print_tel_w Alpha_20 Enterable; Modifiable

150 Preschool_setting_code Alpha_2 Enterable; Modifiable

151 Preschool_setting_name Alpha_30 Enterable; Modifiable

152 Transition_mtg_D Date Enterable; Modifiable

153 WorkAbility_program_B Boolean Enterable; Modifiable

154 STAR_participation_code Alpha_2 Enterable; Modifiable

155 STAR_participation_name Alpha_30 Enterable; Modifiable

156 Alternative_assessment_B Boolean Enterable; Modifiable

157 AB2726_3632_B Boolean Enterable; Modifiable

158 QR2_print_name Alpha_50 Enterable; Modifiable

159 QR2_print_address_L1 Alpha_80 Enterable; Modifiable

160 QR2_print_address_L2 Alpha_80 Enterable; Modifiable

161 QR2_print_city Alpha_40 Enterable; Modifiable

162 QR2_print_state Alpha_20 Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes



163 QR2_print_postalCode Alpha_10 Enterable; Modifiable

164 QR2_print_tel_h Alpha_20 Enterable; Modifiable

165 QR2_print_tel_w Alpha_20 Enterable; Modifiable

166 Duplicate_ID Long Integer Indexed; Enterable; Modifiable

167 Duplicate_record_number Alpha_18 Enterable; Modifiable

168 Duplicate_student_name Alpha_40 Enterable; Modifiable

169 Other_review_D Date Enterable; Modifiable

170 District_residence_name Alpha_40 Enterable; Modifiable

171 Record_number_400 Alpha_30 Indexed; Enterable; Modifiable

172 Foster_LCI_number Alpha_30 Enterable; Modifiable

173 Interpreter_required_B Boolean Enterable; Modifiable

174 Student_language_code Alpha_2 Enterable; Modifiable

175 IEP_translation_reqd_B Boolean Enterable; Modifiable

176 Student_language_name Alpha_40 Enterable; Modifiable

177 Case_manager_ID Long Integer Invisible; Indexed; Enterable; Modifiable

178 Extended_yr_days Integer Enterable; Modifiable

179 Extended_yr_minutes Integer Enterable; Modifiable

180 Physical_education_type Alpha_30 Enterable; Modifiable

181 FEP_B Boolean Enterable; Modifiable

182 Transfer_D Date Indexed; Enterable; Modifiable

183 TR_school_notified_D Date Enterable; Modifiable

184 TR_parent_contact_with Alpha_40 Enterable; Modifiable

185 TR_school_contact_with Alpha_40 Enterable; Modifiable

186 TR_transfer_nbr_pickup Alpha_9 Enterable; Modifiable

187 TR_transfer_nbr_dropoff Alpha_9 Enterable; Modifiable

188 TR_special_instructions Text Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes
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Student contact table field listing

189 TR_emergency_numbers Text Enterable; Modifiable

190 TR_emergency_dropoff Text Enterable; Modifiable

[Student] table field listing

Order Field name Type Attributes

[Student_Contact] table field listing

Order Field name Type Attributes

1 StudentContact_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Student_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 Contact_name Alpha_50 Indexed; Enterable; Modifiable

10 Address_Line1 Alpha_80 Enterable; Modifiable

11 Address_Line2 Alpha_80 Enterable; Modifiable

12 City Alpha_40 Enterable; Modifiable

13 State Alpha_20 Enterable; Modifiable

14 Postal_code Alpha_10 Indexed; Enterable; Modifiable

15 Telephone_home Alpha_20 Enterable; Modifiable

16 Telephone_work Alpha_20 Enterable; Modifiable

17 Telephone_ext Alpha_10 Enterable; Modifiable



Student service table field listing

18 Telephone_other Alpha_20 Enterable; Modifiable

19 Telephone_other_type Alpha_30 Enterable; Modifiable

20 e_mail_1 Alpha_80 Enterable; Modifiable

21 e_mail_2 Alpha_80 Enterable; Modifiable

22 Address_type Alpha_30 Choices; Indexed; Enterable; Modifiable

23 Contact_relation Alpha_30 Choices; Enterable; Modifiable

24 ST_resides_here_B Boolean Enterable; Modifiable

25 Contact_note Alpha_80 Enterable; Modifiable

[Student_Contact] table field listing

Order Field name Type Attributes

[Student_service] table field listing

Order Field name Type Attributes

1 Stdnt_service_ID Long_Integer Invisible; Indexed; Unique; Enterable

2 Student_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 Teacher_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

10 Teacher_name Alpha_40 Indexed; Enterable; Modifiable

11 School_ID Long_Integer Indexed; Enterable; Modifiable

12 School_name Alpha_40 Indexed; Enterable; Modifiable
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13 CASEMIS_service
_code

Alpha_6 Choices; Indexed; Enterable; Modifiable

14 Service_name Alpha_30 Choices; Enterable; Modifiable

15 Class_code Alpha_5 Enterable; Modifiable

16 Start_original_D Date Enterable; Modifiable

17 Start_D Date Indexed; Enterable; Modifiable

18 Drop_D Date Indexed; Enterable; Modifiable

19 Drop_rsnCode_pri
mary

Alpha_2 Choices; Enterable; Modifiable

20 Drop_reason_prima
ry

Alpha_30 Choices; Enterable; Modifiable

21 Drop_rsnCode_non
Prmy

Alpha_2 Enterable; Modifiable

22 Drop_reason_nonPr
my

Alpha_30 Enterable; Modifiable

23 Primary_enroll_B Boolean Indexed; Enterable; Modifiable

24 Do_not_report_B Boolean Indexed; Enterable; Modifiable

25 Isolated_site_B Boolean Enterable; Modifiable

26 Minutes_per_sessio
n

Integer Enterable; Modifiable

27 Sessions_per_week Integer Enterable; Modifiable

28 Disabling_conditio
n

Alpha_30 Indexed; Enterable; Modifiable

29 Prev_StdntService_
ID

Long_Integer Invisible; Indexed; Enterable; Modifiable

30 Session_note Alpha_80 Enterable; Modifiable

31 Next_year_B Boolean Indexed; Enterable; Modifiable

32 Agency_code Alpha_2 Enterable; Modifiable

33 Agency_name Alpha_30 Enterable; Modifiable

[Student_service] table field listing

Order Field name Type Attributes



Goal table field listing

34 Location_code Alpha_3 Enterable; Modifiable

35 Location_name Alpha_30 Enterable; Modifiable

36 Frequency_code Alpha_2 Enterable; Modifiable

37 Frequency_name Alpha_30 Enterable; Modifiable

38 Aux_service_code Alpha_80 Enterable; Modifiable

39 Regional_SDC_B Boolean Enterable; Modifiable

40 Evaluation_D Date Enterable; Modifiable

[Student_service] table field listing

Order Field name Type Attributes

[Assessment_goal] table field listing

Order Field name Type Attributes

1 Assessment_goal_I
D

Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Assessment_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 Area_of_need Alpha_30 Enterable; Modifiable

10 Goal_text Text Enterable; Modifiable

11 Benchmark_1 Text Enterable; Modifiable

12 Bench1_method Alpha_30 Enterable; Modifiable

13 Bench1_progress_1 Alpha_30 Enterable; Modifiable
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14 Bench1_prgs_1_dat
e

Date Enterable; Modifiable

15 Bench1_progress_2 Alpha_30 Enterable; Modifiable

16 Bench1_prgs_2_dat
e

Date Enterable; Modifiable

17 Bench1_progress_3 Alpha_30 Enterable; Modifiable

18 Bench1_prgs_3_dat
e

Date Enterable; Modifiable

19 Bench1_progress_4 Alpha_30 Enterable; Modifiable

20 Bench1_prgs_4_dat
e

Date Enterable; Modifiable

21 Bench1_progress_5 Alpha_30 Enterable; Modifiable

22 Bench1_prgs_5_dat
e

Date Enterable; Modifiable

23 Bench1_criteria_me
t_B

Boolean Enterable; Modifiable

24 Bench1_prgs_6_dat
e

Date Enterable; Modifiable

25 Benchmark_2 Text Enterable; Modifiable

26 Bench2_method Alpha_30 Enterable; Modifiable

27 Bench2_progress_1 Alpha_30 Enterable; Modifiable

28 Bench2_prgs_1_dat
e

Date Enterable; Modifiable

29 Bench2_progress_2 Alpha_30 Enterable; Modifiable

30 Bench2_prgs_2_dat
e

Date Enterable; Modifiable

31 Bench2_progress_3 Alpha_30 Enterable; Modifiable

32 Bench2_prgs_3_dat
e

Date Enterable; Modifiable

33 Bench2_progress_4 Alpha_30 Enterable; Modifiable

[Assessment_goal] table field listing

Order Field name Type Attributes



34 Bench2_prgs_4_dat
e

Date Enterable; Modifiable

35 Bench2_progress_5 Alpha_30 Enterable; Modifiable

36 Bench2_prgs_5_dat
e

Date Enterable; Modifiable

37 Bench2_criteria_me
t_B

Boolean Enterable; Modifiable

38 Bench2_prgs_6_dat
e

Date Enterable; Modifiable

39 Benchmark_3 Text Enterable; Modifiable

40 Bench3_method Alpha_30 Enterable; Modifiable

41 Bench3_progress_1 Alpha_30 Enterable; Modifiable

42 Bench3_prgs_1_dat
e

Date Enterable; Modifiable

43 Bench3_progress_2 Alpha_30 Enterable; Modifiable

44 Bench3_prgs_2_dat
e

Date Enterable; Modifiable

45 Bench3_progress_3 Alpha_30 Enterable; Modifiable

46 Bench3_prgs_3_dat
e

Date Enterable; Modifiable

47 Bench3_progress_4 Alpha_30 Enterable; Modifiable

48 Bench3_prgs_4_dat
e

Date Enterable; Modifiable

49 Bench3_progress_5 Alpha_30 Enterable; Modifiable

50 Bench3_prgs_5_dat
e

Date Enterable; Modifiable

51 Baseline_goal Text Enterable; Modifiable

52 Bench3_prgs_6_dat
e

Date Enterable; Modifiable

53 3702_Persons_resp
onsible_1

Alpha_80 Enterable; Modifiable

[Assessment_goal] table field listing

Order Field name Type Attributes
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54 Student_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

55 Bench1_progress_6 Alpha_30 Enterable; Modifiable

56 Bench2_progress_6 Alpha_30 Enterable; Modifiable

57 Bench3_progress_6 Alpha_30 Enterable; Modifiable

58 First_name Alpha_15 Enterable; Modifiable

59 Last_name Alpha_15 Enterable; Modifiable

60 Alt_content_code Alpha_2 Enterable; Modifiable

61 Alt_content_name Alpha_30 Enterable; Modifiable

62 Alt_mastery_code Alpha_2 Enterable; Modifiable

63 Alt_mastery_name Alpha_30 Enterable; Modifiable

64 Alt_reason_code Alpha_2 Enterable; Modifiable

65 Alt_reason_name Alpha_30 Enterable; Modifiable

66 Record_number Alpha_18 Enterable; Modifiable

67 Goal_enables_gene
ral_ed_B

Boolean Enterable; Modifiable

68 Goal_addresses_oth
er_nds_B

Boolean Enterable; Modifiable

69 Goal_priority_nbr Long_Integer Enterable; Modifiable

70 Measureable_object
ive

Text Enterable; Modifiable

71 0901_Bench1_decis
ion

Alpha_30 Enterable; Modifiable

72 0901_Bench2_decis
ion

Alpha_30 Enterable; Modifiable

73 Progress_monitored
_by

Text Enterable; Modifiable

74 3702_Persons_resp
onsible_2

Alpha_80 Enterable; Modifiable

[Assessment_goal] table field listing

Order Field name Type Attributes



Disciplinary action table field listing

75 3702_Persons_resp
onsible_3

Alpha_80 Enterable; Modifiable

76 Progress_1_comme
nt

Alpha_80 Enterable; Modifiable

77 3702_Progress_2_c
omment

Alpha_80 Enterable; Modifiable

78 3702_Progress_3_c
omment

Alpha_80 Enterable; Modifiable

79 3702_Progress_4_c
omment

Alpha_80 Enterable; Modifiable

80 3702_Baseline_1 Text Enterable; Modifiable

81 3702_Baseline_2 Text Enterable; Modifiable

82 3702_Baseline_3 Text Enterable; Modifiable

83 Criteria_met_3_B Boolean Enterable; Modifiable

84 Criteria_met_4_B Boolean Enterable; Modifiable

[Assessment_goal] table field listing

Order Field name Type Attributes

[Disciplinary_action] table field listing

Order Field name Type Attributes

1 Discipline_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Student_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable
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Assessment table field listing

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 Disc_action_type Alpha_30 Indexed; Enterable; Modifiable

10 Action_start_D Date Indexed; Enterable; Modifiable

11 Number_of_days Long_Integer Enterable; Modifiable

12 Report_D Date Indexed; Enterable; Modifiable

13 Reason_code_1 Alpha_2 Enterable; Modifiable

14 Reason_1 Alpha_80 Enterable; Modifiable

15 Reason_code_2 Alpha_2 Enterable; Modifiable

16 Reason_2 Alpha_80 Enterable; Modifiable

17 Reason_code_3 Alpha_2 Enterable; Modifiable

18 Reason_3 Alpha_80 Enterable; Modifiable

19 Discipline_note Text Enterable; Modifiable

20 WR_discLetter_ BLOB Enterable; Modifiable

21 Student_status_cod
e

Alpha_2 Enterable; Modifiable

22 Student_status_nam
e

Alpha_30 Enterable; Modifiable

23 User_alpha_1 Alpha_80 Indexed; Enterable; Modifiable

24 User_alpha_2 Alpha_80 Enterable; Modifiable

[Disciplinary_action] table field listing

Order Field name Type Attributes

[Assessment] table field listing

Order Field name Type Attributes

1 Assessment_ID Long_Integer Invisible; Indexed; Unique; Enterable

2 Student_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable



4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable

8 Modified_by Alpha_33 Invisible; Enterable; Modifiable

9 Age_calculated Integer Enterable; Modifiable

10 IEP_meeting_type Alpha_30 Indexed; Enterable; Modifiable

11 Special_ed_started_
D

Date Enterable; Modifiable

12 Meeting_date Date Indexed; Enterable; Modifiable

13 Last_name Alpha_15 Indexed; Enterable; Modifiable

14 First_name Alpha_15 Indexed; Enterable; Modifiable

15 Address_Line1 Alpha_80 Enterable; Modifiable

16 Address_Line2 Alpha_80 Enterable; Modifiable

17 SSN Alpha_9 Enterable; Modifiable

18 Date_of_birth Date Enterable; Modifiable

19 Grade_level Alpha_2 Enterable; Modifiable

20 School_attends_cod
e

Alpha_7 Indexed; Enterable; Modifiable

21 School_attends_na
me

Alpha_40 Enterable; Modifiable

22 School_resides_cod
e

Alpha_7 Indexed; Enterable; Modifiable

23 School_resides_na
me

Alpha_40 Enterable; Modifiable

24 Telephone_home Alpha_20 Enterable; Modifiable

25 Telephone_work Alpha_20 Enterable; Modifiable

26 Home_language_co
de

Alpha_2 Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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27 Home_language_na
me

Alpha_30 Enterable; Modifiable

28 Gender Alpha_2 Enterable; Modifiable

29 Ethnicity_code Alpha_3 Enterable; Modifiable

30 Ethnicity_name Alpha_30 Enterable; Modifiable

31 LEP_B Boolean Enterable; Modifiable

32 4100_FEP_B Boolean Enterable; Modifiable

33 4100_English_only
_B

Boolean Enterable; Modifiable

34 Disability_prime_c
ode

Alpha_3 Enterable; Modifiable

35 Disability_prime_n
ame

Alpha_30 Enterable; Modifiable

36 Areas_of_strength Text Enterable; Modifiable

37 Areas_of_need Text Enterable; Modifiable

38 Service_delivery_o
ptions

Text Enterable; Modifiable

39 Service_delivery_ra
tionale

Text Enterable; Modifiable

40 General_ed_progra
m_B

Boolean Enterable; Modifiable

41 General_ed_progra
m_pct

Integer Enterable; Modifiable

42 General_ed_acade
mic_areas

Text Enterable; Modifiable

43 4100_General_ed_n
onAcad_areas

Text Enterable; Modifiable

44 General_ed_why_n
ot

Text Enterable; Modifiable

45 4100_General_ed_s
pecialist

Alpha_40 Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



46 4100_General_ed_s
tart_D

Date Enterable; Modifiable

47 4100_General_ed_d
uration

Long_Integer Enterable; Modifiable

48 4100_General_ed_f
requency

Long_Integer Enterable; Modifiable

49 4100_General_ed_l
ocation

Alpha_2 Enterable; Modifiable

50 4100_General_ed_s
ervice_code

Alpha_2 Enterable; Modifiable

51 4100_NI_RSS_spec
ialist

Alpha_40 Enterable; Modifiable

52 4100_NI_RSS_start
_D

Date Enterable; Modifiable

53 4100_NI_RSS_dura
tion

Long_Integer Enterable; Modifiable

54 4100_NI_RSS_freq
uency

Long_Integer Enterable; Modifiable

55 4100_NI_RSS_loca
tion

Alpha_2 Enterable; Modifiable

56 4100_NI_RSS_serv
ice_code

Alpha_2 Enterable; Modifiable

57 4100_RSP_subject_
areas

Text Enterable; Modifiable

58 4100_IN_SDC_spe
cialist

Alpha_40 Enterable; Modifiable

59 4100_IN_SDC_star
t_D

Date Enterable; Modifiable

60 4100_IN_SDC_dur
ation

Long_Integer Enterable; Modifiable

61 4100_IN_SDC_freq
uency

Long_Integer Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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62 4100_IN_SDC_loc
ation

Alpha_2 Enterable; Modifiable

63 4100_IN_SDC_ser
vice_code

Alpha_2 Enterable; Modifiable

64 4100_DIS_RS_spec
ialist

Alpha_40 Enterable; Modifiable

65 4100_DIS_RS_start
_D

Date Enterable; Modifiable

66 4100_DIS_RS_dura
tion

Long_Integer Enterable; Modifiable

67 4100_DIS_RS_freq
uency

Long_Integer Enterable; Modifiable

68 4100_DIS_RS_loca
tion

Alpha_2 Enterable; Modifiable

69 4100_DIS_RS_serv
ice_code

Alpha_2 Enterable; Modifiable

70 Other1_service Alpha_40 Enterable; Modifiable

71 Other1_specialist Alpha_40 Enterable; Modifiable

72 Other1_start_D Date Enterable; Modifiable

73 Other1_duration Long_Integer Enterable; Modifiable

74 4100_Other1_frequ
ency

Long_Integer Enterable; Modifiable

75 4100_Other1_locati
on

Alpha_2 Enterable; Modifiable

76 4100_Other1_servi
ce_code

Alpha_2 Enterable; Modifiable

77 Other2_service Alpha_40 Enterable; Modifiable

78 Other2_specialist Alpha_40 Enterable; Modifiable

79 Other2_start_D Date Enterable; Modifiable

80 4100_Other2_durati
on

Long_Integer Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



81 4100_Other2_frequ
ency

Long_Integer Enterable; Modifiable

82 4100_Other2_locati
on

Alpha_2 Enterable; Modifiable

83 4100_Other2_servi
ce_code

Alpha_2 Enterable; Modifiable

84 DIS_transportation Alpha_80 Enterable; Modifiable

85 4100_ESY_to_recei
ve_FAPE_B

Boolean Enterable; Modifiable

86 4100_Extended_yr_
specialist

Alpha_40 Enterable; Modifiable

87 4100_Extended_yr_
start_D

Date Enterable; Modifiable

88 Extended_yr_durati
on

Long_Integer Enterable; Modifiable

89 Extended_yr_frequ
ency

Long_Integer Enterable; Modifiable

90 4100_Extended_yr_
location

Alpha_2 Enterable; Modifiable

91 4100_Extended_yr_
service_code

Alpha_2 Enterable; Modifiable

92 Physical_education
_type

Alpha_40 Enterable; Modifiable

93 4100_Vocational_g
oal_included_B

Boolean Enterable; Modifiable

94 General_ed_accom
modate_B

Boolean Enterable; Modifiable

95 General_ed_accom
modate_type

Text Enterable; Modifiable

96 Supplemental_aids_
support

Text Enterable; Modifiable

97 Lang_LEP_accom
modations

Text Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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98 Prev_assessment_I
D

Long_Integer Invisible; Indexed; Enterable; Modifiable

99 3702_Preschool_set
ting_code

Alpha_2 Enterable; Modifiable

100 Interpreter_required
_B

Boolean Enterable; Modifiable

101 3702_IEP_translate
_reqd_B

Boolean Enterable; Modifiable

102 Last_triennial_D Date Enterable; Modifiable

103 3702_Last_IEP_D Date Enterable; Modifiable

104 Foster_LCI_number Alpha_30 Enterable; Modifiable

105 Alternative_assess
ment_B

Boolean Enterable; Modifiable

106 Diff_proficiency_st
ds_txt

Text Enterable; Modifiable

107 Parent_guardian_na
me

Alpha_50 Enterable; Modifiable

108 Address_city Alpha_40 Enterable; Modifiable

109 Address_state Alpha_20 Enterable; Modifiable

110 Address_postal_cod
e

Alpha_10 Enterable; Modifiable

111 Outside_reg_class_
pct

Integer Enterable; Modifiable

112 3702_Preschool_set
ting_name

Alpha_30 Enterable; Modifiable

113 3702_Track Alpha_2 Enterable; Modifiable

114 Student_language_c
ode

Alpha_2 Enterable; Modifiable

115 Student_language_
name

Alpha_30 Enterable; Modifiable

116 Agency_services Text Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



117 Designated_instruct
ion_B

Boolean Enterable; Modifiable

118 Vision_impairment
_B

Boolean Enterable; Modifiable

119 Vision_Braille_nee
ds

Text Enterable; Modifiable

120 Hearing_impairmen
t_B

Boolean Enterable; Modifiable

121 Hearing_communic
_needs

Text Enterable; Modifiable

122 Assistive_devices_
B

Boolean Enterable; Modifiable

123 Assistive_devices_t
ype

Text Enterable; Modifiable

124 Behavior_follow_ru
les_B

Boolean Enterable; Modifiable

125 4100_Behavior_cla
ss_mods_B

Boolean Enterable; Modifiable

126 Behavior_interventi
on_B

Boolean Enterable; Modifiable

127 Behavior_assess_pl
an_B

Boolean Enterable; Modifiable

128 Testing_general_ed
_stds_B

Boolean Enterable; Modifiable

129 4100_Testing_out_
of_grade_B

Boolean Enterable; Modifiable

130 4100_Testing_flexi
ble_setting_B

Boolean Enterable; Modifiable

131 4100_Testing_flex_
setting_why

Text Enterable; Modifiable

132 Testing_revised_for
mat_B

Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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133 Testing_rev_format
_what

Text Enterable; Modifiable

134 4100_Test_revised_
directions_B

Boolean Enterable; Modifiable

135 4100_Test_revd_dir
ections_what

Text Enterable; Modifiable

136 4100_Test_flexible_
scheduling_B

Boolean Enterable; Modifiable

137 4100_Testing_Brail
le_B

Boolean Enterable; Modifiable

138 4100_Testing_aids_
B

Boolean Enterable; Modifiable

139 4100_Testing_aids_
which

Alpha_80 Enterable; Modifiable

140 4100_Testing_parts
_exempted_B

Boolean Enterable; Modifiable

141 4100_Testing_parts
_exempt_which

Text Enterable; Modifiable

142 Testing_exemption_
reason

Text Enterable; Modifiable

143 Testing_alt_method Text Enterable; Modifiable

144 4100_Parent_attend
ed_mtg_B

Boolean Enterable; Modifiable

145 Prior_contact_mail
_D

Date Enterable; Modifiable

146 4100_Prior_contact
_phone_D

Date Enterable; Modifiable

147 Non_public_school
_B

Boolean Enterable; Modifiable

148 Other_district_asses
sment

Text Enterable; Modifiable

149 Case_manager_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



150 3702_SELPA_from Alpha_4 Enterable; Modifiable

151 PLEP_communicati
on_dev

Text Enterable; Modifiable

152 PLEP_motor_devel
opment

Text Enterable; Modifiable

153 PLEP_social_emoti
onal_dev

Text Enterable; Modifiable

154 PLEP_health Text Enterable; Modifiable

155 PLEP_vocational_d
ev

Text Enterable; Modifiable

156 4100_AD_by_stand
ards_B

Boolean Enterable; Modifiable

157 4100_AD_ability_t
ests

Text Enterable; Modifiable

158 4100_AD_achieve
ment_tests

Text Enterable; Modifiable

159 4100_AD_alternati
ve_measures_B

Boolean Enterable; Modifiable

160 AD_oral_expressio
n_B

Boolean Enterable; Modifiable

161 AD_listening_comp
rehension_B

Boolean Enterable; Modifiable

162 AD_written_expres
sion_B

Boolean Enterable; Modifiable

163 AD_basic_reading_
skills_B

Boolean Enterable; Modifiable

164 AD_reading_compr
ehend_B

Boolean Enterable; Modifiable

165 AD_math_calculati
on_B

Boolean Enterable; Modifiable

166 AD_math_reasonin
g_B

Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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167 AD_attention_disor
der_B

Boolean Enterable; Modifiable

168 AD_visual_processi
ng_B

Boolean Enterable; Modifiable

169 AD_auditory_proce
ssing_B

Boolean Enterable; Modifiable

170 AD_sensory_motor
_B

Boolean Enterable; Modifiable

171 AD_cogn_associati
on_B

Boolean Enterable; Modifiable

172 AD_cogn_conceptu
alize_B

Boolean Enterable; Modifiable

173 AD_cogn_expressio
n_B

Boolean Enterable; Modifiable

174 4100_AD_Oth_vsn
_hearing_mot_B

Boolean Enterable; Modifiable

175 4100_AD_Oth_envi
r_cult_econ_B

Boolean Enterable; Modifiable

176 4100_AD_Oth_limi
ted_school_B

Boolean Enterable; Modifiable

177 4100_AD_Oth_unf
am_English_B

Boolean Enterable; Modifiable

178 4100_AD_Oth_me
ntal_retard_B

Boolean Enterable; Modifiable

179 4100_AD_Oth_em
ot_disturb_B

Boolean Enterable; Modifiable

180 4100_AD_Oth_poo
r_attendance_B

Boolean Enterable; Modifiable

181 4100_Cert_discrep_
corrob_B

Boolean Enterable; Modifiable

182 4100_Cert_disc_aff
ect_gen_ed_B

Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



183 Cert_requires_speci
al_ed_B

Boolean Enterable; Modifiable

184 4100_Assmt_pre_a
cademic_B

Boolean Enterable; Modifiable

185 4100_Assmt_comm
unication_B

Boolean Enterable; Modifiable

186 4100_Assmt_social
_adaptation_B

Boolean Enterable; Modifiable

187 4100_Assmt_vocati
onal_B

Boolean Enterable; Modifiable

188 4100_Assmt_psych
omotor_B

Boolean Enterable; Modifiable

189 4100_Assmt_self_h
elp_skills_B

Boolean Enterable; Modifiable

190 4100_Assmt_psych
ological_B

Boolean Enterable; Modifiable

191 4100_Assmt_leisur
e_skills_B

Boolean Enterable; Modifiable

192 Assmt_other_B Boolean Enterable; Modifiable

193 Assessment_results
_text

Text Enterable; Modifiable

194 Residence_code Alpha_2 Enterable; Modifiable

195 Residence_name Alpha_30 Enterable; Modifiable

196 4100_Assmt_result
s_reviewer

Alpha_50 Enterable; Modifiable

197 Review_annual_D Date Enterable; Modifiable

198 Review_triennial_D Date Enterable; Modifiable

199 Review_other_D Date Enterable; Modifiable

200 4100_Cert_II_B Boolean Enterable; Modifiable

201 4100_Cert_III_B Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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202 District_residence_
code

Alpha_7 Enterable; Modifiable

203 District_service_co
de

Alpha_7 Enterable; Modifiable

204 0901_Current_scho
ol_code

Alpha_7 Enterable; Modifiable

205 Current_program Alpha_80 Enterable; Modifiable

206 0901_Current_subc
lass

Alpha_80 Enterable; Modifiable

207 Migrant_ed_B Boolean Enterable; Modifiable

208 0901_Eligible_Title
_1_B

Boolean Enterable; Modifiable

209 Parents_know_right
s_B

Boolean Enterable; Modifiable

210 Transfer_rights_adv
ised_B

Boolean Enterable; Modifiable

211 Individual_reports_
reviewed_B

Boolean Enterable; Modifiable

212 Individual_reports_
attached_B

Boolean Enterable; Modifiable

213 Goals_objectives_re
viewed_B

Boolean Enterable; Modifiable

214 SLD_not_visual_B Boolean Enterable; Modifiable

215 SLD_not_environm
ental_B

Boolean Enterable; Modifiable

216 SLD_is_psych_B Boolean Enterable; Modifiable

217 Parent_concerns Text Enterable; Modifiable

218 SLD_not_school_B Boolean Enterable; Modifiable

219 Classroom_observe
d_by

Alpha_50 Enterable; Modifiable

220 Classroom_obs_D Date Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



221 Non_acad_edu_nee
ds

Text Enterable; Modifiable

222 Preschool_student_
needs

Text Enterable; Modifiable

223 0901_Specialized_s
ervices_B

Boolean Enterable; Modifiable

224 0901_Specialized_e
quipment_B

Boolean Enterable; Modifiable

225 0901_Specialized_
materials_B

Boolean Enterable; Modifiable

226 Transition_student_
B

Boolean Enterable; Modifiable

227 Transition_needs_B Boolean Enterable; Modifiable

228 0901_Pgm_support
s_mods_B

Boolean Enterable; Modifiable

229 0901_Parent_notif_
per_yr

Long_Integer Enterable; Modifiable

230 Extended_yr_B Boolean Enterable; Modifiable

231 Diff_proficiency_st
ds_B

Boolean Enterable; Modifiable

232 0901_Alt_means_m
odes_B

Boolean Enterable; Modifiable

233 Transportation_requ
ired_B

Boolean Enterable; Modifiable

234 Health_medication_
required

Alpha_80 Enterable; Modifiable

235 0901_STAR_exemp
t_parent_B

Boolean Enterable; Modifiable

236 Resource_specialist
_B

Boolean Enterable; Modifiable

237 Special_day_class_
B

Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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238 DIS_program_optio
ns

Text Enterable; Modifiable

239 Case_manager_nam
e

Alpha_40 Enterable; Modifiable

240 0901_Other3_servi
ce

Alpha_40 Enterable; Modifiable

241 0901_Other3_speci
alist

Alpha_40 Enterable; Modifiable

242 0901_Other4_servi
ce

Alpha_40 Enterable; Modifiable

243 0901_Other4_speci
alist

Alpha_40 Enterable; Modifiable

244 Rationale_peers_B Boolean Enterable; Modifiable

245 Rationale_low_ratio
_B

Boolean Enterable; Modifiable

246 0901_Rationale_int
ensive_B

Boolean Enterable; Modifiable

247 0901_Rationale_hig
h_special_B

Boolean Enterable; Modifiable

248 0901_Team_admini
strator

Alpha_40 Enterable; Modifiable

249 Team_spec_ed Alpha_40 Enterable; Modifiable

250 Team_general_ed Alpha_40 Enterable; Modifiable

251 Team_district_admi
nistrator

Alpha_40 Enterable; Modifiable

252 0901_Team_psycho
logist

Alpha_40 Enterable; Modifiable

253 Team_other1 Alpha_40 Enterable; Modifiable

254 Team_other2 Alpha_40 Enterable; Modifiable

255 Team_other3 Alpha_40 Enterable; Modifiable

256 Team_other4 Alpha_40 Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes



257 Addendum_present
_level

Text Enterable; Modifiable

258 Addendum_purpose Text Enterable; Modifiable

259 Addendum_parenta
l_input

Text Enterable; Modifiable

260 PLEP_self_help Text Enterable; Modifiable

261 Parents_informed_
when

Alpha_30 Enterable; Modifiable

262 Parents_informed_h
ow

Alpha_30 Enterable; Modifiable

263 SF_transition_servi
ce_needs

Text Enterable; Modifiable

264 Mtg_purpose Text Enterable; Modifiable

265 Parent_safeguards Text Enterable; Modifiable

266 3702_Assessment_l
ocked_B

Boolean Enterable; Modifiable

267 3702_Enrollments_
locked

Text Enterable; Modifiable

268 4100_HSEE_indivi
dual_area_B

Boolean Enterable; Modifiable

269 4100_HSEE_separa
te_room_B

Boolean Enterable; Modifiable

270 4100_HSEE_glossa
ry_B

Boolean Enterable; Modifiable

271 4100_HSEE_small
_group_B

Boolean Enterable; Modifiable

272 4100_HSEE_signed
_oral_items_B

Boolean Enterable; Modifiable

273 Parent_guardian_ty
pe

Alpha_30 Enterable; Modifiable

274 Mailing_Line1 Alpha_80 Enterable; Modifiable

275 Mailing_Line2 Alpha_80 Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes
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Other disability table field listing (for assessments)

276 Mailing_city Alpha_40 Enterable; Modifiable

277 Mailing_state Alpha_20 Enterable; Modifiable

278 Mailing_postal_cod
e

Alpha_10 Enterable; Modifiable

279 Workability_progra
m_B

Boolean Enterable; Modifiable

280 STAR_participation
_code

Alpha_2 Enterable; Modifiable

281 STAR_participation
_name

Alpha_30 Enterable; Modifiable

282 Comm_special_stra
tegies_B

Boolean Enterable; Modifiable

283 Comm_direct_opps
_B

Boolean Enterable; Modifiable

284 Vision_Braille_requ
ired_B

Boolean Enterable; Modifiable

[Assessment] table field listing

Order Field name Type Attributes

[Assessmnt_other_disability] table field listing

Order Field name Type Attributes

1 Assessment_disab_
ID

Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Assessment_ID Long_Integer Indexed; Enterable; Modifiable

3 Created_D Date Invisible; Enterable; Modifiable

4 Created_T Time Invisible; Enterable; Modifiable

5 Created_by Alpha_33 Invisible; Enterable; Modifiable

6 Modified_D Date Invisible; Enterable; Modifiable

7 Modified_T Time Invisible; Enterable; Modifiable



Disposition table field listing (for assessments)

8 Modified_by Alpha_30 Invisible; Enterable; Modifiable

9 Disability_other_co
de

Alpha_3 Enterable; Modifiable

10 Disability_other_na
me

Alpha_30 Enterable; Modifiable

[Assessmnt_other_disability] table field listing

Order Field name Type Attributes

[Assessment_disposition] table field listing

Order Field name Type Attributes

1 Assessment_disposi
t_ID

Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Assessment_ID Long_Integer Indexed; Enterable; Modifiable

3 Student_ID Long_Integer Indexed; Enterable; Modifiable

4 Created_D Date Invisible; Enterable; Modifiable

5 Created_T Time Invisible; Enterable; Modifiable

6 Created_by Alpha_33 Invisible; Enterable; Modifiable

7 Modified_D Date Invisible; Enterable; Modifiable

8 Modified_T Time Invisible; Enterable; Modifiable

9 Modified_by Alpha_33 Invisible; Enterable; Modifiable

10 Disposition Alpha_80 Enterable; Modifiable

11 Start_D Date Enterable; Modifiable

12 Disability_prime_c
ode

Alpha_3 Enterable; Modifiable

13 Service_name Alpha_30 Enterable; Modifiable

14 CASEMIS_service
_code

Alpha_6 Enterable; Modifiable

15 School_name Alpha_40 Enterable; Modifiable
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Transition table field listing

16 Sessions_per_week Integer Enterable; Modifiable

17 Minutes_per_sessio
n

Integer Enterable; Modifiable

18 Mainstreamed_perc
ent

Integer Enterable; Modifiable

19 School_ID Long_Integer Enterable; Modifiable

[Assessment_disposition] table field listing

Order Field name Type Attributes

[Transition] table field listing

Order Field name Type Attributes

1 Transition_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Student_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

3 Prev_transition_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

4 Created_D Date Invisible; Enterable; Modifiable

5 Created_T Time Invisible; Enterable; Modifiable

6 Created_by Alpha_33 Invisible; Enterable; Modifiable

7 Modified_D Date Invisible; Enterable; Modifiable

8 Modified_T Time Invisible; Enterable; Modifiable

9 Modified_by Alpha_33 Invisible; Enterable; Modifiable

10 _Goal_1 Alpha_80 Invisible; Enterable; Modifiable

11 _Goal_2 Alpha_80 Invisible; Enterable; Modifiable

12 _Goal_3 Alpha_80 Invisible; Enterable; Modifiable

13 _Goal_4 Alpha_80 Invisible; Enterable; Modifiable

14 _Score_1 Real Invisible; Enterable; Modifiable

15 _Score_2 Real Invisible; Enterable; Modifiable



16 _Score_3 Real Invisible; Enterable; Modifiable

17 _Score_4 Real Invisible; Enterable; Modifiable

18 _Completed_B Boolean Invisible; Enterable; Modifiable

19 _Goal_comment Text Invisible; Enterable; Modifiable

20 4100_Transition_ne
eds_statement

Text Enterable; Modifiable

21 4100_Means_achie
ve_std_reading

Alpha_40 Enterable; Modifiable

22 4100_Means_achie
ve_std_writing

Alpha_40 Enterable; Modifiable

23 4100_Means_achie
ve_std_math

Alpha_40 Enterable; Modifiable

24 4100_Means_achie
ve_std_other

Alpha_40 Enterable; Modifiable

25 4100_Means_achie
ve_std_other_2

Alpha_40 Enterable; Modifiable

26 4100_Means_std_ot
her_2_topic

Alpha_40 Enterable; Modifiable

27 4100_Means_alt_ac
hieve_stds

Text Enterable; Modifiable

28 4100_IEP_addition
al_info

Text Enterable; Modifiable

29 Meeting_date Date Enterable; Modifiable

30 3702_Projected_tra
nsition_D

Date Enterable; Modifiable

31 3702_School_atten
ds_name

Alpha_40 Enterable; Modifiable

32 3702_School_atten
ds_code

Alpha_7 Indexed; Enterable; Modifiable

33 3702_Graduation_p
lan

Alpha_30 Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes
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34 3702_Goal_resident
ial

Alpha_30 Enterable; Modifiable

35 3702_Goal_employ
ment

Alpha_30 Enterable; Modifiable

36 3702_Goal_educati
on_training

Alpha_30 Enterable; Modifiable

37 3702_Goal_financia
l_economic

Alpha_30 Enterable; Modifiable

38 3702_Goal_indepen
dent_living

Alpha_30 Enterable; Modifiable

39 3702_Vocational_R
OP_classes

Text Enterable; Modifiable

40 3702_Vocational_cl
asses_non_ROP

Text Enterable; Modifiable

41 3702_Career_prep_
programs

Text Enterable; Modifiable

42 3702_Work_hist_vo
lunteer_serv

Text Enterable; Modifiable

43 3702_Documents_i
nfo_txt

Text Enterable; Modifiable

44 3702_Support_servi
ces_txt

Text Enterable; Modifiable

45 3702_Student_input
_source

Alpha_30 Enterable; Modifiable

46 3702_Instruction_s
ervices

Text Enterable; Modifiable

47 3702_Instruction_a
ctivities

Text Enterable; Modifiable

48 3702_Instruction_c
ontact

Text Enterable; Modifiable

49 3702_Instruction_ti
meline

Text Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes



50 3702_Instruction_c
ompleted_D

Date Enterable; Modifiable

51 3702_Instruction_e
valuation

Alpha_30 Enterable; Modifiable

52 3702_Community_
services

Text Enterable; Modifiable

53 3702_Community_
activities

Text Enterable; Modifiable

54 3702_Community_
contact

Text Enterable; Modifiable

55 3702_Community_t
imeline

Text Enterable; Modifiable

56 3702_Community_
completed_D

Date Enterable; Modifiable

57 3702_Community_
evaluation

Alpha_30 Enterable; Modifiable

58 3702_Employment
_services

Text Enterable; Modifiable

59 3702_Employment
_activities

Text Enterable; Modifiable

60 3702_Employment
_contact

Text Enterable; Modifiable

61 3702_Employment
_timeline

Text Enterable; Modifiable

62 3702_Employment
_completed_D

Date Enterable; Modifiable

63 3702_Employment
_evaluation

Alpha_30 Enterable; Modifiable

64 3702_Daily_skills_
services

Text Enterable; Modifiable

65 3702_Daily_skills_
activities

Text Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes
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66 3702_Daily_skills_
contact

Text Enterable; Modifiable

67 3702_Daily_skills_t
imeline

Text Enterable; Modifiable

68 3702_Daily_skills_
completed_D

Date Enterable; Modifiable

69 3702_Daily_skills_
evaluation

Alpha_30 Enterable; Modifiable

70 3702_Interagency_s
ervices

Text Enterable; Modifiable

71 3702_Interagency_a
ctivities

Text Enterable; Modifiable

72 3702_Interagency_c
ontact

Text Enterable; Modifiable

73 3702_Interagency_t
imeline

Text Enterable; Modifiable

74 3702_Interagency_c
ompleted_D

Date Enterable; Modifiable

75 3702_Interagency_e
valuation

Alpha_30 Enterable; Modifiable

76 3702_Related_servi
ces_B

Boolean Enterable; Modifiable

77 3702_Related_servi
ces_why_not

Text Enterable; Modifiable

78 3702_Parent_name Alpha_50 Enterable; Modifiable

79 3702_School_dist_r
epresentative

Alpha_40 Enterable; Modifiable

80 3702_Special_ed_te
acher

Alpha_40 Enterable; Modifiable

81 3702_General_ed_t
eacher

Alpha_40 Enterable; Modifiable

82 3702_Other_person
_1

Alpha_40 Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes



83 3702_Other_person
_2

Alpha_40 Enterable; Modifiable

84 3702_Other_person
_3

Alpha_40 Enterable; Modifiable

85 3702_Goal_resident
ial_note

Text Enterable; Modifiable

86 3702_Goal_employ
ment_note

Text Enterable; Modifiable

87 3702_Goal_educati
on_trng_note

Text Enterable; Modifiable

88 3702_Goal_financia
l_econ_note

Text Enterable; Modifiable

89 3702_Goal_indep_l
iving_note

Text Enterable; Modifiable

90 4100_Referral_noti
ce_D

Date Enterable; Modifiable

91 4100_Referral_prop
osed_action

Text Enterable; Modifiable

92 4100_Referral_reco
rds_B

Boolean Enterable; Modifiable

93 4100_Referral_prog
ress_B

Boolean Enterable; Modifiable

94 4100_Referral_teac
her_info_B

Boolean Enterable; Modifiable

95 4100_Referral_pare
nt_info_B

Boolean Enterable; Modifiable

96 4100_Referral_acti
on_reason

Text Enterable; Modifiable

97 4100_Referral_othe
r_options

Text Enterable; Modifiable

98 4100_Referral_othe
r_factors

Text Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes
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Postal (Zip) Code table field listing

99 4100_Referral_revi
ewed_other

Text Enterable; Modifiable

100 4100_Referral_cont
act_name

Alpha_40 Enterable; Modifiable

101 4100_Referral_cont
act_phone

Alpha_20 Enterable; Modifiable

[Transition] table field listing

Order Field name Type Attributes

[Postal_code] table field listing

Order Field name Type Attributes

1 PstCde_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Created_D Date Invisible; Enterable; Modifiable

3 Created_T Time Invisible; Enterable; Modifiable

4 Created_by Alpha_33 Invisible; Enterable; Modifiable

5 Modified_D Date Invisible; Enterable; Modifiable

6 Modified_T Time Invisible; Enterable; Modifiable

7 Modified_by Alpha_33 Invisible; Enterable; Modifiable

8 Country Alpha_30 Indexed; Enterable; Modifiable

9 Postal_code Alpha_10 Indexed; Enterable; Modifiable

10 State_prov Alpha_30 Enterable; Modifiable

11 City Alpha_80 Enterable; Modifiable

12 FIPS Alpha_20 Enterable; Modifiable

13 Area_code Integer Enterable; Modifiable

14 Latitude Real Enterable; Modifiable

15 Longitude Real Enterable; Modifiable

16 Time_zone Alpha_30 Enterable; Modifiable



Calendar table field listing

17 County Alpha_80 Enterable; Modifiable

18 Comment Alpha_80 Enterable; Modifiable

19 Mark_B Boolean Indexed; Enterable; Modifiable

[Postal_code] table field listing

Order Field name Type Attributes

[Calendar_item] table field listing

Order Field name Type Attributes

1 CalendarItem_ID Long_Integer Invisible; Indexed; Unique; Enterable; 
Modifiable

2 Created_D Date Invisible; Enterable; Modifiable

3 Created_T Time Invisible; Enterable; Modifiable

4 Created_by Alpha_33 Indexed; Enterable; Modifiable

5 Modified_D Date Invisible; Enterable; Modifiable

6 Modified_T Time Invisible; Enterable; Modifiable

7 Modified_by Alpha_33 Enterable; Modifiable

8 Item_type Alpha_30 Indexed; Enterable; Modifiable

9 Item_class Alpha_30 Indexed; Enterable; Modifiable

10 Start_date Date Indexed; Enterable; Modifiable

11 End_date Date Indexed; Enterable; Modifiable

12 Item_font Alpha_30 Enterable; Modifiable

13 Font_size Integer Enterable; Modifiable

14 Font_style Integer Enterable; Modifiable

15 ForeColor Integer Enterable; Modifiable

16 BackColor Integer Enterable; Modifiable

17 Description Alpha_80 Indexed; Enterable; Modifiable
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18 Icon_ID Integer Enterable; Modifiable

19 Event_time Time Indexed; Enterable; Modifiable

20 ForeignKey_ID Long_Integer Invisible; Indexed; Enterable; Modifiable

21 Fgn_table_number Long_Integer Invisible; Indexed; Enterable; Modifiable

22 Fgn_field_number Long_Integer Invisible; Indexed; Enterable; Modifiable

[Calendar_item] table field listing

Order Field name Type Attributes
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 Appendix B: Assessment Table Map

This appendix contains information on the mapping of fields in the 
Assessment table of SELPA Manager, to specific SELPAs. The fields that 
appear in this appendix are a subset of those that appeared in the principal 
data tables listing (refer to “Assessment table field listing” on page 680) — 
only those that are not hidden, and that are shared by more than one SELPA, 
are listed here.

The first column identifies the internal or structural name of the field. 

The remaining columns display the mapping of the field name to the specific 
SELPA that is identified in each column header. 

If the cell representing the intersection of the SELPA and the field contains 
an “N/A”, then that field is not visible to the SELPA in the program user’s 
environment (the Query Editor, Sort Editor, Quick Report Editor, and the 
Location box choice list). If the cell is empty, then the SELPA uses the 
internal name for that field (excluding underscore “_” characters). 

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811

[Assessment]Addendum_parental_input Other 
responsible 
adult

SF behavior 
strategies

N/A N/A

[Assessment]Addendum_present_level Health alert 
condition desc

SF behavior 
impedes how

N/A N/A

[Assessment]Addendum_purpose LCI FFH 
agency contact

SF 
opportunity 
direct instruct

Additional 
information 
IEP4

Additional 
information 
IEP4

[Assessment]AD_attention_disorder_B N/A N/A
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[Assessment]AD_auditory_processing_B N/A N/A

[Assessment]AD_basic_reading_skills_B N/A N/A

[Assessment]AD_cogn_association_B N/A N/A

[Assessment]AD_cogn_conceptualize_B N/A N/A

[Assessment]AD_cogn_expression_B N/A N/A

[Assessment]AD_listening_comprehension_B N/A N/A

[Assessment]AD_math_calculation_B N/A N/A

[Assessment]AD_math_reasoning_B N/A N/A

[Assessment]AD_oral_expression_B N/A N/A

[Assessment]AD_reading_comprehend_B N/A N/A

[Assessment]AD_sensory_motor_B N/A N/A

[Assessment]AD_visual_processing_B N/A N/A

[Assessment]AD_written_expression_B N/A N/A

[Assessment]Agency_services N/A N/A N/A

[Assessment]Alternative_assessment_B N/A

[Assessment]Areas_of_need SF 
educational 
needs 
summary

PLEP areas of 
need

[Assessment]Areas_of_strength PLEP 
strengths 
interests

N/A PLEP 
strengths 
interests

[Assessment]Assessment_results_text MP provisions 
decisions 
notes

Mtg 
comments

[Assessment]Assistive_devices_B SF assistive 
devices 
required B

SF assistive 
devices B

[Assessment]Assistive_devices_type SF 
documentatio
n

N/A SF assistive 
devices type

[Assessment]Assmt_other_B N/A N/A Regional SDC

[Assessment]Behavior_assess_plan_B SF behavior 
plan attached 
B

N/A SF Hughes 
Bill plan 
attached B

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811



[Assessment]Behavior_follow_rules_B SF behavior 
impedes 
learning B

N/A N/A

[Assessment]Behavior_intervention_B SF behavior 
intervention 
plan B

SF behavior 
impedes 
learning B

[Assessment]Case_manager_name N/A N/A N/A

[Assessment]Cert_requires_special_ed_B N/A N/A

[Assessment]Classroom_observed_by MP age 18 
advised rights 
by

SF age 18 
advised rights 
by

HSEE 
participation 
type

HSEE 
participation 
type

[Assessment]Classroom_obs_D MP addnd 
attach to IEP 
D

Mtg 
addendum to 
IEP dated

N/A N/A

[Assessment]Comm_direct_opps_B SF comm 
direct opps B

N/A N/A N/A N/A

[Assessment]Comm_special_strategies_B SF comm 
special 
strategies B

N/A SF hearing 
strategy 
required B

N/A N/A

[Assessment]Current_program Outside 
operating dist 
why

N/A N/A N/A

[Assessment]Designated_instruction_B N/A N/A N/A

[Assessment]Diff_proficiency_stds_B LRE 
differential 
standards B

HSEE large 
print B

HSEE large 
print B

[Assessment]Diff_proficiency_stds_txt LRE 
differential 
standards desc

N/A N/A N/A

[Assessment]District_residence_code N/A N/A N/A

[Assessment]District_service_code N/A N/A N/A

[Assessment]DIS_program_options N/A N/A N/A

[Assessment]DIS_transportation LRE special 
transport 
provider

N/A Special ed 
transportation 
type

[Assessment]Extended_yr_B LRE extended 
year B

N/A N/A

[Assessment]Extended_yr_duration N/A N/A Extended year 
days

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811
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[Assessment]Extended_yr_frequency N/A N/A Extended year 
minutes

[Assessment]Foster_LCI_number N/A N/A N/A

[Assessment]General_ed_academic_areas LRE general 
ed areas

N/A SF general ed 
participate

[Assessment]General_ed_accommodate_B LRE special 
ed at sch resid

N/A SF services at 
school resid B

[Assessment]General_ed_accommodate_type LRE non 
general ed 
areas

N/A SF gen ed not 
participate

[Assessment]General_ed_program_B N/A

[Assessment]General_ed_program_pct N/A N/A

[Assessment]General_ed_why_not LRE general 
ed why not

N/A SF general ed 
why not

[Assessment]Goals_objectives_reviewed_B N/A Mtg offer 
highlight 
rights B

HSEE verbal 
written signed 
B

HSEE verbal 
written signed 
B

[Assessment]Health_medication_required Health care 
procedure 
desc

N/A N/A N/A

[Assessment]Hearing_communic_needs N/A N/A SF hearing 
strategy 
describe

[Assessment]Hearing_impairment_B SF comm 
hearing 
impaired B

N/A

[Assessment]Individual_reports_attached_B N/A Mtg parent 
declined 
summarize 
rights B

HSEE 
calculator 
provided B

HSEE 
calculator 
provided B

[Assessment]Individual_reports_reviewed_B N/A Mtg offer 
summarize 
rights B

HSEE 
additional 
time B

HSEE 
additional 
time B

[Assessment]Interpreter_required_B N/A N/A N/A

[Assessment]Lang_LEP_accommodations N/A N/A SF LEP how 
addressed

[Assessment]Last_triennial_D N/A N/A N/A

[Assessment]LEP_B SF limited 
English 
proficient B

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811



[Assessment]Mailing_city N/A N/A N/A N/A

[Assessment]Mailing_Line1 N/A N/A N/A N/A

[Assessment]Mailing_Line2 N/A N/A N/A N/A

[Assessment]Mailing_postal_code N/A N/A N/A N/A

[Assessment]Mailing_state N/A N/A N/A N/A

[Assessment]Migrant_ed_B N/A N/A

[Assessment]Mtg_purpose N/A N/A N/A N/A

[Assessment]Non_acad_edu_needs PLEP disab 
affect 
involvemt

SF disability 
affects 
involvement

N/A N/A

[Assessment]Non_public_school_B N/A N/A N/A

[Assessment]Other1_duration N/A N/A IEP services 
duration

[Assessment]Other1_service SF career 
interest

N/A

[Assessment]Other1_specialist LRE supp aids 
location

N/A

[Assessment]Other1_start_D LRE supp aids 
begin D

N/A IEP services 
start D

[Assessment]Other2_service N/A N/A

[Assessment]Other2_specialist LRE supp aids 
frequency

N/A

[Assessment]Other2_start_D LRE supp aids 
end D

N/A SF ITP start D

[Assessment]Other_district_assessment LRE extended 
year why

N/A N/A N/A

[Assessment]Outside_reg_class_pct N/A N/A N/A

[Assessment]Parents_informed_how GO parents 
informed how

N/A SF parents 
informed how

N/A N/A

[Assessment]Parents_informed_when GO parents 
informed 
when

N/A SF parents 
informed 
when

N/A N/A

[Assessment]Parents_know_rights_B N/A Mtg offer read 
rights B

HSEE 
adaptive 
furniture B

HSEE 
adaptive 
furniture B

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811
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[Assessment]Parent_concerns PLEP parent 
concerns

SF parent 
concerns

Parent's 
comments

Parent's 
comments

[Assessment]Parent_guardian_type N/A N/A N/A N/A

[Assessment]Parent_safeguards PLEP motor 
dev gross

N/A N/A N/A

[Assessment]Physical_education_type LRE phys ed 
type

[Assessment]PLEP_communication_dev N/A N/A N/A

[Assessment]PLEP_health N/A N/A N/A

[Assessment]PLEP_motor_development PLEP motor 
dev fine

N/A N/A N/A

[Assessment]PLEP_self_help N/A N/A N/A

[Assessment]PLEP_social_emotional_dev N/A N/A N/A

[Assessment]PLEP_vocational_dev PLEP career 
awareness dev

N/A N/A N/A

[Assessment]Preschool_student_needs PLEP 
preacademic 
functional

PLEP 
preacademic 
functional

N/A N/A

[Assessment]Prior_contact_mail_D MP age 18 
advised rights 
D

N/A SF age 18 
advised rights 
D

[Assessment]Rationale_low_ratio_B Health care 
procedure B

N/A N/A N/A

[Assessment]Rationale_peers_B Health alert B N/A N/A N/A

[Assessment]Resource_specialist_B HSEE lighting 
acoustics B

HSEE lighting 
acoustics B

[Assessment]Review_other_D N/A N/A

[Assessment]Review_triennial_D N/A

[Assessment]School_resides_code N/A

[Assessment]School_resides_name N/A

[Assessment]Service_delivery_rationale LRE sp ed sch 
resid why not

N/A SF service 
delivery 
rationale

[Assessment]SF_transition_service_needs N/A N/A N/A

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811



[Assessment]SLD_is_psych_B MP team 
meeting notes 
B

Mtg parent 
declined 
answer 
questions B

HSEE Braille 
transcription 
B

HSEE Braille 
transcription 
B

[Assessment]SLD_not_environmental_B N/A Mtg offer 
answer 
questions B

HSEE reduced 
items per pg B

HSEE reduced 
items per pg B

[Assessment]SLD_not_school_B MP addendum 
to IEP B

Mtg 
addendum to 
IEP B

Private school 
enrollment B

Private school 
enrollment B

[Assessment]SLD_not_visual_B N/A Mtg parent 
declined 
highlight 
rights B

HSEE markers 
masks B

HSEE markers 
masks B

[Assessment]Special_day_class_B HSEE 
multiple 
sessions B

HSEE 
multiple 
sessions B

[Assessment]Special_ed_started_D N/A

[Assessment]STAR_participation_code N/A N/A N/A N/A

[Assessment]STAR_participation_name N/A N/A N/A N/A

[Assessment]Student_language_code N/A N/A N/A

[Assessment]Student_language_name N/A N/A N/A

[Assessment]Supplemental_aids_support LRE 
supplemental 
aids support

N/A SF 
supplemental 
aids support

[Assessment]Team_district_administrator N/A N/A

[Assessment]Team_other1 N/A N/A

[Assessment]Team_other2 N/A N/A

[Assessment]Team_other3 N/A N/A N/A

[Assessment]Team_other4 N/A N/A N/A

[Assessment]Team_spec_ed N/A N/A

[Assessment]Team_general_ed N/A N/A

[Assessment]Testing_alt_method Alternate 
assessment 
how

N/A N/A N/A

[Assessment]Testing_exemption_reason Alternate 
assessment 
why

CA alternative 
assessment 
why

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811
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[Assessment]Testing_general_ed_stds_B N/A

[Assessment]Testing_rev_format_what General ed 
accommodatio
n areas

[Assessment]Transfer_rights_advised_B N/A Mtg parent 
declined read 
rights 

HSEE more 
frequent 
breaks B

HSEE more 
frequent 
breaks B

[Assessment]Transition_needs_B SF high school 
diploma B

N/A N/A N/A

[Assessment]Transition_student_B Transition 
partnership 
pgm B

N/A N/A N/A

[Assessment]Transportation_required_B LRE special 
transportation 
B

N/A N/A

[Assessment]Vision_Braille_needs N/A N/A SF Braille 
instruction 
why not

[Assessment]Vision_Braille_required_B SF vision 
Braille 
required B

N/A SF Braille 
instruction 
provided B

N/A N/A

[Assessment]Vision_impairment_B SF vision 
impairment B

N/A

[Assessment]Workability_program_B Workability I 
program B

N/A N/A N/A N/A

[Assessment] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811
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 Appendix C: Goal Table Map

This appendix contains information on the mapping of fields in the goal 
([Assessment_goal]) table of SELPA Manager, to specific SELPAs. The 
fields that appear in this appendix are a subset of those that appeared in the 
principal data tables listing (refer to “Goal table field listing” on page 675) 
— only those that are not hidden, and that are shared by more than one 
SELPA, are listed here.

The first column identifies the internal or structural name of the field. 

The remaining columns display the mapping of the field name to the specific 
SELPA that is identified in each column header. 

If the cell representing the intersection of the SELPA and the field contains 
an “N/A”, then that field is not visible to the SELPA in the program user’s 
environment (the Query Editor, Sort Editor, Quick Report Editor, and the 
Location box choice list). If the cell is empty, then the SELPA uses the 
internal name for that field (excluding underscore “_” characters).

[Assessment_goal] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811

[Assessment_goal]Baseline_goal N/A N/A N/A

[Assessment_goal]Bench1_criteria_met_B GO criteria 
met baseline

N/A N/A N/A

[Assessment_goal]Bench1_method N/A N/A

[Assessment_goal]Bench1_prgs_1_date GO reviewed 
baseline date

IEP meeting 
date

[Assessment_goal]Bench1_prgs_2_date GO reviewed 
1 date

N/A
715 

• 
• 
• 
•
•
•



716  

• 
• 
• 
•
•
•

[Assessment_goal]Bench1_prgs_3_date GO reviewed 
2 date

Progress 
report 1 date

[Assessment_goal]Bench1_prgs_4_date GO reviewed 
3 date

Progress 
report 2 date

[Assessment_goal]Bench1_prgs_5_date N/A Progress 
report 3 date

[Assessment_goal]Bench1_prgs_6_date N/A Progress 
report 4 date

N/A

[Assessment_goal]Bench1_progress_1 N/A N/A

[Assessment_goal]Bench1_progress_2 N/A Bench 1 ann 
review code

[Assessment_goal]Bench1_progress_3 N/A Progress 
report 1 code

[Assessment_goal]Bench1_progress_4 N/A Progress 
report 2 code

[Assessment_goal]Bench1_progress_5 N/A Progress 
report 3 code

[Assessment_goal]Bench1_progress_6 N/A Progress 
report 4 code

N/A

[Assessment_goal]Bench2_criteria_met_B GO criteria 
met 1

N/A N/A N/A

[Assessment_goal]Bench2_method N/A N/A

[Assessment_goal]Bench2_prgs_1_date N/A N/A

[Assessment_goal]Bench2_prgs_2_date N/A N/A

[Assessment_goal]Bench2_prgs_3_date N/A N/A

[Assessment_goal]Bench2_prgs_4_date N/A N/A

[Assessment_goal]Bench2_prgs_5_date N/A N/A

[Assessment_goal]Bench2_prgs_6_date N/A N/A N/A

[Assessment_goal]Bench2_progress_1 N/A N/A

[Assessment_goal]Bench2_progress_2 N/A Bench 2 ann 
review code

[Assessment_goal]Bench2_progress_3 N/A Progress 
sufficient 1

[Assessment_goal]Bench2_progress_4 N/A Progress 
sufficient 2

[Assessment_goal] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811



[Assessment_goal]Bench2_progress_5 N/A Progress 
sufficient 3

[Assessment_goal]Bench2_progress_6 N/A N/A N/A

[Assessment_goal]Bench3_method N/A N/A

[Assessment_goal]Bench3_prgs_1_date N/A N/A

[Assessment_goal]Bench3_prgs_2_date N/A N/A

[Assessment_goal]Bench3_prgs_3_date N/A N/A

[Assessment_goal]Bench3_prgs_4_date N/A N/A

[Assessment_goal]Bench3_prgs_5_date N/A N/A

[Assessment_goal]Bench3_prgs_6_date N/A N/A N/A

[Assessment_goal]Bench3_progress_1 N/A N/A

[Assessment_goal]Bench3_progress_2 N/A Bench 3 ann 
review code

[Assessment_goal]Bench3_progress_3 N/A Reason failed 
1

[Assessment_goal]Bench3_progress_4 N/A Reason failed 
2

[Assessment_goal]Bench3_progress_5 N/A Reason failed 
3

[Assessment_goal]Bench3_progress_6 N/A Reason failed 
4

N/A

[Assessment_goal]Criteria_met_3_B GO criteria 
met 2

N/A N/A N/A N/A

[Assessment_goal]Criteria_met_4_B GO criteria 
met 3

N/A N/A N/A N/A

[Assessment_goal]Goal_priority_nbr Goal number

[Assessment_goal]Progress_1_comment GO comment N/A N/A N/A

[Assessment_goal]Progress_monitored_by GO persons 
responsible

N/A

[Assessment_goal] table mapping to various SELPAs

Structure field name SELPA 
0400/ 4500/ 
5300

SELPA 0901 SELPA 3702 SELPA 4100 
(default)

SELPA 4811
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 Appendix D: Quick Report Editor

[rev. 2.2005]

SELPA Manager has the capability of generating reports in five different 
ways: 

• Pre-configured reports in a specified format, such as IEP verification 
sheets, transportation notice forms, the student by teacher report, 
attendance registers, and assessment (IEP) forms. Some of these forms 
may be customized for your particular SELPA. If there are no custom 
forms for your SELPA, however, then “default” forms are available for 
use by all other SELPAs.1

• Word processing documents, in ad hoc (user-defined) format, using 4D 
Write. This feature can be used to generate “mail merge” letters or 
notification forms for a selection of students, student services, schools, 
etc.

• Two and three-dimensional graphs of a selection of field information, 
using the Chart Wizard.

• Custom labels, in ad hoc format, using the Label Editor. 

• Custom columnar reports, in ad hoc format, using the Quick Report 
Editor.

The use of the Quick Report Editor is the topic of this appendix. The 
discussion which follows has been incorporated (with minimal 
modification) from the 4th Dimension reference materials.2

1. To have custom forms made for your SELPA, contact Fusion Technik.
2. 4D SA/ 4D Inc., 4th Dimension User Reference, Version 6.7 for Mac ™ OS and
Windows. Cupertino: 1985-1990, 4D SA/4D Inc.
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Features
The Quick Report Editor is the primary means within SELPA Manager to 
quickly create reports of your own design. The Quick Report Editor enables 
you to:

• Produce lists of records, in a simple, column-style format.

• Create break areas, which separate groups of records by a sorted 
characteristic. For example: schools separated into districts; student 
services separated by service name or code; or student services organized 
by the teacher name.

• Prepare summary calculations, such as the total count of records in the 
selection, or the sum or average of a numeric field.

• Use fonts and styles in the report.

• Save Quick Report templates (form designs) to disk, independently of the 
data in a particular report. This feature enables you to create the same 
report with different selections of data (records).

Working with Quick Reports
To create a new Quick Report or to open an existing Quick Report template 
for use, you should have a browse window open within SELPA Manager. 
For more information on using the browse window, refer to “Using the 
browse window (browser)” on page 168.

The Quick Report Editor produces reports based upon the current selection 
of records in the browse window. Before you print a report, you should 
ensure that the current focus and the current selection of records in the 
browse window represents the information that you want included in your 
report. 

Creating a sample Quick Report

For example, to create a report containing student service information:

1 Switch to the Services context by clicking on the Services button in the 
browse window.



The browse window will change contexts, if necessary, so that student 
services appear in the upper list and either students or teachers appear in the 
lower list.1 

After switching to the new context, the focus will be on the upper list. If you 
have not yet entered any student services, or if you have specified in 
Preferences that the browse window should initially display no records, then 
the upper list will be empty (refer to “Browse window initial display 
options:” on page 296).

If you did not switch contexts (you were already browsing student services), 
then ensure that the focus is on the upper list.

2 Select the student service records that are to be included in the report.

Use the Query Editor or enter search criteria directly into the Location box 
to narrow the selection of services. You can also manually select particular 
records to print, and then use SHOW SUBSET from the Data menu. For 
more information on generating selections of records, refer to “The current 
selection of records” on page 171.

3 Select PRINT from the File menu. 

With the student services list as the focus, SELPA Manager will display a 
print request dialog (Fig. D-1) asking you to select either a Quick Report or 
the transportation summary (a preconfigured report). 

NOTE: If you are accessing the Quick Report Editor from a context other 
than Services, then SELPA Manager may display a different type of print 
request dialog, or may display the Quick Report Editor without first 
displaying a print request dialog.

1. You can configure SELPA Manager to display either students or teachers in the low-
er list, for the Services context. Refer to the Chapter, “Configuring SELPA Manager”
on page 301.
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Fig. DD-1. Print request dialog from the Services context (student services in upper 
list, which has the current focus; teachers in the lower list). To display the Quick 
Report Editor, select the first option and press the OK button.

4 Select the default (Quick Report) option on the print request dialog, and 
press the OK button. 

SELPA Manager will then display a new, blank Quick Report Editor for 
student services (Fig. D-2).

NOTE: At this point, rather than creating a new report, you may also access 
an existing Quick Report template on disk for student services. Select 
OPEN... from the File menu. From the File Open dialog that appears next, 
select the report template as a file on disk. SELPA Manager will then display 
the columns and sorting options for the existing report template.



Fig. DD-2. Quick Report Editor, when creating a new report from the Services context.

5 Drag the fields to be printed from the “Select the fields” box onto the 
Quick Report (tablet) area. Click on the SORTED button when the column 
is highlighted, to specify sort order.

A discussion of the controls in the Quick Report Editor appears in the next 
section (refer to “Editor components” on page 726). 

Be sure that you have at least one field in the tablet area. Select student-level 
information (first name, last name, SSN, etc.), by opening the linking field 
in the list, Student ID. Fields in the “Select the fields” list appear in 
alphabetical order.

Fig. D-3 is an example of the appearance of the Quick Report Editor after 
selecting a few fields from the students and student services tables. Note that 
the linking field1, Student ID, is in the open position so that the student fields 
can be viewed / selected. Because student service records are also linked to 
school records, you may also select fields from the schools table (linking 
field “School ID”).

1. Sometimes also referred to as the “foreign key” field. Linking fields in SELPA Man-
ager are program-assigned long integers (not user-editable).
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Fig. DD-3. Quick Report Editor, showing the appearance after selecting four fields by 
dragging them from the field list to the Quick Report area.

6 Select PRINT... from the File menu to print the Quick Report.

SELPA Manager displays the standard print dialog for the selected printer. 
Specify the number of copies to be printed, enlargement/reduction size, and 
any other printer settings as required. Press the PRINT button.

NOTE: If there are no records in the current selection of student services; or 
if the Quick Report Editor has no fields specified as report columns, then 
selecting PRINT...will have no effect.

7 To save a template of the report that you have created or modified, select 
SAVE from the File menu.

For a newly-created Quick Report, SELPA Manager displays a standard 
create-file dialog box in which you can name the Quick Report template.

NOTE: Quick Report templates for Windows are denoted on disk by the file 
suffix, “.4QR”. If you do not save your design, then it is displayed the next 
time you open the Quick Report Editor, in that work session only.



Printing from the correct context
An additional, and more subtle, consideration when deciding where and 
how to use the Quick Report Editor is to take into account the full range of 
fields that you wish to include in the report. As a general rule, you must 
access the Quick Report Editor from the lowest level in the relational 
hierarchy from which field data is needed. 

In the student services example (Fig. D-2) we wish to create a report that 
contains both student and service information. Because one student can have 
many services in SELPA Manager, we say that student services is a “related 
many” of students, and therefore is below students in the relational 
hierarchy. 

For that reason, the Quick Report must run from the Services context, rather 
than the Students context. From Services, both the student and the student 
service fields will be available in the “Select the fields:” box of the Quick 
Report Editor. If you were to open the Quick Report Editor from the 
Students context, then you would not have the option of including student 
service fields from the “Select the fields:” box.

As another example, if you wanted a report of schools that is separated into 
districts, you would need to open the Quick Report Editor from Schools (a 
related many of Districts).

There is, however, an exception to the general rule for student address 
information. A student can have many associated addresses or contacts in 
SELPA Manager, so that, in general, a Quick Report of contacts should be 
prepared from a selection of contact records (an optional display for the 
lower list in the Students context, refer to the Chapter, “Configuring SELPA 
Manager” on page 298).

To facilitate student reporting in conjunction with contact addresses, SELPA 
Manager provides two sets of replicate or “clone” address fields in the 
Student table, for use in Quick Reports. Initially, these fields may be empty. 
From the Actions menu1, you can populate these fields for the current 
selection of students with particular types of addresses (e.g., “resides here”, 
“emergency 1”, etc.). Alternately, you can use the QR button on one 
particular Student data entry form, to insert a highlighted contact address 
into the replicate address fields (refer to the Chapter, “Entering Students” on 

1. Actions menu -> Update other... -> Update “clone” Quick Report address fields
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page 369). Once the replicate fields are populated with address and/or 
contact information, you can generate Quick Reports from the Students 
context that contain address information.

Editor components
The Quick Report Editor contains the following elements (refer to Fig. D-3):

• Fields list (“Select the fields”) – Displays fields in the current table, and 
in certain related tables. You can view the names of fields in related tables 
by expanding the linking fields. A linking field has a plus sign (on 
Windows) or an arrow (on Macintosh) to its left.

NOTE: The fields that appear in the list will depend upon the context in 
which the Quick Report Editor is opened (Students, Services, Districts, etc.), 
and, for the Assessment and Goal contexts, on the SELPA. For a list of all 
fields in each table, refer to the Chapter, “Principal Data Tables” on 
page 659. For more information on field mapping for specific SELPAs, refer 
to the Chapter, “Assessment Table Map” on page 707; and to the Appendix, 
“Goal Table Map” on page 715.

• Sort list (“Sort order:”) – This list displays the sort order assigned to the 
report and indicates whether each sort level is ascending or descending. 
If your report will contain summary calculations from groups of records, 
then you must sort the current selection of records on one or more fields. 
You can change the order of fields in the Sort list by dragging the field 
name vertically to the desired position in the list.

• Summary calculation buttons (“Cell”) – Use these buttons to place 
summary calculations into cells, in the Break and Total areas of the 
report.

• Column properties (“Column”) – You use these check boxes to set the 
characteristics for each column in the report:

a) Sorted – Click this check box if you want the records to be sorted on 
the selected column. 

b) Repeated Values – You use this check box to tell the Quick Report 
Editor to repeat identical values for a field, within a particular column, for 
each record (row) that will be printed in that column. If you un-check the 
Repeated Values check box, then the identical field value within a group 
of records (a break) is displayed only once, on the first line (row).



c) Automatic Width – Click this check box to request that the Quick 
Report Editor compute the width of the selected column based on the 
maximum length of the contents of the column. The sizing is done only 
at the time the report is printed. You can check this option for each 
column individually. The check box does not refer to the entire report. If 
the Automatic Width check box is not checked for a column, you can 
modify that column’s width by dragging column dividers.

• Quick Report area (lower, white portion of the dialog) – This area is 
used to design the report, by dragging fields, adding formulas, adjusting 
column widths, and adding or deleting breaks. Some of the components 
of the Quick Report area are listed below:

a) Column dividers (between adjacent columns) – These lines indicate 
the boundaries between columns of the report.

b) Right margin marker (after last column) – This marker indicates the 
right margin of the report. The right margin marker is meaningful only 
when no columns have the Automatic Width check box selected. You may 
have to scroll horizontally to view the right margin marker.

c) Column header – The column header displays the names of fields or 
formulas added to the report. It is not part of the printed report.

d) Row label bar (first/label column) – This column identifies the 
different horizontal areas within the report: the Header, Detail, Break, 
and Total rows. It is not part of the printed report.

e) Header row – This row contains information that appears in the 
printed report above the records. The Quick Report Editor automatically 
places field names in the Header row, but you can modify its contents.

f) Detail row – This row prints information from individual records, and 
will be repeated in the printed report for each break.

g) Break and Total rows – These rows display summary calculations 
and associated labeling, if any. The Break row displays summary 
calculations for each subgroup in the report, while the Totals row displays 
summary calculations obtained from all records in the current selection. 
For more information on creating breaks, refer to “Setting break levels” 
on page 742.

h) Cells – A cell is the intersection of a row and a column.
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i) Scroll bars – You use the scroll bars to view parts of the Quick Report 
area that extend beyond the columns currently displayed on the dialog.

Fig. D-4 illustrates the appearance of a Quick Report in print preview mode, 
showing record contents.This report conforms to the specifications shown in 
Fig. D-3. Note that the “Repeated Values” check box was turned off for the 
Service Name (fourth) column; consequently, the name of the service within 
each break group of records is printed only once.

Fig. DD-4. Quick Report Editor print preview, showing the appearance of the report 
that was specified in Fig. D-3.

• Resize lines (raised lines between sections of the Quick Report Editor) – 
These lines can be used to resize certain sections of the Quick Report 
Editor, for easier access. Position the cursor directly over the line; it will 
change from an arrow to a double-vertical or double-horizontal line icon. 
Use the mouse to drag the line to the desired position. 

Fig. D-5 illustrates the appearance of the Quick Report Editor after 
widening the dialog, and then dragging the resize lines adjacent to the 
“Select the fields:” and “Sort order:” areas.



Fig. DD-5. Quick Report Editor, after enlarging the dialog box (dragging the lower 
right corner to make it wider), and then enlarging the “Select the fields” and “Sort 
order” areas, by dragging the resize lines.

Using contextual menus
The Quick Report editor has “hidden” contextual menus that facilitate 
access to certain row, column, and cell operations. Instead of making menu 
selections or working with the Cell or Column properties areas, you can 
perform these operations by displaying a Quick Report contextual menu. 
There are separate contextual menus for row, column, and cell operations.

To use a Quick Report contextual menu:

1 Position the pointer in a cell, a row label, or a column heading and hold 
down the mouse button.

A contextual menu appears. The commands in the contextual menu depend 
upon where your pointer is situated (i.e., a row label, column heading, or 
cell). Also, menu commands that are inappropriate for the particular row, 
column, or cell are disabled.

2 Select the item that you wish to insert, or the property / attribute that you 
wish to change.

The illustrations that follow (Fig. D-6, Fig. D-7, and Fig. D-8) display the 
three Quick Report contextual menus as they appear after holding down the 
mouse button in particular locations.
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Fig. DD-6. Quick Report Editor, displaying the contextual menu for columns, after 
holding down the mouse button on the [Student]Date of birth column header. The top 
portion of the menu represents addition, deletion, and other column operations. The 
middle portion of the menu contains column properties. The bottom portion of the 
menu represents format and text attributes.

Fig. DD-7. Quick Report Editor, displaying the contextual menu for rows, after holding 
down the mouse button on “Detail” in the row label bar. The upper portion of the menu 
is for break row operations and for hiding a particular row. The lower portion of the 
menu sets text attributes for the row.



Fig. DD-8. Quick Report Editor, displaying the contextual menu for a cell, after 
holding the mouse button down on a particular cell. The top portion of the menu is for 
summary calculations, valid only in the Break and Total rows. The next portion of the 
menu (“Format”) is valid only if a display format can be applied to the cell. The bottom 
portion of the menu represents text attributes.

Selecting columns, rows, and cells
When designing a Quick Report, you need to select rows, columns, and cells 
within the Quick Report area, and then apply formats, attributes, 
calculations, etc.

To select a row, click on the Header, Detail, Break, or Total markers on the 
row label bar, or click in the desired row to the right of the last column.

To select a column, click above the header row of the desired column.

To select a cell, click on the desired cell.

Adding and modifying text
You can add or modify text in the Quick Report area, to label parts of the 
report. For example, if you requested summary calculations, you can label 
them by adding text to other cells in the Break and Total rows.
Quick Report Editor 731 

• 
• 
• 
•
•
•



732  

• 
• 
• 
•
•
•

To add text in a report cell:

1 Click twice on an empty cell in the Quick Report area.

A text insertion point appears in the cell.

NOTE: If you are entering a label for a summary calculation, select an 
adjacent cell in the same row as the cell containing the calculation icons. 
You cannot enter text into the same cell that contains the summary 
calculation.

2 Type the text into the selected cell.

To modify text in a cell:

1 Double-click in a cell to get an insertion point and drag across the text in 
the cell you want to modify.

The program highlights the selected text.

2 Type the new text in the cell.

Specifying fonts and font attributes
While designing your Quick Report, you can specify different fonts, font 
sizes, justification, and styles. You can then apply these specifications to 
text, data, and summary calculations within rows, columns, or cells in the 
report.

If you assign specifications to the Detail row of the report, you will not see 
the results until you preview or print the report. You can specify font 
attributes using either the Quick Report menu commands or the Quick 
Report contextual menus.

To specify font attributes using the Quick Report menus:

1 Select the column, row, or cell where you want to apply the font.

2 Select a font from the Font menu; or choose a font size, style, or 
justification from the Style menu.

The program applies the font to any text, data, or summary calculations that 
appear in the selected area.



To specify font attributes using the Quick Report contextual menu:

1 Hold down the mouse button on the row label, column header, or cell to 
which you want to apply the font attributes.

A contextual menu appears (refer to Fig. D-6, Fig. D-7, or Fig. D-8).

2 Use the Font, Size, Style, or Alignment hierarchical menus to change the 
font attributes as desired.

Adding / changing columns
You create columns by dragging field names from the “Select the fields:” list 
to the Quick Report area. If you want to add a field from a related table, 
expand the linking (“foreign key”) field to that table in the hierarchical list 
of fields (e.g., “Student ID” or “School ID”). The program will then display 
the fields in the related table. Only certain related tables will be available in 
the list; as a function of the current context of the browse window (refer to 
“Printing from the correct context” on page 725).

To add a field (column) at the end of a Quick Report:

1 Drag the name of a field to the right of existing columns in the Quick 
Report area and release the mouse button.

The program creates a column for the field, and places the field name in both 
the column header and the cell in the Header row. By default, the program 
prints the field names as column headings, at the top of each page in the 
Quick Report.

To insert a field (column) to the left of an existing column:

1 Select an existing column.

For more information, refer to “Selecting columns, rows, and cells” on 
page 731.

2 Choose Insert Column from the Edit menu.

As an option, you can instead hold down the mouse button on the column 
header, to display the Quick Report contextual menu. Choose the Insert 
Column from the contextual menu.
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The program inserts a blank column to the left of the column you selected. 
To assign a field to the empty column, drag a field name from the “Select the 
fields:” list to the column. To assign a formula to the column, refer to 
“Adding formulas” on page 735.

To delete a field (column) from the Quick Report area:

1 Select the column you want to delete.

For more information, refer to “Selecting columns, rows, and cells” on 
page 731.

2 Choose Delete Column from the Edit menu.

As an alternative to using the Edit menu, you can instead hold down the 
mouse button on the column header, causing the Quick Report contextual 
menu to appear. In this case, select Delete Column from the contextual 
menu.

To replace a field (column) with a different field:

1 Drag another field from the Fields list directly over the column that you 
want to replace.

OR:

1 Select the column that you want to replace.

2 Choose Edit Column from the Edit menu.

OR:

1 Hold down the mouse button on the column header to display the Quick 
Report contextual menu and choose Edit Column.

The Formula Editor appears.

2 Enter a formula for the column.

If you want to assign a field to the column, you can simply use the field name 
as the formula. When you print the Quick Report, the program prints the 
results of the formula for each record that appears in the Detail row. To 
assign a formula to the column, refer to “Adding formulas” on page 735.



Sizing columns
By default, the Quick Report Editor sizes columns automatically (the 
Automatic Width check box is checked for the column, refer to “Editor 
components” on page 726). It sizes each column based upon the maximum 
length of data displayed in the column, and any labels typed into the column. 
The column sizing occurs at the time the report is printed. To view the 
widths of each column, you can preview the report to the screen (Print 
Preview from the File menu).

Because selecting the Automatic Width check box changes the width of a 
column based on the maximum width of data in the records being printed, 
selecting different records can change the size of the columns.

You can resize a column manually after deselecting the Automatic Width 
check box. When a column is set manually, text in the column wraps within 
the specified area.

To manually resize a column:

1 Select the column you want to resize.

2 Deselect Automatic Width.

For this purpose, you can use either the check box in the Column Properties 
area or the Quick Report contextual menu for that column.

3 Move the pointer over the column divider in the Quick Report, to change 
the pointer into a column width cursor.

The column width cursor has double vertical bars and outward-pointing 
arrow symbols.

4 Drag the column divider to the left or right to resize the column.

Adding formulas
A column in a Quick Report can represent more than the contents of just one 
field. For example, a column can represent a calculation based upon a 
numeric field value; a string expression composed of more than one field; or 
a difference in date or time (you could add a formula that calculates the 
student’s age in years based on today’s date).
Quick Report Editor 735 

• 
• 
• 
•
•
•



736  

• 
• 
• 
•
•
•

To add a formula:

1 Insert an empty column or click an existing column and choose Edit 
Column from the Edit menu.

OR

1 Double-click an existing column.

OR

1 Hold down the mouse button on an existing column header to display the 
Quick Report contextual menu, and choose Edit Column.

The program displays the Formula Editor (Fig. D-9), in which you can 
build a formula. If you selected an existing column, the formula you create 
will replace the previous contents of the column. 

NOTE: Make sure that the formula you create does not change the current 
selection of records for the Quick Report. Changing the current selection 
will cause problems when you print the report.

Fig. DD-9. The Formula Editor, as displayed by double-clicking on a column in the 
Quick Report Editor.



The Formula Editor provides many shortcuts for writing formulas. You can 
click field names, operators, and routines to add them to the formula. The 
formula created in the editor must be a valid 4th Dimension programming 
expression; the program will place small bullets around any invalid 
expressions after you enter them.

The Formula Editor contains the following areas / components:

• Editing area – This area displays the formula as you build and edit it. You 
create the formula in this area by either typing a function or selecting 
operators, fields, and functions from the toolbar or panels at the bottom 
of the Editor. You can add a field to the Editing area by double-clicking 
or by using drag-and-drop.

• Operators toolbar – The toolbar contains a row of buttons that you can 
use to insert operators into a formula. 

The first group of buttons are for keywords. From left to right, they are: 
Assignment, Addition, Subtraction, Multiplication, Division, and 
Modulo (modulus).

The second group of buttons are comparison operators. From left to 
right, they are: Equals, Not Equal To, Greater Than, Less Than, Less 
Than or Equal To, and Greater Than or Equal to.

The third group of buttons are for braces: Parenthesis, Curved Brackets 
(for array elements), and Double Brackets (for string character 
references).

• Tables drop-down list – This list controls the fields displayed in the 
Fields list. You can choose to display fields from the master table (the 
table that has the current focus in the browse window); from related 
tables (in hierarchical lists, beneath the linking field); or from all tables1.

2 Build the formula, or click the LOAD button to retrieve an existing formula 
from disk.

To save the formula as a file that you can retrieve and use in another column 
or in another report, click the SAVE button and enter a file name in the 
dialog box.

1. It is not recommended that you use this option, as the table names will be empty
(“[]”) in the list. You will still see the names of the fields when you expand the table
listing, but the empty table names may be confusing.
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If you click the LOAD button, the program displays a standard, Open File 
dialog, and asks you to identify a file on disk. When you load a file, it 
replaces any formula that currently appears in the Formula Editor. After you 
load a formula, you can modify it in the editing area.

NOTE: Formulas on disk are not stored as plain text files.

The Formula Editor can only accept single-line expressions; that is, it does 
not support conditional branch statements (“IF()...”). However, you can 
make use of existing, more complex routines within SELPA Manager. As an 
example, there is a SELPA Manager routine, “UTIL_yearsBetween(<recent 
date>;<older date>)”, which returns the calculated age in years between two 
dates. Fig. D-10 illustrates the use of this routine in the Formula Editor, to 
return a calculated age for a column in the report.

Fig. DD-10. The Formula Editor, making use of an existing routine within SELPA 
Manager to calculate the number of years between two dates 
(“UTIL_yearsBetween”).

3 Click OK to assign the formula to the column.



The program adds a new label to the column that identifies it as a formula. 
You can re-label the column by typing a label into the header cell for that 
column. Formulas are labeled C1 through Cn. The labels are the names of 
variables that contain the column’s value. You can use these variables in 
other formulas.

Click the CANCEL button to close the Formula Editor and return to the 
Quick Report Editor, without adding the formula.

After the change to the use of a calculated column for age in the Formula 
Editor, the Quick Report Editor now appears as in Fig. D-11. A sample print 
preview of the current selection of records for this report appears in Fig. D-
12.

Fig. DD-11. Quick Report Editor, incorporating a column that calculates the student’s 
age as of today’s date.
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Fig. DD-12. Print preview, Quick Report that calculates the student’s age as of today’s 
date.

Sorting
An important feature of the Quick Report Editor is the ability to sort the 
current selection of records when you print your report. This feature enables 
you to view the records in a particular order, and to create groups of records 
and break areas in the report, for the purpose of reporting summary 
calculations for groups. You can specify more than one sort criterion.

You can specify the sort order for the report using one of three methods, 
described below.

To specify the sort order:

1 Select the column that contains the field or formula you want to specify 
as the first sort level.

2 Click the Sorted check box.

OR

1 Drag a field from the Fields list to the Sort order list.

If the field or formula does not already appear in the “Sort order:” list, then 
the program adds it as the last item in the listing.

OR

1 Hold down the mouse button on the column header belonging to the 
column on which you want to sort.



The Quick Report contextual menu appears.

2 Choose Sorted from the contextual menu.

For all sort techniques: 

The program will display the name of the newly-added column in the “Sort 
order:” list. To the right of the name is an arrow, indicating an ascending sort 
order. By default, all sorts are performed in ascending sort order. 

1 If desired, you can click on the sort direction arrow to reverse the sort (to 
descending order).

2 If desired, select additional fields or formula columns and add the Sorted 
property using either the Sorted check box or contextual menu 
command.

You can specify ascending or descending sort order for any additional fields 
or formulas you specify. When you specify multiple sort levels, the program 
sorts the records on the first field in the “Sort order:” list, then on other fields 
in the order that they appear in the list.

To change the order of a column in the “Sort order:” list (relative to other 
columns), you can drag the name of a field or formula up or down within the 
list. 

To remove a field or formula from the sort order:

1 Select the column and deselect the Sorted check box.

OR

1 Hold down the mouse button on the column header to display the Quick 
Report contextual menu, and deselect the Sorted menu command.

The program removes the field or formula in the “Sort order:” list. It does 
not delete the column itself from the report. When you print the report, the 
program will no longer use that field or formula to sort the records.
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Setting break levels
In a Quick Report, you set break levels to separate or “break” records into 
groups according to the values in one or more sort fields. The program prints 
a break area for each break level, which you can use for displaying summary 
calculations (sum, average, minimum, maximum, and count) for each group 
of records. 

Break levels are determined by the sort levels and Break rows. For example, 
if you sort student service records by CASEMIS service code and create a 
Break row, then SELPA Manager inserts a break between each group of 
records that have the same service code.

After you add a Break row to the Quick Report, you can request summary 
calculations for the break.

To insert a Break row:

1 Choose Add Break from the Edit menu.

OR

1 Hold down the mouse button on the Total row label in the Row label bar 
and choose the Duplicate Break menu command.

2 If desired, add additional Break rows by repeating the insertion 
operation.

The program adds a sequential number to each new break label in the row 
label bar (“Break1”, “Break2”, “Break3”, etc.).

NOTE: There should be at least as many sort levels as there are break levels 
in the report. If there is no sort criterion specified, then the program cannot 
make use of the newly-added break level. The break will appear in red text 
until you add a sort criterion.

Labeling break levels
You can improve the appearance and comprehensibility of your reports by 
labeling each Break row using the value of the break field. To request that 
the value of a break field be printed in a label placed in the break area, use 
the number sign (#) in the label. For example, if you were to change “Total 



for student service” in the break area of Fig. D-11 into “Total for #” (as in 
Fig. D-13), then the printed report would be similar to the print preview in 
Fig. D-14.

Fig. DD-13. Quick Report Editor, changing the title of the “Break 1” area to 
incorporate field information for a group of records.

Fig. DD-14. Print preview, Quick Report, showing the change to the break level label 
made in Fig. D-13.

The number sign does not need to be placed in the same column as the break 
field. It will display the value of the break field in any cell in the Break row.
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Adding summary calculations
You can add summary calculations on the contents of fields and formulas to 
each Break row and to the Totals row. The check boxes in the cell area of the 
Quick Report editor identify the summary calculation options available for 
Quick Reports. The following summary calculations are available.

• Sum – totals the values in the report or break.

• Minimum – displays the lowest value in the report or break.

• Maximum – displays the highest value in the report or break.

• Average – calculates the average of the values in the report or break.

• Count – calculates the number of records in the report or break.

These options also appear in the Quick Report contextual menu for cells in 
the Break and Total rows.

When you place a summary calculation in the Totals row, the calculation is 
done for all records in the report. If you place the summary calculation in a 
Break row, separate calculations are done for the records in each break.

To add a summary calculation:

1 Select a cell in a Break row or in the Totals row where you want to insert 
the summary calculation.

The Sum, Minimum, Maximum, and Average calculations work only on a 
numeric field or formula.

2 Click as many summary calculation check boxes as you like, or hold 
down the mouse button and choose the desired summary calculations 
from the Quick Report contextual menu for cells.

The program displays a calculation icon in the selected cell for each type of 
summary calculation you request.

Displaying repeated values in break columns
In a report with breaks, the columns which are used to group records so that 
summary calculations can be done are called Break columns. When the 
report is printed, the values for the Break column are printed only once per 
break. 



In some cases, you may want to repeat the values for the Break columns, so 
that they appear for every record in the Break area. You can do so either by 
clicking the Repeated Values check box in the Column Properties area, or by 
choosing the Repeated Values menu command in the Quick Reports 
contextual menu for that column.

Setting display formats
You can specify display formats for columns that contain numeric or 
alphanumeric data. For example, if your report includes Alpha fields such as 
a contact telephone number or Social Security number for a student, then 
you can use an Alpha format. For example, “(###) ###-####” for a 
telephone number or “###-##-####” for a Social Security Number. For 
information on available format characters, refer to “Display format types” 
on page 746.

To enter a display format for a numeric or Alpha field:

1 Click twice in the Detail cell for a numeric or Alpha column.

2 Type a display format or the name of a style that you want to use as the 
display format.

The names of styles are preceded by a vertical bar (|). 

NOTE: At the present time, the only style in SELPA Manager that would be 
applicable within a Quick Report is the “|Percent_format” for numeric 
data, which is “##0 %”. 

OR, using the contextual menus:

1 Position the pointer over the Detail cell for a column, hold down the 
mouse button and select a display format from the hierarchical menu.

The hierarchical menu will show display formats that are appropriate for the 
data type of the column. For example, if the column displays numeric 
information, then the menu command would be “Numeric” instead of 
“Alpha”, and the submenu would list only numeric formats. After you make 
your selection, you can further edit the format if desired. If you have also 
requested summary calculations for that column, the format specified in the 
Detail cell will automatically be applied to the summary calculations.
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Regardless of the display format, the count is always displayed as an integer 
without formatting symbols such as the dollar sign. Different formats can be 
applied to different columns in the report.

Display format types
This section presents a brief overview of display format types that can be 
used when formatting Quick Report columns.

• Dates – The table below shows the Date field display formats and gives 
an example of each format. A date must be displayed in one of these 
formats.

• Time expressions – The table below shows the Time field display 
formats and gives examples. A time expression must be displayed in one 
of these formats.

Choice Example

Short 3/25/95

Abbreviated Wed, Mar 25, 1995

Long Wednesday, March 25, 1995

mm/dd/yyyy 03/25/1995

Month Date, Year March 25, 1995

Abbr: Month Date, Year Mar 25, 1995

Choice Example

HH:MM:SS 02:15:34

HH:MM 02:15

Hour Min Sec 2 hours 15 minutes 34 seconds

Hour Min 2 hours 15 minutes

H:MM AM/PM 2:15 AM



• Number formats – In the number display formats, the number sign 
(“#”), zero (“0”), caret (“^”), and asterisk (“*”) are used as placeholders. 
You create number formats by using one placeholder for each digit that 
you expect to display. 

For example, if you want to display three numbers, you could use the 
format “###”. If the numeric value contains more digits than the format 
allows, however, then the program prints “<<<” to indicate that more 
digits were required than the number of digits specified in the display 
format. 

If the numeric value is negative, the left-most character is displayed as a 
minus sign (unless a negative display format has been specified). If “##0” 
is the format, minus 26 is displayed as “–26” and minus 260 is displayed 
as "<<<", because the minus sign occupies a placeholder and there are 
only three placeholders.

Each placeholder character has a different effect on the display of leading 
or trailing zeros. A leading zero is a zero that starts a number before the 
decimal point; a trailing zero is a zero that ends a number after the 
decimal point.

Suppose you use the format “##0” to display three digits. If the user 
enters nothing in the field, the field displays “0”. If the user enters “26”, 
then the field displays “26”.

The table below explains the effect of each placeholder on leading and 
trailing zeros.

Placeholder Effect for leading or trailing zero

# Displays nothing

0 Displays 0

^ Displays a space a

a. The caret (“^”) generates space character that occu-
pies the same width as a digit in most fonts.

* Displays an asterisk
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• Numbers containing other characters – You can use one decimal point 
in the format. You can use any other characters in the format. When used 
alone, or placed before or after placeholders, the characters always 
appear. For example, if you use the following format:

$##0

a dollar sign (“$”) always appears because it is placed before the 
placeholders.

If characters are placed between placeholders, they appear only if digits 
are displayed on both sides. For example, if you define the format:

###,##0

a comma appears only if the number to be displayed is at least four digits 
in length.

Spaces are treated as characters in number display formats.

• Positive, negative, and zero number formats – A number display 
format can have up to three parts allowing you to specify display formats 
for positive, negative, and zero values. You specify the three parts by 
separating them with semicolons.

You do not have to specify all three parts of the format. If you use just one 
part, the program uses it for all numbers, placing a minus sign in front of 
negative numbers. If you use two parts, the program uses the first part for 
positive numbers and zero and the second part for negative numbers. If 
you use three parts, the first is for positive numbers, the second for 
negative numbers, and the third for zero.

Here is an example of a number display format that shows dollar signs 
and commas, places negative values in parentheses, and does not display 
zeros:

$###,##0.00;($###,##0.00);

Notice that the presence of the second semicolon instructs SELPA 
Manager to use nothing to display zero.



The following format is similar except that the absence of the second 
semicolon instructs the program to use the positive number format for 
zero:

$###,##0.00;($###,##0.00)

In this case the display for zero would be $0.00.

If you want to display numbers in scientific notation, use the ampersand 
(“&”) followed by a number to specify the number of digits you want to 
display. For example, the format,

&3

would display 759.62 as

7.60e+2

NOTE: The scientific notation format is the only format that will automati-
cally round the displayed number. Note in the example above that the 
number is rounded up to 7.60e+2 instead of truncating to 7.59e+2.

• Hexadecimal number formats – You can display a number in 
hexadecimal using the display format

“&x” or “&$”

If the user enters “10”, it is displayed as “A”.

• Displaying a number as a time – You can display a number as a time 
(with a time format) by using “&/” followed by a digit. Time is 
determined by calculating the number of seconds since midnight that the 
value represents. The digit in the format corresponds to the order in which 
the time format appears in the format drop-down menu. For example, the 
format:

&/5

corresponds to the fifth time format in the pop-up menu, specifically the 
AM/PM time. A number field with this format would display 25000 as:

6:56 AM
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• Number format examples – The following table shows how different 
formats affect the display of numbers. The three columns — Positive, 
Negative, and Zero — each show how 1,234.50, –1,234.50, and 0 would 
be displayed.

Number format examples

Format Entered Positive Negative Zero

### <<< <<<

#### 1234 <<<<

####### 1234 –1234

#####.## 1234.5 –1234.5

####0.00 1234.50 –1234.50 0.00

#####0 1234 –1234 0

+#####0;–#####0;0 +1234 –1234 0

#####0DB;#####0CR; 0 1234DB 1234CR 0

#####0 ;(#####0) 1234 (1234) 0

###,##0 1,234 –1,234 0

##,##0.00 1,234.50 –1,234.50 0.00

^^^^^^^ 1234 –1234

^^^^^^0 1234 –1234 0

^^^,^^0 1,234 –1,234 0

^^,^^0.00 1,234.50 –1,234.50 0.00

******* ***1234 **–1234 *******

******0 ***1234 **–1234 ******0

***,**0 **1,234 *–1,234 ******0

**,**0.00 *1,234.50 –1,234.50 *****0.00

$*,**0.00;–$*,**0.00 $1,234.50 –$1,234.50 $****0.00

$^^^^0 $ 1234 $–1234 $ 0

$^^^0;–$^^^0 $1234 –$1234 $ 0



• Alpha field formats – Alpha formats control the way the alphanumeric 
characters appear when displayed or printed. You can choose a format 
from the Format pop-up menu or type a display format into the Format 
Display area. After choosing a format from the pop-up menu, you can 
edit it in the Format Display area.

• You can also enter and edit a format in the Format Display area. You can 
edit a format after choosing it from the Format pop-up menu. The number 
sign (#) is the placeholder for an Alpha field display format. You can 
include the appropriate dashes, hyphens, spaces, and any other 
punctuation marks that you want to display. You use the actual 
punctuation marks you want and the number sign for each character you 
want to display.

For example, consider a part number with a format such as:

RB-1762-1

The alpha format would be:

$^^^0 ;($^^^0) $1234 ($1234) $ 0

$^,^^0.00 ;($^,^^0.00) $1,234.50 ($1,234.50) $ 0.00

&2 1.2e+3 -1.2e+3 0.0e+0

&5 1.23450e+3 -1.23450e+3 0.00000

Number format examples

Format Entered Positive Negative Zero

Format Field type

###-#### Telephone number (local)

(###) ###-#### Telephone number (long distance)

###-###-#### Telephone number (long distance)

###-##-#### Social Security number

00000 Zip Code
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##-####-#

When the user enters “RB17621,” the field displays:

RB-1762-1

The field actually contains “RB17621.”

If the user enters more characters than the format allows, the program
displays the last characters. For example, if the format is:

(###)

and the user enters “HAPPY,” the field displays:

(PPY)

The field actually contains “HAPPY.” The program accepts and stores the 
entire entry no matter what the display format. No information is lost.

• Boolean field formats – You format a Boolean field as a pair of radio 
buttons by entering two labels separated by a semicolon (;) in the Format 
Display area. For example, a field for sex could have one button named 
Male and one button named Female. To create these buttons, you would 
type, “Male;Female.”

Hiding and showing columns
The Quick Report Editor allows you to hide rows or columns when printing 
the report. If desired, you can show a hidden column or row. Hiding rows is 
useful when you want the report to include only summary calculations. For 
example, hide the Detail row if you want to display only the summary 
calculations that appear in the Totals and Break rows. You can also use this 
feature to hide a Break row or the Totals row. You can hide a column if you 
need to use the column as a sort column, but do not want the report to display 
the column. You can hide a row using either a Quick Report menu command 
or the Quick Reports contextual menu.

To hide a row using the menu command:

1 Select the row you want to hide.



2 Choose Hide from the Edit menu.

To hide a row using the contextual menu:

1 Hold down the mouse button over the row label in the Row label bar.

The Quick Reports contextual menu appears.

The program displays the column in gray to remind you that the row will not 
appear when you print or preview the Quick Report. You can also use a menu 
command or the Quick Reports contextual menu to hide a column.

To hide a column using the menu command:

1 Select the column you want to hide.

2 Choose Hide from the Edit menu.

To hide a column using the Quick Reports contextual menu:

1 Hold down the mouse button over the column header.

The Quick Reports contextual menu appears.

2 Choose Hide from the contextual menu.

The Quick Report Editor displays the column in gray to remind you that it 
will not appear in the printed report.

When a row or column is hidden, the Hide menu command in the Edit menu 
and Quick Report contextual menu becomes Show. You can display a hidden 
row or column choosing Show from either the Edit or contextual menu. 
When you do so, the row or column is displayed normally in the Quick 
Report area.

Adding headers and footers
You can use the Headers and Footers dialog box to add page headers and 
footers text, specify font attributes, and insert codes for page numbers and/or 
date and time. You can only specify page headers when printing to a printer 
(as opposed to printing to disk or an alternate output device).
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To add page headers and footers:

1 Choose Headers and Footers from the File menu.

The Headers and Footers dialog box appears (Fig. D-15).The Header and 
Footers dialog box lets you specify both headers and footers from the same 
screen. You use the Edit drop-down list to specify either the header or footer.

Fig. DD-15. Quick Report Editor, Headers and Footers dialog.

2 Choose Header or Footer from the Edit menu.

3 Enter the header or footer height in the Height area.

Header and footer heights are set initially to 25 points each. You can change 
the measurement scale to enter values in inches or centimeters. As you enter 
the header and footer height, the dotted lines on the page preview area 
change accordingly.

4 Select an entry area and type the header or footer text.

To the right of each entry area is a contextual menu that allows you to insert 
variables for date, time, and the printing page number. Variables and static 
text may be combined in the same area.

5 If desired, select a font and font size from the drop-down lists, and click 
one or more Style check boxes.

Font specifications apply to all three entry areas. You cannot apply different 
font attributes to different areas of the header or footer. Some Style 
combinations are not valid; for example, you can choose Bold and Italic, but 
you cannot choose both Plain and Bold.



Printing/exporting Quick Reports
When you have completed the Quick Report design, you are ready to 
generate the report. You can print a Quick Report to a connected printer; 
export it as delimited text to a disk file; or send it to the Graph Editor (4D 
Chart) to view/print the information graphically.

To select the type of Quick Report to generate, choose Print Destination 
from the File menu. 

• Printed reports (Printer) — This option uses the device that you have 
selected in the Print Manager (Chooser on Macintosh) to preview and/or 
generate a printed report. You can print to a printer without using the Print 
Destination item, by choosing Print from the File menu. 

• Disk file — This option sends the report to delimited text export file on 
disk. The file can be opened and modified with other applications, 
including text editors and spreadsheets. The program automatically uses 
the column headings as the first “record” that is exported.

To print to a disk file:

1 Choose Disk File from the Print Destination hierarchical menu.

2 Choose Print from the File menu.

The program displays a standard, “save as”-type dialog box for creating a 
file on disk, and prompts you to enter a file name (Fig. D-16). As an option, 
you can also specify the delimiting characters between columns and rows. 
Generally, to re-open the file in a spreadsheet program, you will want to 
leave these at their default values: Tab (9) for columns and Carriage Return 
(13) for rows.

3 Enter a file name and click the OK button.

The program will display a progress dialog as the export proceeds. Click the 
Stop Printing button to cancel the export.

After the report is exported to a file on disk, the program returns you to the 
Quick Report Editor. Remember to change the output device if you want to 
resume sending the report to a standard printer.
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Fig. DD-16. Quick Report Editor, Export data dialog.

• Print to graph – This option directs the output of the Quick Report to 4D 
Chart, the 4th Dimension plug-in for plotting data. When you choose the 
Graph item in the Print Destination hierarchical menu, your report 
appears as a graph rather than in columnar form. 4D Chart uses only the 
summary calculations and labels in the Break row. It uses the left most, 
non-numeric column for the Values axis (the horizontal axis). Your graph 
can then be printed using 4D Chart.

To use the Graph feature successfully, your report should include from 
one to five numeric fields or formulas. These columns will be assigned to 
the values axis in the graph. The report should also use one type of 
summary calculation per numeric field. 

To print to a graph:

1 Choose Graph from the Print Destination hierarchical menu.

2 Choose Print from the File menu.

Initially, the program graphs your data as a column graph.You can use the 
4D Chart menu items to select another graph type, or to print the graph.



• • • • • •
 Appendix E: Using 4D Tools

4D Tools is a utility for maintaining and, as necessary, repairing 4th 
Dimension™ databases. Because SELPA Manager uses the 4th Dimension 
database engine, 4D Tools is an important utility for maintaining the 
integrity of your SELPA Manager data file.

This appendix covers the use of 4D Tools with SELPA Manager. The 
discussion which follows has been incorporated (with minimal 
modification) from the 4th Dimension reference materials.1

When to use 4D Tools
You should run 4D Tools periodically to verify the integrity of your SELPA 
Manager data file. The frequency with which you should check the data file 
will depend upon the number of additions and/or deletions of information 
that SELPA Manager receives. 

For example, during periods of high usage, you might want to check the data 
file weekly with 4D Tools. With a lower level of activity, monthly checks 
might be appropriate. If you have experienced a computer crash while 
adding information to or deleting information from a single-user edition of 
SELPA Manager, then you might want to run 4D Tools immediately. In 
some cases, when attempting to re-open SELPA Manager after a computer 
crash, the program will inform you that you must run 4D Tools before 
proceeding further.

When you are upgrading from an earlier version to a newer version of 
SELPA Manager, the update will, on occasion, incorporate a newer version 
of the underlying 4th Dimension database engine. For this type of upgrade, 
prior to the upgrade, you should compact or rebuild (“recover”) your data 

1. 4D SA/ 4D Inc., 4th Tools Version 6.7 Reference. Cupertino: 2000, 4D SA/4D Inc.
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file with the version of 4D Tools that matches your earlier version of SELPA 
Manager. Normally, there will be instructions with a particular upgrade that 
inform you when data file preparation with 4D Tools is necessary.

As an example, SELPA Manager versions 4.01 through 4.6982 use 4th 
Dimension 6.0 as the database engine. Versions on or after 4.701 but prior 
to 4.75 use 4th Dimension 6.7 as the database engine (refer to Fig. E-1). If 
you had been using SELPA Manager 4.6982 and intended to upgrade to 
4.701, then we would recommend that you run 4D Tools 6.0.6 to compact 
or rebuild the data file, prior to the upgrade. 

When moving from SELPA Manager 4.7x to SELPA Manager 4.75x, the 
underlying database engine changes from 4th Dimension 6.7 to 4D 2003. 
For this change, recommend first using 4D Tools 6.72 or 4D Tools 6.74 to 
compact or rebuild the data file, prior to the upgrade.

This appendix focuses on the use of 4D Tools 6.7 and 4D Tools 2003, which 
cover the most recent releases of SELPA Manager. These two versions have 
similar interfaces. 

There is also a brief description of the use of 4D Tools 6.0.6 on page 771. 
4D Tools 6.0.6 is a more rudimentary precursor, and does not have a dialog-
type interface. The version of 4D Tools that you use is determined by the last 
version of SELPA Manager used in conjunction with the data file.

Fig. EE-1. SELPA Manager with the corresponding versions of the 4D database engine 
and 4D Tools. The letter “x” refers to the minor version of 4D. For example, the most-
used version of 4D 6.0.x with SELPA Manager was 4D 6.0.6.

1. SELPA Manager data files prior to Version 4.0 used an earlier version of the 4th Di-
mension database engine. A data export from SELPA Manager (v. 3.58) into the newer
program (4.0x and later) was available, so preparing the earlier data file with 4D Tools
was not required. Exports from SELPA Manager 3.58 can still be imported into the
current version of SELPA Manager.

Program version 4D database engine 4D Tools version

SELPA Manager 4.00 - 4.6987 4D 6.0 4D Tools 6.0.6

SELPA Manager 4.701 - 4.74xx 4D 6.7 4D Tools 6.72 or 6.74

SELPA Manager 4.75xx 4D 2003 4D Tools 2003.2



Installing 4D Tools
4D Tools is a component of the standard installation, for both the single-user 
and multiple-user editions of SELPA Manager. Therefore, unless you un-
checked the default option to install 4D Tools, it should already be installed 
on your computer (for example, refer to the 4D Tools check box of Fig. 2-4 
in the Chapter, “Installing SELPA Manager” on page 54).

If you do not have 4D Tools installed currently on your computer, then you 
can install it by re-running the most recent SELPA Manager installer. 

To locate the most recent installer on your hard disk, look for a file 
containing the version number of SELPA Manager that you are currently 
using. For example, if you are using SELPA Manager v. 4.7374, then the 
name of the installer file on disk would be “SLPA47374_RT.EXE” 
(Windows); “Selpa47374_RT.bin”1 (Macintosh) or “Selpa47374_RT.sit” 
(Macintosh).

If you no longer have the SELPA Manager installer on your hard disk, you 
can still download the current installer from the SELPA Manager download 
page (refer to the download instructions for Windows computers on page 50, 
and for Macintosh computers on page 90).

Once you have started the installer program, you may be able to check a 
custom option that installs 4D Tools only, without re-installing the SELPA 
Manager software itself.

For the multi-user editions of SELPA Manager, if you don't already have 4D 
Tools installed, you can re-run the last “full” install of SELPA Manager 
server.2 Ensure that you do not also install SELPA Manager itself, however, 
since this action may replace the current copy of the SELPA Manager 
program on the server with an older copy of SELPA Manager.

You can also install 4D Tools on the server computer by using one of the 
single-user installers (as described above). In this case, make sure that you 
un-check the box for installing SELPA Manager itself.

1. When the binary (“.bin”) encoding is removed by Stuffit Expander from the Macintosh
archive, the installer program will then have the name, “SELPA 4.7374 RT Install”.
2. At this writing, the last “full” server installers for SELPA Manager were
“SLPAsrv_47387.EXE” (for Windows servers) and “SelpaSrv_47398.sit” (for Macin-
tosh servers).
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Running 4D Tools
4D Tools is a separate application, independent from SELPA Manager. 
However, it can open SELPA Manager program files to verify their integrity, 
and to perform maintenance or repairs. In order for 4D Tools to access your 
data, however, you must first exit from SELPA Manager itself. You should 
also ensure that your computer is in a stable state, prior to conducting file 
validation and repair.

Data file validation and repair

To validate the data file with 4D Tools:

1 If SELPA Manager is running, exit the program now.

From the File menu, select Exit (refer to the Chapter, “File Menu 
Operations” on page 606). In the case of a multi-user installation, any 
connected client workstations should exit from SELPA Manager, and then 
the database administrator should stop the server (File menu -> Quit).

WARNING: When running on Macintosh OS 10 (“OS X”), 4D Tools can 
inadvertently open an active data file (i.e., one that is running in SELPA 
Manager). To avoid serious damage to your data file, ensure that SELPA 
Manager and 4D Tools do not simultaneously access the same structure and 
data file.

2 Verify that no other programs are running on your computer.

Quit/exit from any open applications. If you have a virus program, a disk 
compression utility, Windows Messaging, or other background operations 
running, be sure that you disable these items before proceeding. This step is 
particularly critical with Windows 95/98/ME, because certain types of 
interruptions during a 4D Tools run may cause the program to quit 
unexpectedly.

On Windows, some of these items can be disabled by right-clicking or 
double-clicking on their icons in the System Tray, and selecting a “disable” 
or a “close” option. Another approach is to re-boot your computer and press 
the [F5] key on startup, to select a “protected mode” start-up. 

For Macintosh computers running OS 9, you may wish to re-boot with the 
computer with the [SHIFT] key down (extensions disabled).



3 Ensure that the hard disk directory on your computer is intact.

4D Tools uses your computer’s hard disk directory as a “road map” while it 
is compacting and rebuilding the SELPA Manager data file. If the directory 
is corrupt, then 4D Tools may send portions of the data file to incorrect 
locations on the hard drive, resulting in data file damage or even an unusable 
data file.

Macintosh disk check

To check the condition of the disk directory on a Macintosh with OS 9, run 
Disk First Aid and perform any repairs that are identified from the scan. 

For Mac OS X in single-user mode, with a non-journaled disk, run “fsck -y” 
from the command line. If the response is “FILE SYSTEM WAS 
MODIFIED”, then repeat the operation until there are no more 
modifications. If the disk is journaled, then you can skip this step; it will not 
be possible to run “fsck -y” to check or repair the disk.

When booting Mac OS X from a system CD, with a non-journaled disk, run 
Disk Utility. Fix any errors that the program finds. With a journaled disk, 
skip this step.

Windows disk check

To check the condition of the disk directory on a Windows computer, 
double-click on My Computer. When the My Computer window opens, 
right-click on “Local Disk (C:)” and select Properties from the contextual 
menu. 

NOTE: If SELPA Manager is located on the D: drive, or on some other drive 
or combination of drives, then you should check the integrity of the drive on 
which the data file is located. To minimize verification time, it is best to 
perform this operation (and subsequent 4D Tools operations) on a local 
drive, rather than a network drive. Therefore, if your data file resides on a 
network drive (e.g., “I:” or “P:”), then you may wish to relocate the data 
file first to a local drive.

Windows will then display the “Local Disk (C:) Properties” window (Fig. 
E-2), which contains several tabs. For Windows XP, these tabs are 
“General”, “Tools”, “Hardware”, and “Sharing”. 
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Fig. EE-2. Accessing the hard disk properties window (Windows XP Professional).

Fig. EE-3. Initiating a disk check (Windows XP Professional).



Click on the Tools tab. Windows will then display the Tools section of the 
Properties dialog. Press the CHECK NOW button under the Error Checking 
section. Windows displays the “Check Local Disk (C:)” dialog (Fig. E-3). 
Select the check box, “Automatically fix file system errors” and then press 
the START button.

On Windows NT, 2000, and XP systems, you will obtain an additional 
warning that the disk check cannot be performed because the system cannot 
obtain exclusive access to the disk. Press the YES button on the dialog, to 
schedule the disk checking operation on the next re-start of the computer. 
Then, re-boot your computer (Start menu -> Turn off computer -> 
RESTART button).

Alternatively, if you think that the disk directory is probably okay, then you 
may be able to run the disk check immediately, without making repairs as 
necessary, by un-checking the “Automatically fix file system errors” box, 
and then pressing the START button again.

Close the Properties window for the local hard disk.

4 Start the 4D Tools program (application).

To run 4D Tools on a Windows computer that has SELPA Manager single-
user edition installed, you can select it from the Windows Start menu (Fig. 
E-4). 

Fig. EE-4. 4D Tools item in the Windows Start menu.
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As an alternative, you can also double-click on the icon for the program 
(“4DTools.EXE”); or perform a “drop-launch” by dragging the SELPA 
Manager structure (“SelpaMgr_v47.4DC”) on top of “4DTools.EXE”. 

For Macintosh users, locate the 4D Tools icon (or an alias thereof) on your 
hard disk, and double-click on it. 

If you are running a multi-user edition of SELPA Manager on 4D Server, 
then you may already have created shortcut icons on your desktop for the 
SELPA Manager structure and for 4D Tools (refer to Step 28 on page 72, of 
the 4D Server installation instructions, Windows; and to Step 17 on 
page 104, Macintosh). In this case, you can drop-launch the SELPA 
Manager structure shortcut on top of the 4D Tools shortcut.

5 Open the SELPA Manager structure file

If you did not perform a drop-launch of 4D Tools in the previous step, then 
4D Tools will present an Open-file-type dialog, prompting you to locate the 
SELPA Manager structure file on disk (Fig. E-5). 

Fig. EE-5. 4D Tools open structure dialog. To find the SELPA Manager structure, you 
must select “Files of type: Compiled Database (*.4dc)” for Windows, or “Custom 
document” for Macintosh.



The open-file dialog will contain a “Files of type:” selection menu at the 
bottom. For SELPA Manager, you must select “Compiled Database (*.4dc)” 
for Windows; “Custom document” for Macintosh single-user; or “Compiled 
database” for Macintosh server. 

If you leave the selection menu on the default value (e.g., “Structure File 
(*.4db)”), then you will not be able to locate the SELPA Manager structure 
on your hard disk.

6 Select user login name and password

The SELPA Manager structure will present the standard password/login 
dialog within 4D Tools. Select the appropriate user and password, then press 
the OK button to connect.

NOTE: If you have copied your data file temporarily from a network server 
volume to a local hard drive, then you may need to hold down the 
[ALT/OPTION] key while clicking with the mouse on the OK button, to 
redirect 4D Tools to the data file copy at its new location. Similarly, if you 
want to check more than one data file, you will need to re-start 4D Tools for 
each data file, and use this keystroke sequence again after the 
password/login dialog.

7 If trouble is detected on opening...

If 4D Tools detects data file damage when it first opens the SELPA Manager 
structure, then it will present a dialog box indicating that a problem has been 
found. 

In this case, you should elect to fix the problem by pressing the FIX button. 
If the problem is sufficiently serious, 4D Tools will want to perform a 
“recovery” operation. The program will prompt you to specify the name for 
a new (“recovered”) data file on disk, by displaying a “Save as”-type 
dialog.We recommend that you specify a name for the data file which 
includes the date on which the file was recovered (e.g., 
“Smith_Junior_082202.4DD”).1 

1. For Windows installations, 4D uses the “.4DD” suffix for the principal data file on disk, and
the “.4DR” suffix for its companion, the data resource file. Both files must have the same prefix
name (for example, “Smith_Junior_082202.4DD” and “Smith_Junior_082202.4DR”). 4D Tools
6.7 and 4D Tools 2003 for Windows ask you to name the “.4DD” file only, and then will create
the “.4DR” companion file automatically. 4D Tools 6.0.6 requires you to create the data resource
file manually after the recovery; refer to “Creating the data resource file after recovery (4D
Tools 6.0.6, Windows only)” on page 772. On Macintosh installations, there is only one data file
on disk, rather than a pair of files. (e.g., “Smith_Junior_082202.data”).
Using 4D Tools 765 

• 
• 
• 
•
•
•



766  

• 
• 
• 
•
•
•

After specifying the name for the new data file, press the SAVE button. 4D 
Tools will begin the recovery operation. Be patient, as you may not see any 
activity on the screen for several seconds. You should then see a series of 
thermometer bars (“scavenging”, “rebuilding”, “indexing”, etc.). 

NOTE: Ensure that you have enough room on disk for another copy of the 
database. A recovery operation may cause damaged records to be deleted. 
Following the recovery, you may want to re-enter deleted records from an 
earlier copy of the data file.

You should wait until 4D Tools displays a message, “The data file has been 
recovered” or “The data file has been repaired”, before using the keyboard 
or the mouse. At the point that you see the confirmation message, press the 
OK button at the bottom of the dialog to return to the Information tab of the 
standard 4D Tools dialog (shown in Fig. E-6, below).

After the repair or recovery is complete, you can exit from 4D Tools by 
pressing the QUIT button, or by selecting Quit from the File menu. You do 
not need to follow the next series of steps in these instructions.

8 If trouble is not detected on opening...

If 4D Tools does not detect any immediate problems with the data file on 
opening the SELPA Manager structure, then it will present a dialog box 
containing its standard (main) interface (Fig. E-6).

The 4D Tools dialog box includes the following tabs:

• Information – Provides descriptive statistics which allow you to view 
the principal characteristics of the database at a glance.

• Maintain – Allows you to verify the data integrity, to sort the records in 
a specific order, and to compact the data file.

• Repair – Can be used if the database is damaged. Several different repair 
methods are available. Different options are appropriate depending on the 
type and the degree of damage.

• Structure – Allows you to verify, repair, and compact the structure file. 
The options on this tab are not relevant to SELPA Manager.



Fig. EE-6. 4D Tools, main interface dialog.

9 Click on the Maintain tab

4D Tools takes you to the second tab, which is shown in Fig. E-7.

10 Click on the CHECK ALL button

You will see a series of thermometer bars on the screen, as 4D Tools verifies 
the integrity of records and indices in the various tables in SELPA Manager. 
After the verification is complete, 4D Tools will present a confirmation 
message. For example, if no problems are found, the message is “Checking 
all data file...Everything seems OK.”. You can then press the OK button to 
return to the Maintain tab of the 4D Tools dialog.

If 4D Tools finds one or more problems, then the confirmation message may 
contain information related to the error(s), instead of the message, 
“Everything seems OK.” There may be additional information, such as 
advice on how to fix particular problems. 
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Fig. EE-7. 4D Tools, Tab 2 (Maintain).

Press the OK button at the bottom of the confirmation dialog, to return to the 
Maintain tab of the 4D Tools dialog. 

If the problem(s) detected are sufficiently serious, then 4D Tools will want 
to perform the recovery operation – you will be prompted to name a new 
data file on disk, as in Step 7 on page 765.

NOTE: Ensure that you have enough room on your disk for another copy of 
the database. If you do not have sufficient room, then exit from 4D Tools; do 
not proceed with these instructions. 

A recovery operation may cause damaged records to be deleted. Following 
the recovery, you may want to re-enter deleted records from an earlier copy 
of the data file.



In some cases, 4D Tools may indicate that a problem can be fixed by making 
a “quick repair,” by pressing the REPAIR ALL button in the Repair tab 
section of the dialog (Fig. E-8). 

Fig. EE-8. 4D Tools, Tab 3 (Repair).

In general, however, we recommend that you repair any damage which 4D 
Tools has detected by clicking on the RECOVER... button, instead. The 
RECOVER... button performs a more thorough repair by completely 
rebuilding the data file. 4D Tools will prompt you to name the new 
(recovered) data file, as in Step 7 on page 765. 

When the recovery has completed, 4D Tools will present an 
acknowledgement message, Press the OK button to return to the Repair tab 
of the 4D Tools dialog, and then QUIT to exit 4D Tools.
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Compacting the data file
The Maintain tab of 4D Tools (Fig. E-7) includes a COMPACT... button, 
which can be used to reduce the amount of space that the data file occupies 
on disk. 

Data files can acquire unoccupied spaces (“holes”) when records are 
modified and deleted. Holes are created when information no longer fits in 
the space it once occupied or when information is deleted. Although SELPA 
Manager will reuse an unoccupied space when a new record can fit into it, 
holes may still remain because the size of the records is variable, or because 
a large amount of data is deleted.

Unoccupied spaces can separate the data file into non-contiguous patches of 
information, or fragments. If the data file is sufficiently fragmented on disk, 
the responsiveness of SELPA Manager may suffer. In this case, the 
compacting operation of 4D Tools may improve database performance 
somewhat.

You can determine how efficiently the data file occupies space on disk by 
reading the thermometer graph for “data file use,” on the Information tab of 
4D Tools (Fig. E-6). If the thermometer is below 80 percent space 
utilization, then you may want to compact the data file. Under the 
“Administration” heading at the bottom, 4D Tools will also suggest whether 
or not the data file should be compacted.

When you press the COMPACT... button, 4D Tools will prompt you to 
specify the name for a new data file on disk, in similar fashion to the recover 
operation (Step 7 on page 765). Compacting a data file does not rebuild the 
records or the indices, however. Therefore, if 4D Tools detects that you have 
data file damage, you should repair it using the RECOVER button instead of 
compacting.

NOTE: It is not necessary to perform a compaction after a recovery, because 
the recovery operation itself results in a newly-created, compact data file. 
Prior to compacting, be sure that you have enough room on your disk for 
another copy of the database.



Re-starting SELPA Manager
SELPA Manager remembers the name and path to the data file that you 
opened when you last used the program. After performing a data file 
recovery or a data file compaction using 4D Tools, you will have created a 
new data file on disk. Therefore, you will need to identify the new data file 
to SELPA Manager, the next time that you start the program. 

To direct SELPA Manager to the new data file, hold down the 
[ALT/OPTION] key immediately after entering the password and pressing 
the OK button. For multi-user installations, hold down the [ALT/OPTION] 
key immediately after you see the blue 4D logo on start-up. 

SELPA Manager will then display a standard, open file-type dialog, 
prompting you to locate the new data file on disk.

If you fail to hold down the [ALT/OPTION] key as SELPA Manager is 
starting, then you may get an error message indicating that a file cannot be 
found. The error message results because 4D Tools has renamed the old data 
file, and thus SELPA Manager cannot locate it under the previous name.

Using 4D Tools 6.0.6 to recover a data file
4D Tools 6.0.6 is an earlier version of 4D Tools. It does not use the dialog 
described previously for 4D Tools 6.7x and 4D Tools 2003.x, as its interface.

Like its newer siblings, 4D Tools 6.0.6 can be used to repair, compact, 
and/or recover a damaged data file for SELPA Manager. However, it should 
only be used for data files run with SELPA Manager versions prior to 4.700. 
It should not be used for versions on or after 4.700 (refer to Fig. E-1), but 
can be used to prepare an earlier data file to run with a 4.700+ upgrade to 
SELPA Manager.

Start 4D Tools 6.0.6. The program will display a standard Windows “open 
file”-type dialog, prompting you to select a database to open.

Open the SELPA Manager program by selecting the compiled structure file 
that is in use. For example, the default path to the structure is “C:\Program 
Files\Fusn_Tek\Selpa_fldr\SelpaMgr_v46.4DC”. This path assumes 
standard placement of SELPA Manager on the C: drive; your actual path to 
and name of the “.4DC” file may be different).
Using 4D Tools 771 

• 
• 
• 
•
•
•



772  

• 
• 
• 
•
•
•

4D Tools will then present the database log-in box. Select Administrator and 
use the administrator password to access SELPA Manager. 

After log-in, the screen will become an empty, gray area (the “MDI 
window”) above the Windows task bar. On Macintosh, the desktop 
background will remain; the only clue to the user that the program is running 
may be the change from the normal Finder menu items. 

From the Utilities menu, select “Check and recover...” and, from the 
resulting dialog, “recover by tags.” This option will create a new, recovered 
copy of the data file, which 4D Tools will prompt you to name on disk. 
Select an appropriate data file name, and save this new copy of the data file 
into the same folder (directory) as the current data file (C:\Program 
Files\Fusn_Tek\Selpa_fldr).

Once recovery has started, you will see a series of thermometer bars appear 
on the monitor screen (“scavenging”, “rebuilding”, “indexing”, etc.). When 
the thermometer activity ceases completely, then you may quit 4D Tools 
(File menu -> Quit). 4D Tools 6.0.6 does not present an alert message 
indicating that it has finished.

After performing the 4D Tools operation, you should find the recovered file 
in the SELPA_fldr directory. For example, suppose the original data file was 
named “Caroline_Middle.4DD”, and the newly-recovered file is 
“Caroline_Middle2.4DD”; both should be located in the SELPA_fldr 
directory.

Creating the data resource file after recovery (4D 
Tools 6.0.6, Windows only)
Unlike later versions of 4D Tools under Windows, v. 6.0.6 does not 
automatically create the companion data resource file (“.4DR”) when it 
creates a recovered data file (“.4DD”). Therefore, after a recovery by tags 
with v.6.0.6, Windows users will need to make a copy of the original data 
resource file and then re-name it, so that the prefix forms a matching pair 
with the recovered data file. 

For example, the original data resource file, “Caroline_Middle.4DR”, could 
be copied and then the copy re-named as “Caroline_Middle2.4DR”.



Top copy the original data resource file, right-click on it and select “Copy” 
from the contextual menu. Then, with the cursor pointing only to the white 
space within a folder (not directly at another file or folder), right-click again 
and select “Paste”. The newly-created data resource file can then be re-
named so that its prefix matches that of the data (“.4DD”) file. 

If you do not remember to create the data resource file after a recovery by 
tags, then SELPA Manager will present an error message when attempting 
to open the recovered data file.
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 Appendix F: Using the 4D Label Editor

The 4D Label Editor is an interface for designing and printing labels from 
4th Dimension™ databases. Because SELPA Manager uses the 4th 
Dimension database engine, the Label Editor is available from within the 
program. 

This appendix covers the use of the 4D Label Editor with SELPA Manager. 
The discussion which follows has been incorporated with only minimal 
modification from the 4th Dimension reference materials.1

Label Editor basics
You can access the Label Editor dialog box within SELPA Manager by 
selecting “Print label” from the File menu. The “Print label” item is 
available when a browse window is the active (front-most) window.

You use the Label Editor to create, format, and print labels. The Label Editor 
contains settings for designing labels and positioning the labels on label 
paper. For example, when producing mailing labels, you might want a label 
design that includes the parents’ name on the first line, the street address on 
the second line, and so on. 

As part of the design, the Label Editor enables you to specify the number of 
labels on the page and the margins of the label paper so that the label text is 
centered within the labels. The Label Editor consists of two tabs, the “Label 
page (tab)” and the “Layout page (tab)”, each identified by a tab at the top 
of the dialog box. You use the Label page (tab) to specify the content of the 
label and the Layout page (tab) to define the size and position of the labels 
on the page. When you create a satisfactory label design, you can save it to 
disk as a template, so that you can reuse it.

1. 4D SA/ 4D Inc., 4th Dimension User Reference, Version 6.7 for Mac™ OS and Win-
dows®. Cupertino: 1985-2000, 4D SA/4D Inc.
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Label templates should be loaded and re-used for printing from the same 
section of SELPA Manager as their original use. For example, if you created 
a mailing label template for a selection of students, then a student list must 
have the current focus in the browse window, when you activate the Label 
Editor and then re-open the template.

Label page (tab)
Fig. F-1 is an illustration of the Label page (tab) of the Label Editor.

Fig. FF-1. Label Editor, Label page/tab (File menu -> Print label).

The Label page contains the following elements:

1 Fields list 

This area displays the names of the fields in the current table, in an 
hierarchical list. If this table is related to other tables, the foreign key fields 
have a plus sign (on Windows) or an arrow (on Macintosh). You can display 
fields from the related table by expanding the relating fields. The fields in 
the related table are indented.



2 Label preview area 

You use this area to design your label.

3 Toolbar

The Label Editor toolbar contains button tools for drawing, selecting, 
aligning, distributing, layering, and duplicating objects. 

The first button is the Arrow tool, for selecting individual objects.

The next four buttons are drawing tools, for placing rectangles, rounded 
rectangles, ovals, and lines onto the label. Depress the tool button, then drag 
the cursor across the preview area to place the object onto the label. When 
you release the mouse button, the object will appear on the form. The object 
can be moved by dragging or re-sized by dragging the object corners.

NOTE: To draw a square rather than a rectangle, or an oval rather than a 
circle, hold down the [SHIFT] key as you drag the cursor.

The next six buttons are alignment tools. Select two or more objects on the 
label preview area that you wish to be aligned, and then click on the 
alignment button (right, left, bottom, top, horizontal center, or vertical 
center).

The next two buttons are distribute vertically and distribute horizontally. 
Use one of these buttons to separate three or more selected objects by equal 
distances, from their adjacent sides. [SHIFT]-clicking on the distribute 
buttons will separate the selected objects from their tops (vertical 
distribution) or their left sides (horizontal). [ALT/OPTION]-clicking on the 
distribute buttons will separate the selected objects from their bottoms 
(vertical distribution) or their right sides (horizontal).[ALT/OPTION]-
[SHIFT]-clicking on these buttons will distribute the selected objects from 
their centers.

The final three buttons are move to front, move to back, and duplicate. You 
must have at least one item selected in the label preview area to use these 
buttons. Move to front and move to back control the “layering” of a 
highlighted item on the label, compared to other items. Pressing the 
duplicate button will make a copy of one or more highlighted items on the 
label.

4 Object Look area 
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These controls let you specify foreground and background colors, fill 
patterns, line width, and borders for selected objects on the label. To select 
a color, pattern, or line width, first select the object in the label preview area, 
and then select the attribute that you wish to apply.

5 DEFAULT LOOK button 

This button applies the default set of Object Look attributes to the selected 
object.

6 Static Text entry area 

This area allows you to add static text objects to the label.

7 Text attributes areas 

These controls allow you to specify the font, font size, display format, and 
style of the text.

8 Form to Use drop-down list 

This drop-down list lets you bypass the Label Editor, to use a form and 
associated methods from within SELPA Manager itself to print the labels. If 
you are using the Label Editor to create the label, choose No Form (the 
default) from this list. 

NOTE: At the present time, there are no internal forms in SELPA Manager 
suitable for use with the Label Editor.

Layout page (tab)
Fig. F-2 is an illustration of the Layout page (tab) of the Label Editor. The 
Layout page contains controls for printing labels based upon the 
requirements of the printer you selected in the Print Manager (or the 
Chooser, for Macintosh), so that it can format the page accurately.

The Layout page contains the following elements:

1 Orientation and Labels Order buttons 

These buttons enable you to specify the page orientation and the order in 
which information is assigned to labels.



Fig. FF-2. Label Editor, Layout page/tab (File menu -> Print label).

2 Labels across and down boxes 

These boxes are used to control the size of labels by specifying the number 
of labels that appear on your label paper.

3 Layout preview area 

This area provides a reduced view of how an entire page of labels will look, 
based on the dimensions you enter in the Label Editor. The page preview 
also reflects the paper size selected in the Print Setup dialog box. You can 
also select the first label on the page to be printed. The red border indicates 
the size of the physical page, and the blue border indicates the size of the 
printable area.

4 Label Size and Page Size radio buttons 

These buttons are used to select the label or the page for setting label and 
page dimensions. If you click LABEL SIZE, you can enter the label width 
and label height in the appropriate areas. If you click PAGE SIZE, you can 
enter values for right margin and bottom margin.

5 Margin boxes
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These boxes are used to specify the dimensions of the label and the page 
size, depending on the radio button you select. After you have entered the 
margins of your label paper, you may need to make some additional 
adjustments so that the label text is centered in the labels. You can use both 
positive and negative numbers in the Margin boxes to increase and decrease 
the margins.

6 Automatic Resizing 

If AUTOMATIC RESIZING is checked, then the values in the LABEL 
WIDTH and LABEL HEIGHT entry areas are set automatically.

7 Horizontal Gap 

This area controls the amount of space between label columns.

8 Vertical Gap 

This area controls the amount of space between label rows.

9 Unit drop-down list 

This drop-down list allows you to change the units in which you specify 
your label and label page measurements. You can use pixels, millimeters, 
centimeters, or inches.

10 Labels per record drop-down list 

This control lets you print more than one copy of each label. If you print 
more than one copy, then the program will print the copies consecutively 
rather than making copies of the label pages.

11 Standard Code drop-down list 

This control lets you specify the label, page dimensions, and margins by 
choosing a standard commercial label paper from the drop-down list.

12 Method to apply 

This control lets you choose a method that will be run at print time. For 
example, you can execute a method that posts the date and time that each 
label was printed.

13 Apply Once radio buttons 



These radio buttons are used to specify whether to run the method once per 
label or once per record. This control has meaning only if you are printing 
more than one copy of each label and you are also executing a method at 
print time.

NOTE: At the present time, SELPA Manager does not contain any methods 
that are specifically associated with printing from the Label Editor.

14 File buttons 

These buttons provide options for page setup, printing, saving, and loading 
label designs.

Label design
You create a label by dragging field names to the label preview area, adding 
static text, drawing graphic objects using the graphics tools in the toolbar, 
and pasting graphics from the Clipboard. You can edit the label by 
distributing, moving, resizing, layering, and aligning objects.

With the Object Look and Text attribute areas, you can control the font 
attributes, foreground and background colors, fill patterns, and borders of 
individual objects.

The label preview area shows the approximate size and shape of the selected 
label. Before adding elements to the label, you may want to specify your 
label paper and label dimensions using the Layout page.

Specifying label size / paper

To specify a label size:

1 Click the Layout page tab.

The Layout page of the Label Editor appears (Fig. F-2, above).

2 Click the Print Setup button.

The Print Setup dialog box for your operating system appears.

3 Choose the desired printer and click OK.

If necessary, the label preview area changes to reflect your selection.
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4 If appropriate, choose the type of label paper you are using from the 
Standard Code drop-down list.

You can specify the design of the label paper using the entry areas on the 
Layout page or choose a standard design from the Standard Code drop-down 
list. This drop-down list contains specifications for selected commercial 
label sheets.

NOTE: Unfortunately, because of licensing restrictions, the drop-down list 
does not include Avery labels. Consult the HelpServer to obtain 
recommended settings for Avery labels.

The remaining entry areas on the page change to reflect the selected label 
paper’s characteristics. If necessary, you can modify these specifications.

5 Click the appropriate Orientation and Labels Order radio pictures.

You can choose between portrait and landscape orientation and horizontal 
or vertical order.

6 Enter the number of labels in each row of your label sheet in the Labels 
Across box and the number of labels in each column in the Labels Down 
box.

The label preview area adjusts to display the appearance of the labels on a 
printed page.

7 If the first sheet of label paper is partially used, click on the first blank 
label in the label preview area.

When you subsequently print the label, the program will begin printing 
labels on the label you indicated, rather than on the first label on the page.

8 If desired, choose a unit of measurement from the Unit drop-down list, to 
use for entering margin sizes.

9 Enter values to reflect the margins on your label paper.

Use the LABEL SIZE and PAGE SIZE radio buttons to control whether you 
use the entry area for the size of the label or the size of the page. The size of 
the individual labels in the label page preview will adjust to accommodate 
the margins. For example, if you increase the size of your margins to two 
inches, top and bottom, the size of the individual labels will shrink to 
maintain the same number of labels that you specified earlier.



Because some printers use portions of the margin to hold the label sheet in 
place, the printer may not take the full margins into account when printing 
your labels. In this case, you may need to adjust the margin settings so the 
label text is properly centered in each label. 

Since the printer uses part of the margins, the printer begins measuring the 
margins from a point that is not precisely at the edge of the label paper. 
When the labels are printed, the label text may appear skewed to the right or 
to the bottom of the label paper.

To compensate for this lost margin space, you can use negative numbers in 
some of the margin boxes. When placed in the Right margin box, negative 
numbers pull the label text to the right. When entered in the Top margin box, 
negative numbers pull the label text toward the top of the page.

NOTE: As a rule, using a negative number in a margin box moves the label 
text toward the margin that you are setting.

10 (Optional) If you want to print more than one copy of each label, use the 
Labels per Record drop-down list to choose the number of copies to 
print.

The copies are printed consecutively on the label paper. The program does 
not duplicate the entire label page.

Creating a label

To create a label:

1 Drag the first field you want to display in the label from the Fields list to 
the label preview area.

If the field is in a related table, expand the relating field to display the fields 
in the related table. Your field is added to the label preview area. The 
selection handles (Fig. F-1, above) indicate that the field is selected.

2 If you want to concatenate another field onto the existing field, by 
appending it at the end of the existing field, then drag the new field from 
the Field list on top of the existing field.
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By default, a space is used to separate the two concatenated fields. A “+” 
marker between field names in a field object indicates that the fields are 
concatenated on a single line. When the program prints the label, it will 
insert a space between the fields on the same line.

If you want to concatenate two or more fields together so that there is a new 
line (in other words, a carriage return) rather than a space separating the 
fields, then drag the new field on top of the existing field, while holding 
down the [SHIFT] key. 

You can combine regular (space) concatenation with [SHIFT]-
concatenation, for multiple concatenated fields on a label.

For concatenated fields, if no text is present in the first field, then SELPA 
Manager will not print the first field or the separator character, before 
printing the contents of the second field.

You can automatically resize a group of concatenated fields so that it 
corresponds to the number of lines that it contains. To do so, 
[CNTRL/CMD]-click on the lower right handle of the group.

3 To add other, non-concatenated fields, continue dragging fields to the 
label preview area.

As you add fields, you can reposition them by dragging or using the 
alignment tools in the toolbar.

4 To add a text element to the label, enter the text in the Static Text area and 
then click the adjacent arrow button.

The static text object is added to the label preview area. After you add the 
element to the label, you can reposition it by dragging and aligning it with 
other objects.

5 If desired, use a drawing tool to draw any graphic objects that you want 
to appear on the label. Alternately, you can also paste a graphic from the 
Clipboard into the label preview area.



Editing a label

After you add all required elements to the label preview area, you can 
use any of the editing tools to modify the label design.

1 To remove an item from the label, highlight the item to be deleted and 
press the [BACKSPACE] or [DELETE] key. 

The selected object is removed. 

If the object is a row of concatenated fields, then pressing the 
[BACKSPACE] or [DELETE] key removes only the last field in the 
concatenated field object. Continue pressing the [BACKSPACE] or 
[DELETE] key to remove additional fields from the object.

2 To move one or more objects, select the objects on the label preview 
area, and use the mouse to drag the objects.

To move an object ten pixels at a time, select the object, hold down the 
[CNTRL/CMD] key, and then press an arrow key.

3 To add a border to an object, select the object, hold down the 
[CMD/CNTRL] key, and press a number from 1 to 9.

The distance in pixels from the object to the new border is determined by the 
number that you pressed.Using the number zero (0) will remove a border 
that you have previously applied to an object.

4 To change the appearance of an object (other than adding a border), 
select the object and then apply the attribute that you wish to change.

Use the “Object Look area” or the “Text attributes areas” of the Label Editor 
dialog (Fig. F-1, above) to change the desired attribute.

5 To restore the “default” appearance to an object on a label, select the 
object in the label preview area, and then press the DEFAULT LOOK 
button.

When you add an object to the label, it takes on the Object Look attributes 
of the most recently created object. If you want to assign the default Object 
Look attributes to this object (or any object), select the object and click 
DEFAULT LOOK. The foreground and background colors, fill patterns, and 
border width will reset to the default settings.
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Saving a label design

To save a label design (template):

1 Click the SAVE button.

The program displays a dialog box where you can enter a file name for the 
label design.

NOTE: Label template files on Windows are denoted by the file extension, 
“.4LB”.

2 Enter a filename for the label design and click OK (on Macintosh, click the 
SAVE button).

Loading a label design
You can load the label design whenever the Label Editor dialog is active.

To load a label design:

1 Click the Load button.

The program displays an open-file dialog box where you can select the 
filename of a label design. Double-click the filename or select the filename 
and click OK. (On Macintosh, choose a filename and click OPEN).

The program replaces the current label design with the design you selected.

Printing labels
After you have completed your label design, you can preview or print the 
labels. You may want to print first on regular paper so that you can check the 
placement of text before you use the more expensive label paper.

To print your labels:

1 Click the PRINT button.

The Print dialog box appears for the printer you selected in the Print 
Manager. If you check the PRINT PREVIEW check box before clicking 
OK, then the labels are previewed to the screen.



After the labels are printed, SELPA Manager closes the Label Editor and 
returns you to the browse window.
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 Appendix G: Revision History

SELPA Manager has gone through many revisions, both major and minor. 
This index contains a brief summary of the changes featured in each 
revision.

4.7x Revisions

4.7374 - 8.7.2002
1. Fixed a display problem when the Preferences dialog opens for the first 
time (during the creation of a new data file). 

2. Added an error trap for the SELPA 2300 (Services) import, to prevent the 
addition of a new student when neither district of residence nor district of 
service are available in a row. 

3. Fixed a shading problem with SELPA 4800 printed goal forms. 

4. Added the capability to print goal forms from the browse window 
(formerly the Quick Report Editor was the only option available).

4.7373 - 8.6.2002
1. Made some minor changes in access privileges, to improve consistency of 
the interface. 

2. Fixed a potential problem with the print students dialog, when printing 
from a student data entry form (“other” print type not fully disabled).

3. Added a 38th field to the 2300 / Services import, for home language 
(Mendocino).
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4.7372 - 7.27.2002
1. Fixed some minor display problems for Mac, standard student data entry 
form, transportation page check boxes.

2. Added the ability to export and import user choice list items. To access the 
export, the administrator needs to [ALT/OPTION]-click on the EDIT button 
(Preferences -> System settings tab), after selecting the list to be exported.

3. Added a supplemental goals warning, which can appear during student 
data entry. If the student has the alternative assessment box checked and 
there are no goals with the CASEMIS report date equal to the Report As Of 
date set in preferences, having a functional code of at least “10”, then 
SELPA Manager provides a warning. (The Report As Of date must be on or 
after 7.1.2001 to obtain the warning.)

4. Added a CASEMIS Table A import for the 2001-2002 table format.

5. Added a warning to the student record for a teacher that is under the 
teacher-access restrictions. If the teacher deletes and/or fails to add an 
enrollment for herself/himself, to the student record, then SELPA Manager 
provides a warning. If the student is saved under these conditions, then the 
teacher will no longer be able to access the student.

6. Added a missing/problem items box to the assignments data entry form. 
Changed “engagement is active” to “assignment is active” for the checkbox 
label.

7. Fixed a problem with the 3702 / BasicView import that was causing true 
drop dates (Field/Col 87) not to be recognized. 

4.7371 - 7.17.2002
1. Revised the “My District” function so that it will work for each program 
user (individually).

2. Fixed a cosmetic issue with the next-previous arrow buttons on data entry 
forms, for merged runtime editions of the program.



3. Changed to native-based progress dialogs, instead of plug-in based 
progress dialogs. This change affected approximately 86 existing 
procedures in the program. Progress dialogs will attempt to center 
themselves within the last opened window for a particular process (e.g., for 
the browse window being operated upon).

4. Made a minor change to the alert dialog that is displayed when generating 
the selection of CASEMIS-exportable students for display only, when none 
are found.

5. Made an adjustment to the student error checking, to compensate for a 
change to CASEMIS (Age 7-17, Gr 15 need STAR code 10-40 range).

4.7370 - 7.10.2002
1. Fixed a problem that was causing disciplinary actions that were not in the 
current year to be written to Table C, if they were attached to a student 
record that was a reporting duplicate of another student record (the “master” 
student record).

2. Made structural revisions to the Table C and D export searches, so that 
during preliminary screening, they will find discipline and alternate 
assessment information that is attached to duplicate student records, even if 
similar information is not also attached to the master student record. 

3. Fixed a problem that was causing all newly-created [Assessment_goal] 
records to be stamped with the As Of date 
([Assessment_goal]CASEMIS_report_D field, for CASEMIS reporting of 
alternate assessment information), after a SELPA Central import. This 
problem affected only those goals that did not already exist in the SELPA 
Central database.

4. Added an Enrollment Summary Report By Disability, which is similar to 
the report with this name in CASEMIS. However, at the present time, the 
reports do not generate exactly the same counts. Accessible with a selection 
of students, or with a selection of districts listed in a browse window.
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4.7369 - 6.28.2002
1. Added a second type of district chargeback report, which uses selected 
school of attendance types rather than the alternative service codes. Made 
slight modifications to the title of the existing chargeback report.

2. Added SELPA 3703 (North Inland).

4.7368 - 6.26.2002
1. Made requested changes to the Individual Transition Plan for SELPA 
3013 (Anaheim). There are new, activity pop-ups for each of the activities 
tables. The Administrator can set the content of the pop-ups from the 
Preferences -> System settings tab -> EDIT LIST button (“ITP activities 
3013”).

2. On goal data entry forms, if the CASEMIS report date is before 
6.30.2002, then the program will apply the 2000-2001 set of requirements 
for alternate assessment (three fields rather than six were required - content, 
mastery, and alt. reason), to determine whether the record can be saved. If 
the code of “10” is entered for alt. reason under these circumstances, then 
SELPA Manager will enter “not applicable” as the code description. This 
code is not allowed for current goal entry (blank date or date of 6.30.2002 
and beyond).

3. In cases where the alternate assessment field code of an existing goal 
record is not recognized when re-opened, the program will display the 
contents of the name and code fields in the combo box. Formerly, the 
program would display a blank box.

4. On goal data entry forms, SELPA Manager no longer asks more than once 
per student if the user selects an alternate assessment functional or curricular 
value, when the student record is not marked for a STAR code of 30.

5. Added a choice list for the [Assessment_goal]CASEMIS_report_D field 
consisting of June 30 dates. Added this field to the included form for SELPA 
0901 (not there previously, perhaps by mistake). If the user selects a date 
other than June 30, then the missing/problem items area on the data entry 
form displays a new “WNG” item.



6. Made changes to the SELPA Central, Students from Web, and District to 
District imports so that modification dates are obtained from the records 
being imported (for existing records in the target/central database). 
Previously, the modified date/time always would reflect the date and time of 
importation. Revised the order of certain post-processing operations, and 
the key clean-up will be slower. Holding down the [ALT/OPT] key will 
expedite the clean-up operations; however, the modified information will be 
lost.

7. Fixed a problem that was causing an errant message, 
“UTIL_districtAccessCheck has been called without a district...” when 
canceling a new student record, after SELPA Manager displays the dialog 
from which the user selects a district.

8. Fixed a problem with the confirmation/tracking information, following a 
SELPA Central import that involved adding discipline records. Previously, 
the program always indicated that zero disciplinary actions were added.

9. Changed a “missing/problem item(s)” error message for consistency with 
a change that was made in the CASEMIS software, concerning ungraded 
students. Formerly, CASEMIS generated a 650 error if a student was in 
Grade 15 (ungraded), the STAR/PARTICIP code was 30 (alternate 
assessment), and the student's age was 7 or greater. Now the error is 
generated if the same student is less than 7 years old.

4.7367 - 6.18.2002
1. Added two custom imports for SELPA 2300 (Mendocino), “SELPA 2300 
/ Services” and “SELPA 2300 / Addresses”, in the “Other” pull-down menu 
of the import dialog. The services import will accept multiple rows for the 
same student, so that multiple services can be imported; however, it will not 
update existing student-level information. The addresses import can (as a 
user-selected option) update existing student information.

2. Disabled “Show current for...” menu item for members of the TeacherGrp.

3. Added a warning when a student is marked for alternate assessment (the 
checkbox), but has no associated goal records.

4. Added a warning when a goal has a CASEMIS report date, but does not 
have any AA Functional code.
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5. Fixed a problem with getting an “invalid grade level” warning when no 
grade level is present (there is another error message for missing grade 
level).

6. Revised delete operations, so that the program will display thermo bars 
when preparing to delete more than 200 records. Re-enabled sorting after 
deletion, for large numbers of records being deleted. It is not recommended 
that you delete more than a few records at a time.

4.7366 - 6.7.2002
1. Fixed a minor problem that caused SELPA Manager to display duplicate 
warning and error messages for Last IEP / Last evaluation date being after 
the Report As Of date.

2. Fixed a problem that was causing “record out of range” errors in some 
cases, when the user selected “Show all” with the focus on either the upper 
or lower list of the browse window.

3. Added another special phrase for the Location box, “count enrollments”, 
which will find students with a specified number of enrollments. Works only 
when a student list has the current focus.

4. Fixed a problem in the Location box which had been preventing access to 
certain special phrases, when the list that had the focus was the lower list 
rather than the upper list. Fixed a problem that was causing a [TAB] out of 
the Location box (as opposed to using the [ENTER] key) not to be 
recognized after entering some text, in certain cases. Using [TAB] is less 
desirable if the current focus is on the lower list, however, because keystroke 
will change the focus to the upper list.

5. Changed the “Show all” and “Show current” items in the Data menu to 
“Show all for me” and “Show current for me” in student-related lists, when 
the user has specified “for me” as the browse window initial display option 
(in Preferences). Holding down the [ALT/OPTION] key while selecting this 
item will override and perform a show all / show current, without regard to 
the “for me” restriction.

6. Added a new group, “TeacherGrp”. Members of this group who are not 
also in the “AdminGroup” are restricted to finding/viewing students for 
whom they provide services. When a user is a member of the “TeacherGrp” 



but not also a member of the “AdminGroup”, then “for ” <teacher name> 
will appear in the descriptive text, at the bottom of the browse window. 
CASEMIS exports generated by these users are limited to the students for 
whom they provide services.

7. Fixed a problem with cache memory that was causing the program to 
“stall” while checking problem items in the browse window, for a large 
number of students, on Windows platforms. The thermo bar would stop 
about half-way through the verification, and the program became lethargic 
until the current window was closed.

8. Fixed a problem that was causing 4DWrite privilege errors on the single-
user editions. The current (logged-on) user must be in the 4D Write group 
(see Users and Groups...) to have access to the 4D Write areas.

9. Changed the descriptive text at the bottom of the browse window, for 
more compact descriptions.

10. Added “New discipline for...”, “New enrollment for...”, and “New goal 
for...” to list of Location box words that create new records. Must add a 
student name. 

11. Made some transportation field label changes, and added an option to 
print bus routes on the transportation summary (in place of pickup/drop-off 
addresses).

12. Implemented a multiple alternate years feature for enrollments. When 
the user selects “Other year enrollments” from the Data menu while in the 
current (present) year, the program prompts the user to identify which 
alternate year should be displayed (1 to 32000). 

When the user highlights enrollments and then selects “Move to other 
year...” from the Actions menu, the program now displays a dialog. The 
dialog offers options to clone or move the records. 

When returning from an alternate year to the main year, a different (return 
move) dialog appears. The return dialog has options to clone or to move the 
highlighted enrollments; to drop and/or to mark as “Do Not Report” the 
enrollments in the current year, for the same student(s); and to change the 
school of attendance, if a primary enrollment is being copied/moved back.
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To see the effects of a clone/move on another browse window that is 
displaying another year, it will be necessary to click on one of the records in 
that window (or perform some other action), to refresh it. Unfortunately, 
auto-refresh of this window after a clone/move is not at present working.

Alternate year enrollments are not exported with student transfer, SELPA 
Central, or CASEMIS reports.

4.7365 - 5.28.2002
1. Made some minor changes to tool tip help (browse window context 
buttons, student age calculations).

2. Added an additional validation for [Assessment_goal] records, checking 
for unlisted ALT_RESON (alternate assessment reason why goal not met) 
codes. 

3. Added a 2001-02 format CASEMIS Table C import (60 cols.). Also 
improved the 48-column import to display students after import (when 
import initiated from a discipline context / focus). Fixed some minor 
problems with error reporting on the 48-col. import.

4. Per request from Sharon Darby, made STAR#90 for first grader a warning 
rather than an error. Although this is a CASEMIS error, it allows the district 
to specify a non-90 participation code for the first graders that will be second 
graders in the fall.

4.7364 - 5.22.2002
1. Fixed a problem that was causing the SELPA Central import to generate 
an error “the set does not exist”, related to displaying the imported records. 
Also fixed a problem with not clearing certain variable contents between 
sequential SELPA Central imports. These problems were also addressed in 
other imports that use the display-after-import mechanism.

2. Disabled certain buttons in Preferences, when display takes place on 
startup with a new data file (was causing freezes in certain circumstances).



4.7363 - 5.21.2002
1. Fixed a problem that was causing the 2001-2002 end-of-year export to 
revert to the older (2000-2001) CASEMIS table formats, and to skip Table 
D. This is the first version tested against the June 2002 CASEMIS software 
(beta-D).

2. A list of recent items is now available for the browse window. Applies 
only to search requests that are entered into Location box. Recent items 
appear in the drop-down menu for the Location box. You may set the number 
of recent items in File menu -> Preferences... -> Appearances tab -> MAX 
RECENT ITEMS. A setting of zero disables the feature after the next 
program start-up.

3. If a [Student] list has the current focus in the browse window, then when 
selecting Actions -> CASEMIS report -> “All schools...”, there will be a new 
check box on the dialog, DISPLAY ONLY. Checking this box causes 
SELPA Manager to display the students eligible for the selected CASEMIS 
report, without actually exporting them to disk. The program will then offer 
to check these students' records for missing/problem items.

4. The user can enter “check missing items” or “check problem items” in the 
Location box, for the program to perform a verification of the listed records, 
for any that have missing/problem items. Does not find district access denial 
restrictions.

5. A user in the read-write group may now enter “Fix STAR#90 errors” into 
the Location box, when the current focus is on students. This action will 
change the STAR (PARTICIP) code to 90 for students with a non-90 STAR 
code, if the student is in grades 1, 12, 13, 16, 17, or 18.

6. Some of the special phrases for the Location box now are listed at the 
bottom of the drop-down (“Context chg or special” item list). Some of the 
associated actions now have access limitations, so that the ones that modify 
records are restricted either to read-write or administrative group members 
(depending upon the particular action).

7. Enabled the “Update other...” function in the Actions menu for goals. A 
user in the read-write group can now batch update certain goal fields, 
including the alternate assessment information.
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8. When generating the CASEMIS Table A, if the drop date for the last 
enrollment is beyond the As Of date, then SELPA Manager writes a blank 
drop date and drop reason.

9. The program now allows infant and preschool settings to be entered for 
older students, to preserve historical information. These items now generate 
warnings rather than errors if present for older students. Similarly, infant-
related dates generate warnings rather than errors, for older students. The 
warnings can still be disabled by selecting “no infant/preschool error 
checking for existing students” in Preferences.

10. After changing the Report As Of date, the program no longer changes 
infant/preschool fields when it recalculates the students' ages, unless the 
user holds down the [SHIFT] key as s/he presses the OK to the batch update 
ages dialog.

11. Added a field, [Assessment_goal]CASEMIS_report_D, which is 
“stamped” with the Report As Of date when a new goal record is saved. 
When generating the report for CASEMIS, SELPA Manager looks among 
the eligible alternate assessment records for those that are stamped with the 
correct Report As Of date. If none are marked with the correct date, then the 
program offers to export all eligible alternate assessment records. 

NOTE: Goals marked Do Not Report (DNR) are not exported, regardless of 
whether the report date is present or not.

4.7362 - 5.10.2002
1. The offer to perform a SELPA Central import (when first displaying a 
browse window with no student records) is now restricted to users with read-
write access.

2. When automatically adding a new student record following the creation 
of an assessment (IEP) record, the program now sets [Student]RIS_B to true 
when the RIS default is selected in Preferences.

3. Added a set of IEP notification fields to [User_info], which have the same 
purpose as the ones in the [Constants] table, except that the user can now 
store individual IEP default settings. Hold down the [ALT/OPT] key to 
defeat.



4. Fixed a problem with Data menu -> “Show current” not working with the 
Assessments listing in the browse window (generates an “M_showCurrent” 
error message).

5. Made changes so that the “No start date matching for enrollments” 
preference option also applies to the students from web import. Previously 
this setting applied only to the SELPA Central import (v.4.7359, Item #2).

6. The user now must be at least in the “ReadWriteGrp” access group to 
perform an export or an internal student transfer.

7. Made certain changes to access privileges so that a user in the 
“AdminGroup” access group can access the “Users and groups...” item from 
the File menu, provided that the Administrator has designated the user to be 
the owner of a group. 

8. Made certain changes to access privileges to correct an inconsistency in 
access to the MediCAL export, from different contexts within the program.

9. Added a new access group, “4DWriteGrp”, into which users must be 
placed to obtain access to available 4D Write licenses (server only).

10. Added a display update mechanism, so that after certain imports (e.g., 
SELPA Central or district-to-district) the “calling” browse window will 
refresh to show the relevant records that have been imported.

11. For an assessment (IEP) data entry form, holding down the 
[ALT/OPTION] key while pressing the SAVE button will cause the program 
to offer to update the [Student] record with any differing [Assessment] 
information, even if the assessment record has not changed since it was 
opened. If the [ALT/OPTION] key is not held down and there are no 
modifications since opening the assessment record, then the dialog will not 
appear. Similarly, if there are no differences between the assessment and the 
student records, then the dialog will not appear.

12. Added teacher services as an optional display, on the lower list of the 
Teachers context (rather than teacher assignments.)

13. When selecting “Transfer...” from the File menu for a selection of 
assessment (IEP) records, the program now offers to perform a SELPA 
Central export instead, as an option, and explains the differences. SELPA 
Central exports include any associated enrollment records, whereas the IEP 
transfer does not.
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14. When importing assessment (IEP) forms via the SELPA Central import, 
the district-to-district transfer, the assessment form transfer, or the students 
from web import, the program will now stamp any newly-created 
assessment records with an import date. This date appears as a “Imported 
on” column, just before the “Modified on” column in the browse window. 
You can search for imported IEPs by typing “imported on is after <date>” 
in the Location box, or by searching with the Query Editor.

15. Made certain changes to the SELPA 3702 (North Coastal) IEP printed 
form, so that nothing below the horizontal line on the first printed page is 
completed with data, for the “Working copy p.1” option. This option does 
not affect the other printed IEP pages.

4.7361 - 4.10.2002
1. The enhanced version of the transportation-only form can now display up 
to ten user Boolean (“Yes/No”) fields, as defined on the “User 2” tab of the 
student data entry form. To select which user yes/no fields to include on the 
enhanced transportation form, go to File menu -> Preferences... -> System 
Settings (Tab 2), and edit the list called “Transport aux boxes.” You may add 
up to the ten yes/no fields by name; they will appear at the bottom of the 
enhanced transportation-only form.

2. Fixed a problem with the transportation-only form, which allowed a user 
that was not a member of the read-write group to make changes to the 
student record, which would be saved.

3. Added vertical scrolling to the transportation-only data entry form, using 
the [CNTRL/CMD]-[up arrow] or [CNTRL/CMD]-[down arrow] 
keystrokes.

4. Fixed some minor problems with enabled/disabled and displayed/hidden 
items on the Preferences dialog, for users lacking administrative privileges.

5. Making field label changes for the user fields on the student and 
enrollment data entry forms is now restricted to users with administrative 
access.



4.7360 - 4.8.2002
1. Changed the field, [Assessment]Current_program from A80 to text, to 
accommodate additional information for SELPA 3013 (Anaheim). 

2. Changed the sixth tab description of the transition form (ITP) from “6 
Funct vocational eval” to “6 Related areas”, for SELPA 3013 (Anaheim).

3. Revised the SELPA 3702/Baseview import to include an additional three 
fields (replacing one, for a total of 112 fields. Changed the enrollments 
portion of the import to use the “new,” 2-digit CASEMIS service code 
designations.

4. Made extensive revisions to the SELPA 0400/4500/5300 
(Butte/Shasta/Trinity) IEP forms, as requested.

5. Made the “transport required” checkbox on the transportation-
only/enhanced form more prominent. Previously it was labeled only as 
“Req'd.”.

6. When start date is skipped as a criterion for matching enrollment records, 
for the SELPA Central import, then the program allows the start date field to 
be updated with the date in the import record.

7. Added a “[P]rint” button to the generic import dialog.

4.7359 (alpha) - 4.1.2002
1. When “My Districts” is selected as the first browse mode in Preferences 
(Tab 4), and the administrator has restricted the user to particular districts, 
then SELPA Manager will offer to display selections only in the user's 
districts when s/he selects “Show all” or “Show current” from the Data 
menu. Applies only to certain tables/contexts.

2. Added a new system preference checkbox, “No start date matching for 
enrollments”, which reduces the criteria for matching to an existing 
enrollment during SELPA Central imports. You may wish to try this setting 
if you are getting duplicate enrollment records after performing a SELPA 
Central import.
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4.7358 (alpha) - 3.29.2002
1. Added a new system preference checkbox, “IEP req. std. fields”, which 
mandates for saving an [Assessment] record that the user complete those 
items that are also required on the [Student] data entry form (e.g., grade 
level, residence, etc.). These items are identified as incomplete/missing on 
the assessment data entry form only if they are available on the IEP form for 
that particular SELPA. If the “Incomplete” box is checked, these items are 
_not_ identified as incomplete/missing.

2. Fixed a problem that was preventing the program from flagging a missing 
first name, on the assessment (IEP) data entry form.

3. The fields that are now/still required when an assessment form is marked 
as incomplete include first name, last name, IEP meeting type, and meeting 
date.

4. Fixed a problem that was generating an error message when the user 
added a new [Assessment] record from the browse window, without first 
selecting an existing student record with which the new assessment would 
be associated.

4.7357 (alpha) - 3.28.2002
1. Fixed a problem during SELPA Central importing, wherein (if modifying 
of districts is checked), an existing district would receive the next student 
number from the copy of SELPA Manager where the import originated. This 
update could cause duplicate record number conflicts in the receiving data 
file.

2. Added a box to the transportation-only student form, showing the drop 
date for the most recent primary (if any).

3. For SELPA 3702 (North Coastal), the service abbreviations appear rather 
than the codes in the last column of the student by teacher report.

4.7356 (alpha) - 3.27.2002
1. Made preliminary printed forms (PC) for SELPA 4900 (SCOE). Removed 
certain fields that aren't being used from the Query, Sort, and Report Editors, 
for the [Assessment_goal] and [Assessment_disposition] tables.



2. Added a feature for SELPAs 0400, 3702, 4500, 4900, and 5300 which 
updates a duplicate meeting date field for each goal, when the user adjusts 
the meeting date on the IEP form.

4.7355 (alpha) - 3.26.2002
1. Made preliminary printed forms (Mac only) for SELPA 4900 (SCOE). 
Windows forms are not yet adjusted for printing.

4.7354 (alpha) - 3.22.2002
1. Made certain modifications to the SELPA 3013 transition forms 
(underlined “other” categories on p. 1, printed forms; adjusted page 
numbering; changed the column title on p. 6). Made changes to the choice 
list pull-down menu for the first column, pp. 2-6. The pull-down menu now 
allows more than one entry of the same item, in the first column.

2. Fixed a problem with the “next” arrow key on the goals/objectives page 
of the IEP form. The “next” arrow would attempt to go to the second record, 
when there was only one goal record.

3. Added an option to show “My districts” as the initial browse preference. 
This preference will display students (and student-related tables) whose 
record number begins with the 7-digit prefix of the district(s) to which the 
user is limited. For the schools and districts tables, the program displays just 
those districts (schools) to which the user has district-level access. If the user 
has no district-level limitations, then the program will display all records. 
For non-relevant tables (teachers, assignments, users, tracking, etc.), the 
program will display no records.

4. Made a minor change to the ID Process, to reduce the chances of 
obtaining errant, “nil pointer” error messages in the Tracking section.

This particular version should NOT be used by SELPA 4900 for IEP 
functions

4.7353 (alpha) - 3.18.2002
1. Added deletion of associated user district limits, when the program user 
is deleted from the browse window.
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2. Added an option, if the Administrator holds down the [ALT/OPTION] key 
on closing the Users and Groups dialog, to create any new/unlisted users in 
the [User_info] section.

3. Disabled the close box on the Windows MDI window. To quit from 
SELPA Manager, use the Exit item in the File menu. The accidental use of 
the close box among Windows 98 users was causing problems with an 
unexpected quit while the cache still contained information.

4. Added previously unlisted alternate assessment fields (columns) to the 
Goals list in the browse window. The “functional area” field was incorrectly 
listed under the previous name, “content”.

5. Adjusted the printed goal forms for SELPA 3702 (North Coastal), so that 
a goal may be two lines long. To compensate, the third benchmark/short 
term objective fields are shortened by one line.

6. Began developing, but did not yet complete, the SELPA 4900 (Sonoma) 
IEP forms. This particular version should NOT be used by SELPA 4900 for 
IEP functions (some items will malfunction).

4.7352 - 3.7.2002
1. Fixed a problem that prevented the student name from appearing on the 
first page of the SELPA 0400/4500/5300 form, when the student is new. On 
the same form, added look-up functionality for the school of attendance 
name; and the district of residence/service codes.

2. For the SELPA 0400/4500/5300 IEP form, added an option to print a 
blank page if the student has no goals.

3. For SELPA 4100 (San Mateo), changed the description, “Special day 
inclusion services” to “Inclusion services,” when adding a new enrollment, 
teacher service, or teacher assignment record with a service code of 40. This 
revision does _not_ update the description for existing records. However, 
the Special Operations dialog box can be used for this purpose.

4. Fixed a problem that could cause duplicate service codes to be listed in 
the pop-up, after the teacher is specified on a new enrollment record. This 
problem was related to the coexistence of old and new service codes.



5. Added a mechanism that allows administrators (in the “AdminGroup”) to 
restrict a particular program user to specified districts, when that user is 
working with student-related records (students, contacts, enrollments, 
assessments, goals, transitions). 

 If the student-related record has a record number whose district prefix is not 
among the specified districts, then SELPA Manager disable the SAVE 
button on the form. The program will also place a diagnostic message in the 
“problem area” box, “District access denied”.

 The means for specifying the allowed districts for a user is a button on the 
user's information form, RESTRICTIONS BY DISTRICT. To display the 
user's information form, type “Show user info” into the Location box, and 
then double-click on a user.

 If no districts are specified for a particular user, then the program user has 
access to all districts.

4.7351 - 3.4.2002
1. Fixed a problem with an undefined array, when adding a new IEP for an 
existing student (SELPA 0901 / El Dorado only).

2. Added a search for students with NO current enrollments. Hold down the 
[SHIFT] key when selecting “Show current” from the data menu. The 
program will prompt you for the drop date. If a student has NO enrollments, 
or the enrollments have been dropped on or before the specified date, then 
the student will be included in the found set. Can be used in conjunction 
with an existing selection of student records in the browse window, and/or 
enrollments for a particular teacher (also hold down the [ALT/OPTION] 
key.

4.735 - 2.27.2002
1. Added the ability to display “for me” as a “current”-type option for 
“Browse window initially displays”, under Preferences, Appearance Tab. In 
this case, when switching to certain new contexts, the program will search 
for enrollments for which the logged-on user is the teacher.
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2. Under Data menu -> Show current, if the “for me” option is set in 
Preferences, then the program now displays a request dialog, offering to 
restrict the search to enrollments for which the logged-on user is the teacher. 
Pressing the CANCEL button on this request, or clearing the logged-on user 
name from the request, causes the program to revert to the previous behavior 
(to get all current students, regardless of teacher). This request dialog can be 
forced to appear, even when the “for me” option is not set in Preferences, by 
holding down the [ALT/OPTION] key while selecting “Show current”.

3. Added an option under Preferences -> Appearance Tab -> “Don't guess 
AC prefix”. Checking this box stops the program from “guessing” the area 
code of the work/other phone number, when the home phone is entered. 

In addition, when editing addresses from the first (General) student tab, 
entering a postal code (with an associated area code) normally causes the 
program to enter the area code prefix for both the work and home telephone 
numbers. When this box is checked, the program now enters the area code 
only for the home number.

4. Made some enhancements to the serial number request/registration 
process. There is a new serial number entry dialog, and a printable form that 
can be sent/faxed to Fusion Technik to obtain the serial number.

5. Now all assessment (IEP) forms have the “Incomplete” checkbox at the 
top, allowing the form to be saved even when the user hasn't completed all 
required fields. Even with the box checked, there must be a student name 
and meeting date.

6. For all SELPAs, the [Assessment]Meeting_date field now updates the 
student field, [Student]Last_IEP_D, upon saving the assessment record.

7. Made some minor changes to the dialog box which confirms that updates 
should be made to the student record, upon saving the IEP/assessment form.

4.734 - 2.11.2002
1. Added the SELPA 3013 (Anaheim) Individual Transition Form (ITP). 

2. Added the ability to print transition forms from the browse window 
(previously only Quick Reports were available).



4.733 - 1.30.2002
1. Adjusted the print from the goals and objectives palette, to accommodate 
longer goals and longer benchmarks. If the goal or benchmark is particularly 
long, it may still be cut off in the print.

4.732 - 1.28.2002
1. Added the “DNR” (Do Not Report) checkbox to the enhanced, 
transportation-only data entry form, for student records.

2. Users other than the Administrator now see “Change password...” in the 
File menu, rather than “Users and groups...” The Administrator can also 
access the functionality by holding down the [ALT/OPTION] key during 
menu item selection.

3. For SELPA 3702, new student records that have been created by saving 
IEP forms are no longer marked Do Not Report. For all new students created 
from IEP forms, the program now enters a Plan Type of 1 (IEP or IFSP) on 
the student record.

4.731 - 1.14.2002
1. Added a new [Assessment]Last_export_D field, which SELPA Manager 
automatically stamps with the current date, when it exports (transfers) an 
assessment record. 

2. Enhanced the functionality of the “IEPs...” item in the Actions menu. It is 
now enabled as “Send unsent IEPs...” when the focus is on assessments. The 
program will find assessment records that have a null last export date.

3. For SELPA 3013 (Anaheim), the assessment meeting date (IEP/ITP date) 
now updates the [Student]Last_IEP_D field on saving the assessment, if the 
user permits updates to the student table. For newly created student records, 
the program adds the [Student]SELPA_from as the default SELPA.

4. For SELPA 3013 (Anaheim), made minor adjustments to some IEP pages, 
as requested. The goals/objectives page now has an extra “row” for pen-and-
ink entries, below the dates and percent completion values. 
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5. For SELPA 3013 (Anaheim), fixed a few problems wherein the primary 
disabling condition did not cause an “X” to be placed in the appropriate 
position on p. 5 of the IEP form. Added auto-set checkbox functionality to 
items on p. 5, when editing the primary disabling condition.

4.730 (alpha) - 12.26.2001
1. Added district of residence name to the batch update dialog (student 
fields). Previous versions offered to update the district of residence code 
only.

2. Made requested changes for 2001-02 SELPA 0901 (El Dorado) IEP 
forms.

3. Fixed a problem that was causing the license information display to 
disappear after pressing CANCEL to close the Preferences dialog.

4.729 (alpha) - 12.12.2001
1. Adjusted the goals/objectives printed forms for SELPA 3702 (North 
Coastal), so that certain items are printed in a 9-point font size rather than 
the previous, 7-point font size.

2. Added navigation buttons and modified the display mechanism for goal 
records on the subform (within the assessment data entry form), to permit 
easier entry/review of goals.

4.728 (alpha) - 12.6.2001
1. Rearranged the first tab of the Preferences dialog slightly, to improve ease 
of use when starting a new data file.

2. Added a prompt to perform a SELPA Central-type import when a browse 
window first opens, if there are no records in the [Student] table.

3. Added an option to perform an internal student transfer without dropping 
any enrollments.



4.727 - 12.4.2001
1. Made a variety of requested changes to the SELPA 3013 (Anaheim) IEP 
form, including: 

    - Change capitalization of first page header using a combo box (new field 
usage).

    - Required entry of DOB and home language.

    - Ability to save an incomplete IEP, by checking the INCOMPLETE box.

    - Addition of teacher name to the printed “Services Selected” section, p. 1.

    - Change IEP summary (p. 7) so that the summary notes always print on 
a separate page (which always follows, whether there are summary notes or 
not). 

    - Change to the way that p. 7 prints from the browse list, certain 
information was not being printed.

    - “LH's” added as a disabling condition choice item.

    - Other minor phrasing, spacing, and tool tip adjustments.

2. Added new fields for SELPA 4100 (San Mateo/default) IEP form: 
“Progress dates to match General Education reporting time” checkbox (IEP 
5.1); and a field to enter the student's age as plain text. Made adjustments to 
some IEP pages and updated font styles. The Windows installer now places 
Arial Narrow into the System, if it is not already installed. The Mac installer 
containers print drivers for Optima, which can be used if the Mac does not 
already have this font.

3. Removed pop-up choice lists from certain fields, IEP2 page of the SELPA 
4100 (San Mateo/default) IEP form. Made other minor spacing / font 
adjustments to improve printed forms in Windows.

4. Tested infant compatibility of the SELPA Manager export with 
CASEMIS “d01a”. Changed the export so that a student outside the ages of 
3 to 22 will not have any services listed (Service 01-08) in Table A. With 
earlier versions of the CASEMIS software, this exclusion caused errors 
during CASEMIS verification.
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4.726 (alpha) - 11.29.2001
1. Moved to a newer version of the 4D database engine (6.7.2). This engine 
should eliminate the problem with the fonts changing on print preview. It 
should also fix the problem with unstable behavior after performing a print 
to disk, from a Quick Report.

2. Made some modifications to the underpinnings of the “About SELPA 
Manager...” box, to handle some problems with the 6.7.2 engine.

3. Fixed a runtime error in “AL_ECB_Svc”, related to correcting teacher 
service codes (destination is smaller than source).

4. Fixed a problem that was causing non-current infant services to be written 
to Table B, for the CASEMIS export.

5. Partially implemented 3911 data entry (NOT fully implemented, do NOT 
use this version if you are SELPA 3911).

4.725 - 11.20.2001
1. Revised the IEP forms for SELPA 3013 (Anaheim) as requested. 
Converted the two “rights/notifications” checkboxes on p. 7 of the IEP into 
alphanumeric fields (A40); these two fields may need to be populated for 
existing IEP forms.

2. Modified the Preferences dialog (Tab 2) so that there are fewer buttons for 
editing choice lists.

3. Removed the requirement for an infant setting, when the student is under 
3 years of age (entry into this field is now optional for a student of this age).

4. Added an import that updates the school of attendance or the school or 
residence (or both), for existing students that are identified by their student 
number.



4.724 - 11.10.2001
1. Added 3 more fields to the SELPA 3013 nightly import (home language 
and 2 ethnicities).  (4.724a) Fixed a problem with the thermo progress bars 
not appearing, and with the telephone area code not being properly updated. 
Made adjustments to prevent blank home language and ethnicity 1 or 2 (in 
the import) from replacing non-blank current field contents.

4.723 - 11.7.2001
1. Fixed a problem with the SELPA 3013 nightly import (no space between 
first name and middle initial). Added three more fields before the final field: 
DOB, gender, and grade. 

2. Made an adjustment to the SELPA 3013 nightly import so that it strips off 
leading zero (“0”) characters from the student numbers, as they are 
imported.

3. The SELPA 3013 nightly import now will place the school code into the 
student school of attendance code field, if the code is 7 characters in length. 
Otherwise, the code will appear in [Student]User_Alpha_2 (previously 
Alpha 1; revised for consistency with the CASEMIS Table A import, 
optional fields). If the 7-digit code being imported represents an existing 
school in the [School] table, then the import will complete the student 
school of attendance name and type fields (if this information is available).

4. Started making requested changes to the 3013 IEP form, including some 
field usage changes (not finished as of yet, with this version).

4.722 - 10.25.2001
1. Fixed a problem with the SELPA 2400 (Modesto) IEP verification form, 
which was preventing the extended year boxes from being checked. Added 
two more “template” variants of the form, for making handwritten entries on 
the form.

4.721 - 10.23.2001
1. Updated the SELPA 2400 (Modesto) IEP verification form. 
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4.720 - 10.19.2001
1. Changed the CASEMIS export for 2001-02, so that there can be no spaces 
between ethnicity codes, and so that Services 01-08 are empty for a student 
that is not in the age range of 3-22 years (based upon the Report As Of date). 
Made other changes to fix problems identified on testing.

2. Added a function to Actions menu -> “Update other...”, to revise “old-
style” CASEMIS service codes into the new, 2-digit codes. This feature also 
works by typing “convert service codes” into the Location box, when 
browsing enrollments. Holding down the [ALT/OPTION] key will convert 
new codes back to old codes, although the reverse conversion is not fully 
reciprocal (there are more old codes than new codes).

3. Added warnings for missing alternate assessment information, and for 
missing infant services / service information. Added a warning for more 
than one of the 21-22-23 infant service series. Changed the warning for 
%ORC, for infants.

4. Fixed a problem with the CASEMIS code export descriptions getting 
truncated (Preferences).

4.719 - 10.17.2001
1. Added a diagnostic to the dialog for selecting the type of CASEMIS 
report, to warn the user if there might be an inconsistency between the 
selected report and the Report As Of date. Changed the CASEMIS export 
for 2001-02, so that Tables C and D are not exported in December.

2. Removed address lines from the printed SELPA 1700 (Lake County) IEP 
notification form. Optional words that can be used for searching for the 
student contacts include “student resides here” (resides here checkbox set) 
and “mail or residence” (mailing address, home address, OR resides here 
checkbox set).

3. Fixed a problem with some arrays being inadequately dimensioned in the 
CASEMIS Table A import routine. Added Next IEP and Next assessment (3-
yr) dates as optional fields on the end of the import (5 extra fields, total of 
219 cols. plus return).

4. Added a warning to the student data entry form, if there are more than one 
reportable services of the 21-22-23 (infant) series for the student. 



5. Added an error to the student data entry form, if the plan type is not 
shown.

4.718 - 10.15.2001
1. Changed the CASEMIS Table A import (2000-01) so that it can optionally 
accommodate three additional fields used by SELPA 3013 (Anaheim Union 
SD).

4.717 - 10.9.2001
1. Changed the SELPA Central import search criteria back to what it was 
before v. 4.716 (see below). The 4.716 change introduced the possibility of 
a false match on student(s) that had previously been reissued new record 
numbers, to avoid record number conflicts due to duplicate site numbers.

2. Added Table A, B, C, D exports for CASEMIS 2001-02. These exports 
are preliminary only, since the CASEMIS software hasn't come out yet.

3. Added a delimited text import for SELPA 3013 (“SELPA 3013 / 
Nightly”), which updates certain student and contact fields. If the student 
and/or contact is not found, the routine can create new record(s). The student 
record is located using the [Student]Record_number field and the contact 
record is located using the [Student_contact]Contact_name field; therefore, 
these fields cannot themselves be updated by the import operation.

4.716 - 10.6.2001
1. Revised the user field name handler for [Disciplinary_action] so that the 
user-selected labels/names for these fields will appear in the Query Editor, 
Sort Editor, browse window, etc. Refer to the similar item for [Student] user 
fields, for v.4.709.

2. Made slight changes in the SELPA Central and district-to-district imports, 
so that the program can search for the imported student (as an existing 
record) in additional record number fields. 

 The SELPA Central import initially searches [Student]Record_number and 
[Student]Record_number_prev in a combined, OR-type search. If the record 
is not found, but the [Student]Record_number_400 is available in the import 
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(in the “old” record number format), it then searches this third field. The 
District-to-district import now searches all three fields in a combined, OR-
type query.

3. On the transportation-only data entry form for students, added the 
capability of editing the IEP instructions (lift, seat belt, POP, etc.), and the 
reason that transportation is being requested. For these edits to be made, the 
“Enhanced transportation-only form..” item must be checked in Preferences.

4. Made a change to permit the table names to appear in the Query Editor 
and Formula Editor. Previously, they appeared as blank brackets ("[ ]").

4.715 - 10.1.2001
1. Added special, print-only service codes for SELPA 3702 (North Coastal), 
for the IEP form (p. 1).

4.714 - 9.28.2001
1. Made some adjustments to the SELPA 1700 (Lake County) IEP 
notification forms.

4.713 - 9.25.2001
1. Fixed a problem that occurred when adding an enrollment, when selecting 
the service name to be used for the enrollment. The program was displaying 
(and searching for) the “old” service names. Additionally, the program now 
allows portions of the service names to be entered into the code area.

2. Removed the [Assessment_goal]Measureable_objective field from the 
printing area on goal pages, for SELPA 3702 (North Coastal) IEP form.

3. The first page of the SELPA 3702 (North Coastal) IEP form now prints 
teacher code (when available) rather than teacher name, if it is available.

4.712 - 9.19.2001
1. Fixed a runtime error that occurred when entering a date in the location 
box, with enrollments as the current focus.



2. Added options to the SELPA Central import, so that the user can prevent 
particular tables from being updated. For example, by un-checking the 
Student checkbox on the dialog, the user will prevent existing student 
records from being updated during the import.

3. Fixed a problem that was preventing existing goals from being recognized 
during the SELPA Central or district-to-district transfer operations.

4. Added an “Other” (90) code that was missing for the alternate assessment 
source fields.

4.711 - 9.17.2001
1. Added a new field to the IEP Notice tab of the student data entry form, to 
indicate the purpose of the IEP. Modified the default IEP notice form to 
include active checkboxes for the IEP purpose.

2. Added custom IEP notice forms for SELPA 1700 (Lake County).

4.710 - 9.14.2001
1. Added preliminary IEP forms for SELPA 3013 (Anaheim). A 
[Test_score] table has been added, so the SELPA Central exports and 
student transfer routines have been updated. The import routines should 
accept an export either with or without the [Test_score] records.

2. Because of problems with 251 and 252 ASCII characters being changed 
by some of the web browsers, the student export to the web now uses lower 
ASCII characters as the field and record delimiters. The new delimiters are 
ASCII 124 (|) and ASCII 126 (~); be careful not to use them in your field 
contents, or the import may not function properly. 

3. Added a number prefix to the tabs of the various IEP forms, so that the 
user can use [CNTRL/CMD]-1, 2, 3, etc. shortcuts to move among the tabs.

4. Fixed a problem that was preventing auxiliary DIS services from 
appearing on the printed Student by Teacher report, when the DIS services 
used the new, 2-digit CASEMIS codes rather than the older codes. 

5. (For SELPA 3702 only). The descriptions “mild”, “moderate”, and 
“severe” no longer print on the IEP form, page 1. 
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6. (For SELPA 3702 only). The physical education type (combo box) no 
longer offers the adapted PE items as choices.

7. (For SELPA 3702 only). The [Enrollment]Session_note field can now 
contain multiplexed data: an item enclosed in square brackets (e.g., “[per yr] 
Mabel Hills School”). If the square bracket is found as the first character in 
the field, then the program will substitute the contents (between the 
brackets) as the class frequency, rather than using the default value of “per 
wk”. The rest of the field (after the closing square bracket) will be used as 
the “location” information; previously, the program used the 
[Enrollment]School_name field for the location.

8. (For SELPA 3702 only). Added a print-time check box (“working copy”) 
that causes the program to skip the printing of existing services / service 
recommendations, on the IEP form.

9. Added an option to transfer selected assessment (IEP) records by 
selecting File menu -> “Transfer...” when assessments have the current 
focus in the browse window. The corresponding import routine is File menu 
-> Import... -> “Assessments (...)” During the import process, the student 
record will be created if it does not exist; however, the import will NOT 
update an existing student record or an existing assessment in the target data 
file. If the student is not found by matching on the student's record number, 
then the routine will search by last name, date of birth, and gender, and 
prompt the user to select among possible candidates (if any are found). 

10. Added 3 more telephone numbers (and telephone number types) to the 
[Student_contact] table, for additional compatibility with the SELPA 3013 
IEP form.

4.709 - 9.5.2001
1. Fixed a problem with the Preferences information being non-enterable 
(appears blank when opened) after selecting a user-type field to be displayed 
in the student lists, in the browse window. 

2. Made slight adjustments to the process for selecting an optional field to 
display in the student lists (browse window). These fields will no longer 
appear with any underscore (“_”) characters in them, either in Preferences 
or in the displayed column itself, although the user can enter underscore 



characters in the student data entry form. The field will appear in 
Preferences with its new name immediately after renaming and saving the 
student record, although you must change the browse

window context before the column header will reflect the new field name (if 
a user field is selected).

4.708 - 8.31.2001
1. Added a Preference setting allowing a few more of the fields on the 
transportation-only form to be enterable. This setting also displays the 
“requires transportation” checkbox and agency name fields. Note that this 
option causes certain fields, such as the drop-off/pickup addresses and 
times, to be enterable in more than one location on the same form, a 
potential source of confusion. No changes were made to the printed form for 
SELPA 3911 (Lodi).

2. Added the capability to export and import selected goals. The export is 
available from File menu -> Transfer... when a list of goals is displayed in 
the browse window. The import is File menu -> Import... -> “Goals 
(student)”. If the import routine does not find the student (for whom to add 
the goals) by record number, it will search by last name, gender, and date of 
birth. If it finds any matches, it will prompt the user to confirm the match. 

If the user cancels the confirmation dialog, the import will ask whether a 
new student record should be created, or whether the student should be 
skipped (press CANCEL).

The import does NOT update the student or goal records that already exist 
in the destination copy of SELPA Manager. Additionally, it should NOT 
import the goal if another one having the same goal description, benchmark, 
creation date, and creation time already exists in the data file. 

3. Added a Preference setting that causes items on the goals/objectives 
palette to be pasted verbatim onto a student's assessment goal records 
(without prefix or suffix modification).
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4.707 - 8.16.2001
1. Fixed a runtime error message that appears when adding an enrollment 
for a student, when the enrollment has one of the new, longer descriptions. 
The error appears when entering a teacher that provides the service as one 
of his/her assignments.

4.706 - 8.15.2001
1. Added 2001-2001 academic year IEP forms for SELPA 0901 (El Dorado). 
Fixed some problems with displaying assessment dispositions, when 
printing from the browse window.

2. Made some changes to tool tips (help) on the Preferences dialog. The 4D 
license button is no longer available for users of 4D Client (multi-user 
version).

3. Changed the shortcut for changing records using the arrow keys, from 
[ALT/OPT]-(left/right arrow key) to [CNTRL/CMD]-[SHIFT]-(left/right 
arrow key). There was some interference on the Windows platform with the 
use of the [ALT]-arrow combination.

4. Fixed a problem with the “Other year enrollments” check mark in the 
Data menu, which was being displayed in the wrong position.

4.705 - 8.2.2001
1. Fixed array range check problems associated with discipline status, and 
with batch application of handicap and STAR participation code to student 
records.

4.704 - 8.1.2001
1. Added limited Location box support for the word “blank” -- e.g., 
“Referral D is blank”, “Mainstreamed pct is not blank”, “TR dropoff T is not 
blank”. Works for alpha, text, numeric, date and time fields, for equals or not 
equals searches only. For numeric fields, searches for integer zero (no 
special accommodation for reals). 



2. Fixed a problem with the enlarged description of the disability, which was 
resulting in runtime range-check errors.

3. Added an alert that prevents the user from inadvertently 
removing/replacing an existing, low-incidence disability for a student.

4. Added the first two pages of the 4100 IEP form (San Mateo/Default) for 
web serving. Unless you have purchased and installed the Web Extension 
License from 4D, Inc., the web services will only function for 60 minutes in 
“demo” mode. To initiate another 60-minute demo period, SELPA Manager 
will need to be restarted.

5. Added a “4D licenses” button to the first tab of the Preferences dialog, so 
that the Web Extension License can be entered. However, there appears to 
be a problem that prevents this feature from working right now (the dialog 
is not fully enabled).

6. Holding down the [ALT/OPT] key when clicking on the FIND button in 
the browse window will restrict the action of the Query Editor to searching 
(querying) within the existing selection of records, provided that there is a 
selection of one or more records.

7. Added a search to the Data menu (Data menu -> Find other -> Alternate 
assessment...), that displays a new dialog. The dialog permits searches of 
students have STAR codes 30 and/or 90, and (optionally) who (have/do not 
have) associated, active, alternate assessment goals.

8. Replaced the gender column with grade level in the student listing.

9 Added 5 more user alpha fields and 5 more user yes/no (Boolean) fields to 
the student data entry form and table. This change necessitated the addition 
of a tenth tab to the student data entry form.

10. Changed some field descriptions on the demographics and dates tabs, 
student data entry form.

11. When entering a home language for a student, if the student language 
box is empty, then SELPA Manager will also place the home language into 
the student language box.

12. Added new items to the pop-ups for address type, contact relation, and 
other phone type (student contact data entry).

13. Added another mode for the first browse window: Contacts / students.
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14. Added warnings for potentially non-compliant last IEP and last 
evaluation dates (based upon the Report As Of date specified in 
Preferences).

4.703 (alpha) - 7.19.2001
1. Reorganized the Boolean checkboxes under the Demographics tab, 
student data entry form, so that the CASEMIS-required boxes appear in the 
first column. The tab order now goes by column in this area.

2. Made the authority name/code field for disciplinary actions mandatory 
only if the As Of date is on or after 7.1.2001. Similarly, made STAR 
mandatory for all students (even outside grades 2-11), if As Of date is on or 
after 7.1.2001. The program now checks for STAR code = 30 in conjunction 
with the alternate assessment box being checked (it still checks for STAR 
code 90 if the As Of date is before 7.1.2001).

3. Added shortcuts for the next/previous record buttons on data entry forms.

4. Finished first version of Spanish printed IEP forms for SELPA 3902.

5. Made requested adjustments to data entry and printed IEP forms for 
SELPA 3702.

6. Renamed the discipline report date field to the incident date (event that 
triggered the disciplinary action).

4.702 (alpha) - 7.10.2001
1. Added new fields and changed certain existing fields to conform with the 
CASEMIS 2001-02 data format. This version does NOT yet have the Table 
A-B-C-D exports. The new service codes will coexist along with the old 
service codes, so there is NOT a need to change the service codes for 
existing enrollments. Note, however, that there are fewer “new-style” 
service codes than there are “old-style” service codes, so the reverse 
mapping (to the old) is not fully reciprocal.

2. Made requested changes to the SELPA 3702 (North Coastal) IEP form. 
Started making the printed IEP form in Spanish (only a portion of page 1 is 
finished at this point).



3. Made changes to other IEP forms to permit the use of 6 ethnicity fields, 
for CASEMIS 2001-02.

4. Changed the missing items logic on data entry, to allow items that are 
preceded with the letters “WNG:” to be warnings that do not disable the 
SAVE button. Added % outside regular class = 0 and duplicate ethnicities 
(both students and assessments) as warning items. 

5. Added residence code as a required field in the missing items list, for a 
student record.

6. Corrected a problem introduced in 4.6981, regarding the STAR code. The 
program now checks for the presence of the STAR code when the student is 
presently listed in Grades 02 through 11 only.

7. Begin adding SELPA 3013 IEP form (not available yet).

8. Added the capability to batch print IEP form page(s), from the browse 
window.

 4.701 - 6.17.2001 
1. First version converted for use with 4D v.6.7. Made necessary 
adjustments to form objects for compatibility with 4D 6.7, so there may be 
some apparent changes to printed forms.

2. Fixed a problem with an error message (only in 4D v.6.7.x) related to an 
undefined pointer, when selecting File -> Import from the U/R process.

3. Fixed a problem with Area List scroll bars not being refreshed in the 
SELPA 0904 and 0400 assessment data entry forms, in certain cases of 
switching tabs.

4. Added warning on changing SELPA codes in Preferences, when 
assessment or transition records exist, for unserialized copies of the 
program. Previously, the warning appeared only on serialized copies of the 
program.
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4.6x Revisions

4.6981 - 6.16.2001 
1. Changed the way that students' ages are calculated again, since the 
Department of Education backtracked on the plan to use the previous 
December 1 as the base date. There is now a place on Preferences, second 
tab, to indicate the base date for age calculations. If this item is empty, then 
the program will base age calculations on the Report As Of date.

2. There was an inconsistency in the way student ages were calculated for 
the data validation checks, student/enrollment data entry forms (the Report 
As Of date was being used, rather than the base date from Item #1, above).

3. Added underlining for certain additional field titles on the student, 
enrollment, and disciplinary action data entry forms, to indicate that these 
items contain information that is transferred to the CASEMIS program (or 
is analogous to similar fields in the CASEMIS program). Additionally, 
SELPA Manager now requires STAR participation code to save the student.

4. Added STAR participation code to the batch update dialog, for student 
records.

5. Added a new, check box field, [Assessment_goal]Do_not_report_B 
(“DNR” on the forms), to indicate that a goal is not to be reported as part of 
the alternate assessment information (with the CASEMIS report). DNR 
goals are now italicized in the browse window (when styled text is turned 
on).

6. Enhanced duplicates searches (Action menu -> Duplicates...). When no 
records are highlighted, a new dialog box appears. The dialog enables the 
user to exclude duplicate students that have only dropped enrollments 
associated with them; to search only within the current selection of students; 
and to exclude or include duplicates that are not part of the current selection.

7. Added a special function to display time fields in a Quick Report as blank, 
if the time happens to be midnight. Double-click on the time column, and 
wrap the field name with the function name. An example, for the field 
[Student]TR_dropoff_T, would be:

Quick_Report_time_fix([Student]TR_dropoff_T)



Note that this expression is not case-sensitive; however, the underscore 
characters are necessary.

8. Add a new, auxiliary service location field to the Enrollment table. This 
field is not part of the CASEMIS report. It can be used to provide an 
alternate name for schools that are part of a “county-served” program.

9. When adding a new disciplinary action under the Discipline tab of the 
student data entry form, the program no longer inserts today's date as the 
start date for the action.

10. Added a new search item (Data menu  -> Find other -> Discipline...), 
which enables you to search for students that have more than a specified 
number of disciplinary actions, based upon the action start date and the type 
of action (suspension and/or expulsion).

11. Enhanced the function (Data menu -> Last found set) in the following 
manner:

- [ALT/OPT] - Last found set: This action will place the current contents of 
the two lists in a “durable” pair of sets. The durable sets exist until you reset 
them by selecting this item again. The durable sets exist separately in each 
browse window; if you have more than one browse window open, each can 
have its own durable sets.

- [ALT/OPT] - [SHIFT] - Last found set: This action will restore the durable 
sets, assuming that you are still in the same context (showing the same two 
lists). If you are in a different context, but one of the lists is still the same 
table, then the program will attempt to restore that set of records, and clear 
the other list. 

 4.698 - 6.5.2001 
1. The “Transfer students...” item in the File menu can now be used to 
perform an internal transfer, for districts that manage both the originating 
and the destination districts in the same database. The program will reassign 
a new student record number and (optionally) change the student's district 
of residence as well.
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 4.697 - 6.4.2001 
1. Fixed a problem that occurs when switching contexts in the browse 
window, with 4D Engine 6.7.1 (compiled), from one of the other contexts 
back to students, with “all records” and sorting enabled in Preferences. 
(Added a delay before AreaList routines redraw the lists, if 4D 6.70 or 
beyond is detected.) This problem does not occur with 4D 6.0.6.

2. Added a special request to be able to reissue record numbers for a 
selection of students in the browse window. You should NOT perform this 
task if the students have already been exported to SELPA Central.

3. Made a minor change in the way that “Change grade...” works (Actions 
menu). Students whose primary enrollment has a blank drop date, or has a 
drop date beyond the Report As Of date (in Preferences), will get promoted 
to the next level. Previously, they would get promoted if the drop date was 
blank or was beyond today's date.

 4.696 - 5.9.2001 
1. Fixed a possible problem with the audit trail generating a “red herring” 
error message on server (in UTIL_updateHistory, detecting no selected 
record number for the table).

2. Made a slight change in the way that student age is calculated on the 
assessment form, to better handle the simultaneous addition of a new student 
and to more elegantly handle null dates.

3. Added postal code lookup to the assessment forms.

4. For the SELPA 4100 (default) assessment form, on the Team Certification 
tab, added logic to the “Yes/No” buttons on Items I, II and III, and their 
associated checkboxes.

5. Added logic to the subforms for goals on the assessment (IEP) form, to 
warn for the absence of the alternate assessment/ STAR code of “90” on the 
associated students record. Note that the program will allow you to enter 
alternate assessment content for the goal even if the student's STAR code is 
not 90, even though this situation is considered to be an error. Also enhanced 
this warning capability on the goal entry forms - formerly it worked only 
when clicking on a menu item, rather than on typing the code directly into 
the box.



6. Added a couple of shortcuts to the default (SELPA 4100) goal entry form, 
to allow quick cursor insertions in the goal and alt. assessment content data 
entry areas.

7. Changed the way calculated ages are performed for student records, to 
conform with the new federal requirement that they be referenced to the 
previous December 1 (from the reporting date). Enhanced the update 
messages after the user closes Preferences, when the Report As Of date has 
changed in a way that will impact the previous December 1. Added the 
ability to cancel the age recalculation while in progress.

 4.695 - 4.30.2001 
1. The enrollments data entry form will allow the user to add a primary 
enrollment that has been dropped (drop date is on or before today's date), 
when there is an active primary enrollment. Previously, the program would 
not allow this operation to take place.

2. Fixed a problem that was causing the completeness tests for a record not 
to detect empty text fields (STFields_Filled, etc.).

3. Fixed a problem that was preventing goals from being deleted in the 
browse window.

 4.694 - 4.25.2001 
1. Fixed a problem that was causing slow change to the Enrollments context 
of the browse window, when “Sort on browse” was turned on. The slowness 
was due to sorting on an unindexed field, original start date. Now sorting on 
start date.

2. Enhanced the QR button on the first tab of the student data entry form, so 
that it can populate the second set of Quick Report fields, when the user 
[SHIFT]-clicks on the button.

3. The DATES button on Tab 3 (Dates) of the student data entry form was 
not clearing the new transferred date field (fixed). 

4. Made minor modifications to the student data entry form for enhanced 
readability. The previous record number now also appears (as a replicate) on 
the User 1 / dups tab.
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5. Fixed a problem that was introduced in 4.691, which disabled the auto-
addition of the school type code, when adding a new or editing an existing 
student (entering the school of attendance).

 4.693 - 4.18.2001 
1. Fixed a problem that was preventing a code “20” for alternate assessment 
from being entered (runtime error).

2. Added an option to display a transportation-only data entry form, instead 
of the regular student data entry form (File -> Preferences -> Appearance 
tab). Like the assessment data entry forms, this form scrolls both 
horizontally and vertically. At present there is only a SELPA 3911-based 
form (Lodi).

 Program users that are in the “ReadWriteGrp” or a newly-defined 
“TransportGrp” can edit a limited selection fields on this form. However, 
program users who are members of the “TransportGrp” but are not also 
members of the “ReadWriteGrp” may NOT save changes on the regular 
student form (SAVE button will be dimmed), or save any other type of form. 
“TransportGrp” users have access to audit trail information (in the Student 
context only).

 While the transportation-only mode is active, the program will print the 
Lodi-based form rather than the default transportation form. Also, you 
cannot add new students to SELPA Manager when this mode is active.

NOTE: This feature is a work in progress, and is expected to change 
somewhat over the next few revisions of the program. Please log your 
observations / comments to the HelpServer.

3. Changed the transportation tab of the Student data entry form to 
accommodate eight additional student-level transportation fields.

4. Changed the “Transportation required” item in the Data menu (Data -> 
Find other -> Transportation required) to “Transportation...”. Selecting this 
item now causes the program to display a dialog. You can search for students 
whose transportation required box is checked (same as previous versions); 
or search for students with transportation field changes on or after a 
particular date. For the latter search option to be effective, you need to have 
the “Audit trail” option turned on in Preferences. 



5. Fixed a minor inconsistency related to access privileges in File -> 
Preferences, related to unserialized data files and non-administrative users.

 4.692 - 4.13.2001 
1. Revised the list of language codes so that it corresponds to the state list 
(there were a couple of additions/deletions, as well as a typographical error).

2. Added an option to display one additional student field (of the user's 
choice), after the third column (student number) in the students browse 
listing. You can set this option in File -> Preferences -> Appearance tab.

3. Added a new student field, [Student]Transfer_D, representing the date of 
transfer to another school district. The program “stamps” this field when 
student(s) are exported to another district. For the SELPA Central and 
CASEMIS exports, there are new options to prevent students with transfer 
dates (up to and including a specified date) from being exported.

4. The “Students to district...” File menu item has been changed to “Transfer 
students...”.

5. The web server now omits dropped enrollments when generating a 
selection of students for a teacher (enrollments that have a blank drop date, 
or a drop date greater than today's date).

6. Added explanatory information to the browse window (under the “?” 
button), explaining the meaning of the color/styled text settings. Scroll 
about 1/5 of the way down through the text that is displayed.

 4.691 - 4.9.2001 
1. First version containing combined IEP form for SELPAs 
0400/4500/5300. There is also a new goals form for these SELPAs. This 
version contains additional IEP fields and therefore will not correctly import 
the district -> central export from previous versions.

2. Because of the changes needed for #1, there is a conversion process for 
two Boolean fields in the 3702 data. This conversion takes place on start-up.
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3. Modified/enhanced the default IEP notice form (when printing a selection 
of student records). An additional dialog appears prior to printing, to specify 
the extra information for the form. Fixed an errant item on the printed form.

4. Fixed a problem in Preferences that prevented the re-serialize warning 
message from appearing, in conjunction with a new warning message about 
existing [Assessment] records, when the user selects a different SELPA 
from the pull-down menu. The second warning message has changed as well 
- it now includes a warning about the presence of [Transition] records, and 
offers a means to cancel the change.

5. There is a new option in Preferences to display (but not to store) the 
calculated age of the student based on today's date (rather than based upon 
the As Of date).

6. Fixed a problem with more than one record being printed when printing 
an assessment goal directly (not from the IEP, but from the data entry form).

7. Fixed a problem (with 4.68 and 4.69) that caused a new student not to be 
saved after adding a new assessment form, when the assessment was entered 
by typing “new assessment for...(student's name)” in the browse window.

8. Worked around a problem that prevents the OK button on a dialog from 
being enabled, when selecting the district of residence for a new student, 
while adding a new assessment. The work-around is that the OK button is 
not disabled in any case. The dialog now also capitalizes the first letter of the 
first and last names.

9. Added support for the phrase “new IEP for...” in the Location box.

10. Fixed a problem that was causing records to remain locked under some 
circumstances on the multi-user version, after one user views/edits an 
existing student.

 4.69 - 3.23.2001 
1. Changed the SELPA 3702 import so that a student with a non-DIS type 
primary enrollment will always get the Case Manager as the provider for the 
enrollment (teacher), provided that there is a non-blank case manager name 
(otherwise it is “Teacher, Unknown”.) Previously, the import used the 
provider for the student's first DIS service (DIS1).



 4.68 - 3.22.2001 
1. Fixed a problem related to very slow display of the browse window when 
changing from other contexts to the Student or Enrollment context, on 
Windows only. This problem also manifested itself when the browse 
window first displayed on Windows, since Students is in the first context 
displayed.

 The solution to this problem allowed for colored/stylized text in most other 
browse window contexts (formerly it was present for students only). The 
styling can be turned off on the Appearance tab, File > Preferences.

2. Fixed a problem that prevented user info from being displayed as a 
browse window context. Type “get user info” in the Location box to display 
user-related information.

3. Fixed a problem with tab order on the student contact forms. Also 
disabled auto-capitalization on the email fields.

 4.67 - 3.19.2001 
1. For the SELPA 3702 import, the second user alpha field is now called 
“SDC type”. If the student has a 430-type primary enrollment, and the SDC 
type is “Reg”, then the enrollment will be checked for Regional SDC.

2. For the SELPA 3702 import, fixed a problem with the teacher code prefix 
not being read correctly.

 4.66 - 3.16.2001 
1. Made some minor adjustments in the default IEP verification forms. They 
now carry the STAR code/description, and the days and minutes for 
extended year. Fixed a problem that was causing the printed values of the 
“parent”, “guardian”, and “other” boxes to be incorrect. These items now go 
with either the “resides with” setting on Tab 1 of the student, or the contact 
relation field of the “lives with” contact for the student.

2. Added two new enrollment fields, [Enrollment]Evaluation_D and 
[Enrollment]Regional_SDC_B. The latter indicates regional (rather than 
local) special day class, and can be set for a primary enrollment of type 430 
only. For SELPA 3702, if the user checks the Regional SDC box on an IEP 
Revision History 829 

• 
• 
• 
•
•
•



830  

• 
• 
• 
•
•
•

form, the program verifies that there is an active primary (no drop date or 
drop beyond As Of date) with service code 430. If so, it checks the Regional 
SDC setting for the enrollment. Conversely, it also un-checks the enrollment 
Regional SDC box if the user un-checks the Regional SDC box on the IEP 
form.

NOTE: The addition of these two fields prevents District-Central or District-
District exports/imports from working properly with earlier versions of 
SELPA Manager.

3. For the SELPA 3702 import, switched to reading the program exit date as 
the drop date for all services. Previously the import used the “end” date for 
each service as the drop date. Added an option to use some other prefix than 
“NewTeach_” when creating codes for new teacher records. Added a 110th 
column for agency services. The import now allows for alpha characters in 
the school of attendance.

4. Changed the use of the agency services field ([Assessment]) for SELPA 
3702 to accommodate more than one choice.

5. Limited the use of the [Assessment]3702_Regional_SDC_B field to 
students with a 430 service code for their active primary enrollment.

6. On the CASEMIS Table A export, changed the criteria for selecting the 
DIS 1-8 services to filter enrollments based on start, original start, and drop 
dates, in a similar manner to the enrollment criteria used to get the original 
student selection. 

7. Fixed a problem that cropped up with the batch continuation of 
enrollments (it was asking too many questions).

 4.65 - 3.9.2001 
1. On the CASEMIS Table A export, SELPA Manager was mistakenly 
writing the Workability field twice (once in the correct location, once in 
place of Alternate Assessment). This error has been fixed.

2. Added the Alternate Assessment table after Table C, on the end-of-year 
CASEMIS export for 2000-2001 (only). The structure of this export table is 
expected to change for the 2001-2002 year.



3. Fixed a problem with tabs not responding immediately on user click, after 
adding goals from the goals/objectives palette onto the Goals data entry 
form (SELPAs 4100/default and 3702).

 4.64 - 3.6.2001 
1. Fixed a problem related to detecting the wrong number of tab characters, 
for the 3702 import. 

2. Changed Col. 8 of the 3702 import from “Address type” to “FC/LCI 
number”.

3. Added the revised IEP forms for 4100 (San Mateo). The referral and 
transition forms are now in the [Transition] table. Added printed forms for 
each platform and on-line page help.

4. Added a FEP (Fluent English Proficiency) field to the [Student] table.

5. Fixed a problem with the DIAL button on the transportation tab of the 
Student data entry form (it wasn't working).

6. Fixed a problem with “new transition for [student name]”, when the 
student was not recognized. The program incorrectly displayed the “add 
new student” dialog for assessments.

7. Added an option to enter “new referral for [student name]” in the Location 
box. For the default (4100) transition/referral forms, this request also moves 
the form to page 2 and adds a referral meeting date.

 4.63 - 3.1.2001 
1. Fixed some problems related to using the goals/objectives palette when 
adding a new goal, directly from the browse window (not from the 
goals/objectives tab on the assessment data entry form).

2. Added district/central, district/district, and web export/import capability 
for the new [Transition] table.

3. Fixed a few lingering problems related to adding new assessments and/or 
transitions for a particular student, directly from the browse window. 
Reorganized the before-phase actions for this purpose.
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4. When the user selects File > Import, the program automatically switches 
to the user/runtime process / environment, to improve the speed of the 
import.

 4.62a7 - 2.28.2001 
1. Added extended year days and minutes fields to Student table, which map 
to the equivalent fields on the SELPA 4100 and 3207 IEP forms.

2. Added physical education type field (as a combo box) to the Student table. 
The field maps to all three current IEP forms (SELPA 4100, 0901, 3207).

3. Added a custom import for SELPA 3702. 

4. Fixed a problem that was causing the district of residence name to be 
empty when adding a new student. Also made slight changes in the way the 
district of residence is handled in the SELPA 0600 import (was defaulting to 
district of attendance for the student record number).

5. Fixed a problem that was causing the combo boxes to be blank when the 
field actually is not blank, after executing, “new assessment for [student 
name]”, or “new transition for [student name]” in the Location box.

 4.62a6 - 2.19.2001 
NOTE: This version has only partially implemented changes to the 4100 San 
Mateo (default) IEP forms. Therefore, if you are using this form, you should 
NOT upgrade to this version of the program.

1. Fixed a problem present in earlier versions that, for the December 2000-
2001 CASEMIS report, would write DIS services that were dropped for the 
DIS 1 through DIS 8 slots. This problem would not have been present in the 
December 1999-2000 report. Dropped DIS services are still written to the 
end-of-year report.

2. Attached additional warnings to the dialogs for the “duplicates...” student 
record association process, to discourage the use of a student with expired 
primar(ies) as the master student. The program uses the latest primary of the 
master student to determine the school of enrollment in the CASEMIS 
export.



3. The program now offers an option to display assessments above students 
(more convenient for teachers that complete IEPs).

4. Separated student name field for [Assessments] into separate last and first 
name fields, to match the fields in the [Students] table. The 
[Assessment]Parent_name field was moved in conjunction with this change, 
so the contents of the parent field are moved during the 4.6x upgrade from 
previous versions.

5. Enabled “get current” for assessment records.

6. Fixed a problem with new-context searches on district name (“district 
is...”).

7. Added a temporary change for the first browse window preference 
(“students” context), so that if “Students / contacts” is selected, and the user 
enters “assessments” or “assessment for...[student]” in the Location box, 
then the program will switch to displaying assessments / students. After 
changing to another context and then back again, the browse window will 
revert to the user's original preference.

8. When certain fields are updated on the student record, the program asks 
if the assessment (IEP) and assessment goal records should also be updated 
(last name, first name, SSN, DOB, original entry date, gender, ethnicity).

9. Assessments can now be added without first highlighting the linked 
student on the student browse list (although this approach will still work). 

To link a student with the new assessment (IEP) form, the user can type the 
name of the student directly onto the IEP form. If SELPA Manager finds the 
student, it copies values of the [Student] fields into the associated 
[Assessment] fields (e.g., SSN, DOB, original entry date, gender, ethnicity, 
etc.). 

If the user selects a different, linked student for the assessment form while 
it is still new (unsaved), then SELPA Manager replaces the values in the 
associated fields with their equivalents for the other student. 

If the user selects a different student for an EXISTING (saved) assessment 
form, then SELPA Manager will ask for confirmation that the associated 
fields on the assessment form should be replaced with values for the other 
student.
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If the student does not yet exist, then SELPA Manager will ask the user to 
select a district (for creating the pending new student's record number). The 
program will create the new student at the time that the assessment form is 
saved.

10. There is now a separate table for preparing transition plans / creating 
transition records for a student. Thus, the transition information can be 
prepared independently of the rest of the IEP (assessment). Added transition 
form for SELPA 3702 (North Coastal); forms 4100 (San Mateo) are still 
incomplete (in progress). To access transition forms, go to File> Preferences 
and select Transitions / Students or Students / Transitions for the first browse 
window. You can also type “transition” or “new transition for [student 
name]” anytime into the Location box (without setting Preferences), and the 
browse window will switch contexts temporarily.

11. Allow the special CASEMIS Table A district of service substitution to 
all users, as an optional preference (formerly SELPA 4500 only).

12. The IEP psychologist, translator, nurse (etc.) fields are now 40 characters 
long, rather than 25 (applies to [Student], [Constant] (preferences), and 
[Assessment] tables. 

13. Fixed an obscure problem that occurred on the Enrollments tab of the 
Student data entry form, when selecting File > Print from the menu, 
canceling the print dialog, and then pressing the CANCEL button on the 
data entry form.

14. Added IEP (assessment data entry forms) for SELPA 3702 (North 
Coastal). These forms include the ability to add/edit enrollments. The 
enrollments are updated for all contexts (that is, they are not fixed in time 
with the rest of the assessment form).

15. The case manager now must be an existing name in the [Teacher] table. 
If the name isn't there, the program offers to create a new teacher and then 
make the link. Revised district-to-central and district-to-district imports to 
handle the linking, for both the student and the assessment tables. 

16. Added update functionality for [Assessment] and [Transition], when the 
user changes the school name and/or school code, in the [School] record.



17. Added the ability to type “new assessment for [student name]” into the 
Location box, to go directly into a new assessment form. If, however, the 
student is new, and the program presents the district selection dialog, the OK 
button will be dimmed (you will need to double-click on the district name 
to make your selection).

 4.61- 1.10.2001 
1. Added a CASEMIS Table A import (based upon the 2000-2001 format, 
with 196 columns, not including return character). The import can also work 
if there are 199 columns, to accommodate an extra/optional field used by 
one SELPA.

2. Fixed a problem with the Type 19 school selection (during CASEMIS 
import or selection on the Demographics tab of the Student data entry form), 
which was causing a runtime error.

3. Added the capability to use the words “today”, “yesterday”, and 
“tomorrow” in the browse window (location box) searches.

4. Added an “Audit trail...” item at the bottom of the Actions menu., to keep 
track of field-level changes to each record (in selected tables). The tracking 
does NOT work for text and picture-type fields. You must turn on audit 
tracking on the second tab of the Preferences panel before the program will 
begin logging field-level changes. This function may noticeably slow the 
program when saving an existing record.

5. Added audit trail buttons (“Au”) for certain locations on the Student and 
Teacher data entry forms, so the user may highlight a listed record and press 
the button to get audit information. 

6. In the browse window when displaying students, the student record has 
red-colored text if it is “marked” (upper right on data entry form). The 
student record will appear in italics if it is designated as do not report 
(DNR). 

7. With the districts-to-central export (File menu), users now have the option 
of exporting or not exporting students and enrollments that are marked “do 
not report.”

8. Added date formatting on the drop box date (for an enrollment), with date 
range checking.
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9. Fixed a problem with variable definitions that was preventing the web 
student export from working, when running with 4D Server (4D Engine was 
working properly).

10. Switched the formulation of the student record number from 7-7-2 to 7-
5-4 (district code - next student number - site code), so that the site number 
can range from 1 to 9,999. In previous versions of SELPA Manager, the 
range of the site number was from 1 to 99. When opening a data file prior to 
4.6, SELPA Manager 4.61 will automatically convert students to the new 
numbering system, but ONLY for the site number of your copy of the 
program (File menu -> Preferences). Record numbers that were generated 
from another site number will not be updated, except if you import them in 
a district-to-central import, AND they have been renumbered at the district 
level already.

11. Added a special repair procedure for Lompoc USD, date fields 
(UTIL_LompocCleanDates). These dates appear to be in the 
YYYY/MM/DD format, for unknown reasons. This change is similar to a 
simultaneous update in 4.01 B32. Key words: “Lompoc fix” or 
“YYYY/MM/DD fix” in the browse window.

12. Fixed some problems with the CASEMIS Table A import. Type 410 
enrollments were not being linked to schools. Schools with alphanumeric 
codes were missing the alpha characters. Added more specificity to the 
detection of duplicate students (first name field), and allowed for duplicates 
to be imported if the user so specifies. This change is similar to a 
simultaneous update in 4.56.

13. Fixed a problem that was causing the browse window context to switch 
to program users, when the user searched for a student or other item whose 
name contained the letters, “user”.



 4.60- 11.29.2000 
IMPORTANT: SELPA Manager will initiate a conversion process after 
opening your 4.01 or 4.5x data file for the first time. The program will warn 
you about the conversion process, and give you an opportunity to exit the 
program without converting. 

If you proceed, it is important to let the conversion process run without 
interference. Wait a few minutes before using the program (you will see some 
progress bars appear on the screen, followed by a confirmation dialog).

1. Retired the [Goal] table, replacing it with the [Assessment_Goal] table. 
The latter can be accessed from the IEP form (a tab under the [Assessment] 
section), or directly by pressing the GOALS button on the browse window. 
Goals that are added directly from the browse window (using the Goals 
section, rather than the Assessment section) are associated with the student, 
but _not_ with an IEP form (Assessment record). You can later associate the 
goal with an IEP form by pressing the (A+) button, on the IEP form.

Goal records that existed in the old [Goal] table will be converted on start-
up to [Assessment_goal] records. 

2. Fixed a problem with the goals and objectives palette which prevented the 
user from adding a new item to a blank palette; prior to the change, new 
items could only be added if there were at least one existing item to 
highlight.

3. Fixed a problem with the goals and objectives palette, which on user 
deletion of a high-level item caused some of the lower-level items in the 
same hierarchy to remain in the table.

4. The goals and objectives palette now can be accessed when adding a goal 
in the new Goals section. When adding from the palette, the form will switch 
to the first available benchmark page (where the benchmark field is empty).

5. Revised the San Mateo/default IEP data entry and printed forms, through 
Tab IEP 5 (goals/objectives) only. There is no longer a fourth benchmark 
and associated date/progress fields.

6. The default/San Mateo assessment (IEP) form no longer uses certain 
language proficiency and support fields that were present on earlier releases.
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There are additional forms to be added, but some of these forms remain 
under discussion and therefore are not ready for incorporation into SELPA 
Manager.

7. Added Goals section printed forms for SELPA 4811 (Vallejo). These 
forms also print from the IEP 5 tab in the Assessments section. Because 
Vallejo uses only 5 of the possible 6 evaluation dates, the “Benchmark 3” 
tab of the Goals data entry form is not accessible. On the printed forms, 
underscore character(s) after a date (e.g., “08/17/1999__”) indicate that the 
dates for the benchmark progress fields in the corresponding column do not 
match.

8. Added field filtering (to exclude undesirable characters during data entry) 
to the included forms for goals/objectives, in the Assessments section. On 
the San Mateo / default form, this tab is IEP 5. On the SELPA 0901 (El 
Dorado) forms, this tab is the seventh (Goals/Objectives).

NOTE: If you experience “jerky” included form behavior when using the 
[BACKSPACE] key in an enterable field, try resizing the window first, so that 
the field is more toward the middle of the window.

9. There is now an option in File > Preferences... > System Settings to 
disable the pop-up choice lists for the goals/objectives included forms 
(“Disable goal/obj. pop-ups”). Checking this option box also enables 
“begins with”-type searching on the non-date fields that formerly had the 
pop-up choice lists, so that the user may enter the first few letters of a listed 
item, then press the [TAB] key.

10. Added alternate assessment content, mastery, and “not met because” 
fields to the included forms and the data entry forms, for [Assessment_goal].

11. SELPA Manager now exports and imports the [Assessment] table and 
related tables ([Assessment_goal], [Assessment_other_disability], 
[Assessment_disposition]). It no longer exports or imports the [Goal] table, 
which is being retired. You cannot import or export between 4.6 and earlier 
versions of SELPA Manager. This change affects district-to-central, district-
to-district, and students from web exports/imports.



12. Added a district of residence name field to the [Student] table. It appears 
on the demographics tab of the data entry form, and works similarly to the 
school fields (code and name). For new student records, the district of 
residence must exist in the [District] table, or the program will offer to add 
it as a new district.

13. Re-enabled a validation check for preschool setting, for a child ages 3-
5. This check was introduced about a year ago, but had been disabled for the 
past year.

4.5x Revisions

4.54a - 12.6.2000 
1. Changed version of 4D Engine, back to 6.06r7 PPC, to avoid a crash with 
the Label Editor.

 4.54- 11.17.2000 
1. Eliminated the 3 new [Student] fields related to alternate assessment 
activities, which are to be part of the 2000-2001 end-of-year reporting 
requirements. These fields should appear at the assessment (IEP) goal level, 
rather than the student level. They will reappear in upcoming v.4.60 in a 
more appropriate location.

2. Made adjustments to the printed IEP verification form for SELPA 4811 
(Vallejo), Windows.

3. Made minor adjustments to the printed IEP5 form.

4. Removed % Mainstreamed from the December 2000-2001 Table A export 
for CASEMIS (no longer a required field). Added the 2000-2001 year as an 
item in the pop-up.
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 4.53- 10.30.2000 
1. Added a new option to the Preferences dialog, which allows the 
administrator to disable age mismatch checking when editing existing 
students, and when editing/adding enrollments for existing students. If the 
student record is new (not yet saved), then the age mismatch error checking 
will still take place, even if the new preference is checked.

    When you are editing a student, the record information (at lower left on 
the form) will indicate whether age mismatch checking has been disabled.

2. Made minor changes to SELPA 0901 (El Dorado) assessment form, #1 
and #3.

 4.52- 10.20.2000 
1. Revised the printed cover sheet for SELPA 2400 (Merced) to include both 
lines of the QR address fields (where available).

2. Increased default stack size from 64K to 256K, to reduce stack full errors 
during web serving.

 4.51- 10.17.2000 
1. First general release of v.4.5x.

 4.50 A13- 10.5.2000 
1. Made adjustments to the printed cover sheet for SELPA 2400 (Merced).

2. The Query, Quick Report, and Sort Editors now display fields in alpha 
order. When a field is prefixed with a SELPA number: (1) It is not displayed, 
when the SELPA number is foreign; (2) It is displayed, without the prefix, 
for the native SELPA. You will still need the full syntax (with prefix and 
underscores) when using the Special Operations dialog.



 4.50 A12- 10.4.2000 
1. Added a menu bar for the goals and objectives palette, so that items can 
be copied and pasted. Added “Find” and “Find again” to the menu bar 
(under File), so that the user can search for a goal/objective that contains a 
particular word or phrase.

2. Added a new IEP cover sheet for SELPA 2400 (Merced). Made 
adjustments so that this form can print multiple pages when there are more 
than 4 enrollments that should be displayed.

3. Made adjustments requested by SELPA 0901 (El Dorado), to the 
assessment forms.

 4.50 A11- 9.27.2000 
1. Added portions of the Assessment form for SELPA 0901 (El Dorado). 
Includes approximately 56 new [Assessment] fields and a new 
[Assessment_Disposition] table, which clones enrollments when adding a 
new assessment for a student.

2. Added 3 new [Student] fields related to alternate assessment activities, 
which will be part of the 2000-2001 end-of-year reporting requirements.

 4.50 A10- 9.17.2000 
1. Added an import for CASEMIS Table C (disciplinary actions). The 
import matches against student record number or (if less than the standard 
18 characters) against student number (with leading zeroes removed).

2. Added a leading zero removal to the student ID number, when importing 
the fixed-column CASEMIS (98-99) format, so that SELPA Manager does 
not think leading zeroes constitute a 16-digit record number.

3. Added a special routine (UTIL_xfer_PRN_to_sn), to batch transfer 
previous record numbers with leading zeroes (mistakenly placed by earlier 
versions of SELPA Manager), from [Student]Record_nbr_previous into the 
[Student]Student_number field instead.

4. Made a slight modification to the appearance of the printed IEP5 form 
(Assessment section). 
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5. Added a few more alert and confirm messages for the palette of goals and 
objectives. This release comes with the first version of the goals and 
objective import files for both mathematics and language arts standards 
(from the State of California documents). 

 To import the goals/objectives, select Import from the File menu, and select 
the generic goals and objectives import. If you wish to clear out any existing 
goals and objectives prior to importation, hold down the [ALT/OPTION] 
key while opening the palette (you must be logged in as Administrator for 
this to work).

 4.50 A9- 8.28.2000 
1. Added an alternate way of executing special procedures, which is 
accessible when canceling from the dialog asking whether the special 
operations dialog should be displayed. Added a more robust suffix 
reassignment routine (UTIL_newRecNbr_suffix) which is accessible with 
the alternate method.

2. Added a palette of goals and objectives, which can be used in conjunction 
with the IEP-5 page of the student assessment form. Activate the palette by 
pressing the “L+” button on that page of the data entry form. You can import 
goals and objectives into the palette from a 5-column, spreadsheet-style text 
file (FILE > Import > Goals and objectives (generic)).

 4.50 A8- 8.9.2000 
1. Added error-checking code that allows a dropped infant service to be 
entered for a non-infant, provided that the student was an infant on the date 
that the service was dropped. 

2. Fixed a problem that would cause disciplinary actions outside the 
reporting year range to appear in Table C of the CASEMIS year-end export.

 4.50 A7 - 7.17.2000 
1. Fixed a problem that, in a case where a student had more than one primary 
enrollment that was not marked “DNR”, may have caused the program to 
write the wrong drop date to the CASEMIS Table A export. 



2. Revised the Table A and Table B exports to exclude alternate-year 
enrollments.

3. Added an alternate determination of infant status, for a student that has no 
active primary, based upon the latest drop date rather than the Report As Of 
date. The program performs this calculation only after determining that the 
student is not an infant based upon the Report As Of date.

4. Made minor adjustments to some tool tip help statements.

 4.50 A6 - 7.4.2000 
1. Fixed a problem with the enrollment data entry form (and “drill-down” 
form) that was preventing the user from adding a primary enrollment for a 
particular student to the alternate year, when a student had an active primary 
enrollment in the current year. The work-around for this problem with the 
“drill-down” form was to [ATL/OPTION]-click on the ADD (+) button on 
the Student enrollments tab, to add the enrollment directly to the list and edit 
it there.

2. Fixed an interface flaw that caused the disabling condition for a 
previously-added enrollment to appear again when adding another 
enrollment, using the “drill-down” enrollment data entry form when in the 
student data entry form. This information was not being saved with the new 
enrollment; however - a visual problem only.

3. Added SELPA 4900 (Sonoma County) to the list.

4. Added a new field to the [Enrollment] table, 
[Enrollment]Aux_service_code, for accounting (charge-back) purposes. 
The auxiliary enrollment codes (and associated accounting parameters) can 
be edited from the Preferences dialog. The report is accessible from the 
browser, when printing districts (District chargeback report).

5. Added a new field to the [District] table, [District]Holidays_txt, for 
specifying which days of the year are district holidays.

NOTE: With the addition of Items #4, and #5, you can successfully import 
from District to Central only if the district export is v.4.50 A6 or later. 
Exports made with the earlier versions will not import properly.
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 4.50 A5 - 6.21.2000 
1. Fixed a problem that was causing two buttons adjacent to the date fields 
on the Discipline data entry form to move vertically when the window was 
re-sized. 

2. When adding a disciplinary action from the Student data entry form 
(Discipline tab), when the user presses the (+) button, the cursor now moves 
directly into the second column for data entry. 

3. A repeat record addition loop is now optional. That is, if the user accepts 
a newly-created record, the program will not go to the next new record 
unless this option is checked in Preferences.

4. When adding a new record from the browser, it is now possible to link to 
the associated record from the other list without highlighting the associated 
record. For this mode to work, there must be only one record in the 
associated record list.

5. Enhanced error handling for the District data entry form. Turned off 
unique keying in the structure for the district code (now handled 
programmatically).

6. Added two more convenience arrays for teacher services and assignments 
(upper and lower lists on the teacher data entry form, Services tab). These 
arrays allow the service codes to sort independently of the service 
descriptions; and the school codes to sort independently of the school 
names.

7. Made minor changes to the logic of the SELPA plan status combo box and 
the COMPLY BY button (for calculating the compliance date), Student data 
entry form.

8. Made minor changes to the appearance of checkboxes on the 
Demographics tab, Student data entry form. Also added or revised tool tips.

9. Revised the DATES button to clear all dates on the Dates tab, Student data 
entry form. Added or revised tool tips for some dates.

10. Made minor revisions to tool tip help and a field label on the Enrollments 
data entry form (regular and drill-down from Student).



11. Made a minor change to the continue enrollment function, so that it 
carries the original start date forward when an enrollment is continued more 
than once. Previously, it always moved the start date of the enrollment to be 
dropped into the original start date of the continued enrollment. 

12. Enhanced the drop button (Enrollments tab of the Student data entry 
form), so that it can (optionally) not change the source enrollment if it has 
been dropped already.

13. The “Continue enrollment...” option from the browser can now handle 
up to 100 enrollments at one time. Prior to this version, it handled only one 
(highlighted) enrollment at a time. If errors are encountered, the program 
will display the errors, and then give you the option of canceling the 
continuation or proceeding. At the end of the batch process, both the 
dropped and the continued enrollments will appear in the browser.

 4.50 A4 - 3.31.2000 
1. Adjustments for Windows forms, [Assessment] area. 

 4.50 A3 - 3.31.2000 
1. Finished the remaining printed pages for the [Assessment] form (Mac 
only). Added the ability to pick dates for page “IEP 5" from the Calendar 
(description of the event begins with “IEP5”). If this option is unchecked, 
then the list will contain 1 year's worth of dates, starting from the current 
date.

 4.50 A2 - 3.29.2000 
1. Dressed up the Location box with separators and an appended, context-
switching word list.

2. It is now possible to type “Schedule for July, 1989" in the Location box, 
when not browsing the calendar (in another context), and when the Calendar 
appears it should be on the correct month and year.
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3. The browser no longer re-sorts when a search or set manipulation returns 
2000 records or more. Previously, it would sort according to the currently 
highlighted column header, taking too much time in the case of non-indexed 
fields.

4. Fixed a minor visual defect when context-switching to the Calendar, 
using the Location box (two buttons could be pressed simultaneously).

5. Added IEP forms for SELPAs 4500 and 5300. Be sure to scroll down to 
the special instructions on the print dialog, to read the field mapping key.

6. Fixed a problem that was causing attendance registers not to renumber the 
rows at Line 1, when there are exactly 25 students in the previous category 
(a track or a class).

7. Fixed a problem that was causing the title bar to be temporarily blank on 
a new window, when adding a student contact or an enrollment from the 
student data entry form (affected Windows users only).

8. Added a feature to the “Move to alternate year” process that will clone 
(rather than move) the highlighted enrollment records, into the alternate 
year. The program will ask whether it should move or clone (copy) the 
highlighted enrollments. Accepting this request causes the enrollments to be 
cloned; canceling the request causes them to be moved.

9. Added the ability to set/clear the start and drop dates for a selection of 
enrollments, from “Apply teacher...”. 

10. Fixed an undefined variable problem when selecting “Drop...” without 
highlighting an enrollment.

11. When switching to the alternate year (Data menu), the program now 
displays the user's preferred selection, as on switching to a new context.

12. When opening a saved set of enrollments, the program will no longer 
allow display of current year enrollments in the alternate year, or vise-versa.

13. Made certain corrections as requested to the data entry for [Assessment] 
(IEP report). The first page of the IEP now prints (data entry only). There is 
a problem in which the “combo boxes” do not work after scrolling. When 
opening the form or switching to a new page (tab), edit the combo boxes 
before scrolling the form. 



14. Fixed a problem with the default IEP verification print form (prints from 
the Students section), which was causing the checkboxes for school type and 
residence status to be marked incorrectly (when printed).

 4.50 A1 - 3.1.2000 
1. Introduced first pass at an assessment section. You can activate this 
section from Preferences (Appearance tab). It appears below the students 
context (browser listing) when turned on. You must first highlight the name 
of a student in the upper list, before you can create a new record in the 
Assessment list / table.

When creating a new Assessment record, the program will copy certain 
fields from the Student record, such as SSN, grade, gender, school of 
residence, school of attendance, etc. It will also copy parent information 
from Student Contacts, provided that one contact is marked as “resides 
here” with the checkbox. Once these fields are copied into the Assessment 
table, changing their values in the Assessment section does NOT change the 
corresponding value in the Student record / section. The converse of this 
statement is also true.

The Assessment record has just one field for the student's name (first plus 
last); you can edit this field to obtain the desired appearance for the printed 
IEP form. (Note that there is not yet a printed form.)

2. Added enlargement preference for resizeable Type 8 windows / forms. 
Added underlining of browser buttons.

3. Made some logic changes to the UTIL_showRelateds routines, which 
display related records in the browser.

4. Added the ability to import a SELPA logo in Preferences. This logo will 
be printed at the top of the IEP form.
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4.0x Revisions

4.01 B17 - 2.9.2000 
1. Revised the way that the CASEMIS Table A export obtains the primary 
enrollment, in the case where there are linked (dependant) student records, 
so that the primary is always that of the reportable (master) student. This 
change may affect the reported primary enrollment and associated 
school/district information for a master student record (with linked 
dependants). However, non-linked students should remain the same.

4.01 B16 - 1.25.2000 
1. Added a special option that allows the CASEMIS Table A export to use 
the first seven digits of the [Student]Record_number field as the district of 
service. This option is available from the Preferences dialog, only when the 
selected SELPA is 4500.

4.01 B15 - 1.19.2000 
1. Added a special option that allows a 173-column CASEMIS import, for 
Anaheim Union. The extra three columns are placed in User Alpha Field 1. 

2. Further modified the CASEMIS import to handle the creation of schools, 
if the school of service does not already exist.

3. Fixed a problem that was causing the calendar to display 3 months' worth 
of days (rather than a single month), when initially viewed on any day in 
December.

4. Fixed a problem that was allowing only the current calendar month to 
print, regardless of what was actually being displayed.

5. Adjusted the width of certain text elements in the "Show current for...." 
dialog.

6. In Preferences, after the user has changed the site number, the program 
will now search for any students whose record numbers have the old site 
number as a suffix, and offer to revise them. You should NOT perform this 
update if you are a SELPA Central. If you are an individual site, then all the 



other sites in your SELPA region should have a unique (different) site 
number. If this is not the case for your region, then you should coordinate 
with your SELPA director to obtain a unique site number. Then update your 
Preferences (and the affected students, by using the automatic update).

7. Fixed a minor visual problem with the browser window, which (in certain 
circumstances) would cause a column to be underlined even when the 
browser was not sorted by that column. The problem occurred when default 
sorting is turned off in Preferences, but the user performed a manual sort, 
and then switched to a new context.

8. Fixed a minor problem that caused the old interface setting not to be 
restored, after the user changed the platform interface in Preferences, but 
then canceled the dialog.

4.01 B14 - 12.15.99 
1. Added a special option that allows the user to specify (by ASCII number) 
the record and field delimiters for this SELPA Central import. This option 
can be invoked by holding down the [SHIFT] key after selecting SELPA 
Central import, while pressing the OK button on the dialog. The option may 
be necessary if the import file has been sent by an html-based email package 
that converts all the high-ASCII delimiters to low-ASCII. For example, the 
standard 251 and 252 delimiters may have been converted to 176 and 184. 
It is preferable to send the import file with an email package that does not 
modify the integrity of the file; or to archive the file (".sit" or ".zip") before 
sending.

2. Changed the error checking for the Student data entry form so that (1) a 
kindergartner can have a non-zero value in the % outside regular class field, 
regardless of age; and (2) an infant must have at least one infant-type 410 
enrollment.

3. Changed the CASEMIS 1999-2000 Table A and Table B exports so that 
(1) only allowed student DIS services are exported in Table A; and (2) only 
allowed infant DIS services are exported in Table B. In previous versions, 
an infant DIS service that was not a student DIS service (e.g., 410-30) could 
be written to Table A, which would result in an error message in the state 
CASEMIS verification program.
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4.01 B13 - 12.14.99 
1. Fixed a tab order abnormality when when selecting the Demographics 
tab, Student data entry form. Now you must tab into the grade level combo 
box; the next [TAB] key takes you to the next combo box.

2. Fixed a problem that caused the school type to be improperly saved on the 
student data entry form, Demographics tab, when the user manually typed 
in the school type code. The problem did not occur if the user selected the 
school type from the list. 

  Adjusted the coding of the other combo boxes on the same page slightly 
(the other combo boxes were not displaying the same problem, however).

3. Fixed a problem that occasionally caused the tab to be incorrectly 
positioned on the data entry forms for Students, Enrollments, and Teachers. 
The problem occurred only after viewing an existing record, on a tab other 
than the first, and then double-clicking to open another record.

4. Fixed a minor visual defect related to errant error messages, when saving 
a student record from the data entry form.

4.01 B12 - 12.13.99 
1. Added the infant service specification fields to the drill-down form 
(adding an enrollment to the student data entry form). 

4.01 B11 - 12.11.99 
1. Added a more accurate determination of infant age eligibility for the 
CASEMIS Table B export. The algorithm used is now the same as the 
"recalculate ages" item in the Actions menu.

NOTE: Be sure that you designate at least one 410-xx type service for an 
infant. Otherwise, the infant will not be included in the CASEMIS Table B 
export file.

4.01 B10 - 12.9.99 
1. Added the capability to write a text file of CASEMIS codes to disk, from 
the Preferences dialog.



2. Modified the list of SELPAs for new users.

3. Changed the SELPA 0600 import to allow the use of alphanumeric 
student numbers (formerly numeric only).

4.01 B9 - 11.20.99 
1. Fixed a problem that was preventing the entry of a number greater than 
99 for the percentage outside of regular class field (now the upper limit is 
100 percent).

2. Underlined "Mainstreamed" field. This field is required, but can have a 
value between zero and 100 percent. However, the CASEMIS export will 
write values greater than 99 percent as 99 percent (this situation has not 
changed).

3. Added a new exit reason to the list (81).

4. Added some new non-DIS placement codes. Revised the descriptions for 
Codes 440, 441, and 442. 

5. Changed the names of the "handicap" fields to "disability ", along with 
associated error messages, diagnostics, column titles, etc.

6. Made additional modifications related to the SOLE_LOW checkbox field. 
This field is no longer enterable if the primary disability is not a low-
incidence one; the low incidence box must be checked before the 
SOLE_LOW checkbox will be enabled.  

 In the CASEMIS export, the program still writes a blank space for 
SOLE_LOW, if the student is not of the proper age. It will also write a blank 
space if the disability is not a low incidence one. 

 Subject to these restrictions, the program will write a "T" if SOLE_LOW is 
checked; an "N" if it is not checked.

7. Fixed a cosmetic bug (Windows) on the update Quick Reports fields 
dialog.
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4.01 B8 - 11.18.99 
1. Fixed a problem that was preventing students with a dropped primary 
enrollment from being saved (without checking DNR).

2. Made a modification to the CASEMIS Table A export (1999-2000) so that 
if the student's calculated ("As Of") age is not in the 0-2 year range, then the 
program will report a blank space (rather than an "N" value), for the 
SOLE_LOW field. The CASEMIS software reports a SOLE_LOW value of 
"N" as being in error, if the student is not an infant.

3. Fixed a runtime error that occurred when selecting a location code for an 
infant service, from the Enrollments tab of the student data entry form.

4.01 B7 - 11.10.99 
1. Added a second set of Quick Report fields ("QR2..."), for placing an 
alternate address of the user's choosing. Enhanced the "Update other..." 
function in the Actions menu with an additional dialog.

2. Added the capability to print user-entered, choice-list items using the 
Quick Report Editor. This feature appears in Tab 2 of Preferences.

3. Added the capability to update "other" fields as a batch. Select "Update 
other..." from the Actions menu when displaying Student records in the 
browser.

4. Changed duplicate student search so that (a) it will not search for SSN if 
the SSN is blank for the source student(s); and (b) it will identify duplicates 
for one highlighted student row in the listing (showing the highlighted 
student as well as the duplicates).

5. Changed Action menu item, "Check for duplicates..." into "Duplicates...", 
and enhanced its capabilities. Highlighting more than one student row with 
the same last (family) name will cause the program to (a) offer to associate 
duplicate students, if none has any previous associations; or (b) offer to 
remove existing associations, if there are existing associations among the 
highlighted students.



6. Revised the CASEMIS 1999-2000 exports (December and year-end) to 
get enrollment and disciplinary actions from associated duplicate students, 
where appropriate. The master student record that is linked to the duplicates 
must not be marked as DNR or have an inappropriate original start date, or 
the services will not get reported.

7. Added a "dups" section to Tab 8 of the student data entry form (User 
1/dups), which allows the user to associate the student with a master student 
record (as a duplicate); or to disassociate the student with other student 
records. To make an association, you must enter the 18-character 
record_number of the other student. 

4.01 B6 - 11.8.99 
1. When selecting "Apply Teacher..." for a selection of enrollment records, 
the user can now apply a specific teacher assignment (location / service 
combination). The routine can also (optionally) update the student's school 
of attendance and/or school of residence.

2. Changed "Apply school of att..." to "Apply school..." for a selection of 
student records. The user can now apply a selected school as the school of 
residence and/or the school of attendance. 

3. Added underline markers for required fields, Postal Codes table.

4. Added a "calculated" first column to the enrollments list, showing a "D" 
character when the enrollment has been dropped (the drop date is not 
00/00/00).

5. The primary drop code and primary drop reason are now both alpha 
sorted, when editing enrollments from the student data entry form or from 
the enrollment data entry form.

6. Added a new student checkbox field, "AB2726 (3632)".

7. Fixed a problem that was causing an array range-check error when 
importing from districts into SELPA Central.

4.01 B5 - 11.5.99 
1. Fixed the 410 service problem (again) from 4.01 B2, #1.
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4.01 B4 - 11.5.99 
1. Added CASEMIS 1999-2000, 3-table exports 

NOTE: These exports have not yet been tested against CASEMIS. You must 
use the CASEMIS conversion utility to change the text format into dbf 
format.

2. Added some code in an attempt to fix an irregular problem, which causes 
the select district dialog to be blank (show no district listing) when 
performing the CASEMIS 1998-99 student IMPORT. If you still experience 
the problem, try dragging the window down below the lower edge of the 
screen, then back up, to force a redraw.

3. Added underlining on the titles of certain fields that are required, on 
various data entry forms. Removed the requirement that certain new fields 
be completed for the student, for academic year 1999-2000.

4. Modified certain list codes for disciplinary action (reasons, student status) 
so that they will appear in alpha code order.

5. Added a preference so that the user can generate CASEMIS export files 
that incorporate the [Student]Student_number field instead of the program-
generated [Student]Record_number field. The program will still use the 
latter, however, if the former is blank. Applies only to the 1999-2000 
CASEMIS exports, not to the earlier CASEMIS exports.

6. Fixed a minor problem that resulted in the program displaying an errant 
pull-down menu (containing no items) for the "days" column of the 
disciplinary actions list for each student (student data entry form).

4.01 B3 - 10.25.99 
1. Fixed additional problems that were preventing the non-410 services from 
being entered on on the Enrollments tab of the Student data entry form.

2. Added a routine (to be used with the San Mateo imports) to merge 
duplicate enrollments together (from the CASEMIS import and the 
enrollment auxiliary import). The program user can access the routine from 
"Update Other...", when displaying a selection of students in

the upper browser list.



4.01 B2 - 10.25.99 
1. Fixed a problem that was preventing the non-410 services from being 
entered on an enrollment data entry form.

2. Fixed a minor problem that was causing import files to remain open after 
being rejected for format inconsistancies.

3. Rearranged CASEMIS service codes (under students) so that they appear 
in order (in addition to the alpha-ordered CASEMIS service names).

4.01 B1 - 10.25.99 
1. CASEMIS 1999-2000 changes: Added new fields and changed certain 
lists to correspond with CASEMIS changes for the new year. 

NOTE: This version does NOT yet export to CASEMIS in the new format. 
For a description of the new fields, refer to the memo from the Dr. Alice D. 
Parker, dated June 22, 1999.

2. Added new functionality to intrepret San Mateo service codes, for the San 
Mateo aux. student information import.

3. Reconfigured the Preferences dialog options slightly. Added default IEP 
Notice fields that can be copied to a student's record. Added the ability to 
edit non-primary drop reasons, and to edit primary handicapping conditions 
from Preferences.

4. Added "parents" as an option for the type of contact, when adding 
contacts for a student.

5. An enrollment can now be saved even when there are validation problems, 
by clicking on the "DNR" button for the enrollment. Similarly, the 
validation checks for the student record will now ignore problems with 
associated enrollments that are marked "DNR".

6. Apply school of att. (attendance) is now available, in the Students section 
of the Actions menu.

7. When updating students' calculated ages (Actions menu), the program 
now offers to modify infant and preschool fields appropriately, if the student 
is no longer an infant and/or a preschooler. The modifications will NOT 
affect the associated enrollment records, however.
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4.00 B32 - 10.11.99 
1. Fixed a minor problem related to changing tabs (data entry form pages) 
using the arrow buttons, immediately followed by clicking on the tabs.

2. Changed the Quick Report and Label Editor calling routines slightly, to 
reduce the possibility of a Windows crash that happens only in certain cases. 
Pre-check for the number of fonts installed, with a warning if a Windows 
machine has more than 250 fonts. 

To verify the number of fonts that you have installed, consult "About SELPA 
Manager..." from the Help (Windows) or the Apple menu. Scroll to the 
bottom of the information that is displayed.

3. Fixed the column width for teacher names (Col. 2) at 160. 

4. Added an optional third column to the District import, which (if present), 
prepends the information to the district name, e.g., "[A]- Solstice Unified 
School District", where "A" is in the third column.

5. Added custom imports for San Mateo (Districts, Schools, Teachers, 
auxiliary student info., and auxiliary enrollments info). Adapted the 
CASEMIS import to tolerate 160 columns rather than 170, where the 
missing columns are the last two: drop reason and date. 

 The order for creating a San Mateo-type data file is: (1) import districts (the 
San Mateo single-digit district code will prefix each district name); (2) 
import schools (3-digit code will appear in Address_2 field); (3) import 
teachers; (4) run CASEMIS 170-column import; (5) run auxiliary student 
info. import; and (6) run aux. enrollments import. The auxiliary enrollments 
will require valid CASEMIS codes (they will be flagged as "DNR").

6. Added SELPAs: 0400, 0600, 1100, 2000, and 5800.

7. Made some changes to the wording of diagnostics when adding new 
records, and fixed a problem with the goal-section add record diagnostics.

8. Disabled certain preferences to non-administrative users on serialized 
client-server installations, to reduce the possibility of requiring re-entry of 
the serial number.



4.00 B31 - 9.7.99 
1. Changed the operation of keys for [Tracking] and [Tracking_item] so that 
a primary key failure from SEQUENCE NUMBER won't produce a 
duplicate key problem. [Tracking_item] dependant records won't be created 
if the [Tracking]Tracking_ID key is null. Further, the "primary key repair" 
option now attempts to clean up [Tracking]Tracking_ID nulls by resetting 
the current sequence number for the table.

4.00 B30 - 8.18.99 
1. Fixed a minor problem related to the Update other... item in the Actions 
menu (it was displaying an alert rather than an confirm dialog).

2. Added a print button (and associated form) to the About SELPA Manager 
dialog (Help or Apple menu).

3. Added input filtering on combo boxes, where non-listed item entry is 
permitted.

4. Added the export / import of teachers, teacher services, and assignments 
to the Selpa District-to-Central transfer. 

NOTE: B30 will NOT import a District-to-Central export file created with v. 
B29 or earlier.

4.00 B29 - 8.2.99 
1. Added Quick Report address fields to the Student table, so that address 
information is accessible from the Quick Report editor. To batch-copy a 
selected address type for each student from Student Contacts to the Student 
table, select Update other... from the Actions menu. The update will affect 
the current selection of students only (or, depending upon context, the 
current selection of students corresponding to the current selection of 
Enrollments or Student Contacts). 

 The Update other... dialog will ask you to specify a type of address to be 
copied from the Student Contacts table, for each student (home, work, 
emergency, default residence, etc.). If the address type is not found for a 
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student, the address will not be copied, and the new Student address fields 
will retain their previous values. If more than one address is found, then the 
first one in alpha order (contact name) will be used.

 To clear the Quick Report address fields for selected students, select the 
option, "Clear selected" in the Update other... dialog.

 To access the address fields update directly from the Location box, type 
"update quick report fields".

 To manually copy any Student Contact address into the Quick Report fields 
for a particular student, highlight the contact on the General tab of the 
Student data entry form, then press the QR button. To manually clear the 
fields, [ALT/OPTION]-click on the QR button. 

4.00 B28 - 7.27.99 
1. Fixed a few problems with the import for Selpa 0600. In certain cases, it 
was not generating the CASEMIS service description for all imported 
enrollment service codes. It was not linking schools to districts. 
Restructured the code somewhat to limit the size of the main importing 
routine.

2. Reversed the compliance target dates for initial and interim status 
students, so that now the initial date is plus 50 days (from the current date), 
and the interim is plus 30 days.

3. Changed remaining pull-down menus to combo boxes on the Student data 
entry form. Also changed the school type pull-down menu to a combo box 
on the School data entry form.

4. Added maintenance of user-selected sort in included lists (AreaList 
displays), when using the arrow keys to move among records. Affected data 
entry forms are: Teacher, Student, and Enrollment.

5. For the Student data entry form, linked the Next IEP date and Next 
Evaluation date to the user-entered Last IEP date, rather than the Original 
Entry date. If the Original Entry date is blank when the Last IEP date is 
entered, then the Original Entry will also get the Last IEP date.



6. Added telephone number "telepathy" to selected data entry forms, for 
easier entering of other phone numbers (after the first one). To cancel the 
telepathy, tab out of the telephone field without typing anything.

7. In the district-to-district export, added a new export dialog allowing the 
user to mark the drop date and drop reason(s) for active enrollments. The 
active enrollments are dropped prior to export (not true before this version). 

 Also fixed a minor problem with the title of the export, in the Tracking 
section.

8. Added a DROP... item to the Actions menu, when browsing enrollments. 
Dropping affects only those enrollments with blank (zero) drop dates. 
Selecting this item with the [ALT/OPTION] key held down will cause the 
listed enrollments to be un-dropped.

9. Turned off a key assignment operation that allowed returned keys to be re-
used. This mechanism was failing occasionally for undetermined record 
loading - locking reasons. With this release, only the currently-assigned key 
for any table can be recovered for re-use (when adding records).

4.00 B27 - 7.20.99 
1. Added a tab-delimited text import for Selpa 0600.

4.00 B26 - 7.7.99 
1. Fixed a problem that, under certain circumstances, causes the attendance 
register day columns to contain unwanted text.

2. Added an option which allows attendance registers to be separated by 
school name and student track. The normal separators are class code and 
CASEMIS service code.

4.00 B25 - 7.7.99 
1. Fixed a problem related to updating school codes for existing school 
records. The school of residence and school of attendance codes were being 
updated with the school name, rather than the revised school code. 
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 The user can now enter an alpha, alphanumeric, or numeric school code 
(formerly numeric only). The code still must contain 7 digits for the record 
to be saved.

 The updates of related records for a change in school name or code take 
place only if (1) on school code changes, if the school code has 7 digits; and 
(2) if the user is in the "ReadWriteGrp" access group. Formerly the changes 
took place in any case, but were not saved if the user was not in the 
"ReadWriteGrp" group.

2. Revised the enrollments display on certain IEP forms, so that the teacher 
name is displayed as a wider column.

4.00 B24 - 7.2.99 
1. Fixed a minor problem with Location box searches, when the user enters 
"contact name is...", in the Students context.

2. Changed field name (TR Trans is required B) so it does not contain the 
word "is"; the presence of this word was confusing the searching routines.

3. Made slight adjustments to the student by teacher and transportation 
summary report headers, to reduce the possibility of overlap on Windows. 

4. Added the capability to cancel the student by teacher report during 
execution, by pressing the [ESC] key.

5. Fixed some faulty tool tip explanations on the print attendance registers 
dialog.

6. On the Enrollment data entry form (and the add enrollment form, 
enrollments tab of Student data entry form), widened the combo boxes 
explaining the drop reason (primary and non-primary). 

 Also added the capability to detect a primary reason or code in the non-
primary code or reason (name) box, respectively. For both reason boxes, you 
can now enter the first portion of the reason name, and the program will 
complete the reason name and enter the code, if found.

 Fixed a bug that caused the primary enrollment reason not to be cleared 
when switching from a primary to a non-primary enrollment, during data 
entry.



4.00 B23 - 6.22.99 
1. Fixed a minor problem that caused the area lists on tabbed data entry 
forms not to have scroll bars, when the new tab buttons or keystrokes were 
used.

2. Added a new user group, "ReadWriteGrp". Administrators should place 
all users that have read-write access to the program in this group. If a user is 
not in this group, then the user will not be able to save any changes when 
editing records. Additionally, certain menu items will not be available.

3. Added "show all", "show subset", "omit subset", "sort" and "order by" as 
commands that the Location box understands.

4. Changed the preference checkbox for "no 4D Write licenses installed" 
into a field in which the user can place the number of 4D Write licenses that 
are installed on the server. This setting does not apply to single-user versions 
of Selpa Manager. 

When the number of current users exceeds the number of 4D Write licenses, 
the exceeding user(s) will have the 4D Write button and internal 4D Write 
calls (going into data entry form) disabled.

If you enter more than the actual number of 4D Write licenses in this 
preference, then the user(s) that log onto the system without available 
licenses will have the 4D Write functions enabled, but will experience code 
errors when these functions are activated.

4.00 B22 - 6.20.99 
1. Fixed a minor problem related to the initial incorrect display of the 
number of records, when browsing enrollments over the web.

4.00 B21 - 6.19.99 
1. Made minor adjustments to the Location-box searches to improve the 
likelihood of finding a name. The particular problem related to students' 
names that were similar to or contained the names of (calendar) months.
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2. Enhanced web serving with the following items: (1) Disciplinary actions 
browse and single-record view; (2) Enrollments browse and single-record 
view; (3) Moved browse buttons to the top of the form (there is still a DONE 
button at the bottom of each browse form); (4) Added a STUDENTS FOR 
button to the Students browse, to get students whose enrollments are 
associated with a specified teacher; (5) Enabled the EXPORT button on the 
Students browse, so that the remote user can download students and 
associated contacts, enrollments, disciplinary actions, and goals. 

There is another problem with the internal web server, which is due to a 
limitation in the v6 web serving engine of 4D. If the user moves around 
between students, enrollments, and disciplinary actions quickly (within a 
few minutes, in the same session), the server may stall. If the web browser 
is not responsive to a request for 30 seconds or so, you may need to quit the 
browser and start again.

3. Added an import for "students from web", to handle the export discussed 
in Item 2, above.

4.00 B20 - 6.17.99 
1. Fixed a problem that was causing the target teacher (the one that should 
remain) to be deleted, after a teacher merge (Actions menu).

2. Added the ability to print the transportation summary form when 
browsing a selection of enrollments. Select Print from the File menu.

3. Disabled the start/stop web server items in the File menu, for multi-user 
systems. In this case, you must start the web server from the menus of the 
4D Server machine itself.

4. Made a minor adjustment to the search on first name, when viewing 
enrollments.

5. Added a combo box to the Location line of the browser, which will 
display the fields that are applicable to the current table (active table in the 
current context). You can select the field name from the combo box; append 
the comparator and search criterion; then press [ENTER] to execute the 
search.



4.00 B19 - 6.16.99 
1. Made minor changes to the Selpa 3911 transportation form.

2. Changed the pivot year of the default century from 1980 to 1955. When 
the pivot year was on 1980, 2-digit birthdays before "80" were being read as 
the 21st century (e.g., 2/15/79 was interpreted as 2/15/2079). With the new 
setting, two-digit dates before "55" are interpreted as the 21st century, but 
two-digit dates after "55" are the 20th century. These assumptions apply for 
the remainder of the 20th century (1999). After 2000, two-digit dates that are 
beyond "55" will be interpreted as "2155".

If you have a batch of students with 21st-century birthdays, there is a special 
patch that you can apply internally to fix this problem: type "fix unusual 
birthdays" in the browser.

3. Added a new transportation summary form, which can be either sorted by 
student name or grouped by teacher and then sorted by student name.

4.00 B18 - 6.15.99 
1. Fixed a problem that was causing the day checkboxes on the 
transportation forms not to be changed properly, when printing multiple 
transportation forms from the browser.

4.00 B17 - 6.14.99 
1. Fixed a few problem areas with the web serving ($1 variables). There 
appears to be an engine bug related to $0 in triggers (the web process should 
not be in the trigger at all).

2. Added a generic import for disciplinary actions. The action won't be 
added if the student can't be found during the import, or if an action with the 
same start and end dates already exists in Selpa Manager for the student.

4.00 B16 - 6.13.99 
1. Added a v6-contextual web server, which is activated and turned off from 
the File menu.  Clients of the web server persist until the time-out interval is 
reached (approximately 5 minutes without a request from the client). For 
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Windows servers, you must have TCP networking installed, and the 4D TCP 
network component (4Dnctcp.dll) installed in the 
C:/Windows/ACI/Network folder.

Right now the web server only browses students. In your web browser, enter 
the URL of the server machine. The program will ask you to log in - use the 
normal name and password. The web server does not at present permit 
editing of records, but you can display data form for a single record by 
clicking on the appropriate row while browsing students.

If you append a person's name after the URL, as in: "192.168.1.10/Holman, 
Sally", then the web server will attempt to find enrollments for this teacher 
(Holman, Sally), then join to get the students. In the absence of an appended 
name, the web server will search for enrollments for a teacher that has the 
current user's login name. If none are found, then the web server will display 
all student records. 

NOTE: The web server displays a maximum of 150 pages of 20 students in 
browse mode; if there are more than this number of students (3000) in the 
selection, then you will have to search within the selection to reduce the 
number. Otherwise the records beyond 3000 won't be accessible.

2. Added access to the Label Editor, from the File menu.

3. Fixed a problem in various areas, where confirm or select-type dialog 
windows were not being closed properly. This problem appeared to cause 
occasional misbehavior of Area Lists.

4. For Selpa 3911, when printing transportation forms, the program now 
requires the user to specify an "as of" date (for generating the primary active 
enrollment). This change does not affect the use of the default transportation 
form for other Selpas. Also revised the 3911 transportation form to show 
transportation start date rather than original (student) start date, at upper 
right.

4.00 B15 - 6.12.99 
1. Made created and modified date, time, and user invisible (again) in Query 
and Sort Editors. Added the ability to perform a "Query in selection...", 
"Find in selection...", or "Search in selection..." when searching on a 
particular field name.



2. Reduced the number of tables that appear in the pull-down menu, when 
inserting a field into 4D Write.

4.00 B14 - 6.9.99 
1. Fixed a problem that was causing an erroneous message to be displayed 
when adding a new enrollment from the enrollment data entry form. If the 
user selected a school before selecting a teacher, the diagnostic message was 
slightly in error.

2. Added a "drill-down" form when the user presses the (+) button, to add an 
enrollment from the Student data entry form. Many changes were required 
in the coding to permit the drilldown - further testing is required. To add an 
enrollment in the previous manner (by adding directly to the list), hold down 
the [ALT/OPTION] key while clicking on the (+) button.

3. Added an import for SELPA 1600 (refer to "Import" under the File menu).

4. When the user checks the DNR box while in the Student data entry form, 
the program will then automatically check the DNR box for each associated 
enrollment. The converse operation does not happen, however, to avoid 
enabling enrollments that should not be reported.

4.00 B13 - 6.7.99 
1. Fixed a problem with the default district of residence. Normally this code 
is obtained when the user selects the district, on creating a new student. 
There is an additional override setting in Preferences; do not use this 
override if you want the district of residence code to always match the 
student's Record Number.

2. Revised the Selpa #3911 printed transportation form again to omit 
midnight (default time) for school starts and school ends fields.

4.00 B12 - 6.7.99 
1. Added Omit Subset (Data menu), Show Subset (Data menu), and custom 
typed searches in the Browser as operations that automatically instigate the 
Last found set update. The Last found set menu item (which restores the 
Last found set) now has a shortcut: [CNTRL/CMD]-2.
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2. Added a custom transportation form for Selpa #3911 (Windows form). 
Revised both the Windows and Mac versions of this form not to print the 
pick-up and/or drop-off times when the fields are set to midnight (default 
time).

3. Fixed a problem in the Browser that caused the upper and lower radio 
buttons to both be unselected, under certain circumstances.

4. Added a Data menu item, "Other year enrollments", which is either 
checked or unchecked for each displayed window. When checked, the 
browser and student data entry form will only display enrollments for an 
alternate year. This feature can be used to prepare enrollments for a new 
year. These alternate-year enrollments are not exported, but can be printed. 
To distinguish between existing and alternate-year enrollments, enrollment 
list headers for the affected Browser will turn a darker color of pink. 
Additionally, the Browser information display will contain the words, 
"[ALT YEAR]" at the end of the description.

5. Added a button to the Enrollments tab of the Students data entry form, 
which allows the user to either drop or un-drop a highlighted set of 
enrollments. [ALT/OPTION]-click to un-drop.

6. For the Enrollments list on the Students data entry form, if the user enters 
a primary drop reason or code into the non-primary column(s); and there is 
no corresponding code or reason among the non-primary reasons; then the 
program will search the primary codes and reasons for a match.

7. When adding a new student, the program assumes that the district of 
residence is the selected district going into the form, or My District (if the 
user has pre-set the latter).

8. Fixed a display problem after printing the student by teacher report, when 
viewing the Enrollments context. 

9 Revised the student by teacher report so that it offers the option of 
separating the contents into separate schools of attendance and student 
tracks for each teacher. This option also applies to the "print to disk" option, 
which will add separator lines and titles to each section of the delimited text 
file.



 The report now only considers current enrollments (defined by the user-
specified date in the print dialog) when printing primary and secondary 
services for each student.

10. Added a new menu item for merging up to 5 teachers together into a 
single teacher. The teachers to be merged must be highlighted in the 
Browser, before pressing the "Merge..." item in the Actions menu. 
Combined with the new student by teacher report option (Item 9), this 
feature enables you to merge duplicate teachers (previously necessary due 
to maintaining separate assignments).

To merge more than five teachers, perform the merging operation more than 
once.

11. Added an Actions menu item, "Move to other year", which will move 
highlighted enrollment(s) to the alternate year. The direction of the move 
depends upon whether "Other year enrollments" is checked or not in the 
Data menu (refer to Item 4, above).

4.00 B11 - 6.4.99 
1. Fixed a problem that was causing students that have a NON-active 
primary enrollment to be increased to the next grade level, by the Change 
grade level... menu item (Actions menu). 

 To restore a selection of students to the previous grade level:

  (a) Using the Query Editor in the Students context, find the affected 
students by searching for the phrase, "rev. grade level from" as a contains 
search, for the field, [Student]Student_note:

     [Student]Student_note   contains   "rev. grade level from" 

  (b) Hold down the [ALT/OPTION] key and then select the Change grade 
level... menu item. Confirm that the dialog indicates that it will reduce the 
grade level (rather than increasing the grade level), and then press OK to 
proceed with the change.

2. Added code to prevent next-year (alternate year) enrollments from being 
sent to SELPA Central, in an export operation.

3. Revised the structure to permit the created and revised fields (date, time, 
and by user) to be visible in the Query Editor.
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4.00 B10 - 6.3.99 
1. Fixed a problem that was preventing the teacher from being recognized as 
having active assignments, when the user enters the teacher code rather than 
the teacher name (Student data entry form, Enrollments tab).

2. Provided additional feedback to the user, if a teacher has active 
assignments at schools other than the one that the user has selected (Student 
data entry form, Enrollments tab).

3. Fixed a problem that was causing the drop code and handicapping 
condition pop-ups to behave erratically after being edited (Student data 
entry form, Enrollments tab). Also allow handicapping condition to revert 
back to default list if user deletes all custom entries.

4. When adding a new contact for a student, if exactly one existing contact 
is highlighted, then the new contact will be a clone of the highlighted contact 
(Student data entry form, General tab).

5. Added a custom transportation form for Selpa #3911 (Macintosh form).

6. Indexed the field, [Enrollment]CASEMIS_service_code.

7. Fixed a problem that was causing an errant dialog to be displayed after 
viewing the About box, under certain circumstances (while editing a 
student).

8. Added a new item to the Data menu, "Last found set". When changing 
contexts in the Browser; when first displaying the Browser; and when 
performing a Find using the Query Editor, the program automatically saves 
the found records in both upper and lower lists. Selecting the menu item 
restores the two lists to contain these found record(s).

 To force the program to save the list contents, hold down the 
[ALT/OPTION] key while selecting the menu item. The contents will be 
available until the next time that you change contexts or perform a search 
with the Query Editor.

9. Changed the prefix from "420:" to "RSP:" on the Student by Teacher 
report (refer to Item #3 on B9).

10. Added a shortcut keystroke for "Show subset" in the Browser: 
[CNTRL/CMD]-R.



11. Added an "Address" button to the Transportation tab (Student data entry 
form) which copies the student's home address and city into the pick-up and 
drop-off fields.

4.00 B9 - 6.2.99 
1. Fixed a problem that was preventing the related one fields from appearing 
in the Quick Report Editor. Also turned all manual relations to automatic 
when invoking the Quick Report or Search (Query) Editors.

2. Added the capability to install and print transportation forms. Added a 
default transportation form. At present, only a Mac default form is installed. 
Custom forms can be installed for each SELPA.

3. Added a field, [Enrollment]Session_note, that prints on the Student by 
Teacher report when the corresponding service is "420". The note will print 
as "420: [note...]", after any alternate enrollments are printed, in the final 
report column. During data entry, the field appears as the last column before 
the "Modified on" column, enrollments tab, Student data entry form.

4. Added another field, [Enrollment]Next_year_B, for eventual use in 
displaying alternate year enrollments (this item is not in service yet). Began 
making modifications to the CASEMIS export to account for these future 
records. 

5. Allowed cancellation of the CASEMIS export during the search (query) 
phase.

6. Changed the name of the [Engagement] table to [Assignment].

7. Changed the names of the Last 3-Year and Next 3-Year fields to Last 
Evaluation and Next Evaluation.

8. Fixed a problem that was causing the Recall date field-associated calendar 
button to move around when the form was resized (Student data entry form).

9. Added new handicapping conditions to the list, and fixed the tool tip for 
Handicapping Condition on the Enrollment data entry form.

10. Added a new option to display teachers rather than students, in the lower 
list for the Enrollments context of the browser.
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11. Fixed a problem with finding long-hand dates, when searching on field 
names.

12. Fixed a problem related to searching for dates on the calendar, when the 
goal is to view a month at a time. In same-context search mode, this type of 
request resulted in no items found until the user selected "all items" from the 
pull-down menu. In change-context search mode, if items were found, the 
start and end dates were not the start and end of the month. When the user 
searches for a particular date, the program still displays found items only on 
that date, not on any adjacent dates that may be displayed.

4.00 B8 - 5.30.99 
1. Fixed a problem in various import routines that prevented the STOP 
button from resetting, in the case that the user didn't really want to stop the 
import but pressed the STOP button anyway.

2. When selecting a teacher for an enrollment (Enrollments section), where 
the teacher has no engagements at any school, the dialog that appears now 
contains the name of the teacher.

3. Fixed a problem that was causing enrollments not to have a linked school, 
when importing district-to-district, or importing district-to-central. Note 
that the district-to-district import does _not_ include schools, so there still 
may not be a linked school after importing enrollments in this case. 

4. Fixed a minor problem with checking and unchecking the re-apply same 
teacher button, when selecting ASSIGN TEACHER... in the Actions menu, 
for Enrollments. 

5. Added another check box to ASSIGN TEACHER... which causes the 
program to create the teacher record, if the teacher does not already exist in 
this copy of SELPA Manager. For this feature to function, the Enrollment 
record must have a teacher name. Previously, the program could create 
teacher services and engagements for a blank (nonexistent) teacher.

6. For the ASSIGN TEACHER... item, added a supplemental check for the 
foreign key to the [School] table, to ensure that an engagement is not created 
for a nonexistent school.



7. When the user selects all records or a subset of records in one browser list, 
if browse sorting is enabled in Preferences, then the program sorts the 
resulting selection in the other (associated) browser list.

4.00 B7 - 5.28.99 
1. Sorted the logon list of program users in alphabetical order.

2. Fixed a minor problem related to error logging (UTIL_logAlert).

3. When adding an enrollment for a student on a Windows workstation, if 
there would be more than 200 teachers or schools in the pull-down menu, 
then that pull-down menu is eliminated, and the user must enter the teacher 
or school name directly in the column. This change was necessary to reduce 
confusion when selecting from pull-down menus in Windows.

4. Added the selected teacher or school name to the dialog title, when there 
is a problem while adding an enrollment.

5. Fixed a problem on server that prevented User #2 from adding a new 
student while User #1 was adding a new student to the same district (so that 
User #1 had the data entry form for the new student open). Added a new 
tracking log entry when a "next student" number is skipped due to the user 
canceling the data entry form.

6. Added the recall date as an item that can be added to the calendar, by 
pressing a button on the Student data entry form.

7. Fixed a problem with tab order on the Student data entry form.

8. Enabled the "Stop" button on certain import routines where it had been 
disabled.

4.00 B6 - 5.22.99 
1. Added 6 IEP forms for each of SELPAs 2300, 2700, 3901.

2. Added export to disk for student by teacher report.
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4.00 B5 - 5.19.99 
1. Added 6 IEP forms for each of SELPAs 2400, 3911, and 4811. (Three 
each for Windows, three for Mac. Total added thus far: 2400, 3911, 4811, 
4900, 5011, plus defaults.) Fixed a minor problem related to forms 
recognition on Macintosh.

2. Indexed additional fields requested by Tom.

3. Fixed a problem with two SELPAs having the same code (3911).

4. Fixed a problem with a grade level being described as "Upgraded" rather 
than "Ungraded".

4.00 B4 - 5.17.99 
1. Fixed a problem that was causing the first student contact to be locked 
(non-enterable) from within the student data entry form.

2. Made further adjustments to the SELPA 5011 IEP forms.

3  Added IEP forms for SELPA 4900.

4. Fixed a problem that was causing extraneous data validation messages to 
appear for enrollments, when the user had not made any changes. The error 
occurred when the user double-clicked into a cell in the Enrollment list from 
the Student data entry form, and then clicked away without making any 
modifications.

4.00 B3 - 5.15.99 
1. Added two checks on startup: deletion of zero spare keys (if any) and re-
assignment of keys to user tables that have somehow gotten a zero ID 
record. The latter occurs in the background after the first browse window is 
opened; it will log to the tracking section if it finds anything wrong. These 
checks occur at every workstation startup.

2. The verification and correction of zero-numbered primary keys can be 
initiated by the user, by typing "primary key repair" into the browser.



4.00 B2 - 5.14.99 
1. Fixed a problem that was causing 2-digit dates exported from the SELPA 
Manager 3.57 import to be interpreted as being in the wrong century. 
Revised delimited exports from this program to always force a 4-digit year 
on a date field

NOTE: Does not apply to Quick Reports exports.

2. Fixed a problem that was preventing the Case Manager from being 
imported, SELPA Manager 3.57 import.

3. Modified all imports to refresh foreign window selection information, if 
any foreign windows are open. Also revised the background refresh process 
to handle this task at periodic intervals, for client-server installations.

4. Added completeness checks for the two Area Lists on the Teacher data 
entry form (for services and engagements). 

5. Adjusted positioning of goal Area List on Tab 2 of the Enrollments data 
entry form.

6. Revised all Engagement Area Lists to display the Active Engagement 
Boolean field as the first column. When adding new engagements to Tab 2 
of the Teacher data entry form, the program now auto-checks the Active 
field.

7. Fixed a problem with the Engagement data entry form formatting.

4.00 B1 - 5.13.99 
1. Added Student by Teacher report, along with a convenience dialog for 
teachers, when the user selects PRINT from the File menu.

2. Rearranged the convenience print dialog for students, allowing the user to 
force default IEP forms. Added custom IEP forms for Selpa #5011.

3. Enabled the Assign Case Manager menu item.

4.00 A13 - 5.12.99 
1. Added apply teacher and apply class routines, with tracking logs.
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2. Rearranged Action and Data menus somewhat. 

3. Added a routine to find students whose district of residence does not 
match the district of attendance.

4. Added progress bars when the user highlights a large selection in the 
browser. The progress bar can be canceled, to stop the show related records 
operation. The user can avoid generating the selection of relateds by holding 
down the [ALT/OPTION] key while click-dragging on the Area List, or 
while [SHIFT]-clicking on a contiguous selection.

5. Added supplemental verifications for the two teacher Area List (services 
and engagements), to detect whether the user has made a change to the field, 
or merely dragged off a popup or clicked out of the field. Cloned the service 
arrays so that the two Area Lists do not share any arrays.

6. Made some refinements to the printed attendance registers for Windows.

7. Added serial numbers for AreaList 7.5 (now used in both Mac and PC 
versions; formerly only PC version in demo mode.)

8. Made extensive changes to the "show current" enrollment routines, for 
consistency with the previous versions of SELPA Manager. Introduced four 
different defaults in Preferences for show current. Provided a new dialog for 
"Show current for..." menu item.

4.00 A12 - 5.9.99 
1. Added generic imports for Teacher, School, and District. These imports 
would typically be from tab-delimited spreadsheet files. The import dialog 
specifies the field order, and allows the user to specify the field and record 
delimiters (defaults are tab and return).

2. Added default print forms for IEP All, IEP Template, IEP Data and IEP 
Notice. There are a total of eight forms, four for Mac and four for Windows. 
The new Print IEP dialog indicates whether a custom form is available for 
the user's SELPA, prior to printing. At present there are no custom forms 
available.

The IEP forms print only current enrollments, starting with the primary 
enrollment and continuing in start date sort order, to print a maximum of 
four.



The "parent" information on the IEP comes from the student contact record 
that is checked as "student lives here". If there is no such record, then the 
program looks for contact records where the contact relation is "guardian", 
then takes the first one of these that it finds.

The alternate parent contact information on the IEP comes from the student 
contact record that has its contact relation as "guardian 2". If there is more 
than one of these, the program sorts the found contact records by address 
type and contact name, then takes the first one in the sort order.

To get the emergency contact and number, the program looks for contacts 
with the address type starting with the word, "emergency"; sorts them in 
order of address type and contact name; and then takes the first one in the 
sort order. The emergency telephone number taken is the "Telephone other"; 
if this phone number is blank, then it defaults to the home telephone and the 
work telephone, in that order.

3. Made some minor changes to the way student contacts are parsed when 
importing students from SELPA Manager 3.57. The changes improve the 
matching for the IEP forms printing.

4. Added the ability to print attendance registers. The user can specify the 
contents of the upper right block and the seven code fields, at printing time. 
This form is for landscape, legal-sized paper only.

5. Added online documentation of the browser functions, and fixed certain 
problems in some of the searching routines. Added a few new conjunctive 
expressions, which can be used in the browser searches. The 4D progress bar 
can now be canceled for in-context searches, to prevent longer searches and 
nested repeating searches from running ad infinitum.

6. Fixed a problem that was preventing the calendar from updating the 
clients in client-server mode.

7. Fixed a problem that was preventing a normal quit of clients, in client-
server mode.

8. Added a MediCAL eligibility (fixed-column) export to the program.
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9. Added auto-disable code for 4D Write functions,. The code runs when 
there are no licenses installed in client-server mode. Without this code, 4D 
Write will generate error messages that cause certain modify record/data 
entry events to malfunction. If there are no licenses installed, the browser's 
4D Write button is disabled.

4.00 A11 - 5.5.99 
1. Added the ability to import from a fixed-column CASEMIS export 
document. This import can be used to bring in students from another district 
that does not use Selpa Manager. The import requires the user to specify a 
district into which the student(s) will be imported. Their old record numbers 
(if any) will appear in the previous record number field.

2. Broadened the scope of the new search options (#2 on A10) to include in 
context and change-of-context searches for schools (only).

4.00 A10 - 5.3.99 
1. Added support for the district-to-district export and import routines. The 
import will create a new display-only field containing the old record number 
(refer to Tab 2, demographics, Student data entry form).

2. Added some additional options for the in-context field searches from the 
browser -

(a) It's okay to say "Get" (followed by a space) as the first part of the 
sentence; (b) You can use "equals", "is equal to", "is not", "is not equal to", 
"is greater than", etc., as well as the "<", "<=", ">=", "<>", "#"  characters 
as conjunctive phrases, between the field name and the search criterion. 

NOTE: At this time, these new phrases only work for in-context field 
searches, not with the context-switching words or non-field name, in-context 
searches. 

Examples -

Get Score 1 is greater than 3   -- for goals
Score 2 is not 100  -- for goals 
Get last name is greater than Smith  -- for students
First name is not Riley  -- for students



3. Enabled the default progress bar while doing searches from the Location 
area in the browser. The presence of the progress bar enables the user to 
cancel a slow search.

4. Fixed a problem that was causing the default progress bar to display 
unnecessarily during imports into the user/runtime process (when the small 
SELPA Manager window is the front most window). Imports into this 
process may be faster than in the browser processes.

5. Allow "starts-with" type text entry for the disciplinary action reasons / 
student status columns of the Area List, Discipline tab of the student data 
entry form.

6. Revised deletion criteria to prevent deletion of teachers with enrollments; 
to prevent deletion of schools with associated teacher engagements or 
enrollments; and to prevent deletion of districts with associated schools. 
Improved deletion dialog descriptions.

7. Added more "fire-points" for the data validation routines when 
completing the student data entry form. These points include certain 
manipulations to the contacts and the disciplinary action aerialists.

4.00 A9 - 5.2.99 
1. Fixed a problem related to inadequate process stack size on Windows 
merged. Updated AreaList and CalendarSet versions for Windows (demo 
mode - no serial number available yet, will time out after 15 minutes).

2. Fixed a problem with the Selpa Manager 3.57 import placing the non-
primary service into the primary service field, for an enrollment.

3. Added the CASEMIS export routines and associated menu items.

4. Added a batch update of the user fields for Disciplinary Action.

5. Installed validation checks for adding new records, when there are no 
available records in other tables with which they can be associated (for 
example, no district when adding a school).

6. Added a check for duplicates routine, right now applicable only to the 
[Student] table.
Revision History 877 

• 
• 
• 
•
•
•



878  

• 
• 
• 
•
•
•

7. Added an error handling routine for the environmental stuff in "about this 
program" - was causing problems compiled on Windows 95. In Win 95, the 
routines seem to be unable to return the data file size.

8. Enabled deletion of records from the browser, with handling for relateds. 
Deletion is accomplished inside a transaction, which gets rolled back if the 
program encounters one or more locked records.

4.00 A8 - 4.29.99 
1.  Finished the first pass on an import procedure from Selpa Manager 3.57 
(also wrote the export facility into Selpa Manager 3.57).

2.  Fixed a problem introduced into 4.00 A7 with birth date verification, on 
opening a new student record.

4.00 A7 - 4.28.99 
1.  Moved the browser window down slightly to accommodate Tom's 
display.

2.  Added this get info box.

3.  Finished first pass on the Export To and Import From Selpa Central 
routines.

4.  Added more diagnostics to the Student data entry form (for student 
contacts and disciplinary actions). The diagnostics now include Infant 
Setting if the student is more than 2 years old.

5. Revised age calculations to be performed with the "Report As Of" date, 
and provided a calculate ages menu item. Additionally, when the user 
changes the report as of date, the program automatically revises all of the 
students.

6. "Initial" plan status now adds 30 days to the current date, to arrive at the 
compliance date ("interim" adds 50). The calculation is only performed if 
the compliance date is empty, or if the record is not yet saved (new record). 
To clear the compliance date, remove the plan status and click away from 
the field.
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  Index

Symbols
"internal" districts

capability of program to maintain 42
% ORC (percent outside regular class), 

student data entry 379
, in goal and benchmark text 279

Numerics
-10002 error message, 4D Client 140
4D Backup

Backup Project file 129
configuration of, 4D Server

(Macintosh) 111
configuring 126
external dest. volume size and 129
FireWire drives 129
log file 127
log file integration 127
network volumes and 130
number of sets 80, 112
re-activating 131
removable media drives and 81, 129

4D Chart
chart menu bar 631
Chart Wizard dialog 631
graphing dialog, from the Data ->

Graph command in the brows
window 631

4D Client
-10002 error message 140
Connection to 4D Server (dialog) 136
Duplicating resources locally

(message) 139
install or upgrade on PC workstation

87
major version upgrades and 86, 118
problems connecting/possible fixes

140
shortcut, making, on Windows

Desktop 89
version of, should match 4D Server

86, 118
4D database engine

incremental updates to 121
4D Server

4D Server 2003 58, 95
4D Server 2003 and 4D Server 6.7,

licensing different for 63, 98
4D Server 2003, full installer with,

name of 63, 99
expansion product licenses, entry of

(Macintosh) 116
expansion product licenses, entry of

(Windows) 85
expansion products registration 61,

98
full backup, first time, Backup Project

and 129
full backup, Macintosh server

installation 111, 115
full backup, PC server installation 79,

83
full backup, second time for log file

128
Full backup... menu item 126
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menu items and 512, 607, 651, 657
online registration 60, 97
Product ID numbers and 62, 98
registration cards for 60, 96
required and optional items for

installation, Windows server 58, 95
Restore Log window (4D Backup)

127
Select log file... (command) 83
serial numbers 60
serial numbers from Product ID

numbers 97
serial numbers, obtaining 96
server data backup (4D Backup) 126
structure-only update, installer for 63
structure-only update, installer for

(Macintosh) 99
update license dialog, serial number

85
4D Tools

4D Client, do not install with 88
4D Tools 6.0.6, use of on 4.6x-4.7x

upgrades 122
compact before upgrading SELPA

Manager 757
deleting previous shortcut to (PC

server install) 72
Disk First Aid use and 761
Disk Utility (Mac OSX) and 761
finding recov. data file created with,

major upgrade 73
installing 759
Macintosh disk check prior to 761
Macintosh OS 10 (“OS X”) and

(warning) 760
make alias to (Mac server install) 104
make shortcut for (PC server install)

72
minor version updates and 123
running 760
scan hard disk before running 761
Selpa Manager RT (PC), installation

with 53
Selpa Manager Server, installation

with 67

split (segment) data file and 164
when to use 757, 775
Windows disk check prior to 761

4D Write (word processing plug-in)
4DWriteGrp access group 148
as program component 44
browse window access and use 225
browse window button location 173
composing disciplinary letters 471
discipline data entry (word processing

window) 474
document format conversion 226
Enrollments tab, word processing area

394
expansion pack licenses 59, 95
expansion pack part numbers 58, 95
report generation options 719
single-user vs. server license 59, 96

4D Write (word processsing plug-in)
assigning plug-in access 583
expansion pack licenses 583

4DWriteGrp (password system) 147, 148
creating/editing access groups and

578
default access group 143

4th Dimension
multi-threaded and 513
SELPA Manager and database engine

513

A
Access groups (password system) 143, 

146
Access privileges

function/privilege summary by access
group (table) 150

Actions menu
batch operations and 44

Active primary enrollment
CT (CONTINUE) button and 392
disabling condition and 389
enrollment data entry form checkbox

421
enrollment record data entry

validation 387



general definition 417
printing enrollments (checkbox) 593
transportation summary report and

(for selected students) 589
Active, as teacher/staff assignment 

marking 176
ADD LINE button (Query Editor) 629
Add new record loop (preference) 293, 

319, 330
address fields, replicate/clone, for Quick 

Reports 725
AdminGroup (password system)

Administrator a member of 143
applying school or district access

restrictions 156
audit information access and 372,

400
audit trail (Au) button and 393
choice list items import (generation

of) 524
connect to server during excluded time

284
creating/editing access groups and

578
default access group 143
definition 146
district access restrictions and 158
goals objectives palette, deleting items

455
group owners must themselves be

members of 146
owner of new access group must be in

579
Preferences dialog and 243
relation to "TeacherGrp" 794
retrieval of sets on disk and 638
SELPA Central import, performing

166
transportation-only data form and

413
Administrative access or privileges 

(password system)
definition 147

Administrator (password system) 143
Alternate data entry form, student services 

301
alternate year

Current (as of date), other year
enrollments and 296

Other year enrollments (Data menu
item) 647

other year enrollments, data menu
608

other year enrollments, Query Editor
and 621

transportation summary report and
589

Americans with Disabilities Act (ADA)
student’s age group (attendance entry)

356
Angle brackets, use of (manual 

conventions) 134
area code prefix, auto-insertion of 293
arrow key navigation, browse window 

172
Assessment (IEP form)

new, creating from Location box 298
State of California "DFL2" form,

OTHER FORMS button and 268
assessment (keyword, Location box) 201
Assignment

definition 327
Assignments (program section)

adding staff and related information
(intro.) 325

assignments, teacher
Preference, "Limit student services to

active teacher assignments" 317
relation to school records 317

attendance
entry of, attendance list (steps) 353
entry of, Location box and 357
entry via adding teacher assignments

351
logging daily, from assignments

section 328
logging in browse window 183

attendance confirmation expressions 
(Location box) 181

attendance registers
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legal-sized paper and 585
printing actual attendance information

328
audit trail

"Find transportation changes since"
option and 643

Actions menu overview and 652
Administator login access and 143
Audit (Au) button, disciplinary actions

list, student data entry form 400
Audit (Au) button, student contacts

list, student data entry form 372
Audit trail (Au) button, enrollments

list, student data entry form 393
batch update operations and 272
Counselor, Limited (user) and 144
dialog (fig.) showing sample changes

271
function/privilege summary table, by

access group 151
Martinez, Waldo, access and 144
Preferences setting 270
purge audit trail (Location box

function) 196
purge audit trail information

(summary table, by access group)
151

Read-Write user and 144
ReadWriteGrp access group and 147
Teacher, Limited (user) and 145
Teacher, Standard (user) and 145
Transport User can access for student

146
TransportGrp access group and 147
TransportGrp access group, field-level

student changes and 413
Auxiliary enrollment codes

editing (Preferences) 262
enrollment data entry (assign to

enrollment) 423
not used with Type 2 chargeback

report 461
school name (Type 1) chargeback

algorithm and 461
school name (Type 1) chargeback

report and 457, 458
school name (Type 1) chargeback

report requirements and 465
steps to define (Preferences) 465
steps to generate school name (Type 1)

chargeback report 467
student data entry (assigning to

enrollment) 389
to generate district chargeback report

417
available fields menu (Query Editor) 627

B
Backup Project (file, 4D Backup) 129
Backup Scheduler

4D Server (Macintosh), window 110
4D Server (Windows), window 79
configuration of (4D Server

Macintosh) 116
configuration of (4D Server Windows)

84
bandwidth (network), simultaneous 

connections to 4D Server and 140
batch change operations

Administrator access to 143
blank, as value in standard search 

expression 189
Boolean fields, during data entry 237
browse context (browse window) 133, 

162, 169, 170, 171, 174, 178, 181, 
187, 190

browse forms
definition 167

browse window
"browser" 168
"standard" browse window 168
arrow key navigation and 172
as major program form 43
attendance logging 183
browse contexts 133, 162
browse contexts, changing 169
browse contexts, changing with

Location box phrases 170
browse contexts, relationship of a field

in another table to 187



browse contexts, special expressions
and 190

browse contexts, standard search
expressions and 181

browse forms 167
calendar context 169
context, temporary change of 298
contexts and 133, 162
contexts, changing 169
contexts, changing with Location box

phrases 170
contexts, relationship of a field in

another table to 187
contexts, special expressions and 190
contexts, standard search expressions

and 181
current focus 178
current focus and 178
current selection 171
data entry cycle and browse context

241
discipline context 169
districts context 169
freezing one or more columns on lists

173
goals context 169
location box 170
lower (secondary) list 168
maximum open at one time 168
maximum open simultaneously 513
multi-level sort options 177
New window function and 512
other contexts 170
postal or zip context 171
printing from 584, 603
program users context 170
schools context 169
slider control 173
sorting 177
staff context 169
student services context 169
students context 169
styled text and 174
summary of contexts 242
tiled windows and 513

tracking or events context 171
upper (primary) list 168
using 168

Building references... (completing the 
connection) 163

buttons
conventions for manual 134
for cycling tabs, data entry form 234
navigation, proximity to cycle buttons

234
record navigation 239

BY TEACHER checkbox (transportation 
summary report) 590

C
cache files

4D Client, location of and deletion of
141

4D Client, waiting for creation of 139
Calculate ORC function, Location box 

191
Calendar

browse window context 169
display exception, browse window

168
calendar (keyword, Location box) 202
calendar items, searching for 229
CANCEL button 241
capitalization, during data entry 235
Carbon application, Mac OS X, SELPA 

Manager and 90
CarbonLib 1.4, as Macintosh requirement 

in OS 9 90
cartridge drive (removable)

use with 4D Backup (Macintosh) 112
Case Carrier (Mendocino Cty. example) 

45
CASEMIS

"lives with" vs. residence codes 368
"TRAN_LANG" field (transition

language) 377
2-digit service codes for 338
3- and 5-digit service codes 338
alternate assessment (Table C) for

2000-2001 report 430
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alternate assessment content and
reporting 504

alternate district of service option
(Preferences) 246

associating two or more student
records for reporting 410, 411

auxiliary service code not related to
466

auxiliary service location not part of
390

break level determination on sorting
enrollments by service code
(enrollments example, Quick
Report) 742

data specification ("data dictionary")
changes over time 256

defined (California Special Education
Management Information System)
41

discipline data reporting 399
DNR (Do Not Report) checkbox 367
Do not report checkbox for enrollment

389, 422
enrollment start and drop date criteria

for selecting students 423
import of data from, 169-column

(1998-99) 519
import of data from, 48-column

disciplinary action (2000-01) 525
minutes/session as duration, for infant

service reporting 388, 424
obtaining district of service for 380
pct. mainstreamed values 379
previous record number 380
Regional SDC with 423
Report As Of date 255
reporting through another district 312
residence code 377
results of report in Tracking or Events

browse context 171
revised codes for 2006-2007, Report

As Of date and 256
school type codes for 321
selecting eligibile students for report

390

service code use in tallying
chargeback costs 466

service name and code 388
shared school codes and 270
Student ID field, use with 269, 270
student record or Student ID number

use 362, 363, 367
sub-districts, for reporting 312
transfer date criterion (exclusion from

reports) 383
using service code to find enrollment

records, browse window 426
WRITE CASEMIS CODES (button,

Preferences) 267
CBEDS (California Basic Educational 

Data System)
Assignment code, for PAIF 353
CBEDS assignment code, for PAIF

341
CBEDS county/district info report,

access privileges and 152
CBEDS reports and inactive staff

members 333
ethnicity/ethnicities for staff member

335
grade level, for PAIF 341, 353
highest educational level attained by

teacher (PAIF) 335
Professional Assignment Information

Form (PAIF) 333
staff member authorized teaching

areas (credentials) 334
staff member classification 335
staff member date of birth and 334
staff member gender and 334
staff member school/district

affiliations 335
staff member years in this district 334
staff member years of educational

service 334
staff percent full-time 334
teacher status, for PAIF 335

central-office user (of SELPA Manager) 
41

certificate signing request (CSR) 251



certification authority, for SSL certificate 
250, 251, 253

Change password... (menu item) 146
chart menu bar 631
Chart Wizard dialog (4D Chart) 631
Check next student number function, 

Location box 191
Check problem items (location box 

function) 192
client-server

getting started 136
multi-user edition of SELPA Manager

134
clone address fields 725
Closed, in teacher/staff name 176
coded information, data entry areas and 

234
Collate by teacher (transportation 

summary report) 594
column sizing (Quick Report Editor) 735
combo box, on data entry form 232
comparison operator

Location box queries, use with 186,
204

Query Editor, types available 624
Query Editor, use with 622

comparison operator area (Query Editor) 
627

compliance date, initial/interim plan status 
370

compound query, definition of 625
conjunction buttons (Query Editor) 627
conjunction operator

compound query, use with 625
Order, "Or" before "And" in

compound searches 626
Connection to 4D Server

4D Client, server selection dialog 136
contacts

use of student contacts section for
"unassociated" contacts 170

context, in browse window 133, 162, 
169, 170, 181, 187, 190

calendar 169
Calendar view 226

changing initial display and 295
changing, browse window update and

283
context-changing keywords (Location

box) 200
current focus and 178
current selection and 171
data entry cycle and 241
discipline 169
districts 169
goals 169
last found set and change of 223
other contexts 170
postal or zip 171
printing and 725
program users 170
schools 169
searching on a change of 203
staff 169
student services 169
students 169
styled text and 174
summary of (diagram) 242
tracking or events 171
visibility of related tables and (in

Quick Report Editor) 733
context-changing keywords (Location 

box) 181, 200
contextual help (tool tips) 291
Conventions (used in this manual) 134
Convert disability names (location box 

function) 192
Convert service codes (location box 

function) 192
CouneslorLtdGrp (password system)

"Counselor, Limited" is member of
144

CounselorLtdGrp (password system)
default access group 143
definition 149

Count disciplinary actions (location box 
function) 193

Count student services (location box 
function) 193

criteria area (Query Editor) 626
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CSIS (California School Information 
Services)

Report As Of date and 256
CSIS number 367
Current focus (browse window)

searching for records and 179
setting 178

current selection of records 171

D
data entry cycle, the 241
data entry form

as major program form 43
definition 167
printing from 585
using 230

Data file
creating new data file ("NEW" button)

164
locating on disk and opening 163
partitioning with "Split..." button 164

Data menu
Modify record 233
narrowing selection of records with,

browse window 172
New record 179

data resource file (*.4DR)
companion to recovered data file

(*.4DD) during installation 73
creating manually after recovery with

4D Tools 6.0.6 765, 772
data tables (manual conventions) 134
meta-characters, 279
date (keyword, Location box) 202
date fields, during data entry 236
DEL LINE button (Query Editor) 629
deletion of records

audit trail, retention of values and 272
Department of Education (California) 41
Designer (password system) 144
dialog box

as major program form 43
Dialogs, definition 167
disability codes, conversion of associated 

names 192

disabling (handicapping) condition codes 
263

disciplinary (keyword, Location box) 201
discipline (keyword, Location box) 201
Discipline, browse window context 169
Disk check

performing on Macintosh 761
performing on Windows 761

Disk First Aid
Mac OS 9, use before 4D Tools 761

Disk Utility (Mac OS X), use with 4D 
Tools 761

display-only area, on data entry form 230
district (keyword, Location box) 201
District access restrictions

defining for a user 158
inability to save form and 240
Modify record, limitations to user 611
specifying (function/privilege

summary by access group table)
150

two levels of 158, 162
district chargeback report 262, 456
Districts, browse window context 169
DNQ (does not qualify)

text coloration, browse window 175
DNR (do not report)

text coloration, browse window 175
domain memberships, Microsoft Windows 

57
download page, for SELPA Manager 

installers 50, 62, 90, 99, 123, 124
drop-down arrow (Location box) 180
drop-down list, on data entry form 231
Duplicating resources locally (message, 

4D Client connection) 139

E
editions, single-user and multi-user, 

Windows/Mac 49
enrollment (keyword, Location box) 202
Enrollments

"Show current for me" (Data menu)
616

"Show current for..." dialog, when



assigning/replacing a teacher 343
"Show current for..." search

preference dialog 618
"Show current" menu item and 615
"Show current", search criteria for

615
active primary (definition) 417
auxiliary enrollment codes, data entry

423
auxiliary enrollment codes, for district

chargeback 417
auxiliary enrollment codes, not used

with Type 2 chargeback report 461
auxiliary enrollment codes, school

name (Type 1) chargeback report
and 458

auxiliary enrollment codes, steps to
define (Preferences) 465

copying current to assmt. dispos. table,
SELPA 0901 IEP form 486

current enrollment status, on
enhanced, transportation-only form
272

current, definition of, for browse
window initial display options 296

data entry form (description) 419
edit an existing enrollment 425
entry from browse window 418
primary enrollment checkbox,

enrollment data entry 387
three principal methods to add 417

event (keyword, Location box) 203
Events, browse window context 171
Exiting the program

abnormal exits and "Who is here..."
dialog 584

expansion products (expansion packs)
4D Client 59
4D Client part numbers 58, 95
4D serial number and 85
4D Server (Macintosh) 95
4D server, update license dialog and

117
4D Write 59, 95, 583
4D Write licenses and "4DWriteGrp"

access group 148
4D Write part numbers 58, 95
do not enter yet (license agreement)

106
Installation of ("Update license...")

85, 116, 250
license entry, 4D Server (Windows)

85
licenses, entry of (4D Server) 116
online registration 98
online registration for 61
purchase from 4D, Inc. 58, 94

Exporting
Goals and objectives (SELPA Mgr)

572
MediCAL eligibility 570
Quick Report Editor and 755
SELPA Central 569

F
field

data entry form and 230
scrolling field 230

field (manual conventions) 134
field name

internal (structural) name 659
internal to external (user), mapping of

188
Location box queries, use with 186
Query Editor, use with 622
structural (internal) name 659

fields list (Query Editor) 627
filtering, during data entry 235
Firefox web browser 59, 96, 133
FireWire drives (4D Backup) 129
Fix STAR#90 errors (location box 

function) 194
Folder Options dialog (Windows), to show 

all files 73
Formula Editor

Order by editor and 637
Quick Report Editor and 736

free-form searches (Location box) 214, 
215

freezing columns, browse window lists 
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173
full backup

4D Backup (Macintosh server
installation) 115

Full Time Equivalents (FTEs) 328, 341
functions (Location box) 191

G
GENERATE CERTIFICATE REQUEST 

(button) 251
goal (keyword, Location box) 201
Goals and objectives

option to install, PC server update
installer 89

Goals, browse window context 169
Goals/objectives palette

Choice list table and 266
no prefix/suffix when pasting items

from (preference) 278, 279
Preferences, displaying from 267

Graph function, Location box 194
gremlins, in data entry 235
Groups (password system) 146

H
handicapping condition (disabling 

condition) codes 263
Help function, Location box 194
HelpServer

Version release notes and 123
Hewlett-Packard printer compatibility 

(printed forms) 585
Hide file extensions for known types 

(Windows setting) 73
holidays and vacations

district, adding for 314
hops (router), distance from 4D Server to 

4D Client, on wide-area network 138

I
iep (keyword, Location box) 201
IEP templates (blank form sets)

available choices (Preferences) 280
Imports

170-column CASEMIS (1998-99)

519
Assessment (full IEP form) 522
Discipline (CASEMIS Table C) 525
Discipline (generic) 526
Districts (generic) 528
Districts (San Mateo) 529
district-to-district 518
Enrollments (aux., San Mateo) 529
Goals (student) 532
Goals/objectives (generic) 533
Goals/objectives (SELPA Mgr) 534
Postal codes 536
Schools (generic) 537
Schools (San Mateo) 538
SELPA 0600 (Colusa County) 540
SELPA 1600 (King’s County) 545
SELPA 3013 / Nightly (Anaheim

Union) 549
SELPA 3702 / Basic View (North

Coastal SELPA) 551
SELPA Central 515
SELPA Central, no start date match on

260
SELPA Manager 3.5x 519
Student-associated schools 565
Students (aux., San Mateo) 557
Students (CASEMIS Table A) 558
Students (CMS Tbl A 01-02) 561
Students from web 563
Teachers (generic) 565
Teachers (San Mateo) 566

in-context search criteria (Location box) 
181

index, definition 623
Individual Education Plan (IEP) 44

enter/edit capability, for service
providers 42

web-based IEP interface 44, 59, 96
initial, for initial/interim plan status 370
INSERT LINE button (Query Editor) 629
integrated, log file needs to be (alert) 127
interim, for initial/interim plan status 370
internal districts

capability of program to maintain 42
internal name (structural name) for a field 



659
Internet Explorer web browser, Microsoft 

50, 59, 96, 133
IP (TCP/IP) number of the server

manual entry of, starting 4D Client
138

itp (keyword, Location box) 201

J
journaled disk, Macintosh disk check and 

761

K
Kernel

4D Server (Macintosh) 110
4D Server (Windows) 79

keystrokes (manual conventions) 134
keywords, context-changing, for browse 

window 200

L
Last durable set

browse window and 224
last found set (Data menu item) 640

Last found set
browse window and 222
Data menu item 639

licensing
program registration dialog 249
SERIAL NO. (button) 247

list object, on data entry form 232
Location box

adding an assessment, if student does
not yet exist in program 479

adding assessment for new or existing
student with 487

assessment (keyword) 201
assessment information, temporary

display of 480
attendance confirmation expressions

181
attendance items, adding from 357
Calculate ORC (function) 191
calendar (keyword) 202
calendar item searches and 229

change context of browse window
temporarily with 298

Check next student number (function)
191

check problem items (function) 192
comparison operator, in standard

search expressions 186
comparison operator, in-context

search expressions 204
context-changing keywords 181,

200
context-switching words and 170
Convert disability names (function)

192
Convert service codes (function) 192
Count disciplinary actions (function)

193
Count student services (function) 193
current focus buttons, proximity of

178
date (keyword) 202
definition, use in browse window

queries 170
disciplinary (keyword) 201
discipline (keyword) 201
district (keyword) 201
district access restriction definition

and ("show user info") 158
drop-down arrow 180
enrollment (keyword) 202
event (keyword) 203
field name, in standard search

expressions 186
field names, internal or structural,

contrasted with Location box names
659, 707, 715

find district by name or code using
316

find school by name or code using
323

find staff member by name or code
using 342

finding an existing assessment 510
finding an existing disciplinary action

using 476
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finding an existing enrollment using
425

finding an existing goal using 455
finding an existing student using 415
finding student for an assessment with

483
Fix STAR#90 errors (function) 194
free-form searches 214, 215
function execution with (functional

expressions) 191
goal (keyword) 201
Graph (function) 194
help 194
iep (keyword) 201
in-context search criteria 181
itp (keyword) 201
last found set and 222
lock (function) 199
new assessment/transition/IEP for

phrase 298
new record expressions 190
omitted (hidden) records, use to un-

hide 620
optional prefix, in standard search

expressions 186
other browse contexts and 170
Overdue (function) 195
Plade dates on caleandr (function)

195
pop-up choice list and 186
postal (keyword) 202
Purge audit trail (function) 196
Quick Report, record selection for,

using 721
recent items, maximum number of to

appear in ("max recent items" in
Preferences) 293

referral (keyword) 201
Reset capitalization (function) 196
Restore last found set (function) 196
Save last found set (function) 197
schedule (keyword) 202
school (keyword) 202
search object, in-context search

expressions 204

search with, on change of context 203
service (keyword) 202
Show all (function) 197
Show current (function) 197
Show subset (function) 197
show user info (keyword) 202
Sort (function) 197
special expressions 181, 190
Special operations dialog (function)

197
staff (keyword) 203
standard search expressions 181,

186
student (keyword) 202
teacher (keyword) 203
tracking (keyword) 203
transition (keyword) 201
unlock (function) 198
un-transfer students (function) 199
update quick report fields (function)

199
uses of 180
value, in standard search expressions

186
value, in-context search expressions

204
zip (keyword) 202

lock (Location box function) 199
locked records (editing records) 514
log file

creation of, 4D Backup (Macintosh)
115

login dialog (password system) 141
login names

eight "default" names 142
eight default names, explained 143
User list, Password dialog 141

Login notice, for web users 286
Logo, adding (printed forms) 302
Logon message, for non-web users 285
lower (secondary) list (browse window) 

168

M
major version upgrades



4D Client and 86, 118
Martinez, Waldo (password system) 144
MediCAL

provider ID number for SELPA
(Preferences) 269

Mendocino County SELPA (collecting 
student data) 45

Microsoft
file sharing protocols and SELPA

Manager 57
missing/problem items list

as non-enterable area, data entry form
230

assessment data entry 486
assessment form data entry, "IEP req.

std fields" box in Preferences and
281

data entry form (sample depiction)
239

district data entry form and 310
infant age warning messages and 259
no "As Of" warnings option and 259
no age-related error checking option

and 261
no percent ORC warnings/errors

(preferences) 273
SAVE button disabled on data entry

forms 239
school data entry form and 319
staff data entry form and 330
student data entry form and 365
student data entry, alternate

assessment box requires STAR
30/90 378

student data entry, infant referral date
and 382

student data entry, infant transition
mtg. date and 382

student data entry, Last IEP not within
1 year warning 383

student data entry, Percent ORC error
and 379

student infant setting, warning added
for 378

student preschool setting, warning

added for 378
Modification date (field), handling of 647
modifier (manual conventions) 134
Modify record (Data menu) 233
Modifying a record

locked records and 514
Mozilla web browser 133
multi-level sort, browse window 177
multi-threaded application 513
My defaults (check box, Preferences) 288
My District (designation for a District 

record) 176, 269, 360, 364
MyCalendarItems (access group)

creating/editing access groups and
578

MyCalendarItems (password system) 148
"Teacher, Standard" is member of

145
default access group 143

MyDistrictRstrs (access group)
applying school or district restrictions

to self 156
as default access group 143

MyDistrictRstrs (password system)
definition 150

N
and 279
navigation buttons, record 239
Navigator web browser, AOL-Netscape 

59, 96
nested groups (password system) 155
network drive

use with 4D Backup (Macintosh) 113
use with 4D Backup (Windows) 81

New record (Data menu) 179
New record expressions (Location box) 

190
New record, and the current focus, browse 

window 179
next student number (District data entry) 

313

O
online registration
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4D Server 60, 97
expansion products 61, 98

Open, in teacher/staff name 176
Operating system (OS)

requirements, minimum, PC client 86
requirements, minimum, PC server 57
requirements, recommended, PC

single-user 50
Operating systems, computer 41
optional prefix

Location box queries, use with 186
ORC (Outside Regular Classroom, 

percent) 273
Order By dialog

sorting browse lists and 177
Order By dialog (sorting) 636
OTHER FORMS (button, on assessment 

form) 268
OTHER IEP FORMS (button, 

Preferences) 268
Other year enrollments

Current (as of date) Preferences
setting, relation to 296

Data menu item 647
data menu overview 608
Query Editor searches and 621
transportation summary report and

589
Overdue (Location box function) 195

P
Quick Report Editor

 266
Password system

4DWriteGrp (access group) 143,
147, 148

access group relationships 154
access groups 146
adding a user 575
AdminGroup (access group) 143,

146, 156, 166
administrative access 147
Administrator (default login name)

143
administrator (running 4D

Tools/Windows) 772
assigning users to access groups 580
Change password (menu item) 573
Change password... (menu item) 146
changing user name or password 577
Counselor, Limited (default login

name) 143
CounselorLtdGrp (access group)

143, 149
creating/editing access groups 578
default user login names 143
Designer (default login name) 144
district access restrictions, defining

158
File menu and (Users and groups...)

512
Function/privilege summary by access

group (table) 150
groups 146
login dialog 141
login dialog (illus.) 142
Martinez, Waldo (default login name)

144
MyCalendarItems (access group)

143, 148
MyDistrictRstrs (access group) 143,

150, 156
nested groups 155
Nesting access groups 580
Passwords dialog 146, 159
plug-in access 583
Preferences dialog restrictions 243
Read-Write User (default login name)

144
ReadWriteGrp 147
ReadWriteGrp (access group) 143,

147, 166
removing users from access groups

580
saving and loading groups 581
Simplified Passwords dialog 146
Teacher, Limited (default login name)

144
Teacher, Standard (default login

name) 145



TeacherGrp (access group) 143,
148, 149, 166, 260

TeacherLtdGrp (access group) 143,
260

Transport User (default login name)
145

TransportGrp (access group) 143,
147

user name maximum for 578
user not in any access group 150
users and groups (passwords) dialog

574
Users and groups... (menu item) 573

Passwords dialog 146
pdf (Portable Document Format)

OTHER IEP FORMS (button) 268
print-to-pdf services, excluded time

exception 284
print-to-pdf services, timeout

preference 285
pdf995 print driver for Windows 285
Percent ORC (%ORC) 273
Place dates on calendar (location box 

function) 195
pop-up choice list

date entry, goals/objectives 276
date entry, goals/objectives

(deactivation preference) 277
limited-access user preferences and

305
non-date entry, goals/objectives

(deactivation preference) 278
read-write user preferences and 303

postal (keyword, Location box) 202
Postal codes, browse window context 171
Preferences

current selection of records and 172
menu item, accessing 572
new preferences dialog ("Welcome to

SELPA Manager") 164
New window (menu item) and 512
no styled browse text option 175
Preferences dialog 243

prefix, optional, Location box (standard 
search expressions) 186

Previous record number, student data entry 
form 380

primary (upper) list, browse window 168
Print (menu item) 584, 603, 604, 605, 

606
Printing

assessments (IEP forms, print
assessments dialog, options) 592

assignments 599
attendance registers 585, 598
disciplinary actions 595
district chargeback report 600
districts (print districts dialog,

options) 600
enrollments (print enrollments dialog,

options) 593
enrollments by disability, caution

dialog 591
goals 594
Hewlett-Packard printer compatibility

585
IEP data verification form 586
IEP notification form 586
personnel data report 601
Print (menu item), explained 584,

603, 604, 605, 606
schools 599
student by teacher report 596
student by teachers report (dialog,

options) 596
student service summary by disability

report 601
students (print students dialog,

options) 585
students, using Quick Report Editor

590
teachers (print teachers dialog,

options) 596
transportation profile 586, 589
transportation summary 589

print-to-pdf services
excluded time exception made for

284
print timeout (Preferences) 285

Procedure stack 513
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Product ID number(s), from 4D, Inc. 60, 
96

Product ID number(s), proof of purchase 
and 62, 98

Professional Assignment Information 
Form (PAIF), CBEDS 333

Program Manager Group, selecting during 
installation (PC) 54, 68

program registration dialog 247, 249, 
250

Program users, browse window context 
170

Provider (Mendocino Cty. example) 45
Pupil Count Operator (Mendocino Cty. 

example) 45
pupil counts 44
Purge audit trail (Location box function) 

196

Q
QR button, for replicate/clone address 

fields 725
Query

comparison operator component 622
compound query, definition of 625
conjunction operator, use for 625
definition 622
field name component 622
index, as used with 623
sequential (unindexed) search for 623
simple query, definition of 625
value component 622

Query Editor
ADD LINE button 629
appearance of SELPA-specific fields

in 480
as program component 44
available fields menu 627
comparison operator area 627
conjunction buttons 627
criteria area 626
DEL LINE button 629
field names and (compared to

Location box) 188
field names as listed vs. internal

(structural) field names 659
fields indicated as "N/A" (invisible for

particular SELPAs) 707, 715
fields list 627
finding attendance records with, on

assignment data entry form 352
INSERT LINE button 629
last found set and 222
query in selection button 627
Quick Report, use with to find records

721
related tables, searching in 626
unhiding records after "Omit subset"

620
use of, with "Find..." menu item 620
use of, with SEARCH button 179
value area 627

query in selection button (Query Editor) 
627

Quick Report Editor 480, 659, 707, 715
as program component 44
automatic column sizing and 735
clone address fields and 725
Formula Editor and 736
printed reports 755
printing to disk 755
printing to graph 756
QR button and 369
replicate address fields and 725

R
RAM Doubler, SELPA Manager 

incompatability with 90
Read-Write User (password system) 144
ReadWriteGrp (password system) 143, 

144, 147, 154, 157, 240, 299, 413, 
515, 567, 569, 571, 572, 578, 581, 
604, 605, 609, 610, 611, 799, 826

nesting and 580
retrieval of sets on disk and 638
SELPA Central import, performing

166
record navigation buttons 239
records, navigating within 233
referral (keyword, Location box) 201



Register Expansion Products (4D Server) 
61, 98

registration card, 4D Server 60, 96
related many 725
related tables, Query Editor searches and 

626
removable media drives (4D Backup) 81, 

129
replicate address fields 725
Report As Of date (Preferences) 151, 

192, 194
service codes and 337
Student’s age today and 300

Reports
attendance registers 585
IEP data verification 586
IEP notice 587
students, using Quick Report Editor

590
transportation profile 589
transportation summary 589

re-serialization of program 247
Reset capitalization (Location box 

function) 196
Restore last found set (Location box 

function) 196
Restore Log

4D Server (Macintosh), window 110
4D Server (Windows), window 79

Restore Log window (4D Server) 127
restricted choice list (for data entry) 368
Restrictions by District

closing Users and Groups dialog and
577

RINT USER LISTS (button) 266
roll back, to previous version 53, 67, 70, 

88
router “hops” (distance from 4D Server to 

4D Client workstation, on wide-area 
network) 138

runtime (single-user editions) 49

S
Safari web browser, Apple 59, 96, 133
Save last found set (Location box function) 

197
Saving records, data entry 238
schedule (keyword, Location box) 202
school (keyword, Location box) 202
School or district access restrictions

"AdminGroup" access group, ability
to impose 147

"MyDistrictRstrs" access group and
150, 153

attendance logging and 184
district access restrictions, enhanced

level 158, 162
inapplicable to "TeacherGrp" and

"TeacherLtdGrp" access groups
157

introduction 156
reduce ability to access IEPs

(footnote) 145
two levels of district access

restrictions 158, 162
Schools, browse window context 169
scrolling field, data entry and 230
scrolling text areas, during data entry 238
search object

Location box queries, use with 204
secondary (lower) list, browse window 

168
SELPA

specifying in new preferences dialog
164

specifying in preferences dialog
(administrators) 244

SELPA Central (transfer/export option) 
309

Separate by school/track
attendance registers printing and 599

sequential search
queries on related tables and 626
query and 623

SERIAL NO. (button) 247
serial numbers

4D Server 61
4D Server 6.7, 6,8, etc. and 63, 98
4D Server, dialog for entry of 75,

106
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4D Server, Product ID numbers and
97

4D Server, registration and 96
4D Server, update license dialog and

85, 117
serial numbers, 4D Server 60
Serialization (licensing) of the program 

247, 249, 250
server data backup (4D Backup) 126
service (keyword, Location box) 202
Service code (CASEMIS)

"new" vs. "old" codes and service
name 388

2-digit ("new") and 3- or 5-digit
("old") codes 338

2-digit service codes introduced,
2001-2002 338

attendance register printing options
and 379

Colusa (0600) import uses"old"-style
codes 540

converting "old"-style to "new"-style
codes 544

converting San Mateo 3-digit codes to
CASEMIS service codes, Aixiliary
Enrollment (San Mateo) import 529

editing enrollments, student data entry
form 388

finding enrollment records and
(browse window) 426

King’s County (1600) import
uses"old"-style codes 545

Location box search for, example 180
not used to calculate chargeback fees

466
old-style codes, conversion of

(Location box) 192
pop-up lists and, enrollment data entry

form 422
teacher assignments and, entering

339
teacher default when adding an

enrollment 337, 350
teacher default, enrollment data entry

form 421

teacher default, when adding an
enrollment, Student data entry 387

teacher services, entering 338
use to tally chargebacks 466
using as a break in a Quick Report

742
Services (student), browse window context 

169
Sets

definition of 222, 637, 638, 639
last durable set 224, 639, 640
Last found set (Data menu) 639
last found set, browse window and

222
Open a set (from disk) 637
Save a set (on disk) 638
saving to disk 224

shared school codes
Preferences option 270
school data entry and 320

shortcut to 4D Client, on Windows 
Desktop 89

shortcut, on Windows Desktop, to SELPA 
Manager RT 55

Show all function, Location box 197
Show current (Data menu)

as menu item 615
Last found set, relationship to 639

Show current function, Location box 197
Show subset function, Location box 197
show user info (keyword, Location box) 

202
simple query, definition of 625
Simplified Passwords dialog 146
single-level sort, browse window 177
single-user runtime

accessing SELPA Manager with 141
getting started 135
single-user edition of SELPA

Manager 134
slider control, browse window 173
Sort function, Location box 197
Sorting browse lists 177
Special Education Local Plan Areas 

(SELPAs) 41



special expressions (Location box) 181, 
190

Special Operations dialog
Administrator access to 143
Function/privilege summary table and

150
Martinez, Waldo denied access to 144
ReadWriteGrp access group cannot

access 147
Special operations dialog (Location box 

function) 197
spell checking

NO SPELLING check box
(Prefereces) 292

Split... button (creating a new data file) 
164

SSID Enrollment Update (CSIS)
Report As Of date and 256

SSL (Secure Sockets Layer) encryption
certificate signing request (CSR)

generation 251
GENERATE CERTIFICATE

REQUEST (button) 251
SSL button 250
SSL certificate 250

Stack memory 513
Stack, procedure

New window command and 513
staff (keyword, Location box) 203
Staff (program section)

adding staff and related information
(intro.) 325

Staff, browse window context 169
standard browse window, described 168
standard search expressions (Location box) 

181, 186
STAR (Statewide Testing and Reporting 

program)
alternate assessment goal, error if

student is not STAR 90 430
IEP goal, alternate assessment entry,

associated student should be STAR
90 504

Imported field, CASEMIS Table A
560

Imported field, CASEMIS Table A
(2001-02) 563

Imported field, SELPA 3702 556
required codes for alternate

assessment 377
student fields 377

Statewide Testing and Reporting (STAR) 
program 377

status bar (status window) 511, 607, 
651, 657

structural name (internal name) for a field 
659

structure
"SELPA Manager Structure" check

box, server update installer
(Windows) 70

check box, Full Backup dialog, 4D
Backup 83, 115

program structure, replace similar
item in "SELPA_fldr" (Macintosh)
104

SELPA Manager program structure,
definition of 63, 99

SELPA Manager structure, major
version updates and 121

SELPA Manager Structure, shortcut to
72

structure file
".comp" suffix may not be visible on,

Macintosh 125
"Files of type" option, *.4DB, on

dialog "Open a 4D Database" 77
as part of backup to destination

volume 80, 112
backup project saved to same folder as

115
data file with same prefix as, SELPA

Manager server, Macintosh 109
data file with same prefix as, SELPA

Manager server, Windows 78
selecting structure file (database) to be

opened, 4D Server 77
structure-only update

double-click to execute installer 68
installation dialog for, Windows 72
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installer, double-click to expand
(Macintosh) 103

installer, for SELPA Manager client-
server (Macintosh) 99

installer, for SELPA Manager client-
server (Windows) 63

minor version updates 123
student (keyword, Location box) 202
Student services, browse window context 

169
Students, browse window context 169
sub-districts, for CASEMIS reporting 312
sub-sites (schools sharing same code) 270

T
tabs, data entry forms and 230, 234
target table ("Show current for..." menu 

item) 617
TCP/IP networking, required on Windows 

multi-user installation 57
teacher (keyword, Location box) 203
Teacher services (program section)

adding staff and related information
(intro.) 325

Teacher, Limited (password system) 144
Teacher, Standard (password system) 145
TeacherGrp (password system)

"As Of" warnings do not appear for
260

"Teacher, Standard" is member of
145

Alternate assessment... (Data menu
item) and 646

as default access group 143
browse window initially displays

(Preferences option) 295
creating/editing access groups and

578
definition 148, 149
Discipline... (Data menu item) and

644
Last modified on... (Data menu item)

and 647
logging attendance information,

restrictions 183

member of "ReadWriteGrp" 154
Modify record command and 611
nesting and 580
not in any group, comparison to 150
Query Editor searches and ("Find...")

621
retrieval of sets on disk and 638
SAVE button dimmed if not member

240
school or district access restrictions

not applicable 157
SELPA Central import, performing

166
Student by Teacher and Attendance

Registers reports, limitations 595
Transportation... (Data menu item)

and 643
TeacherLtdGrp (password system)

"As Of" warnings do not appear for
260

creating/editing access groups and
578

default access group 143
nesting and 580
no access to transportation-only data

entry form 272
not in any group, comparison to 150
school or district access restrictions

not applicable 157
temporary change of context 298
tiled windows 513
tool tips (contextual help)

Fig. 90 (example) 291
option not to display 291

tracking (keyword, Location box) 203
Tracking, browse window context 171
transition

new, creating from Location box 298
transition (keyword, Location box) 201
Transport aux. boxes, transportation-only 

data form 265
Transport User (password system) 145
transportation-only data form

transport aux. boxes 265
TransportGrp (access group)



"AdminGroup" a member of 147
"Transport User" is member of 146,

413
as default access group 143
audit trail access and 153, 413
creating/editing access groups and

578
definition 147
revision notes, added in v.4.693 826
student record editing and 154
transportation-only check box

(Preferences) and 299
transportation-only data form and

413
TransportGrp (password system) 273

U
unassociated contacts, use of student 

contacts section for 170
underlining, labels (to indicate required 

fields) 256
unlock (Location box function) 198
un-transfer students (Location box 

function) 199
UPDATE LICENSE (button) 250
update licensing

UPDATE LICENSE (button) 250
update quick report fields (Location box 

function) 199
Updates, SELPA Manager

minor version updates 123
updating, from earlier version 49
upper list (primary list, browse window) 

168
user input (manual conventions) 134
user/password information, save prior to 

program update 49

V
vacant postions, for personnel data report 

603
value

Location box queries, use with 186,
204

Query Editor, use with 622

value area (Query Editor) 627

W
web interface

Chapt. 3 not relevant to web-only use
of pgm. 133

chapt. presents web-based IEP
interface to pgm. 44

IEP entry capability using a web
browser program 43

web login notice 286
web-serving functions

4D Web 2003 Extension license 59,
96

Welcome to SELPA Manager 
(preferences) 164

Who’s here... (menu item) 584
wildcard character (“@”)

adding new assignments, use with
352

adding new services, use with 349
definition of 625
Query Editor, use with 625
replacing a teacher, use with 345
school of attendance (student’s), use

entering 378
teacher entry, use with, on enrollment

data entry form 420
teacher name on enrollment form, use

when entering 386
Windows 2000 Server

network optimization for 64
word processing area

student data entry, enrollments tab
384

workgroup, Microsoft Windows 57

Z
zip (keyword, Location box) 202
Zip codes, browse window context 171
Zip disk

use with installing client software
(Macintosh) 117

use with installing client software
(Windows) 86
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